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MODULE 1: BASIC COMPUTING 

Lesson 1: Basics of Computing 
1.1 What is a Computer? 
A computer is an electronic device that manipulates information, or data. It has the 
ability to store, retrieve, and process data. You may already know that you can use a 
computer to type documents, send email, play games, and browse the Web. You can also 
use it to edit or create spreadsheets, presentations, and even videos. 
Characteristics of computers 
 The  characteristics  of  computers  that  have  made  them  so powerful  and  universally  
useful  are  speed,  accuracy, diligence,  versatility  and  storage  capacity.  Let us discuss 
them briefly. 
Speed 
Computers work at an incredible speed. A  powerful  computer is  capable  of  performing  
about  3-4 million  simple  instructions per  second.  
Accuracy  
In addition to being fast, computers are also accurate. Errors that  may  occur  can  
almost  always  be  attributed  to  human error  (inaccurate  data,  poorly  designed  
system  or  faulty instructions/programs  written  by  the  programmer)  
Diligence 
Unlike human beings, computers are highly consistent. They do not suffer from human 
traits of boredom and tiredness resulting in lack of concentration.  Computers,  
therefore,  are better  than  human  beings  in  performing  voluminous  and repetitive  
jobs.  
Versatility 
 Computers  are  versatile  machines  and  are  capable  of performing  any  task  as  long  
as  it  can  be  broken  down  into  a series  of  logical  steps.  The  presence  of  computers  
can  be seen in almost every  sphere – Railway/Air reservation,  Banks, Hotels,  Weather  
forecasting  and  many  more.  
Storage Capacity  
Today’s computers can store large volumes of data. A piece of information once recorded 
(or stored) in the computer, can never be forgotten 
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1.2 Computer association  

 
1.1 Computer System 

Basic  Concepts  of  Computer  :  computer  system  (figure 1.1)  consists  of  mainly  four  
basic units;  namely  input  unit,  storage  unit,  central  processing unit  and output unit.  
Central  Processing unit  further  includes Arithmetic  logic  unit  and  control  unit,  as  
shown  in Figure  1.2.  
A  computer  performs  five  major  operations  or  functions irrespective  of  its  size  and  
make.  These are  

 it accepts  data  or  instructions  as  input,  

 it stores  data  and  instruction  

 it processes  data  as  per  the  instructions,  

 it controls  all  operations  inside  a  computer,  and  

 It gives results in the form of output. 
Functional Units:  
a. Input  Unit:  This  unit  is  used  for  entering  data  and programs    into  the  computer  
system  by  the  user  for processing. 
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b. Storage Unit:   
The  storage  unit  is  used  for  storing  data and  instructions  before  and  after  
processing. 
c. Output  Unit:  The  output  unit  is  used  for  storing  the result  as  output  produced  
by  the  computer  after processing.  
d. Processing:  The  task  of  performing  operations  like arithmetic  and  logical  
operations  is  called  processing. The  Central  Processing  Unit  (CPU)  takes  data  and 
instructions  from  the  storage  unit  and  makes  all  sorts  of calculations  based  on  the  
instructions  given  and  the  type of  data  provided.  It is then sent back to the storage 
unit. CPU includes Arithmetic logic unit (ALU) and control unit (CU)  

o Arithmetic  Logic  Unit:  All  calculations  and comparisons,  based  on the  
instructions  provided,  are carried  out  within  the  ALU.  It  performs  arithmetic 
functions  like  addition,  subtraction,  multiplication, division  and  also  logical  
operations  like  greater  than, less  than  and  equal  to  etc.  

o Control  Unit:  Controlling  of  all  operations like  input, processing  and  output  
are  performed  by  control  unit. It  takes  care of  step  by step  processing of  all  
operations inside  the  computer. 

Memory  
Computer’s memory can be classified into two types;  

 Primary memory  and 

 Secondary  memory  
a. Primary Memory can be further classified  as RAM and ROM: 

RAM  or  Random  Access  Memory  is  the  unit  in  a computer  system.  It  is  the  
place  in  a  computer  where the  operating  system,  application  programs  and  
the data  in  current  use  are  kept  temporarily  so  that  they can  be  accessed  
by  the  computer’s  processor.  It  is said  to  be  ‘volatile’  since  its  contents  are  
accessible only  as  long  as  the  computer  is  on.  The  contents  of RAM  are  no  
more  available  once  the  computer  is turned  off. 
 
ROM or Read Only Memory is a special type of  memory which  can  only  be  
read  and  contents  of  which  are  not lost  even  when the computer is switched 
off. It typically contains manufacturer’s instructions.  Among  other things,  ROM  
also  stores  an  initial  program  called  the ‘bootstrap  loader’  whose  function  is  
to  start  the operation  of  computer  system once the power is turned on. 
 

b. Secondary Memory RAM is volatile memory having a limited storage capacity. 
Secondary/auxiliary memory is storage other than the RAM. These  include  
devices  that  are  peripheral  and  are connected  and  controlled  by  the  
computer  to  enable permanent  storage  of  programs  and  data. Secondary 
storage devices are of two types; magnetic and optical.  Magnetic  devices  
include  hard  disks  and  optical storage  devices  are  CDs,  DVDs,  Pen  drive,  Zip  
drive  etc. 

Hard Disk 
 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  10 | 1352  

 

Hard  disks  are  made  up  of  rigid  material  and  are  usually a  stack  of  metal  disks  
sealed  in  a  box.  The  hard  disk  and the  hard  disk  drive  exist  together  as  a  unit  and  
is  a permanent part of the computer  where data and programs are  saved.  These disks 
have storage capacities ranging from 1GB to 80 GB and more. Hard disks are rewritable. 
Compact Disk  
Compact  Disk  (CD)  is  portable  disk  having  data  storage capacity  between  650-700  
MB.  It  can  hold  large  amount of  information  such  as  music,  full-motion  videos,  and 
text  etc.  CDs can be either read only or read write type. 
Digital Video Disk 
 Digital  Video  Disk  (DVD)  is  similar  to  a  CD  but  has  larger storage  capacity  and  
enormous  clarity.  Depending  upon the  disk  type  it  can  store  several  Gigabytes  of  
data.  DVDs are  primarily  used  to  store  music  or  movies  and  can  be played  back  on 
your television  or  the computer  too.  These are not rewritable. 
1.3 What are the different types of computers? 
When most people hear the word computer, they think of a personal computer such as 
a desktop or laptop. However, computers come in many shapes and sizes, and they 
perform many different functions in our daily lives. When you withdraw cash from an 
ATM, scan groceries at the store, or use a calculator, you're using a type of computer. 
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Desktop computers 

 
Many people use desktop computers at work, home, and school. Desktop computers are 
designed to be placed on a desk, and they're typically made up of a few different parts, 
including the computer case, monitor, keyboard, and mouse. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  12 | 1352  

Laptop computers 

 
The second type of computer you may be familiar with is a laptop computer, commonly 
called a laptop. Laptops are battery-powered computers that are more portable than 
desktops, allowing you to use them almost anywhere. 
Tablet computers 
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Tablet computers—or tablets—are handheld computers that are even more portable 
than laptops. Instead of a keyboard and mouse, tablets use a touch-sensitive screen for 
typing and navigation. The iPad is an example of a tablet. 
Servers 

 
A server is a computer that serves up information to other computers on a network. For 
example, whenever you use the Internet, you're looking at something that's stored on a 
server. Many businesses also use local file servers to store and share files internally. 
Other types of computers 
Many of today's electronics are basically specialized computers, though we don't always 
think of them that way. Here are a few common examples. 

 Smartphones: Many cell phones can do a lot of things computers can do, 
including browsing the Internet and playing games. They are often 
called smartphones. 

 Wearables: Wearable technology is a general term for a group of 
devices—including fitness trackers and smartwatches—that are designed 
to be worn throughout the day. These devices are often 
called wearables for short. 

 Game consoles: A game console is a specialized type of computer that is 
used for playing video games on your TV. 

 TVs: Many TVs now include applications—or apps—that let you access 
various types of online content. For example, you can stream video from 
the Internet directly onto your TV. 

PCs and Macs 
Personal computers come in two main styles: PC and Mac. Both are fully functional, but 
they have a different look and feel, and many people prefer one or the other. 
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PCs 

 
This type of computer began with the original IBM PC that was introduced in 1981. Other 
companies began creating similar computers, which were called IBM PC 
Compatible (often shortened to PC). Today, this is the most common type of personal 
computer, and it typically includes the Microsoft Windows operating system. 
 
 
 
 
 
Macs 
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The Macintosh computer was introduced in 1984, and it was the first widely sold 
personal computer with a graphical user interface, or GUI (pronounced gooey). All Macs 
are made by one company (Apple), and they almost always use the Mac OS X operating 
system. 
1.4 Hardware vs. software 
Before we talk about different types of computers, let's talk about two things all 
computers have in common: hardware and software. 

 Hardware is any part of your computer that has a physical structure, such 
as the keyboard or mouse. It also includes all of the computer's internal 
parts, which you can see in the image below. 
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 Software is any set of instructions that tells the hardware what to 

do and how to do it. Examples of software include web browsers, games, 
and word processors. 

 
Everything you do on your computer will rely on both hardware and software. For 
example, right now you may be viewing this lesson in a web browser (software) and 
using your mouse (hardware) to click from page to page. As you learn about different 
types of computers, ask yourself about the differences in their hardware. As you progress 
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through this tutorial, you'll see that different types of computers also often use different 
types of software. 

Lesson 2: Hardware Basics 
2.1 Basic Parts of a Computer 
Computer case 
The computer case is the metal and plastic box that contains the main components of 
the computer, including the motherboard, central processing unit (CPU), and power 
supply. The front of the case usually has an On/Off button and one or more optical 
drives. 
Computer cases come in different shapes and sizes. A desktop case lies flat on a desk, 
and the monitor usually sits on top of it. A tower case is tall and sits next to the monitor 
or on the floor. All-in-one computers come with the internal components built into the 
monitor, which eliminates the need for a separate case. 
Input / Output Devices: 
These  devices  are  used  to  enter  information  and  instructions into  a  computer  for  
storage  or  processing  and  to  deliver  the processed  data to  a  user.  Input/output 
devices are required for users to communicate with the computer. In simple terms, input  
devices  bring  information  INTO  the  computer  and output  devices  bring  information  
OUT  of  a  computer  system. These  input/output  devices  are  also  known  as  
peripherals since  they  surround  the  CPU  and  memory  of  a  computer system. 
Input Devices 
 An  input  device  is  any  device  that  provides  input  to  a computer.  There  are  many  
input  devices,  but  the  two most  common  ones  are  a  keyboard  and  mouse.  Every 
key  you  press  on  the  keyboard  and  every  movement  or click  you  make  with  the  
mouse  sends  a  specific  input signal  to  the  computer. 

 
Keyboard 
The keyboard is one of the main ways to communicate with a computer. There are many 
different types of keyboards, but most are very similar and allow you to accomplish the 
same basic tasks. 
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Mouse 
The mouse is another important tool for communicating with computers. Commonly 
known as a pointing device, it lets you point to objects on the screen, click on them, and 
move them. 
There are two main mouse types: optical and mechanical. The optical mouse uses an 
electronic eye to detect movement and is easier to clean. The mechanical mouse uses a 
rolling ball to detect movement and requires regular cleaning to work properly. 
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Mouse alternatives 
There are other devices that can do the same thing as a mouse. Many people find them 
easier to use, and they also require less desk space than a traditional mouse. The most 
common mouse alternatives are below. 

 Trackball: A trackball has a ball that can rotate freely. Instead of moving 
the device like a mouse, you can roll the ball with your thumb to move 
the pointer. 

 Touchpad: A touchpad—also called a trackpad—is a touch-sensitive pad 
that lets you control the pointer by making a drawing motion with your 
finger. Touchpads are common on laptop computers. 

 Touch Screen:  It allows the user to operate/make selections by simply 
touching the display screen.  A display screen  that  is  sensitive  to  the  
touch  of  a  finger  or  stylus. Widely  used  on  ATM  machines,  retail  
point-of-sale terminals,  car  navigation systems,  medical  monitors  and 
industrial  control  panels. 

 Light  Pen:  Light  pen  is  an  input  device  that  utilizes  a light-sensitive  
detector  to  select  objects  on  a  display screen. 

Some other Input devices 
Magnetic ink character recognition  (MICR):  MICR can identify  character  printed  
with  a  special  ink  that  contains particles  of  magnetic  material.  This device 
particularly finds applications in banking industry.  
Optical  mark  recognition  (OMR):  Optical  mark recognition,  also  called  mark  
sense  reader  is  a  technology where  an  OMR  device  senses  the  presence  or  
absence  of a  mark,  such  as  pencil  mark.  OMR is widely used in tests such as 
aptitude test.  
Bar  code  reader: Bar-code  readers  are  photoelectric scanners  that  read  the  
bar  codes  or  vertical  zebra  strips marks,  printed  on  product  containers.  
These devices are generally used in super markets, bookshops etc.  
Scanner:  Scanner  is  an  input  device  that  can  read  text or  illustration  printed  
on  paper  and  translates  the information  into  a  form  that  the  computer  can  
use.  A scanner works by digitizing an image.   
Output  Devices: Output  device  receives  information  from  the  CPU  and 
presents  it  to the  user  in  the  desired  from.  The  processed data,  stored  in  
the  memory  of  the  computer  is  sent  to  the output  unit,  which  then  
converts  it  into  a  form  that  can be  understood  by  the  user.  The  output  is  
usually produced  in  one  of  the  two  ways  –  on  the  display  device, or  on  
paper  (hard  copy). 
Monitor 

The monitor works with a video card, located inside the computer case, to display 
images and text on the screen. Most monitors have control buttons that allow you to 
change your monitor's display settings, and some monitors also have built-in speakers. 
Newer monitors usually have LCD (liquid crystal display) or LED (light-emitting diode) 
displays. These can be made very thin, and they are often called flat-panel displays. 
Older monitors use CRT (cathode ray tube) displays. CRT monitors are much larger and 
heavier, and they take up more desk space. 
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Printer:  Printers are used to produce paper (commonly known as hardcopy) 
output. Based on the technology used, they can be classified as Impact or Non-
impact printers. 
Impact  printers  use the typewriting  printing  mechanism wherein  a  hammer 
strikes  the  paper  through  a  ribbon  in order  to  produce  output.  Dot-matrix 
and Character printers fall under this category.  
Non-impact printers do not touch the paper while printing.  They  use  chemical,  
heat  or  electrical  signals  to etch  the  symbols  on paper.  Inkjet, Deskjet, Laser, 
Thermal printers fall under this category of printers.  
Plotter:  Plotters are used to print graphical output on paper.  It  interprets  
computer  commands  and  makes  line drawings  on  paper  using  multicolored  
automated  pens. It is capable of producing graphs, drawings, charts, maps etc.  
 Facsimile  (FAX):  Facsimile  machine,  a  device  that  can send  or  receive  pictures  
and  text  over  a  telephone  line. Fax machines work by digitizing an image. 
Sound  cards  and  Speaker(s):  An  expansion  board  that enables  a  computer  to  
manipulate  and  output  sounds. Sound  cards  are  necessary  for  nearly  all  CD-
ROMs  and have  become  commonplace  on  modern  personal computers.  
Sound  cards  enable  the  computer  to  output sound through speakers  
connected to the board,  to  record sound  input  from  a  microphone  connected  
to  the computer,  and  manipulate  sound  stored  on  a  disk. 
2.2 Buttons and Ports on a Computer 
Take a look at the front and back of your computer case and count the number of 
buttons, ports, and slots you see. Now look at your monitor and count any you find 
there. You probably counted at least 10, and maybe a lot more. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  21 | 1352  

Each computer is different, so the buttons, ports, and sockets will vary from computer to 
computer. However, there are certain ones you can expect to find on most desktop 
computers. Learning how these ports are used will help whenever you need to connect 
something to your computer, like a new printer, keyboard, or mouse. 
 
Front of a computer case 

 
Back of a computer case 

The back of a computer case has connection ports that are made to fit specific devices. 
The placement will vary from computer to computer, and many companies have their 
own special connectors for specific devices. Some of the ports may be color coded to 
help you determine which port is used with a particular device. 
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Other types of ports 

There are many other types of ports, such as FireWire, Thunderbolt, and HDMI. If your 
computer has ports you don't recognize, you should consult your manual for more 
information. 

 
 
Peripherals you can use with your computer 
The most basic computer setup usually includes the computer case, monitor, keyboard, 
and mouse, but you can plug many different types of devices into the extra ports on your 
computer. These devices are called peripherals. Let's take a look at some of the most 
common ones. 

 Printers: A printer is used to print documents, photos, and anything else 
that appears on your screen. There are many types of printers, 
including inkjet, laser, and photo printers. There are even all-in-one 
printers, which can also scan and copy documents. 
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 Scanners: A scanner allows you to copy a physical image or 

document and save it to your computer as a digital (computer-
readable) image. Many scanners are included as part of an all-in-one 
printer, although you can also buy a 
separate flatbed or handheld scanner. 

 Speakers/headphones: Speakers and headphones are output devices, 
which means they send information from the computer to the user—in 
this case, they allow you to hear sound and music. Depending on the 
model, they may connect to the audio port or the USB port. Some 
monitors also have built-in speakers. 
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 Microphones: A microphone is a type of input device, or a device that 
receives information from a user. You can connect a microphone 
to record sound or talk with someone else over the Internet. Many 
laptop computers come with built-in microphones. 

 
 Web cameras: A web camera—or webcam—is a type of input device that 

can record videos and take pictures. It can also transmit video over the 
Internet in real time, which allows for video chat or video 
conferencing with someone else. Many webcams also include a 
microphone for this reason. 

 Game controllers and joysticks: A game controller is used to control 
computer games. There are many other types of controllers you can use, 
including joysticks, although you can also use 
your mouse and keyboard to control most games. 

 Digital cameras: A digital camera lets you capture pictures and videos in a 
digital format. By connecting the camera to your computer's USB port, 
you can transfer the images from the camera to the computer. 

 Mobile phones, MP3 players, tablet computers, and other 
devices: Whenever you buy an electronic device, such as a mobile phone 
or MP3 player, check to see if it comes with a USB cable. If it does, this 
means you can most likely connect it to your computer. 

 
2.3 Inside a Computer 
Have you ever looked inside a computer case, or seen pictures of the inside of one? The 
small parts may look complicated, but the inside of a computer case isn't really all that 
mysterious. This lesson will help you master some of the basic terminology and 
understand a bit more about what goes on inside a computer. 
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Motherboard 

 
The motherboard is the computer's main circuit board. It's a thin plate that holds the 
CPU, memory, connectors for the hard drive and optical drives, expansion cards to 
control the video and audio, and connections to your computer's ports (such as USB 
ports). The motherboard connects directly or indirectly to every part of the computer. 
CPU/processor 

 
The central processing unit (CPU), also called a processor, is located inside the computer 
case on the motherboard. It is sometimes called the brain of the computer, and its job is 
to carry out commands. Whenever you press a key, click the mouse, or start an 
application, you're sending instructions to the CPU. 
The CPU is usually a two-inch ceramic square with a silicon chip located inside. The chip 
is usually about the size of a thumbnail. The CPU fits into the motherboard's CPU socket, 
which is covered by the heat sink, an object that absorbs heat from the CPU. 
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A processor's speed is measured in megahertz (MHz), or millions of instructions per 
second; and gigahertz (GHz), or billions of instructions per second. A faster processor can 
execute instructions more quickly. However, the actual speed of the computer depends 
on the speed of many different components—not just the processor. 
RAM (random access memory) 

 
RAM is your system's short-term memory. Whenever your computer performs 
calculations, it temporarily stores the data in the RAM until it is needed. 
This short-term memory disappears when the computer is turned off. If you're working 
on a document, spreadsheet, or other type of file, you'll need to save it to avoid losing it. 
When you save a file, the data is written to the hard drive, which acts as long-term 
storage. 
RAM is measured in megabytes (MB) or gigabytes (GB). The more RAM you have, the 
more things your computer can do at the same time. If you don't have enough RAM, you 
may notice that your computer is sluggish when you have several programs open. 
Because of this, many people add extra RAM to their computers to improve 
performance. 
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Hard drive 

 
The hard drive is where your software, documents, and other files are stored. The hard 
drive is long-term storage, which means the data is still saved even if you turn the 
computer off or unplug it. 
When you run a program or open a file, the computer copies some of the data from 
the hard drive onto the RAM. When you save a file, the data is copied back to the hard 
drive. The faster the hard drive, the faster your computer can start up and load 
programs. 
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Power supply unit 

 
The power supply unit in a computer converts the power from the wall outlet to the type 
of power needed by the computer. It sends power through cables to the motherboard 
and other components. 
If you decide to open the computer case and take a look, make sure to unplug the 
computer first. Before touching the inside of the computer, you should touch a grounded 
metal object—or a metal part of the computer casing—to discharge any static buildup. 
Static electricity can be transmitted through the computer circuits, which can seriously 
damage your machine. 
Expansion cards 

Most computers have expansion slots on the motherboard that allow you to add various 
types of expansion cards. These are sometimes called PCI (peripheral component 
interconnect) cards. You may never need to add any PCI cards because most 
motherboards have built-in video, sound, network, and other capabilities. 
However, if you want to boost the performance of your computer or update the 
capabilities of an older computer, you can always add one or more cards. Below are 
some of the most common types of expansion cards. 
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Video card 

 
The video card is responsible for what you see on the monitor. Most computers have 
a GPU (graphics processing unit) built into the motherboard instead of having a separate 
video card. If you like playing graphics-intensive games, you can add a faster video card 
to one of the expansion slots to get better performance. 
Sound card 

The sound card—also called an audio card—is responsible for what you hear in the 
speakers or headphones. Most motherboards have integrated sound, but you can 
upgrade to a dedicated sound card for higher-quality sound. 
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Network card 

 
The network card allows your computer to communicate over a network and access the 
Internet. It can either connect with an Ethernet cable or through a wireless connection 
(often called Wi-Fi). Many motherboards have built-in network connections, and a 
network card can also be added to an expansion slot. 
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Bluetooth card (or adapter) 

 
Bluetooth is a technology for wireless communication over short distances. It's often 
used in computers to communicate with wireless keyboards, mice, and printers. It's 
commonly built into the motherboard or included in a wireless network card. For 
computers that don't have Bluetooth, you can purchase a USB adapter, often called 
a dongle. 
2.4 Laptop Computers 
A laptop is a personal computer that can be easily moved and used in a variety of 
locations. Most laptops are designed to have all of the functionality of a desktop 
computer, which means they can generally run the same software and open the same 
types of files. However, laptops also tend to be more expensive than comparable desktop 
computers. 
How is a laptop different from a desktop? 

Because laptops are designed for portability, there are some important differences 
between them and desktop computers. A laptop has an all-in-one design, with a built-
in monitor, keyboard, touchpad (which replaces the mouse), and speakers. This means it 
is fully functional, even when no peripherals are connected. A laptop is also quicker to set 
up, and there are fewer cables to get in the way. 
You'll also have to the option to connect a regular mouse, larger monitor, and other 
peripherals. This basically turns your laptop into a desktop computer, with one main 
difference: You can easily disconnect the peripherals and take the laptop with you 
wherever you go. 
Here are the main differences you can expect with a laptop. 

 Touchpad: A touchpad—also called a trackpad—is a touch-sensitive pad 
that lets you control the pointer by making a drawing motion with your 
finger. 
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 Battery: Every laptop has a battery, which allows you to use the laptop 

when it's not plugged in. Whenever you plug in the laptop, the 
battery recharges. Another benefit of having a battery is that it can 
provide backup power to the laptop if the power goes out. 

 AC adapter: A laptop usually has a specialized power cable called an AC 
adapter, which is designed to be used with that specific type of laptop. 

 
 Ports: Most laptops have the same types of ports found on desktop 

computers (such as USB), although they usually have fewer ports to save 
space. However, some ports may be different, and you may need an 
adapter in order to use them. 

 Price: Generally speaking, laptops tend to be more expensive than a 
desktop computer with the same internal components. While you may 
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find that some basic laptops cost less than desktop computers, these are 
usually much less powerful machines. 

 
2.5 Mobile Devices 
What is a mobile device? 

A mobile device is a general term for any type of handheld computer. These devices are 
designed to be extremely portable, and they can often fit in your hand. Some mobile 
devices—like tablets, e-readers, and smartphones—are powerful enough to do many of 
the same things you can do with a desktop or laptop computer. 
 
Tablet computers 

Like laptops, tablet computers are designed to be portable. However, they provide a 
different computing experience. The most obvious difference is that tablet computers 
don't have keyboards or touchpads. Instead, the entire screen is touch-sensitive, allowing 
you to type on a virtual keyboard and use your finger as a mouse pointer. 

 
Tablet computers can't necessarily do everything traditional computers can do. For many 

people, a traditional computer like a desktop or laptop is still needed in order to use some 

programs. However, the convenience of a tablet computer means it may be ideal as 

a second computer. 
E-readers 

E-book readers—also called e-readers—are similar to tablet computers, except they are 
mainly designed for reading e-books (digital, downloadable books). Notable examples 
include the Amazon Kindle, Barnes & Noble Nook, and Kobo. Most e-readers use an e-
ink display, which is easier to read than a traditional computer display. You can even read 
in bright sunlight, just like if you were reading a regular book. 
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You don't need an e-reader to read e-books. They can also be read 
on tablets, smartphones, laptops, and desktops. 
Smartphones 

A smartphone is a more powerful version of a traditional cell phone. In addition to the 
same basic features—phone calls, voicemail, text messaging—smartphones can connect 
to the Internet over Wi-Fi or a cellular network (which requires purchasing a 
monthly data plan). This means you can use a smartphone for the same things you would 
normally do on a computer, such as checking your email, browsing the Web, or shopping 
online. 
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Most smartphones use a touch-sensitive screen, meaning there isn't a physical keyboard 
on the device. Instead, you'll type on a virtual keyboard and use your fingers to interact 
with the display. Other standard features include a high-quality digital camera and the 
ability to play digital music and video files. For many people, a smartphone can actually 
replace electronics like an old laptop, digital music player, and digital camera in the same 
device. 

Lesson 3: Software Basics 
3.1 Understanding Operating Systems 
What is an operating system? 

An operating system is the most important software that runs on a computer. It manages 
the computer's memory and processes, as well as all of its software and hardware. It also 
allows you to communicate with the computer without knowing how to speak the 
computer's language. Without an operating system, a computer is useless. 
System software  consists  of  a  group  of  programs  that  control the  operations  of  a  
computer  equipment  including  functions like  managing  memory,  managing  
peripherals,  loading, storing,  and  is  an  interface  between the  application  programs 
and  the  computer.  MS  DOS  (Microsoft’s  Disk  Operating System),  UNIX  are  examples  
of  system  software. 
 
The operating system's job 

Your computer's operating system (OS) manages all of the software and hardware on 
the computer. Most of the time, there are several different computer programs running 
at the same time, and they all need to access your computer's central processing unit 
(CPU), memory, and storage. The operating system coordinates all of this to make sure 
each program gets what it needs. 
Types of operating systems 

Operating systems usually come pre-loaded on any computer you buy. Most people use 
the operating system that comes with their computer, but it's possible to upgrade or 
even change operating systems. The three most common operating systems for personal 
computers are Microsoft Windows, macOS, and Linux. 
Modern operating systems use a graphical user interface, or GUI (pronounced gooey). A 
GUI lets you use your mouse to click icons, buttons, and menus, and everything is clearly 
displayed on the screen using a combination of graphics and text. 
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Each operating system's GUI has a different look and feel, so if you switch to a different 
operating system it may seem unfamiliar at first. However, modern operating systems 
are designed to be easy to use, and most of the basic principles are the same. 
Microsoft Windows 

Microsoft created the Windows operating system in the mid-1980s. There have been 
many different versions of Windows, but the most recent ones are Windows 10 (released 
in 2015), Windows 8 (2012), Windows 7 (2009), and Windows Vista (2007). Windows 
comes pre-loaded on most new PCs, which helps to make it the most popular operating 
system in the world. 

 
macOS 

macOS (previously called OS X) is a line of operating systems created by Apple. It comes 
preloaded on all Macintosh computers, or Macs. Some of the specific versions 
include Mojave (released in 2018), High Sierra (2017), and Sierra (2016). 
According to StatCounter Global Stats, macOS users account for less than 10% of global 
operating systems—much lower than the percentage of Windows users (more 
than 80%). One reason for this is that Apple computers tend to be more expensive. 
However, many people do prefer the look and feel of macOS over Windows. 
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Linux 

Linux (pronounced LINN-ux) is a family of open-source operating systems, which means 
they can be modified and distributed by anyone around the world. This is different 
from proprietary software like Windows, which can only be modified by the company 
that owns it. The advantages of Linux are that it is free, and there are many 
different distributions—or versions—you can choose from. 
According to StatCounter Global Stats, Linux users account for less than 2% of global 
operating systems. However, most servers run Linux because it's relatively easy to 
customize. 
Operating systems for mobile devices 

The operating systems we've been talking about so far were designed to run 
on desktop and laptop computers. Mobile devices such as phones, tablet computers, 
and MP3 players are different from desktop and laptop computers, so they run operating 
systems that are designed specifically for mobile devices. Examples of mobile operating 
systems include Apple iOS and Google Android. In the screenshot below, you can see iOS 
running on an iPad. 
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Operating systems for mobile devices generally aren't as fully featured as those made for 
desktop and laptop computers, and they aren't able to run all of the same software. 
However, you can still do a lot of things with them, like watch movies, browse the Web, 
manage your calendar, and play games. 
 
3.2 Understanding Applications 
What is an application? 

You may have heard people talking about using a program, an application, or an app. But 
what exactly does that mean? Simply put, an app is a type of software that allows you 
to perform specific tasks. Applications for desktop or laptop computers are sometimes 
called desktop applications, while those for mobile devices are called mobile apps. 
When you open an application, it runs inside the operating system until you close it. 
Most of the time, you will have more than one application open at the same time, which 
is known as multi-tasking. 
App is a common term for an application, especially for simple applications that can be 
downloaded inexpensively or even for free. Many apps are also available for mobile 
devices and even some TVs. 
Software  that  can  perform  a  specific  task  for  the  user,  such as  word  processing,  
accounting,  budgeting  or  payroll,  fall under  the  category  of  application  software.  
Word  processors, spreadsheets,  database  management  systems  are  all examples  of  
general  purpose  application  software. Types of application software are: 
Desktop applications 

There are countless desktop applications, and they fall into several categories. Some are 
more full featured (like Microsoft Word), while others may only do one or two 
things (like a clock or calendar app). Below are just a few types of applications you might 
use. 

 Word processors: A word processor allows you to write a letter, design a 
flyer, and create many other types of documents. The most well-known 
word processor is Microsoft Word. 
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 Web browsers: A web browser is the tool you use to access the Internet. 

Most computers come with a web browser pre-installed, but you can also 
download a different one if you prefer. Examples of browsers 
include Internet Explorer, Mozilla Firefox, Google Chrome, and Safari. 

 
 Media players: If you want to listen to MP3s or watch movies you've 

downloaded, you'll need to use a media player. Windows Media 
Player and iTunes are popular media players. 
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 Games: There are many types of games you can play on your computer. 

They range from card games like Solitaire to action games like Halo. Many 
action games require a lot of computing power, so they may not work 
unless you have a newer computer. 

 Database software:  Database is a collection of related data.  The purpose 
of this software is to organize and manage data.  The  advantage  of  this  
software  is  that  you can  Change  the  way  data  is  stored  and  
displayed.  MS access,  dBase,  FoxPro,  Paradox,  and  Oracle  are  some  
of the  examples  of  database  software. 

 Spread sheet software: The spread sheet software is used to  maintain  
budget,  financial  statements,  grade  sheets, and  sales  records.  The 
purpose of this software is organizing numbers.  It  also  allows  the  users  
to  perform simple  or  complex  calculations  on  the  numbers  entered in  
rows  and  columns.  MS-Excel is one of the example of spreadsheet 
software. 

 Presentation  software:  This  software  is  used  to  display the  
information  in  the  form  of  slide  show.  The  three  main functions  of  
presentation  software  is  editing  that  allows insertion  and  formatting  
of  text,  including  graphics  in the  text  and  executing  the  slide  shows.  
The best example for this type of application software is Microsoft 
PowerPoint. 

 Multimedia software:  Media players and real players are the examples of 
multimedia software. This software will allow the user to create audio and 
videos.  The different forms of multimedia software are audio converters, 
players, burners, video encoders and decoders. 

Mobile apps 

Desktop and laptop computers aren't the only devices that can run applications. You can 
also download apps for mobile devices like smartphones and tablets. Here are a few 
examples of mobile apps. 
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 Gmail: You can use the Gmail app to easily view and send emails from 

your mobile device. It's available for Android and iOS devices. 
 Instagram: You can use Instagram to quickly share photos with your 

friends and family. It's available for Android and iOS. 
 Duolingo: With a combination of quizzes, games, and other activities, this 

app can help you learn new languages. It's available for Android and iOS. 
Installing new applications 
Every computer and mobile device will come with some applications already built in, 
such as a web browser and media player. However, you can also purchase and install 
new apps to add more functionality. You can review our lessons on Installing Software on 
Your Windows PC, Installing Software on Your Mac, and Free Software to learn more. 
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Lesson 4: Using a Computer  
4.1 Setting up a Computer 
Setting up a computer 
So you have a new computer and you're ready to set it up. This may seem like an 
overwhelming and complicated task, but it's actually a lot easier than you might think! 
Most computers are set up in a similar way, so it doesn't matter what brand of computer 
you have. 
If you're setting up a new computer that's still in the box, you'll probably find a how-to 
guide that includes step-by-step details. Even if it didn't include instructions, you can still 
set up the computer in a few easy steps. We'll take you through the different steps 
needed to set up a typical computer. 
Setting up a laptop computer 
If you have a laptop, setup should be easy: Just open it and press the power button. If the 
battery isn't charged, you'll need to plug in the AC adapter. You can continue using the 
laptop while it charges. 

 
If your laptop has any peripherals, like external speakers, you may want to read the 
instructions below. Laptops and desktops generally use the same types of connections, 
so the same steps will still apply. 
Setting up a desktop computer 
Step 1 
Unpack the monitor and computer case from the box. Remove any plastic covering or 
protective tape. Place the monitor and computer case on a desk or work area. 
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Be sure to place your computer case in an area that is well ventilated and has good air 
flow. This will help to prevent the computer from overheating. 
Step 2 
Locate the monitor cable. There are several types of monitor cables, so the one for your 
computer may not look like the one in the image below. 

 
If you're having trouble finding your monitor cable, refer to the instruction manual for 
your computer. (If you have an all-in-one computer that's built into the monitor, you can 
skip to Step 4). 
Step 3 
Connect one end of the cable to the monitor port on the back of the computer case and 
the other end to the monitor.  

 
Many computer cables will only fit a specific way. If the cable doesn't fit, don't force it or 
you might damage the connectors. Make sure the plug aligns with the port, then connect 
it. 
To figure out which cables belong in which ports, try our Connecting Cables interactive. 
Step 4 
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Unpack the keyboard and determine whether it uses a USB (rectangular) connector or 
a PS/2 (round) connector. If it uses a USB connector, plug it into any of the USB ports on 
the back of the computer. If it uses a PS/2 connector, plug it into the purple keyboard 
port on the back of the computer. 

 
Step 5 
Unpack the mouse and determine whether it uses a USB or PS/2 connector. If it uses a 
USB connector, plug it into any of the USB ports on the back of the computer. If it uses a 
PS/2 connector, plug it into the green mouse port on the back of the computer. 
If your keyboard has a USB port, you can connect your mouse to the keyboard instead of 
connecting it directly to your computer. 
If you have a wireless mouse or keyboard, you may need to connect a 
Bluetooth dongle (USB adapter) to your computer. However, many computers have built-
in Bluetooth, so an adapter may not be necessary. 
Step 6 
If you have external speakers or headphones, you can connect them to your 
computer's audio port (either on the front or back of the computer case). Many 
computers have color-coded ports. Speakers or headphones connect to the green port, 
and microphones connect to the pink port. The blue port is the line in, which can be 
used with other types of devices. 

 
Some speakers, headphones, and microphones have USB connectors instead of the usual 
audio plug. These can be connected to any USB port. In addition, many computers have 
speakers or microphones built into the monitor. 
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Step 7 
Locate the two power supply cables that came with your computer. Plug the first power 
supply cable into the back of the computer case and then into a surge protector. Then, 
using the other cable, connect the monitor to the surge protector. 

 
You can also use an uninterruptable power supply (UPS), which acts as a surge protector 
and provides temporary power if there is a power outage. 
Step 8 
Finally, plug the surge protector into a wall outlet. You may also need to turn on 
the surge protector if it has a power switch. 

 
If you don't have a surge protector, you can plug the computer directly into the wall. 
However, this is not recommended because electrical surges can damage your computer. 
Step 9 
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If you have a printer, scanner, webcam, or other peripherals, you can connect them at 
this point. Many peripherals are plug and play, which means they will be recognized by 
your computer as soon as they are plugged in. 

 
Other peripherals may include software that needs to be installed before you can begin 
using them. Use the instructions included with the device to install it if necessary. 
Generally, peripherals are optional, and you can add new ones at any time; you don't 
have to add all peripherals during the initial setup of your computer. 
Setup complete! 
That's it—you've finished setting up your computer, so it's time to start using it!  
4.2 Getting Started with Your First Computer 
Getting started with your first computer 

A computer is more than just another household appliance. The vast amount of 
information and possibilities can be overwhelming. But you can accomplish a lot with a 
computer, and using one can be a good experience. Let's walk through getting started 
with your first computer. 
Turning on a computer for the first time can be different from one computer to the next. 
Your experience could be different from this lesson. It's OK to ask someone for help. 
If you're using a desktop computer, you'll need to make sure that the keyboard, mouse, 
and monitor are plugged into the computer case before you continue. Review our lesson 
on Setting Up a Computer to learn how. 
Turning on a computer 

The very first step is to turn on the computer. To do this, locate and press 
the power button. It's in a different place on every computer, but it will have the 
universal power button symbol (shown below). 

 
Once turned on, your computer takes time before it's ready to use. You may see a few 
different displays flash on the screen. This process is called booting up, and it can take 
anywhere from 15 seconds to several minutes. 

http://www.gcflearnfree.org/computerbasics/setting-up-a-computer/1/
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Once the computer has booted up, it may be ready to use, or it may require you to log 
in. This means identifying yourself by typing your user name or selecting your profile, 
then typing your password. If you've never logged in to your computer before, you may 
need to create an account. 

 
The keyboard and mouse 

You interact with a computer mainly by using the keyboard and mouse, or a trackpad on 
laptops. Learning to use these devices is essential to learning to use a computer. Most 
people find it comfortable to place the keyboard on the desk directly in front of them and 
the mouse to one side of the keyboard. 

 
The mouse controls the pointer on the screen. Whenever you move the mouse across 
the desk, the pointer will move in a similar manner. A mouse usually has two buttons, 
which are referred to as the left button and the right button. You will often interact with 
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the computer by moving the mouse pointer over something on the computer screen, 
then clicking one of the buttons. 

 
On laptops, you can use the trackpad, located below the keyboard, instead of a mouse. 
Simply drag your finger across the trackpad to move the pointer on the screen. Some 
trackpads do not have buttons, so you'll either press or tap the trackpad to click. 

 
The keyboard allows you to type letters, numbers, and words into the computer. 
Whenever you see a flashing vertical line—called the cursor—you can start typing. 
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Note that the mouse pointer is also called a cursor, but it is shaped differently. 
The keyboard cursor is also called the insertion point. 
Using a computer 

The main screen you'll start from is the desktop. This is sort of like a main menu or a 
table of contents. From here, you can access the programs and features you need to use 
your computer. 
Icons are used to represent the different files, applications, and commands on your 
computer. An icon is a small image that's intended to give you an idea at a glance of what 
it represents, like a logo. Double-clicking an icon on the desktop will open that 
application or file. 

 
A button is a command that performs a specific function within an application. The most 
commonly used commands in a program will be represented by buttons. 
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Menus are organized collections of commands and shortcuts. Click a menu to open it and 
display the commands and shortcuts within. Then click an item in the menu to execute it. 

 
When you open an application or folder, it is displayed in its own window. A window is a 
contained area—like a picture within a picture—with its own menus and buttons specific 
to that program. You can rearrange multiple windows on the desktop and switch 
between them. 
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4.3 Getting to Know the OS 
Getting to know your computer's OS 

Now that you know the absolute basics of using a computer, it's time to learn more 
about your computer's operating system. We'll be talking about the two most common 
operating systems in this lesson: Microsoft Windows and macOS. 
Getting to know the interface 

Both PCs and Macs use a graphical user interface (GUI), and they each have their own 
look and feel. The interactives below will introduce you to the Windows and Mac 
interfaces. 
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If you have difficulty seeing or hearing—or if you have trouble manipulating the mouse or 
keyboard—there are many settings that can help make your computer easier to use. To 
learn more, check out our lesson on Using Accessibility Features. 
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All about your computers file system 

No matter which operating system you use, your computer uses folders to organize all of 
the different files and applications it contains. Folder icons on your computer are 
designed to look like file folders full of documents or pictures. 

 
Each operating system has its own file system, which helps you find your folders and files. 
If you have a Windows PC, you'll use the File Explorer (also known as Windows Explorer). 
If you have a Mac, you'll use Finder. Here, we'll talk about the basic functions that are 
common to all computer file systems. 
To find out more about file systems on Macs, check out the lesson on Working with 
Files in our macOS Basics tutorial. To learn more about PC file systems, take a look at 
the Working with Files lesson in our Windows Basics tutorial. 
 
Opening your computer's file system 

Whether you're using a PC or a Mac, the file system icon will be on the toolbar. On a PC, 
the File Explorer icon looks like a folder, as in the image below. 

https://edu.gcfglobal.org/en/macosbasics/
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On a Mac, the Finder icon looks like a face on the Dock, as in the image below. 

 
In both operating systems, you can also open the file system by clicking a folder from 
your desktop. 
Basic navigation 

Whether you're using File Explorer or Finder, basic navigation will work the same way. If 
you see the file you want, you can double-click it with your mouse. Otherwise, you can 
use the Navigation pane on the left side of the window to select a different location. 
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Deleting files 

macOS and Windows use a Trash can—or Recycle Bin—to prevent you from accidentally 
deleting files. When you delete a file, it is moved to the Trash can. If you change your 
mind, you can move the file back to its original location. 

 
If you want to permanently delete the file, you will need to empty the Trash or Recycle 
Bin. To do this, right-click the icon and select Empty. 
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Opening files and applications 

Each application on your computer has a group of file types—or formats—it is able to 
open. When you double-click a file, your computer will automatically use the correct 
application to open it. In our example, we're opening a Microsoft Word document (Cover 
Letter), which will open in Microsoft Word. 

 
However, there may be times you may want to open an application directly, instead of 
just opening a file. 

 To open an application in Windows, click the Start button, then select the 
desired application. If you don't see the one you want, you can click All 
Programs/All Apps to see a full list, scroll through the application list in 
Windows 10, or simply type the name of the application on your 
keyboard to search for it. In the example below, we're opening Microsoft 
Edge from the tiles. 
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 To open an application on a Mac, click the application's icon on the Dock. 

If you don't see the one you want, click the Spotlight icon in the top-right 
corner of the screen, then type the name of the application on your 
keyboard to search for it. In the example below, we're opening Safari. 

 
Adjusting your computer's settings 

When you start using a new computer, you may want to begin by adjusting the 
computer's settings. Adjusting your settings can range from simple tasks such as 
changing your desktop background to more advanced tasks like adjusting 
your security or keyboard settings. 

 In Windows 10, click the Start button, then select Settings. 
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 In Windows 8.1 and earlier, click the Start button, then locate and select 

the Control Panel. Check out the Adjusting Your Settings lesson in 
our Windows Basics tutorial to learn more about the Control Panel. 

 
 On a Mac, click the Apple icon, then select System Preferences. Check out 

our Adjusting Your Settings lesson in our macOS Basics tutorial to learn 
more about System Preferences. 
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Shutting down your computer 

When you're done using your computer, it's important to shut it down properly. 
 To shut down Windows, click the Start button, then select Shut 

down from the menu (in some versions, this may say Turn Off 
Computer or look like the power symbol). 
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 To shut down a Mac, click the Apple icon, then select Shut Down. 
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Lesson 5: Working with file and folders 
 All the data for documents and programs on your computer is stored in electronic files. 
These files are then arranged into a series of folders and subfolders—just as you’d 
arrange paper files in a series of file folders in a filing cabinet. 
 
In Windows 10, you use File Explorer to view and manage your folders and files. You can 
navigate to folders and files on your computer and connected devices, or to those on 
other computers on your network. 
5.1 What is a file? 
There are many different types of files you can use. For example, Microsoft Word 
documents, digital photos, digital music, and digital videos are all types of files. You 
might even think of a file as a digital version of a real-world thing you can interact with 
on your computer. When you use different applications, you'll often be viewing, creating, 
or editing files. 
 
Files are usually represented by an icon. In the image below, you can see a few different 
types of files below the Recycle Bin on the desktop. 

 
5.2 What is a folder? 
Windows uses folders to help you organize files. You can put files inside a folder, just like 
you would put documents inside a real folder. In the image below, you can see some 
folders on the desktop. 

 
5.3 File Explorer 
You can view and organize files and folders using a built-in application known as File 
Explorer (called Windows Explorer in Windows 7 and earlier versions). 
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To open File Explorer, click the File Explorer icon on the taskbar, or double-click any 
folder on your desktop. A new File Explorer window will appear. Now you're ready to 
start working with your files and folders. 
 

 
  
 
Launching File Explorer 
From File Explorer, double-click a folder to open it. You can then see all of the files 
stored in that folder. 
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Notice that you can also see the location of a folder in the address bar near the top of 
the window. 

 
 
To open a file: 
There are two main ways to open a file: 

 Find the file on your computer and double-click it. This will open the file 
in its default application. In our example, we'll open a Microsoft Word 
document (Cover Letter.docx), which will open in Microsoft Word. 
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 Open the application, then use the application to open the file. Once the 

application is open, you can go to the File menu at the top of the window 
and select Open. 
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Moving and deleting files 
As you begin using your computer, you will start to collect more and more files, which 
can make it more difficult to find the files you need. Fortunately, Windows allows you 
to move files to different folders and delete files you no longer use. 
To move a file: 
It's easy to move a file from one location to another. For example, you might have a file 
on the desktop that you want to move to your Documents folder. 

1. Click and drag the file to the desired location. 

 
2. Release the mouse. The file will appear in the new location. In this 

example, we have opened the folder to see the file in its new location. 
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You can use this same technique to move an entire folder. Note that moving a folder will 
also move all of the files within that folder. 
To create a new folder: 

1. Within File Explorer, locate and select the new folder button. You can 
also right-click where you want the folder to appear, then select New > 
Folder. 
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2. The new folder will appear. Type the desired name for the folder and 
press Enter. In our example, we'll call it School Documents. 

 
3. The new folder will be created. You can now move files into this folder. 

To rename a file or folder: 
You can change the name of any file or folder. A unique name will make it easier to 
remember what type of information is saved in the file or folder. 

1. Click the file or folder, wait about one second, and click again. An editable 
text field will appear. 

2. Type the desired name on your keyboard and press Enter. The name will 
be changed. 
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You can also right-click the folder and select rename from the menu that appears. 

 
To delete a file or folder: 
If you no longer need to use a file, you can delete it. When you delete a file, it is moved 
to the Recycle Bin. If you change your mind, you can move the file from the Recycle Bin 
back to its original location. If you're sure you want to permanently delete the file, you 
will need to empty the Recycle Bin. 
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1. Click and drag the file to the Recycle Bin icon on the desktop. You can also 
click the file to select it and press the Delete key on your keyboard. 

 
2. To permanently delete the file, right-click the Recycle Bin icon and 

select Empty Recycle Bin. All files in the Recycle Bin will be permanently 
deleted. 

 
Note that deleting a folder will also delete all of the files within that folder. 
Selecting multiple files 
Now that you know the basics, here are a few tips to help you move your files even 
faster. 
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Selecting more than one file 
There are a few ways to select more than one file at a time: 

 If you're viewing your files as icons, you can click and drag the mouse to 
draw a box around the files you want to select. When you're done, 
release the mouse; the files will be selected. You can now move, copy, or 
delete all of these files at the same time. 

 
 To select specific files from a folder, press and hold the Control key on 

your keyboard, then click the files you want to select. 
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 To select a group of files from a folder, click the first file, press and hold 
the Shift key on your keyboard, then click the last file. All of the files 
between the first and last ones will be selected. 

 
Selecting all files 
If you want to select all files in a folder at the same time, open the folder in File Explorer 
and press Ctrl+A (press and hold the Control key on your keyboard, then press A). All of 
the files in the folder will be selected. 
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Ctrl+A is an example of a keyboard shortcut. If working with files and folders feels a little 
tricky right now, don't worry! Like anything else, working with files and folders is largely a 
matter of practice. You'll start to feel more comfortable as you continue using your 
computer.  
 
Shortcuts 
If you have a file or folder you use frequently, you can save time by creating 
a shortcut on the desktop. Instead of navigating to the file or folder each time you want 
to use it, you can simply double-click the shortcut to open it. A shortcut will have a small 
arrow in the lower-left corner of the icon. 
Note that creating a shortcut does not create a duplicate copy of the folder; it's simply a 
way to access the folder more quickly. If you delete a shortcut, it will not delete the 
actual folder or the files it contains. Also note that copying a shortcut onto a flash drive 
will not work; if you want to bring a file with you, you'll need to navigate to the actual 
location of the file and copy it to the flash drive. 
To create a shortcut: 

1. Locate and right-click the desired folder, then select Send to Desktop 
(create shortcut). 
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2. A shortcut to the folder will appear on the desktop. Notice the arrow in 

the lower-left corner of the icon. You can now double-click the shortcut to 
open the folder at any time. 

 
You can also hold the Alt key on your keyboard, then click and drag the folder to the 
desktop to create a shortcut. 
5.4 Finding Files on Your Computer 
Finding files on your computer 
There may be times when you have trouble finding a certain file. If this happens to you, 
don't panic! The file is probably still on your computer, and there are a few simple ways 
to find it. In this lesson, we'll show you different techniques you can use to find your files, 
including searching and looking in common places. 
Common places to look for files 
If you're having a difficult time finding a file, there's a good chance you can find it in one 
of the following places: 
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 Downloads: By default, your computer will place downloaded files in a 
specific folder, known as the Downloads folder. If you're having trouble 
finding a file you downloaded from the Internet, such as a photo attached 
to an email message, this is the first place you should look. To view the 
Downloads folder, open File Explorer, then locate and 
select Downloads (below Favorites on the left side of the window). A list 
of your recently downloaded files will appear. 

 
 Default folders: If you don't specify a location when saving a file, 

Windows will place certain types of files into default folders. For example, 
if you're looking for a Microsoft Word document, you could try looking in 
the Documents folder. If you're looking for a photo, try looking in 
the Pictures folder. Most of these folders will be accessible on the left 
side of the File Explorer window. 
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 Recycle Bin: If you deleted a file by mistake, it may still be in the Recycle 

Bin. You can double-click the Recycle Bin icon on the desktop to open it. If 
you find the file you need, click and drag it back to the desktop or to a 
different folder. 
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Searching for files 
Let's say you recently downloaded a few photos that were attached to an email message, 
but now you're not sure where these files are on your computer. If you're struggling to 
find a file, you can always search for it. Searching allows you to look for any file on your 
computer. 
To search for a file (Windows 10): 
In the Search Box next to the Start button, type to search for a file. The search results will 
appear above the search box. 
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To search for a file (Windows 8): 
Click the Start button to go to the Start screen, then start typing to search for a file. The 
search results will appear on the right side of the screen. Simply click a file or folder to 
open it. 

 
To search for a file (Windows 7 and earlier): 
Click the Start button, type the file name or keywords with your keyboard, and 
press Enter. The search results will appear. Simply click a file or folder to open it. 

 
Tips for finding files 
If you're still having trouble finding the file you need, here are some additional tips. 

 Try different search terms. If you're using the search option, try using 
different terms in your search. For example, if you're looking for a certain 
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Microsoft Word document, try searching for a few different file names 
you might have used when saving the document. 

 Open the last application used to edit the file. If you know you used a 
certain application to edit a file, open that application and select File > 
Open > Recent from the menu. The file may appear in the list of recently 
edited files. 

 
 Move and rename the file after finding it. Once you've located the file, 

you may want to move it to a related folder so you can find it more easily 
in the future. For example, if the file is a picture, you might move it to 
your Pictures folder. You may also want to give it a file name that will be 
easy to remember.  
 

5.5 Common Computer Tasks 
Common computer tasks 
There are some common computer skills that will work the same way in almost any 
situation. Once you learn how to use these skills, you'll be able to use them to perform a 
variety of tasks on your computer. In this lesson, we'll talk about some common 
commands you can use in almost any application, including cut, copy, paste, and undo. 
The Menu bar 
Most applications have a Menu bar at the top of the window. Each menu has a set 
of commands that will perform a specific action within the program. While each 
application is different, there are some common commands that work the same way, no 
matter which application you're using. Whenever you open a program for the first time, 
try clicking these menus to see the various options available. 
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File menu commands 
You'll find the File menu on the leftmost side of the Menu bar in almost every 
application. The File menu will usually have the same type of commands. For example, 
you can create a new file, open an existing file, and save the current file, among other 
functions. 

 
Cut, copy, and paste 
Many applications allow you to copy items from one place and then paste them to 
another. For example, if you're working with a word processor, you might copy and paste 
text to avoid typing the same thing over and over. If there's something you want to move 
from one place to another, you can cut and paste instead. 
To copy and paste: 

1. Select the item you want to copy. In our example, we'll select a word in a 
document. 

2. Right-click the mouse and select Copy from the menu that appears. You 
can also press Ctrl+C on your keyboard. 
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3. Locate and right-click the desired location for the item, then select Paste. 

You can also press Ctrl+V on your keyboard. 

 
4. The item will be copied to the new location. Notice how the original text 

that was copied has not been moved or changed. 
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To cut and paste: 
1. Select the item you want to cut. In our example, we'll select a paragraph 

of text in a document. 
2. Right-click the mouse and select Cut from the menu that appears. You can 

also press Ctrl+X on your keyboard. 

 
3. Locate and right-click the desired location for the item, then select Paste. 

You can also press Ctrl+V on your keyboard. 
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4. The item will be pasted, or moved, to the new location. In our example, 
we used the cut and paste commands to move the second paragraph 
above the first paragraph. 

 
To copy and paste files: 
You can use the cut, copy, and paste commands for a variety of tasks on your computer. 
For example, if you wanted to create a duplicate copy of a file, you could copy it from 
one folder to another. 

1. Right-click the file and select Copy from the menu that appears. You can 
also press Ctrl+C on your keyboard. 
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2. Locate and right-click the new location, then select Paste. You can also 

press Ctrl+V on your keyboard. In our example, we'll paste the file to 
the desktop. 
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3. The duplicate file will appear. Notice how the original file has not been 
moved or changed. Also, note that if you make a change to the original 
file, it will not update any copies of that file. 

 
Copying a file is not the same as creating a shortcut. You can review our lesson 
on Working with Files to learn more about using shortcuts. 
 
Undoing changes 
Let's say you're working on a text document and accidentally delete some text. 
Fortunately, you won't have to retype everything you just deleted! Most applications 
allow you to undo your most recent action when you make a mistake like this. Just 
locate and select the Undo command, which is usually in the upper-left corner of the 
window near the Menu bar. You can also press Ctrl+Z on your keyboard. You can 
continuing using this command to undo multiple changes in a row. 

 
Note that the Undo command will work almost all of the time, but not in every situation. 
For example, if you empty the Recycle Bin to permanently delete a file, you can't undo 
the action. 

Lesson 6: Adjusting Your Settings 
6.1 Adjusting your settings 
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At some point, you may want to adjust your computer's settings. For example, you might 
want to change your desktop background or modify your Internet settings. You can 
change these settings and more from the Control Panel. 
However, in Windows 10, the Control Panel has mostly been replaced by the Settings 
app. The Control Panel is still available, but most of the tasks and settings are now also 
located in the Settings app. 
 To open the Settings app (Windows 10): 
Click the Start button, then select the gear icon. 

 
 
6.2 To open the Control Panel (Windows 10): 
Type Control Panel in the Search Box next to the Start button. Then, select the Control 
Panel app from the menu.   
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To open the Control Panel (Windows 8): 
In Windows 8, you can open the Control Panel directly from the Start screen. Using your 
keyboard, type Control Panel and press the Enter key. 

 
To open the Control Panel (Windows 7 and earlier): 

1. Click the Start button, then select Control Panel. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  87 | 1352  

 
2. The Control Panel will appear. Simply click a setting to adjust it. In this 

example, we'll click Change desktop background to choose a new 
wallpaper for our desktop. 
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Adjusting application settings 
You'll also be able to change the settings for different applications on your computer. 
You will usually find application settings under File > Options, Tools > Options, or within 
a separate Settings menu. Keep in mind that the location will vary, and some applications 
may not have any settings you can change. 
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Lesson 7 Understanding user accounts 
 
A user account allows you to sign in to your computer. By default, your computer already 
has one user account, which you were required to create when you set up your 
computer. If you plan to share your computer with others, you can create a separate user 
account for each person. 
7.1 Why use separate user accounts? 
At this point, you may be wondering why you would even need to use separate user 
accounts. But if you're sharing a computer with multiple people—for example, with your 
family or at the office—user accounts allow everyone to save their own files, 
preferences, and settings without affecting other computer users. When you start your 
computer, you'll be able to choose which account you want to use. 
7.2 Administrator, Standard, and Managed accounts 
Before you create new user accounts, it's important to understand the different types. 

 Administrator: Administrator accounts are special accounts that are used 
for making changes to system settings or managing other people's 
accounts. They have full access to every setting on the computer. Every 
computer will have at least one Administrator account, and if you're the 
owner you should already have a password to this account. 

 Standard: Standard accounts are the basic accounts you use for normal 
everyday tasks. As a Standard user, you can do just about anything you 
would need to do, such as running software or personalizing your 
desktop. 

 Standard with Family Safety: These are the only accounts that can 
have parental controls. You can create a Standard account for each child, 
then go to the Family Safety settings in your Control Panel to set website 
restrictions, time limits, and more. 

Generally, it's safer to be signed in to a Standard account than an Administrator account. 
If you're logged in as an Administrator, it may actually make it easier for an unauthorized 
user to make changes to your computer. Therefore, you may want to create a Standard 
account for yourself, even if you're not sharing the computer with anyone. You'll still be 
able to make Administrator-level changes; you'll just need to provide your Administrator 
password when making these changes. 
7.3 Adding and managing user accounts 
The process for adding and managing user accounts is quite different for each version of 
Windows.  
Switching between user accounts 
If you have multiple user accounts on your computer, it's easy to switch between users 
without signing out or closing your current apps. Switching users will lock the current 
user, so you won't need to worry about someone else accessing your account. 
To switch between user accounts (Windows 10): 
Click the current user icon on the left side of the Start menu, then select the desired 
user from the drop-down menu. The user will then need to enter a password to sign in. 
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To switch between user accounts (Windows 8): 
Click the current user in the upper-right of the Start screen, then select the desired 
user from the drop-down menu. The user will then need to enter a password to sign in. 

 
You can switch back by selecting the desired user from the drop-down menu. You'll need 
to re-enter your password to unlock the account. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  91 | 1352  

 
To switch between user accounts (Windows 7): 
Click the Start button, click the arrow next to Shut Down, and select Switch user. 
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If you're finished using the computer, you can also choose to log off. This will allow other 
users to sign in to the computer with different accounts. 
 
 
 

Lesson 8: Using the Internet 
8.1 Connecting to the Internet 
Once you've set up your computer, you may want to purchase home Internet access so 
you can send and receive email, browse the Web, stream videos, and more. You may 
even want to set up a home wireless network, commonly known as Wi-Fi, so you can 
connect multiple devices to the Internet at the same time. 
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8.2 Types of Internet service 
The type of Internet service you choose will largely depend on which Internet service 
providers (ISPs) serve your area, along with the types of service they offer. Here are 
some common types of Internet service. 

 Dial-up: This is generally the slowest type of Internet connection, and you 
should probably avoid it unless it is the only service available in your area. 
Dial-up Internet uses your phone line, so unless you have multiple phone 
lines you will not be able to use your landline and the Internet at the 
same time. 

 DSL: DSL service uses a broadband connection, which makes it much 
faster than dial-up. DSL connects to the Internet via a phone line but does 
not require you to have a landline at home. And unlike dial-up, you'll be 
able to use the Internet and your phone line at the same time. 

 Cable: Cable service connects to the Internet via cable TV, although you 
do not necessarily need to have cable TV in order to get it. It uses a 
broadband connection and can be faster than both dial-up and DSL 
service; however, it is only available where cable TV is available. 

 Satellite: A satellite connection uses broadband but does not require 
cable or phone lines; it connects to the Internet through satellites 
orbiting the Earth. As a result, it can be used almost anywhere in the 
world, but the connection may be affected by weather patterns. Satellite 
connections are also usually slower than DSL or cable. 

 3G and 4G: 3G and 4G service is most commonly used with mobile 
phones, and it connects wirelessly through your ISP's network. However, 
these types of connections aren't always as fast as DSL or cable. They will 
also limit the amount of data you can use each month, which isn't the 
case with most broadband plans. 

8.3 Choosing an Internet service provider 
Now that you know about the different types of Internet service, you can do some 
research to find out what ISPs are available in your area. If you're having trouble getting 
started, we recommend talking to friends, family members, and neighbors about the ISPs 
they use. This will usually give you a good idea of the types of Internet service available in 
your area. 
Most ISPs offer several tiers of service with different Internet speeds, usually measured 
in Mbps (short for megabits per second). If you mainly want to use the Internet 
for email and social networking, a slower connection (around 2 to 5 Mbps) might be all 
you need. However, if you want to download music or stream videos, you'll want a 
faster connection (at least 5 Mbps or higher). 
You'll also want to consider the cost of the service, including installation charges and 
monthly fees. Generally speaking, the faster the connection, the more expensive it will 
be per month. 
Although dial-up has traditionally been the least expensive option, many ISPs have 
raised dial-up prices to be the same as broadband. This is intended to encourage people 
to switch to broadband. We do not recommend dial-up Internet unless it's your only 
option. 
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8.4 Hardware needed 
Modem 

 
Once you have your computer, you really don't need much additional hardware to 
connect to the Internet. The primary piece of hardware you need is a modem. 
The type of Internet access you choose will determine the type of modem you need. Dial-
up access uses a telephone modem, DSL service uses a DSL modem, cable access uses 
a cable modem, and satellite service uses a satellite adapter. Your ISP may give you a 
modem—often for a fee—when you sign a contract, which helps ensure that you have 
the right type of modem. However, if you would prefer to shop for a better or less 
expensive modem, you can choose to buy one separately. 
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Router 

 
A router is a hardware device that allows you to connect several computers and other 
devices to a single Internet connection, which is known as a home network. Many 
routers are wireless, which allows you to create a home wireless network, commonly 
known as a Wi-Fi network. 
You don't necessarily need to buy a router to connect to the Internet. It's possible to 
connect your computer directly to your modem using an Ethernet cable. Also, many 
modems include a built-in router, so you have the option of creating a Wi-Fi network 
without buying extra hardware. 
8.5 Setting up your Internet connection 

 
Once you've chosen an ISP, most providers will send a technician to your house to turn 
on the connection. If not, you should be able to use the instructions provided by your 
ISP—or included with the modem—to set up your Internet connection. 
After you have everything set up, you can open your web browser and begin using the 
Internet. If you have any problems with your Internet connection, you can call your 
ISP's technical support number. 
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Home networking 

 
If you have multiple computers at home and want to use all of them to access the 
Internet, you may want to create a home network, also known as a Wi-Fi network. In a 
home network, all of your devices connect to your router, which is connected to 
the modem. This means everyone in your family can use the Internet at the same time. 
Your ISP technician may be able to set up a home Wi-Fi network when installing your 
Internet service. 
8.6 Getting Started with the Internet 
Getting started with the Internet 

The Internet is a global network of billions of computers and other electronic devices. 
With the Internet, it's possible to access almost any information, communicate with 
anyone else in the world, and much more. You can do all of this on your computer. 
Connecting to the Internet 

A device has to be connected to the Internet before you can access it. If you plan to use 
the Internet at home, you'll usually need to purchase an Internet connection from 
an Internet service provider, which will likely be a phone company, Cable Company, or 
the government. Other devices usually connect through Wi-Fi or cellular 
Internet connections. Sometimes libraries, cafes, and schools offer free Wi-Fi for their 
patrons, customers, and students. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  97 | 1352  

 
Browsing the web 

Most information on the Internet is on websites. Once you are connected to the 
Internet, you can access websites using a kind of application called a web browser. 
A website is a collection of related text, images, and other resources. Websites can 
resemble other forms of media—like newspaper articles or television programs—or they 
can be interactive in a way that's unique to computers. The purpose of a website can be 
almost anything: a news platform, an advertisement, an online library, a forum for 
sharing images, or an educational site like us! 
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A web browser allows you to connect to and view websites. The web browser itself is not 
the Internet, but it displays pages on the Internet. Each website has a unique address. By 
typing this address into your web browser, you can connect to that website and your 
web browser will display it. 
Navigating websites 

Websites often have links to other sites, also called hyperlinks. These are often parts of 
the text on the website. They are usually colored blue, and sometimes they are 
underlined or bold. If you click the text, your browser will load a different page. Web 
authors use hyperlinks to connect relevant pages. This web of links is one of the most 
unique features of the Internet, lending to the old name World Wide Web. 
Each website has a unique address, called a URL. You'll notice that when you click a link, 
the URL changes as your browser loads a new page. If you type a URL in the address bar 
in your browser, your browser will load the page associated with that URL. It's like a 
street address, telling your browser where to go on the Internet. 
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When you're looking for specific information on the Internet, a search engine can help. A 
search engine is a specialized website that's designed to help you find other websites. If 
you type keywords or a phrase into a search engine, it will display a list of websites 
relevant to your search terms. 
Other things you can do on the Internet 

One of the best features of the Internet is the ability to communicate almost instantly 
with anyone in the world. Email is one of the oldest and most universal ways to 
communicate and share information on the Internet, and billions of people use it. Social 
media allows people to connect in a variety of ways and build communities online. 
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There are many other things you can do on the Internet too. There are thousands of ways 
to keep up with news or shop for anything online. You can pay your bills, manage your 
bank accounts, meet new people, watch TV, or learn new skills. You can learn or do 
almost anything online. 
 
8.7 Understanding the Cloud 
What is the cloud? 

You may have heard people using terms like the cloud, cloud computing, or cloud 
storage. But what exactly is the cloud? 
Simply put, the cloud is the Internet—more specifically, it's all of the things you can 
access remotely over the Internet. When something is in the cloud, it means it's stored 
on Internet servers instead of your computer's hard drive. 
Why use the cloud? 

Some of the main reasons to use the cloud are convenience and reliability. For example, 
if you've ever used a web-based email service, such as Gmail or Yahoo! Mail, you've 
already used the cloud. All of the emails in a web-based service are stored on servers 
rather than on your computer's hard drive. This means you can access your email from 
any computer with an Internet connection. It also means you'll be able to recover your 
emails if something happens to your computer. 
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Let's look at some of the most common reasons to use the cloud. 

 File storage: You can store all types of information in the cloud, including 
files and email. This means you can access these things from any 
computer or mobile device with an Internet connection, not just your 
home computer. Dropbox and Google Drive are some of the most 
popular cloud-based storage services. 
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 File sharing: The cloud makes it easy to share files with several people at 

the same time. For example, you could upload several photos to a cloud-
based photo service like Flickr or iCloud Photos, then quickly share them 
with friends and family. 

 
 Backing up data: You can also use the cloud to protect your files. There 

are apps such as Carbonite that automatically back up your data to the 
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cloud. This way, if your computer ever is lost, stolen, or damaged, you'll 
still be able to recover these files from the cloud. 

 
What is a web app? 

Previously, we talked about how desktop applications allow you to perform tasks on 
your computer. But there are also web applications—or web apps—that run in the 
cloud and do not need to be installed on your computer. Many of the most popular sites 
on the Internet are actually web apps. You may have even used a web app without 
realizing it! Let's take a look at some popular web apps. 

 Facebook: Facebook lets you create an online profile and interact with 
your friends. Profiles and conversations can be updated at any time, so 
Facebook uses web app technologies to keep the information up to date. 
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 Pixlr: Pixlr is an image editing application that runs in your web browser. 
Much like Adobe Photoshop, it includes many advanced features, like 
color correction and sharpening tools. 
 

 
 Google Docs: Google Docs is an office suite that runs in your browser. 

Much like Microsoft Office, you can use it to 
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create documents, spreadsheets, presentations, and more. And because 
the files are stored in the cloud, it's easy to share them with others. 

 
 
 

Lesson 9: Keyboard shortcuts in Windows 
Keyboard shortcuts are keys or a combination of keys you can press on your keyboard to 
perform a variety of tasks. Using keyboard shortcuts is often faster than using a mouse 
because you can keep both hands on the keyboard. Keyboard shortcuts are also 
universal, which means you can use many of the same shortcuts in a variety of 
applications. For example, you can use the shortcuts to copy and paste text in a word 
processor and in a web browser. 
9.1 Using shortcuts 
 
Many keyboard shortcuts require you to press two or more keys in a specific order. For 
example, to perform the shortcut Ctrl+X, you would press and hold the Ctrl key, then 
press the X key, then release. 
You'll use the Ctrl (Control) or Alt key to perform most keyboard shortcuts. You'll find 
these keys near the bottom-left corner of your keyboard. 
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9.2 Working with text 
These keyboard shortcuts are useful when working with text in word processors, email 
applications, and more. They can help you perform commonly repeated tasks, 
like copying and pasting text. 

 Ctrl+X: Cut the selected text. 
 Ctrl+C: Copy the selected text. 
 Ctrl+V: Paste the copied or cut text. 
 Ctrl+A: Select all of the text on the page or in the active window. 

 
 Ctrl+B: Bold the selected text. 

 Ctrl+I: Italicize the selected text. 

 Ctrl+U: Underline the selected text. 
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9.3 Working with files and applications 
You can use keyboard shortcuts to open, close, and switch applications. When working 
with a file, like a Microsoft Word document, shortcuts can be used to create new 
files, find words, and print. 

 Ctrl+Alt+Delete: Force an unresponsive or frozen program to quit. This 
keyboard shortcut opens the Task Manager. You can then select the 
unresponsive application and close it. 

 
 Delete: Send a selected file or files to the Recycle Bin. 
 Enter: Open a selected application or file. 
 Ctrl+N: Create a new file. 
 Ctrl+O: Open an existing file. 
 Ctrl+S: Save the current file. 
 Ctrl+Z: Undo the previous action. If you want to redo the action, 

press Ctrl+Y. 
 Windows key: Open the Start menu (or the Start screen in Windows 8). 

 
9.4 Internet shortcuts 
Keyboard shortcuts can also be used to navigate your web browser. Many of the text 
shortcuts above are also useful online, like the shortcuts for selecting, copying, 
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and pasting text into your web browser's address bar. Note that some of these shortcuts 
may work a bit differently depending on the web browser you're using. 

 Ctrl+N: Open a new browser window. 
 Ctrl+T: Open a new browser tab. 

 
 Ctrl+D: Bookmark the current page. 
 Ctrl+B: View bookmarks. 
 Ctrl+J: View recently downloaded files. 

 
9.5 Using the Alt key to navigate menus 
When you press the Alt key, you will have access to all of the menus in the current 
application. This means you can perform almost any task with just your keyboard. For 
example, you can type Alt+F+X to quit an application. When performing these shortcuts, 
you will not need to hold down the Alt key. 
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9.6 Finding more keyboard shortcuts 
In many applications, you'll find keyboard shortcuts next to menu items. 

 
In some applications, you may need to hover over a button to display its keyboard 
shortcut. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  110 | 1352  

 
 

Lesson 10: Safety and Maintenance 
10.1 Keeping Your Computer Clean 
Keeping your computer physically clean 
Dust isn't just unattractive—it can potentially damage or even destroy parts of your 
computer. Cleaning your computer regularly will help you keep it working properly and 
avoid expensive repairs. 
Cleaning the keyboard 

Dust, food, liquid, and other particles can get stuck underneath the keys on your 
keyboard, which can prevent it from working properly. The basic cleaning tips below can 
help keep your keyboard clean. 

1. Unplug the keyboard from the USB or PS/2 port. If the keyboard is 
plugged into the PS/2 port, you will need to shut down the computer 
before unplugging it. 

2. Turn the keyboard upside down and gently shake it to remove dirt and 
dust. 

3. Use a can of compressed air to clean between the keys. 
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4. Moisten a cotton cloth or paper towel with rubbing alcohol and use it to 

clean the tops of the keys. Do not pour alcohol or any other liquid directly 
onto the keys. 

 
5. Reconnect the keyboard to the computer once it is dry. If you are 

connecting it to a PS/2 port, you will need to connect it before turning on 
the computer. 

Dealing with liquids 

If you spill liquid on the keyboard, quickly shut down the computer and disconnect the 
keyboard. Then turn the keyboard upside down and allow the liquid to drain. 
If the liquid is sticky, you will need to hold the keyboard on its side under running water 
to rinse away the sticky liquid. Then turn the keyboard upside down to drain for two days 
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before reconnecting it. Please note that the keyboard may not be fixable at this point, 
but the method above is probably the best option. 
To prevent this situation altogether, we recommend keeping drinks away from the 
computer area. 
Cleaning the mouse 

There are two main mouse types: optical and mechanical. Each is cleaned in basically the 
same way, although the mechanical mouse requires a bit more work. 

 Optical mice require no internal cleaning because they do not contain 
any rotating parts; however, they can get sticky over time as dust collects 
near the light emitter. This can cause erratic cursor movement or prevent 
the mouse from working properly. 

 
 Mechanical mice are especially susceptible to dust and particles that can 

accumulate inside the mouse, which can make it difficult to track—or 
move—properly. If the mouse pointer does not move smoothly, the 
mouse may need to be cleaned. 
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The basic cleaning tips below will help keep your mouse clean: 

1. Unplug the mouse from the USB or PS/2 port. If the mouse is plugged into 
the PS/2 port, you will need to shut down the computer before 
unplugging it. 

2. Moisten a cotton cloth with rubbing alcohol, and use it to clean the top 
and bottom of the mouse. 

3. If you have a mechanical mouse, remove the tracking ball by turning 
the ball-cover ring counter-clockwise. Then clean the tracking ball and the 
inside of the mouse with a cotton cloth moistened with rubbing alcohol. 

4. Allow all of the parts to dry before reassembling and reconnecting the 
mouse. If you are connecting it to a PS/2 port, you will need to connect 
it before turning on the computer. 

If you just want to give the mouse a quick cleaning, place it on a clean sheet of 
paper and move the mouse back and forth. Some of the dust and particles should rub 
off onto the paper. 
 
Cleaning the monitor 

Dirt, fingerprints, and dust can make your computer screen difficult to read; however, it's 
easy to clean your screen when needed. There are monitor-cleaning kits you can buy, but 
they may damage your monitor if they're designed for a different type of monitor. For 
example, a monitor cleaner that is designed for glass screens may not work with 
some non-glass LCD screens. The safest method is simply to use a soft clean 
cloth moistened with water. 
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Do not use glass cleaner to clean a monitor. Many screens have anti-glare coatings that 
can be damaged by glass cleaner. 

1. Turn off the computer. 
2. Unplug the monitor from the power. If you are using a laptop, unplug the 

laptop. 
3. Use a soft clean cloth moistened with water to wipe the screen clean. 

Do not spray any liquids directly onto the screen. The liquid could leak into the monitor 
and damage the internal components. 
Tips for cleaning other computer surfaces 

From time to time, you should clean your computer case and the sides and back of the 
monitor to avoid a buildup of dust and dirt. Here are a few tips you can use when 
cleaning these surfaces. 

 Dust is your computer's main enemy. Use an anti-static cloth to lightly 
dust your computer casing. Do not use furniture cleaners or strong 
solvents. 

 Use a can of compressed air to blow out debris from the air intake slots. 
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 Ammonia diluted with water—or glass cleaner comprised mostly of 

ammonia and water—is a safe cleaning solution for computer surfaces. 
The milder the solution, the better. 

 Clean the monitor housing and case (but not the monitor screen) by 
spraying a safe cleaning solution onto a paper towel or anti-static cloth 
and wiping in a downward motion. 

 
Keep it cool 

Don't restrict airflow around your computer. A computer can generate a lot of heat, so 
the casing has fans that keep it from overheating. Avoid stacking papers, books, and 
other items around your computer. 
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Many computer desks have an enclosed compartment for the computer case. If you 
have this type of desk, you may want to position the case so it is not against the back side 
of the desk. If the compartment has a door, you may want to leave it open to improve 
airflow. 
10.2 Protecting Your Computer 
Your computer faces many potential threats, including viruses, malware, and hard drive 
failure. This is why it's important to do everything you can to protect your computer and 
your files. 
Safeguarding against malware 

Malware is any type of software that is designed to damage your computer or 
gain unauthorized access to your personal information. It 
includes viruses, worms, Trojan horses, and spyware. Most malware is distributed over 
the Internet and is often bundled with other software. 
The best way to guard against malware is to install antivirus software, such 
as Bitdefender, Norton, or Kaspersky. Antivirus software helps to prevent malware from 
being installed, and it can also remove malware from your computer. 

http://www.bitdefender.com/
http://us.norton.com/index.jsp
http://usa.kaspersky.com/products-services/home-computer-security/anti-virus
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It's also important to stay smart when you're browsing the Web or using email. If a 
website or email attachment looks suspicious, trust your instincts. Keep in mind that your 
antivirus program may not catch everything, so it's best to avoid downloading anything 
that might contain malware. 
To learn more about protecting your computer from malware, check out How to Avoid 
Malware in our Internet Safety tutorial. 
Backing up your computer 

Imagine what would happen if your computer suddenly stopped working. Would you lose 
any important documents, photos, or other files? It may be possible to repair your 
computer, but your files may be lost forever. Luckily, you can prevent this by 
creating backup copies of all of your files (or just the important ones) on an external 
hard drive or an online backup service. 
External hard drives 

http://www.gcflearnfree.org/internetsafety/how-to-avoid-malware/1/
http://www.gcflearnfree.org/internetsafety/how-to-avoid-malware/1/
http://www.gcflearnfree.org/internetsafety
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You can purchase an external hard drive and copy the contents of your computer to it. 
The initial backup could take several hours, so you will need to select a period of time 
when you do not need access to your computer. Running the backup overnight usually 
works best. Follow-up backups should be conducted on a regular basis, but they should 
not take as long. 
One drawback is that an external hard drive can be lost, damaged, or stolen—just as your 
computer might be. This is why it's important to keep your drive in a secure 
location when not in use. 
Online backup services 

 
You can also back up your files to an online backup service like Mozy, Carbonite, or Box. 
These services will back up your your files in the cloud, which means you'll be able to 
recover them from any computer with an Internet connection. The amount of storage 

http://mozy.com/home
http://www.carbonite.com/
http://www.box.net/
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provided by these sites varies, and you will probably need to pay a fee for adequate 
storage space. 
One drawback to online backup services is that the initial backup can be slow and may 
even take days to upload if you have a lot of files. However, subsequent backups should 
not take as long. 
 
Other maintenance techniques 

To keep your computer running smoothly, it's important to keep files and 
folders uncluttered. Cluttered or unorganized folders make it more difficult to find the 
files you need. Additionally, unwanted files can eventually fill up your hard drive, which 
will make your computer slower and more difficult to use. Here are a few things you can 
do to delete unwanted files and improve your computer's performance. 

 Delete files: If you have any unwanted files, you can delete them 
manually. To do this, drag them to the Recycle Bin or Trash, then empty it 
to permanently delete the files. 

 Run the Disk Defragmenter: Windows includes a Disk 
Defragmenter program in the Control Panel. If your computer is running 
slowly, running Disk Defragmenter can help to speed it up. 

 
 Run a Disk Cleanup: Windows also includes a Disk Cleanup program in the 

Control Panel. It scans your computer for temporary files and other files 
that can be deleted. You can then delete the files to free up space on your 
hard drive. 
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10.3 Creating a Safe Workspace 
In addition to keeping your computer healthy, it's important to think about your own 
health. Using a computer involves a lot of repetitive motions such as typing and using the 
mouse. Over time, these motions can begin to negatively impact your body, especially 
your wrists, neck, and back. Staring at a monitor for long periods of time can also cause 
eye strain. To minimize these risks, you should take a few moments to make sure your 
workspace is arranged in a comfortable and healthy way. 
Avoiding strain and injury: 
Computer ergonomics 

Computer ergonomics is the science of equipment design and how specific equipment 
usage and placement can reduce a user's discomfort and increase productivity. Some 
equipment is designed with special attention to ergonomics, like ergonomic 
keyboards and ergonomic chairs. 
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Here are a few tips to help you avoid injury in your workspace. 

 Adjust your chair: Make sure your chair is adjusted to allow you to sit in a 
natural, comfortable position. Many office chairs are specially designed 
to support the lower back and promote good posture. 

 
 Keep the keyboard at a comfortable height: Try to place the keyboard in 

a position that allows you to keep your wrists straight and relaxed to 
avoid wrist strain. Many desks have a keyboard tray that can keep the 
keyboard at a better height. You can also buy an ergonomic 
keyboard that is designed to minimize wrist strain. 
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 Keep the mouse close to the keyboard: If possible, place the mouse right 

next to the keyboard. If the mouse is too far away, it may be 
uncomfortable or awkward to reach for it. 

 Place the monitor at a comfortable distance: The ideal position for a 
monitor is 20 to 40 inches away from your eyes. It should also be at eye 
level or slightly lower. 

 
 Avoid clutter: The computer area can quickly become cluttered with 

paper, computer accessories, and other items. By keeping this area as 
uncluttered as possible, you can improve your productivity and prevent 
strain and injury. 
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 Take frequent breaks: It's important to take breaks while you're working 
at your computer. To avoid eye strain, you should look away from the 
monitor every once in a while. You can also stand up and walk around to 
avoid sitting in the same position for long periods of time. Programs such 
as Work rave can automatically remind you to take breaks. 

 
For more information on setting up a computer workspace, visit the Computer 
Workstations eTool from the Occupational Safety & Health Administration (OSHA). 
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10.4 Basic Troubleshooting Techniques 
Troubleshooting 

Do you know what to do if your screen goes blank? What if you can't seem to close an 
application, or can't hear any sound from your speakers? Whenever you have a problem 
with your computer, don't panic! There are many basic troubleshooting techniques you 
can use to fix issues like this. In this lesson, we'll show you some simple things to try 
when troubleshooting, as well as how to solve common problems you may encounter. 
General tips to keep in mind 

There are many different things that could cause a problem with your computer. No 
matter what's causing the issue, troubleshooting will always be a process of trial and 
error—in some cases, you may need to use several different approaches before you can 
find a solution; other problems may be easy to fix. We recommend starting by using the 
following tips. 

 Write down your steps: Once you start troubleshooting, you may want 
to write down each step you take. This way, you'll be able to remember 
exactly what you've done and can avoid repeating the same mistakes. If 
you end up asking other people for help, it will be much easier if they 
know exactly what you've tried already. 

 Take notes about error messages: If your computer gives you an error 
message, be sure to write down as much information as possible. You 
may be able to use this information later to find out if other people are 
having the same error. 

 Always check the cables: If you're having trouble with a specific piece of 
computer hardware, such as your monitor or keyboard, an easy first step 
is to check all related cables to make sure they're properly connected. 

 
 Restart the computer: When all else fails, restarting the computer is a 

good thing to try. This can solve a lot of basic issues you may experience 
with your computer. 

Using the process of elimination 

If you're having an issue with your computer, you may be able to find out what's wrong 
using the process of elimination. This means you'll make a list of things that could be 
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causing the problem and then test them out one by one to eliminate them. Once you've 
identified the source of your computer issue, it will be easier to find a solution. 
Scenario: 

Let's say you're trying to print out invitations for a birthday party, but the printer won't 
print. You have some ideas about what could be causing this, so you go through them 
one by one to see if you can eliminate any possible causes. 
First, you check the printer to see that it's turned on and plugged in to the surge 
protector. It is, so that's not the issue. Next, you check to make sure the printer's ink 
cartridge still has ink and that there is paper loaded in the paper tray. Things look good 
in both cases, so you know the issue has nothing to do with ink or paper. 
Now you want to make sure the printer and computer are communicating correctly. If 
you recently downloaded an update to your operating system, it might interfere with 
the printer. But you know there haven't been any recent updates and the printer was 
working yesterday, so you'll have to look elsewhere. 
You check the printer's USB cord and find that it's not plugged in. You must have 
unplugged it accidentally when you plugged something else into the computer earlier. 
Once you plug in the USB cord, the printer starts working again. It looks like this printer 
issue is solved! 
This is just one example of an issue you might encounter while using a computer. In the 
rest of this lesson, we'll talk about other common computer problems and some ways to 
solve them. 
Simple solutions to common problems 

Most of the time, problems can be fixed using simple troubleshooting techniques, 
like closing and reopening the program. It's important to try these simple solutions 
before resorting to more extreme measures. If the problem still isn't fixed, you can try 
other troubleshooting techniques. 
Problem: Power button will not start computer 

 Solution 1: If your computer does not start, begin by checking the power 
cord to confirm that it is plugged securely into the back of the computer 
case and the power outlet. 

 Solution 2: If it is plugged into an outlet, make sure it is a working outlet. 
To check your outlet, you can plug in another electrical device, such as a 
lamp. 

 Solution 3: If the computer is plugged in to a surge protector, verify that it 
is turned on. You may have to reset the surge protector by turning it off 
and then back on. You can also plug a lamp or other device into the surge 
protector to verify that it's working correctly. 
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 Solution 4: If you are using a laptop, the battery may not be charged. Plug 

the AC adapter into the wall, then try to turn on the laptop. If it still 
doesn't start up, you may need to wait a few minutes and try again. 

Problem: An application is running slowly 

 Solution 1: Close and reopen the application. 
 Solution 2: Update the application. To do this, click the Help menu and 

look for an option to check for Updates. If you don't find this option, 
another idea is to run an online search for application updates. 

 
Problem: An application is frozen 

Sometimes an application may become stuck, or frozen. When this happens, you won't 
be able to close the window or click any buttons within the application. 

 Solution 1: Force quit the application. On a PC, you can press (and 
hold) Ctrl+Alt+Delete (the Control, Alt, and Delete keys) on your keyboard 
to open the Task Manager. On a Mac, press and 
hold Command+Option+Esc. You can then select the unresponsive 
application and click End task (or Force Quit on a Mac) to close it. 
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 Solution 2: Restart the computer. If you are unable to force quit an 

application, restarting your computer will close all open apps. 
Problem: All programs on the computer run slowly 

 Solution 1: Run a virus scanner. You may have malware running in the 
background that is slowing things down. 

 
 Solution 2: Your computer may be running out of hard drive space. 

Try deleting any files or programs you don't need. 
 Solution 3: If you're using a PC, you can run Disk Defragmenter. To learn 

more about Disk Defragmenter, check out our lesson on Protecting Your 
Computer. 
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Problem: The computer is frozen 

Sometimes your computer may become completely unresponsive, or frozen. When this 
happens, you won't be able to click anywhere on the screen, open or close applications, 
or access shut-down options. 

 Solution 1 (Windows only): Restart Windows Explorer. To do this, press 
and hold Ctrl+Alt+Delete on your keyboard to open the Task Manager. 
Next, locate and select Windows Explorer from the Processes tab and 
click Restart. You may need to click More Details at the bottom of the 
window to see the Processes tab. 

 
 Solution 2 (Mac only): Restart Finder. To do this, press and 

hold Command+Option+Esc on your keyboard to open the Force Quit 
Applications dialog box. Next, locate and select Finder, then 
click Relaunch. 
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 Solution 3: Press and hold the Power button. The Power button is usually 

located on the front or side of the computer, typically indicated by 
the power symbol. Press and hold the Power button for 5 to 10 
seconds to force the computer to shut down. 

 Solution 4: If the computer still won't shut down, you can unplug the 
power cable from the electrical outlet. If you're using a laptop, you may 
be able to remove the battery to force the computer to turn off. Note: 
This solution should be your last resort after trying the other suggestions 
above. 

Problem: The mouse or keyboard has stopped working 

 Solution 1: If you're using a wired mouse or keyboard, make sure it's 
correctly plugged into the computer. 
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 Solution 2: If you're using a wireless mouse or keyboard, make sure it's 

turned on and that its batteries are charged. 
Problem: The sound isn't working 

 Solution 1: Check the volume level. Click the audio button in the top-right 
or bottom-right corner of the screen to make sure the sound is turned on 
and that the volume is up. 

 Solution 2: Check the audio player controls. Many audio and video players 
will have their own separate audio controls. Make sure the sound is 
turned on and that the volume is turned up in the player. 

 Solution 3: Check the cables. Make sure external speakers are plugged in, 
turned on, and connected to the correct audio port or a USB port. If your 
computer has color-coded ports, the audio output port will usually 
be green. 

 Solution 4: Connect headphones to the computer to find out if you can 
hear sound through the headphones. 
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Problem: The screen is blank 

 Solution 1: The computer may be in Sleep mode. Click the mouse or press 
any key on the keyboard to wake it. 

 Solution 2: Make sure the monitor is plugged in and turned on. 
 Solution 3: Make sure the computer is plugged in and turned on. 
 Solution 4: If you're using a desktop, make sure the monitor cable is 

properly connected to the computer tower and the monitor. 
Solving more difficult problems 

If you still haven't found a solution to your problem, you may need to ask someone else 
for help. As an easy starting point, we'd recommend searching the Web. It's possible that 
other users have had similar problems, and solutions to these problems are often posted 
online. Also, if you have a friend or family member who knows a lot about computers, 
they may be able to help you. 
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Keep in mind that most computer problems have simple solutions, although it may take 
some time to find them. For difficult problems, a more drastic solution may be required, 
like reformatting your hard drive or reinstalling your operating system. If you think you 
might need a solution like this, we recommend consulting a professional first. If you're 
not a computer expert, it's possible that attempting these solutions could make the 
situation worse. 

Lesson 11: Extras 
11.1 How to Use Your Computer's Built-in Help 
How to use your computer's built-in help 
Everyone needs to look for help sometimes. Luckily, when you want help with a 
computer program, it’s usually easy to find. Most programs have a help feature 
somewhere, and learning how to use it can make a big difference. You may not find 
everything you need, but your computer’s built-in help is a great place to start. 
Different programs integrate help features in different ways. Some are like interactive 
manuals included with the program that you can open with a menu, while others are just 
links to the developer’s support website. But they’re always designed with the same 
thing in mind: to help you learn the features of the program and to solve problems 
yourself. 
How to access built-in help 

Most programs have one of two ways to access built-in help. For example, Adobe 
Photoshop Elements has a Help menu with a variety of options. Many of these options 
open Adobe’s support page in your web browser, while others access features within the 
program itself. 

 
Other programs have a help button. For example, Microsoft Office 2016 has the Help tab 
with a Help button to open a search. 
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Features of a help file 

Help files can be organized in a variety of ways, including as a table of contents, FAQ, or 
searchable database. 
When you open the help panel in Office 2016, you'll see a search box. Much like a search 
engine, you type keywords in the search bar, and it will display topics relevant to the 
keywords you entered. 
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The table of contents for Mozilla’s support page is a broad list of categories. Clicking any 
of these hyperlinks will lead to a list of narrower topics and specific help articles. There’s 
also a search bar to help you. 
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Although built-in help can be useful, it may not always have the information you want. If 
you can’t find what you’re looking for or don’t understand what you've found, you can 
usually ask someone you know, do a Google search, or contact support staff. It can take a 
little extra time and effort, but learning how to find solutions on your own is a valuable 
skill—and you’ll get better at it with practice. 
 
11.2 Learning a New Program 
Learning a new program 

You ask a friend who is good with computers to help you do something in a new program. 
The friend says she hasn't used the program before, but will give it a try. Two minutes 
later, she's figured out what to do. 
How did she do that? If you've experienced a situation like the one just described, it 
might seem like magic. But your friend probably just applied what she knew about 
computers and computer programs to the program you were trying to use. In this lesson, 
we'll show you how you can do the same thing. 
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You know more than you think you do! 

Starting to use a new computer program can seem overwhelming, but keep in mind that 
you already know more than you think you know. Even if the screen in front of you looks 
totally unfamiliar, everything you've learned so far about your computer and other 
programs will help you figure out what to do next. As you spend more time using the new 
program, it will start to feel more familiar. 
Look for similarities with programs you've used 

The first thing you'll want to do when opening a new program is look for familiar 
features. You may not realize it, but most computer programs have certain basic features 
in common—so once you've learned to use one program, you'll already know something 
about any other ones you try to use. For example, many keyboard shortcuts remain the 
same from program to program. 
Most programs also have File and Edit menus, and they'll usually be in the same place: at 
the top of your screen, either as a drop-down menu or in a ribbon. The File and Edit 
menus tend to contain similar functions in any program. So if you know the Print function 
appears in the File menu in Microsoft Word, you'll have a good idea of where to look for 
it in Google Docs, as in the image below. 
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Even if you're switching from a PC to a Mac or vice versa, keyboard shortcuts will remain 
mostly the same. Just substitute the Command key on a Mac for the Ctrl key on a PC. For 
example, the shortcut for the Cut function is Ctrl+X on a PC; on a Mac, it's Command+X. 
Check for hidden toolbars or panels 

Let's say you've checked your new program for familiar functions, but there are a few 
you just can't find. Don't give up! If you believe a particular function should be there, 
you're probably right—you may just need to open it. Many programs 
have toolbars, sidebars, or panels you can hide or make visible, and they are often 
hidden by default when you start the program. If you can't find a function you need, try 
clicking the View or Window menu to check for hidden toolbars, as shown in the image 
of the Firefox web browser below. 

 
If you're having trouble 

If the program you're trying to use has a lot of unfamiliar elements—or if there's a 
feature you simply don't know how to use—don't despair. There are still some simple 
things you can do to find your way around a program. 
Use the help feature 

Software companies know that most users will have questions about how to use their 
programs, which is why they include built-in help features. You can usually access a 
program's help feature by clicking a Help menu (sometimes represented by a question 
mark icon) at the top of your screen. There, you'll find instructions on how to do 
things, troubleshooting tips, and answers to frequently asked questions. Some help 
features will even include links to online help forums, where users can post answers to 
each other's questions. Remember, if something isn't obvious to you, it probably isn't 
obvious to other users either, so the help section should have some information on it. 
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Google it! 

If you haven't found the answer in the program's help feature, try searching for a 
solution on Google. You will probably find tutorials or posts from other users explaining 
how to use the program. You may also want to search YouTube for video tutorials on the 
program you're using. 
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11.3 Common applications in Windows 
 
Windows comes with several useful applications already installed. These applications can 
help you with many common tasks, including browsing the Internet, managing your 
calendar, and shopping for music. 
Most of these apps can be opened by clicking the Start button, then clicking the icon of 
the app you want to open. You may need to navigate the Start menu to find the app 
you're looking for.  
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Web browsers 
Microsoft Edge replaces Internet Explorer in Windows 10 but serves the same function. It 
has a few new features over Internet Explorer, including an option to display webpages in 
an easy-to-read format, better security, and integration with other parts of Windows 10. 
 

 
Internet Explorer is one of the most well-known applications on the Internet, primarily 
because it has come bundled with many versions of Windows for the past 20 years. It has 
a simple interface and most standard web browser features, including bookmarking your 
favorite websites.  

http://www.gcflearnfree.org/internet/internetexplorer
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Productivity 
Windows 8 and Windows 10 include several productivity apps that can help you with 
daily tasks, like managing your email and calendars, finding directions, and organizing 
notes. 
Mail and Calendar are apps that connect your accounts with other services, such as 
Microsoft, Google, and Apple. They synchronize your mailboxes and calendars within 
these services and display them in a single window on your computer. 
Maps, an app powered by Bing Maps, gives you access to all of the same navigation and 
search features. It adds a few other features as well, like pinning locations and saving 
directions on all of your Windows devices. 

 
OneNote is the advanced note organization software originally included with Microsoft 
Office, but now it's a default app in Windows 10. OneNote lets you create a collection of 
notes that you can then search and share. 
Media 
Photos, introduced in Windows 8, is a digital photo organizer that helps you store, sort, 
and display photos on your computer. It also includes features for editing, online storage, 
and sharing to social media. 
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Groove Music and Movies & TV are apps included with Windows 10 that access 
Microsoft's online media services. Groove Music can play music stored on your computer 
and OneDrive, and it can stream online music with the purchase of a monthly 
subscription. You can play video files stored on your computer with Movies & TV, and 
you can use it to shop for movies and TV shows online as well. 
Windows Media Player is Microsoft's default basic media player that has come with 
most versions of Windows. It can play most types of audio and video files stored on your 
computer. 
Settings 
The Control Panel is where you can adjust your computer's settings and configurations. 
The Settings app, introduced in Windows 8, gives you access to most of your computer's 
settings but is designed in a new tablet style instead of the classic Windows style. 
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11.4 Opening Files with Different Applications 
 
Opening files with different applications 
When you open a file in Windows, it will usually open in the default application for that 
type of file. For example, a photo will open in Windows Photo Viewer (or 
the Photos application in Windows 8) by default. But you may not always want this. In 
this lesson, we'll show you how to open a file in a different application, as well as how 
to change the default application so a file will always open in your preferred program. 
If you're using Windows 8, files will usually open in a Start screen application, even if you 
opened it from the desktop. If you prefer to work in the desktop, you can choose to open 
the file with a desktop application. For example, a jpeg picture in Windows 8 will open in 
the Photos application by default, but you can open it on the desktop in Windows Photo 
Viewer instead. 
Opening a file in the default application 
As you learned in our lesson on Working with Files, you can locate and double-click a file 
to open it. It will open in the default application for that type of file. 

 
 
To open a file in a different application: 
Sometimes you may want to open a file in a different application without changing the 
default. For example, you may want to open a photo with Microsoft Paint to crop or 
resize it. 

1. From the desktop, right-click the desired file. 
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2. From the drop-down menu, click Open with, then select the 

desired application. In this example, we'll select Paint. 

 
3. The file will open in the selected application. 
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To change the default application: 
You may prefer to change the default application for certain types of files so 
they'll always open in the new app when you double-click them. For example, you may 
want your photos to always open in Windows Photo Viewer instead of 
the Photos application. 

1. From the desktop, right-click the desired file, select Open with, and 
click Choose another app from the menu that appears. 
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2. Select the desired application. If you don't see the one you want, 

click More apps or Look for an app in the Store to look for other 
applications. In this example, we want to open the file in Windows Photo 
Viewer. Then check off Always use this app to open .jpg files and 
click OK. 
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3. The file will open in the new application. The next time you double-click a 

file of that type, it will open in the new default application. 
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11.5 Bringing Your Files with You 
Bringing your files with you 

When you're working on a document or other computer file, you can always save it to 
your computer's hard drive. Sometimes, you may want to bring your file with you and 
open it on a different computer. In this lesson, we'll talk about two ways to save your 
files so you can access them from almost anywhere. 

 Flash drive: Flash drives are small, removable hard drives that plug into 
the USB ports on your computer. They are relatively inexpensive (usually 
less than $20) and can be purchased at any store with an electronics 
section. 

 Cloud storage: Cloud storage means you save your files on servers on the 
Internet using an account with a cloud service. With cloud storage, you 
can access your files from any computer with Internet access without 
having to keep track of a physical device. 

Flash drives and the cloud can also be used to back up your files. To learn more, check 
out our lesson on Backing Up Your Files. 

http://www.gcflearnfree.org/techsavvy/backing-up-your-files/1
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Using a flash drive 

 
Flash drives make it easy to carry your important files and documents with you in a 
portable form. You should always back up the files on your flash drive elsewhere just in 
case it gets lost or breaks. 
To connect a flash drive: 

1. Insert the flash drive into a USB port on your computer. You should find a 
USB port on the front, back, or side of your computer (the location may 
vary depending on whether you have a desktop or laptop). 

2. If you're using Windows, a dialog box may appear. If it does, select Open 
folder to view files. On a Mac, a flash drive icon will usually appear on 
the desktop. 

3. If a dialog box does not appear, open Windows Explorer—or Finder if 
you're using a Mac—and select the flash drive on the left side of the 
window. Note that the name of the flash drive may vary. 

 
To work with a flash drive: 
Once you've connected a flash drive, you can work with it just like any other folder on 
your computer, including moving and deleting files. 

1. If you want to copy a file from your computer to the flash drive, click and 
drag the file from your computer to this window. 
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2. The file will be duplicated, and this new version will be saved to the flash 

drive. The original version of the file will still be saved to your computer. 

 
3. If you want to copy a file from your flash drive to your computer, click 

and drag the file from this window to your computer.  
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4. If you want to remove a file from your flash drive, click and drag the file 

to the Recycle Bin on a PC or the Trash can on a Mac. A dialog box may 
appear appear. If it does, click Yes to confirm that you want to 
permanently delete the file. 

 
If a dialog box does not appear, you may need to empty the Trash can to permanently 
delete the file. 
To safely remove a flash drive: 
When you're done using a flash drive, don't remove it from the USB port just yet. You'll 
need to make sure to disconnect it properly to avoid damaging files on the drive. 

1. Right-click the flash drive and select Disconnect (or Eject). 
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2. You can now safely remove the flash drive from the USB port. 

If you're using a Mac, you can also click the Eject button next to the flash drive 
in Finder to eject it. 

 
Saving files to the cloud 
There are many services that allow you to create a free account and save documents, 
images, and other files to the cloud. Some of the most popular are Google 
Drive, OneDrive, and Dropbox. The free storage space that comes with these accounts 
(usually around 15GB) should be plenty if you're using your account for regular personal, 

https://www.google.com/drive/
https://www.google.com/drive/
https://onedrive.live.com/about/en-us/
https://www.dropbox.com/
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work, or school purposes. If you own a business and want to keep all of your documents 
in the cloud, you may want to pay your cloud service for more storage. 
Unlike physical media, the cloud can't break or get lost, so you don't necessarily need to 
back up the files you keep on it. Files in the cloud are also easier to share so you 
can collaborate with friends and coworkers. However, when you save something online, 
there's always a risk that unauthorized users will try to gain access to your personal 
information. To protect your files, create a strong password and pay attention to 
the privacy settings and policies of the cloud service you're using. 

 
 
11.6 Using Accessibility Features 
Accessibility features are designed to help people with disabilities use technology more 
easily. For example, a text-to-speech feature may read text out loud for people with 
limited vision, while a speech-recognition feature allows users with limited mobility to 
control the computer with their voice. In this lesson, we'll introduce you to 
some common accessibility features. We'll also discuss assistive technology that you can 
attach to your computer for greater accessibility. 
Common accessibility features 
Although some accessibility features require special software downloads, many are built 
into the operating system of your computer or mobile device. Here are just a few types 
of accessibility features you may already have on your device. 

 Features for blind or low-vision computer users: Features such as text-to-
speech allow users to hear what's on the screen instead of reading it. 
Other features, like high-contrast themes and enlarged cursors, make it 
easier for users with limited vision to see the screen. 
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 Features for deaf or low-hearing computer users: Closed-
captioning helps to convey audio information to deaf users in visual 
form. Mono audio systems transmit right and left audio signals through 
both earbuds and headphones so users with limited hearing in one ear 
will not miss part of what they are listening to. 

 Features for limited-mobility computer users: Keyboard shortcuts are 
convenient for many people, but they are especially helpful to those with 
difficulty physically manipulating a mouse. For users who have difficulty 
pressing several keys at once, sticky keys allows them to press keys one 
at a time to activate a shortcut. 

 
Using accessibility features 
Most computers and mobile devices come with built-in accessibility features, although 
they'll usually need to be turned on before you can use them. Let's take a look at how to 
locate these features for your device. 

 In Windows, open the Settings app (or Control Panel in Windows 8 and 
earlier), then click Ease of Access. 
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 In macOS, open System Preferences, then click Accessibility (or Universal 

Access in older versions). 

 
 On mobile devices that use Android or iOS, open the Settings app, then 

locate the Accessibility section. On iOS devices, you'll find it within 
the General settings category. 
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Web accessibility 
Most web browsers also offer their own built-in accessibility features. You'll usually find 
these options in your browser's settings. 

 
Before you adjust these settings, you may want to try zooming instead. Zooming is an 
easy way to make webpages easier to read, and it works the same way in most browsers. 
If you're using a browser in Windows, you can zoom in or out by 
pressing Ctrl+ or Ctrl- (hold down the Ctrl key and press the + or - key). If you're using a 
Mac, you'll press Command+ or Command-. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  157 | 1352  

To return to the default zoom level, press Ctrl+0 (hold down the Ctrl key and press 
the zero key). If you're using a Mac, press Command+0. 
Accessibility features in specific software 
There are many more accessibility features you can use, depending on the type of 
computer you have and the software you use. The resources below will direct you to 
accessibility features for some of the most commonly used applications. 

 Microsoft Accessibility: Here, you'll find news on Microsoft's accessibility 
projects, as well as help pages on accessibility features in the Windows 
operating system and in the Microsoft Office suite. 

 Apple Accessibility: This is Apple's overview site for accessibility features 
on Macs, iPods, iPhones, and iPads. From here, you can navigate to help 
documents for specific features. 

 Google Accessibility: This is Google's help site for accessibility features on 
Android phones and tablets and in Chrome. 

 Accessibility Features in Firefox: This is Mozilla's official help site for 
Firefox's accessibility features. 

 Apples: This community-based website offers tips, tutorials, and product 
reviews for blind and low-vision users of Apple products. 

Assistive technology devices 
As you've already seen, software can do a lot to make computers more accessible for 
disabled users. However, some accessibility features require extra hardware, or assistive 
technology. Most assistive-technology devices are similar to keyboards and speakers—
they are peripherals that can be plugged into the main computer. Here are some 
common types of assistive technology you may encounter. 

 Screen magnifiers: Screen magnifiers can be placed over your computer's 
monitor to ensure the content on the screen always appears magnified. 
Today, most people use the magnifier or zoom features on their operating 
systems to view content, but external magnifiers are still available as well. 

 Alternative keyboards: For people who have difficulty using standard 
keyboards, there are a range of alternative options. For example, users 
can purchase keyboards with larger keys that are easier to see or press. 
They can also buy keyboards with alternative key arrangements, 
including arrangements for people who can only type with one hand or 
with a limited number of fingers. 

 Switch-adapted peripherals: Switch devices allow people with limited 
mobility to control technology with very small motions, such as a puff of 
breath or a head movement. Switch-adapted mice and keyboards make 
it possible for disabled users to interact with computers even if they are 
unable to operate peripherals with their hands. 
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MODULE 2: MICROSOFT WORD (BASIC TO ADVANCE) 

Introduction 

Microsoft Word 2016 is a word processing application that allows you to create a variety 
of documents, including letters, resumes, and more. In this lesson, you'll learn how to 
navigate the Word interface and become familiar with some of its most important 
features, such as the Ribbon, Quick Access Toolbar, and Backstage view. 

Lesson 1: Getting to know Word 2016 

Word 2016 is similar to Word 2013 and Word 2010. If you've previously used either 
version, then Word 2016 should feel familiar. But if you are new to Word or have more 
experience with older versions, you should first take some time to become familiar with 
the Word 2016 interface. 
The Word interface 
When you open Word for the first time, the Start Screen will appear. From here, you'll be 
able to create a new document, choose a template, and access your recently edited 
documents. From the Start Screen, locate and select Blank document to access the Word 
interface. 

 
Click the buttons in the interactive below to learn more about the Word interface: 
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Working with the Word environment 
Like other recent versions, Word 2016 continues to use features like the Ribbon and 
the Quick Access Toolbar—where you will find commands to perform common tasks in 
Word—as well as Backstage view. 
The Ribbon 
Word uses a tabbed Ribbon system instead of traditional menus. 
The Ribbon contains multiple tabs, which you can find near the top of the Word window. 

 
Each tab contains several groups of related commands. For example, the Font group on 
the Home tab contains commands for formatting text in your document. 

 
Some groups also have a small arrow in the bottom-right corner that you can click for 
even more options. 
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Showing and hiding the Ribbon 
If you find that the Ribbon takes up too much screen space, you can hide it. To do this, 
click the Ribbon Display Options arrow in the upper-right corner of the Ribbon, then 
select the desired option from the drop-down menu: 

 
 Auto-hide Ribbon: Auto-hide displays your document in full-screen mode 

and completely hides the Ribbon from view. To show the Ribbon, click 
the Expand Ribbon command at the top of screen. 

 Show Tabs: This option hides all command groups when they're not in 
use, but tabs will remain visible. To show the Ribbon, simply click a tab. 

 Show Tabs and Commands: This option maximizes the Ribbon. All of the 
tabs and commands will be visible. This option is selected by default when 
you open Word for the first time. 

To learn how to add custom tabs and commands to the Ribbon, review our Extra 
on Customizing the Ribbon. 
Using the Tell me feature 
If you're having trouble finding command you want, the Tell Me feature can help. It 
works just like a regular search bar: Type what you're looking for, and a list of options will 
appear. You can then use the command directly from the menu without having to find it 
on the Ribbon. 
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The Quick Access Toolbar 
Located just above the Ribbon, the Quick Access Toolbar lets you access common 
commands no matter which tab is selected. By default, it shows the Save, Undo, 
and Redo commands, but you can add other commands depending on your needs. 
To add commands to the Quick Access Toolbar: 

1. Click the drop-down arrow to the right of the Quick Access Toolbar. 

 
2. Select the command you want to add from the menu. 

 
3. The command will be added to the Quick Access Toolbar. 

 
The Ruler 
The Ruler is located at the top and to the left of your document. It makes it easier 
to adjust your document with precision. If you want, you can hide the Ruler to create 
more screen space. 
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To show or hide the Ruler: 
1. Click the View tab. 

 
2. Click the checkbox next to Ruler to show or hide the Ruler. 

 
Backstage view 
Backstage view gives you various options for saving, opening a file, printing, and sharing 
your document. To access Backstage view, click the File tab on the Ribbon. 

 
Click the buttons in the interactive below to learn more about using Backstage view. 

 
Document views and zooming 
Word has a variety of viewing options that change how your document is displayed. You 
can choose to view your document in Read Mode, Print Layout, or Web Layout. These 
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views can be useful for various tasks, especially if you're planning to print the document. 
You can also zoom in and out to make your document easier to read. 
Switching document views 
Switching between different document views is easy. Just locate and select the 
desired document view command in the bottom-right corner of the Word window. 

 Read Mode: This view opens the document to a full screen. This view is 
great for reading large amounts of text or simply reviewing your work. 

 
 Print Layout: This is the default document view in Word. It shows what 

the document will look like on the printed page. 

 
 Web Layout: This view displays the document as a webpage, which can be 

helpful if you're using Word to publish content online. 
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Zooming in and out 
To zoom in or out, click and drag the zoom control slider in the bottom-right corner of 
the Word window. You can also select the + or - commands to zoom in or out by smaller 
increments. The number next to the slider displays the current zoom percentage, also 
called the zoom level. 

 
 

Lesson 2: Creating and Opening Documents 

Introduction 
Word files are called documents. Whenever you start a new project in Word, you'll need 
to create a new document, which can either be blank or from a template. You'll also 
need to know how to open an existing document. 
Watch the video below to learn more about creating and opening documents in Word. 
To create a new blank document: 
When beginning a new project in Word, you'll often want to start with a new blank 
document. 

1. Select the File tab to access Backstage view. 

 
2. Select New, then click Blank document. 
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3. A new blank document will appear. 

To create a new document from a template: 
A template is a predesigned document you can use to create a new document quickly. 
Templates often include custom formatting and designs, so they can save you a lot of 
time and effort when starting a new project. 

1. Click the File tab to access Backstage view, then select New. 
2. Several templates will appear below the Blank document option. You can 

also use the search bar to find something more specific. In our example, 
we'll search for a flyer template. 

 
3. When you find something you like, select a template to preview it. 
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4. A preview of the template will appear. Click Create to use the selected 

template. 

 
5. A new document will appear with the selected template. 

You can also browse templates by category after performing a search. 
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To open an existing document: 
In addition to creating new documents, you'll often need to open a document that was 
previously saved.  

1. Navigate to Backstage view, then click Open. 

 
2. Select This PC, then click Browse. Alternatively, you can 

choose OneDrive to open files stored on your OneDrive. 
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3. The Open dialog box will appear. Locate and select your document, then 

click Open. 

 
4. The selected document will appear. 

Most features in Microsoft Office, including Word, are geared toward saving and sharing 
documents online. This is done with OneDrive, which is an online storage space for your 
documents and files. If you want to use OneDrive, make sure you’re signed in to Word 
with your Microsoft account. Review our lesson on Understanding OneDrive to learn 
more. 
To pin a document: 
If you frequently work with the same document, you can pin it to Backstage view for 
quick access. 

1. Navigate to Backstage view, click Open, then select Recent. 
2. A list of recently edited documents will appear. Hover the mouse over 

the document you want to pin, then click the pushpin icon. 
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3. The document will stay in Recent documents list until it is unpinned. 

To unpin a document, click the pushpin icon again. 

 
Compatibility Mode 
Sometimes you may need to work with documents that were created in earlier versions 
of Microsoft Word, such as Word 2010 or Word 2007. When you open these types of 
documents, they will appear in Compatibility Mode. 
Compatibility Mode disables certain features, so you'll only be able to access commands 
found in the program that was used to create the document. For example, if you open a 
document created in Word 2007 you can only use tabs and commands found in Word 
2007. 
In the image below, you can see how Compatibility Mode can affect which commands 
are available. Because the document on the left is in Compatibility Mode, it only shows 
commands that were available in Word 2007. 
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To exit Compatibility Mode, you'll need to convert the document to the current version 
type. However, if you're collaborating with others who only have access to an earlier 
version of Word, it's best to leave the document in Compatibility Mode so the format will 
not change. 
You can review this support page from Microsoft to learn more about which features are 
disabled in Compatibility Mode. 
To convert a document: 
If you want access to all Word 2016 features, you can convert the document to the 2016 
file format. 

1. Click the File tab to access backstage view, then locate and select 
the Convert command. 

 
2. A dialog box will appear. Click OK to confirm the file upgrade. 

 
3. The document will be converted to the newest file type. 

Converting a file may cause some changes to the original layout of the document. 
 

Lesson 3: Saving and Sharing Documents 
Introduction 
When you create a new document in Word, you'll need to know how to save it so you 
can access and edit it later. As with previous versions of Word, you can save files to your 
computer. If you prefer, you can also save files to the cloud using OneDrive. You can even 
export and share documents directly from Word. 
Save and Save As 
Word offers two ways to save a file: Save and Save As. These options work in similar 
ways, with a few important differences. 
 

https://edu.gcfglobal.org/en/word2016/saving-and-sharing-documents/1/
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Save: When you create or edit a document, you'll use the Save command to save your 
changes. You'll use this command most of the time. When you save a file, you'll only 
need to choose a file name and location the first time. After that, you can click the Save 
command to save it with the same name and location. 
Save As: You'll use this command to create a copy of a document while keeping the 
original. When you use Save As, you'll need to choose a different name and/or location 
for the copied version. 
About OneDrive 
Most features in Microsoft Office, including Word, are geared toward saving and sharing 
documents online. This is done with OneDrive, which is an online storage space for your 
documents and files. If you want to use OneDrive, make sure you’re signed in to Word 
with your Microsoft account. Review our lesson on Understanding OneDrive to learn 
more. 
To save a document: 
It's important to save your document whenever you start a new project or make changes 
to an existing one. Saving early and often can prevent your work from being lost. You'll 
also need to pay close attention to where you save the document so it will be easy to find 
later. 

1. Locate and select the Save command on the Quick Access Toolbar. 

 
2. If you're saving the file for the first time, the Save As pane will appear 

in backstage view. 
3. You'll then need to choose where to save the file and give it a file name. 

Click Browse to select a location on your computer. Alternatively, you can 
click OneDrive to save the file to your OneDrive. 
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4. The Save As dialog box will appear. Select the location where you want to 

save the document. 
5. Enter a file name for the document, then click Save. 

 
6. The document will be saved. You can click the Save command again to 

save your changes as you modify the document. 
You can also access the Save command by pressing Ctrl+S on your keyboard. 
Using Save As to make a copy 
If you want to save a different version of a document while keeping the original, you can 
create a copy. For example, if you have a file named Sales Report, you could save it 
as Sales Report 2 so you'll be able to edit the new file and still refer back to the original 
version. 
To do this, you'll click the Save As command in Backstage view. Just like when saving a 
file for the first time, you'll need to choose where to save the file and give it a new file 
name. 
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To change the default save location: 
If you don't want to use OneDrive, you may be frustrated that OneDrive is selected as 
the default location when saving. If you find this inconvenient, you can change 
the default save location so This PC is selected by default. 

1. Click the File tab to access backstage view. 

 
2. Click Options. 

 
3. The Word Options dialog box will appear. Select Save on the left, check 

the box next to Save to Computer by default, then click OK. The default 
save location will be changed. 
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Auto Recover 
Word automatically saves your documents to a temporary folder while you are working 
on them. If you forget to save your changes or if Word crashes, you can restore the file 
using Auto Recover. 
To use Auto Recover: 

1. Open Word. If AutoSaved versions of a file are found, 
the Document Recovery pane will appear on the left. 

2. Click to open an available file. The document will be recovered. 

 
By default, Word AutoSaves every 10 minutes. If you are editing a document for less than 
10 minutes, Word may not create an AutoSaved version. 
If you don't see the file you need, you can browse all AutoSaved files 
from backstage view. Select the File tab, click Manage Versions, and then 
choose Recover Unsaved Documents. 
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Exporting documents 
By default, Word documents are saved in the .docx file type. However, there may be 
times when you need to use another file type, such as a PDF or Word 97-2003 
document. It's easy to export your document from Word to a variety of file types. 
To export a document as a PDF file: 
Exporting your document as an Adobe Acrobat document, commonly known as a PDF 
file, can be especially useful if you're sharing a document with someone who does not 
have Word. A PDF file will make it possible for recipients to view—but not edit—the 
content of your document. 

1. Click the File tab to access backstage view, choose Export, then 
select Create PDF/XPS. 
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2. The Save As dialog box will appear. Select the location where you want to 
export the document, enter a file name, then click Publish.

 
If you need to edit a PDF file, Word allows you to convert a PDF file into an editable 
document.  
To export a document to other file types: 
You may also find it helpful to export your document to other file types, such as a Word 
97-2003 Document if you need to share with people using an older version of Word or as 
a .txt file if you need a plain-text version of your document. 

1. Click the File tab to access backstage view, choose Export, then 
select Change File Type. 

 
2. Select a file type, then click Save As. 
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3. The Save As dialog box will appear. Select the location where you want to 

export the document, enter a file name, and then click Save. 
You can also use the Save as type drop-down menu in the Save As dialog box to save 
documents to a variety of file types. 

 
Sharing documents 
Word makes it easy to share and collaborate on documents using OneDrive. In the past, 
if you wanted to share a file with someone you could send it as an email attachment. 
While convenient, this system also creates multiple versions of the same file, which can 
be difficult to organize. 
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When you share a document from Word, you're actually giving others access to the exact 
same file. This lets you and the people you share with edit the same document without 
having to keep track of multiple versions. 
In order to share a document, it must first be saved to your OneDrive. 
To share a document: 

1. Click the File tab to access backstage view, then click Share. 

 
2. The Share pane will appear. 

Click the buttons in the interactive below to learn more about different ways to share a 
document. 

 
 

Lesson 4: Working with Text 
Text Basics 
Introduction 
If you're new to Microsoft Word, you'll need to learn the basics of typing, editing, and 
organizing text. Basic tasks include the ability to add, delete, and move text in your 
document, as well as how to cut, copy, and paste. 
Using the insertion point to add text 
The insertion point is the blinking vertical line in your document. It indicates where you 
can enter text on the page. You can use the insertion point in a variety of ways. 

 Blank document: When a new blank document opens, the insertion point 
will appear in the top-left corner of the page. If you want, you can begin 
typing from this location. 
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 Adding spaces: Press the spacebar to add spaces after a word or in 

between text. 

 
 New paragraph line: Press Enter on your keyboard to move the insertion 

point to the next paragraph line. 

 
 Manual placement: Once you begin typing, you can use the mouse to 

move the insertion point to a specific place in your document. Simply click 
the location in the text where you want to place it. 
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 Arrow keys: You can also use the arrow keys on your keyboard to move 

the insertion point. The left and right arrow keys will 
move between adjacent characters on the same line, while 
the up and down arrows will move between paragraph lines. You can 
also press Ctrl+Left or Ctrl+Right to quickly move between entire words. 

In a new blank document, you can double-click the mouse to move the insertion point 
elsewhere on the page. 
Selecting text 
Before you can move or format text, you'll need to select it. To do this, click and drag 
your mouse over the text, then release the mouse. A highlighted box will appear over 
the selected text. 

 
When you select text or images in Word, a hover toolbar with command shortcuts will 
appear. If the toolbar does not appear at first, try hovering the mouse over the selection. 

 
To select multiple lines of text: 

1. Move the mouse pointer to the left of any line so it becomes a right 
slanted arrow. 

 
2. Click the mouse. The line will be selected. 
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3. To select multiple lines, click and drag the mouse up or down.

 
4. To select all of the text in your document, choose the Select command on 

the Home tab, then click Select All. Alternatively, you can press Ctrl+A on 
your keyboard. 

 
Other shortcuts include double-clicking to select a word and triple-clicking to select an 
entire sentence or paragraph. 
To delete text: 
There are several ways to delete—or remove—text: 

 To delete text to the left of the insertion point, press the Backspace key 
on your keyboard. 

 To delete text to the right of the insertion point, press the Delete key on 
your keyboard. 

 Select the text you want to remove, then press the Delete key. 
If you select text and start typing, the selected text will automatically be deleted and 
replaced with the new text. 
Copying and moving text 
Word allows you to copy text that's already in your document and paste it in other 
places, which can save you a lot of time and effort. If you want to move text around in 
your document, you can cut and paste or drag and drop. 
To copy and paste text: 

1.  
2. Select the text you want to copy. 
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3. Click the Copy command on the Home tab. Alternatively, you can press Ctrl+C on 

your keyboard. 

 
4. Place the insertion point where you want the text to appear. 

 
5. Click the Paste command on the Home tab. Alternatively, you can press Ctrl+V on 

your keyboard. 

 
6. The text will appear. 

 
To cut and paste text: 

1. Select the text you want to cut. 
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2. Click the Cut command on the Home tab. alternatively, you can press Ctrl+X on 

your keyboard. 

 
3. Place your insertion point where you want the text to appear. 

 
4. Click the Paste command on the Home tab. Alternatively, you can press Ctrl+V on 

your keyboard. 

 
5. The text will appear. 

 
 You can also cut, copy, and paste by right-clicking your document and choosing 

the desired action from the drop-down menu. When you use this method to 
paste, you can choose from three options that determine how the text will be 
formatted: Keep Source Formatting, Merge Formatting, and Keep Text Only. You 
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can hover the mouse over each icon to see what it will look like before you select 
it. 

To drag and drop text: 
1. Select the text you want to move. 

 
2. Click and drag the text to the location where you want it to appear. A small 

rectangle will appear below the arrow to indicate that you are moving text.

 
3. Release the mouse, and the text will appear. 

 
If text does not appear in the exact location you want, you can press the Enter key on 
your keyboard to move the text to a new line. 
Undo and Redo 
Let's say you're working on a document and accidentally delete some text. Fortunately, 
you won't have to retype everything you just deleted! Word allows you to undo your 
most recent action when you make a mistake like this. 
To do this, locate and select the Undo command on the Quick Access Toolbar. 
Alternatively, you can press Ctrl+Z on your keyboard. You can continue using this 
command to undo multiple changes in a row. 

 
By contrast, the Redo command allows you to reverse the last undo. You can also access 
this command by pressing Ctrl+Y on your keyboard. 
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Symbols 
If you need to insert an unusual character that's not on your keyboard, such as 
a copyright (©) or trademark (™) symbol, you can usually find them with 
the Symbol command. 
To insert a symbol: 

1. Place the insertion point where you want the symbol to appear. 

 
2. Click the Insert tab. 

 
3. Locate and select the Symbol command, then choose the desired symbol 

from the drop-down menu. If you don't see the one you want, 
select More Symbols. 

 
4. The symbol will appear in the document. 
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Lesson 5: Formatting Text 

Introduction 
Formatted text can draw the reader's attention to specific parts of a document and 
emphasize important information. In Word, you have several options for adjusting text, 
including font, size, and color. You can also adjust the alignment of the text to change 
how it is displayed on the page. 
To change the font size: 

1. Select the text you want to modify. 

 
2. On the Home tab, click the Font size drop-down arrow. Select a font size 

from the menu. If the font size you need is not available in the menu, you 
can click the Font size box and type the desired font size, then 
press Enter. 

 
3. The font size will change in the document. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  187 | 1352  

 
You can also use the Grow Font and Shrink Font commands to change the font size. 

 
To change the font: 
By default, the font of each new document is set to Calibri. However, Word provides 
many other fonts you can use to customize text. 

1. Select the text you want to modify. 

 
2. On the Home tab, click the drop-down arrow next to the Font box. A 

menu of font styles will appear. 
3. Select the font style you want to use. 
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4. The font will change in the document. 

 
When creating a professional document or a document that contains multiple 
paragraphs, you'll want to select a font that's easy to read. Along with Calibri, standard 
reading fonts include Cambria, Times New Roman, and Arial. 
To change the font color: 

1. Select the text you want to modify. 
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2. On the Home tab, click the Font Color drop-down arrow. The Font 
Color menu appears. 

 
3. Select the font color you want to use. The font color will change in the 

document. 

 
Your color choices aren't limited to the drop-down menu that appears. Select More 
Colors at the bottom of the menu to access the Colors dialog box. Choose the color you 
want, then click OK. 
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To use the Bold, Italic, and Underline commands: 
The Bold, Italic, and Underline commands can be used to help draw attention to 
important words or phrases. 

1. Select the text you want to modify. 

 
2. On the Home tab, click the Bold (B), Italic (I), or Underline (U) command in 

the Font group. In our example, we'll click Bold. 

 
3. The selected text will be modified in the document. 

 
To change text case: 
When you need to quickly change text case, you can use the Change Case command 
instead of deleting and retyping text. 

1. Select the text you want to modify. 
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2. On the Home tab, click the Change Case command in the Font group. 
3. A drop-down menu will appear. Select the desired case option from the 

menu. 

 
4. The text case will be changed in the document. 

 
To highlight text: 
Highlighting can be a useful tool for marking important text in your document. 

1. Select the text you want to highlight. 
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2. From the Home tab, click the Text Highlight Color drop-down arrow. 

The Highlight Color menu appears. 

 
3. Select the desired highlight color. The selected text will then be 

highlighted in the document. 

 
To remove highlighting, select the highlighted text, then click the Text Highlight 
Color drop-down arrow. Select No Color from the drop-down menu. 
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If you need to highlight several lines of text, changing the mouse into a highlighter may 
be a helpful alternative to selecting and highlighting individual lines. Click the Text 
Highlight Color command, and the cursor changes into a highlighter. You can then click 
and drag the highlighter over the lines you want to highlight. 
To change text alignment: 
By default, Word aligns text to the left margin in new documents. However, there may be 
times when you want to adjust text alignment to the center or right. 

1. Select the text you want to modify. 

 
2. On the Home tab, select one of the four alignment options from 

the Paragraph group. In our example, we've selected Center Alignment. 

 
3. The text will be realigned in the document. 
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Align Text Left: This aligns all selected text to the left margin. The 
Align Text Left command is the most common alignment and is 
selected by default when a new document is created. 

  
Center: This aligns text an equal distance from the left and right 
margins. 

  
Align Text Right: This aligns all selected text to the right margin. 
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Justify: Justified text is equal on both sides. It lines up equally to the 
right and left margins. Many newspapers and magazines use full 
justification. 
 

You can use Word's convenient Set as Default feature to save all of 
the formatting changes you've made and automatically apply them to new documents. 
To learn how to do this, read our article on Changing Your Default Settings in Word. 
 

Lesson 6: Using Find and Replace 
Introduction 
When you're working with longer documents, it can be difficult and time consuming to 
locate a specific word or phrase. Word can automatically search your document using the 
Find feature, and it allows you to quickly change words or phrases using Replace. 
To find text 
In our example, we've written an academic paper and will use the Find command to 
locate all instances of a particular word. 

1. From the Home tab, click the Find command. Alternatively, you can 
press Ctrl+F on your keyboard. 

 
2. The navigation pane will appear on the left side of the screen. 
3. Type the text you want to find in the field at the top of the navigation 

pane. In our example, we'll type the word we're looking for. 
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4. If the text is found in the document, it will be highlighted in yellow and 

a preview of the results will appear in the navigation pane. Alternatively, 
you can click one of the results below the arrows to jump to it. 

 
5. When you are finished, click the X to close the navigation pane. The 

highlight will disappear. 

 
For more search options, click the drop-down arrow next to the search field. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  197 | 1352  

 
To replace text 
At times, you may discover that you've made a mistake repeatedly throughout your 
document—such as misspelling a person's name—or that you need to exchange a 
particular word or phrase for another. You can use Word's Find and Replace feature to 
quickly make revisions. In our example, we'll use Find and Replace to change the title of a 
magazine so it is abbreviated. 

1. From the Home tab, click the Replace command. Alternatively, you can 
press Ctrl+H on your keyboard. 

 
2. The Find and Replace dialog box will appear. 
3. Type the text you want to find in the Find what: field. 
4. Type the text you want to replace it with in the Replace with: field. Then 

click Find Next. 
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5. Word will find the first instance of the text and highlight it in gray. 
6. Review the text to make sure you want to replace it. In our example, the 

text is part of the title of the paper and does not need to be replaced. 
We'll click Find Next again to jump to the next instance. 

 
7. If you want to replace it, you can click Replace to change individual 

instances of text. Alternatively, you can click Replace All to replace every 
instance of the text throughout the document. 
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8. The text will be replaced. 

 
9. When you're done, click Close or Cancel to close the dialog box. 

For more search options, click More in the Find and Replace dialog box. From here, you 
can select additional search options, such as matching case and ignoring punctuation. 

 
When it comes to using Replace All, it's important to remember that it could find 
matches you didn't anticipate and that you might not actually want to change. You 
should only use this option if you're absolutely sure it won't replace anything you didn't 
intend it to. 
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Lesson 7: Indents and Tabs 

Introduction 
Indenting text adds structure to your document by allowing you to separate information. 
Whether you'd like to move a single line or an entire paragraph, you can use the tab 
selector and the horizontal ruler to set tabs and indents. 
Indenting text 
In many types of documents, you may want to indent only the first line of each 
paragraph. This helps to visually separate paragraphs from one another. 

 
It's also possible to indent every line except for the first line, which is known as 
a hanging indent. 

 
To indent using the Tab key 
A quick way to indent is to use the Tab key. This will create a first-line indent of 1/2 inch. 

1. Place the insertion point at the very beginning of the paragraph you want 
to indent. 

 
2. Press the Tab key. On the Ruler, you should see the first-line indent 

marker move to the right by 1/2 inch. 
3. The first line of the paragraph will be indented. 
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If you can't see the Ruler, select the View tab, then click the check box next to the Ruler. 

 
Indent markers 
In some cases, you may want to have more control over indents. Word provides indent 
markers that allow you to indent paragraphs to the location you want. 

 
The indent markers are located to the left of the horizontal ruler, and they provide 
several indenting options: 

 First-line indent marker  adjusts the first-line indent 
 Hanging indent marker  adjusts the hanging indent 
 Left indent marker  moves both the first-line indent and hanging indent 

markers at the same time (this will indent all lines in a paragraph) 
To indent using the indent markers 

1. Place the insertion point anywhere in the paragraph you want to indent, 
or select one or more paragraphs. 
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2. Click and drag the desired indent marker. In our example, we'll click and 

drag the left indent marker. 

 
3. Release the mouse. The paragraphs will be indented. 
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To indent using the Indent commands 
If you want to indent multiple lines of text or all lines of a paragraph, you can use 
the Indent commands. The Indent commands will adjust the indent by 1/2-inch 
increments. 

1. Select the text you want to indent. 

 
2. On the Home tab, click the Increase Indent or Decrease Indent command. 

 
3. The text will indent. 
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To customize the indent amounts, select the Layout tab near the desired values in the 
boxes under Indent. 

 
Tabs 
Using tabs gives you more control over the placement of text. By default, every time you 
press the Tab key, the insertion point will move 1/2 inch to the right. Adding tab stops to 
the Ruler allows you to change the size of the tabs, and Word even allows you to apply 
more than one tab stop to a single line. For example, on a resume you could left-
align the beginning of a line and right-align the end of the line by adding a Right Tab, as 
shown in the image below. 

 
Pressing the Tab key can either add a tab or create a first-line indent, depending on 
where the insertion point is. Generally, if the insertion point is at the beginning of an 
existing paragraph, it will create a first-line indent; otherwise, it will create a tab. 
The tab selector 
The tab selector is located above the vertical ruler on the left. Hover the mouse over the 
tab selector to see the name of the active tab stop. 
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Types of tab stops: 

 Left Tab  left-aligns the text at the tab stop. 
 Center Tab  centers the text around the tab stop. 
 Right Tab  right-aligns the text at the tab stop. 
 Decimal Tab  aligns decimal numbers using the decimal point. 
 Bar Tab  draws a vertical line on the document. 
 First Line Indent  inserts the indent marker on the Ruler and indents the 

first line of text in a paragraph. 
 Hanging Indent  inserts the hanging indent marker and indents all lines 

other than the first line. 
Although Bar Tab, First Line Indent, and Hanging Indent appear on the tab selector, 
they're not technically tabs. 
To add tab stops 

1. Select the paragraph or paragraphs you want to add tab stops to. If you 
don't select any paragraphs, the tab stops will apply to the current 
paragraph and any new paragraphs you type below it. 

 
2. Click the tab selector until the tab stop you want to use appears. In our 

example, we'll select Right Tab. 
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3. Click the location on the horizontal ruler where you want your text to 

appear (it helps to click on the bottom edge of the Ruler). You can add as 
many tab stops as you want. 

 
4. Place the insertion point in front of the text you want to tab, then press 

the Tab key. The text will jump to the next tab stop. In our example, we 
will move each date range to the tab stop we created. 

 
Removing tab stops 
It's a good idea to remove any tab stops you aren't using so they don't get in the way. To 
remove a tab stop, first select all of the text that uses the tab stop. Then click and drag it 
off of the Ruler. 

 
Word can also display hidden formatting symbols such as spaces ( ), paragraph marks (

), and tabs ( ) to help you see the formatting in your document. To show hidden 
formatting symbols, select the Home tab, then click the Show/Hide command. 
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Lesson 8: Line and Paragraph Spacing 
Introduction 
As you design your document and make formatting decisions, you will need to consider 
line and paragraph spacing. You can increase spacing to improve readability and reduce it 
to fit more text on the page. 
About line spacing 
Line spacing is the space between each line in a paragraph. Word allows you to 
customize the line spacing to be single spaced (one line high), double spaced (two lines 
high), or any other amount you want. The default spacing in Word is 1.08 lines, which is 
slightly larger than single spaced. 
In the images below, you can compare different types of line spacing. From left to right, 
these images show default line spacing, single spacing, and double spacing. 
Line spacing is also known as leading (pronounced to rhyme with wedding). 
To format line spacing 
Select the text you want to format. 
On the Home tab, click the Line and Paragraph Spacing command, then select the desired 
line spacing. 
The line spacing will change in the document. 
Fine tuning line spacing 
Your line spacing options aren't limited to the ones in the Line and Paragraph Spacing 
menu. To adjust spacing with more precision, select Line Spacing Options from the menu 
to access the Paragraph dialog box. You'll then have a few additional options you can use 
to customize spacing. 
Exactly: When you choose this option, the line spacing is measured in points, just like 
font size. For example, if you're using 12-point text, you could use 15-point spacing. 
At least: Like the exactly option, this lets you choose how many points of spacing you 
want. However, if you have different sizes of text on the same line, the spacing will 
expand to fit the larger text. 
Multiple: This option lets you type the number of lines of spacing you want. For example, 
choosing Multiple and changing the spacing to 1.2 will make the text slightly more spread 
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out than single-spaced text. If you want the lines to be closer together, you can choose a 
smaller value, like 0.9. 
Paragraph spacing 
Just as you can format spacing between lines in your document, you can adjust spacing 
before and after paragraphs. This is useful for separating paragraphs, headings, and 
subheadings. 
 
To format paragraph spacing: 
In our example, we'll increase the space before each paragraph to separate them a bit 
more. This will make it a little easier to read. 
Select the paragraph or paragraphs you want to format. 
On the Home tab, click the Line and Paragraph Spacing command. Click Add Space before 
Paragraph or Remove Space after Paragraph from the drop-down menu. In our example, 
we'll select Add Space before Paragraph. 
The paragraph spacing will change in the document. 
From the drop-down menu, you can also select Line Spacing Options to open the 
Paragraph dialog box. From here, you can control how much space there is before and 
after the paragraph. 
You can use Word's convenient Set as Default feature to save all of the formatting 
changes you've made and automatically apply them to new documents. To learn how to 
do this, read our article on Changing Your Default Settings in Word. 

Lesson 9: Lists 

Introduction 
Bulleted and numbered lists can be used in your documents to outline, arrange, and 
emphasize text. In this lesson, you will learn how to modify existing bullets, insert new 
bulleted and numbered lists, select symbols as bullets, and format multilevel lists. 
To create a bulleted list: 

1. Select the text you want to format as a list. 

 
2. On the Home tab, click the drop-down arrow next to 

the Bullets command. A menu of bullet styles will appear. 
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3. Move the mouse over the various bullet styles. A live preview of the bullet 

style will appear in the document. Select the bullet style you want to use. 

 
4. The text will be formatted as a bulleted list. 

 
Options for working with lists 

 To remove numbers or bullets from a list, select the list and click 
the Bulleted or Numbered list command. 

 When you're editing a list you can press Enter to start a new line, and the 
new line will automatically have a bullet or number. When you've 
reached the end of your list, press Enter twice to return to normal 
formatting. 

 By dragging the indent markers on the Ruler, you can customize the 
indenting of your list and the distance between the text and the bullet or 
number. 
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To create a numbered list: 
When you need to organize text into a numbered list, Word offers 
several numbering options. You can format your list with numbers, letters, or Roman 
numerals. 

1. Select the text you want to format as a list. 

 
2. On the Home tab, click the drop-down arrow next to 

the Numbering command. A menu of numbering styles will appear. 

 
3. Move the mouse over the various numbering styles. A live preview of the 

numbering style will appear in the document. Select the numbering style 
you want to use. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  211 | 1352  

 
4. The text will format as a numbered list. 

 
To restart a numbered list: 
If you want to restart the numbering of a list, Word has a Restart at 1 option. It can be 
applied to numeric and alphabetical lists. 

1. Right-click the list item you want to restart the numbering for, then 
select Restart at 1 from the menu that appears. 
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2. The list numbering will restart. 

 
You can also set a list to continue numbering from the previous list. To do this, right-click 
and select Continue Numbering. 
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Customizing bullets 
Customizing the look of the bullets in your list can help you emphasize certain list items 
and personalize the design of your list. Word allows you to format bullets in a variety of 
ways. You can use symbols and different colors, or even upload a picture as a bullet. 
To use a symbol as a bullet: 

1. Select an existing list you want to format. 
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2. On the Home tab, click the drop-down arrow next to 
the Bullets command. Select Define New Bullet from the drop-down 
menu. 

 
3. The Define New Bullet dialog box will appear. Click the Symbol button. 

 
4. The Symbol dialog box will appear. 
5. Click the Font drop-down box and select a font. 

The Wingdings and Symbol fonts are good choices because they have 
many useful symbols. 

6. Select the desired symbol, then click OK. 
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7. The symbol will appear in the Preview section of the Define New Bullet 

dialog box. Click OK. 

 
8. The symbol will appear in the list. 

 
To change the bullet color: 

1. Select an existing list you want to format. 
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2. On the Home tab, click the drop-down arrow next to 

the Bullets command. Select Define New Bullet from the drop-down 
menu. 

 
3. The Define New Bullet dialog box will appear. Click the Font button. 
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4. The Font dialog box will appear. Click the Font Color drop-down box. A 
menu of font colors will appear. 

5. Select the desired color, then click OK. 

 
6. The bullet color will appear in the Preview section of the Define New 

Bullet dialog box. Click OK. 

 
7. The bullet color will change in the list. 
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Multilevel lists 
Multilevel lists allow you to create an outline with multiple levels. Any bulleted or 
numbered list can be turned into a multilevel list by using the Tab key. 

 
To create a multilevel list: 

1. Place the insertion point at the beginning of the line you want to move. 
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2. Press the Tab key to increase the indent level of the line. The line will 

move to the right. 

 
To increase or decrease an indent level: 
You can make adjustments to the organization of a multilevel list by increasing or 
decreasing the indent levels. There are several ways to change the indent level. 

 To increase the indent by more than one level, place the insertion point 
at the beginning of the line, then press the Tab key until the desired level 
is reached. 
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 To decrease the indent level, place the insertion point at the beginning of 

the line, then hold the Shift key and press the Tab key. 

 
 You can also increase or decrease the levels of text by placing the 

insertion point anywhere in the line and clicking the Increase 
Indent or Decrease Indent commands. 

 
When formatting a multilevel list, Word will use the default bullet style. To change the 
style of a multilevel list, select the list, then click the Multilevel list command on 
the Home tab. 
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Lesson 10: Hyperlinks 
Introduction 
Adding hyperlinks to text can provide access to websites and email addresses directly 
from your document. There are a few ways to insert a hyperlink into your document. 
Depending on how you want the link to appear, you can use Word's automatic link 
formatting or convert text into a link. 
Understanding hyperlinks in Word 
Hyperlinks have two basic parts: the address (URL) of the webpage and the display text. 
For example, the address could be http://www.popsci.com, and the display text could 
be Popular Science Magazine. When you create a hyperlink in Word, you'll be able to 
choose both the address and the display text. 
Word often recognizes email and web addresses as you type and will automatically 
format them as hyperlinks after you press Enter or the spacebar. In the image below, you 
can see a hyperlinked web address. 

 
To follow a hyperlink in Word, hold the Ctrl key and click the hyperlink. 

http://www.popsci.com/
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To format text with a hyperlink: 

1. Select the text you want to format as a hyperlink. 

 
2. Select the Insert tab, then click the Hyperlink command. 

 
Alternatively, you can open the Insert Hyperlink dialog box by right-
clicking the selected text and selecting Hyperlink... from the menu that 
appears. 

3. The Insert Hyperlink dialog box will appear. Using the options on the left 
side, you can choose to link to a file, webpage, email address, document, 
or a place in the current document. 

4. The selected text will appear in the Text to display: field at the top. You 
can change this text if you want. 

5. In the Address: field, type the address you want to link to, then click OK. 
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6. The text will then be formatted as a hyperlink. 

 
After you create a hyperlink, you should test it. If you've linked to a website, your web 
browser should automatically open and display the site. If it doesn't work, check the 
hyperlink address for misspellings. 
Editing and removing hyperlinks 
Once you've inserted a hyperlink, you can right-click the hyperlink to edit, open, copy, 
or remove it. 
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To remove a hyperlink, right-click the hyperlink and select Remove Hyperlink from the 
menu that appears. 

 
Lesson 11: Layout and Printing 

Page Layout 
Word offers a variety of page layout and formatting options that affect how content 
appears on the page. You can customize the page orientation, paper size, and page 
margins depending on how you want your document to appear. 
Page orientation 
Word offers two page orientation options: landscape and portrait. Compare our example 
below to see how orientation can affect the appearance and spacing of text and images. 

 Landscape means the page is oriented horizontally. 
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 Portrait means the page is oriented vertically. 
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To change page orientation: 
1. Select the Layout tab. 
2. Click the Orientation command in the Page Setup group. 

 
3. A drop-down menu will appear. Click either Portrait or Landscape to 

change the page orientation. 

 
4. The page orientation of the document will be changed. 

Page size 
By default, the page size of a new document is 8.5 inches by 11 inches. Depending on 
your project, you may need to adjust your document's page size. It's important to note 
that before modifying the default page size, you should check to see which page sizes 
your printer can accommodate. 
To change the page size: 
Word has a variety of predefined page sizes to choose from. 

1. Select the Layout tab, then click the Size command. 

 
2. A drop-down menu will appear. The current page size is highlighted. Click 

the desired predefined page size. 
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3. The page size of the document will be changed. 

To use a custom page size: 
Word also allows you to customize the page size in the Page Setup dialog box. 

1. From the Layout tab, click Size. Select More Paper Sizes from the drop-
down menu. 

 
2. The Page Setup dialog box will appear. 
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3. Adjust the values for Width and Height, then click OK. 

 
4. The page size of the document will be changed. 

Page margins 
A margin is the space between the text and the edge of your document. By default, a 
new document's margins are set to Normal, which means it has a one-inch space 
between the text and each edge. Depending on your needs, Word allows you to change 
your document's margin size. 
To format page margins: 
Word has a variety of predefined margin sizes to choose from. 

1. Select the Layout tab, then click the Margins command. 

 
2. A drop-down menu will appear. Click the predefined margin size you 

want. 
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3. The margins of the document will be changed. 

To use custom margins: 
Word also allows you to customize the size of your margins in the Page Setup dialog box. 

1. From the Layout tab, click Margins. Select Custom Margins from the 
drop-down menu. 
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2. The Page Setup dialog box will appear. 
3. Adjust the values for each margin, then click OK. 

 
4. The margins of the document will be changed. 

Alternatively, you can open the Page Setup dialog box by navigating to the Layout tab 
and clicking the small arrow in the bottom-right corner of the Page Setup group. 

 
You can use Word's convenient Set as Default feature to save all of 
the formatting changes you've made and automatically apply them to new documents.  
Printing Documents 
 
Once you've created your document, you may want to print it to view and share your 
work offline. It's easy to preview and print a document in Word using the Print pane. 
To access the Print pane: 

1. Select the File tab. backstage view will appear. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  231 | 1352  

 
2. Select Print. The Print pane will appear. 

 
Click the buttons in the interactive below to learn more about using the Print pane. 

 
You can also access the Print pane by pressing Ctrl+P on your keyboard. 
To print a document: 

1. Navigate to the Print pane, then select the desired printer. 
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2. Enter the number of copies you want to print. 

 
3. Select any additional settings if needed. 
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4. Click Print. 

 
Custom printing 
Sometimes you may find it unnecessary to print your entire document, in which 
case custom printing may be more suited for your needs. Whether you're 
printing several individual pages or a range of pages, Word allows you to specify exactly 
which pages you'd like to print. 
To custom print a document: 
If you'd like to print individual pages or page ranges, you'll need to separate each entry 
with a comma (1, 3, 5-7, or 10-14 for example). 

1. Navigate to the Print pane. 
2. In the Pages: field, enter the pages you want to print. 

 
3. Click Print. 

 
If your document isn't printing the way you want, you may need to adjust some of the 
page layout settings.  
 
Breaks 
When you're working on a multi-page document, there may be times when you want to 
have more control over how exactly the text flows. Breaks can be helpful in these cases. 
There are many types of breaks to choose from depending on what you need, including 
page breaks, section breaks, and column breaks. 
To insert a page break: 
In our example, the section headers on page three (Monthly Revenue and By Client) are 
separated from the table on the page below. And while we could just press Enter until 
that text reaches the top of page four, it could easily be shifted around if we added or 
deleted something in another part of the document. Instead, we'll insert a page break. 

1. Place the insertion point where you want to create the page break. In our 
example, we'll place it at the beginning of our headings. 
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2. On the Insert tab, click the Page Break command. Alternatively, you can 

press Ctrl+Enter on your keyboard. 

 
3. The page break will be inserted into the document, and the text will move 

to the next page. 
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By default, breaks are invisible. If you want to see the breaks in your document, click 
the Show/Hide command on the Home tab. 

 
Section breaks 
Section breaks create a barrier between different parts of a document, allowing you to 
format each section independently. For example, you may want one section to have two 
columns without adding columns to the entire document. Word offers several types of 
section breaks. 

 Next Page: This option inserts a section break and moves text after the 
break to the next page of the document. 

 Continuous: This option inserts a section break and allows you to 
continue working on the same page. 

 Even Page and Odd Page: These options add a section break and move 
the text after the break to the next even or odd page. These options may 
be useful when you need to begin a new section on an even or odd page 
(for example, a new chapter of a book). 
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To insert a section break: 
In our example, we'll add a section break to separate a paragraph from a two-column list. 

1. Place the insertion point where you want to create the break. In our 
example, we'll place it at the beginning of the paragraph we want to 
separate from two-column formatting. 

 
2. On the Page Layout tab, click the Breaks command, then select the 

desired section break from the drop-down menu. In our example, we'll 
select Continuous so our paragraph remains on the same page as the 
columns. 
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3. A section break will appear in the document. 

 
4. The text before and after the section break can now be formatted 

separately. In our example, we'll apply one-column formatting to the 
paragraph. 
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5. The formatting will be applied to the current section of the document. In 

our example, the text above the section break uses two-column 
formatting, while the paragraph below the break uses one-column 
formatting. 

 
Other types of breaks 
When you want to format the appearance of columns or modify text wrapping around an 
image, Word offers additional break options that can help: 

 Column: When creating multiple columns, you can apply a column break 
to balance the appearance of the columns. Any text following the column 
break will begin in the next column. To learn more about how to create 
columns in your document, visit our lesson on Columns. 

 Text wrapping: When text has been wrapped around an image or object, 
you can use a text-wrapping break to end the wrapping and begin typing 
on the line below the image. Review our lesson on Pictures and Text 
Wrapping to learn more. 
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To delete a break: 
By default, breaks are hidden. If you want to delete a break, you'll first need to show the 
breaks in your document. 

1. On the Home tab, click the Show/Hide command. 

 
2. Locate the break you want to delete, then place the insertion point at the 

beginning of the break. 

 
3. Press the Delete key. The break will be deleted from the document. 
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Columns 
Sometimes the information you include in your document is best displayed in columns. 
Not only can columns help improve readability, but some types of documents—like 
newspaper articles, newsletters, and flyers—are often written in column format. Word 
also allows you to adjust your columns by adding column breaks. 
To add columns to a document: 

1. Select the text you want to format. 

 
2. Select the Layout tab, then click the Columns command. A drop-down 

menu will appear. 
3. Select the number of columns you want to create. 
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4. The text will format into columns. 

 
Your column choices aren't limited to the drop-down menu that appears. Select More 
Columns at the bottom of the menu to access the Columns dialog box. Click the arrows 
next to Number of columns: to adjust the number of columns. 

 
If you want to adjust the spacing and alignment of columns, click and drag the indent 
markers on the Ruler until the columns appear the way you want. 
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To remove columns: 
To remove column formatting, place the insertion point anywhere in the columns, then 
click the Columns command on the Layout tab. Select One from the drop-down menu 
that appears. 

 
Adding column breaks 
Once you've created columns, the text will automatically flow from one column to the 
next. Sometimes, though, you may want to control exactly where each column begins. 
You can do this by creating a column break. 
To add a column break: 
In our example below, we'll add a column break that will move text to the beginning of 
the next column. 

1. Place the insertion point at the beginning of the text you want to move. 
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2. Select the Layout tab, then click the Breaks command. A drop-down menu 

will appear. 
3. Select Column from the menu. 

 
4. The text will move to the beginning of the column. In our example, it 

moved to the beginning of the next column. 
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To remove column breaks: 

1. By default, breaks are hidden. If you want to show the breaks in your 
document, click the Show/Hide command on the Home tab. 

 
2. Place the insertion point to the left of the break you want to delete. 

 
3. Press the delete key to remove the break. 
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Headers and Footers 
 
The header is a section of the document that appears in the top margin, while the footer 
is a section of the document that appears in the bottom margin. Headers and footers 
generally contain additional information such as page numbers, dates, an author's name, 
and footnotes, which can help keep longer documents organized and make them easier 
to read. Text entered in the header or footer will appear on each page of the document. 
To create a header or footer: 
In our example, we want to display the author's name at the top of each page, so we'll 
place it in the header. 

1. Double-click anywhere on the top or bottom margin of your document. In 
our example, we'll double-click the top margin. 

 
2. The header or footer will open, and a Design tab will appear on the right 

side of the Ribbon. The insertion point will appear in the header or footer. 
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3. Type the desired information into the header or footer. In our example, 

we'll type the author's name and the date. 

 
4. When you're finished, click Close Header and Footer. Alternatively, you 

can press the Esc key. 

 
5. The header or footer text will appear. 
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To insert a preset header or footer: 
Word has a variety of preset headers and footers you can use to enhance your 
document's design and layout. In our example, we'll add a preset header to our 
document. 

1. Select the Insert tab, then click the Header or Footer command. In our 
example, we'll click the Header command. 

 
2. In the menu that appears, select the desired preset header or footer. 
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3. The header or footer will appear. Many preset headers and footers 
contain text placeholders called Content Control fields. These fields are 
good for adding information like the document title, author's name, date, 
and page number. 

 
4. To edit a Content Control field, click it and type the desired information. 

 
5. When you're finished, click Close Header and Footer. Alternatively, you 

can press the Esc key. 

 
If you want to delete a Content Control field, right-click it and select Remove Content 
Control from the menu that appears. 
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Editing headers and footers 
After you close the header or footer, it will still be visible, but it will be locked. Simply 
double-click a header or footer to unlock it, which will allow you to edit it. 

 
Design tab options 
When your document's header and footer are unlocked, the Design tab will appear on 
the right side of the Ribbon, giving you various editing options: 

 Hide the first-page header and footer: For some documents, you may not 
want the first page to show the header and footer, like if you have a cover 
page and want to start the page numbering on the second page. If you 
want to hide the first-page header and footer, check the box next 
to Different First Page. 

 
 Remove the header or footer: If you want to remove all information 

contained in the header, click the Header command and select Remove 
Header from the menu that appears. Similarly, you can remove a footer 
using the Footer command. 
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 Page Number: You can automatically number each page with the Page 

Number command. Read our Page Numbers lesson to learn more. 

 
 Additional options: With the commands available in the Insert group, you 

can add the date and time, document info, pictures, and more to your 
header or footer. 

 
To insert the date or time into a header or footer: 
Sometimes it's helpful to include the date or time in the header or footer. For example, 
you may want your document to show the date when it was created. 

http://www.gcflearnfree.org/word2016/page-numbers/1/
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On the other hand, you may want to show the date when it was printed, which you can 
do by setting it to update automatically. This is useful if you frequently update and print 
a document because you'll always be able to tell which version is the most recent. 

1. Double-click anywhere on the header or footer to unlock it. Place 
the insertion point where you want the date or time to appear. In our 
example, we'll place the insertion point on the line below the author's 
name. 

 
2. The Design tab will appear. Click the Date & Time command. 

 
3. The Date and Time dialog box will appear. Select the desired date or time 

format. 
4. Check the box next to Update Automatically if you want the date to 

change every time you open the document. If you don't want the date to 
change, leave this option unchecked. 

5. Click OK. 

 
6. The date will appear in the header. 
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Page Numbers 
 
Page numbers can be used to automatically number each page in your document. They 
come in a wide range of number formats and can be customized to suit your needs. Page 
numbers are usually placed in the header, footer, or side margin. When you need to 
number some pages differently, Word allows you to restart page numbering. 
To add page numbers: 
Word can automatically label each page with a page number and place it in a header, 
footer, or side margin. If you have an existing header or footer, it will be removed and 
replaced with the page number. 

1. On the Insert tab, click the Page Number command. 

 
2. Open the Top of Page, Bottom of Page, or Page Margin menu, depending 

on where you want the page number to be positioned. Then select the 
desired style of header. 
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3. Page numbering will appear. 

 
4. Press the Esc key to lock the header and footer. 
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5. If you need to make any changes to your page numbers, simply double-

click the header or footer to unlock it. 
If you've created a page number in the side margin, it's still considered part of 
the header or footer. You won't be able to select the page number unless the header or 
footer is selected. 
To add page numbers to an existing header or footer: 
If you already have a header or footer and you want to add a page number to it, Word 
has an option to automatically insert the page number into the existing header or footer. 
In our example, we'll add page numbering to our document's header. 

1. Double-click anywhere on the header or footer to unlock it. 

 
2. On the Design tab, click the Page Number command. In the menu that 

appears, hover the mouse over Current Position and select the 
desired page numbering style. 
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3. Page numbering will appear. 

 
4. When you're finished, press the Esc key. 

 
To hide the page number on the first page: 
In some documents, you may not want the first page to show the page number. You 
can hide the first page number without affecting the rest of the pages. 

1. Double-click the header or footer to unlock it. 
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2. From the Design tab, place a check mark next to Different First Page. The 
header and footer will disappear from the first page. If you want, you can 
type something new in the header or footer, and it will only affect the 
first page. 

 
If you're unable to select Different First Page, it may be because an object within the 
header or footer is selected. Click in an empty area within the header or footer to make 
sure nothing is selected. 
To restart page numbering: 
Word allows you to restart page numbering on any page of your document. You can do 
this by inserting a section break and selecting the number you want to restart the 
numbering with. In our example, we'll restart the page numbering for our 
document's Works Cited section. 

1. Place the insertion point at the top of the page you want to restart page 
numbering for. If there is text on the page, place the insertion point at 
the beginning of the text. 

 
2. Select the Layout tab, then click the Breaks command. Select Next 

Page from the drop-down menu that appears. 
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3. A section break will be added to the document. 
4. Double-click the header or footer containing the page number you want 

to restart. 

 
5. Click the Page Number command. In the menu that appears, 

select Format Page Numbers. 

 
6. A dialog box will appear. Click the Start at: button. By default, it will start 

at 1. If you want, you can change the number. When you're done, 
click OK. 
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7. The page numbering will restart. 

 
 

Lesson 12: Working with Objects 
Pictures and Text Wrapping 
Adding pictures to your document can be a great way to illustrate important information 
and add decorative accents to existing text. Used in moderation, pictures can improve 
the overall appearance of your document. 
To insert a picture from a file: 
If you have a specific image in mind, you can insert a picture from a file. In our example, 
we'll insert a picture saved locally on our computer. If you'd like to work along with our 
example, right-click the image below and save it to your computer. 

 
1. Place the insertion point where you want the image to appear. 
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2. Select the Insert tab on the Ribbon, then click the Pictures command. 

 
3. The Insert Picture dialog box will appear. Navigate to the folder where 

your image is located, then select the image and click Insert. 
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4. The image will appear in the document. 

 
To resize an image, click and drag one of the corner sizing handles. The image will change 
size while keeping the same proportions. If you want to stretch it horizontally or 
vertically, you can use the side sizing handles. 
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Page Break 
Changing text wrapping settings 
When you insert a picture from a file, you may notice that it's difficult to move it exactly 
where you want. This is because the text wrapping for the image is set to In Line with 
Text. You'll need to change the text wrapping setting if you want to move the image 
freely, or if you just want the text to wrap around the image in a more natural way. 
To wrap text around an image: 

1. Select the image you want to wrap text around. The Format tab will 
appear on the right side of the Ribbon. 

 
2. On the Format tab, click the Wrap Text command in the Arrange group. 

Then select the desired text wrapping option. In our example, we'll 
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select In Front of Text so we can freely move it without affecting the text. 
Alternatively, you can select More Layout Options to fine tune the layout.

 
3. The text will wrap around the image. You can now move the image if you 

want. Just click and drag it to the desired location. As you move 
it, alignment guides will appear to help you align the image on the page. 

 
Alternatively, you can access text wrapping options by selecting the image and clicking 
the Layout Options button that appears. 
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If the alignment guides do not appear, select the Page Layout tab, then click the Align 
command. Select Use Alignment Guides from the drop-down menu that appears. 

 
Using a predefined text wrapping setting 
Predefined text wrapping allows you to quickly move the image to a specific location on 
the page. The text will automatically wrap around the object so it's still easy to read. 
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Inserting online pictures 
If you don't have the picture you want on your computer, you can find a picture online to 
add to your document. Word offers two options for finding online pictures. 

 OneDrive: You can insert an image stored on your OneDrive. You can also 
link other online accounts with your Microsoft account, such as Facebook 
and Flickr. 

 
 Bing Image Search: You can use this option to search the Internet for 

images. By default, Bing only shows images that are licensed 
under Creative Commons, which means you can use them for your own 
projects. However, you should click the link to the image's website to see 
if there are any restrictions on how it can be used. 
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To insert an online picture: 

1. Place the insertion point where you want the image to appear. 

 
2. Select the Insert tab, then click the Online Pictures command. 

 
3. The Insert Pictures dialog box will appear. 
4. Choose Bing Image Search or your OneDrive. In our example, we'll use 

Bing Image Search. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  266 | 1352  

 
5. Press the Enter key. Your search results will appear in the box. 
6. Select the desired image, then click Insert. 

 
7. The image will appear in the document. 
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Formatting Pictures 
There are many ways to format pictures in Word. For instance, you can change the size 
or shape of an image to better suit your document. You can also enhance its appearance 
using Word's image adjustment tools. 
To crop an image: 
When you crop an image, part of the picture is removed. Cropping can be useful if you're 
working with an image that's too big and you want to focus on only part of it. 

1. Select the image you want to crop. The Format tab will appear. 
2. From the Format tab, click the Crop command. 

 
3. Cropping handles will appear on the sides and corners of the image. Click 

and drag any handle to crop the image. Because the cropping handles are 
near the resizing handles, be careful not to drag a resizing handle by 
mistake. 

 
4. To confirm, click the Crop command again. The image will be cropped. 

 
The corner handles are useful for simultaneously cropping the 
image horizontally and vertically. 
To crop an image to a shape: 

1. Select the image you want to crop, then click the Format tab. 
2. Click the Crop drop-down arrow. Hover over Crop to Shape, then select 

the desired shape from the drop-down menu. 
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3. The image will be cropped to the chosen shape. 

 
To add a border to a picture: 

1. Select the picture you want to add a border to, then click the Format tab. 
2. Click the Picture Border command. A drop-down menu will appear. 
3. From here, you can select a color, weight (thickness), and whether the 

line is dashed. 
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4. The border will appear around the image. 

Making image adjustments 
With Word's image adjustment tools, you can easily fine tune properties like color, 
contrast, saturation, and tone. Word also offers built-in picture styles, which can be used 
to add a frame, drop shadow, and other predefined effects. 
When you're ready to adjust an image, simply select it. Then use the options below, 
which can be found on the Format tab. 

 
Corrections 
From here, you can sharpen or soften the image to adjust how clear or blurry it appears. 
You can also adjust brightness and contrast, which affect the image's lightness and 
general intensity. 
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Color 
Using this command, you can adjust the image's saturation (how vibrant the colors 
appear), tone (the color temperature of the image, from cool to warm), and coloring (the 
overall tint of the image). 

 
Artistic Effects 
Here, you can apply special effects to your image, such as pastel, watercolor, or glowing 
edges. Because the results are so bold, you may want to use these effects sparingly 
(especially in professional documents). 
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Picture Styles group 
This group contains many different predefined styles that make image formatting even 
easier. Picture styles are designed to frame your image without changing its basic 
settings or effects. 
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Compressing pictures 
If you plan to email a document that contains pictures, you'll need to monitor its file size. 
Large, high-resolution images can cause your document to become very large, which may 
make it difficult to attach to an email. Additionally, cropped areas of pictures are saved 
within the document by default, which can add to the file size. 
Thankfully, you can reduce your document's file size by compressing your pictures. This 
will lower their resolution and delete cropped areas. 
Compressing a picture may noticeably affect its quality (for instance, the image may 
become blurry or pixelated). Therefore, we recommend saving an extra copy of your 
document before you compress pictures. Alternatively, be prepared to use the Undo 
command if you're dissatisfied with the results. 
To compress a picture: 

1. Select the picture you want to compress, then navigate to the Format tab. 
2. Click the Compress Pictures command. 

 
3. A dialog box will appear. Check the box next to Delete cropped areas of 

pictures. You can also choose whether to apply the settings to this 
picture only or to all pictures in the document. 

4. Choose a Target output. If you are emailing your document, you may 
want to select Email, which produces the smallest file size. 

5. Click OK. 

 
Shapes 
You can add a variety of shapes to your document, including arrows, callouts, squares, 
stars, and flowchart shapes. Want to set your name and address apart from the rest of 
your resume? Use a line. Need to create a diagram showing a timeline or process? Use 
flowchart shapes. While you may not need shapes in every document you create, they 
can add visual appeal and clarity. 
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To insert a shape: 
1. Select the Insert tab, then click the Shapes command. A drop-down menu 

of shapes will appear. 
2. Select the desired shape. 

 
3. Click and drag in the desired location to add the shape to your document. 

 
If you want, you can enter text in a shape. When the shape appears in your document, 
you can begin typing. You can then use the formatting options on the Home tab to 
change the font, font size, or color of the text. 
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To change the order of shapes: 
If one shape overlaps another, you may need to change the ordering so the correct 
shape appears in front. You can bring a shape to the front or send it to the back. If you 
have multiple images, you can use Bring to Front or Send to Back to fine tune the 
ordering. You can also move a shape in front of or behind text. 

1. Right-click the shape you want to move. In our example, we want the 
heart to appear behind the ribbon, so we'll right-click the heart. 

 
2. In the menu that appears, hover over Bring to Front or Send to Back. 

Several ordering options will appear. Select the desired ordering option. 
In this example, we'll choose Send to Back. 

 
3. The order of the shapes will change. 
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In some cases, the ordering option you select will not affect the ordering of the shapes. If 
this happens, try selecting the same option again or try a different option. 
If you have several shapes placed on top of each other, it may be difficult to select an 
individual shape. The Selection pane allows you to select a shape and drag it to a new 
location. To access the Selection pane, click Selection Pane on the Format tab. 

 
To resize a shape: 

1. Select the shape you want to resize. Sizing handles will appear on the 
corners and sides of the shape. 

 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  276 | 1352  

2. Click and drag the sizing handles until the shape is the desired size. You 
can use the corner sizing handles to change the 
shape's height and width at the same time. 

 
3. To rotate the shape, click and drag the rotation handle. 

 
Some shapes also have one or more yellow handles that can be used to modify the 
shape. For example, with banner shapes you can adjust the position of the folds. 

 
Modifying shapes 
Word allows you to modify your shapes in a variety of ways so you can tailor them to 
your projects. You can change a shape into a different shape, format a shape's style and 
color, and add various effects. 
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To change the shape style: 
Choosing a shape style allows you to apply preset colors and effects to quickly change 
the appearance of your shape. 

1. Select the shape you want to change. 

 
2. On the Format tab, click the More drop-down arrow in the Shape 

Styles group. 

 
3. A drop-down menu of styles will appear. Select the style you want to use. 
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4. The shape will appear in the selected style. 
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To change the shape fill color: 
1. Select the shape you want to change. 

 
2. On the Format tab, click the Shape Fill drop-down arrow. Select 

the color you want to use. To view more color options, select More Fill 
Colors. 

 
3. The shape will appear in the selected fill color. 

 
If you want to use a different type of fill, select Gradient or Texture from the drop-down 
menu. You can also select No Fill to make it transparent. 
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To change the shape outline: 
1. Select the shape you want to change. 

 
2. On the Format tab, click the Shape Outline drop-down arrow. The Shape 

Outline menu will appear. 
3. Select the color you want to use. If you want to make the outline 

transparent, select No Outline. 

 
4. The shape will appear in the selected outline color. 

 
From the drop-down menu, you can change the outline color, weight (thickness), and 
whether it is a dashed line. 
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To add shape effects: 

1. Select the shape you want to change. 

 
2. On the Format tab, click the Shape Effects drop-down arrow. In the menu 

that appears, hover the mouse over the style of effect you want to add, 
then select the desired preset effect. 
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3. The shape will appear with the selected effect. 

 
To further adjust your shape effects, select Options at the end of each menu. The Format 
Shape pane will appear, allowing you to customize the effects. 
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To change to a different shape: 
1. Select the shape you want to change. The Format tab will appear. 

 
2. On the Format tab, click the Edit Shape command. In the menu that 

appears, hover the mouse over Change Shape, then select the 
desired shape. 

 
3. The new shape will appear. 
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Text Boxes 
Text boxes can be useful for drawing attention to specific text. They can also be helpful 
when you need to move text around in your document. Word allows you to format text 
boxes and the text within them with a variety of styles and effects. 
To insert a text box: 

1. Select the Insert tab, then click the Text Box command in the Text group. 

 
2. A drop-down menu will appear. Select Draw Text Box. 
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3. Click and drag anywhere on the document to create the text box. 

 
4. The insertion point will appear inside the text box. You can now type to 

create text inside the text box. 
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5. If you want, you can select the text and then change the font, color, 

and size by using the commands on the Format and Home tabs. To learn 
more about using these formatting commands, see our Formatting 
Text lesson. 

 
6. Click anywhere outside the text box to return to your document. 

You can also select one of the built-in text boxes that have predefined colors, fonts, 
positions, and sizes. If you choose this option, the text box will appear automatically, so 
you will not need to draw it. 

http://www.gcflearnfree.org/word2016/formatting-text/1/
http://www.gcflearnfree.org/word2016/formatting-text/1/
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To move a text box: 

1. Click the text box you want to move. 
2. Hover the mouse over one of the edges of the text box. The mouse will 

change into a cross with arrows. 
3. Click and drag the text box to the desired location. 

 
To resize a text box: 

1. Click the text box you want to resize. 
2. Click and drag any of the sizing handles on the corners or sides of the text 

box until it is the desired size. 
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Modifying text boxes 
Word offers several options for changing the way text boxes appear in your document. 
You can change the shape, style, and color of text boxes or add various effects. 
To change the shape style: 
Choosing a shape style allows you to apply preset colors and effects to quickly change 
the appearance of your text box. 

1. Select the text box you want to change. 
2. On the Format tab, click the More drop-down arrow in the Shape 

Styles group. 

 
3. A drop-down menu of styles will appear. Select the style you want to use. 
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4. The text box will appear in the selected style. 

 
If you want to have more control over text box formatting, you can use any of the shape 
formatting options such as Shape Fill and Shape Outline. To learn more, see 
our Shapes lesson. 
To change the text box shape: 
Changing the shape of a text box can be a useful option for creating an interesting look in 
your document. 

1. Select the text box you want to change. The Format tab will appear. 
2. From the Format tab, click the Edit Shape command. 

http://www.gcflearnfree.org/word2016/shapes/1/
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3. Hover the mouse over Change Shape, then select the desired shape from 

the menu that appears. 

 
4. The text box will appear formatted as the shape. 
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Aligning, Ordering, and Grouping Objects 
There may be times when your documents have multiple objects, such as pictures, 
shapes, and text boxes. You can arrange the objects any way you want by aligning, 
grouping, ordering, and rotating them in various ways. 
To align two or more objects: 

1. Hold the Shift (or Ctrl) key and click the objects you want to align. In our 
example, we'll select the four shapes on the right. 

 
2. From the Format tab, click the Align command, then select one of 

the alignment options. In our example, we'll choose Align Right. 

 
3. The objects will be aligned based on the selected option. In our example, 

the shapes are now aligned with each other. 
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Note that the Align Selected Objects option is selected by default, which allows you to 
align objects without moving them to a different part of the page. However, if you want 
to move the objects the top or bottom of the page, select Align to Page or Align to 
Margin before choosing an alignment option. 
To distribute objects evenly: 
If you have arranged your objects in a row or column, you may want them to be an equal 
distance from one another for a neater appearance. You can do this by distributing the 
objects horizontally or vertically. 

1. Hold the Shift (or Ctrl) key and click the objects you want to distribute. 
2. On the Format tab, click the Align command, then select Distribute 

Horizontally or Distribute Vertically. 

 
3. The objects will be evenly spaced from one another. 

 
Grouping objects 
At times, you may want to group multiple objects into one object so they will stay 
together. This is usually easier than selecting them individually, and it also allows you to 
resize and move all of the objects at the same time. 
To group objects: 

1. Hold the Shift (or Ctrl) key and click the objects you want to group. 
2. Click the Group command on the Format tab, then select Group. 
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3. The selected objects will now be grouped. There will be a single box with 

sizing handles around the entire group so you can move or resize all of 
the objects at the same time. 

 
To ungroup objects: 

1. Select the grouped object. From the Format tab, click 
the Group command and select Ungroup. 
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2. The objects will be ungrouped. 

 
Ordering objects 
In addition to aligning objects, Word gives you the ability to arrange objects in a specific 
order. The ordering is important when two or more objects overlap because it 
determines which objects are in the front or the back. 
Understanding levels 
Objects are placed on different levels according to the order in which they were inserted 
into a document. In the example below, if we move the wave’s image to the beginning of 
the document, it covers up several of the text boxes. That's because the image is 
currently on the highest—or top—level. However, we can change its level to put it 
behind the other objects. 
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To change an object's level: 

1. Select the object you want to move. In our example, we'll select the image 
of the waves. 

2. From the Format tab, click the Bring Forward or Send 
Backward command to change the object's ordering by one level. In our 
example, we'll select Send Backward. 

 
3. The objects will be reordered. In our example, the image is now behind 

the text on the left, but it's still covering the shapes on the right. 
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4. If you want to move an object behind or in front of several objects, it's 

usually faster to use Bring Forward or Send Backward instead of clicking 
the other ordering command multiple times. 

 
5. In our example, the image has been moved behind everything else on the 

page, so all of the other text and shapes are visible. 
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If you have several objects placed on top of each other, it may be difficult to select an 
individual object. The Selection Pane allows you to easily drag an object to a different 
level. To view the Selection Pane, click Selection Pane on the Format tab. 

 
To rotate or flip an object: 
If you need to turn an object so it faces a different direction, you can rotate it to the left 
or right, or you can flip it horizontally or vertically. 

1. With the desired object selected, click the Rotate command on 
the Format tab, then choose the desired rotation option. In our example, 
we'll choose Flip Horizontal. 

 
2. The object will be rotated. In our example, we can now see the bubbles on 

the left that were previously hidden behind the text boxes. 
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Tables 
A table is a grid of cells arranged in rows and columns. Tables can be used to organize any 
type of content, whether you're working with text or numerical data. In Word, you can 
quickly insert a blank table or convert existing text to a table. You can also customize 
your table using different styles and layouts. 
To insert a blank table: 

1. Place the insertion point where you want the table to appear. 
2. Navigate to the Insert tab, then click the Table command. 

 
3. This will open a drop-down menu that contains a grid. Hover over the grid 

to select the number of columns and rows you want. 
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4. Click the grid to confirm your selection, and a table will appear. 
5. To enter text, place the insertion point in any cell, then begin typing. 

 
To navigate between cells, use the Tab key or arrow keys on your keyboard. If the 
insertion point is in the last cell, pressing the Tab key will automatically create a new row. 
To convert existing text to a table: 
In the example below, each line of text contains part of a checklist, including chores and 
days of the week. The items are separated by tabs. Word can convert this information 
into a table, using the tabs to separate the data into columns. 

1. Select the text you want to convert to a table. If you're using our practice 
file, you can find this text on page 2 of the document. 

 
2. Go to the Insert tab, then click the Table command. 
3. Select Convert Text to Table from the drop-down menu. 
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4. A dialog box will appear. Choose one of the options under Separate text 

at. This is how Word knows what to put into each column. 

 
5. Click OK. The text will appear in a table. 
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Modifying tables 
You can easily change the appearance of your table once you've added one to your 
document. There are several options for customization, including adding rows or 
columns and changing the table style. 
To add a row or column: 

1. Hover outside the table where you want to add a row or column. Click 
the plus sign that appears. 

 
2. A new row or column will be added to the table. 

 
Alternatively, you can right-click the table, then hover over Insert to see various row and 
column options. 
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To delete a row or column: 

1. Place the insertion point in the row or column you want to delete. 
2. Right-click, then select Delete Cells from the menu. 

 
3. A dialog box will appear. Choose Delete entire row or Delete entire 

column, then click OK. 
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4. The row or column will be deleted. 

To apply a table style: 
Table styles let you change the look and feel of your table instantly. They control several 
design elements, including color, borders, and fonts. 

1. Click anywhere in your table to select it, then click the Design tab on the 
far right of the Ribbon. 

 
2. Locate the Table Styles group, then click the More drop-down arrow to 

see the full list of styles. 

 
3. Select the table style you want. 
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4. The table style will appear. 

 
To modify table style options: 
Once you've chosen a table style, you can turn various options on or off to change its 
appearance. There are six options: Header Row, Total Row, Banded Rows, First 
Column, Last Column, and Banded Columns. 

1. Click anywhere in your table, then navigate to the Design tab. 
2. Locate the Table Style Options group, then check or uncheck the desired 

options. 

 
3. The table style will be modified. 
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Depending on the Table Style you've chosen, certain Table Style Options may have a 
different effect. You might need to experiment to get the look you want. 
To apply borders to a table: 

1. Select the cells you want to apply a border to. 

 
2. Use the commands on the Design tab to choose the desired Line 

Style, Line Weight, and Pen Color. 

 
3. Click the drop-down arrow below the Borders command. 
4. Choose a border type from the menu. 
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5. The border will be applied to the selected cells. 

 
Modifying a table using the Layout tab 
In Word, the Layout tab appears whenever you select your table. You can use the options 
on this tab to make a variety of modifications. 
Click the buttons in the interactive below to learn more about Word's table layout 
controls. 
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Charts 
A chart is a tool you can use to communicate information graphically. Including a chart in 
your document can help you illustrate numerical data—such as comparisons and 
trends—so it's easier for the reader to understand. 
Types of charts 
There are several types of charts to choose from. To use charts effectively, you'll need to 
understand what makes each one unique. 
Click the arrows in the slideshow below to learn more about the types of charts in Word. 

 
Word has a variety of chart types, each with its own advantages. Click 
the arrows to see some of the different types of charts available in 
Word. 
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Column charts use vertical bars to represent data. They can work with 
many different types of data, but they're most frequently used for 
comparing information. 
 

  
Line charts are ideal for showing trends. The data points are 
connected with lines, making it easy to see whether values are 
increasing or decreasing over time. 
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Pie charts make it easy to compare proportions. Each value is shown 
as a slice of the pie, so it's easy to see which values make up the 
percentage of a whole. 

  
Bar charts work just like column charts, but they use horizontal rather 
than vertical bars. 
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Area charts are similar to line charts, except the areas under the lines 
are filled in. 

  
Surface charts allow you to display data across a 3D landscape. They 
work best with large data sets, allowing you to see a variety of 
information at the same time. 

Identifying the parts of a chart 
In addition to chart types, you'll need to understand how to read a chart. Charts contain 
several different elements—or parts—that can help you interpret data. 
Click the buttons in the interactive below to learn about the different parts of a chart. 

 
Inserting charts 
Word utilizes a separate spreadsheet window for entering and editing chart data, much 
like a spreadsheet in Excel. The process of entering data is fairly simple, but if you're 
unfamiliar with Excel, you might want to review our Cell Basics lesson. 
To insert a chart: 

1. Place the insertion point where you want the chart to appear. 
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2. Navigate to the Insert tab, then click the Chart command in 
the Illustrations group. 

 
3. A dialog box will appear. To view your options, choose a chart type from 

the left pane, then browse the charts on the right. 
4. Select the desired chart, then click OK. 

 
5. A chart and spreadsheet window will appear. The text in the spreadsheet 

is merely a placeholder that you'll need to replace with your own source 
data. The source data is what Word will use to create the chart. 
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6. Enter your source data into the spreadsheet. 

 
7. Only the data enclosed in the blue box will appear in the chart. If 

necessary, click and drag the lower-right corner of the blue box to 
manually increase or decrease the data range. 

 
8. When you're done, click X to close the spreadsheet window. 
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9. The chart will be complete. 

 
To edit your chart again, simply select it, then click the Edit Data command on 
the Design tab. The spreadsheet window will reappear. 

 
Creating charts with existing Excel data 
If you already have data in an existing Excel file that you'd like to use in Word, you 
can copy and paste it instead of entering it by hand. Just open the spreadsheet in Excel, 
copy the data, then paste it as the source data in Word. 
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You can also embed an existing Excel chart into your Word document. This is useful if you 
know you're going to be updating your Excel file later; the chart in Word will update 
automatically any time a change is made. 
Read our guide on Embedding an Excel Chart for more information. 
Modifying charts with chart tools 
There are many ways to customize and organize your chart in Word. For example, you 
can quickly change the chart type, rearrange the data, and even change the 
chart's appearance. 
To switch row and column data: 
Sometimes you may want to change the way your chart data is grouped. For example, in 
the chart below the data is grouped by genre, with columns for each month. If we 
switched the rows and columns, the data would be grouped by month instead. In both 
cases, the chart contains the same data—it's just presented in a different way. 

1. Select the chart you want to modify. The Design tab will appear on the 
right side of the Ribbon. 

 
2. From the Design tab, click the Edit Data command in the Data group. 

 
3. Click the chart again to reselect it, then click the Switch 

Row/Column command. 

https://edu.gcfglobal.org/en/word2013/embedding-an-excel-chart/1/
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4. The rows and columns will be switched. In our example, the data is now 

grouped by month, with columns for each genre. 

 
To change the chart type: 
If you find that your chosen chart type isn't suited to your data, you can change it to a 
different one. In our example, we'll change the chart type from a column chart to 
a line chart. 

1. Select the chart you want to change. The Design tab will appear. 
2. From the Design tab, click the Change Chart Type command. 

 
3. A dialog box will appear. Select the desired chart, then click OK. 
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4. The new chart type will be applied. In our example, the line chart makes it 

easier to see trends over time. 

 
To change the chart layout: 
To change the arrangement of your chart, try choosing a different layout. Layout can 
affect several elements, including the chart title and data labels. 

1. Select the chart you want to modify. The Design tab will appear. 
2. From the Design tab, click the Quick Layout command. 
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3. Choose the desired layout from the drop-down menu. 

 
4. The chart will update to reflect the new layout. 

 
If you don't see a chart layout that has exactly what you need, you can click the Add 
Chart Element command on the Design tab to add axis titles, gridlines, and other chart 
elements. 
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To fill in a placeholder (such as the chart title or axis title), click the element and enter 
your text. 

 
To change the chart style: 
Word's chart styles give you an easy way to change your chart's design, including the 
color, style, and certain layout elements. 

1. Select the chart you want to modify. The Design tab will appear. 
2. From the Design tab, click the More drop-down arrow in the Chart 

Styles group. 

 
3. A drop-down menu of styles will appear. Select the style you want. 

 
4. The chart style will be applied. 
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For even faster customization, use the formatting shortcuts to the right of your chart. 
These allow you to adjust the chart style, chart elements, and even add filters to your 

data. 
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Lesson 13: Collaboration and Reviewing 

Checking Spelling and Grammar 
Worried about making mistakes when you type? Don't be. Word provides you with 
several proofing features—including the Spelling and Grammar tool—that can help you 
produce professional, error-free documents. 
To run a Spelling and Grammar check: 

1. From the Review tab, click the Spelling & Grammar command. 

 
2. The Spelling and Grammar pane will appear on the right. For each error in 

your document, Word will try to offer one or more suggestions. You can 
select a suggestion and click Change to correct the error. 

 
3. Word will move through each error until you have reviewed all of them. 

After the last error has been reviewed, a dialog box will appear 
confirming that the spelling and grammar check is complete. Click OK. 

 
If no suggestions are given, you can manually type the correct spelling in your document. 
Ignoring "errors" 
The spelling and grammar check is not always correct. Particularly with grammar, there 
are many errors Word will not notice. There are also times when the spelling and 
grammar check will say something is an error when it's actually not. This often happens 
with names and other proper nouns, which may not be in the dictionary. 
If Word says something is an error, you can choose not to change it. Depending on 
whether it's a spelling or grammatical error, you can choose from several options. 
For spelling "errors": 

 Ignore: This will skip the word without changing it. 
 Ignore All: This will skip the word without changing it, and it will also skip 

all other instances of the word in the document. 
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 Add: This adds the word to the dictionary so it will never come up as an 
error. Make sure the word is spelled correctly before choosing this 
option. 

 
For grammar "errors": 

 Ignore: This will skip the word or phrase without changing it. 

 
For some grammatical errors, Word will provide an explanation for why it thinks 
something is incorrect. This can help you determine whether you want to change or 
ignore it. 
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Automatic spelling and grammar checking 
By default, Word automatically checks your document for spelling and grammar errors, 
so you may not even need to run a separate check. These errors are indicated by colored 
wavy lines. 

 The red line indicates a misspelled word. 
 The blue line indicates a grammatical error, including misused words. 

 
A misused word—also known as a contextual spelling error—occurs when a word is 
spelled correctly but used incorrectly. For example, if you used the phrase Deer Mr. 
Theodore at the beginning of a letter, deer would be a contextual spelling error. Deer is 
spelled correctly, but it is used incorrectly in the letter. The correct word is dear. 
To correct spelling errors: 

1. Right-click the underlined word, then select the correct spelling from the 
list of suggestions. 
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2. The corrected word will appear in the document. 

You can also choose to Ignore All instances of an underlined word or add it to 
the dictionary. 
To correct grammar errors: 

1. Right-click the underlined word or phrase, then select the correct spelling 
or phrase from the list of suggestions. 

 
2. The corrected phrase will appear in the document. 

To change the automatic spelling and grammar check settings: 
1. Click the File tab to access backstage view, then click Options. 
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2. A dialog box will appear. On the left side of the dialog box, 
select Proofing. From here, you have several options to choose from. For 
example, if you don't want Word to mark spelling errors, grammar errors, 
or frequently confused words automatically, simply uncheck the desired 
option. 
 

 
If you've turned off the automatic spelling and/or grammar checks, you can still go to 
the Review tab and click the Spelling & Grammar command to run a new check. 
To hide spelling and grammar errors in a document: 
If you're sharing a document like a resume with someone, you might not want that 
person to see the red and blue lines. Turning off the automatic spelling and grammar 
checks only applies to your computer, so the lines may still show up when someone else 
views your document. Fortunately, Word allows you to hide spelling and grammar errors 
so the lines will not show up on any computer. 

1. Click the File tab to go to backstage view, then click Options. 
2. A dialog box will appear. Select Proofing, then check the box next to Hide 

spelling errors in this document only and Hide grammar errors in this 
document only, then click OK. 

 
3. The lines in the document will be hidden. 
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Track Changes and Comments 
Let's say someone asks you to proofread or collaborate on a document. If you had a 
printed copy, you might use a red pen to cross out sentences, mark misspellings, and add 
comments in the margins. Word allows you to do all of these things electronically using 
the Track Changes and Comments features. 
Understanding Track Changes 
When you turn on Track Changes, every change you make to the document will appear 
as a colored markup. If you delete text, it won't disappear—instead, the text will 
be crossed out. If you add text, it will be underlined. This allows you to see edits before 
making the changes permanent. 

 
If there are multiple reviewers, each person will be assigned a different markup color. 
To turn on Track Changes: 

1. From the Review tab, click the Track Changes command. 

 
2. Track Changes will be turned on. From this point on, any changes you 

make to the document will appear as colored markups. 

 
Reviewing changes 
Tracked changes are really just suggested changes. To become permanent, they must 
be accepted. On the other hand, the original author may disagree with some of the 
tracked changes and choose to reject them. 
To accept or reject changes: 

1. Select the change you want to accept or reject. 

 
2. From the Review tab, click the Accept or Reject command. 
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3. The markup will disappear, and Word will automatically jump to the next 

change. You can continue accepting or rejecting each change until you 
have reviewed all of them. 

 
4. When you're finished, click the Track Changes command to turn off Track 

Changes. 

 
To accept all changes at once, click the Accept drop-down arrow, then select Accept All. 
If you no longer want to track your changes, you can select Accept All and Stop Tracking. 
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Track Changes viewing options 
If you have a lot of tracked changes, they may become distracting if you're trying to read 
through a document. Fortunately, Word provides a few ways to customize how tracked 
changes appear: 

 Simple Markup: This shows the final version without inline markups. Red 
markers will appear in the left margin to indicate where a change has 
been made. 

 All Markup: This shows the final version with inline markups. 
 No Markup: This shows the final version and hides all markups. 
 Original: This shows the original version and hides all markups. 

To hide tracked changes: 
1. From the Review tab, click the Display for Review command. The Display 

for Review command is located to the right of the Track Changes 
command. 

 
2. Select the desired option from the drop-down menu. In our example, we'll 

select No Markup to preview the final version of the document before 
accepting the changes. 
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You can also click the marker in the left margin to switch between Simple 
Markup and All Markup. 

 
Remember that hiding Track Changes is not the same as reviewing changes. You will still 
need to accept or reject the changes before sending out the final version of your 
document. 
To show revisions in balloons: 
By default, most revisions appear inline, meaning the text itself is marked. You can also 
choose to show the revisions in balloons, which moves most revisions to the right 
margin. Removing inline markups can make the document easier to read, and balloons 
also give you more detailed information about some markups. 

1. From the Review tab, click Show Markup > Balloons > Show Revisions in 
Balloons. 

 
2. Most revisions will appear in the right margin, although any added text 

will still appear inline. 
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To go back to inline markups, you can select either Show All Revisions Inline or Show 
Only Comments and Formatting in Balloons. 
Comments 
Sometimes you may want to add a comment to provide feedback instead of editing a 
document. While it's often used in combination with Track Changes, you don't 
necessarily need to have Track Changes turned on to add comments. 
To add comments: 

1. Highlight some text, or place the insertion point where you want the 
comment to appear. 

 
2. From the Review tab, click the New Comment command. 

 
3. Type your comment. When you're done, you can close the comment box 

by pressing the Esc key or by clicking anywhere outside the comment box. 

 
To delete comments: 

1. Select the comment you want to delete. 
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2. From the Review tab, click the Delete command. 

 
3. The comment will be deleted. 

To delete all comments, click the Delete drop-down arrow and select Delete All 
Comments in Document. 

 
Comparing documents 
If you edit a document without tracking changes, it's still possible to use reviewing 
features such as Accept and Reject. You can do this by comparing two versions of the 
document. All you need is the original document and the revised document (the 
documents must also have different file names). 
To compare two documents: 

1. From the Review tab, click the Compare command, then 
select Compare from the drop-down menu. 
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2. A dialog box will appear. Choose your Original document by clicking the 

drop-down arrow and selecting the document from the list. If the file is 
not in the list, click the Browse button to locate it. 

3. Choose the Revised document, then click OK. 

 
4. Word will compare the two files to determine what was changed and then 

create a new document. The changes will appear as colored markups, just 
like Track Changes. You can then use the Accept and Reject commands to 
finalize the document. 
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Inspecting and Protecting Documents 
Before sharing a document, you'll want to make sure it doesn't include any information 
you want to keep private. You may also want to discourage others from editing your file. 
Fortunately, Word includes several tools to help inspect and protect your document. 
Document Inspector 
Whenever you create or edit a document, certain personal information may be added to 
the file automatically—for example, information about the document's author. You can 
use Document Inspector to remove this type of information before sharing a document 
with others. 
Because some changes may be permanent, it's a good idea to use Save As to create a 
backup copy of your document before using Document Inspector. 
To use Document Inspector: 

1. Click the File tab to go to Backstage view. 
2. From the Info pane, click Check for Issues, then 

select Inspect Document from the drop-down menu. 
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3. Document Inspector will appear. Check or uncheck the boxes, depending 

on the content you want to review, then click Inspect. In our example, 
we'll leave everything selected. 

 
4. The inspection results will show an exclamation mark for any categories 

where it found potentially sensitive data, and it will also have a Remove 
All button for each of these categories. Click Remove All to remove the 
data. 
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5. When you're done, click Close. 

Protecting your document 

By default, anyone with access to your document will be able to open, copy, and edit its 
content unless you protect it. There are several ways to protect a document, depending 
on your needs. 
To protect your document: 

1. Click the File tab to go to Backstage view. 
2. From the Info pane, click the Protect Document command. 
3. In the drop-down menu, choose the option that best suits your needs. In 

our example, we'll select Mark as Final. Marking your document as final is 
a good way to discourage others from editing the file, while other options 
give you more control if you need it. 
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4. A dialog box will appear prompting you to save. Click OK. 

 
5. Another dialog box will appear. Click OK. 

 
6. The document will be marked as final. Whenever others open the file, a 

bar will appear at the top to discourage them from editing the document. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  336 | 1352  

 
Marking a document as final will not actually prevent others from editing it because they 
can just select Edit Anyway. If you want to prevent people from editing the document, 
you can use the Restrict Access option instead. 
 

Lesson 14: Doing More with Word 

SmartArt Graphics 
SmartArt allows you to communicate information with graphics instead of just using text. 
There are a variety of styles to choose from, which you can use to illustrate many 
different types of ideas. 
To insert a SmartArt graphic: 

1. Place the insertion point in the document where you want the SmartArt 
graphic to appear. 

2. From the Insert tab, select the SmartArt command in 
the Illustrations group. 

 
3. A dialog box will appear. Select a category on the left, choose the desired 

SmartArt graphic, then click OK. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  337 | 1352  

 
4. The SmartArt graphic will appear in your document. 

 
To add text to a SmartArt graphic: 

1. Select the SmartArt graphic. The text pane should appear on the left side. 
If it doesn't appear, you can click the small arrow on the left edge of the 
graphic. 

2. Enter text next to each bullet in the text pane. The text will appear in the 
corresponding shape. It will be resized automatically to fit inside the 
shape. 
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You can also add text by clicking the desired shape and then typing. This works well if you 
only need to add text to a few shapes. However, for more complex SmartArt graphics, 
working in the text pane is often quicker and easier. 

 
To reorder, add, and delete shapes: 
It's easy to add new shapes, change their order, and even delete shapes from your 
SmartArt graphic. You can do all of this in the text pane, and it's a lot like creating an 
outline with a multilevel list. For more information on multilevel lists, you may want to 
review our Lists lesson. 

 To demote a shape, select the desired bullet, then press the Tab key. The 
bullet will move to the right, and the shape will move down one level. 

http://www.gcflearnfree.org/word2016/lists/1/
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 To promote a shape, select the desired bullet, then press 

the Backspace key (or Shift+Tab). The bullet will move to the left, and the 
shape will move up one level. 

 
 To add a new shape, place the insertion point after the desired bullet, 

then press Enter. A new bullet will appear in the text pane, and a new 
shape will appear in the graphic. 
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 To remove a shape, keep pressing Backspace until the bullet is deleted. 

The shape will then be removed. In our example, we'll delete all of the 
shapes without text. 

 
Organizing SmartArt from the Design tab 
If you'd prefer not to use the text pane to organize your SmartArt, you can use the 
commands on the Design tab in the Create Graphic group. Just select the shape you want 
to modify, then choose the desired command. 

 Promote and Demote: Use these commands to move a shape up or down 
between levels. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  341 | 1352  

 
 Move Up and Move Down: Use these commands to change the order of 

shapes on the same level. 

 
 Add Shape: Use this command to add a new shape to your graphic. You 

can also click the drop-down arrow for more exact placement options. 
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In our example, we've been organizing a graphic with a hierarchical layout. Not all 
SmartArt graphics use this type of layout, so remember that these commands may work 
differently (or not at all) depending on the layout of your graphic. 
Customizing SmartArt 
After inserting SmartArt, there are several things you might want to change about its 
appearance. Whenever you select a SmartArt graphic, the Design and Format tabs will 
appear on the right side of the Ribbon. From there, it's easy to edit 
the style and layout of a SmartArt graphic. 

 There are several SmartArt styles, which allow you to quickly modify the 
look and feel of your SmartArt. To change the style, select the desired 
style from the SmartArt styles group. 
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 You have a variety of color schemes to use with SmartArt. To change the 

colors, click the Change Colors command and choose the desired option 
from the drop-down menu. 
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 You can also customize each shape independently. Just select any shape in 

the graphic, then choose the desired option from the Format tab. 
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To change the SmartArt layout: 
If you don't like the way your information is organized within a SmartArt graphic, you can 
always change its layout to better fit your content. 

1. From the Design tab, click the More drop-down arrow in the Layouts 
group. 

 
2. Choose the desired layout, or click More Layouts to see even more 

options. 
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3. The selected layout will appear. 

 
If the new layout is too different from the original, some of your text may not appear. 
Before deciding on a new layout, check carefully to make sure no important information 
will be lost. 
 
Applying and Modifying Styles 
A style is a predefined combination of font style, color, and size that can be applied to 
any text in your document. Styles can help your documents achieve a more professional 
look and feel. You can also use styles to quickly change several things in your document 
at the same time. 
To apply a style: 

1. Select the text you want to format, or place your cursor at the beginning 
of the line. 
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2. In the Styles group on the Home tab, click the More drop-down arrow. 

 
3. Select the desired style from the drop-down menu. 
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4. The text will appear in the selected style. 

 
To apply a style set: 
Style sets include a combination of title, heading, and paragraph styles. Style sets allow 
you to format all elements in your document at once instead of modifying each element 
separately. 

1. From the Design tab, click the More drop-down arrow in the Document 
Formatting group. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  349 | 1352  

 
2. Choose the desired style set from the drop-down menu. 

 
3. The selected style set will be applied to your entire document. 
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To modify a style: 

1. In the Styles group on the Home tab, right-click the style you want to 
change and select Modify from the drop-down menu. 

 
2. A dialog box will appear. Make the desired formatting changes, such as 

font style, size, and color. If you want, you can also change the name of 
the style. Click OK to save your changes. 
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3. The style will be modified. 

 
When you modify a style, you're changing every instance of that style in the document. 
In the example below, we've modified the Normal style to use a larger font size. Because 
both paragraphs use the Normal style, they've been updated automatically to use the 
new size. 
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To create a new style: 

1. Click the arrow in the bottom-right corner of the Styles group. 

 
2. The Styles task pane will appear. Select the New Style button at the 

bottom of the task pane. 
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3. A dialog box will appear. Enter a name for the style, choose the desired 

text formatting, then click OK. 

 
4. The new style will be applied to the currently selected text. It will also 

appear in the Styles group. 
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You can also use styles to create a table of contents for your document. To learn how, 
review our article on How to Create a Table of Contents in Microsoft Word. 
 
Mail Merge 
Mail Merge is a useful tool that allows you to produce multiple letters, labels, envelopes, 
name tags, and more using information stored in a list, database, or spreadsheet. When 
performing a Mail Merge, you will need a Word document (you can start with an existing 
one or create a new one) and a recipient list, which is typically an Excel workbook. 
To use Mail Merge: 

1. Open an existing Word document, or create a new one. 
2. From the Mailings tab, click the Start Mail Merge command and 

select Step-by-Step Mail Merge Wizard from the drop-down menu. 

 

http://www.gcflearnfree.org/word-tips/how-to-create-a-table-of-contents-in-word/1/
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The Mail Merge pane will appear and guide you through the six main steps to complete a 
merge. The following example demonstrates how to create a form letter and merge the 
letter with a recipient list. 
Step 1: 

 From the Mail Merge task pane on the right side of the Word window, 
choose the type of document you want to create. In our example, we'll 
select Letters. Then click Next: Starting document to move to Step 2. 
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Step 2: 
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 Select Use the current document, then click Next: Select recipients to 
move to Step 3. 

 
Step 3: 
Now you'll need an address list so Word can automatically place each address into the 
document. The list can be in an existing file, such as an Excel workbook, or you can type 
a new address list from within the Mail Merge Wizard. 

1. Select Use an existing list, then click Browse to select the file. 
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2. Locate your file, then click Open. 
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3. If the address list is in an Excel workbook, select the worksheet that 

contains the list, then click OK. 

 
4. In the Mail Merge Recipients dialog box, you can check or uncheck each 

box to control which recipients are included in the merge. By default, all 
recipients should be selected. When you're done, click OK. 
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5. Click Next: Write your letter to move to Step 4. 

 
If you don't have an existing address list, you can click the Type a new list button and 
click Create, then type your address list manually. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  361 | 1352  

Step 4: 
Now you're ready to write your letter. When it's printed, each copy of the letter will 
basically be the same; only the recipient data (such as the name and address) will be 
different. You'll need to add placeholders for the recipient data so Mail Merge knows 
exactly where to add the data. 
To insert recipient data: 

1. Place the insertion point in the document where you want the 
information to appear. 

 
2. Choose one of the placeholder options. In our example, we'll 

select Address block. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  362 | 1352  

 
3. Depending on your selection, a dialog box may appear with various 

customization options. Select the desired options, then click OK. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  363 | 1352  

 
4. A placeholder will appear in your document (for 

example, «AddressBlock»). 

 
5. Add any other placeholders you want. In our example, we'll add 

a Greeting line placeholder just above the body of the letter. 
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6. When you're done, click Next: Preview your letters to move to Step 5. 
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For some letters, you'll only need to add an Address block and Greeting line. But you can 
also add more placeholders (such as recipients' names or addresses) in the body of the 
letter to personalize it even further. 
Step 5: 

1. Preview the letters to make sure the information from the recipient list 
appears correctly in the letter. You can use the left and right scroll arrows 
to view each version of the document. 

 
2. If everything looks correct, click Next: Complete the merge to move to 

Step 6. 
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Step 6: 

1. Click Print to print the letters. 
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2. A dialog box will appear. Decide if you want to print All of the letters, the 

current document (record), or only a select group, then click OK. In our 
example, we'll print all of the letters. 
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3. The Print dialog box will appear. Adjust the print settings if needed, then 

click OK. The letters will be printed. 

 
 
 
 
 
 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  369 | 1352  

 

MODULE 3: MICROSOFT EXCEL (BASIC TO ADVANCE) 

 
EXCEL BASICS  

Lesson 1 – Getting Started with Excel 
Overview: 

Excel  is  a  spreadsheet program  that  allows  you  to  store,  organize,  and  analyze 
information. Microsoft Excel is one of the most used software applications of all time. 
Hundreds of millions of people around the world use Microsoft Excel. You can use Excel to 
enter all sorts of data and perform financial, mathematical or statistical calculations. 
Microsoft Excel is an office use application designed by Microsoft. It comes with Office 
Suite with several other Microsoft applications, such as Word, PowerPoint, Access, 
Outlook, and OneNote, etc. It is supported in Windows as well as Mac operating system 
too. 
Microsoft Excel is one of the most suitable spreadsheet programs that help us to store and 
represent the data in tabular form, manage and manipulate data, create optically logical 
charts, and more. Excel provides you the worksheet to create a new document in it. You 
can save the Excel file with .xls extension. 
Exploring the excel 2016 environment 
 
Open Excel by using the Start menu or by double-clicking the Desktop icon for Excel 
2016. 
Title Bar 

1. Note the Title Bar section which has window controls at the right end, as in 
other Microsoft Office programs. 

2. Note that a blank workbook opens with a default file name of Book1. 
 
Quick Access Toolbar 

The Quick Access Toolbar is located all 
the way to the left on the Title Bar. It 
contains frequently used commands 
and can be customized using the drop-
down menu. 
1. Point to each small icon to view its ScreenTip. 
2. Be aware that the Undo and 

Repeat buttons commands are 
not located anywhere else in 
the application except for on 
the Quick Access Toolbar. 

3. Click the Customize Quick Access Toolbar button, 
Redo/Repeat 

Customize Undo Save 
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Check New on the menu. Notice how a new button has appeared. 

 
 

4. Click the Customize Quick Access Toolbar button again and select Show 
below the Ribbon. This repositions the toolbar to be below the ribbon. 

 
5. Note that when the toolbar is below the ribbon, its customize button is very 

difficult to see, due to its white color. 
 

 
6. Move the Quick Access Toolbar back above the ribbon by clicking the customize 

button and selecting Show above the Ribbon. 
 
Ribbon 

The ribbon contains all of the tools that you use to 
interact with your Microsoft Excel file. It is located 
at the top of the window. All of the programs in the 
Microsoft Office suite have one. 
The ribbon has a number of tabs, each of which contains buttons, which are 
organized into groups. Try clicking on other tabs to view their buttons (do not click 
the File tab yet), and then return to Home tab. 
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Active Tab 
By default, Excel will open with the Home tab active on the Ribbon. Note how 
the Active tab has a white background, and the Inactive tabs have the opposite. 

 

Contextual Tabs 
Contextual tabs are displayed when certain objects, such as an images and charts, 
are selected. They contain additional options for modifying the object. Contextual 
tabs stand out because they are darker in color and are located to the right of all the 
other tabs. As soon as we start being productive in the program, we will see 
contextual tabs appear. 

 

 

Groups and Buttons 
On each tab, the buttons (a.k.a. commands or tools) are organized into 
Groups. The groups have names, but the names are not clickable. 
Hover over some active buttons on the Home tab to observe ScreenTips. The 
ScreenTips display the name of the button, along with a short description of what 
the button does. 
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Buttons with Arrows 
Note that some buttons have images on them and some have images and an 
arrow. The arrow indicates that more information is needed to carry out the 
function of the button. Some arrowed buttons have two parts: the button 
proper and the list arrow. 

 A one-part arrowed button, called a menu button, will darken completely 
when you point to it: 

1. In the Styles group, point to the Conditional Formatting button. 
2. Note there is no difference in shading between the 

left and right of the button when you point to each 
section. 

 
 

 On a two-part arrowed button, called a split button, only one section at 
a time will darken when you point to it. 

1. In the Font group, point to the left part of the Fill Color 
button. This is the “button proper” section of the button. 
Note how it is darkened separately from the arrow 
portion of the button. 

2. Point to the right portion, the section with the arrow. 
This is the “list arrow” section of the button. Note how it 
is darkened separately from the left portion. 

3. The button proper is the section of a two-part button that will 
carry out the default option or the last used option. 

4. The list arrow section will open an options menu. 
 
 
 
 
 
 
 
Dialogue Box Launcher  

On some groups there is a Launcher button which will open a dialogue box or side 
panel with related but less common commands. 
Click a launcher button, and then close the dialogue box. 

Ribbon Display Options button 
This button provides options that will hide the ribbon from view. The main 
benefit to this is that it allows your spreadsheet to take up more of the screen. 
1. Locate the Ribbon Display Options button (to the left of the window control 

buttons). 
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2. Click on it. Three options appear. 
 

3. Click Auto-hide Ribbon. This option essentially makes Excel go into “full 
screen” mode. It hides not only the ribbon, but also the Quick Access 
Toolbar, title bar, and Window Controls. 

4. To get the ribbon to show after Auto-hiding it: 
a. Point to the top-center of the screen and click. (Clicking the three 

dots does the same thing.) The full ribbon can be seen and used. 
However, as as soon as the body of the spreadsheet is clicked it 
will hide again. 

 

b. Click in the middle of the document. Notice how the ribbon hides again. 
5. To get a partial display of the ribbon to stay in view: 

a. Click the “mini” Ribbon Display Options button on the top right. 
 

b. Click Show Tabs. Note this option has brought back our Quick Access 
Toolbar, title bar, Window Controls, and part of the ribbon; only the 
Tabs are visible. The buttons are not. 

c. Click the Home tab. Notice how the buttons come into view. 
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d. Click in the middle of the spreadsheet. Notice how the buttons disappear 
again. 

 

6. To get the entire ribbon to stay in view: 
a. Click Ribbon Display Options 

b. Click Show Tabs and Commands. This option keeps entire ribbon 
visible at all times. It is the default option. We will keep this option 
selected for the remainder of class. 

Dynamic Resizing 
If you use Excel on other computers, be aware that the button placement on the 
Ribbon might look slightly different. For instance, a button might be a different 
size or be positioned in a slightly different place. The reason for this is that the 
Ribbon auto-adjusts itself based on the size of the Excel window. 
1. Notice what the buttons in the Styles group currently look like. 

 

2. Click the Restore Down button. 
 

3. Notice how the buttons look different now. Rest assured, they are still the same 
buttons. 

 

4. Click the Maximize button to bring the window back to full screen. 
 
File Tab 

The File tab provides a Backstage view of your document. Backstage view gives you 
various options for saving, opening a file, printing, or sharing your document. 
Instead of just a menu, it is a full-page view which makes it easier to work with. 
1. Click the File tab. 

Note: A shortcut for changing to the “Show Tabs” view is to double-click the Active Tab. If 

the buttons in the ribbon suddenly disappear, then you may have done this by accident. 
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2. Notice that the Ribbon and the spreadsheet are no longer in view. Note the 
commands on the left side of the screen that you use to perform actions TO a 
document rather than IN a document. 

3. Other things you can do in the Backstage view: 
a. Click the Info menu option. The Info section of the File tab offers an easy 

to use interface for inspecting documents for hidden properties or 
personal information. 

b. Click the New menu option. In this view you can create a new Blank 
document, or choose from a large selection of Templates. 

c. Click the Open menu option. The Open pane is used to open existing files on 
your computer. 
i. It immediately presents you with a list of documents that you have 

recently opened, so you can quickly find and open them again. The 
computers in the Computer lab have this feature turned off for privacy 
reasons. 

ii. Clicking OneDrive allows you to open a file that is stored in OneDrive, 
which is Microsoft’s internet cloud service. 

iii. Clicking Browse opens a File Explorer dialog, which allows you to find 
the file on your computer. We will be using this option in class. 

d. Notice the two “save” menu options: Save and Save As. There is a 
difference between these settings, which we will explain shortly. 

4. To return to the spreadsheet from the backstage view, click the 
large, left pointing arrow in the top-left corner of the screen. 

 
Workspace: 

Open Excel and locate the parts of the Excel window. 
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 Name Box: Displays the currently selected sell. 

 Formula Bar: Displays the number, text, or formula that is in the currently 
selected cell, and allows you to edit it. It behaves just like a text box. 

 Selected Cell: The selected cell has a dark border around it. 

 Column: Columns run vertically (top to bottom). 

 Column Label: Identifies each column with a letter. Clicking on a column label 
selects the entire column. 

 Row: Rows run horizontally (left to right). 

 Row Label: Identifies each row with a number. Clicking on a row label selects the 
entire row. 

 Cell: The intersection of a row and column. 

 Worksheets: The worksheets contained in the workbook are displayed at the 
bottom-left of the screen. Click on a worksheet to view it. 

 Scroll Bars: Used to view other parts of a worksheet when the entire worksheet 
cannot fit on the screen. 

 View Tools: See Status Bar next 
Status Bar 

The status bar is located below the document window area. 
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Current Information 

The left end gives current information about the spreadsheet. Excel doesn’t have 
much information here. 

Views 
At the right end are shortcuts to the different views that are available. Each 
view displays the spreadsheet in a different way, allowing you to carry out 
various tasks more efficiently. 

 

    Normal This is the view we will be working in throughout this course. It 
simply displays the grid of cells that make up your spreadsheet. 

    Page Layout 
 

Shows what your spreadsheet will look like when printed on paper. 

    Page Break Preview Allows you to add page breaks to your spreadsheet so you can 
better control what parts of the spreadsheet are printed on each 
page. 

Zoom Slider 
Also at the right end of the Status Bar is the Zoom Slider. This allows you to adjust 
how large the spreadsheet is displayed on the screen. It does not adjust the actual 
size of the text—just how big or small they are rendered on the screen (like moving 
a newspaper away from or closer to your eyes). 

 

 
Creating an Excel Document and Saving It 

 
Creating an Excel file 
1. When Excel opens, it will display a blank worksheet ready for you to enter data. The 
data that you enter and the formatting that you use become your document. 
2. In cell A1, type “My first spreadsheet.” 
3. Each spreadsheet you create is temporary unless you save it as a file with a unique 
name and location. 
Saving the File 

1. Click the File tab. 
2. Click the Save As button. (We use Save As instead of Save the first time 

we save a file or whenever we want to save an existing file under a 
different name or change where we save the file.) 

3. Click Browse. 
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4. Notice that a smaller window appears in front of our work. This small window 
is called a dialog box. Because the computer needs to know more than just 
“OK, save,” the dialog box is where we tell it how we want to save our work. 

 

5. When it comes to saving, there are two important things to identify for the 
computer: 

1. The location where the file is going to be saved to. 
2. What name you want to give the file. 

6. The location where it will be saved is displayed for us in the Address field. In 
this case, note that the Documents directory is the default save location, but 
we want to save our file to the flash drive. 

7. Notice other available folders and devices can be seen in the left pane, called 
the navigation pane. If we wanted to save to one of these alternate locations, 
we would have to click on it. 

8. Find the location labeled Kingston (E:) and click on it. Kingston is the name 
of the company that created our flash drive. 

 

 

9. Your address field should now read Computer > Kingston E:). 
 

10. Now we need to name our file. Notice that the file name field is located 
towards the bottom of the dialogue box. 

“Save” or “Open” Button 

File Name Field 

Navigation 

Pane 

Content Pane 

Address field Dialog Box 

Title 

Will be either 

“Save As” or 

“Open” 

Note: If you are taking this class from home and do not have a 

flash drive, use “Documents” as the location to save your files. 
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11. Click in the File Name box and the words will be highlighted. Then enter the 
word first to name your file ‘first’. 

12. Once we have given the computer a file name and a save location, we are 
ready to save. At this point, your Save As dialog box should look like the image 
below. To save, you will click the Save button. 

 

13. Your Excel window will still be open but notice the title bar will now show the file 
name first.xlsx. 

 

 
 
Opening a spreadsheet 
When you first open Excel (by double-clicking the icon or selecting it from the Start 
menu), the application will ask what you want to do. 
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If you want to open a new spreadsheet, click Blank workbook. 
To open an existing spreadsheet (like the example workbook you just downloaded), click 
Open Other Workbooks in the lower-left corner, then click Browse on the left side of the 
resulting window. 
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Then use the file explorer to find the workbook you’re looking for, select it, and click 
Open. 
Differences between Workbook and worksheet: 
Worksheet 

A worksheet is made of rows and columns that intersect each other to form cells where 
data is entered. It is capable of performing multiple tasks like calculations, data analysis, 
and integrating data. 
In Excel worksheet, rows are represented by numbers and columns by alphabets. 

 
An Excel Workbook is a collection of several worksheet. A single Excel workbook can 

consist of several sheets, named Sheet1, Sheet2, and Sheet3… SheetN. You can add one 

or more sheets to your Excel document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: There’s something we should clear up before we move on. 

 

Workbooks vs. spreadsheets 

A workbook is an Excel file. It usually has a file extension of .XLSX (if you’re 

using an older version of Excel, it could be .XLS). 

 

A spreadsheet or worksheet is a single sheet inside a workbook. There can be 

many sheets inside of a workbook, and they’re accessed via the tabs at the 

bottom of the screen. 
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Working with the Ribbon 
The Ribbon is the central control panel of Excel. You can do just about everything you 
need to directly from the Ribbon. 
Where is this powerful tool? At the top of the window: 

 
 
There are a number of tabs, including Home, Insert, Data, Review, and a few others. Each 
tab contains different buttons. 
There’s also a very useful search bar in the Ribbon. It says Tell me what you want to do. 
Just type in what you’re looking for, and Excel will help you find it. 
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Most of the time, you’ll be in the Home tab of the Ribbon. But Formulas and Data are 
also very useful (we’ll be talking about formulas shortly). 
Worksheet views 
Excel has a variety of viewing options that change how your workbook is displayed. These 
views can be useful for various tasks, especially if you're planning to print the 
spreadsheet. To change worksheet views, locate the commands in the bottom-right 
corner of the Excel window and select Normal view, Page Layout view, or Page Break 
view. 

 
Normal view is the default view for all worksheets in Excel. 
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Page Layout view displays how your worksheets will appear when printed. You can also 
add headers and footers in this view. 

 
Page Break view allows you to change the location of page breaks, which is especially 
helpful when printing a lot of data from Excel. 
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Backstage view 
Backstage view gives you various options for saving, opening a file, printing, and sharing 
your workbooks. 
To access backstage view: 
Click the File tab on the Ribbon. Backstage view will appear. 
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Lesson 2 - Data Entry, Data Editing, and Number Formatting 
Entering data 
Now it’s time to enter some data! 
And while entering data is one of the most central and important things you can do in 
Excel, it’s almost effortless. 
Just click into a blank cell and start typing. 
You can also copy (Ctrl + C), cut (Ctrl + X), and paste (Ctrl + V) any data you’d like (or read 
our full guide on copying and pasting here). 
Try copying and pasting the data from the example spreadsheet into another column. 
You can also copy data from other programs into Excel. 
Steps: 
The following steps explain how the column headings in Row 2 are typed into the 
worksheet: 

1. Click cell location A2 on the worksheet. 
2. Type the word Month. 
3. Press the RIGHT ARROW key. This will enter the word into cell A2 and activate the next 

cell to the right. 
4. Type Unit Sales and press the RIGHT ARROW key. 
5. Repeat step 4 for the words Average Price and then again for Sales Dollars. 

Figure 1.15 shows how your worksheet should appear after you have typed the column 
headings into Row 2. Notice that the word Price in cell location C2 is not visible. This is 
because the column is too narrow to fit the entry you typed. We will examine formatting 
techniques to correct this problem in the next section. 
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Figure 1.15 Entering Column Headings into a Worksheet 

 
Column Headings 
It is critical to include column headings that accurately describe the data in each column 
of a worksheet. In professional environments, you will likely be sharing Excel workbooks 
with coworkers. Good column headings reduce the chance of someone misinterpreting 
the data contained in a worksheet, which could lead to costly errors depending on your 
career. 

1. Click cell location B3. 
2. Type the number 2670 and press the ENTER key. After you press the ENTER key, cell B4 

will be activated. Using the ENTER key is an efficient way to enter data vertically down 
a column. 

3. Enter the following numbers in cells B4 through 
B14: 2160, 515, 590, 1030, 2875, 2700, 900, 775, 1180, 1800, and 3560. 

4. Click cell location C3. 
5. Type the number 9.99 and press the ENTER key. 
6. Enter the following numbers in cells C4 through 

C14: 12.49, 14.99, 17.49, 14.99, 12.49, 9.99, 19.99, 19.99, 19.99, 17.49, and 14.99. 
7. Activate cell location D3. 
8. Type the number 26685 and press the ENTER key. 
9. Enter the following numbers in cells D4 through 

D14: 26937, 7701, 10269, 15405, 35916, 26937, 17958, 15708, 23562, 31416, 
and 53370. 

10. When finished, check that the data you entered matches Figure 1.16. 
Avoid Formatting Symbols When Entering Numbers 
When typing numbers into an Excel worksheet, it is best to avoid adding any formatting 
symbols such as dollar signs and commas. Although Excel allows you to add these 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image1-11.png
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symbols while typing numbers, it slows down the process of entering data. It is more 
efficient to use Excel’s formatting features to add these symbols to numbers after you 
type them into a worksheet. 
Data Entry 
It is very important to proofread your worksheet carefully, especially when you have 
entered numbers. Transposing numbers when entering data manually into a worksheet is 
a common error. For example, the number 563 could be transposed to 536. Such errors 
can seriously compromise the integrity of your workbook. 
Figure 1.16 shows how your worksheet should appear after entering the data. Check 
your numbers carefully to make sure they are accurately entered into the worksheet. 
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Figure 1.16  Completed Data Entry for Columns B, C, and D 
EDITING DATA 
Data that has been entered in a cell can be changed by double clicking the cell location or 
using the Formula Bar. You may have noticed that as you were typing data into a cell 
location, the data you typed appeared in the Formula Bar. The Formula Bar can be used 
for entering data into cells as well as for editing data that already exists in a cell. The 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image2-5.png
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following steps provide an example of entering and then editing data that has been 
entered into a cell location: 

1. Click cell A15 in the Sheet1 worksheet. 
2. Type the abbreviation Tot and press the ENTER key. 
3. Click cell A15. 
4. Move the mouse pointer up to the Formula Bar. You will see the pointer turn into a 

cursor. Move the cursor to the end of the abbreviation Tot and left click. 
5. Type the letters al to complete the word Total. 
6. Click the checkmark to the left of the Formula Bar (see Figure 1.17). This will enter the 

change into the cell. 
Figure 1.17 Using the Formula Bar to Edit and Enter Data 

7. Double click cell A15. 
8. Add a space after the word Total and type the word Sales. 
9. Press the ENTER key. 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image3-4.png
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Keyboard Shortcuts: Editing Data in a Cell 
 Activate the cell that is to be edited and press the F2 key on your keyboard. 

 

Lesson 3 - Data and cell Formatting 
FORMATTING DATA AND CELLS 
Enhancing the visual appearance of a worksheet is a critical step in creating a valuable 
tool for you or your coworkers when making key decisions. There are accepted 
professional formatting standards when spreadsheets contain only currency data. For 
this course, we will use the following Excel Guidelines for Formatting. The first figure 
displays how to use accounting number format when ALL figures are currency. Only the 
first row of data and the totals should be formatted with the Accounting format.  The 
other data should be formatted with Comma style.  There also needs to be a Top Border 
above the numbers in the total row.  If any of the numbers have cents, you need to 
format all of the data with two decimal places. 
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Figure 1.31a 
Often, your Excel spreadsheet will contain values that are both currency and non-
currency in nature. When that is the case, you’ll want to use the guidelines in the 
following figure: 
  
Figure 1.31b 
The following steps demonstrate several fundamental formatting skills that will be 
applied to the workbook that we are developing for this chapter. Several of these 
formatting skills are identical to ones that you may have already used in other Microsoft 
applications such as Microsoft® Word® or Microsoft® PowerPoint®. 

1. Highlight the range A2:D2 in the Sheet1 worksheet by placing the mouse pointer 
over cell A2 and left clicking and dragging to cell D2. Click the Bold button in the 
Font group of commands in the Home tab of the ribbon. 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image2-1.png
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2. Click the Border button in the Font group of commands in the Home tab of the 
Ribbon (see Figure 1.32). Select the Bottom Border option from the list to achieve 
the goal of a border on the bottom of row 2 below the column headings. 

 

Figure 1.32 Font Group of Commands 
  

Keyboard Shortcuts: Bold Format 
 Hold the CTRL key while pressing the letter B on your keyboard. 

3. Highlight the range A15:D15 by placing the mouse pointer over cell A15 and left 
clicking and dragging to cell D15. 

4. Click the Bold button in the Font group of commands in the Home tab of the Ribbon. 
5. Click the Border button in the Font group of commands in the Home tab of the 

Ribbon (see Figure 1.32). Select the Top Border option from the list to achieve the 
goal of a border on the top of row 15 where totals will eventually display. 

Keyboard Shortcuts: Italics Format 
 Hold the CTRL key while pressing the letter I on your keyboard. 

 Keyboard Shortcuts: Underline Format 

 Hold the CTRL key while pressing the letter U on your keyboard. 
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 Format Column Headings and Totals 
Applying formatting enhancements to the column headings and column totals in a 
worksheet is a very important technique, especially if you are sharing a workbook 
with other people. These formatting techniques allow users of the worksheet to 
clearly see the column headings that define the data. In addition, the column totals 
usually contain the most important data on a worksheet with respect to making 
decisions, and formatting techniques allow users to quickly see this information. 

1. Highlight the range B3:B14 by placing the mouse pointer over cell B3 and left clicking 
and dragging down to cell B14. 

2. Click the Comma Style button in the Number group of commands in the Home tab of 
the Ribbon. This feature adds a comma as well as two decimal places. (see Figure 

1.33). 
 

Figure 1.33 Number Group of Commands 
3. Since the figures in this range do not include cents, click the Decrease Decimal button 

in the Number group of commands in the Home tab of the Ribbon two times 
(see Figure 1.33). 

4. The numbers will also be reduced to zero decimal places. 
5. Highlight the range C3:C14 by placing the mouse pointer over cell C3 and left clicking 

and dragging down to cell C14. 
6. Click the Accounting Number Format button in the Number group of commands in the 

Home tab of the Ribbon (see Figure 1.33). This will add the US currency symbol and 
two decimal places to the values. This format is common when working with pricing 
data. As discussed above in the Formatting Data and Cells section, you will want to use 
Accounting format on all values in this range since the worksheet contains non-
currency as well as currency data. 

7. Highlight the range D3:D14 by placing the mouse pointer over cell D3 and left clicking 
and dragging down to cell D14. 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image4-1.png
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8. Again, select the Accounting Number Format; this will add the US currency symbol to 
the values as well as two decimal places. 

9. Click the Decrease Decimal button in the Number group of commands in the Home tab 
of the Ribbon. 

10. This will add the US currency symbol to the values and reduce the decimal places to 
zero since there are no cents in these figures. 

11. Highlight the range A1:D1 by placing the mouse pointer over cell A1 and left clicking 
and dragging over to cell D1. 

12. Click the down arrow next to the Fill Color button in the Font group of commands in 
the Home tab of the Ribbon (see Figure 1.34). This will prepare the range for a 

worksheet title. 
Figure 1.34 Fill Color Palette 

  
13. Click the Blue, Accent 1, Darker 25% color from the palette (see Figure 1.34). Notice 

that as you move the mouse pointer over the color palette, you will see a preview of 
how the color will appear in the highlighted cells. Experiment with this feature. 

14. Click on A1 and enter the worksheet title: General Merchandise World and click on the 
check mark in the formula bar to enter this information. 

15. Since the black font is difficult to read on the blue background, you’ll change the font 
color to be more visible. Click the down arrow next to the Font Color button in the 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/1-3-fig-1-34-1.jpg
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Font group of commands in the Home tab of the Ribbon; select White as the font color 
for this range (see Figure 1.32). 

16. Highlight the range A1:D1 by placing the mouse pointer over cell A1 and and dragging 
across to cell D1. 

17. Click the drop-down arrow on the right side of the Font button in the Home tab of the 
Ribbon; select Arial as the font for this range. (see Figure 1.32). 

18. Notice that as you move the mouse pointer over the font style options, you can see 
the font change in the highlighted cells. 

19. Expand the column width of Column D to 14 characters. 
Pound Signs (####) Appear in Columns 
When a column is too narrow for a long number, Excel will automatically convert the 
number to a series of pound signs (####). In the case of words or text data, Excel will only 
show the characters that fit in the column. However, this is not the case with numeric 
data because it can give the appearance of a number that is much smaller than what is 
actually in the cell. To remove the pound signs, increase the width of the column. 
 Figure 1.35 shows how the Sheet1 worksheet should appear after the formatting 
techniques are applied. 

 
Figure 1.35 Formatting Techniques Applied 

DATA ALIGNMENT (WRAP TEXT, MERGE CELLS, AND CENTER) 
The skills presented in this segment show how data are aligned within cell locations. For 
example, text and numbers can be centered in a cell location, left justified, right justified, 
and so on. In some cases you may want to stack multiword text entries vertically in a cell 
instead of expanding the width of a column. This is referred to as wrapping text. These 
skills are demonstrated in the following steps: 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/Figure_1.35_Formatting_Techniques_Appllied.png


 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  397 | 1352  

1. Highlight the range B2:D2 by placing the mouse pointer over cell B2 and left clicking 
and dragging over to cell D2. 

2. Click the Center button in the Alignment group of commands in the Home tab of the 
Ribbon (see Figure 1.36). This will center the column headings in each cell location. 

 
Figure 1.36 Alignment Group in Home Tab 

  
3. Click the Wrap Text button in the Alignment group (see Figure 1.36). The height of Row 

2 automatically expands, and the words that were cut off because the columns were 
too narrow are now stacked vertically. 

Keyboard Shortcuts: Wrap Text 
o Press the ALT key and then the letters H and W one at a time. 

Wrap Text 
The benefit of using the Wrap Text command is that it significantly reduces the need to 
expand the column width to accommodate multiword column headings. The problem 
with increasing the column width is that you may reduce the amount of data that can 
fit on a piece of paper or one screen. This makes it cumbersome to analyze the data in 
the worksheet and could increase the time it takes to make a decision. 

4. Highlight the range A1:D1 by placing the mouse pointer over cell A1 and left clicking 
and dragging over to cell D1. 

5. Click the down arrow on the right side of the Merge & Center button in the Alignment 
group of commands in the Home tab of the Ribbon. 

6. Left click the Merge & Center option (see Figure 1.37). This will create one large cell 
location running across the top of the data set. 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image7-1.png
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Keyboard Shortcuts: Merge Commands 
 Merge & Center: Press the ALT key and then the letters H, M, and C one at a time. 
 Merge Cells: Press the ALT key and then the letters H, M, and M one at a time. 
 Unmerge Cells: Press the ALT key and then the letters H, M, and U one at a time. 

   

 
Figure 1.37 Merge Cell Drop-Down Menu 

 
Merge & Center 
One of the most common reasons the Merge & Center command is used is to center the 
title of a worksheet directly above the columns of data. Once the cells above the column 
headings are merged, a title can be centered above the columns of data. It is very difficult 
to center the title over the columns of data if the cells are not merged. 
 Figure 1.38 shows the Sheet1 worksheet with the data alignment commands applied. 
The reason for merging the cells in the range A1:D1 will become apparent in the next 
segment. 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image8-1.png
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Figure 1.38 Sheet1 with Data Alignment Features Added 

  
Wrap Text 

1. Activate the cell or range of cells that contain text data. 
2. Click the Home tab of the Ribbon. 
3. Click the Wrap Text button. 

Merge Cells 
1. Highlight a range of cells that will be merged. 
2. Click the Home tab of the Ribbon. 
3. Click the down arrow next to the Merge & Center button. 
4. Select an option from the Merge & Center list. 

ENTERING MULTIPLE LINES OF TEXT 
In the Sheet1 worksheet, the cells in the range A1:D1 were merged for the purposes of 
adding a title to the worksheet. This worksheet will contain both a title and a subtitle. 
The following steps explain how you can enter text into a cell and determine where you 
want the second line of text to begin: 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/Figure_1.38_Sheet1_with_Data_Alignment_Features_Added.png
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1. Activate cell A1 in the Sheet1 worksheet by placing the mouse pointer over cell A1 and 
clicking the left mouse button. Since the cells were merged, clicking cell A1 will 
automatically activate the range A1:D1. Position your mouse to the end of the title, 
directly after the “d” in the word “World” and double-click to get a cursor (flashing I-
beam). 

2. Hold down the ALT key and press the ENTER key. This will start a new line of text in this 
cell location. 

3. Type the text Retail Sales (in millions) and press the ENTER key. 
4. Select cell A1. Then click the Italics and Bold buttons in the Font group of commands in 

the Home tab of the Ribbon. 
5. Increase the height of Row 1 to 30 points. Once the row height is increased, all the text 

typed into the cell will be visible (see Figure 1.39). 
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Figure 1.39 Title & Subtitle Added to the Worksheet 
  
Entering Multiple Lines of Text 

1. Activate a cell location. 
2. Type the first line of text. 
3. Hold down the ALT key and press the ENTER key. 
4. Type the second line of text and press the ENTER key. 

BORDERS (ADDING LINES TO A WORKSHEET) 
In Excel, adding custom lines to a worksheet is known as adding borders. Borders are 
different from the grid lines that appear on a worksheet and that define the perimeter of 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/Figure-1.39-Title-and-Subtitle-Added.png
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the cell locations. The Borders command lets you add a variety of line styles to a 
worksheet that can make reading the worksheet much easier. The following steps 
illustrate methods for adding preset borders and custom borders to a worksheet: 

1. Click the down arrow to the right of the Borders button in the Font group of 
commands in the Home page of the Ribbon to view border options. (see Figure 
1.40).Figure 1.40 Borders Drop-Down Menu

 
2. Highlight the range A1:D15. Left click the All Borders option from the Borders drop-

down menu (see Figure 1.40). This will add vertical and horizontal lines to the range 
A1:D15. 

3. Highlight the range A2:D2 by placing the mouse pointer over cell A2 and left clicking 
and dragging over to cell D2. 

4. Click the down arrow to the right of the Borders button. 
5. Left click the Thick Bottom Border option from the Borders drop-down menu. 
6. Highlight the range A14:D14 and apply a Thick Bottom Border from the drop-down 

menu. The thick border will help maintain the Excel Formatting Guidelines. 
7. Highlight the range A1:D15. 
8. Click the down arrow to the right of the Borders button. 
9. Click More Borders… at the bottom of the List. 
10. This will open the Format Cells dialog box (see Figure 1.41). You can access all 

formatting commands in Excel through this dialog box. 
11. In the Style section of the Borders tab, left click the thickest line style (see Figure 1.41). 
12. Left click the Outline button in the Presets section (see Figure 1.41). 
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13. Click the OK button at the bottom of the dialog box (see Figure 1.41). 
  

Figure 1.41 Borders Tab of the Format Cells Dialog Box 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image12-1.png
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Figure 1.42 Borders Added to the Sheet1 Worksheet 
 
Preset Borders 

1. Highlight a range of cells that require borders. 
2. Click the Home tab of the Ribbon. 
3. Click the down arrow next to the Borders button. 
4. Select an option from the preset borders list. 

Custom Borders 
1. Highlight a range of cells that require borders. 
2. Click the Home tab of the Ribbon. 
3. Click the down arrow next to the Borders button. 
4. Select the More Borders option at the bottom of the options list. 
5. Select a line style and line color. 
6. Select a placement option. 
7. Click the OK button on the dialog box. 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/1-3-fig-1-42.jpg
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Lesson 4 - Working with Cells and Ranges in Excel 
Format Cells 
 When we format cells in Excel, we change the appearance of a number without changing 
the number itself. We can apply a number format (0.8, $0.80, 80%, etc) or other 
formatting (alignment, font, border, etc). 
1. Enter the value 0.8 into cell B2. 

 
By default, Excel uses the General format (no specific number format) for numbers. To 
apply a number format, use the 'Format Cells' dialog box. 
2. Select cell B2. 
3. Right click, and then click Format Cells (or press CTRL + 1). 
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The 'Format Cells' dialog box appears. 
4. For example, select Currency. 

 
Note: Excel gives you a life preview of how the number will be formatted (under Sample). 
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5. Click OK. 

 
Cell B2 still contains the number 0.8. We only changed the appearance of this number. 
The most frequently used formatting commands are available on the Home tab. 
6. On the Home tab, in the Number group, click the percentage symbol to apply a 
Percentage format. 

 
7. On the Home tab, in the Alignment group, center the number. 

 
8. On the Home tab, in the Font group, add outside borders and change the font color to 
blue. 
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Result: 

 
 
Decimal Places 
  
Learn how to show fewer decimal places in Excel without changing the number itself. You 
can also round a number. 
1. Enter the value 2.175 into cell A1. 

 
2. On the Home tab, in the Number group, click the Decrease Decimal button twice. 
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Result: 

 
Note: if you look at the formula bar, you can see that cell A1 still contains the value 
2.175. 
3. We can still use this underlying precise value in calculations. 

 
Note: if you want to use 2.2 to get a result of 6.6, round the value in cell A1. 
 
 
Text to Numbers 
  
By default, text is left-aligned and numbers are right-aligned. This example teaches you 
how to convert 'text strings that represent numbers' to numbers. 
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1. Select the range A1:A4 and change the number format to General. 

 
2. Numbers preceded by an apostrophe are also treated as text. Select cell A5 and 
manually remove the apostrophe. 

 
3a. you can also combine step 1 and 2 by adding an empty cell to the range A1:A5. By 
doing this, you let Excel know that these text strings are numbers. Copy an empty cell. 

https://www.excel-easy.com/basics/format-cells.html
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3b. Select the range A1:A5, right click, and then click Paste Special. 
3c. Click Add. 
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3d. Click OK. 
Result. All numbers are right-aligned and treated as numbers. 

 
4a. you can also use the VALUE function. 

 
4b. here’s another example. Use the RIGHT function (or any other text function) to 
extract characters from a text string and then use the VALUE function to convert these 
characters to a number. 

 
Numbers to Text 
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By default, numbers are right-aligned and text is left-aligned. This example teaches you 
how to convert numbers to 'text strings that represent numbers'. 

 
1. Select the range A1:A4 and change the number format to Text. 

 
2. Precede a number by an apostrophe and it will also be treated as text. 

 
3a. If you add text to a number and still want to format this number, use the TEXT 
function. Without using the TEXT function this would be the result. 
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3b. With the TEXT function. 

 
Note: #,## is used to add comma's to large numbers. 
3c. Here's another example. Apply a percentage format. 

 
Note: use 0 to display the nearest integer value. Use 0.0 for one decimal place. Use 0.00 
for two decimal places, etc. 
3d. And another example. Format a date. 
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Note: use less/more m's, d's and y's to change the appearance of the date. Visit our page 
about the TEXT function for many more examples. 
 
Cell Styles 
  
Quickly format a cell by choosing a cell style. You can also create your own cell style. 
Quickly format a range of cells by choosing a table style. 
1. For example, select cell B2 below. 

 
2. On the Home tab, in the Styles group, choose a cell style. 

 
Result. 
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To create your own cell style, execute the following steps. 
3. On the Home tab, in the Styles group, click the bottom right down arrow. 

 
Here you can find many more cell styles. 
4. Click New Cell Style. 
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5. Enter a name and click the Format button to define the Number Format, Alignment, 
Font, Border, Fill and Protection of your cell style. Simply uncheck a check box if you 
don't want to control this type of formatting. 
6. Click OK. 
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7. On the Home tab, in the Styles group, apply your own cell style. 

 
Result. 
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Note: right click a cell style to modify or delete it. Modifying a cell style affects all cells in 
a workbook that use that cell style. This can save a lot of time. A cell style is stored in the 
workbook where you create it. Open a new workbook and click on Merge Styles (under 
New Cell Style) to import a cell style (leave the old workbook with the cell style open). 
Range 
A range in Excel is a collection of two or more cells. This chapter gives an overview of 
some very important range operations. 
Cell, Row, Column 
Let's start by selecting a cell, row and column. 
1. To select cell C3, click on the box at the intersection of column C and row 3. 

 
2. To select column C, click on the column C header. 

 
3. To select row 3, click on the row 3 header. 
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Range Examples 
A range is a collection of two or more cells. 
1. To select the range B2:C4, click on cell B2 and drag it to cell C4. 

 
2. To select a range of individual cells, hold down CTRL and click on each cell that you 
want to include in the range. 

 
Fill a Range 
To fill a range, execute the following steps. 
1a. Enter the value 2 into cell B2. 
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1b. Select cell B2, click on the lower right corner of cell B2 and drag it down to cell B8. 

 
Result: 
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This dragging technique is very important and you will use it very often in Excel. Here's 
another example. 
2a. Enter the value 2 into cell B2 and the value 4 into cell B3. 

 
2b. Select cell B2 and cell B3, click on the lower right corner of this range and drag it 
down. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  423 | 1352  

 
Excel automatically fills the range based on the pattern of the first two values. That's 
pretty cool huh!? Here's another example. 
3a. Enter the date 6/13/2016 into cell B2 and the date 6/16/2016 into cell B3. 

 
3b. Select cell B2 and cell B3, click on the lower right corner of this range and drag it 
down. 

https://www.excel-easy.com/functions/date-time-functions.html
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Note: visit our page about AutoFill for many more examples. 
Move a Range 
To move a range, execute the following steps. 
1. Select a range and click on the border of the range. 

 
2. Drag the range to its new location. 
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Copy/Paste a Range 
To copy and paste a range, execute the following steps. 
1. Select the range, right click, and then click Copy (or press CTRL + c). 

 
2. Select the cell where you want the first cell of the range to appear, right click, and then 
click Paste under 'Paste Options:' (or press CTRL + v). 
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Insert Row, Column 

To insert a row between the values 20 and 40 below, execute the following steps. 
1. Select row 3. 

 
2. Right click, and then click Insert. 
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Result. 

 
The rows below the new row are shifted down. In a similar way, you can insert a column. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  428 | 1352  

AutoFill 
  
Use AutoFill in Excel to automatically fill a series of cells. This page contains many easy to 
follow AutoFill examples. The sky is the limit! 
1. For example, enter the value 10 into cell A1 and the value 20 into cell A2. 

 
2. Select cell A1 and cell A2 and drag the fill handle down. The fill handle is the little 
green box at the lower right of a selected cell or selected range of cells. 

 
Note: AutoFill automatically fills in the numbers based on the pattern of the first two 
numbers. 
3. Enter Jan into cell A1. 

 
4. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the month 
names. 

 
5. Enter Product 1 into cell A1. 
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6. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the product 
names. 

 
7. Enter Friday into cell A1. 

 
8. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the day 
names. 

 
9. Enter the date 1/14/2019 into cell A1. 
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10. Select cell A1 and drag the fill handle down. AutoFill automatically fills in the days. 

 
11. Instead of filling in days, use the AutoFill options to fill in weekdays (ignoring 
weekend days), months (see example below) or years. 

 
Note: also see the options to fill the formatting only and to fill a series without 
formatting. 
12. Enter the date 1/14/2019 into cell A1 and the date 1/21/2019 into cell A2. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  431 | 1352  

 
13. Select cell A1 and cell A2 and drag the fill handle down. AutoFill automatically fills in 
the dates based on the pattern of the first two dates. 

 
14. Enter the time 6:00 AM into cell A1. 

 
15. Select cell A1 and drag the fill handle across. AutoFill automatically fills in the times. 

 
16. When Excel doesn't recognize a list, simply create a custom list. 
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17. Use flash fill in Excel 2013 or later to automatically extract or to automatically 
combine data. 

 

 
If you have Excel 365 or Excel 2021, you can also use the SEQUENCE function to fill a 
series of cells. This function is pretty cool. 
18. The SEQUENCE function below generates a two-dimensional array. Rows = 7, 
Columns = 4, Start = 0, Step = 5. 
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19. The SEQUENCE function below generates a list of odd numbers. Rows = 10, Columns 
= 1, Start = 1, Step = 2. 

 
Note: the SEQUENCE function, entered into cell A1, fills multiple cells. Wow! This 
behavior in Excel 365/2021 is called spilling. 
Flash Fill 
  
Use flash fill in Excel 2013 or later to automatically extract or to automatically combine 
data. Flash Fill in Excel only works when it recognizes a pattern. 
Flash Fill Example 1 
For example, use flash fill in Excel to extract the numbers in column A below. 
1. First, tell Excel what you want to do by entering the value 4645 into cell B1. 
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2. On the Data tab, in the Data Tools group, click Flash Fill (or press CTRL + E). 

 
Result: 

 
Flash Fill Example 2 
 
For example, use flash fill in Excel to join the last names in column A below and the first 
names in column B below to create email addresses. 
1. First, tell Excel what you want to do by entering a correct email address in cell C1. 
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2. On the Data tab, in the Data Tools group, click Flash Fill (or press CTRL + E). 

 
Result: 

 
Flash Fill Example 3 
 
For example, use flash fill in Excel to reformat the numbers in column A below. 
1. First, tell Excel what you want to do by entering a correct social security number in cell 
B1. 
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2. On the Data tab, in the Data Tools group, click Flash Fill (or press CTRL + E). 

 
Result: 

 
Flash Fill Limitations 
Flash fill is a great Excel tool. However, it has a few limitations. For example, use flash fill 
in Excel to extract the numbers in column A below. 
1. First, tell Excel what you want to do by entering the value 130 into cell B1. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  437 | 1352  

 
2. On the Data tab, in the Data Tools group, click Flash Fill (or press CTRL + E). 

 
Result: 

 
Note: flash fill did not correctly extract the decimal numbers (only the digits after the 
decimal point). 
3. Flash fill needs a little help sometimes. Immediately after executing step 2, change the 
value in cell B3 to 26.2 and Excel will correctly extract all other decimal numbers for you. 
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4. Flash fill in Excel does not automatically update your results when your source data 
changes. For example, if you change the number in cell A1 to 200, Excel will not update 
the number in cell B1. 

 
 
Transpose 
  
Use the 'Paste Special Transpose' option to switch rows to columns or columns to rows 
in Excel. You can also use the TRANSPOSE function. 
Paste Special Transpose 
To transpose data, execute the following steps. 
1. Select the range A1:C1. 
2. Right click, and then click Copy. 
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3. Select cell E2. 
4. Right click, and then click Paste Special. 
5. Check Transpose. 

 
6. Click OK. 
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Transpose Function 
To insert the TRANSPOSE function, execute the following steps. 
1. First, select the new range of cells. 

 
2. Type in =TRANSPOSE( 
3. Select the range A1:C1 and close with a parenthesis. 
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4. Finish by pressing CTRL + SHIFT + ENTER. 

 
Note: the formula bar indicates that this is an array formula by enclosing it in curly braces 
{}. To delete this array formula, select the range E2:E4 and press Delete. 
5. If you have Excel 365 or Excel 2021, simply select cell E2, enter the TRANSPOSE 
function and press Enter. Bye bye curly braces. 

 
Note: the TRANSPOSE function, entered into cell E2, fills multiple cells. Wow! This 
behavior in Excel 365/2021 is called spilling. 
Transpose Table without Zeros 
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The TRANSPOSE function in Excel converts blank cells to zeros. Simply use the IF function 
to fix this problem. 
1. For example, cell B4 below is blank. The TRANSPOSE function converts this blank cell to 
a zero (cell G3). 

 
2. If blank, the IF function below returns an empty string (two double quotes with 
nothing in between) to transpose. 

 
Transpose Magic 
The 'Paste Special Transpose' option is a great way to transpose data but if you want to 
link the source cells to the target cells, you need a few magic tricks. 
1. Select the range A1:E2. 
2. Right click, and then click Copy. 

https://www.excel-easy.com/examples/transpose.html#paste-special-transpose
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3. Select cell A4. 
4. Right click, and then click Paste Special. 
5. Click Paste Link. 
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Result. 

 
6. Select the range A4:E5 and replace all equal signs with xxx. 

https://www.excel-easy.com/basics/find-select.html#replace
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Result. 

 
7. Use 'Paste Special Transpose' to transpose this data. 

 
8. Select the range G1:H5 and replace all occurrences of 'xxx' with equal signs (the exact 
opposite of step 6). 

https://www.excel-easy.com/examples/transpose.html#paste-special-transpose
https://www.excel-easy.com/basics/find-select.html#replace
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Note: for example, change the value in cell C2 from 16 to 36. The value in cell H3 will also 
change from 16 to 36. 
 

Lesson 5 - Managing Worksheets 
Managing your sheets 
As we saw, workbooks can contain multiple sheets. 
You can manage those sheets with the sheet tabs near the bottom of the screen. Click a 
tab to open that particular worksheet. 
If you’re using our example workbook, you’ll see two sheets, called Welcome and Thank 
You: 

 
To add a new worksheet, click the + (plus) button at the end of the list of sheets. 
You can also reorder the sheets in your workbook by dragging them to a new location. 
And if you right-click a worksheet tab, you’ll get a number of options: 
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Grouping and ungrouping worksheets 
You can work with each worksheet individually, or you can work with multiple 
worksheets at the same time. Worksheets can be combined together into a group. Any 
changes made to one worksheet in a group will be made to every worksheet in the 
group. 
To group worksheets: 

1. Select the first worksheet you want to include in the worksheet group. 

 
2. Press and hold the Ctrl key on your keyboard. Select the next 

worksheet you want in the group. 

 
3. Continue to select worksheets until all of the worksheets you want to 

group are selected, then release the Ctrl key. The worksheets are 
now grouped. 
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While worksheets are grouped, you can navigate to any worksheet within the group. 
Any changes made to one worksheet will appear on every worksheet in the group. 
However, if you select a worksheet that is not in the group, all of your worksheets will 
become ungrouped. 
To ungroup worksheets: 

1. Right-click a worksheet in the group, then select Ungroup Sheets from 
the worksheet menu. 

 
2. The worksheets will be ungrouped. Alternatively, you can simply click any 

worksheet not included in the group to ungroup all worksheets. 

 
 
EXCEL ESSENTIALS 

Lesson 6 - Introduction to Excel Tables 
Once you've entered information into your worksheet, you may want to format your 
data as a table. Just like regular formatting, tables can improve the look and feel of your 
workbook, and they'll also help you organize your content and make your data easier to 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  449 | 1352  

use. Excel includes several tools and predefined table styles, allowing you to create tables 
quickly and easily. 
To format data as a table: 

1.  
Select the cells you want to format as a table. In our example, we'll select 
the cell range A2:D9. 

 
2. From the Home tab, click the Format as Table command in 

the Styles group. 

 
3. Select a table style from the drop-down menu. 
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4. A dialog box will appear, confirming the selected cell range for the table. 
5. If your table has headers, check the box next to My table has headers, 

then click OK. 
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6. The cell range will be formatted in the selected table style. 

 
Tables include filtering by default. You can filter your data at any time using the drop-
down arrows in the header cells. To learn more, review our lesson on Filtering Data. 
 
Modifying tables 
It's easy to modify the look and feel of any table after adding it to a worksheet. Excel 
includes many different options for customizing a table, including adding rows or 
columns and changing the table style. 
To add rows or columns to a table: 
If you need to fit more content into your table, Excel allows you to modify the table 
size by including additional rows and columns. There are two simple ways to change the 
table size: 

 Enter new content into any adjacent row or column. The row or column 
will be roped into the table automatically. 
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 Click and drag the bottom-right corner of the table to create additional 

rows or columns. 
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To change the table style: 

1. Select any cell in your table, then click the Design tab. 
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2. Locate the Table Styles group, then click the More drop-down arrow to 

see all available table styles. 

 
3. Select the desired table style. 
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4. The table style will be applied. 
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To modify table style options: 
You can turn various options on or off to change the appearance of any table. There are 
several options: Header Row, Total Row, Banded Rows, First Column, Last 
Column, Banded Columns, and Filter Button. Select any cell in your table, then click 
the Design tab. 

1. Check or uncheck the desired options in the Table Style Options group. In 
our example, we'll check Total Row to automatically include a total for 
our table. 

 
2. The table style will be modified. In our example, a new row has been 

added to the table with a formula that automatically calculates the total 
value of the cells in column D. 
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Depending on the type of content you have—and the table style you've chosen—these 
options can affect your table's appearance in various ways. You may need to experiment 
with a few different options to find the exact style you want. 
To remove a table: 
It's possible to remove a table from your workbook without losing any of your data. 
However, this can cause issues with certain types of formatting, including colors, fonts, 
and banded rows. Before you use this option, make sure you're prepared to reformat 
your cells if necessary. 

1. Select any cell in your table, then click the Design tab. 
2. Click the Convert to Range command in the Tools group. 

 
3. A dialog box will appear. Click Yes. 
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4. The range will no longer be a table, but the cells will retain their data and 

formatting. 

 
To restart your formatting from scratch, click the Clear command on the Home tab. Next, 
choose Clear Formats from the menu. 
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Lesson 7 - Auto-fill, Custom Lists, and Flash Fill, Data Validations 
AUTO FILL 
The Auto Fill feature is a valuable tool when manually entering data into a worksheet. 
This feature has many uses, but it is most beneficial when you are entering data in a 
defined sequence, such as the numbers 2, 4, 6, 8, and so on, or nonnumeric data such as 
the days of  
the week or months of the year. The following steps demonstrate how Auto Fill can be 
used to enter the months of the year in Column A: 

1. Click cell A3 in the Sheet1 worksheet. 
2. Type the word January and press the ENTER key. 
3. Activate cell A3 again. 
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4. Move the mouse pointer to the lower right corner of cell A3. You will see a small 
square in this corner of the cell; this is called the Fill Handle (See Figure 1.18) when the 
mouse pointer gets close to the Fill Handle, the white block plus sign will turn into a 
black plus sign. 

 
Figure 1.18 Fill Handle 

Left click and drag the Fill Handle to cell A14. Notice that the Auto Fill tip box indicates 
what month will be placed into each cell (see Figure 1.19). Release the left mouse button 
when the tip box reads “December.” 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image5-5.png
https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image4-4.png
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Figure 1.19  Using Auto Fill to Enter the Months of the Year 
Once you release the left mouse button, all twelve months of the year should appear in 
the cell range A3:A14, as shown in Figure 1.20. You will also see the Auto Fill Options 
button. By clicking this button, you have several options for inserting data into a group of 
cells. 

 
Figure 1.20 Auto Fill Options Button 

1. Click the Auto Fill Options button. 

https://openoregon.pressbooks.pub/app/uploads/sites/7/2016/09/image6-5.png
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2. Click the Copy Cells option. This will change the months in the range A4:A14 to 
January. 

3. Click the Auto Fill Options button again. 
4. Click the Fill Months option to return the months of the year to the cell range A4:A14. 

The Fill Series option will provide the same result. 
 

Lesson 8 - Number Formatting in Excel 
Microsoft Excel has a lot of built-in formats for number, currency, percentage, 
accounting, dates and times. But there are situations when you need something very 
specific. If none of the inbuilt Excel formats meets your needs, you can create your own 
number format. 
Number formatting in Excel is a very powerful tool, and once you learn how to use it 
property, your options are almost unlimited. The aim of this tutorial is to explain the 
most essential aspects of Excel number format and set you on the right track to 
mastering custom number formatting. 
How to create a custom number format in Excel 
To create a custom Excel format, open the workbook in which you want to apply and 
store your format, and follow these steps: 
1. Select a cell for which you want to create custom formatting, and press Ctrl+1 to open 

the Format Cells dialog. 
2. Under Category, select Custom. 
3. Type the format code in the Type box. 
4. Click OK to save the newly created format. 
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Tip. Instead of creating a custom number format from scratch, you choose a built-in Excel 
format close to your desired result, and customize it. 
Understanding Excel number format 
To be able to create a custom format in Excel, it is important that you understand how 
Microsoft Excel sees the number format. 
An Excel number format consists of 4 sections of code, separated by semicolons, in this 
order: 
POSITIVE; NEGATIVE; ZERO; TEXT 
Here's an example of a custom Excel format code: 

 
1. Format for positive numbers (display 2 decimal places and a thousands separator). 
2. Format for negative numbers (the same as for positive numbers, but enclosed in 

parenthesis). 
3. Format for zeros (display dashes instead of zeros). 
4. Format for text values (display text in magenta font color). 
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Excel formatting rules 
When creating a custom number format in Excel, please remember these rules: 
1. A custom Excel number format changes only the visual representation, i.e. how a 

value is displayed in a cell. The underlying value stored in a cell is not changed. 
2. When you are customizing a built-in Excel format, a copy of that format is created. 

The original number format cannot be changed or deleted. 
3. Excel custom number format does not have to include all four sections. 

If a custom format contains just 1 section, that format will be applied to all number 
types - positive, negative and zeros. 
If a custom number format includes 2 sections, the first section is used for positive 
numbers and zeros, and the second section - for negative numbers. 
A custom format is applied to text values only if it contains all four sections. 

4. To apply the default Excel number format for any of the middle sections, 
type General instead of the corresponding format code. 
For example, to display zeros as dashes and show all other values with the default 
formatting, use this format code: General; -General; "-"; General 
Note. The General format included in the 2nd section of the format code does not 
display the minus sign, therefore we include it in the format code. 

5. To hide a certain value type(s), skip the corresponding code section, and only type the 
ending semicolon. 
For example, to hide zeros and negative values, use the following format 
code: General; ; ; General. As the result, zeros and negative value will appear only in 
the formula bar, but will not be visible in cells. 

6. To delete a custom number format, open the Format Cells dialog, select Custom in 
the Category list, find the format you want to delete in the Type list, and click 
the Delete button. 

Digit and text placeholders 
For starters, let's explain 4 basic placeholders that you can use in your custom Excel 
format. 

Code Description Example 

0 
Digit placeholder that displays insignificant 
zeros. 

#.00 - always displays 2 
decimal places. 
If you type 5.5 in a cell, it 
will display as 5.50. 

# 

Digit placeholder that represents optional 
digits and does not display extra zeros. 
That is, if a number doesn't need a certain digit, 
it won't be displayed. 

#.## - displays up to 2 
decimal places. 
If you type 5.5 in a cell, it 
will display as 5.5. 
If you type 5.555, it will 
display as 5.56. 

? 
Digit placeholder that leaves a space for 
insignificant zeros on either side of the decimal 

#.??? - displays a maximum 
of 3 decimal places and 
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point but doesn't display them. It is often used 
to align numbers in a column by decimal point. 

aligns numbers in a column 
by decimal point. 

@ Text placeholder 
0.00; -0.00; 0; [Red]@ - 
applies the red font color 
for text values. 

The following screenshot demonstrates a few number formats in action: 

 
As you may have noticed in the above screenshot, the digit placeholders behave in the 
following way: 

 If a number entered in a cell has more digits to the right of the decimal point than there 
are placeholders in the format, the number is "rounded" to as many decimal places as 
there are placeholders. 
For example, if you type 2.25 in a cell with #.# format, the number will display as 2.3. 

 All digits to the left of the decimal point are displayed regardless of the number of 
placeholders. 
For example, if you type 202.25 in a cell with #.# format, the number will display as 
202.3. 
Below you will find a few more examples that will hopefully shed more light on number 
formatting in Excel. 

Format Description 
Input 
values 

Display as 

#.000 Always display 3 decimal places. 
2 
2.5 
0.5556 

2.000 
2.500 
.556 

#.0# 
Display a minimum of 1 and a 
maximum of 2 decimal places. 

2 
2.205 
0.555 

2.0 
2.21 
.56 

???.??? 
Display up to 3 decimal places 
with aligned decimals. 

22.55 
2.5 
2222.5555 
0.55 

22.55 
2.5 
2222.556 
.55 
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Excel formatting tips and guidelines 
Theoretically, there are an infinite number of Excel custom number formats that you can 
make using a predefined set of formatting codes listed in the table below. And the 
following tips explain the most common and useful implementations of these format 
codes. 

Format Code Description 

General General number format 

# 
Digit placeholder that represents optional digits and does not 
display extra zeros. 

0 Digit placeholder that displays insignificant zeros. 

? 
Digit placeholder that leaves a space for insignificant zeros but 
doesn't display them. 

@ Text placeholder 

. (period) Decimal point 

, (comma) 
Thousands separator. A comma that follows a digit placeholder 
scales the number by a thousand. 

\ Displays the character that follows it. 

" " Display any text enclosed in double quotes. 

% 
Multiplies the numbers entered in a cell by 100 and displays the 
percentage sign. 

/ Represents decimal numbers as fractions. 

E Scientific notation format 

_ (underscore) 
Skips the width of the next character. It's commonly used in 
combination with parentheses to add left and right 
indents, _( and _) respectively. 

* (asterisk) 
Repeats the character that follows it until the width of the cell is 
filled. It's often used in combination with the space character to 
change alignment. 

[] Create conditional formats. 

 
How to control the number of decimal places 
The location of the decimal point in the number format code is represented by 
a period (.). The required number of decimal places is defined by zeros (0). For example: 

 0 or # - display the nearest integer with no decimal places. 
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 0.0 or #.0 - display 1 decimal place. 
 0.00 or #.00 - display 2 decimal places, etc. 

The difference between 0 and # in the integer part of the format code is as follows. If the 
format code has only pound signs (#) to the left of the decimal point, numbers less than 1 
begin with a decimal point. For example, if you type 0.25 in a cell with #.00 format, the 
number will display as .25. If you use 0.00 format, the number will display as 0.25. 

 
How to show a thousands separator 
To create an Excel custom number format with a thousands separator, include 
a comma (,) in the format code. For example: 

 #,### - display a thousands separator and no decimal places. 
 #,##0.00 - display a thousands separator and 2 decimal places. 

 
Round numbers by thousand, million, etc. 
As demonstrated in the previous tip, Microsoft Excel separates thousands by commas if a 
comma is enclosed by any digit placeholders - pound sign (#), question mark (?) or zero 
(0). If no digit placeholder follows a comma, it scales the number by thousand, two 
consecutive commas scale the number by million, and so on. 
For example, if a cell format is #.00, and you type 5000 in that cell, the number 5.00 is 
displayed. For more examples, please see the screenshot below: 

 
Text and spacing in custom Excel number format 
To display both text and numbers in a cell, do the following: 

 To add a single character, precede that character with a backslash (\). 
 To add a text string, enclose it in double quotation marks (" "). 

For example, to indicate that numbers are rounded by thousands and millions, you can 
add \K and \M to the format codes, respectively: 

 To display thousands: #.00,\K 
 To display millions: #.00,,\M 

Tip. To make the number format better readable, include a space between a comma and 
backward slash. 
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The following screenshot shows the above formats and a couple more variations: 

 
And here is another example that demonstrates how to display text and numbers within 
a single cell. Supposing, you want to add the word "Increase" for positive numbers, and 
"Decrease" for negative numbers. All you have to do is include the text enclosed in 
double quotes in the appropriate section of your format code: 
#.00" Increase"; -#.00" Decrease"; 0 
Tip. To include a space between a number and text, type a space character after the 
opening or before the closing quote depending on whether the text precedes or follows 
the number, like in "Increase ". 

 
In addition, the following characters can be included in Excel custom format codes 
without the use of backslash or quotation marks: 

Symbol Description 

+ and - Plus and minus signs 

( ) Left and right parenthesis 

: Colon 

^ Caret 

' Apostrophe 
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Symbol Description 

{ } Curly brackets 

< > Less-than and greater than signs 

= Equal sign 

/ Forward slash 

! Exclamation point 

& Ampersand 

~ Tilde 

 Space character 

A custom Excel number format can also accept other special symbols such as currency, 
copyright, trademark, etc. These characters can be entered by typing their four-digit ANSI 
codes while holding down the ALT key. Here are some of the most useful ones: 

Symbol Code Description 

™ Alt+0153 Trademark 

© Alt+0169 Copyright symbol 

° Alt+0176 Degree symbol 

± Alt+0177 Plus-Minus sign 

µ Alt+0181 Micro sign 

For example, to display temperatures, you can use the format code #"°F" or #"°C" and 
the result will look similar to this: 
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You can also create a custom Excel format that combines some specific text and the text 
typed in a cell. To do this, enter the additional text enclosed in double quotes in the 
4th section of the format code before or after the text placeholder (@), or both. 
For example, to proceed the text typed in the cell with some other text, say "Shipped in", 
use the following format code: 
General; General; General; "Shipped in "@ 

 
Including currency symbols in a custom number format 
To create a custom number format with the dollar sign ($), simply type it in the format 
code where appropriate. For example, the format $#.00 will display 5 as $5.00. 
Other currency symbols are not available on most of standard keyboards. But you can 
enter the popular currencies in this way: 

 Turn NUM LOCK on, and 
 Use the numeric keypad to type the ANSI code for the currency symbol you want to 

display. 

Symbol Currency Code 

€ Euro ALT+0128 

£ British Pound ALT+0163 
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¥ Japanese Yen ALT+0165 

¢ Cent Sign ALT+0162 

The resulting number formats may look something similar to this: 

 
If you want to create a custom Excel format with some other currency, follow these 
steps: 
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 Open the Format Cells dialog, select Currency under Category, and choose the desired 
currency from the Symbol drop-down list, e.g. Russian Ruble: 
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 Switch to Custom category, and modify the built-in Excel format the way you want. Or, 
copy the currency code from the Type field, and include it in your own number format: 

 
How to display leading zeros with Excel custom format 
If you try entering numbers 005 or 00025 in a cell with the default General format, you 
would notice that Microsoft Excel removes leading zeros because the number 005 is 
same as 5. But sometimes, we do want 005, not 5! 
The simplest solution is to apply the Text format to such cells. Alternatively, you can type 
an apostrophe (') in front of the numbers. Either way, Excel will understand that you 
want any cell value to be treated as a text string. As the result, when you type 005, all 
leading zeros will be preserved, and the number will show up as 005. 
If you want all numbers in a column to contain a certain number of digits, with leading 
zeros if needed, then create a custom format that includes only zeros. 
As you remember, in Excel number format, 0 is the placeholder that displays insignificant 
zeros. So, if you need numbers consisting of 6 digits, use the following format 
code: 000000 
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And now, if you type 5 in a cell, it will appear as 000005; 50 will appear as 000050, and so 
on: 

 
Tip. If you are entering phone numbers, zip codes, or social security numbers that 
contain leading zeros, the easiest way is to apply one of the predefined Special formats. 
Or, you can create the desired custom number format. For example, to properly display 
international seven-digit postal codes, use this format: 0000000. For social security 
numbers with leading zeros, apply this format: 000-00-0000. 
Percentages in Excel custom number format 
To display a number as a percentage of 100, include the percent sign (%) in your number 
format. 
For example, to display percentages as integers, use this format: #%. As the result, the 
number 0.25 entered in a cell will appear as 25%. 
To display percentages with 2 decimal places, use this format: #.00% 
To display percentages with 2 decimal places and a thousands separator, use this 
one: #,##.00% 

 
Fractions in Excel number format 
Fractions are special in terms that the same number can be displayed in a variety of 
ways. For example, 1.25 can be shown as 1 ¼ or 5/5. Exactly which way Excel displays the 
fraction is determined by the format codes that you use. 
For decimal numbers to appear as fractions, include forward slash (/) in your format 
code, and separate an integer part with a space. For example: 

 # #/# - displays a fraction remainder with up to 1 digit. 
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 # ##/## - displays a fraction remainder with up to 2 digits. 
 # ###/### - displays a fraction remainder with up to 3 digits. 
 ###/### - displays an improper fraction (a fraction whose numerator is larger than or 

equal to the denominator) with up to 3 digits. 
To round fractions to a specific denominator, supply it in your number format code after 
the slash. For example, to display decimal numbers as eighths, use the following fixed 
base fraction format: # #/8 
The following screenshot demonstrated the above format codes in action: 

 
As you probably know, the predefined Excel Fraction formats align numbers by the 
fraction bar (/) and display the whole number at some distance from the remainder. To 
implement this alignment in your custom format, use the question mark placeholders (?) 
instead of the pound signs (#) like shown in the following screenshot: 

 
Tip. To enter a fraction in a cell formatted as General, preface the fraction with a zero 
and a space. For instance, to enter 4/8 in a cell, you type 0 4/8. If you type 4/8, Excel will 
assume you are entering a date, and change the cell format accordingly. 
Create a custom Scientific Notation format 
To display numbers in Scientific Notation format (Exponential format), include the capital 
letter E in your number format code. For example: 

 00E+00 - displays 1,500,500 as 1.50E+06. 
 #0.0E+0 - displays 1,500,500 as 1.5E+6 
 #E+# - displays 1,500,500 as 2E+6 
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Show negative numbers in parenthesis 
At the beginning of this tutorial, we discussed the 4 code sections that make up an Excel 
number format: Positive; Negative; Zero; Text 
Most of the format codes we've discussed so far contained just 1 section, meaning that 
the custom format is applied to all number types - positive, negative and zeros. 
To make a custom format for negative numbers, you'd need to include at least 2 code 
sections: the first will be used for positive numbers and zeros, and the second - for 
negative numbers. 
To show negative values in parenthesis, simply include them in the second section of 
your format code, for example: #.00; (#.00) 
Tip. To line up positive and negative numbers at the decimal point, add an indent to the 
positive values section, e.g. 0.00_); (0.00) 

 
Display zeroes as dashes or blanks 
The built-in Excel Accounting format shows zeros as dashes. This can also be done in your 
custom Excel number format. 
As you remember, the zero layout is determined by the 3rd section of the format code. 
So, to force zeros to appear as dashes, type "-" in that section. For 
example: 0.00;(0.00);"-" 
The above format code instructs Excel to display 2 decimal places for positive and 
negative numbers, enclose negative numbers in parenthesis, and turn zeros into dashes. 
If you don't want any special formatting for positive and negative numbers, 
type General in the 1st and 2nd sections: General; -General; "-" 
To turn zeroes into blanks, skip the third section in the format code, and only type the 
ending semicolon: General; -General; ; General 

 
Add indents with custom Excel format 
If you don't want the cell contents to ride up right against the cell border, you can indent 
information within a cell. To add an indent, use the underscore (_) to create a space 
equal to the width of the character that follows it. 
The commonly used indent codes are as follows: 

 To indent from the left border: _( 
 To indent from the right border: _) 

https://www.ablebits.com/office-addins-blog/2016/07/07/custom-excel-number-format/#Add-indents
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Most often, the right indent is included in a positive number format, so that Excel leaves 
space for the parenthesis enclosing negative numbers. 
For example, to indent positive numbers and zeros from the right and text from the left, 
you can use the following format code: 
0.00_);(0.00); 0_);_(@ 
Or, you can add indents on both sides of the cell: 
_(0.00_);_((0.00);_(0_);_(@_) 
The indent codes move the cell data by one character width. To move values from the 
cell edges by more than one character width, include 2 or more consecutive indent codes 
in your number format. The following screenshot demonstrates indenting cell contents 
by 1 and 2 characters: 

 
Change font color with custom number format 
Changing the font color for a certain value type is one of the simplest things you can do 
with a custom number format in Excel, which supports 8 main colors. To specify the 
color, just type one of the following color names in an appropriate section of your 
number format code. 

[Black] 
[Green] 
[White] 
[Blue] 

[Magenta] 
[Yellow] 
[Cyan] 
[Red] 

Note. The color code must be the first item in the section. 
For example, to leave the default General format for all value types, and change only the 
font color, use the format code similar to this: 
[Green]General;[Red]General;[Black]General;[Blue]General 
Or, combine color codes with the desired number formatting, e.g. display the currency 
symbol, 2 decimal places, a thousands separator, and show zeros as dashes: 
[Blue]$#,##0.00; [Red]-$#,##0.00; [Black]"-"; [Magenta]@ 
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Repeat characters with custom format codes 
To repeat a specific character in your custom Excel format so that it fills the column 
width, type an asterisk (*) before the character. 
For example, to include enough equality signs after a number to fill the cell, use this 
number format: #*= 
Or, you can include leading zeros by adding *0 before any number format, e.g. *0# 

 
This formatting technique is commonly used to change cell alignment as demonstrated in 
the next formatting tip. 
How to change alignment in Excel with custom number format 
A usual way to change alignment in Excel is using the Alignment tab on the ribbon. 
However, you can "hardcode" cell alignment in a custom number format if needed. 
For example, to align numbers left in a cell, type an asterisk and a space after the 
number code, for example: "#,###* " (double quotes are used only to show that an 
asterisk is followed by a space, you don't need them in a real format code). 
Making a step further, you could have numbers aligned left and text entries aligned right 
using this custom format: 
#,###* ; -#,###* ; 0* ;* @ 
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This method is used in the built-in Excel Accounting format . If you apply the Accounting 
format to some cell, then open the Format Cells dialog, switch to the Custom category 
and look at the Type box, you will see this format code: 
_($* #,##0.00_);_($* (#,##0.00);_($* "-"??_);_(@_) 
The asterisk that follows the currency sign tells Excel to repeat the subsequent space 
character until the width of a cell is filled. This is why the Accounting number format 
aligns the currency symbol to the left, number to the right, and adds as many spaces as 
necessary in between. 
Apply custom number formats based on conditions 
To have your custom Excel format applied only if a number meets a certain condition, 
type the condition consisting of a comparison operator and a value, and enclose it 
in square brackets []. 
For example, to displays numbers that are less than 10 in a red font color, and numbers 
that are greater than or equal to 10 in a green color, use this format code: 
[Red][<10];[Green][>=10] 
Additionally, you can specify the desired number format, e.g. show 2 decimal places: 
[Red][<10]0.00;[Green][>=10]0.00 

 
And here is another extremely useful, though rarely used formatting tip. If a cell displays 
both numbers and text, you can make a conditional format to show a noun in a singular 
or plural form depending on the number. For example: 
[=1]0" mile";0.##" miles" 
The above format code works as follows: 

 If a cell value is equal to 1, it will display as "1 mile". 
 If a cell value is greater than 1, the plural form "miles" will show up. Say, the number 3.5 

will display as "3.5 miles". 
Taking the example further, you can display fractions instead of decimals: 
[=1]?" mile";# ?/?" miles" 
In this case, the value 3.5 will appear as "3 1/2 miles". 

 
Tip. To apply more sophisticated conditions, use Excel's Conditional Formatting feature, 
which is specially designed to handle the task. 
Colors 
You can control positive numbers, negative numbers, zero values and text all at the same 
time! Each part is separated with a semicolon (;) in your number format code. 
1. Enter the following values in cells A1, B1, C1 and A2: 5000000, 0, Hi and -5.89. 
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2. Use the following number format 
code: [Green]$#,##0_);[Red]$(#,##0);"zero";[Blue]"Text:" @ 

 
Note: #,## is used to add comma's to large numbers. To add a space, use the underscore 
"_" followed by a character. The length of the space will be the length of this character. 
In our example, we added a parentheses ")". As a result, the positive number lines up 
correctly with the negative number enclosed in parentheses. Use two parts separated 
with a semicolon (;) to control positive and negative numbers only. Use three parts 
separated with a semicolon (;) to control positive numbers, negative numbers and zero 
values only. 
Dates and Times 
You can also control dates and times. Use one of the existing Date or Time formats as a 
starting point. 
1. Enter the value 42855 into cell A1. 
2. Select cell A1, right click, and then click Format Cells. 
3. Select Date and select the Long Date. 
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Note: Excel gives you a life preview of how the number will be formatted (under Sample). 
4. Select Custom. 
5. Slightly change the number format code to: mm/dd/yyyy, dddd 
6. Click OK. 
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Result: 

 
 
 

Lesson 9 -Excel Data Validation, Drop-down List, Grouping 
Data Validation 
  
Use data validation in Excel to make sure that users enter certain values into a cell. 
Data Validation Example 
In this example, we restrict users to enter a whole number between 0 and 10. 
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Create Data Validation Rule 
To create the data validation rule, execute the following steps. 
1. Select cell C2. 
2. On the Data tab, in the Data Tools group, click Data Validation. 

 
On the Settings tab: 
3. In the Allow list, click Whole number. 
4. In the Data list, click between. 
5. Enter the Minimum and Maximum values. 
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Input Message 
Input messages appear when the user selects the cell and tell the user what to enter. 
On the Input Message tab: 
1. Check 'Show input message when cell is selected'. 
2. Enter a title. 
3. Enter an input message. 

 
Error Alert 
If users ignore the input message and enter a number that is not valid, you can show 
them an error alert. 
On the Error Alert tab: 
1. Check 'Show error alert after invalid data is entered'. 
2. Enter a title. 
3. Enter an error message. 
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4. Click OK. 
Data Validation Result 
1. Select cell C2. 

 
2. Try to enter a number higher than 10. 
Result: 
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Note: to remove data validation from a cell, select the cell, on the Data tab, in the Data 
Tools group, click Data Validation, and then click Clear All. You can use Excel's Go To 
Special feature to quickly select all cells with data validation. 
 
Drop-down List: 
Drop-down lists in Excel are helpful if you want to be sure that users select an item from 
a list, instead of typing their own values. 
Create a Drop-down List 
To create a drop-down list in Excel, execute the following steps. 
1. On the second sheet, type the items you want to appear in the drop-down list. 

 
Note: if you don't want users to access the items on Sheet2, you can hide Sheet2. To 
achieve this, right click on the sheet tab of Sheet2 and click on Hide. 
2. On the first sheet, select cell B1. 

 
3. On the Data tab, in the Data Tools group, click Data Validation. 

https://www.excel-easy.com/basics/find-select.html#go-to-special
https://www.excel-easy.com/basics/find-select.html#go-to-special
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The 'Data Validation' dialog box appears. 
4. In the Allow box, click List. 
5. Click in the Source box and select the range A1:A3 on Sheet2. 

 
6. Click OK. 
Result: 

 
Note: to copy/paste a drop-down list, select the cell with the drop-down list and press 
CTRL + c, select another cell and press CTRL + v. 
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7. You can also type the items directly into the Source box, instead of using a range 
reference. 

 
Note: this makes your drop-down list case sensitive. For example, if a user types yes, an 
error alert will be displayed. 
Allow Other Entries 
You can also create a drop-down list in Excel that allows other entries. 
1. First, if you type a value that is not in the list, Excel shows an error alert. 

 
To allow other entries, execute the following steps. 
2. On the Data tab, in the Data Tools group, click Data Validation. 
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The 'Data Validation' dialog box appears. 
3. On the Error Alert tab, uncheck 'Show error alert after invalid data is entered'. 

 
4. Click OK. 
5. You can now enter a value that is not in the list. 

 
Add/Remove Items 
You can add or remove items from a drop-down list in Excel without opening the 'Data 
Validation' dialog box and changing the range reference. This saves time. 
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1. To add an item to a drop-down list, go to the items and select an item. 

 
2. Right click, and then click Insert. 
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3. Select "Shift cells down" and click OK. 

 
Result: 

 
Note: Excel automatically changed the range reference from Sheet2!$A$1:$A$3 to 
Sheet2!$A$1:$A$4. You can check this by opening the 'Data Validation' dialog box. 
 
4. Type a new item. 
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Result: 

 
5. To remove an item from a drop-down list, at step 2, click Delete, select "Shift cells up" 
and click OK. 
Dynamic Drop-down List 
You can also use a formula that updates your drop-down list automatically when you add 
an item to the end of the list. 
1. On the first sheet, select cell B1. 

 
2. On the Data tab, in the Data Tools group, click Data Validation. 
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The 'Data Validation' dialog box appears. 
3. In the Allow box, click List. 
4. Click in the Source box and enter the 
formula: =OFFSET(Sheet2!$A$1,0,0,COUNTA(Sheet2!$A:$A),1) 

 
Explanation: the OFFSET function takes 5 arguments. Reference: Sheet2!$A$1, rows to 
offset: 0, columns to offset: 0, height: COUNTA(Sheet2!$A:$A) and width: 1. 
COUNTA(Sheet2!$A:$A) counts the number of values in column A on Sheet2 that are not 
empty. When you add an item to the list on Sheet2, COUNTA(Sheet2!$A:$A) increases. 
As a result, the range returned by the OFFSET function expands and the drop-down list 
will be updated. 
5. Click OK. 
6. On the second sheet, simply add a new item to the end of the list. 
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Result: 

 
Remove a Drop-down List 
To remove a drop-down list in Excel, execute the following steps. 
1. Select the cell with the drop-down list. 

 
2. On the Data tab, in the Data Tools group, click Data Validation. 

 
The 'Data Validation' dialog box appears. 
3. Click Clear All. 
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Note: to remove all other drop-down lists with the same settings, check "Apply these 
changes to all other cells with the same settings" before you click on Clear All. 
4. Click OK. 
Dependent Drop-down Lists 
1. For example, if the user selects Pizza from a first drop-down list. 

 
2. A second drop-down list contains the Pizza items. 
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3. But if the user selects Chinese from the first drop-down list, the second drop-down list 
contains the Chinese dishes. 

 
Table Magic 
You can also store your items in an Excel table to create a dynamic drop-down list. 
1. On the second sheet, select a list item. 

 
2. On the Insert tab, in the Tables group, click Table. 
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3. Excel automatically selects the data for you. Click OK. 

 
4. If you select the list, Excel reveals the structured reference. 

 
5. Use this structured reference to create a dynamic drop-down list. 

https://www.excel-easy.com/examples/structured-references.html
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Explanation: the INDIRECT function in Excel converts a text string into a valid reference. 
6. On the second sheet, simply add a new item to the end of the list. 

 
Result: 
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Note: try it yourself. Download the Excel file and create this drop-down list. 
7. When using tables, use the UNIQUE function in Excel 365/2021 to extract unique list 
items. 

 
Note: this dynamic array function, entered into cell F1, fills multiple cells. Wow! This 
behavior in Excel 365/2021 is called spilling. 
8. Use this spill range to create a magic drop-down list. 
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Explanation: always use the first cell (F1) and a hash character to refer to a spill range. 
Result: 

 
Note: when you add new records, the UNIQUE function automatically extracts new 
unique list items and Excel automatically updates the drop-down list. 
Group Worksheets 
  
You can group worksheets in Excel if you want to edit multiple worksheets at the same 
time. Our workbook contains 3 similar worksheets (North, Mid and South) and a blank 
fourth worksheet. 
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1. To group worksheets, hold down CTRL and click the sheet tabs of the sheets you want 
to group. 

 
2. Release CTRL. 
Now you can edit multiple worksheets at the same time. 
3. For example, on the North sheet, change the value of cell B2 to $1000 and delete row 
4. 

 
4. Go to the other two worksheets and you'll see that these worksheets have been edited 
as well. 
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5. To ungroup, right click one of the sheet tabs and click Ungroup Sheets or click any 
sheet tab outside the group. For example, the sheet tab of Sheet4. 
 

Lesson 10 – Freeze Panes, Conditional Formatting 
If you have a large table of data in Excel, it can be useful to freeze rows or columns. This 
way you can keep rows or columns visible while scrolling through the rest of the 
worksheet. 
Freeze Top Row 
To freeze the top row, execute the following steps. 
1. On the View tab, in the Window group, click Freeze Panes. 

 
2. Click Freeze Top Row. 
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3. Scroll down to the rest of the worksheet. 
Result. Excel automatically adds a dark grey horizontal line to indicate that the top row is 
frozen. 

 
Unfreeze Panes 
To unlock all rows and columns, execute the following steps. 
1. On the View tab, in the Window group, click Freeze Panes. 

 
2. Click Unfreeze Panes. 
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Freeze First Column 
To freeze the first column, execute the following steps. 
1. On the View tab, in the Window group, click Freeze Panes. 

 
2. Click Freeze First Column. 

 
3. Scroll to the right of the worksheet. 
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Result. Excel automatically adds a dark grey vertical line to indicate that the first column 
is frozen. 

 
Freeze Rows 
To freeze rows, execute the following steps. 
1. For example, select row 4. 
2. On the View tab, in the Window group, click Freeze Panes. 

 
3. Click Freeze Panes. 

 
4. Scroll down to the rest of the worksheet. 
Result. All rows above row 4 are frozen. Excel automatically adds a dark grey horizontal 
line to indicate that the first three rows are frozen. 
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Freeze Columns 
To freeze columns, execute the following steps. 
1. For example, select column E. 
2. On the View tab, in the Window group, click Freeze Panes. 

 
3. Click Freeze Panes. 

 
4. Scroll to the right of the worksheet. 
Result. All columns to the left of column E are frozen. Excel automatically adds a dark 
grey vertical line to indicate that the first four columns are frozen. 
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Freeze Cells 
To freeze cells, execute the following steps. 
1. For example, select cell C3. 
2. On the View tab, in the Window group, click Freeze Panes. 

 
3. Click Freeze Panes. 

 
4. Scroll down and to the right. 
Result. The orange region above row 3 and to the left of column C is frozen. 

 
Magic Freeze Button 
Add the magic Freeze button to the Quick Access Toolbar to freeze the top row, the first 
column, rows, columns or cells with a single click. 
1. Click the down arrow. 
2. Click More Commands. 
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3. Under Choose commands from, select Commands Not in the Ribbon. 
4. Select Freeze Panes and click Add. 
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5. Click OK. 
6. To freeze the top row, select row 2 and click the magic Freeze button. 
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7. Scroll down to the rest of the worksheet. 
Result. Excel automatically adds a dark grey horizontal line to indicate that the top row is 
frozen. 

 
Note: to unlock all rows and columns, click the Freeze button again. To freeze the first 4 
columns, select column E (the fifth column) and click the magic Freeze button, etc. 
Conditional formatting  
Conditional formatting in Excel enables you to highlight cells with a certain color, 
depending on the cell's value. 
Highlight Cells Rules 
To highlight cells that are greater than a value, execute the following steps. 
1. Select the range A1:A10. 
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2. On the Home tab, in the Styles group, click Conditional Formatting. 

 
3. Click Highlight Cells Rules, Greater Than. 

 
4. Enter the value 80 and select a formatting style. 

 
5. Click OK. 
Result. Excel highlights the cells that are greater than 80. 
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6. Change the value of cell A1 to 81. 
Result. Excel changes the format of cell A1 automatically. 

 
Note: you can also use this category (see step 3) to highlight cells that are less than a 
value, between two values, equal to a value, cells that contain specific text, dates (today, 
last week, next month, etc.), duplicates or unique values. 
Clear Rules 
To clear a conditional formatting rule, execute the following steps. 
1. Select the range A1:A10. 

 

https://www.excel-easy.com/examples/find-duplicates.html
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2. On the Home tab, in the Styles group, click Conditional Formatting. 

 
3. Click Clear Rules, Clear Rules from Selected Cells. 

 
Top/Bottom Rules 
To highlight cells that are above average, execute the following steps. 
1. Select the range A1:A10. 
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2. On the Home tab, in the Styles group, click Conditional Formatting. 

 
3. Click Top/Bottom Rules, Above Average. 
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4. Select a formatting style. 

 
5. Click OK. 
Result. Excel calculates the average (42.5) and formats the cells that are above this 
average. 
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Note: you can also use this category (see step 3) to highlight the top n items, the top n 
percent, the bottom n items, the bottom n percent or cells that are below average. 
Conditional Formatting with Formulas 
Take your Excel skills to the next level and use a formula to determine which cells to 
format. Formulas that apply conditional formatting must evaluate to TRUE or FALSE. 
1. Select the range A1:E5. 

 
2. On the Home tab, in the Styles group, click Conditional Formatting. 
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3. Click New Rule. 

 
4. Select 'Use a formula to determine which cells to format'. 
5. Enter the formula =ISODD(A1) 
6. Select a formatting style and click OK. 
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Result. Excel highlights all odd numbers. 

 
Explanation: always write the formula for the upper-left cell in the selected range. Excel 
automatically copies the formula to the other cells. Thus, cell A2 contains the formula 
=ISODD(A2), cell A3 contains the formula =ISODD(A3), etc. 
Here's another example. 
7. Select the range A2:D7. 
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8. Repeat steps 2-4 above. 
9. Enter the formula =$C2="USA" 
10. Select a formatting style and click OK. 

 
Result. Excel highlights all USA orders. 
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Explanation: we fixed the reference to column C by placing a $ symbol in front of the 
column letter ($C2). As a result, cell B2, C2 and cell D2 also contain the formula 
=$C2="USA", cell A3, B3, C3 and D3 contain the formula =$C3="USA", etc. 
 
Manage Rules 
  
To view all conditional formatting rules in a workbook, use the Conditional Formatting 
Rules Manager. You can also use this screen to create, edit and delete rules. 
1. Select cell A1. 

 
2. On the Home tab, in the Styles group, click Conditional Formatting. 
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3. Click Manage Rules. 

 
The Conditional Formatting Rules Manager appears. 
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Note: because we selected cell A1, Excel shows the rule applied to the range A1:A10. 
4. From the drop-down list, change Current Selection to This Worksheet, to view all 
conditional formatting rules in this worksheet. 

 
Note: click New Rule, Edit Rule and Delete Rule to create, edit and delete rules. 
Find Duplicates 
  
This example teaches you how to find duplicate values (or triplicates) and how to find 
duplicate rows in Excel. 
Duplicate Values 
To find and highlight duplicate values in Excel, execute the following steps. 
1. Select the range A1:C10. 
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2. On the Home tab, in the Styles group, click Conditional Formatting. 

 
3. Click Highlight Cells Rules, Duplicate Values. 
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4. Select a formatting style and click OK. 

 
Result. Excel highlights the duplicate names. 
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Note: select Unique from the first drop-down list to highlight the unique names. 
Triplicates 
By default, Excel highlights duplicates (Juliet, Delta), triplicates (Sierra), etc. (see previous 
image). Execute the following steps to highlight triplicates only. 
1. First, clear the previous conditional formatting rule. 
2. Select the range A1:C10. 
3. On the Home tab, in the Styles group, click Conditional Formatting. 

 
4. Click New Rule. 

https://www.excel-easy.com/data-analysis/conditional-formatting.html#clear-rules
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5. Select 'Use a formula to determine which cells to format'. 
6. Enter the formula =COUNTIF($A$1:$C$10,A1)=3 
7. Select a formatting style and click OK. 

https://www.excel-easy.com/examples/countif.html
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Result. Excel highlights the triplicate names. 
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Explanation: =COUNTIF($A$1:$C$10,A1) counts the number of names in the range 
A1:C10 that are equal to the name in cell A1. If COUNTIF($A$1:$C$10,A1) = 3, Excel 
formats cell A1. Always write the formula for the upper-left cell in the selected range 
(A1:C10). Excel automatically copies the formula to the other cells. Thus, cell A2 contains 
the formula =COUNTIF($A$1:$C$10,A2)=3, cell A3 =COUNTIF($A$1:$C$10,A3)=3, etc. 
Notice how we created an absolute reference ($A$1:$C$10) to fix this reference. 
Note: you can use any formula you like. For example, use this formula 
=COUNTIF($A$1:$C$10,A1)>3 to highlight names that occur more than 3 times. 
Duplicate Rows 
To find and highlight duplicate rows in Excel, use COUNTIFS (with the letter S at the end) 
instead of COUNTIF. 
1. Select the range A1:C10. 

 
2. On the Home tab, in the Styles group, click Conditional Formatting. 

https://www.excel-easy.com/examples/countif.html
https://www.excel-easy.com/examples/absolute-reference.html
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3. Click New Rule. 

 
4. Select 'Use a formula to determine which cells to format'. 
5. Enter the formula =COUNTIFS(Animals,$A1,Continents,$B1,Countries,$C1)>1 
6. Select a formatting style and click OK. 
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Note: the named range Animals refers to the range A1:A10, the named range Continents 
refers to the range B1:B10 and the named range Countries refers to the range 
C1:C10. =COUNTIFS(Animals,$A1,Continents,$B1,Countries,$C1) counts the number of 
rows based on multiple criteria (Leopard, Africa, Zambia). 
Result. Excel highlights the duplicate rows. 

https://www.excel-easy.com/examples/named-range.html
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Explanation: if COUNTIFS(Animals,$A1,Continents,$B1,Countries,$C1) > 1, in other 
words, if there are multiple (Leopard, Africa, Zambia) rows, Excel formats cell A1. Always 
write the formula for the upper-left cell in the selected range (A1:C10). Excel 
automatically copies the formula to the other cells. We fixed the reference to each 
column by placing a $ symbol in front of the column letter ($A1, $B1 and $C1). As a 
result, cell A1, B1 and C1 contain the same formula, cell A2, B2 and C2 contain the 
formula =COUNTIFS(Animals,$A2,Continents,$B2,Countries,$C2)>1, etc. 
7. Finally, you can use the Remove Duplicates tool in Excel to quickly remove duplicate 
rows. On the Data tab, in the Data Tools group, click Remove Duplicates. 

 
In the example below, Excel removes all identical rows (blue) except for the first identical 
row found (yellow). 

https://www.excel-easy.com/functions/cell-references.html
https://www.excel-easy.com/examples/remove-duplicates.html
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Note: visit our page about removing duplicates to learn more about this great Excel tool. 
 
Compare Two Lists 
  
This example describes how to compare two lists using conditional formatting. For 
example, you may have two lists of NFL teams. 

 
To highlight the teams in the first list that are not in the second list, execute the following 
steps. 
1. First, select the range A1:A18 and name it firstList, select the range B1:B20 and name it 
secondList. 
2. Next, select the range A1:A18. 
3. On the Home tab, in the Styles group, click Conditional Formatting. 

https://www.excel-easy.com/examples/remove-duplicates.html
https://www.excel-easy.com/examples/named-range.html
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4. Click New Rule. 

 
5. Select 'Use a formula to determine which cells to format'. 
6. Enter the formula =COUNTIF(secondList,A1)=0 
7. Select a formatting style and click OK. 

https://www.excel-easy.com/examples/countif.html
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Result. Miami Dolphins and Tennessee Titans are not in the second list. 

 
Explanation: =COUNTIF(secondList,A1) counts the number of teams in secondList that are 
equal to the team in cell A1. If COUNTIF(secondList,A1) = 0, the team in cell A1 is not in 
the second list. As a result, Excel fills the cell with a blue background color. Always write 

https://www.excel-easy.com/examples/countif.html
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the formula for the upper-left cell in the selected range (A1:A18). Excel automatically 
copies the formula to the other cells. Thus, cell A2 contains the formula 
=COUNTIF(secondList,A2)=0, cell A3 =COUNTIF(secondList,A3)=0, etc. 
8. To highlight the teams in the second list that are not in the first list, select the range 
B1:B20, create a new rule using the formula =COUNTIF(firstList,B1)=0, and set the format 
to orange fill. 
Result. Denver Broncos, Arizona Cardinals, Minnesota Vikings and Pittsburgh Steelers are 
not in the first list. 

 
 
EXCEL FORMULAS  

Lesson 11 - Excel Formula Basics 
 
One of the most powerful features in Excel is the ability to calculate numerical 
information using formulas. Just like a calculator, Excel can add, subtract, multiply, and 
divide. In this lesson, we'll show you how to use cell references to create simple 
formulas. 
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Mathematical operators 
Excel uses standard operators for formulas, such as a plus sign for addition (+), a minus 
sign for subtraction (-), an asterisk for multiplication (*), a forward slash for division (/), 
and a caret (^) for exponents. 

 
All formulas in Excel must begin with an equals sign (=). This is because the cell contains, 
or is equal to, the formula and the value it calculates. 
Understanding cell references 
While you can create simple formulas in Excel using numbers (for 
example, =2+2 or =5*5), most of the time you will use cell addresses to create a formula. 
This is known as making a cell reference. Using cell references will ensure that your 
formulas are always accurate because you can change the value of referenced cells 
without having to rewrite the formula. 
In the formula below, cell A3 adds the values of cells A1 and A2 by making cell 
references: 

 
When you press Enter, the formula calculates and displays the answer in cell A3: 

 
If the values in the referenced cells change, the formula automatically recalculates: 
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By combining a mathematical operator with cell references, you can create a variety of 
simple formulas in Excel. Formulas can also include a combination of cell references and 
numbers, as in the examples below: 

 
 
 
 
Basic calculations 
Now that we’ve seen how to get some basic data into our spreadsheet, we’re going to do 
some things with it. 
Running basic calculations in Excel is easy. First, we’ll look at how to add two numbers. 

Important: start calculations with = (equals) 
When you’re running a calculation (or a formula, which we’ll discuss next), the first thing 
you need to type is an equals sign. This tells Excel to get ready to run some sort of 
calculation. 
So when you see something like =MEDIAN (A2:A51), make sure you type it exactly as it 
is—including the equals sign. 
Let’s add 3 and 4. Type the following formula in a blank cell: 
=3+4 
Then hit Enter. 

https://spreadsheeto.com/median-excel/
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When you hit Enter, Excel evaluates your equation and displays the result, 7. 
But if you look above at the formula bar, you’ll still see the original formula. 
That’s a useful thing to keep in mind, in case you forget what you typed originally. 
Performing subtraction, multiplication, and division is just as easy. Try these formulas: 

 =4-6 
 =2*5 
 =-10/3 

Now let’s try something different. Open up the first sheet in the example workbook, click 
into cell C1, and type the following: 
=A1+B1 
Hit Enter. 
You should get 82, the sum of the numbers in cells A1 and B1. 
Now, change one of the numbers in A1 or B1 and watch what happens: 
Because you’re adding A1 and B1, Excel automatically updates the total when you change 
the values in one of those cells. 
Try doing different types of arithmetic on the other numbers in columns A and B using 
this method. 
The power of functions 
Excel’s greatest power lies in functions. These let you run complex calculations with a few 
keypresses. 
Many formulas take sets of numbers and give you information about them. 
For example, the AVERAGE function gives you the average of a set of numbers. Let’s try 
using it. 
Click into an empty cell and type the following formula: 
=AVERAGE(A1:A4) 
Then hit Enter. 
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The resulting number, 0.25, is the average of the numbers in cells A1, A2, A3, and A4. 

 
Cell range notation 

In the formula above, we used “A1:A4” to tell Excel to look at all the cells between A1 
and A4, including both of those cells. You can read it as “A1 through A4.” 
You can also use this to include numbers in different columns. “A5:C7” includes A5, A6, 
A7, B5, B6, B7, C5, C6, and C7. 
 
There are also functions that work on text. 
Let’s try the CONCATENATE function! 
Click into cell C5 and type this formula: 
=CONCATENATE(A1, ” “, B1) 
Then hit Enter. 
You’ll see the message “1337” in the result cell. 
How did this happen? CONCATENATE takes cells with text in them and puts them 
together. 
 
 

Lesson 12 - Logical Formulas in Excel 
Learn how to use Excel's logical functions, such as IF, AND, OR and NOT. 
Overview 
Microsoft Excel provides 4 logical functions to work with the logical values. The functions 
are AND, OR, XOR and NOT. You use these functions when you want to carry out more 
than one comparison in your formula or test multiple conditions instead of just one. As 
well as logical operators, Excel logical functions return either TRUE or FALSE when their 
arguments are evaluated. 
The following table provides a short summary of what each logical function does to help 
you choose the right formula for a specific task. 

Function Description 
Formula 
Example 

Formula Description 
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AND 
Returns TRUE if all of 
the arguments 
evaluate to TRUE. 

=AND(A2>=10, 
B2<5) 

The formula returns TRUE if a 
value in cell A2 is greater than 
or equal to 10, and a value in 
B2 is less than 5, FALSE 
otherwise. 

OR 
Returns TRUE if any 
argument evaluates to 
TRUE. 

=OR(A2>=10, 
B2<5) 

The formula returns TRUE if 
A2 is greater than or equal to 
10 or B2 is less than 5, or both 
conditions are met. If neither 
of the conditions it met, the 
formula returns FALSE. 

XOR 
Returns a logical 
Exclusive Or of all 
arguments. 

=XOR(A2>=10, 
B2<5) 

The formula returns TRUE if 
either A2 is greater than or 
equal to 10 or B2 is less than 
5. If neither of the conditions 
is met or both conditions are 
met, the formula returns 
FALSE. 

NOT 

Returns the reversed 
logical value of its 
argument. I.e. If the 
argument is FALSE, 
then TRUE is returned 
and vice versa. 

=NOT(A2>=10) 

The formula returns FALSE if a 
value in cell A1 is greater than 
or equal to 10; TRUE 
otherwise. 

 
IF 
The IF function checks whether a condition is met, and returns one value if true and 
another value if false. 
1. For example, take a look at the IF function in cell C2 below. 

 
 
Explanation: if the score is greater than or equal to 60, the IF function returns Pass, else it 
returns Fail. Visit our page about the IF function for many more examples. 

https://www.excel-easy.com/examples/if.html
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AND 
The AND Function returns TRUE if all conditions are true and returns FALSE if any of the 
conditions are false. 
1. For example, take a look at the AND function in cell D2 below. 

 
Explanation: the AND function returns TRUE if the first score is greater than or equal to 
60 and the second score is greater than or equal to 90, else it returns FALSE. 
OR 
The OR function returns TRUE if any of the conditions are TRUE and returns FALSE if all 
conditions are false. 
1. For example, take a look at the OR function in cell D2 below. 

 
Explanation: the OR function returns TRUE if at least one score is greater than or equal to 
60, else it returns FALSE. Visit our page about the OR function for many more examples. 
 
NOT 
The NOT function changes TRUE to FALSE, and FALSE to TRUE. 
1. For example, take a look at the NOT function in cell D2 below. 

https://www.excel-easy.com/examples/or.html
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Explanation: in this example, the NOT function reverses the result of the OR function (see 
previous example). 
Excel IFERROR Function 
Types of Errors in Excel 
Knowing the errors in Excel will better equip you to identify the possible reason and the 
best way to handle these. 
Below are the types of errors you might find in Excel. 
#N/A Error 
This is called the ‘Value Not Available’ error. 
You will see this when you use a lookup formula and it can’t find the value (hence Not 
Available). 
Below is an example where I use the VLOOKUP formula to find the price of an item, but it 
returns an error when it can’t find that item in the table array. 

 
#DIV/0! Error 
You’re likely to see this error when a number is divided by 0. 
This is called the division error. In the below example, it gives a #DIV/0! error as the 
quantity value (the divisor in the formula) is 0. 

https://trumpexcel.com/excel-vlookup-function/
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#VALUE! Error 
The value error occurs when you use an incorrect data type in a formula. 
For example, in the below example, when I try to add cells that have numbers and 
character A, it gives the value error. 
This happens as you can only add numeric values, but instead, I tried adding a number 
with a text character. 

 
#REF! Error 
This is called the reference error and you will see this when the reference in the formula 
is no longer valid. This could be the case when the formula refers to a cell reference and 
that cell reference does not exist (happens when you delete a row/column or worksheet 
that was referred to in the formula). 
In the below example, while the original formula was =A2/B2, when I deleted Column B, 
all the references to it became #REF! and it also gave the #REF! error as the result of the 
formula. 

https://trumpexcel.com/ref-error-in-excel/
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#NAME ERROR 
This error is likely to a result of a misspelled function. 
For example, if instead of VLOOKUP, you by mistake use VLOKUP, it will give a name 
error. 

 
#NUM ERROR 
Num error can occur if you try and calculate a very large value in Excel. For 
example, =187^549 will return a number error. 

 
Another situation where you can get the NUM error is when you give a non-valid number 
argument to a formula. For example, if you’re calculating the Square Root if a number 
and you give a negative number as the argument, it will return a number error. 

https://trumpexcel.com/name-error-excel/
https://trumpexcel.com/name-error-excel/
https://trumpexcel.com/calculate-square-root-in-excel/
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For example, in the case of Square Root function, if you give a negative number as the 
argument, it will return a number error (as shown below). 
While I have shown only a couple of examples here, there can be many other reasons 
that can lead to errors in Excel. When you get errors in Excel, you can’t just leave it there. 
If the data is further used in calculations, you need to make sure the errors are handled 
the right way. 
Excel IFERROR function is a great way to handle all types of errors in Excel. 
Excel IFERROR Function – An Overview 
Using the IFERROR function, you can specify what you want the formula to return instead 
of the error. If the formula does not return an error, then its own result is returned. 

 
IFERROR Function Syntax 
=IFERROR(value, value_if_error) 
Input Arguments 

 value – this is the argument that is checked for the error. In most cases, it is 
either a formula or a cell reference. 

 value_if_error – this is the value that is returned if there is an error. The following 
error types evaluated: #N/A, #REF!, #DIV/0!, #VALUE!, #NUM!, #NAME?, and 
#NULL!. 

Additional Notes: 
 If you use “” as the value_if_error argument, the cell displays nothing in case of 

an error. 
 If the value or value_if_error argument refers to an empty cell, it is treated as an 

empty string value by the Excel IFERROR function. 
 If the value argument is an array formula, IFERROR will return an array of results 

for each item in the range specified in value. 
Excel IFERROR Function – Examples 
Here are three examples of using IFERROR function in Excel. 
Example 1 – Return Blank Cell Instead of Error 
If you have functions that may return an error, you can wrap it within the IFERROR 
function and specify blank as the value to return in case of an error. 
In the example shown below, the result in D4 is the #DIV/0! error as the divisor is 0. 
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In this case, you can use the following formula to return blank instead of the ugly DIV 
error. 
=IFERROR(A1/A2,””) 

 
This IFERROR function would check whether the calculation leads to an error. If it does, it 
simply returns a blank as specified in the formula. 
Here, you can also specify any other string or formula to display instead of the blank. 
For example, the below formula would return the text “Error”, instead of the blank cell. 
=IFERROR(A1/A2,”Error”) 

 
Note: If you are using Excel 2003 or a prior version, you will not find the IFERROR 
function in it. In such cases, you need to use the combination of IF 
function and ISERROR function. 
Example 2 – Return ‘Not Found’ when VLOOKUP Can’t Find a Value 
When you use the Excel VLOOKUP Function, and it can’t find the lookup value in the 
specified range, it would return the #N/A error. 
For example, below is a data set of student names and their marks. I have used the 
VLOOKUP function to fetch the marks of three students (in D2, D3, and D4). 
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While the VLOOKUP formula in the above example finds the names of first two students, 
it can’t find Josh’s name on the list and hence it returns the #N/A error. 
Here, we can use the IFERROR function to return a blank or some meaningful text instead 
of the error. 
Below is the formula that will return ‘Not Found’ instead of the error. 
=IFERROR(VLOOKUP(D2,$A$2:$B$12,2,0),”Not Found”) 

 
Note that you can also use IFNA instead of IFERROR with VLOOKUP. While IFERROR 
would treat all kinds of error values, IFNA would only work on the #N/A errors and 
wouldn’t work with other errors. 
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Example 3 – Return 0 in case of an Error 
If you don’t specify the value to return by IFERROR in the case of an error, it would 
automatically return 0. 
For example, if I divide 100 with 0 as shown below, it would return an error. 

 
However, if I use the below IFERROR function, it would return a 0 instead. Note that you 
still need to use a comma after the first argument. 

 
Example 4 – Using Nested IFERROR with VLOOKUP 
Sometimes when using VLOOKUP, you may have to look through the fragmented table of 
arrays. For example, suppose you have the sales transaction records in 2 separate 
worksheets and you want to look-up an item number and see it’s value. 
Doing this requires using nested IFERROR with VLOOKUP. 
Suppose you have a dataset as shown below: 

 
In this case, to find the score for Grace, you need to use the below nested IFERROR 
formula: 
=IFERROR(VLOOKUP(G3,$A$2:$B$5,2,0),IFERROR(VLOOKUP(G3,$D$2:$E$5,2,0),"Not 
Found")) 
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This kind of formula nesting ensure that you get the value from either of the table and 
any error returned is handled. 
Note that in case the tables are on the same worksheet, however, in a real-life example, 
it likely to be on different worksheets. 
 

Lesson 13 - Financial Formulas in Excel 
To illustrate Excel's most popular financial functions, we consider a loan with monthly 
payments, an annual interest rate of 6%, a 20-year duration, a present value of $150,000 
(amount borrowed) and a future value of 0 (that's what you hope to achieve when you 
pay off a loan). 
We make monthly payments, so we use 6%/12 = 0.5% for Rate and 20*12 = 240 for Nper 
(total number of periods). If we make annual payments on the same loan, we use 6% for 
Rate and 20 for Nper. 
PMT 
Select cell A2 and insert the PMT function. 

 
Note: the last two arguments are optional. For loans, Fv can be omitted (the future value 
of a loan equals 0, however, it's included here for clarification). If Type is omitted, it is 
assumed that payments are due at the end of the period. 
Result. The monthly payment equals $1,074.65. 

 
Tip: when working with financial functions in Excel, always ask yourself the question, am I 
making a payment (negative) or am I receiving money (positive)? We pay off a loan of 
$150,000 (positive, we received that amount) and we make monthly payments of 
$1,074.65 (negative, we pay). Visit our page about the PMT function for many more 
examples. 
RATE 
If Rate is the only unknown variable, we can use the RATE function to calculate the 
interest rate. 

https://www.excel-easy.com/examples/pmt.html
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NPER 
Or the NPER function. If we make monthly payments of $1,074.65 on a 20-year loan, with 
an annual interest rate of 6%, it takes 240 months to pay off this loan. 

 
We already knew this, but we can change the monthly payment now to see how this 
affects the total number of periods. 

 
Conclusion: if we make monthly payments of $2,074.65, it takes less than 90 months to 
pay off this loan. 
PV 
Or the PV (Present Value) function. If we make monthly payments of $1,074.65 on a 20-
year loan, with an annual interest rate of 6%, how much can we borrow? You already 
know the answer. 

 
FV 
And we finish this chapter with the FV (Future Value) function. If we make monthly 
payments of $1,074.65 on a 20-year loan, with an annual interest rate of 6%, do we pay 
off this loan? Yes. 
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But, if we make monthly payments of only $1,000.00, we still have debt after 20 years. 

 
 

Lesson 14 - Lookup and Reference Formulas in Excel 
Learn all about Excel's lookup & reference functions, such as VLOOKUP, HLOOKUP, 
MATCH, INDEX and CHOOSE. 
Vlookup 
The VLOOKUP (Vertical lookup) function looks for a value in the leftmost column of a 
table, and then returns a value in the same row from another column you specify. 
1. Insert the VLOOKUP function shown below. 

 
Explanation: the VLOOKUP function looks for the ID (104) in the leftmost column of the 
range $E$4:$G$7 and returns the value in the same row from the third column (third 
argument is set to 3). The fourth argument is set to FALSE to return an exact match or a 
#N/A error if not found. 
2. Drag the VLOOKUP function in cell B2 down to cell B11. 
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Note: when we drag the VLOOKUP function down, the absolute reference ($E$4:$G$7) 
stays the same, while the relative reference (A2) changes to A3, A4, A5, etc. Visit our 
page about the VLOOKUP function for much more information and many examples. 
Hlookup 
In a similar way, you can use the HLOOKUP (Horizontal lookup) function. 

 
Note: if you have Excel 365 or Excel 2021, use XLOOKUP instead of HLOOKUP to perform 
a horizontal lookup. 
Match 
The MATCH function returns the position of a value in a given range. 
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Explanation: Yellow found at position 3 in the range E4:E7. The third argument is 
optional. Set this argument to 0 to return the position of the value that is exactly equal to 
lookup_value (A2) or a #N/A error if not found. Use INDEX and MATCH in Excel and 
impress your boss. 
Index 
The INDEX function below returns a specific value in a two-dimensional range. 

 
Explanation: 92 found at the intersection of row 3 and column 2 in the range E4:F7. 
The INDEX function below returns a specific value in a one-dimensional range. 

 
Explanation: 97 found at position 3 in the range E4:E7. Use INDEX and MATCH in Excel 
and impress your boss. 
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Choose 
The CHOOSE function returns a value from a list of values, based on a position number. 

 
Explanation: Boat found at position 3. 
  
To lookup a value in a two-dimensional range, use INDEX and MATCH in Excel. Below you 
can find the sales of different ice cream flavors in each month. 
1. To find the position of Feb in the range A2:A13, use the MATCH function. The result is 
2. 

 
2. To find the position of Chocolate in the range B1:D1, use the MATCH function. The 
result is 1. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  555 | 1352  

 
3. Use these results and the INDEX function to find the sales of Chocolate in February. 

 
Explanation: 217 found at the intersection of row 2 and column 1 in the range B2:D13. 
4. Put it all together. 
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You can also lookup a value in a two-dimensional range without using INDEX and MATCH. 
The following trick is pretty awesome. 
5. Select the range A1:D13. 

 
6. On the Formulas tab, in the Defined Names group, click Create from Selection. 

 
7. Check Top row and Left column and click OK. 
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8. Excel created 12 + 3 = 15 named ranges! Simply select a range and look at the Name 
box. 

 
9. Use the intersect operator (space) to return the intersection of two named ranges. 
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10. Create a dynamic two-way lookup. 

 
Explanation: the INDIRECT functions convert the text strings ("Feb" in cell G2 and 
"Chocolate" in cell G3) into valid named ranges. 
 

Lesson 15 – Statistical Formulas in Excel 
Statistical Functions 
This chapter gives an overview of some very useful statistical functions in Excel. 
Average 
To calculate the average of a group of numbers, use the AVERAGE function. 
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Note: visit our page about the AVERAGE function for many more examples. 
 
Averageif 
To average cells based on one criteria, use the AVERAGEIF function. For example, to 
calculate the average excluding zeros. 

 
Note: visit our page about the AVERAGEIF function for many more examples. 
Median 
To find the median (or middle number), use the MEDIAN function. 

 
Check: 

 
Mode 
To find the most frequently occurring number, use the MODE function. 

 
Standard Deviation 
To calculate the standard deviation, use the STEDV function. 

https://www.excel-easy.com/examples/averageif.html
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Note: standard deviation is a number that tells you how far numbers are from their 
mean. Learn more about this topic on our page about standard deviation. 
Min 
To find the minimum value, use the MIN function. 

 
Max 
To find the maximum value, use the MAX function. 

 
Large 
To find the third largest number, use the following LARGE function. 

 
Check: 

 
Small 
To find the second smallest number, use the following SMALL function. 

https://www.excel-easy.com/examples/standard-deviation.html
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Check: 

 
Tip: Excel can generate most of these results with the click of a button. Our Descriptive 
Statistics example shows you how. 
 

Lesson 16 - Text Formulas in Excel 
Excel has many functions to offer when it comes to manipulating text strings. 
Join Strings 
To join strings, use the & operator. 

 
Note: instead of using the & operator, use the CONCATENATE function in Excel. 
Left 
To extract the leftmost characters from a string, use the LEFT function. 

 
Right 
To extract the rightmost characters from a string, use the RIGHT function. 

 
Mid 
To extract a substring, starting in the middle of a string, use the MID function. 
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Note: started at position 5 (p) with length 3. 
Len 
To get the length of a string, use the LEN function. 

 
Note: space (position 8) included! 
Find 
To find the position of a substring in a string, use the FIND function. 

 
Note: string "am" found at position 3. Visit our page about the FIND function for more 
examples. 
Substitute 
To replace existing text with new text in a string, use the SUBSTITUTE function. 

 
 

Lesson 17 - Date and Time Formulas in Excel 

 
To enter a date in Excel, use the "/" or "-" characters. To enter a time, use the ":" (colon). 
You can also enter a date and a time in one cell. 

 
Note: Dates are in US Format. Months first, Days second. This type of format depends on 
your windows regional settings. Learn more about Date and Time formats. 
Year, Month, Day 
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To get the year of a date, use the YEAR function. 

 
Note: use the MONTH and DAY function to get the month and day of a date. 
Date Function 
1. To add a number of days to a date, use the following simple formula. 

 
2. To add a number of years, months and/or days, use the DATE function. 

 
Note: the DATE function accepts three arguments: year, month and day. Excel knows that 
6 + 2 = 8 = August has 31 days and rolls over to the next month (23 August + 9 days = 1 
September). 
Current Date & Time 
To get the current date and time, use the NOW function. 

 
Note: use the TODAY function to enter today's date in Excel. 
Hour, Minute, Second 
To return the hour, use the HOUR function. 

 
Note: use the MINUTE and SECOND function to return the minute and second. 
Time Function 
To add a number of hours, minutes and/or seconds, use the TIME function. 
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Note: Excel adds 2 hours, 10 + 1 = 11 minutes and 70 - 60 = 10 seconds. 

INTRODUCTION TO EXCEL CHARTING 

Lesson 18 - Introduction to Excel Charting 
What Is An Excel Chart? 
Charts are Excel’s most basic way to visualise data. They offer a number of ways to 
represent your data graphically to make it easily understood. 
Excel also offers other ways to uncover data relationships in its more advanced functions 
and business intelligence suite. For more details on the different ways to visualise data 
see our Excel Course Offerings. 
Excel Charts provide a visual way of seeing trends in the data in your worksheet. 
How Can I Create A Chart In Excel? 
The beauty of the charting process is that it is delightfully easy and simple – starting from 
the insert tab. 

 Select the data that you wish to create a chart from 
 Click on the ‘Insert’ tab 
 If you know the type of chart you would like, click on the corresponding button 

within the Charts group within the Insert tab. If you wish to see all the chart types 
available, click on the little arrow in the bottom right-hand corner of the charts 
section 
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 I have chosen a simple column chart for this, your option may be different depending on 
data but the “recommended charts” feature is very helpful (more on this here). 
As you can see there are many different options in the Charts group and even more in 
the menu we opened! 

  
 This embeds the chart into your current worksheet. When you click onto the chart you 
will see thick grey box around it and the data used for the chart will have different colour 
boxes around it. 
When you are clicked onto the chart you are able to change its size by grabbing hold of 
the grey box at any of the circle points on the corners and in the centre of each side. 
Charts can take up a lot of space, you can master control of your page layout using this 
guide. 
 Moving a Chart to Its Own Page 
If you decide that you don’t want your chart on the same sheet as your data you can 
move it onto its own sheet. 

 Click on the chart 
 Click on the ‘Chart Design’ tab 
 Click on ‘Move Chart’ this opens a new box 
 Check the ‘New Sheet’ option 
 Click ok 
 This will move the chart into its own full sized sheet. 

  

https://www.acuitytraining.co.uk/news-tips/an-introduction-to-charts-in-excel-2010/#Recommended_Charts
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If you need to rename this charts page you can use the methods described in this post. 
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For this next section I have moved the chart back to an embedded chart on the same 
sheet as the data as this makes it easier to see what I am doing 
 Switching Rows / Columns In Data 

You may realise that the data would be better displayed the other way round. To change 
it 

 right click on the chart and pick ‘select data‘, this opens up another box 
 choose to ‘Switch Row/Column’, click on this and it will immediately change the 

way the chart displays the information. 
 to change it back, just click on the same button again. 

  
The Switch Row/Column tool is often the solution when the data you have made into a 
chart isn’t being visualised how you may expect! 
 Showing Data In A Chart 

If you are going to use the chart in something else, like a PowerPoint presentation, you 
may want to show the data as well. To do this 

 Click on the chart again and select the ‘Chart Design’ tab 
 Click on the button ‘Add Chart Element’ then ‘Data Table’ and pick whether or not 

you want legend keys. 
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 Different Types Of Excel Charts 
Excel charts come in many different forms and layouts. The use of them is up to your 
discretion but here are a few example of how you could use the most common Excel 
charts. Remember the Charts group contains several options but the menu has even 
more! 
Bar Chart – These Excel charts tend to be most useful when comparing different 
categories of data. As used in the previous example its effective when comparing salaries 
for different cities. You can quickly look at the chart and see the highest and lowest 
salaries even just at a glance. This will often be one of the recommended charts and is 
one of the most common types of charts. 
Pie Chart – A Pie Chart, on the other hand, is great for expressing the relationship an 
individual piece of data has with the whole data set. For example, if you wanted to show 
how much profit your department contributed compared to a whole companies profit – a 
Pie Chart would be excellent. 
Line Chart – Line Charts are excellent for showing growth over time. While a Bar Chart is 
great for showing the highest profit at one point, Line Charts are more appropriate for 
showing how that profit may change over a series of years. You can identify the highs and 
lows of your company’s lifespan quickly and their relationship to other points on the line 
chart! 
All three of these types of charts can be found in the Charts group as they are the most 
commonly used! 
Each Chart Type has its own uses – experiment with what’s best for your needs, and use 
the Recommended Charts feature too! 
 Recommended Charts 
Additionally – the Charts group contains a button for “recommended charts”, which will 
automatically select a chart type for you! Simply go to the Insert Tab and go over to the 
Charts group as before. 
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Recommended charts are best used when you don’t have any pre-existing plan for how 
the data should look. Excel collates countless data to figure out how to generate these 
recommended charts, so seeing what it has to offer couldn’t hurt. 
  
Change Chart Type 
To switch between different types of charts, click on the chart you have already created 
and navigate to the “Change Chart Type” button shown here within the Chart Design tab. 
  

 
  
From here you can switch to any Chart type you want! 
 

Lesson 19 - Advanced Excel Charting Examples 
Column Chart 
  
Column charts are used to compare values across categories by using vertical bars. 
To create a column chart, execute the following steps. 
1. Select the range A1:A7, hold down CTRL, and select the range C1:D7. 

 
2. On the Insert tab, in the Charts group, click the Column symbol. 
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3. Click Clustered Column. 

 
Result: 

 
Note: only if you have numeric labels, empty cell A1 before you create the column chart. 
By doing this, Excel does not recognize the numbers in column A as a data series and 
automatically places these numbers on the horizontal (category) axis. After creating the 
chart, you can enter the text Year into cell A1 if you like. 
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Line Chart 
  
Line charts are used to display trends over time. Use a line chart if you have text labels, 
dates or a few numeric labels on the horizontal axis. Use a scatter plot (XY chart) to show 
scientific XY data. 
To create a line chart, execute the following steps. 
1. Select the range A1:D7. 

 
2. On the Insert tab, in the Charts group, click the Line symbol. 

 
3. Click Line with Markers. 

 
Result: 
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Note: only if you have numeric labels, empty cell A1 before you create the line chart. By 
doing this, Excel does not recognize the numbers in column A as a data series and 
automatically places these numbers on the horizontal (category) axis. After creating the 
chart, you can enter the text Year into cell A1 if you like. 
Let's customize this line chart. 
To change the data range included in the chart, execute the following steps. 
4. Select the line chart. 
5. On the Design tab, in the Data group, click Select Data. 

 
6. Uncheck Dolphins and Whales and click OK. 

 
Result: 
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To change the color of the line and the markers, execute the following steps. 
7. Right click the line and click Format Data Series. 

 
The Format Data Series pane appears. 
8. Click the paint bucket icon and change the line color. 

 
9. Click Marker and change the fill color and border color of the markers. 
Result: 
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To add a trendline, execute the following steps. 
10. Select the line chart. 
11. Click the + button on the right side of the chart, click the arrow next to Trendline and 
then click More Options. 

 
The Format Trendline pane appears. 
12. Choose a Trend/Regression type. Click Linear. 
13. Specify the number of periods to include in the forecast. Type 2 in the Forward box. 
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Result: 

 
To change the axis type to Date axis, execute the following steps. 
14. Right click the horizontal axis, and then click Format Axis. 

 
The Format Axis pane appears. 
15. Click Date axis. 
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Result: 

 
Conclusion: the trend line predicts a population of approximately 250 bears in 2024. 
 

Lesson 20 - Dynamic Charts in Excel 
There are two ways to create a dynamic chart range in Excel: 

 Using Excel Table 
 Using Formulas 

In most of the cases, using Excel Table is the best way to create dynamic ranges in Excel. 
Let’s see how each of these methods work. 
Using Excel Table 
Using Excel Table is the best way to create dynamic ranges as it updates automatically 
when a new data point is added to it. 
Pro Tip: To convert a range of cells to an Excel Table, select the cells and use 
the keyboard shortcut – Control + T (hold the Control key and press the T key). 
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In the example below, you can see that as soon as add new data, the Excel Table expands 
to include this data as a part of the table (note that the border and formatting expand to 
include it in the table). 

 
Now, we need to use this Excel table while creating the charts. 
Here are the exact steps to create a dynamic line chart using the Excel table: 

 Select the entire Excel table. 

 
 Go to the Insert tab. 

 
 In the Charts Group, select ‘Line with Markers’ chart. 

 
That’s it! 
The above steps would insert a line chart which would automatically update when you 
add more data to the Excel table. 
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Note that while adding new data automatically updates the chart, deleting data would 
not completely remove the data points. For example, if you remove 2 data points, the 
chart will show some empty space on the right. To correct this, drag the blue mark at the 
bottom right of the Excel table to remove the deleted data points from the table (as 
shown below). 

 
While the example of a line chart, you can also create other chart types such as 
column/bar charts using this technique. 
Using Excel Formulas 
As mentioned, using Excel table is the best way to create dynamic chart ranges. 
However, if you can’t use Excel table for some reason (possibly if you are using Excel 
2003), there is another (slightly complicated) way to create dynamic chart ranges 
using Excel formulas and named ranges. 
Suppose you have the data set as shown below: 

 
To create a dynamic chart range from this data, we need to: 

1. Create two dynamic named ranges using the OFFSET formula (one each for 
‘Values’ and ‘Months’ column). Adding/deleting a data point would automatically 
update these named ranges. 

2. Insert a chart that uses the named ranges as a data source. 
Step 1 – Creating Dynamic Named Ranges 
Below are the steps to create dynamic named ranges: 

 Go to the ‘Formulas’ Tab. 
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 Click on ‘Name Manager’.  

 
 In the Name Manager dialog box, specify the name as ChartValues and enter the 

following formula in Refers to 
part: =OFFSET(Formula!$B$2,,,COUNTIF(Formula!$B$2:$B$100,”<>”)) 

 

 
 

 Click OK. 
 In the Name Manager dialog box, click on New. 
 In the Name Manager dialog box, specify the name as ChartMonths and enter the 

following formula in Refers to 
part: =OFFSET(Formula!$A$2,,,COUNTIF(Formula!$A$2:$A$100,”<>”)) 

 
 

 
 Click Ok. 
 Click Close. 

The above steps have created two named ranges in the Workbook – ChartValue and 
ChartMonth (these refer to the values and months range in the data set respectively). 
If you go and update the value column by adding one more data point, the ChartValue 
named range would now automatically update to show the additional data point in it. 
The magic is done by the OFFSET function here. 
In the ‘ChartValue’ named range formula, we have specified B2 as the reference point. 
OFFSET formula starts there and extends to cover all the filled cells in the column. 
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The Same logic works in the ChartMonth named range formula as well. 
Step 2 – Create a Chart Using these Named Ranges 
Now all you need to do is insert a chart that will use the named ranges as the data 
source. 
Here are the steps to insert a chart and use dynamic chart ranges: 

 Go to the Insert tab.  

 
 Click on ‘Insert Line or Area Chart’ and insert the ‘Line with markers’ chart. This 

will insert the chart in the worksheet.  

 
 With the chart selected, go to the Design tab.

 
 Click on Select Data. 
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 In the ‘Select Data Source’ dialog box, click on the Add button in ‘Legend Entries 

(Series)’. 
 In the Series value field, enter =Formula!ChartValues (note that you need to 

specify the worksheet name before the named range for this to work).  
 Click OK. 
 Click on the Edit button in the ‘Horizontal (Category) Axis Labels’. 

 
 In the ‘Axis Labels’ dialog box, enter =Formula!ChartMonths 

 

 
 Click Ok. 

That’s it! Now your chart is using a dynamic range and will update when you add/delete 
data points in the chart. 
A few important things to know when using named ranges with charts: 
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 There should not be any blank cells in the chart data. If there is a blank, named 
range would not refer to the correct dataset (as the total count would lead to it 
referring to less number of cells). 

 You need to follow the naming convention when using the sheet name in chart 
source. For example, if the sheet name is a single word, such as Formula, then you 
can use =Formula!ChartValue. But if there is more than one word, such as 
Formula Chart, then you need to use =’Formula Chart’!ChartValue. 

Lesson 21 - Sparklines in Excel 
Sparklines in Excel are graphs that fit in one cell. Sparklines are great for displaying 
trends. 
Insert Sparklines 
To insert sparklines, execute the following steps. 
1. Select the cells where you want the sparklines to appear. In this example, we select the 
range G2:G4. 

 
2. On the Insert tab, in the Sparklines group, click Line. 

 
3. Click in the Data Range box and select the range B2:F4. 

 
4. Click OK. 
Result: 

 
5. Change the value in cell F2 to 1186. 
Result. Excel automatically updates the sparkline. 
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Customize Sparklines 
To customize sparklines, execute the following steps. 
1. Select the sparklines. 
2. On the Design tab, in the Show group, check High Point and Low point. 

 
Result: 

 
Note: to make the sparklines larger, simply change the row height and column width of 
the sparkline cells. 
3. On the Design tab, in the Style group, choose a nice visual style. 

 
Result: 

 
Note: the high points are colored green now and the low points are colored red. 
To delete a sparkline, execute the following steps. 
4. Select 1 or more sparklines. 
5. On the Design tab, in the Group group, click Clear. 
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Compare Sparklines 
By default, each sparkline has its own vertical scale. The maximum value is plotted at the 
top of the cell. The minimum value is plotted at the bottom of the cell. 
To compare sparklines, execute the following steps. 
1. Select the sparklines. 
2. On the Design tab, in the Type group, click Column. 

 
Result: 

 
Note: all green bars have the same height, but the maximum values (B2, E3 and F4) are 
different! 
3. Select the sparklines. 
4. On the Design tab, in the Group group, click Axis. 

 
5. Under Vertical Axis Minimum Value Options and Vertical Axis Maximum Value Options, 
select Same for All Sparklines. 
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Result: 

 
Note: now you can clearly see that the earnings of Jack are much higher. 
Win/Loss Sparklines 
A win/loss sparkline only shows whether each value is positive (win) or negative (loss). 
Sometimes this can be useful. 

 
Note: try it yourself. Download the Excel file and select the sparklines. Next, on the 
Design tab, click Column (instead of Win/Loss) to clearly see how high and low the values 
are. 

PIVOT TABLE  

Lesson 22 - Overview of Excel Pivot Table 
You can use a PivotTable to summarize, analyze, explore, and present summary data. 
PivotCharts complement PivotTables by adding visualizations to the summary data in a 
PivotTable, and allow you to easily see comparisons, patterns, and trends. Both 
PivotTables and PivotCharts enable you to make informed decisions about critical data in 
your enterprise. You can also connect to external data sources such as SQL Server tables, 
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SQL Server Analysis Services cubes, Azure Marketplace, Office Data Connection (.odc) 
files, XML files, Access databases, and text files to create PivotTables, or use existing 
PivotTables to create new tables. 
About PivotTables 

 A PivotTable is an interactive way to quickly summarize large amounts of data. You 
can use a PivotTable to analyze numerical data in detail, and answer unanticipated 
questions about your data. A PivotTable is especially designed for: 

 Querying large amounts of data in many user-friendly ways. 

 Subtotaling and aggregating numeric data, summarizing data by categories and 
subcategories, and creating custom calculations and formulas. 

 Expanding and collapsing levels of data to focus your results, and drilling down to 
details from the summary data for areas of interest to you. 

 Moving rows to columns or columns to rows (or "pivoting") to see different 
summaries of the source data. 

 Filtering, sorting, grouping, and conditionally formatting the most useful and 
interesting subset of data enabling you to focus on just the information you want. 

 Presenting concise, attractive, and annotated online or printed reports. 
Pivot Table 
Pivot tables are one of Excel's most powerful features. A pivot table allows you to extract 
the significance from a large, detailed data set. 
Our data set consists of 213 records and 6 fields. Order ID, Product, Category, Amount, 
Date and Country. 

 
Insert a Pivot Table 
To insert a pivot table, execute the following steps. 
1. Click any single cell inside the data set. 
2. On the Insert tab, in the Tables group, click PivotTable. 

 
The following dialog box appears. Excel automatically selects the data for you. The 
default location for a new pivot table is New Worksheet. 
3. Click OK. 
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Drag fields 
The PivotTable Fields pane appears. To get the total amount exported of each product, 
drag the following fields to the different areas. 
1. Product field to the Rows area. 
2. Amount field to the Values area. 
3. Country field to the Filters area. 

 
Below you can find the pivot table. Bananas are our main export product. That's how 
easy pivot tables can be! 

 
Sort 
To get Banana at the top of the list, sort the pivot table. 
1. Click any cell inside the Sum of Amount column. 
2. Right click and click on Sort, Sort Largest to Smallest. 
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Result. 

 
Filter 
Because we added the Country field to the Filters area, we can filter this pivot table by 
Country. For example, which products do we export the most to France? 
1. Click the filter drop-down and select France. 
Result. Apples are our main export product to France. 

 
Note: you can use the standard filter (triangle next to Row Labels) to only show the 
amounts of specific products. 
Change Summary Calculation 
By default, Excel summarizes your data by either summing or counting the items. To 
change the type of calculation that you want to use, execute the following steps. 
1. Click any cell inside the Sum of Amount column. 
2. Right click and click on Value Field Settings. 
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3. Choose the type of calculation you want to use. For example, click Count. 

 
4. Click OK. 
Result. 16 out of the 28 orders to France were 'Apple' orders. 

 
Two-dimensional Pivot Table 
If you drag a field to the Rows area and Columns area, you can create a two-dimensional 
pivot table. First, insert a pivot table. Next, to get the total amount exported to each 
country, of each product, drag the following fields to the different areas. 
1. Country field to the Rows area. 
2. Product field to the Columns area. 
3. Amount field to the Values area. 
4. Category field to the Filters area. 

https://www.excel-easy.com/data-analysis/pivot-tables.html#insert-pivot-table
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Below you can find the two-dimensional pivot table. 

 
To easily compare these numbers, create a pivot chart and apply a filter. Maybe this is 
one step too far for you at this stage, but it shows you one of the many other powerful 
pivot table features Excel has to offer. 

 
Lesson 23- Pivot Chart 
Create a PivotChart 
Sometimes it's hard to see the big picture when your raw data hasn’t been summarized. 

Your first instinct may be to create a PivotTable, but not everyone can look at numbers in 

a table and quickly see what's going on. Pivot Charts are a great way to add data 

visualizations to your data. 

https://www.excel-easy.com/examples/pivot-chart.html
https://support.microsoft.com/en-us/office/create-a-pivottable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-f99134456576
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Create a PivotChart 

 
1. Select a cell in your table. 
2. Select Insert > PivotChart . 

3. Select OK. 
Create a chart from a PivotTable 

1. Select a cell in your table. 

2. Select PivotTable Tools > Analyze > PivotChart . 
3. Select a chart. 
4. Select OK. 
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INFOGRAPHICS IN EXCEL  

Lesson 24 –Info graphics with Excel 
Infographics in excel is the way of showing the information or summary report through 
attractive charts, graphs, and images. In other words infographics are the art of 
visualizing the data using external elements or images. They are different from 
dashboards and require the architectural mind to build your own infographics in excel. 

 
  

How to Create People Graph Infographics in Excel? 
Now we will see some of the examples of creating infographics in excel. 
People Graph is the new additional feature available from Excel 2013 versions onwards. 
This is a graph available with Excel 2013 onwards versions under the INSERT tab. 

 
For example, below is an organization’s departmental manpower, and for this data, we 
will show you how to create people graph infographics in excel. 
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Steps to create an infographics in excel are as follows. 

1. Copy the data to the excel worksheet, select the data to go to the INSERT tab, and click 
on “People Graph.” 
 

 
2. First, it will show about numbers of this particular app. 
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3. Click on the “Data” icon at the top. 

 

 
4. Choose “Select Data”. 
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5. Now, it will show sample data preview, but at the bottom, it shows how many rows 

and columns in excel are selected. Now click on “Create” to get your first People Graph. 
 

 
We get the following People Graph. 
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Not all the departments are showing here; we need to expand the chart to see all the 
department data. 
From the data, the tab changes the title of the chart. 

 
Click on “Settings” options to format the chart. 

 
 
In this “Settings,” we have three options, i.e., “Type,” “theme,” and “Shape.” 
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From the type, we can choose a different kind of people graph. 

 
Under “Theme,” we can change the color background of the chart. 

 
Under “Shape,” we can change icons of the chart. 
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How to Use External Images to Create Infographics? 
We have seen people graph infographics in excel; we can build infographics by using 
external images as well. For the same data, we will use a human image from outside 
excel. 
I have downloaded the below human image from the internet into excel worksheet. 

 
First, insert a bar chart in excel for the data. 
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Now we have a chart like this. 

 
What you have to do is copy the human image >>> select the bar and paste it. 
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We need to format the chart to make it more beautiful. Select the bar and press Ctrl + 1 
to open the formatting tab to the right side. 

 
Make the “Gap Width” as 0%. 
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Now go to “Fill” and click on “Fill.”Make the fill as “Picture or Texture Fill” and check the 
option of “Stack and Scale Width.” 

 
Now our chart looks like this. 
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Now assume we have a segregation of “Male” and “Female” employees. 

 
In the infographic chart, we need to show male and female human images.  
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Select the data and insert the “Stacked Bar” chart. 

 
Now we have a chart like this. 
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Copy the “Male” image and paste it on an orange-colored bar. 

 
Copy the “Female” image and paste it on a yellow-colored bar. 
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Select the male bar and format the data series as we did in the previous example. Do the 
same thing for the “Female” chart as well, and we have a segregation of “Male” and 
“Female” separately now. 

 
We do one more thing to show male and female employees differently. Arrange the data 
in the below manner. 
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I have converted male employee’s numbers to, now, we can see male employees to the 
left and female employees to the right. 
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ADVANCED DATA ANALYSIS  

Lesson 25 - Advanced sorting & filtering 
You can sort your Excel data on one column or multiple columns. You can sort in 
ascending or descending order. 
One Column 
To sort on one column, execute the following steps. 
1. Click any cell in the column you want to sort. 

 
2. To sort in ascending order, on the Data tab, in the Sort & Filter group, click AZ. 

 
Result: 
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Note: to sort in descending order, click ZA. 
Multiple Columns 
To sort on multiple columns, execute the following steps. 
1. On the Data tab, in the Sort & Filter group, click Sort. 

 
The Sort dialog box appears. 
2. Select Last Name from the 'Sort by' drop-down list. 

 
3. Click on Add Level. 
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4. Select Sales from the 'Then by' drop-down list. 

 
5. Click OK. 
Result. Records are sorted by Last Name first and Sales second. 
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Filter 
 Filter your Excel data if you only want to display records that meet certain criteria. 
1. Click any single cell inside a data set. 
2. On the Data tab, in the Sort & Filter group, click Filter. 

 
Arrows in the column headers appear. 

 
3. Click the arrow next to Country. 
4. Click on Select All to clear all the check boxes, and click the check box next to USA. 
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5. Click OK. 
Result. Excel only displays the sales in the USA. 

 
6. Click the arrow next to Quarter. 
7. Click on Select All to clear all the check boxes, and click the check box next to Qtr 4. 
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8. Click OK. 
Result. Excel only displays the sales in the USA in Qtr 4. 

 
9. To remove the filter, on the Data tab, in the Sort & Filter group, click Clear. To remove 
the filter and the arrows, click Filter. 
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There's a quicker way to filter Excel data. 
10. Select a cell. 

 
11. Right click, and then click Filter, Filter by Selected Cell's Value. 
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Result. Excel only displays the sales in the USA. 

 
Note: simply select another cell in another column to further filter this data set. 
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Advanced Filter 
This example teaches you how to apply an advanced filter in Excel to only display records 
that meet complex criteria. 
When you use the Advanced Filter, you need to enter the criteria on the worksheet. 
Create a Criteria range (blue border below for illustration only) above your data set. Use 
the same column headers. Be sure there's at least one blank row between your Criteria 
range and data set. 
And Criteria 
To display the sales in the USA and in Qtr 4, execute the following steps. 
1. Enter the criteria shown below on the worksheet. 

 
2. Click any single cell inside the data set. 
3. On the Data tab, in the Sort & Filter group, click Advanced. 
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4. Click in the Criteria range box and select the range A1:D2 (blue). 
5. Click OK. 

 
Notice the options to copy your filtered data set to another location and display unique 
records only (if your data set contains duplicates). 
Result. 
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No rocket science so far. We can achieve the same result with the normal filter. We need 
the Advanced Filter for Or criteria. 
Or Criteria 
To display the sales in the USA in Qtr 4 or in the UK in Qtr 1, execute the following steps. 
6. Enter the criteria shown below on the worksheet. 
7. On the Data tab, in the Sort & Filter group, click Advanced, and adjust the Criteria 
range to range A1:D3 (blue). 
8. Click OK. 

 
Result. 
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Formula as Criteria 
To display the sales in the USA in Qtr 4 greater than $10.000 or in the UK in Qtr 1, 
execute the following steps. 
9. Enter the criteria (+formula) shown below on the worksheet. 
10. On the Data tab, in the Sort & Filter group, click Advanced, and adjust the Criteria 
range to range A1:E3 (blue). 
11. Click OK. 
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Result. 

 
Note: always place a formula in a new column. Do not use a column label or use a column 
label that is not in your data set. Create a relative reference to the first cell in the column 
(B6). The formula must evaluate to TRUE or FALSE. 
Date Filters 
  
This example teaches you how to apply a date filter to only display records that meet 
certain criteria. 
1. Click any single cell inside a data set. 
2. On the Data tab, in the Sort & Filter group, click Filter. 

 
Arrows in the column headers appear. 
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3. Click the arrow next to Date. 
4. Click on Select All to clear all the check boxes, click the + sign next to 2015, and click 
the check box next to January. 

 
5. Click OK. 
Result. Excel only displays the sales in 2015, in January. 
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6. Click the arrow next to Date. 
7. Click on Select All to select all the check boxes. 
8. Click Date Filters (this option is available because the Date column contains dates) and 
select Last Month from the list. 

 
Result. Excel only displays the sales of last month. 
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Note: this date filter and many other date filters depend on today's date. 

Lesson 26 - What if analysis 

What-If Analysis in Excel allows you to try out different values (scenarios) for formulas. 
The following example helps you master what-if analysis quickly and easily. 
Assume you own a book store and have 100 books in storage. You sell a certain % for the 
highest price of $50 and a certain % for the lower price of $20. 

 
If you sell 60% for the highest price, cell D10 calculates a total profit of 60 * $50 + 40 * 
$20 = $3800. 
Create Different Scenarios 
But what if you sell 70% for the highest price? And what if you sell 80% for the highest 
price? Or 90%, or even 100%? Each different percentage is a different scenario. You can 
use the Scenario Manager to create these scenarios. 
Note: You can simply type in a different percentage into cell C4 to see the corresponding 
result of a scenario in cell D10. However, what-if analysis enables you to easily compare 
the results of different scenarios. Read on. 
1. On the Data tab, in the Forecast group, click What-If Analysis. 

 
2. Click Scenario Manager. 

 
The Scenario Manager dialog box appears. 
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3. Add a scenario by clicking on Add. 

 
4. Type a name (60% highest), select cell C4 (% sold for the highest price) for the 
Changing cells and click on OK. 

 
5. Enter the corresponding value 0.6 and click on OK again. 
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6. Next, add 4 other scenarios (70%, 80%, 90% and 100%). 
Finally, your Scenario Manager should be consistent with the picture below: 

 
Note: to see the result of a scenario, select the scenario and click on the Show button. 
Excel will change the value of cell C4 accordingly for you to see the corresponding result 
on the sheet. 
Scenario Summary 
To easily compare the results of these scenarios, execute the following steps. 
1. Click the Summary button in the Scenario Manager. 
2. Next, select cell D10 (total profit) for the result cell and click on OK. 
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Result: 

 
Conclusion: if you sell 70% for the highest price, you obtain a total profit of $4100, if you 
sell 80% for the highest price, you obtain a total profit of $4400, etc. That's how easy 
what-if analysis in Excel can be. 
Goal Seek 
What if you want to know how many books you need to sell for the highest price, to 
obtain a total profit of exactly $4700? You can use Excel's Goal Seek feature to find the 
answer. 
1. On the Data tab, in the Forecast group, click What-If Analysis. 

 
2. Click Goal Seek. 

 
The Goal Seek dialog box appears. 
3. Select cell D10. 
4. Click in the 'To value' box and type 4700. 
5. Click in the 'By changing cell' box and select cell C4. 
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6. Click OK. 

 
Result. You need to sell 90% of the books for the highest price to obtain a total profit of 
exactly $4700. 

 
 
 

Lesson 27 – Consolidation 

The consolidate function in Excel allows an analyst to combine information from multiple 
workbooks into one place.  The Excel consolidate function lets you select data from its 
various locations and creates a table to summarize the information for you. 
You can use Excel's Consolidate feature to consolidate your worksheets (located in one 
workbook or multiple workbooks) into one worksheet. Below you can find the workbooks 
of three districts. 
Before you start: if your worksheets are identical, it's probably easier to create 3D-
references (if you have one workbook) or External References (if you have multiple 
workbooks) to consolidate your data. 
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As you can see, the worksheets are not identical. However, the beauty of the Consolidate 
feature is that it can easily sum, count, average, etc this data by looking at the labels. This 
is a lot easier than creating formulas. 
1. Open all three workbooks. 
2. Open a blank workbook. On the Data tab, in the Data Tools group, click Consolidate. 

 
3. Choose the Sum function to sum the data. 
4. Click in the Reference box, select the range A1:E4 in the district1 workbook, and click 
Add. 
5. Repeat step 4 for the district2 and district3 workbook. 

 
6. Check Top row, Left column and Create links to source data. 
Note: if you don't check Top row and Left column, Excel sums all cells that have the same 
position. For example, cell B2 (in district1.xlsx) + cell B2 (in district2.xlsx) + cell B2 (in 
district3.xlsx). Because our worksheets are not identical, we want Excel to sum cells that 
have the same labels. If you check Create links to source data, Excel creates a link to your 
source data (your consolidated data will be updated if your source data changes) and 
creates an outline. 
7. Click OK. 
Result. 
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Lesson 28 - Power Query introduction, Power query Installation 

What is Excel Power Query? 
Power Query is an Excel add-in that you can use for ETL. That means, you can extract 
data from different sources, transform it, and then load it to the worksheet. You can say 
POWER QUERY is a data cleansing machine as it has all the options to transform the data. 
It is real-time and records all the steps that you perform. 
Why Should You Use Power Query (Benefits)? 
If you have this question in your mind, here’s my answer for you: 

 Different Data Sources: You can load data into power query editor from different 
data sources, like, CSV, TXT, JSON, etc. 

 Transform Data Easily: Normally you use formulas and pivot tables for data 
transformations but with POWER QUERY you can do a lot thing just with clicks. 

 It’s Real-Time: Write a query for once and you can refresh it every time there is a 
change in data, and it will transform the new data which you have updated. 
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An example: 
Imagine you have 100 Excel files that have data from 100 cities and now your boss wants 
you to create a report with all the data from those 100 files. OKAY, if you decide to open 
each file manually and copy and paste data from those files and you need at least one 
hour for this. But with the power query, you can do it in minutes.  
The Concept of Power Query 
To learn power query, you need to understand its concept that works in 3 steps: 
1. Get Data 
Power query allows you to get data from different sources like web, CSV, text files, 
multiple workbooks from a folder, and a lot of other sources where we can store data. 
2. Transform Data 
After getting data in the power query you have a whole bunch of options that you can 
use to transform it and clean it. It creates queries for all the steps you perform (in a 
sequence one step after another). 
3. Load Data 
From the power query editor, you can load the transformed data to the worksheet, or 
you can directly create a pivot table or a pivot chart or create a data connection only. 
Where is Power Query (How to install it)? 
Below you can see how to install access to the power query in the different versions of 
Microsoft Excel. 
Excel 2016, 2019, Office 365 
If you are using Excel 2016, Excel 2019, or you have OFFICE 365 subscription, it’s already 
there on the Data tab, as a group named “GET & TRANSFORM”. 
 

 
 
Excel 2010 and Excel 2013 
For 2010 and 2013, you need to install an add-in separately which you can download 
from this link and once you install it, you’ll get a new tab in the Excel ribbon, like below: 

https://www.microsoft.com/en-in/download/details.aspx?id=39379
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 First, download the add-in from here (Microsoft’s Official Website). 
 Once you have downloaded the file, open it and follow the instructions. 
 After that, you’ll automatically get the “Power Query” tab on your Excel ribbon. 

If somehow that “POWER QUERY” tab doesn’t appear, there is no need to worry about it. 
You can add it using the COM Add-ins option. 

 Go to File Tab ➜ Options ➜ Add-ins. 

 
 In “Add-In” options, select “COM Add-ins” and click GO. 
 After that, tick mark “Microsoft Power Query for Excel”. 

 
 In the end, click OK. 

Example – Import Data from Text File 
Getting the data from a text file is common, and each column is separated by delimiter 
value. For example, look at the below data table. 

 
We will use power query to import this data and transform it the format which excel 
loves working with. 

1. Go to Data tab and under get data click on From File and under this click on “From Text 
/ CSV”. 
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2. Now it will ask you to choose the file that you would like to import, so choose the file 

and click on “Ok”. 

 
 
 

3. This will display the preview of the data before it loads to power query model, and it 
looks like this. 
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As you can see above, it has automatically detected the delimiter as “comma” and 
segregated the data into multiple columns. 

4. Click on “Load” at the bottom and data will be loaded to excel file in excel table format. 
 

 
 
As you can see to the right side, we have a window called “Queries & Connections”, so 
this suggests that data is imported through power query. 
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5. Once the data is loaded to excel the connected text file should be intact with excel, so 
go to the text file and add two extra lines of data. 

 
6. Now come to excel and select the table, and it will show two more tabs as “Query & 

Table Design”. 
 

 
7. Under “Query” click on “Refresh” button and data will be refreshed with updated two 

new rows. 
 

 
8. There is another problem here, i.e. first row is not captured as a column header. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  635 | 1352  

 

 
9. To apply these changes, click on “Edit Query” under “Query” tab. 

 

 
10. This will open the power query editor tab. 

 

 
 
This is where we need power query. 

11. To make the first row as header under HOME tab, click on “Use First Row as Header”. 
 

 
12. So this will make the first row as a column header, and we can see this below. 
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13. Click on “Close & Load” under the HOME tab, and data will be back to excel with 

modified changes. 
 

 
14. Now in excel, we have data like this. 

 

 
 
Without changing the actual position of the data, power query modified the data. 
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Lesson 29 - Power query – Append Query, Merge Query   
Merge queries (Power Query) 
When you merge, you typically join two queries that are either within Excel or from an 
external data source. In addition, the Merge feature has an intuitive user interface to 
help you easily join two related tables. For an example of merging total sales from an 
order details query into a products table, see the Learn to combine multiple data 
sources tutorial. 
About Merging queries 
A merge query creates a new query from two existing queries. One query result contains 
all columns from a primary table, with one column serving as a single column containing 
a relationship to a secondary table. The related table contains all rows that match each 
row from a primary table based on a common column value. An Expand operation adds 
columns from a related table into a primary table.  
There are two types of merge operations: 

 Inline Merge    You merge data into your existing query until you reach a final result. The 
result is a new step at the end of the current query. 

 Intermediate Merge     You create a new query for each merge operation. 
To see a visual representation of the relationships in the Query Dependencies dialog box, 
select View > Query Dependencies. At the bottom of the dialog box, select 
the Layout command to control the diagram orientation. 

 
Perform a Merge operation 
You need at least two queries that can be merged and that have at least one or more 
columns to match in a join operation. They can come from different types of external 
data sources. The following example uses Products and Total Sales. 

1. To open a query, locate one previously loaded from the Power Query Editor, select a cell 
in the data, and then select Query > Edit. For more information see Create, load, or edit a 
query in Excel. 

2. Select Home > Merge Queries. The default action is to do an inline merge. To do an 
intermediate merge, select the arrow next to the command, and then select Merge 
Queries as New.  
 
The Merge dialog box appears. 

https://support.microsoft.com/en-us/office/learn-to-combine-multiple-data-sources-power-query-70cfe661-5a2a-4d9d-a4fe-586cc7878c7d
https://support.microsoft.com/en-us/office/learn-to-combine-multiple-data-sources-power-query-70cfe661-5a2a-4d9d-a4fe-586cc7878c7d
https://support.microsoft.com/en-us/office/create-load-or-edit-a-query-in-excel-power-query-ca69e0f0-3db1-4493-900c-6279bef08df4
https://support.microsoft.com/en-us/office/create-load-or-edit-a-query-in-excel-power-query-ca69e0f0-3db1-4493-900c-6279bef08df4
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3. Select the primary table from the first drop-down list, and then select a join column by 
selecting the column header. 

4. Select the related table from the next drop-down list, and then select a matching column 
by selecting the column header. 
 
Ensure that you select the same number of columns to match in the preview of the 
primary and related or secondary tables. Column comparison is based on the order of 
selection in each table. Matching columns must be the same data type, such 
as Text or Number. You can also select multiple columns to merge. 
 

 
5. After you select columns from a primary table and related table, Power Query displays 

the number of matches from a top set of rows. This action validates whether 
the Merge operation was correct or whether you need to make changes to get the 
results you want. You can either select different tables or columns. 

6. The default join operation is an inner join, but from the Join Kind drop down list, you can 
select the following types of join operations: 
Inner join    Brings in only matching rows from both the primary and related tables. 
 
Left outer join    Keeps all the rows from the primary table and brings in any matching 
rows from the related table. 
 
Right outer join    Keeps all the rows from the related table and brings in any matching 
rows from the primary table. 
 
Full outer    Brings in all the rows from both the primary and related tables. 
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Left anti join    Brings in only rows from the primary table that don't have any matching 
rows from the related table. 
 
Right anti join    Brings in only rows from the related table that don't have any matching 
rows from the primary table. 
 
Cross join    Returns the Cartesian product of rows from both tables by combining each 
row from the primary table with each row from the related table. 

7. If you want to do a fuzzy match, select Use fuzzy matching to perform the merge  and 
select from the Fuzzy Matching options. For more information, see Create a fuzzy match. 

8. To include only those rows from the primary table that match the related table, 
select Only include matching rows. Otherwise, all rows from the primary table are 
included in the resulting query. 

9. Select OK. 
Result 

 
Expand the Table column 
After a Merge operation, you can expand the Table structured column to add columns 
from the related table into the primary table. Once a column is expanded into the 
primary table, you can apply filters and other transform operations. For more 
information, see Work with a List, Record, or Table structured column. 

1. In the Data Preview, select the Expand   icon next to the NewColumn column header. 
2. In the Expand drop-down box, select or clear the columns to display the results you 

want. To aggregate the column values, select Aggregate. 

https://support.microsoft.com/en-us/office/create-a-fuzzy-match-power-query-ffdd5082-c0c8-4c8e-a794-bd3962b90649
https://support.microsoft.com/en-us/office/work-with-a-list-record-or-table-structured-column-power-query-d5e552be-c143-4f06-9a5e-0960bbaaf480
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3. You may want to rename the new columns. For more information, see Rename a column. 

Append Queries 
To combine the above data tables, you need to use the Append Queries feature. To use 
this feature click on- 
Home  >  Combine  >  Append Queries  >  Append Queries as New 

 
Step 2: Choose Tables for Appending 
When you click on Append Queries as New option, an Append window gets open that 
allows you to choose the data tables from Power Query. First, you need to specify how 
many tables you want to append. Then choose the tables and click OK as shown in the 
below picture. 

https://support.microsoft.com/en-us/office/rename-a-column-power-query-d72034d0-f271-4b62-bb57-1cce49d13a29
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Step 3: Close & Apply 
After you get the desired output as shown in the below picture, you can click on the Close 
& Apply button. 
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EXCEL PRINTING  

Lesson 30 – Print settings for worksheet, workbooks, Header & footer 
Print a Worksheet 
To print a worksheet in Excel, execute the following steps. 
1. On the File tab, click Print. 
2. To preview the other pages that will be printed, click 'Next Page' or 'Previous Page' at 
the bottom of the window. 
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3. To print the worksheet, click the big Print button. 

 
What to Print 
Instead of printing the entire worksheet, you can also print the current selection. 
1. First, select the range of cells you want to print. 
2. Next, under Settings, select Print Selection. 
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3. To print the selection, click the big Print button. 

 
Note: you can also print the active sheets (first select the sheets by holding down CTRL 
and clicking the sheet tabs) or print the entire workbook. Use the boxes next to Pages 
(see first screenshot) to only print a few pages of your document. For example, 2 to 2 
only prints the second page. 
Multiple Copies 
To print multiple copies, execute the following steps. 
1. Use the arrows next to the Copies box. 
2. If one copy contains multiple pages, you can switch between Collated and Uncollated. 
For example, if you print 6 copies, Collated prints the entire first copy, then the entire 
second copy, etc. Uncollated prints 6 copies of page 1, 6 copies of page 2, etc. 
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Orientation 
You can switch between Portrait Orientation (more rows but fewer columns) and 
Landscape Orientation (more columns but fewer rows). 
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Page Margins 
To adjust the page margins, execute the following steps. 
1. Select one of the predefined margins (Normal, Wide or Narrow) from the Margins 
drop-down list. 
2. Or click the 'Show Margins' icon at the bottom right of the window. Now you can drag 
the lines to manually change the page margins. 
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Scaling 
If you want to fit more data on one page, you can fit the sheet on one page. To achieve 
this, execute the following steps. 
1. Select 'Fit Sheet on One Page' from the Scaling drop-down list. 
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Note: you can also shrink the printout to one page wide or one page high. Click Custom 
Scaling Options to manually enter a scaling percentage or to fit the printout to a specific 
number of pages wide and tall. Be careful, Excel doesn't warn you when your printout 
becomes unreadable. 
Print with Grid lines & Headings 
Print gridlines (the horizontal and vertical lines on your worksheet) and row/column 
headers (1, 2, 3 etc. and A, B, C etc.) to make your printed copy easier to read. 
To print gridlines and headings in Excel, execute the following steps. 
1. On the Page Layout tab, in the Sheet Options group, check Print under Gridlines and 
check Print under Headings. 

 
2. On the File tab, click Print for a print preview. 
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Print Area 
  
If you set a print area in Excel, only that area will be printed. The print area is saved when 
you save the workbook. 
To set a print area, execute the following steps. 
1. Select a range of cells. 
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2. On the Page Layout tab, in the Page Setup group, click Print Area. 

 
3. Click Set Print Area. 

 
4. Save, close and reopen the Excel file. 
5. On the File tab, click Print. 
Result. See the print preview below. Only the print area will be printed. 
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Note: use the Name Manager to edit and delete print areas. On the Formulas tab, in the 
Defined Names group, click Name Manager. 
Headers and Footers 
  
This example teaches you how to add information to the header (top of each printed 
page) or footer (bottom of each printed page) in Excel. 
1. On the View tab, in the Workbook Views group, click Page Layout, to switch to Page 
Layout view. 

 
2. Click Add header. 
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The Header & Footer Tools contextual tab activates. 
3. On the Design tab, in the Header & Footer Elements group, click Current Date to add 
the current date (or add the current time, file name, sheet name, etc). 

 
Result: 

 
Note: Excel uses codes in order to automatically update the header or footer as you 
change the workbook. 
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4. You can also add information to the left and right part of the header. For example, click 
the left part to add the name of your company. 
5. Click somewhere else on the sheet to see the header. 
Page Numbers 
  
This example teaches you how to insert page numbers in Excel. 
1. On the View tab, in the Workbook Views group, click Page Layout, to switch to Page 
Layout view. 

 
2. Click Add footer. 

 
The Header & Footer Tools contextual tab activates. 
3. On the Design tab, in the Header & Footer Elements group, click Page Number to add 
the page number. 

 
4. Type " of " 
5. On the Design tab, in the Header & Footer Elements group, click Number of Pages to 
add the number of pages. 
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Result: 

 
Note: Excel uses codes in order to automatically update the header or footer as you 
change the workbook. 
6. Click somewhere else on the sheet to see the footer. 
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7. On the Design tab, in the Options group, you can add a different first page 
header/footer and a different header/footer for odd and even pages. 

 
8. On the View tab, in the Workbook Views group, click Normal, to switch back to Normal 
view. 
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6. On the Design tab, in the Options group, you can add a different first page 
header/footer and a different header/footer for odd and even pages. 

 
7. On the View tab, in the Workbook Views group, click Normal, to switch back to Normal 
view. 
Print Titles 
  
You can specify rows and columns in Excel that will be printed on each printed page. This 
can make your printed copy easier to read. 
To print titles, execute the following steps. 
1. On the Page Layout tab, in the Page Setup group, click Print Titles. 
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The Page Setup dialog box appears. 
2. To repeat row 1 at the top of each printed page, click in the corresponding box and 
select row 1. 
3. Click OK. 

 
Note: in a similar way, you can repeat columns at the left of each printed page. 
4. On the File tab, click Print for a print preview. 
The labels (LastName, Sales, Country and Quarter) appear on page 1 and page 2. 
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Center on Page 
  
To center a range of cells on a printed page in Excel automatically, execute the following 
steps. 
1. On the File tab, click Print. 
2. Click 'Custom Margins' from the Margins drop-down list. 
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3. Next, check horizontally and vertically. 
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4. Click OK. 
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Module 4: Power Point Presentation (Advance) 

Lesson 1: PowerPoint Basics 
Getting Started with PowerPoint 
PowerPoint is a presentation program that allows you to create dynamic slide 
presentations. These presentations can include animation, narration, images, videos, and 
much more. In this lesson, you'll learn your way around the PowerPoint environment, 
including the Ribbon, Quick Access Toolbar, and Backstage view. 
Getting to know PowerPoint 
PowerPoint 2016 is similar to PowerPoint 2013 and PowerPoint 2010. If you've previously 
used these versions, PowerPoint 2016 should feel familiar. But if you are new to 
PowerPoint or have more experience with older versions, you should first take some time 
to become familiar with the PowerPoint 2016 interface. 
The PowerPoint interface 
When you open PowerPoint for the first time, the Start Screen will appear. From here, 
you'll be able to create a new presentation, choose a template, and access your recently 
edited presentations. From the Start Screen, locate and select Blank Presentation to 
access the PowerPoint interface. 

 
  
Click the buttons in the interactive below to become familiar with the PowerPoint 
interface. 

https://edu.gcfglobal.org/en/powerpoint2016/getting-started-with-powerpoint/1/
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Working with the PowerPoint environment 
The Ribbon and Quick Access Toolbar are where you will find the commands to perform 
common tasks in PowerPoint. Backstage view gives you various options for saving, 
opening a file, printing, and sharing your document. 
The Ribbon 
PowerPoint uses a tabbed Ribbon system instead of traditional menus. The 
Ribbon contains multiple tabs, each with several groups of commands. For example, the 
Font group on the Home tab contains commands for formatting text in your document. 

 
Some groups also have a small arrow in the bottom-right corner that you can click for 
even more options. 
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Showing and hiding the Ribbon 
The Ribbon is designed to respond to your current task, but you can choose 
to minimize it if you find that it takes up too much screen space. Click the Ribbon Display 
Options arrow in the upper-right corner of the Ribbon to display the drop-down menu. 

 
 Auto-hide Ribbon: Auto-hide displays your workbook in full-screen mode 

and completely hides the Ribbon. To show the Ribbon, click the Expand 
Ribbon command at the top of screen. 

 Show Tabs: This option hides all command groups when they're not in 
use, but tabs will remain visible. To show the Ribbon, simply click a tab. 

 Show Tabs and Commands: This option maximizes the Ribbon. All of the 
tabs and commands will be visible. This option is selected by default when 
you open PowerPoint for the first time. 

Using the Tell me feature 
If you're having trouble finding command you want, the Tell Me feature can help. It 
works just like a regular search bar: Type what you're looking for, and a list of options will 
appear. You can then use the command directly from the menu without having to find it 
on the Ribbon. 
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The Quick Access Toolbar 
Located just above the Ribbon, the Quick Access Toolbar lets you access common 
commands no matter which tab is selected. By default, it includes the Save, Undo, Redo, 
and Start From Beginning commands. You can add other commands depending on your 
preference. 
To add commands to the Quick Access Toolbar: 

1. Click the drop-down arrow to the right of the Quick Access Toolbar. 

 
2. Select the command you want to add from the drop-down menu. To 

choose from more commands, select More Commands. 
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3. The command will be added to the Quick Access Toolbar. 

 
The Ruler, guides, and gridlines 
PowerPoint includes several tools to help organize and arrange content on your slides, 
including the Ruler, guides, and gridlines. These tools make it easier to align objects on 
your slides. Simply click the check boxes in the Show group on the View tab to show and 
hide these tools. 
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Zoom and other view options 
PowerPoint has a variety of viewing options that change how your presentation is 
displayed. You can choose to view your presentation in Normal view, Slide 
Sorter view, Reading view, or Slide Show view. You can also zoom in and out to make 
your presentation easier to read. 
Switching slide views 
Switching between different slide views is easy. Just locate and select the desired slide 
view command in the bottom-right corner of the PowerPoint window. 

 
Zooming in and out 
To zoom in or out, click and drag the zoom control slider in the bottom-right corner of 
the PowerPoint window. You can also select the + or - commands to zoom in or out by 
smaller increments. The number next to the slider displays the current zoom percentage, 
also called the zoom level. 
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Backstage view 
Backstage view gives you various options for saving, opening, printing, and sharing your 
presentations. To access Backstage view, click the File tab on the Ribbon. 

 
Click the buttons in the interactive below to learn more about using Backstage view. 
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1.2 Creating and Opening Presentations 
PowerPoint files are called presentations. Whenever you start a new project in 
PowerPoint, you'll need to create a new presentation, which can either be blank or from 
a template. You'll also need to know how to open an existing presentation. 
To create a new presentation: 
When beginning a new project in PowerPoint, you'll often want to start with a new blank 
presentation. 

1. Select the File tab to go to backstage view. 

 
2. Select New on the left side of the window, then click Blank Presentation. 

 
3. A new presentation will appear. 

To create a new presentation from a template: 
A template is a predesigned presentation you can use to create a new slide show quickly. 
Templates often include custom formatting and designs, so they can save you a lot of 
time and effort when starting a new project. 

1. Click the File tab to access backstage view, then select New. 

https://edu.gcfglobal.org/en/powerpoint2016/creating-and-opening-presentations/1/
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2. You can click a suggested search to find templates or use the search bar to 
find something more specific. In our example, we'll search for the 
keyword chalkboard. 

 
3. Select a template to review it. 

 
4. A preview of the template will appear, along with additional 

information on how the template can be used. 
5. Click Create to use the selected template. 
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6. A new presentation will appear with the selected template. 

It's important to note that not all templates are created by Microsoft. Many are created 
by third-party providers and even individual users, so some templates may work better 
than others. 
To open an existing presentation: 
In addition to creating new presentations, you'll often need to open a presentation that 
was previously saved. To learn more about saving presentations, visit our lesson 
on Saving Presentations. 

1. Select the File tab to go to Backstage view, then click Open. 

 
2. Click Browse. Alternatively, you can choose OneDrive to open files stored 

on your OneDrive. 

http://www.gcflearnfree.org/powerpoint2016/saving-presentations/1/
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3. The Open dialog box will appear. Locate and select your presentation, 

then click Open. 

 
Most features in Microsoft Office, including PowerPoint, are geared toward saving and 
sharing documents online. This is done with OneDrive, which is an online storage space 
for your documents and files. If you want to use OneDrive, make sure you’re signed in to 
PowerPoint with your Microsoft account. Review our lesson on Understanding 
OneDrive to learn more. 

http://www.gcflearnfree.org/powerpoint2016/understanding-onedrive/1/
http://www.gcflearnfree.org/powerpoint2016/understanding-onedrive/1/
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To pin a presentation: 
If you frequently work with the same presentation, you can pin it to Backstage view for 
easy access. 

1. Select the File tab to go to Backstage view, then click Open. Your Recent 
Presentations will appear. 

2. Hover the mouse over the presentation you want to pin, then click 
the pushpin icon. 

 
3. The presentation will stay in the Recent presentations list until it is 

unpinned. To unpin a presentation, click the pushpin icon again. 

 
Compatibility Mode 
Sometimes you may need to work with presentations that were created in earlier 
versions of PowerPoint, like PowerPoint 2003 or PowerPoint 2000. When you open these 
types of presentations, they will appear in Compatibility Mode. 
Compatibility Mode disables certain features, so you'll only be able to access commands 
found in the program that was used to create the presentation. For example, if you open 
a presentation created in PowerPoint 2003, you can only use tabs and commands found 
in PowerPoint 2003. 
In the image below, you can see at the top of the window that the presentation is in 
Compatibility Mode. This will disable some PowerPoint 2016 features, including newer 
types of slide transitions. 
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To exit Compatibility Mode, you'll need to convert the presentation to the current 
version type. However, if you're collaborating with others who only have access to an 
earlier version of PowerPoint, it's best to leave the presentation in Compatibility Mode so 
the format will not change. 
You can review this support page from Microsoft to learn more about which features are 
disabled in Compatibility Mode. 
To convert a presentation: 
If you want access to all PowerPoint 2016 features, you can convert the presentation to 
the 2016 file format. 
Note that converting a file may cause some changes to the original layout of the 
presentation. 

1. Click the File tab to access Backstage view. 

 
2. Locate and select the Convert command. 

http://office.microsoft.com/en-us/powerpoint-help/powerpoint-2013-features-behave-differently-in-earlier-versions-HA102893464.aspx?CTT=5&origin=HA102893492


 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  675 | 1352  

 
3. The Save As dialog box will appear. Select the location where you want to 

save the presentation, enter a file name, and click Save. 

 
4. The presentation will be converted to the newest file type. 

 
 

1.3 Saving Presentations 
Whenever you create a new presentation in PowerPoint, you'll need to know how to 
save in order to access and edit it later. As with previous versions of PowerPoint, you can 
save files to your computer. If you prefer, you can also save files to the cloud using 
OneDrive. You can even export and share presentations directly from PowerPoint. 

https://edu.gcfglobal.org/en/powerpoint2016/saving-presentations/1/


 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  676 | 1352  

Save and Save As 
PowerPoint offers two ways to save a file: Save and Save As. These options work in 
similar ways, with a few important differences. 

 Save: When you create or edit a presentation, you'll use 
the Save command to save your changes. You'll use this command most 
of the time. When you save a file, you'll only need to choose a file name 
and location the first time. After that, you can just click the Save 
command to save it with the same name and location. 

 Save As: You'll use this command to create a copy of a presentation while 
keeping the original. When you use Save As, you'll need to choose a 
different name and/or location for the copied version. 

About OneDrive 
Most features in Microsoft Office, including PowerPoint, are geared toward saving and 
sharing documents online. This is done with OneDrive, which is an online storage space 
for your documents and files. If you want to use OneDrive, make sure you’re signed in to 
PowerPoint with your Microsoft account. Review our lesson on Understanding 
OneDrive to learn more. 
To save a presentation: 
It's important to save your presentation whenever you start a new project or make 
changes to an existing one. Saving early and often can prevent your work from being lost. 
You'll also need to pay close attention to where you save the presentation so it will be 
easy to find later. 

1. Locate and select the Save command on the Quick Access Toolbar. 

 
2. If you're saving the file for the first time, the Save As pane will appear 

in Backstage view. 
3. You'll then need to choose where to save the file and give it a file name. 

Click Browse to select a location on your computer. Alternatively, you can 
click OneDrive to save the file to your OneDrive. 

http://www.gcflearnfree.org/powerpoint2016/understanding-onedrive/1/
http://www.gcflearnfree.org/powerpoint2016/understanding-onedrive/1/


 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  677 | 1352  

 
4. The Save As dialog box will appear. Select the location where you want to 

save the presentation. 
5. Enter a file name for the presentation, then click Save. 

 
6. The presentation will be saved. You can click the Save command again to 

save your changes as you modify the presentation. 
You can also access the Save command by pressing Ctrl+S on your keyboard. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  678 | 1352  

Using Save As to make a copy 
If you want to save a different version of a presentation while keeping the original, you 
can create a copy. For example, if you have a file named Client Presentation you could 
save it as Client Presentation 2 so you'll be able to edit the new file and still refer back to 
the original version. 
To do this, you'll click the Save As command in Backstage view. Just like when saving a file 
for the first time, you'll need to choose where to save the file and give it a new file name. 

 
To change the default save location: 
If you don't want to use OneDrive, you may be frustrated that OneDrive is selected as the 
default location when saving. If you find this inconvenient, you can change the default 
save location so This PC is selected by default. 

1. Click the File tab to access Backstage view. 

 
2. Click Options. 
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3. The PowerPoint Options dialog box will appear. Select Save, check the 

box next to Save to Computer by default, then click OK. The default save 
location will be changed. 
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Using Auto Recover 
PowerPoint automatically saves your presentations to a temporary folder while you are 
working on them. If you forget to save your changes or if PowerPoint crashes, you can 
restore the file using AutoRecover. 
To use Auto Recover: 

1. Open PowerPoint. If autosaved versions of a file are found, 
the Document Recovery pane will appear. 

2. Click to open an available file. The presentation will be recovered. 
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By default, PowerPoint autosaves every 10 minutes. If you are editing a presentation for 
less than 10 minutes, PowerPoint may not create an autosaved version. 
If you don't see the file you need, you can browse all autosaved files 
from Backstage view. Just select the File tab, click Manage Presentation, then 
choose Recover Unsaved Presentations. 

 
1.4 Exporting presentations 
By default, PowerPoint presentations are saved in the .pptx file type. However, there 
may be times when you need to use another file type, such as a PDF or PowerPoint 97-
2003 presentation. It's easy to export your presentation from PowerPoint in a variety of 
file types. 

 PDF: Saves the presentation as a PDF document instead of a PowerPoint 
file 
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 Video: Saves the presentation as a video 
 Package for CD: Saves the presentation in a folder along with the 

Microsoft PowerPoint Viewer, a special slide show player anyone can 
download 

 Handouts: Prints a handout version of your slides 
 Other file type: Saves in other file types, including PNG and PowerPoint 

97-2003 
To export a presentation: 
In our example, we'll save the presentation as a PowerPoint 97-2003 file. 

1. Click the File tab to access Backstage view. 
2. Click Export, then choose the desired option. In our example, we'll 

select Change File Type. 

 
3. Select a file type, then click Save As. 
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4. The Save As dialog box will appear. Select the location where you want to 

export the presentation, type a file name, then click Save. 

 
You can also use the Save as type drop-down menu in the Save As dialog box to save 
presentations in a variety of file types. Be careful to choose a file type others will be able 
to open. 
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1.5 Sharing presentations 
PowerPoint makes it easy to share and collaborate on presentations using OneDrive. In 
the past, if you wanted to share a file with someone you could send it as an email 
attachment. While convenient, this system also creates multiple versions of the same file, 
which can be difficult to organize. 
When you share a presentation from PowerPoint, you're actually giving others access to 
the exact same file. This lets you and the people you share with edit the same 
presentation without having to keep track of multiple versions. 
In order to share a presentation, it must first be saved to your OneDrive. 
To share a presentation: 

1. Click the File tab to access Backstage view, then click Share. 

 
2. The Share pane will appear. 
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Lesson 2: Working with Slides 
2.1 Slide Basics 
Every PowerPoint presentation is composed of a series of slides. To begin creating a slide 
show, you'll need to know the basics of working with slides. You'll need to feel 
comfortable with tasks such as inserting a new slide, changing the layout of a slide, 
arranging existing slides, changing the slide view, and adding notes to a slide. 
Understanding slides and slide layouts 
When you insert a new slide, it will usually have placeholders to show you where 
content will be placed. Slides have different layouts for placeholders, depending on the 
type of information you want to include. Whenever you create a new slide, you'll need to 
choose a slide layout that fits your content. 

https://edu.gcfglobal.org/en/powerpoint2016/slide-basics/1/
https://edu.gcfglobal.org/en/powerpoint2016/slide-basics/1/
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Placeholders can contain different types of content, including text, images, and videos. 
Many placeholders have thumbnail icons you can click to add specific types of content. In 
the example below, the slide has placeholders for the title and content. 

 
To insert a new slide: 
Whenever you start a new presentation, it will contain one slide with the Title 
Slide layout. You can insert as many slides as you need from a variety of layouts. 

1. From the Home tab, click the bottom half of the New Slide command. 
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2. Choose the desired slide layout from the menu that appears. 

 
3. The new slide will appear. Click any placeholder and begin typing to add 

text. You can also click an icon to add other types of content, such as 
a picture or a chart. 
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To change the layout of an existing slide, click the Layout command, then choose the 
desired layout. 

 
To quickly add a slide that uses the same layout as the selected slide, click the top half of 
the New Slide command. 
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2.2 Organizing slides 

PowerPoint presentations can contain as many slides as you need. The Slide Navigation 
pane on the left side of the screen makes it easy to organize your slides. From there, you 
can duplicate, rearrange, and delete slides in your presentation. 

 
Working with slides 

 Duplicate slides: If you want to copy and paste a slide quickly, you 
can duplicate it. To duplicate slides, select the slide you want 
to duplicate, right-click the mouse, and choose Duplicate Slide from the 
menu that appears. You can also duplicate multiple slides at once by 
selecting them first. 

 
 Move slides: It's easy to change the order of your slides. Just click and 

drag the desired slide in the Slide Navigation pane to the desired position. 
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 Delete slides: If you want to remove a slide from your presentation, you 

can delete it. Simply select the slide you want to delete, then press 
the Delete or Backspace key on your keyboard. 

To copy and paste slides: 
If you want to create several slides with the same layout, you may find it easier to copy 
and paste a slide you've already created instead of starting with an empty slide. 

1. Select the slide you want to copy in the Slide Navigation pane, then click 
the Copy command on the Home tab. Alternatively, you can 
press Ctrl+C on your keyboard. 
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2. In the Slide Navigation pane, click just below a slide (or between two 
slides) to choose a paste location. A horizontal insertion point will 
appear. 

 
3. Click the Paste command on the Home tab. Alternatively, you can 

press Ctrl+V on your keyboard. 
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4. The slide will appear in the selected location. 

 
2.3 Customizing slide layouts 
Sometimes you may find that a slide layout doesn't exactly fit your needs. For example, a 
layout might have too many—or too few—placeholders. You might also want to change 
how the placeholders are arranged on the slide. Fortunately, PowerPoint makes it easy to 
adjust slide layouts as needed. 
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Adjusting placeholders 
 To select a placeholder: Hover the mouse over the edge of the 

placeholder and click (you may need to click the text in the placeholder 
first to see the border). A selected placeholder will have 
a solid line instead of a dotted line. 

 
 To move a placeholder: Select the placeholder, then click and drag it to 

the desired location. 

 
 To resize a placeholder: Select the placeholder you want to resize. Sizing 

handles will appear. Click and drag the sizing handles until the 
placeholder is the desired size. You can use the corner sizing handles to 
change the placeholder's height and width at the same time. 

 
 To delete a placeholder: Select the placeholder you want to delete, then 

press the Delete or Backspace key on your keyboard. 
To add a text box: 
Text can be inserted into both placeholders and text boxes. Inserting text boxes allows 
you to add to the slide layout. Unlike placeholders, text boxes always stay in the same 
place, even if you change the theme. 

1. From the Insert tab, select the Text Box command. 
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2. Click and drag to draw the text box on the slide. 

 
3. The text box will appear. To add text, simply click the text box and begin 

typing. 

 
Using blank slides 
If you want even more control over your content, you may prefer to use a blank slide, 
which contains no placeholders. Blank slides can be customized by adding your own text 
boxes, pictures, charts, and more. 

 To insert a blank slide, click the bottom half of the New Slide command, 
then choose Blank from the menu that appears. 
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While blank slides offer more flexibility, keep in mind that you won't be able to take 
advantage of the predesigned layouts included in each theme. 
To play the presentation: 
Once you've arranged your slides, you may want to play your presentation. This is how 
you will present your slide show to an audience. 

1. Click the Start From Beginning command on the Quick Access Toolbar to 
see your presentation. 

 
2. The presentation will appear in full-screen mode. 
3. You can advance to the next slide by clicking your mouse or pressing 

the spacebar on your keyboard. Alternatively, you can use the arrow 
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keys on your keyboard to move forward or backward through the 
presentation. 

4. Press the Esc key to exit presentation mode. 
You can also press the F5 key at the top of your keyboard to start a presentation. 
2.4 Customizing slides 
To change the slide size: 
By default, all slides in PowerPoint 2013 use a 16-by-9—or widescreen—aspect ratio. 
You might know that widescreen TVs also use the 16-by-9 aspect ratio. Widescreen slides 
will work best with widescreen monitors and projectors. However, if you need your 
presentation to fit a 4-by-3 screen, it's easy to change the slide size to fit. 

 To change the slide size, select the Design tab, then click the Slide 
Size command. Choose the desired slide size from the menu that appears, 
or click Custom Slide Size for more options. 

 
To format the slide background: 
By default, all slides in your presentation use a white background. It's easy to change the 
background style for some or all of your slides. Backgrounds can have 
a solid, gradient, pattern, or picture fill. 

1. Select the Design tab, then click the Format Background command. 

 
2. The Format Background pane will appear on the right. Select the desired 

fill options. In our example, we'll use a Solid fill with a light gold color. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  697 | 1352  

 
3. The background style of the selected slide will update. 
4. If you want, you can click Apply to All to apply the same background style 

to all slides in your presentation. 

 
To apply a theme: 
A theme is a predefined combination of colors, fonts, and effects that can quickly change 
the look and feel of your entire slide show. Different themes also use different slide 
layouts, which can change the arrangement of your existing placeholders. We'll talk 
more about themes later in our Applying Themes lesson. 

http://www.gcflearnfree.org/powerpoint2016/applying-themes/1/
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1. Select the Design tab on the Ribbon, then click the More drop-down 
arrow to see all of the available themes. 

 
2. Select the desired theme. 

 
3. The theme will be applied to your entire presentation. 

 
Try applying a few different themes to your presentation. Some themes will work better 
than others, depending on your content. 
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2.5 Text Basics 
If you're new to PowerPoint, you'll need to learn the basics of working with text. In this 
lesson, you'll learn how to cut, copy, paste, and format text. 
To select text: 
Before you can move or arrange text, you'll need to select it. 

 Click next to the text you want to select, drag the mouse over the text, 
then release your mouse. The text will be selected. 

 
Copying and moving text 
PowerPoint allows you to copy text that is already on a slide and paste it elsewhere, 
which can save you time. If you want to move text, you can cut and paste or drag and 
drop the text. 
To copy and paste text: 

1. Select the text you want to copy, then click the Copy command on 
the Home tab. 

 
2. Place the insertion point where you want the text to appear. 
3. Click the Paste command on the Home tab. 

https://edu.gcfglobal.org/en/powerpoint2016/text-basics/1/
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4. The copied text will appear. 

To cut and paste text: 
1. Select the text you want to move, then click the Cut command. 

 
2. Place the insertion point where you want the text to appear, then click 

the Paste command. 

 
3. The text will appear in the new location. 

You can access the cut, copy, and paste commands by using keyboard shortcuts. 
Press Ctrl+X to cut, Ctrl+C to copy, and Ctrl+V to paste. 
To drag and drop text: 

1. Select the text you want to move, then click and drag the text to 
the desired location. 
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2. The text will appear in the new location. 

 
Formatting and aligning text 
Formatted text can draw your audience's attention to specific parts of a presentation and 
emphasize important information. In PowerPoint, you have several options for adjusting 
your text, including size and color. You can also adjust the alignment of the text to 
change how it is displayed on the slide. 
Click the buttons in the interactive below to learn about the different commands in the 
Font and Paragraph groups. 
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2.6 Applying Themes 
 
A theme is a predefined combination of colors, fonts, and effects. Different themes also 
use different slide layouts. You've already been using a theme, even if you didn't know it: 
the default Office theme. You can choose from a variety of new themes at any time, 
giving your entire presentation a consistent, professional look. 
What is a theme? 
In PowerPoint, themes give you a quick and easy way to change the design of your 
presentation. They control your primary color palette, basic fonts, slide layout, and other 
important elements. All of the elements of a theme will work well together, which means 
you won't have to spend as much time formatting your presentation. 
Each theme uses its own set of slide layouts. These layouts control the way your content 
is arranged, so the effect can be dramatic. In the examples below, you can see that 
the placeholders, fonts, and colors are different. 

 
If you use a unique slide layout—such as Quote with Caption or Name Card—and then 
switch to a theme that does not include that layout, it may give unexpected results. 
Every PowerPoint theme—including the default Office theme—has its own theme 
elements. These elements are: 

 Theme Colors: There are 10 theme colors, along with darker and lighter 
variations, available from every Color menu. 

https://edu.gcfglobal.org/en/powerpoint2016/applying-themes/1/
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 Theme Fonts: There are two theme fonts available at the top of 

the Font menu under Theme Fonts. 

 
 Theme Effects: These affect the preset shape styles. You can find shape 

styles on the Format tab whenever you select a shape or SmartArt 
graphic. 

 
When you switch to a different theme, all of these elements will update to reflect the 
new theme. You can drastically change the look of your presentation in a few clicks. 
If you apply a font or color that isn't part of the theme, it won't change when you select a 
different theme. This includes colors selected from the Standard Colors or More 
Colors options and fonts selected from All Fonts. Using non-theme elements can be 
useful when you want certain text to be a specific color or font, like a logo. 
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You can also customize themes and define theme elements yourself. To learn more, see 
our Modifying Themes lesson. 
Applying themes 
All themes included in PowerPoint are located in the Themes group on the Design tab. 
Themes can be applied or changed at any time. 
To apply a theme: 

1. Select the Design tab on the Ribbon, then locate the Themes group. Each 
image represents a theme. 

2. Click the More drop-down arrow to see all available themes. 

 
3. Select the desired theme. 

 
4. The theme will be applied to the entire presentation. To apply a different 

theme, simply select it from the Design tab. 

http://www.gcflearnfree.org/powerpoint2016/modifying-themes/1/
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Once you've applied a theme, you can also select a variant for that theme from 
the Variants group. Variants use different theme colors while preserving a theme's 
overall look. 

 
 

2. 7 Applying Transitions 
If you've ever seen a PowerPoint presentation that had special effects between each 
slide, you've seen slide transitions. A transition can be as simple as fading to the next 
slide or as flashy as an eye-catching effect. PowerPoint makes it easy to apply transitions 
to some or all of your slides, giving your presentation a polished, professional look. 
About transitions 
There are three categories of unique transitions to choose from, all of which can be 
found on the Transitions tab. 

 Subtle: These are the most basic types of transitions. They use simple 
animations to move between slides. 

https://edu.gcfglobal.org/en/powerpoint2016/applying-transitions/1/
https://edu.gcfglobal.org/en/powerpoint2016/applying-transitions/1/
https://edu.gcfglobal.org/en/powerpoint2016/applying-transitions/1/
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 Exciting: These use more complex animations to transition between 

slides. While they're more visually interesting than Subtle transitions, 
adding too many can make your presentation look less professional. 
However, when used in moderation they can add a nice touch between 
important slides. 

 
 Dynamic Content: If you're transitioning between two slides that use 

similar slide layouts, dynamic transitions will move only the placeholders, 
not the slides themselves. When used correctly, dynamic transitions can 
help unify your slides and add a further level of polish to your 
presentation. 

 
Transitions are best used in moderation. Adding too many transitions can make your 
presentation look a little silly and can even be distracting to your audience. Consider 
using mostly subtle transitions, or not using transitions at all. 
To apply a transition: 

1. Select the desired slide from the Slide Navigation pane. This is the slide 
that will appear after the transition. 
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2. Click the Transitions tab, then locate the Transition to This Slide group. By 

default, None is applied to each slide. 
3. Click the More drop-down arrow to display all transitions. 

 
4. Click a transition to apply it to the selected slide. This will automatically 

preview the transition. 

 
You can use the Apply To All command in the Timing group to apply the same transition 
to all slides in your presentation. Keep in mind that this will modify any other transitions 
you've applied. 
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Try applying a few different types of transitions to various slides in your presentation. 
You may find that some transitions work better than others, depending on the content of 
your slides. 
To preview a transition: 
You can preview the transition for a selected slide at any time using either of these two 
methods: 

 Click the Preview command on the Transitions tab. 

 
 Click the Play Animations command in the Slide Navigation pane. 

 
Modifying transitions 
To modify the transition effect: 
You can quickly customize the look of a transition by changing its direction. 

1. Select the slide with the transition you want to modify. 
2. Click the Effect Options command and choose the desired option. These 

options will vary depending on the selected transition. 
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3. The transition will be modified, and a preview of the transition will 

appear. 
Some transitions do not allow you to modify the direction. 
To modify the transition duration: 

1. Select the slide with the transition you want to modify. 
2. In the Duration field in the Timing group, enter the desired time for the 

transition. In this example, we'll decrease the time to half a second—or 
00.50—to make the transition faster. 

 
To add sound: 

1. Select the slide with the transition you want to modify. 
2. Click the Sound drop-down menu in the Timing group. 
3. Click a sound to apply it to the selected slide, then preview the transition 

to hear the sound. 
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Sounds are best used in moderation. Applying a sound between every slide could 
become overwhelming or even annoying to an audience when presenting your slide 
show. 
To remove a transition: 

1. Select the slide with the transition you want to remove. 
2. Choose None from the Transition to This Slide group. The transition will 

be removed. 

 
To remove transitions from all slides, apply the None transition to a slide, then click 
the Apply to All command. 

2.8 Advancing slides 
Normally, in Slide Show view you would advance to the next slide by clicking your mouse 
or by pressing the spacebar or arrow keys on your keyboard. The Advance Slides setting 
in the Timing group allows the presentation to advance on its own and display each slide 
for a specific amount of time. This feature is especially useful 
for unattended presentations, such as those at a trade show booth. 
To advance slides automatically: 

1. Select the slide you want to modify. 
2. Locate the Timing group on the Transitions tab. Under Advance Slide, 

uncheck the box next to On Mouse Click. 
3. In the After field, enter the amount of time you want to display the slide. 

In this example, we will advance the slide automatically after 1 minute 
and 15 seconds, or 01:15:00. 
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4. Select another slide and repeat the process until all slides have the 

desired timing. You can also click the Apply to All command to apply the 
same timing to all slides. 

Lesson 3: Managing Slides 
As you add more slides to a presentation, it can be difficult to keep everything organized. 
Fortunately, PowerPoint offers tools to help you organize and prepare your slide show. 
3.1 About slide views 
PowerPoint includes several different slide views, which are all useful for various tasks. 
The slide view commands are located in the bottom-right of the PowerPoint window. 
There are four main slide views. 

 
 Normal view: This is the default view, where you create and edit slides. 

You can also move slides in the Slide Navigation pane on the left. 

 
 Slide sorter view: In this view, you'll see a thumbnail version of each 

slide. You can drag and drop slides to reorder them quickly. 

https://edu.gcfglobal.org/en/powerpoint2016/managing-slides/1/
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 Reading view: This view fills the PowerPoint window with a preview of 

your presentation. It includes easily accessible navigation buttons at the 
bottom-right. 

 
 Slide show view: This is the view you'll use to present to an audience. This 

command will begin the presentation from the current slide. You can also 
press F5 on your keyboard to start from the beginning. A menu will 
appear in the bottom-left corner when you move the mouse. These 
commands allow you to navigate through the slides and access other 
features, such as the pen and highlighter. 
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3.2 Outline view 
Outline view shows your slide text in outline form. This allows you to quickly edit your 
slide text and view the content of multiple slides at once. You could use this layout to 
review the organization of your slide show and prepare to deliver your presentation. 
To view an outline: 

1. From the View tab, click the Outline View command. 

 
2. An outline of your slide text will appear in the slide navigation pane. 
3. You can type directly in the outline to make changes to your slide text. 
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3.3 Slide notes 
You can add notes to your slides from the Notes pane. Often called speaker notes, they 
can help you deliver or prepare for your presentation. 
To add notes: 

1. Click the Notes command at the bottom of the screen to open 
the Notes pane. 

 
2. Click and drag the edge of the pane to resize it if desired. 

 
3. Click the Notes pane, and begin typing to add notes. 
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You can also access Notes Page view to edit and review your notes. Just click the Notes 
Page command from the View tab. From there, you can type notes in the text box below 
each slide. 

 
3.4 Slide sections 
If you have a lot of slides, you can organize them into sections to make your presentation 
easier to navigate. Sections can be collapsed or expanded in the Slide Navigation pane 
and named for easy reference. 
To create slide sections: 
In our example, we will add two sections: one for dogs that are available for adoption, 
and another for cats and other pets. 

1. Select the slide you want to begin a section. 
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2. From the Home tab, click the Section command, then choose Add 

Section from the drop-down menu. 

 
3. An Untitled Section will appear in the Slide Navigation pane. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  717 | 1352  

 
4. To rename the section, click the Section command, then choose Rename 

Section from the drop-down menu. 

 
5. Type the new section name in the dialog box, then click Rename. 
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6. Repeat to add as many sections as you need. 
7. In the Slide Navigation pane, click the arrow next to a section name 

to collapse or expand it. 

 
To remove a section, click the Section command, then click Remove Section. You can 
also click Remove All Sections to remove all sections from your slides. 
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3.5 Using Find & Replace 
When you're working with longer presentations, it can be difficult and time consuming to 
locate a specific word or phrase. PowerPoint can automatically search your presentation 
using the Find feature, and it allows you to quickly change words or phrases using the 
Replace feature. 
To find text: 

1. From the Home tab, click the Find command. 

 
2. A dialog box will appear. Enter the text you want to find in the Find 

what: field, then click Find Next. 

 

https://edu.gcfglobal.org/en/powerpoint2016/using-find-replace/1/
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3. If the text is found, it will be selected. 

 
You can also access the Find command by pressing Ctrl+F on your keyboard. 
3.6 To replace text: 
At times, you may discover that you've repeatedly made a mistake throughout your 
presentation—such as misspelling someone's name—or that you need to exchange a 
particular word or phrase for another. You can use the Replace feature to make quick 
revisions. 

1. From the Home tab, click the Replace command. 

 
2. A dialog box will appear. Type the text you want to find in the Find 

what: field. 
3. Type the text you want to replace it with in the Replace with: field, then 

click Find Next. 
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4. If the text is found, it will be selected. Review the text to make sure you 

want to replace it. 
5. If you want to replace it, select one of the replace options. Replace will 

replace individual instances, and Replace All will replace every instance. 
In our example, we'll use the Replace option. 

 
6. The selected text will be replaced. 
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7. PowerPoint will move to the next instance of the text in the presentation. 

When you are finished replacing text, click Close to exit the dialog box. 
When it comes to using Replace All, it’s important to remember that it could find 
matches you didn’t anticipate and might not actually want to change. Only use this 
option if you're absolutely sure it won't replace anything you didn’t intend it to. 

Lesson 4: Printing 
Even though PowerPoint presentations are designed to be viewed on a computer, there 
may be times when you want to print them. You can even print custom versions of a 
presentation, which can be especially helpful when presenting your slide show. The Print 
pane makes it easy to preview and print your presentation. 
4.1 Print layouts 
PowerPoint offers several layouts to choose from when printing a presentation. The 
layout you choose will mostly depend on why you're printing the slide show. There are 
four types of print layouts. 

 Full Page Slides: This prints a full page for each slide in your presentation. 
This layout is most useful if you need to review or edit a printed copy of 
your presentation. 

https://edu.gcfglobal.org/en/powerpoint2016/printing/1/
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 Notes Pages: This prints each slide, along with any speaker notes for the 

slide. If you've included a lot of notes for each slide, you could keep a 
printed copy of the notes with you while presenting. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  724 | 1352  

 
 Outline: This prints an overall outline of the slide show. You could use this 

to review the organization of your slide show and prepare to deliver your 
presentation. 

 
 Handouts: This prints thumbnail versions of each slide, with optional 

space for notes. This layout is especially useful if you want to give your 
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audience a physical copy of the presentation. The optional space allows 
them to take notes on each slide. 

 
4.2 To access the Print pane: 

1. Select the File tab. backstage view will appear. 
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2. Select Print. The Print pane will appear. 

 
Click the buttons in the interactive below to learn more about using the Print pane. 
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You can also access the Print pane by pressing Ctrl+P on your keyboard. 
4.3 To print a presentation: 

1. Select the File tab. backstage view will appear. 

 
2. Select Print. The Print pane will appear. 
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3. Choose the desired printer and print range. 
4. Chose the desired print layout and color settings. 

 
5. When you're done modifying the settings, click Print. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  729 | 1352  

 
Lesson 5: Presenting Your Slide Show 
Once your slide show is complete, you'll need to learn how to present it to an audience. 
PowerPoint offers several tools and features to help make your presentation smooth, 
engaging, and professional. 

5.1 Presenting a slide show 
Before you present your slide show, you'll need to think about the type 
of equipment that will be available for your presentation. Many presenters 
use projectors during presentations, so you might want to consider using one as well. 
This allows you to control and preview slides on one monitor while presenting them to an 
audience on another screen. 
To start a slide show: 
There are several ways you can begin your presentation: 

 Click the Start from beginning command on the Quick Access Toolbar, or 
press the F5 key at the top of your keyboard. The presentation will appear 
in full-screen mode. 

 
 Select the Slide Show view command at the bottom of the PowerPoint 

window to begin a presentation from the current slide. 

https://edu.gcfglobal.org/en/powerpoint2016/presenting-your-slide-show/1/
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 Go to the Slide Show tab on the Ribbon to access even more options. 

From here, you can start the presentation from the current slide and 
access advanced presentation options. 

 
5.2 To advance and reverse slides: 
You can advance to the next slide by clicking your mouse or pressing the spacebar on 
your keyboard. Alternatively, you can use or arrow keys on your keyboard to move 
forward or backward through the presentation. 
You can also hover your mouse over the bottom-left and click the arrows to move 
forward or backward. 

 
To stop a slide show: 
You can exit presentation mode by pressing the Esc key on your keyboard. Alternatively, 
you can click the Slide Show Options button in the bottom-left and select End Show. 
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The presentation will also end after the last slide. You can click the mouse or press the 
spacebar to return to Normal view. 

 
Lesson 6: Presentation tools and features 
PowerPoint provides convenient tools you can use while presenting your slide show. For 
example, you can change your mouse pointer to a pen or highlighter to draw attention 
to items in your slides. In addition, you can jump around to slides in your presentation or 
access other programs from your taskbar if needed. 

6.1 To show the taskbar 
Sometimes you may need to access the Internet or other files and programs on your 
computer during your presentation. PowerPoint allows you to access 
your taskbar without ending the presentation. 

1. Locate and select the Slide Options button in the bottom-left corner. 
2. Select Screen, then click Show Taskbar. 
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3. Your taskbar will appear. Choose a program you want to open, such as a 
web browser. When you're done, close the window or click the 
PowerPoint icon on the taskbar to return to the presentation. 

 
6.2 Slide options 
You can also access any of the menu items above by right-clicking anywhere on the 
screen during your slide show. 

 
6.3 To skip to a nonadjacent slide 
You can jump to slides out of order if needed. 
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1. Locate and select the See All Slides button in the bottom-left corner. 

 
2. Thumbnail versions of each slide will appear. Select the slide you want to 

jump to. 

 
3. The selected slide will appear. 

6.4 To access drawing tools: 
Your mouse pointer can act as pen or highlighter to draw attention to items in your 
slides. 

1. Locate and select the Pen Tools button in the bottom-left corner. 
2. Select Pen or Highlighter based on your preference. You can also choose a 

different color from the menu. 
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3. Click and drag the mouse to mark your slides. You can also press Ctrl+P on 

your keyboard to access the pen tool while presenting your slide show. 

 
You can also use the laser pointer feature to draw attention to certain parts of your slide. 
Unlike the pen and highlighter, the laser pointer will not leave markings on your slides. 
To use the laser pointer, select it from Pen Tools, or press and hold the Ctrl key and the 
left mouse button. 
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6.5 To erase ink markings: 

1. Locate and select the Pen Tools button in the bottom-left corner. 
2. Select Eraser to erase individual ink markings, or select Erase All Ink on 

Slide to erase all markings. 

 
When you end a slide show, you'll also have the option to Keep or Discard any ink 
annotations made during your presentation. If you keep ink markings, they'll appear 
as objects on your slides in Normal view. 
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6.6 Presenter view 
If you're presenting your slide show with a second display—like a projector—you can 
use Presenter view. Presenter view gives you access to a special set of controls on your 
screen that the audience won't see, allowing you to easily reference slide notes, preview 
the upcoming slide, and much more. 
To access Presenter view: 
Start your slide show as you normally would, then click the Slide Options button and 
select Presenter View. Alternatively, you can press Alt+F5 on your keyboard to start the 
slide show in Presenter view. 

 
Click the buttons in the interactive below to learn more about using Presenter view. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  737 | 1352  

 
Lesson 7: Slide show setup options 
PowerPoint has various options for setting up and playing a slide show. For example, you 
can set up an unattended presentation that can be displayed at a kiosk and make your 
slide show repeat with continuous looping. 

7.1 To access slide show setup options: 
 

1. Select the Slide Show tab, then click the Set Up Slide Show command. 

 
2. The Set Up Show dialog box will appear. From here, you can select the 

desired options for your presentation. 
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To advance slides automatically, you'll need to customize the slide timing on 
the Transitions tab. Review our lesson on Applying Transitions to learn how. 
 

 
 

Lesson 8: Text and Objects 
8.1 Lists 
To create effective PowerPoint presentations, it's important to make your slides easy for 
the audience to read. One of the most common ways of doing this is to format the text as 
a bulleted or numbered list. By default, when you type text into a placeholder, a bullet is 
placed at the beginning of each paragraph—automatically creating a bulleted list. If you 
want, you can modify a list by choosing a different bullet style or by switching to a 
numbered list. 
8.2 To modify the bullet style: 

1. Select an existing list you want to format. 
2. On the Home tab, click the Bullets drop-down arrow. 

https://edu.gcfglobal.org/en/powerpoint2016/lists/1/
https://edu.gcfglobal.org/en/powerpoint2016/lists/1/
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3. Select the desired bullet style from the menu that appears. 
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4. The bullet style will appear in the list. 

8.3 To modify a numbered list: 
1. Select an existing list you want to format. 
2. On the Home tab, click the Numbering drop-down arrow. 
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3. Select the desired numbering option from the menu that appears. 

 
4. The numbering style will appear in the list. 
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8.4 To change the starting number: 
By default, numbered lists count from the number 1. However, sometimes you may want 
to start counting from a different number, like if the list is a continuation from a previous 
slide. 

1. Select an existing numbered list. 
2. On the Home tab, click the Numbering drop-down arrow. 
3. Select Bullets and Numbering from the menu that appears. 

 
4. A dialog box will appear. In the Start At field, enter the desired starting 

number. 
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5. The list numbering will change. 
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8.5 Modifying the list's appearance 
Whether you're using a bulleted or numbered list, you may want to change its 
appearance by adjusting the size and color of the bullets or numbers. This can make your 
list stand out and match the appearance of your presentation. 
To modify the size and color: 

1. Select an existing bulleted list. 
2. On the Home tab, click the Bullets drop-down arrow. 

 
3. Select Bullets and Numbering from the menu that appears. 
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4. A dialog box will appear. In the Size field, set the bullet size. 

 
5. Click the Color drop-down box and select a color. 
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6. Click OK. The list will update to show the new bullet size and color. 

8.6 Customizing bullets 
Customizing the look of the bullets in your list can help you emphasize certain list items 
or personalize the design of your list. A common way to customize bullets is to 
use symbols. 
To use a symbol as a bullet: 

1. Select an existing bulleted list. 
2. On the Home tab, click the Bullets drop-down arrow. 
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3. Select Bullets and Numbering from the menu that appears. 

 
4. A dialog box will appear. On the Bulleted tab, click Customize. 
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5. The Symbol dialog box will appear. 
6. Click the Font drop-down box and select a font. 

The Wingdings and Symbol fonts are good choices because they have a 
lot of useful symbols. 

7. Select the desired symbol. 
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8. Click OK. The symbol will now appear as the selected bullet option in the 

Bullets and Numbering dialog box. 

 
9. Click OK again to apply the symbol to the list in the document. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  750 | 1352  

To change the distance between the bullets and the text, you can move the first-line 
indent marker on the Ruler.  
 

Lesson 9: Indents and Line Spacing 
 
Indents and line spacing are two important features you can use to change the way text 
appears on a slide. Indents can be used to create multilevel lists or to visually set 
paragraphs apart from one another. Line spacing can be adjusted to improve readability 
or to fit more lines on a slide. 
9.1 To indent text: 
Indenting helps to format the layout of text so it appears more organized on your slide. 
The fastest way to indent is to use the Tab key. An alternative method is to use one of 
the Indent commands. With these commands, you can either increase or decrease the 
indent. 

 To indent using the Tab key: Place the insertion point at the very 
beginning of the line you want to indent, then press the Tab key. 

 
 To indent using the Indent commands: Place the insertion point at the 

very beginning of the line you want to indent. From the Home tab, select 
the Increase List Level command. 

https://edu.gcfglobal.org/en/powerpoint2016/indents-and-line-spacing/1/
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To decrease an indent, select the desired line, then press Shift+Tab or the Decrease List 
Level command. 

9.2 Indenting lists and paragraphs 
Indenting will give different results, depending on whether you are working with a list or 
a paragraph. 

 Paragraph: Indenting the first line of a paragraph using the Tab key 
creates a first-line indent. This helps to separate paragraphs from each 
other, as in the examples above. 

 List: Indenting a line of a list creates a multilevel list. This means the 
indented line is a subtopic of the line above it. Multilevel lists are useful if 
you want to create an outline or hierarchy. 
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Once you've created a multilevel list, you may want to choose a different bullet style for 
different levels of the list to make them stand out even more.  
 

 
9.3 Fine-tuning indents 
Sometimes you may want to fine-tune the indents in your presentations. You can do this 
by adjusting the indent markers on the Ruler. By default, the Ruler is hidden, so you'll 
first need to show the Ruler. 
To show the Ruler: 

1. Select the View tab on the Ribbon. 
2. In the Show group, check the box next to Ruler. The Ruler will appear. 
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Indent markers 
Indent markers are located to the left of the horizontal ruler, and they provide several 
indentation options. 

 First-line indent marker: Adjusts the first line of a paragraph 

 
 Hanging indent marker: Adjusts every line of a paragraph except for the 

first line 

 
 Left indent marker: Moves both the first-line indent and hanging indent 

markers at the same time, indenting all lines in a paragraph 

 
To indent using indent markers: 

1. Place the insertion point anywhere in the paragraph where you want to 
indent, or select one or more paragraphs. 
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2. Go to the desired indent marker. In our example, we'll use the left indent 
marker. 

 
3. Click and drag the indent marker as needed. When you're done, the 

selected text will be indented. 

 
9.4 Customizing bullet spacing 
When working with lists, PowerPoint allows you to fine-tune the space 
between bullets and text by using the first-line indent marker or the hanging indent 
marker. 
To change the bullet spacing: 

1. Select the lines you want to change, then go to the desired indent marker. 
In our example, we'll use the hanging indent marker. 
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2. Click and drag the indent marker as needed. When you're done, the bullet 

spacing will be adjusted. 

 
9.5 Line spacing 
PowerPoint allows you to adjust the amount of space between each line in a list or 
paragraph. You can reduce the line spacing to fit more lines on a slide, or you 
can increase it to improve readability. In some instances, PowerPoint may automatically 
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change the font size when you adjust the line spacing, so increasing the line spacing too 
much may cause the text to be too small. 
To format line spacing: 

1. Select the text you want to format. 

 
2. On the Home tab, locate the Paragraph group, click the Line 

Spacing command, then select the desired line spacing option from the 
menu. 

 
3. The line spacing will be adjusted. 
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If you want to adjust the line spacing with even more precision, select Line Spacing 
Options from the drop-down menu. The Paragraph dialog box will appear, allowing you 
to fine-tune the line spacing and adjust the paragraph spacing, which is the amount of 
space that is added before and after each paragraph. 
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Lesson 10: Inserting Pictures 
Adding pictures can make your presentations more interesting and engaging. You can 
insert a picture from a file on your computer onto any slide. PowerPoint even includes 
tools for finding online pictures and adding screenshots to your presentation. 
10.1 To insert a picture from a file: 
 

1. Select the Insert tab, then click the Pictures command in 
the Images group. 

 
2. A dialog box will appear. Locate and select the desired image file, then 

click Insert. 

https://edu.gcfglobal.org/en/powerpoint2016/inserting-pictures/1/
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3. The picture will appear on the currently selected slide. 

 
You can also click the Pictures command in a placeholder to insert images. 
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10.2 Inserting online pictures 
If you don't have the picture you want on your computer, you can find a picture online to 
add to your presentation. PowerPoint offers two options for finding online pictures. 

 OneDrive: You can insert an image stored on your OneDrive. You can also 
link other online accounts with your Microsoft account, such as Facebook 
or Flickr. 

 
 Bing Image Search: You can use this option to search the Internet for 

images. By default, Bing only shows images that are licensed 
under Creative Commons, which means you can use them for your own 
projects. However, you should go to the image's website to see if there 
are any restrictions on how it can be used. 
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To insert an online picture: 

1. Select the Insert tab, then click the Online Pictures command. 

 
2. The Insert Pictures dialog box will appear. 
3. Choose Bing Image Search or your OneDrive. In our example, we'll use 

Bing Image Search. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  762 | 1352  

 
4. Press the Enter key. Your search results will appear in the dialog box. 
5. Select the desired image, then click Insert. 

 
6. The image will appear on the currently selected slide. 
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You can also click the Online Pictures command in a placeholder to insert online images. 

 
When adding images, videos, and music to your own projects, it's important to make sure 
you have the legal right to use them. Most things you buy or download online 
are protected by copyright, which means you may not be allowed to use them.  

10.2 Moving and resizing pictures 
Once you've inserted a picture, you may want to move it to a different location on the 
slide or change its size. PowerPoint makes it easy to arrange pictures in your 
presentation. 
To select a picture: 
Before you can modify a picture, you'll need to select it. 
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 Simply click to select a picture. A solid line will appear around a selected 
picture. 

 
To resize a picture: 

 Click and drag the corner sizing handles until the picture is the desired 
size. 

 
The corner sizing handles will resize a picture while preserving its original aspect ratio. If 
you use the side sizing handles, the image will become distorted. 
To rotate a picture: 

 Click and drag the arrow above an image to rotate it right or left. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  765 | 1352  

 
Hold the Shift key on your keyboard when rotating an image to snap it to angles in 15-
degree increments. 
To move a picture: 

 Click and drag to move a picture to a new location on a slide. 

 
To delete a picture: 

 Select the picture you want to delete, then press 
the Backspace or Delete key on your keyboard. 

You can access even more picture formatting options from the Format tab.  
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10.3 Inserting screenshots 
Screenshots are basically snapshots of your computer screen. You can take a screenshot 
of almost any program, website, or open window. PowerPoint makes it easy to insert a 
screenshot of an entire window or a screen clipping of part of a window in your 
presentation. 
To insert screenshots of a window: 

1. Select the Insert tab, then click the Screenshot command in 
the Images group. 

2. The Available Windows from your desktop will appear. Select 
the window you want to capture as a screenshot. 

 
3. The screenshot will appear on the currently selected slide. 
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To insert a screen clipping: 

1. Select the Insert tab, click the Screenshot command, then select Screen 
Clipping. 

 
2. A view of other open windows will appear. Click and drag to select the 

area you want to capture as a screen clipping. 
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3. The screen clipping will appear on the currently selected slide. 

 
10.4 Formatting Pictures 
There are a variety of ways to format the pictures in your slide show. The picture tools in 
PowerPoint make it easy to personalize and modify the images in interesting ways. 
PowerPoint allows you to change the picture style and shape, add a border, crop and 
compress pictures, add artistic effects, and more. 
To crop an image: 
When you crop an image, a part of the picture is removed. Cropping may be helpful 
when a picture has a lot of content and you want to focus on only part of it. 

https://edu.gcfglobal.org/en/powerpoint2016/formatting-pictures/1/
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1. Select the image you want to crop. The Format tab appears. 
2. On the Format tab, click the Crop command. 

 
3. Cropping handles will appear around the image. Click and drag one of the 

handles to crop the image. Make sure the mouse is right over the black 
cropping handle so you don't accidentally select a resizing handle. 

 
4. Click the Crop command again. The image will be cropped. 

To crop an image to a shape: 
1. Select the image you want to crop, then click the Format tab. 
2. Click the Crop drop-down arrow. Hover the mouse over Crop to Shape, 

then select the desired shape from the drop-down menu that appears. 
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3. The image will appear formatted as the shape. 

 
You may want to crop the image to the desired size before cropping it to a shape. 
To add a border to an image: 

1. Select the image you want to add a border to, then click the Format tab. 
2. Click the Picture Border command. A drop-down menu will appear. 
3. From here, you can select a color, weight (thickness), and whether the 

line is dashed. 
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4. The border will appear around the image. 

 
Image adjustments 
PowerPoint offers several options for changing the way images appear in your slide 
show. For example, you can add a frame, make image corrections, change the 
image's color or brightness, and even add some stylish artistic effects. These options are 
located in the Adjust and Picture Styles groups on the Format tab. 
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When you're ready to make adjustments or experiment with the look of an image, select 
the picture and choose one of these options from the Format tab. 

 Corrections: This command is located in the Adjust group. From here, you 
can sharpen or soften the image to adjust how blurry or clear it appears. 
You can also adjust the brightness and contrast, which controls how light 
or dark the picture appears. 

 
 Color: This command is located in the Adjust group. From here, you can 

adjust the image's saturation (how vivid the colors are), tone (the 
temperature of the image, from cool to warm), and coloring (changing 
the overall color of the image). 
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 Artistic Effects: This command is located in the Adjust group. From here, 

you can add artistic effects such as pastels, watercolors, and glowing 
edges. 
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 Picture Styles Group: This group contains a variety of styles you can apply 
to your picture, such as frames, borders, and soft edges. 

 
Compressing pictures 
If you want to email a presentation that contains pictures, you'll need to monitor its file 
size. Large high-resolution pictures can quickly cause your presentation to become very 
large, which may make it difficult or impossible to attach to an email. 
Additionally, cropped areas of pictures are saved with the presentation by default, which 
can add to the file size. PowerPoint can reduce the file size by compressing pictures, 
lowering their resolution, and deleting cropped areas. 
To compress a picture: 

1. Select the picture you want to compress, then click the Format tab. 
2. Click the Compress Pictures command. 
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3. A dialog box will appear. Place a check mark next to Delete cropped areas 
of pictures. You can also choose whether to apply the settings to this 
picture only or to all pictures in the presentation. 

4. Choose a Target output. If you are emailing your presentation, you may 
want to select Email, which produces the smallest file size. When you are 
done, click OK. 

 
Compressing your pictures in PowerPoint may not reduce the file size enough for your 
needs. For better results, you can use an image editing program to resize the image 
before you insert it in your presentation.  

Lesson 11: Shapes 
Shapes are a great way to make your presentations more interesting. PowerPoint gives 
you a lot of different shapes to choose from, and they can be customized to suit your 
needs, using your own color palette, preferences, and more. While you may not need 
shapes in every presentation you create, they can add visual appeal. 
11.1 To insert a shape: 

1. Select the Insert tab, then click the Shapes command in 
the Illustrations group. A drop-down menu of shapes will appear. 

2. Select the desired shape. 

https://edu.gcfglobal.org/en/powerpoint2016/shapes/1/
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3. Click and drag in the desired location to add the shape to the slide. 
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11.2 Modifying a shape or text box 
When you click a shape or text box, handles will appear that let you manipulate the 
shape. There are several types of handles. 

 Sizing handles: Click and drag the sizing handles until the shape or text 
box is the desired size. You can use the corner sizing handles to change 
the height and width at the same time. 

 
 Rotation handle: Click and drag the rotation handle to rotate the shape. 

 
 Yellow handles: Some shapes have one or more yellow handles that can 

be used to customize the shape. For example, with the sun shape, you 
can change the proportions of the shape. 
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In addition to resizing, customizing, and rotating shapes, you can align, order, and group 
them. To learn more, see our Aligning, Ordering, and Grouping Objects lesson. 
11.3 Formatting shapes and text boxes 
PowerPoint allows you to modify shapes and text boxes in a variety of ways so you can 
tailor them to your projects. You can change shapes and text boxes into different 
shapes, format their style and color, and add effects. 
To change the shape style: 
Choosing a shape style allows you to apply preset colors and effects to quickly change 
the appearance of your shape or text box. These options will depend on the colors that 
are part of your current theme. 

1. Select the shape or text box you want to change. 
2. On the Format tab, click the More drop-down arrow in the Shape 

Styles group. 

 
3. A drop-down menu of styles will appear. Select the style you want to use. 

http://www.gcflearnfree.org/powerpoint2016/aligning-ordering-and-grouping-objects/1/
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4. The shape or text box will appear in the selected style. 

11.4 To change the shape fill color: 
1. Select the shape or text box you want to change. 
2. On the Format tab, click the Shape Fill drop-down arrow. The Shape 

Fill menu appears. 
3. Move the mouse over the various colors. Select the color you want to use. 

To view more color options, select More Fill Colors. 
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4. The shape or text box will appear in the selected color. 

If you want to use a different type of fill, select Gradient or Texture from the drop-down 
menu. You can also select No Fill to make it transparent. 
11.5 To change the shape outline: 

1. Select the shape or text box you want to change. 
2. On the Format tab, click the Shape Outline drop-down arrow. The Shape 

Outline menu will appear. 
3. Select the color you want to use. If you want to make the outline 

transparent, select No Outline. 
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4. The shape or text box will appear in the selected outline color. 

From the drop-down menu, you can change the outline color, weight (thickness), and 
whether it is a dashed line. 
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11.6 To add shape effects: 

1. Select the shape or text box you want to change. 
2. On the Format tab, click the Shape Effects drop-down arrow. In the menu 

that appears, hover the mouse over the style of effect you want to add, 
then select the desired preset effect. 
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3. The shape will appear with the selected effect. 

To further adjust your shape effects, select Options at the end of each menu. The Format 
Shape pane will appear, allowing you to customize the effects. 
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11.7 To change to a different shape: 

1. Select the shape or text box you want to change. The Format tab will 
appear. 

2. On the Format tab, click the Edit Shape command. In the menu that 
appears, hover the mouse over Change Shape and select the 
desired shape. 
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3. The new shape will appear. 

 
If you want, you can enter text in a shape. When the shape appears in your document, 
you can simply begin typing. You can then use the formatting options on the Home tab 
to change the font, font size, or color of the text. 
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Lesson 12:  Aligning, Ordering, and Grouping Objects 
In PowerPoint, each slide may have multiple items, such as pictures, shapes, and text 
boxes. You can arrange the objects the way you want by aligning, ordering, grouping, and 
rotating them in various ways. 
12.1 Aligning objects 
When you move objects in PowerPoint, alignment guides and spacing guides will appear 
as dashed orange lines and arrows around the objects to help you align them. However, 
if you have many different objects on a slide, it may be difficult and time consuming to 
get them perfectly aligned. Luckily, PowerPoint provides you with several alignment 
commands that allow you to easily arrange and position objects. 

 
To align two or more objects: 

1. Select the objects you want to align. To select multiple objects at once, 
hold the Shift key while you click. The Format tab will appear. 

https://edu.gcfglobal.org/en/powerpoint2016/aligning-ordering-and-grouping-objects/1/
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2. From the Format tab, click the Align command, then select Align Selected 

Objects. 

 
3. Click the Align command again, then select one of the six alignment 

options. 
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4. The objects will align based on the option you selected. 

 
To align objects to the slide: 

Sometimes you may want to align one or more objects to a specific location within the 
slide, such as at the top or bottom. You can do this by selecting the Align to Slide option 
before aligning the objects. 

1. Select the objects you want to align. To select multiple objects at once, 
hold the Shift key while you click. 
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2. From the Format tab, click the Align command, then select Align to Slide. 

 
3. Click the Align command again, then select one of the six alignment 

options. 
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4. The objects will align based on the option you selected. 

 
To distribute objects evenly: 

If you have arranged objects in a row or column, you may want them to be an equal 
distance from one another for a neater appearance. You can do this by distributing the 
objects horizontally or vertically. 

1. Select the objects you want to align. To select multiple objects at once, 
hold the Shift key while you click. 
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2. From the Format tab, click the Align command, then select Align to 
Slide or Align Selected Objects. 

 
3. Click the Align command again, then select Distribute 

Horizontally or Distribute Vertically from the drop-down menu that 
appears. 

 
4. The objects will distribute evenly. 
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12.2 Grouping objects 
You may want to group multiple objects into one object so they will stay together if they 
are moved or resized. This is often easier than selecting all of the objects each time you 
want to move them. 
Pictures, shapes, clip art, and text boxes can all be grouped; 
however, placeholders cannot be grouped. If you will be grouping pictures, use one of 
the commands in the Images group on the Insert tab to insert pictures instead of the 
picture icon inside the placeholder. 

 
To group objects: 

1. Select the objects you want to align. To select multiple objects at once, 
hold the Shift key while you click. The Format tab will appear. 

 
2. From the Format tab, click the Group command, then select Group. 
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3. The selected objects will now be grouped. There will be a single box with 

sizing handles around the entire group to show that they are one group. 
You can now move or resize all of the objects at once. 

 
If you want to edit or move one of the objects in the group, double-click to select the 
object. You can then edit it or move it to the desired location. 

 
If you select the objects and the Group command is disabled, it may be because one of 
the objects is inside a placeholder. If this happens, try reinserting the images by using 
the Pictures command on the Insert tab. 
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To ungroup objects: 
1. Select the object group you want to ungroup. 
2. From the Format tab, click the Group command, then select Ungroup. 

 
3. The objects will be ungrouped. 

 
12.3 Ordering objects 
In addition to aligning objects, PowerPoint gives you the ability to arrange objects in 
a specific order. The ordering is important when two or more objects overlap because it 
will determine which objects are in the front or the back. 
Understanding levels 
When objects are inserted into a slide, they are placed on levels according to the order in 
which they were inserted into the slide. In our example, we've drawn an arrow on the 
top level, but we can change the level to put it behind the other objects. 

 
To change the ordering by one level: 

1. Select an object. The Format tab will appear. 
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2. From the Format tab, click the Bring Forward or Send 

Backward command to change the object's ordering by one level. If there 
are multiple objects on the slide, you may need to click the 
command several times to achieve the desired ordering. 

 
3. The objects will reorder. 

 
To bring an object to the front or back: 

If you want to move an object behind or in front of several objects, it's usually faster 
to bring it to front or send it to back instead of clicking the ordering commands multiple 
times. 

1. Select an object. 
2. From the Format tab, click the Bring Forward or Send Backward drop-

down arrow. 
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3. From the drop-down menu, select Bring to Front or Send to Back. 

 
4. The objects will reorder. 

 
If you have several objects placed on top of each other, it may be difficult to select an 
individual object. The Selection pane allows you to easily drag an object to a new 
location. To access the Selection pane, click Selection Pane on the Format Tab. 
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Rotating objects 
If you need to turn an object so it faces a different direction, you can rotate it to the left 
or right or flip it horizontally or vertically. 
To rotate an object: 

1. Select an object. The Format tab will appear. 

 
2. From the Format tab, click the Rotate command. A drop-down menu will 

appear. 
3. Select the desired rotation option. 
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4. The object will rotate. 

 
Lesson 13: Animating Text and Objects 
In PowerPoint, you can animate text and objects such as clip art, shapes, and pictures. 
Animation—or movement—on the slide can be used to draw the audience's attention to 
specific content or to make the slide easier to read. 

13.1 The four types of animations 
There are several animation affects you can choose from, and they are organized into 
four types. 

 Entrance: These control how the object enters the slide. For example, 
with the Bounce animation the object will "fall" onto the slide and then 
bounce several times. 

 
 Emphasis: These animations occur while the object is on the slide, often 

triggered by a mouse click. For example, you can set an object 
to spin when you click the mouse. 

https://edu.gcfglobal.org/en/powerpoint2016/animating-text-and-objects/1/
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 Exit: These control how the object exits the slide. For example, with 

the Fade animation the object will simply fade away. 

 
 Motion Paths: These are similar to Emphasis effects, except the object 

moves within the slide along a predetermined path, like a circle. 

 
13.2 To apply an animation to an object: 

1. Select the object you want to animate. 
2. On the Animations tab, click the More drop-down arrow in 

the Animation group. 
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3. A drop-down menu of animation effects will appear. Select the desired 
effect. 

 
4. The effect will apply to the object. The object will have a 

small number next to it to show that it has an animation. In the Slide 
pane, a star symbol also will appear next to the slide. 

 
At the bottom of the menu, you can access even more effects. 
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12.3 Effect options 
Some effects will have options you can change. For example, with the Fly In effect you 
can control which direction the object comes from. These options can be accessed from 
the Effect Options command in the Animation group. 
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To remove an animation: 
1. Select the small number located next to the animated object. 

 
2. Press the Delete key. The animation will be deleted. 

Animations are best used in moderation. Adding too many animations can make your 
presentation look a little silly and can even be distracting to your audience. Consider 
using mostly subtle animations, or not using animations at all. 

12.4 Working with animations 
To add multiple animations to an object: 
If you select a new animation from the the menu in the Animation group, it will replace 
the object's current animation. However, you'll sometimes want to place more than one 
animation on an object, like an Entrance and an Exit effect. To do this, you'll need to use 
the Add Animation command, which will allow you to keep your current animations 
while adding new ones. 

1. Select an object. 
2. Click the Animations tab. 
3. In the Advanced Animation group, click the Add Animation command to 

view the available animations. 
4. Select the desired animation effect. 
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5. If the object has more than one effect, it will have a different number for 

each effect. The numbers indicate the order in which the effects will 
occur. 

 
To reorder the animations: 

1. Select the number of the effect you want to change. 
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2. From the Animations tab, click the Move Earlier or Move 
Later commands to change the ordering. 

 
To copy animations with the Animation Painter: 
In some cases, you may want to apply the same effects to more than one object. You can 
do this by copying the effects from one object to another using the Animation Painter. In 
our example, we want to copy an animation from one slide to another because they have 
similar layouts. 

1. Click the object that has the effects you want to copy. In our example, 
we'll click our answer text. 

 
2. From the Animations tab, click the Animation Painter command. 

 
3. Click the object you want to copy the effects to. In our example, we'll click 

the answer text on the next slide. Both objects now have the same effect. 

 
To preview animations: 
Any animation affects you have applied will show up when you play the slide show. 
However, you can also quickly preview the animations for the current slide without 
viewing the slide show. 

1. Navigate to the slide you want to preview. 
2. From the Animations tab, click the Preview command. The animations for 

the current slide will play. 
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12.5 The Animation Pane 
The Animation Pane allows you to view and manage all of the effects that are on the 
current slide. You can modify and reorder effects directly from the Animation Pane, 
which is especially useful when you have several effects. 
To open the Animation Pane: 

1. From the Animations tab, click the Animation Pane command. 

 
2. The Animation Pane will open on the right side of the window. It will show 

all of the effects for the current slide in the order in which they will 
appear. 

 
If you have several animated objects, it may help to rename the objects before 
reordering them in the Animation Pane. You can rename them in the Selection Pane. To 
open the Selection Pane, click an object, then from the Format tab click Selection Pane. 
Double-click the name of an object to rename it. 
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To reorder effects from the Animation Pane: 

1. On the Animation Pane, click and drag an effect up or down. 
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2. The effects will reorder themselves. 

To preview effects from the Animation Pane: 
1. From the Animation Pane, click the Play button. 
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2. The effects for the current slide will play. On the right side of the 
Animation Pane, you will be able to see a timeline that shows the 
progress through each effect. 

 
If the timeline is not visible, click the drop-down arrow for an effect, then select Show 
Advanced Timeline. 
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To change an effect's start option: 
By default, an effect starts playing when you click the mouse during a slide show. If you 
have multiple effects, you will need to click multiple times to start each effect 
individually. However, by changing the start option for each effect, you can have effects 
that automatically play at the same time or one after the other. 

1. From the Animation Pane, select an effect. A drop-down arrow will 
appear next to the effect. 
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2. Click the drop-down arrow and select one of the three desired start 

options. Start on Click will start the effect when the mouse is 
clicked, Start With Previous will start the effect at the same time as the 
previous effect, and Start After Previous will start the effect when the 
previous effect ends. 

 
When you preview the animations, all of the effects will play through automatically. To 
test effects that are set to Start on Click, you will need to play the slide show. 
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The Effect Options dialog box 
From the Animation Pane, you can access the Effect Options dialog box, which contains 
more advanced options you can use to fine tune your animations. 
To open the Effect Options dialog box: 

1. From the Animation Pane, select an effect. A drop-down arrow will 
appear next to the effect. 

2. Click the drop-down arrow, then select Effect Options. 

 
3. The Effect Options dialog box will appear. Click the drop-down menus and 

select the desired enhancement. You can add a sound to the animation, 
add an effect after the animation is over, or animate text in a different 
sequence. 
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Some effects have additional options you can change. These will vary depending on 
which effect you have selected. 
To change the effect timing: 

1. From the Effect Options dialog box, select the Timing tab. 
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2. From here, you can add a delay before the effect starts, change 

the duration of the effect, and control whether the effect repeats. 
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Lesson 13: More Objects 
13.1 Inserting Videos 
PowerPoint allows you to insert a video onto a slide and play it during your presentation. 
This is a great way to make your presentation more engaging for your audience. 
You can even edit the video within PowerPoint and customize its appearance. For 
example, you can trim the video's length, add a fade in, and much more. 
To insert a video from a file: 
In our example, we'll insert a video from a file saved locally on our computer. If you'd 
like to work along with our example, right-click this link to our example video and save it 
to your computer. 

1. From the Insert tab, click the Video drop-down arrow, then select Video 
on My PC. 

 
2. Locate and select the desired video file, then click Insert. 

 
3. The video will be added to the slide. 

https://edu.gcfglobal.org/en/powerpoint2016/inserting-videos/1/
https://edu.gcfglobal.org/en/powerpoint2016/inserting-videos/1/
https://media.gcflearnfree.org/content/56cc70b6a17fa60ae065f89e_02_23_2016/butterfly.mp4
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With the Screen Recording feature on the Insert tab, you can create a video of anything 
you are doing on your computer and insert it into a slide. 

 
To insert an online video: 
Some websites—like YouTube—allow you to embed videos into your slides. An 
embedded video will still be hosted on its original website, meaning the video itself won't 
be added to your file. Embedding can be a convenient way to reduce the file size of your 
presentation, but you'll also need to be connected to the Internet for the video to play. 

 
13.2 Working with videos 
To preview a video: 

1. Click a video to select it. 
2. Click the Play/Pause button below the video. The video will begin playing, 

and the timeline next to the Play/Pause button will advance. 
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3. To jump to a different part of the video, click anywhere on the timeline. 

 
To resize a video: 

 Click and drag the corner sizing handles until the video is the desired size. 
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The corner sizing handles will resize a video while preserving its original aspect ratio. If 
you use the side sizing handles, the video will become distorted. 
To move a video: 

 Click and drag to move a video to a new location on a slide. 

 
To delete a video: 

 Select the video you want to delete, then press 
the Backspace or Delete key on your keyboard. 

13.3 Editing and formatting videos 
The Playback tab has several options you can use to edit your video. For example, you 
can trim your video to play an excerpt from the original, add a fade in and fade out, and 
add bookmarks that allow you to jump to specific points in the video. 
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Most of the features on the Playback tab can only be used with videos that are 
inserted from a file. They will not work with embedded videos. 
To trim a video: 

1. Select the video, then click the Playback tab on the Ribbon. 
2. Click the Trim Video command. 

 
3. A dialog box will appear. Use the green handle to set the start time and 

the red handle to set the end time. 

 
4. To preview the video, click the Play button. 
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5. When you're done trimming the video, click OK. 

To add a fade in and fade out: 
1. On the Playback tab, locate the Fade In: and Fade Out: fields. 
2. Type the desired values, or use the up and down arrows to adjust the fade 

times. 

 
To add a bookmark: 

1. Click the timeline to locate the desired part of the video. 

 
2. From the Playback tab, click the Add Bookmark command. 
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3. The bookmark will appear on the timeline. Click the bookmark to jump to 

that location. 

 
Video options 

There are other options you can set to control how your video will play. These are found 
in the Video Options group on the Playback tab. 

 
 Volume: Changes the audio volume for the video 
 Start: Controls whether the video starts automatically or when the mouse 

is clicked 
 Play Full Screen: Lets the video fill the entire screen while playing 
 Hide While Not Playing: Hides the video when not playing 
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 Loop until Stopped: Replays the video until stopped 
 Rewind after Playing: Returns the video to the beginning when it is 

finished playing 
Formatting the appearance of a video 
Like pictures, PowerPoint allows you to format the appearance of a video by applying 
a video style, adding a border, changing the shape, and applying various effects. 
To create a poster frame: 
You can add a poster frame to a video, which is the placeholder image your audience will 
see before the video starts playing. The poster frame is usually just a frame taken from 
the video itself. 

1. Click the timeline to locate the desired part of the video. 
2. From the Format tab, click the Poster Frame command. Select Current 

Frame from the menu that appears. 

 
3. The current frame will become the poster frame. 

 
If you want to use a picture from your computer, select Image from file. 
To apply a video style: 

1. Select the video, then click the Format tab on the Ribbon. 
2. In the Video Styles group, click the More drop-down arrow to display 

available video styles. 
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3. Select the desired style. 

 
4. The new style will be applied to the video. 
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14. Inserting Audio 
PowerPoint allows you to add audio to your presentation. For example, you could add 
background music to one slide, a sound effect to another, and even record your own 
narration or commentary. You can then edit the audio to customize it for your 
presentation. 
14.1 To insert audio from a file: 
In our example, we'll insert an audio file saved locally on our computer. If you'd like to 
work along with our example, right-click this link to our example file and save it to your 
computer (music credit: Something Small (Instrumental) by Minden, CC BY-NC 3.0). 

1. From the Insert tab, click the Audio drop-down arrow, then select Audio 
on My PC. 

 
2. Locate and select the desired audio file, then click Insert. 

https://edu.gcfglobal.org/en/powerpoint2016/inserting-audio/1/
https://media.gcflearnfree.org/content/56d7048b6aa91509c8743424_03_02_2016/minden_something_small.mp3
http://freemusicarchive.org/music/Minden/Instrumentals_1967/Something_Small_Instrumental
http://www.mindenband.com/manor/
http://creativecommons.org/licenses/by-nc/3.0/
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3. The audio file will be added to the slide. 

 
14.2 Recording your own audio 
Sometimes you may want to record audio directly into a presentation. For example, you 
might want the presentation to include narration. Before you begin, make sure you have 
a microphone that is compatible with your computer; many computers have built-in 
microphones or ones that can be plugged in to the computer. 
To record audio: 

1. From the Insert tab, click the Audio drop-down arrow, then select Record 
Audio. 
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2. Type a name for the audio recording if you want. 

 
3. Click the Record button to start recording. 

 
4. When you're finished recording, click the Stop button. 

 
5. To preview your recording, click the Play button. 
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6. When you're done, click OK. The audio file will be inserted into the slide. 

 
14.3 Working with audio 
To preview an audio file: 

1. Click an audio file to select it. 
2. Click the Play/Pause button below the audio file. The sound will begin 

playing, and the timeline next to the Play/Pause button will advance. 

 
3. To jump to a different part of the file, click anywhere on the timeline. 

To move an audio file: 
 Click and drag to move an audio file to a new location on a slide. 
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To delete an audio file: 

 Select the audio file you want to delete, then press 
the Backspace or Delete key on your keyboard. 

14.4 Editing audio 
You can modify your audio files using the commands on the Playback tab. For example, if 
you add a song to a slide you can trim it to play only a brief section. You can also add 
a fade in and fade out and can add bookmarks that allow you to jump to specific points 
in the audio file. 
To trim an audio file: 

1. Select the audio file, then click the Playback tab on the Ribbon. 

 
2. Click the Trim Audio command. 

 
3. A dialog box will appear. Use the green handle to set the start time and 

the red handle to set the end time. 
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4. To preview the audio file, click the Play button. 

 
5. Adjust the handles again if necessary, then click OK. 

To add a fade in and fade out: 
1. On the Playback tab, locate the Fade In: and Fade Out: fields. 
2. Type the desired values, or use the up and down arrows to adjust the 

times. 

 
To add a bookmark: 

1. Click the timeline to locate the desired part of the audio file. 
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2. From the Playback tab, click the Add Bookmark command. 

 
3. The bookmark will appear on the timeline. Click the bookmark to jump to 

that location. 

 
Audio options 
There are other options you can set to control how your audio file will play. These are 
found in the Audio Options group on the Playback tab. 

 
 Volume: Changes the audio volume 
 Start: Controls whether the audio file starts automatically or when the 

mouse is clicked 
 Hide During Show: Hides the audio icon while the slide show is playing 
 Play Across Slides: Continues playing the audio file across multiple slides 

instead of just the current slide 
 Loop until Stopped: Replays the audio file until stopped 
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 Rewind after Playing: Returns the audio file to the beginning when it is 
finished playing 

To change the audio icon: 
By default, an audio file will appear as a speaker icon in the slide. If you want, you can 
change the icon to a different picture. 

1. Select the audio file, then click the Format tab. 
2. Click the Change Picture command. 

 
3. The Insert Pictures dialog box will appear. Click Browse to select a file 

from your computer. Alternatively, you can use the online image search 
tools to locate an image online. In our example, we'll search using the 
phrase music note. 

 
4. Locate and select the desired picture, then click Insert. 
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5. The icon will change to the new picture. 

 
 

Lesson 15: Tables 
Tables are another tool you can use to display information in PowerPoint. A table is a grid 
of cells arranged in rows and columns. Tables are useful for various tasks, including 
presenting text information and numerical data. You can even customize tables to fit 
your presentation. 
15.1 To insert a table: 

1. From the Insert tab, click the Table command. 
2. Hover the mouse over the grid of squares to select the desired number 

of columns and rows in the table. In our example, we'll insert a table 
with six rows and six columns (6x6). 

https://edu.gcfglobal.org/en/powerpoint2016/tables/1/
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3. The table will appear on the currently selected slide. In our example, 

that's slide 3. 
4. Click anywhere in the table, and begin typing to add text. You can also use 

the Tab key or the arrow keys on your keyboard to navigate through the 
table. 

 
You can also insert a table by clicking the Insert Table command in a placeholder. 
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15.2 Modifying tables 
PowerPoint includes several options for customizing tables, 
including moving and resizing, as well as adding rows and columns. 
To move a table: 

 Click and drag the edge of a table to move it to a new location on a slide. 

 
To resize a table: 

 Click and drag the sizing handles until the table is the desired size. 
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To add a row or column: 

1. Click a cell adjacent to the location where you want to add a row or 
column. In our example, we'll select the cell that says Mystery. 

 
2. Click the Layout tab on the right side of the Ribbon. 
3. Locate the Rows & Columns group. If you want to insert a new row, select 

either Insert Above or Insert Below. If you want to insert a new column, 
select either Insert Left or Insert Right. 

 
4. The new row or column will appear. 
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To delete a row or column: 

1. Select the desired row or column. In our example, we'll select the empty 
row at the bottom of the table. 

 
2. From the Layout tab in the Rows & Columns group, click 

the Delete command, then select Delete Rows or Delete Columns from 
the menu. 

 
3. The selected row or column will be deleted. 
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You can also access the Insert and Delete commands by right-clicking a table. 

 
To delete a table: 

 Click the edge of the table you want to delete, then press 
the Backspace or Delete key on your keyboard. 

15.3 Modifying tables with the Layout tab 
When you select a table, the Design and Layout tabs will appear on the right side of the 
Ribbon. You can make a variety of changes to a table using the commands on 
the Layout tab. 
Click the buttons in the interactive below to learn about the different commands on the 
Layout tab. 
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Customizing tables 
PowerPoint makes it easy to change the look and feel of your tables. For example, you 
can quickly apply different table styles and customize the table borders. 
To apply a table style: 

1. Select any cell in your table, then click the Design tab on the right side of 
the Ribbon. 

2. Locate the Table Styles group, then click the More drop-down arrow to 
see available table styles. 

 
3. Select the desired style. 
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4. The selected table style will be applied. 

 
To change table style options: 
You can turn various options on or off to change the appearance of the table. There are 
six options: Header Row, Total Row, Banded Rows, First Column, Last Column, 
and Banded Columns. 

1. Select any cell in your table. 
2. From the Design tab, check or uncheck the desired options in the Table 

Style Options group. 
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These options can affect your table style in various ways, depending on the type of 
content in your table. You may need to experiment with a few options to find the exact 
style you want. 
To add borders to a table: 
You can add borders to help define different sections of a table. Certain table styles may 
include borders automatically, but it's easy to add them manually or customize them. 
You can control the border weight, color, and line style for some or all of a table. 

1. Select the cells where you want to add borders. In our example, we'll 
select every cell in our table. 

2. From the Design tab, select the desired Line Style, Line Weight, and Pen 
Color. 

 
3. Click the Borders drop-down arrow, then select the desired border type. 
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4. The border will be added to the selected cells. 

 
5. To remove borders, select the desired cells, click the Borders command, 

and select No Border. 
 
 
 

Lesson 16: Charts 
 
A chart is a tool you can use to communicate data graphically. Including a chart in a 
presentation allows your audience to see the meaning behind the numbers, which makes 
it easy to visualize comparisons and trends. 

https://edu.gcfglobal.org/en/powerpoint2016/charts/1/
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16.1 Types of charts 
PowerPoint has several types of charts, allowing you to choose the one that best fits your 
data. In order to use charts effectively, you'll need to understand how different charts 
are used. 

 
PowerPoint has a variety of chart types, each with its own 
advantages. Click the arrows to see some of the different types of 
charts available in PowerPoint. 
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Column charts use vertical bars to represent data. They can work with 
many different types of data, but they're most frequently used for 
comparing information. 

  
Line charts are ideal for showing trends. The data points are 
connected with lines, making it easy to see whether values are 
increasing or decreasing over time. 

  
Pie charts make it easy to compare proportions. Each value is shown 
as a slice of the pie, so it's easy to see which values make up the 
percentage of a whole. 
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Bar charts work just like column charts, but they use horizontal bars 
instead of vertical bars. 

  
Area charts are similar to line charts, except the areas under the lines 
are filled in. 
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Surface charts allow you to display data across a 3D landscape. They 
work best with large data sets, allowing you to see a variety of 
information at the same time. 

 

16.2 Identifying the parts of a chart 
In addition to chart types, you'll need to understand how to read a chart. Charts contain 
several different elements—or parts—that can help you interpret data. 
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Inserting charts 
PowerPoint uses a spreadsheet as a placeholder for entering chart data, much like Excel.  
To insert a chart: 

1. Select the Insert tab, then click the Chart command in 
the Illustrations group. 

 
2. A dialog box will appear. Select a category from the left pane, and review 

the charts that appear in the right pane. 
3. Select the desired chart, then click OK. 

 
4. A chart and a spreadsheet will appear. The data that appears in the 

spreadsheet is placeholder source data you will replace with your own 
information. The source data is used to create the chart. 
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5. Enter data into the worksheet. 

 
6. Only the data enclosed by the blue lines will appear in the chart, but this 

area will expand automatically as you continue to type. 
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7. When you're done, click X to close the spreadsheet. 

 
8. The chart will be completed. 
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You can edit the chart data at any time by selecting your chart and clicking the Edit 
Data command on the Design tab. 

 
You can also click the Insert Chart command in a placeholder to insert a new chart. 

 
Creating charts with existing Excel data 
If you already have data in an existing Excel file you want to use for a chart, you can 
transfer the data by copying and pasting it. Just open the spreadsheet in Excel, select and 
copy the desired data, and paste it into the source data area for your chart. 
You can also embed an existing Excel chart into your PowerPoint presentation. This may 
be useful when you know you'll need to update the data in your Excel file and want the 
chart to automatically update whenever the Excel data is changed. 
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16.3 Modifying charts with chart tools 
There are many other ways to customize and organize your charts. For example, 
PowerPoint allows you to change the chart type, rearrange a chart's data, and even 
change the layout and style of a chart. 
To change the chart type: 
If you find that your data isn't well suited to a certain chart, it's easy to switch to a 
new chart type. In our example, we'll change our chart from a column chart to 
a line chart. 

1. Select the chart you want to change. The Design tab will appear on the 
right side of the Ribbon. 

 
2. From the Design tab, click the Change Chart Type command. 

 
3. A dialog box will appear. Select the desired chart type, then click OK. 
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4. The new chart type will appear. 
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To switch row and column data: 
Sometimes you may want to change the way charts group your data. For example, in the 
chart below the book sales data is grouped by genre, with lines for each month. 
However, we could switch the rows and columns so the chart will group the data by 
month, with lines for each genre. In both cases, the chart contains the same data; it's just 
organized differently. 

1. Select the chart you want to modify. The Design tab will appear. 
2. From the Design tab, select the Edit Data command in the Data group. 

 
3. Click the chart again, then select the Switch Row/Column command in 

the Data group. 

 
4. The rows and columns will be switched. In our example, the data is now 

grouped by month, with lines for each genre. 
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We've noticed that when numerical data has been entered in the first column of the 
spreadsheet, switching rows and columns may cause unexpected results. One solution is 
to type an apostrophe before each number, which tells the spreadsheet to format it 
as text instead of a numerical value. For example, the year 2016 would be entered 
as '2016. 

16.4 To change the chart layout: 
Predefined chart layouts allow you to modify chart elements—including chart 
titles, legends, and data labels—to make your chart easier to read. 

1. Select the chart you want to modify. The Design tab will appear. 
2. From the Design tab, click the Quick Layout command. 

 
3. Select the desired predefined layout from the menu that appears. 
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4. The chart will update to reflect the new layout. 

 
To change a chart element (such as the chart title), click the element and begin typing. 
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16.5 To change the chart style: 
Chart styles allow you to quickly modify the look and feel of your chart. 

1. Select the chart you want to modify. The Design tab will appear. 
2. From the Design tab, click the More drop-down arrow in the Chart 

Styles group. 

 
3. Select the desired style from the menu that appears. 

 
4. The chart will appear in the selected style. 
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You can also use the chart formatting shortcut buttons to quickly add chart elements, 
change the chart style, and filter the chart data. 

 
 

16.6 SmartArt Graphics 
SmartArt allows you to communicate information with graphics instead of just using text. 
There are a variety of styles to choose from, which you can use to illustrate different 
types of ideas. 
To insert a SmartArt graphic: 

1. Select the slide where you want the SmartArt graphic to appear. 
2. From the Insert tab, select the SmartArt command in 

the Illustrations group. 

https://edu.gcfglobal.org/en/powerpoint2016/smartart-graphics/1/
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3. A dialog box will appear. Select a category on the left, choose the desired 

SmartArt graphic, then click OK. 

 
4. The SmartArt graphic will appear on the current slide. 
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You can also click the Insert a SmartArt Graphic command in a placeholder to add 
SmartArt. 

 
To add text to a SmartArt graphic: 

1. Select the SmartArt graphic. The text pane will appear to the left 
2. Enter text next to each bullet in the text pane. The text will appear in the 

corresponding shape. It will be resized automatically to fit inside the 
shape. 
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You can also add text by clicking the desired shape and then typing. This works well if you 
only need to add text to a few shapes. However, for more complex SmartArt graphics, 
working in the text pane is often quicker and easier. 

 
To reorder, add, and delete shapes: 

It's easy to add new shapes, change their order, and even delete shapes from your 
SmartArt graphic. You can do all of this in the text pane, and it's a lot like creating an 
outline with a multilevel list. For more information on multilevel lists, you may want to 
review our Lists lesson. 

 To demote a shape, select the desired bullet, then press the Tab key. The 
bullet will move to the right, and the shape will move down one level. 

http://www.gcflearnfree.org/powerpoint2016/lists/1/
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 To promote a shape, select the desired bullet, then press 

the Backspace key (or Shift+Tab). The bullet will move to the left, and the 
shape will move up one level. 

 
 To add a new shape, place the insertion point after the desired bullet, 

then press Enter. A new bullet will appear in the text pane, and a new 
shape will appear in the graphic. 
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 To remove a shape, keep pressing Backspace until the bullet is deleted. 

The shape will then be removed. In our example, we'll delete all of the 
shapes without text. 

 
16.7 Organizing SmartArt from the Design tab 
If you'd prefer not to use the text pane to organize your SmartArt, you can use the 
commands on the Design tab in the Create Graphic group. Just select the shape you want 
to modify, then choose the desired command. 

 Promote and Demote: Use these commands to move a shape up or down 
between levels. 
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 Move Up and Move Down: Use these commands to change the order of 

shapes on the same level. 

 
 Add Shape: Use this command to add a new shape to your graphic. You 

can also click the drop-down arrow for more exact placement options. 
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In our example, we've been organizing a graphic with a hierarchical layout. Not all 
SmartArt graphics use this type of layout, so remember that these commands may work 
differently (or not at all) depending on the layout of your graphic. 
Customizing SmartArt 
After inserting SmartArt, there are several things you might want to change about its 
appearance. Whenever you select a SmartArt graphic, the Design and Format tabs will 
appear on the right side of the Ribbon. From there, it's easy to edit 
the style and layout of a SmartArt graphic. 

 There are several SmartArt styles, which allow you to quickly modify the 
look and feel of your SmartArt. To change the style, select the desired 
style from the SmartArt styles group. 

 
 You have a variety of color schemes to use with SmartArt. To change the 

colors, click the Change Colors command and choose the desired option 
from the drop-down menu. 
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 You can also customize each shape independently. Just select any shape in 

the graphic, then choose the desired option from the Format tab. 
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To change the SmartArt layout: 
If you don't like the way your information is organized within a SmartArt graphic, you can 
always change its layout to better fit your content. 

1. From the Design tab, click the More drop-down arrow in the Layouts 
group. 

 
2. Choose the desired layout, or click More Layouts to see even more 

options. 

 
3. The selected layout will appear. 
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If the new layout is too different from the original, some of your text may not appear. 
Before deciding on a new layout, check carefully to make sure no important information 
will be lost. 
Lesson 5: Review and Collaborating 
5.1 Checking Spelling and Grammar 
Worried about making mistakes when you type? Don't be. PowerPoint provides you with 
several proofing features—including the Spelling and Grammar tool—that can help you 
produce professional, error-free presentations. 
To run a spell check: 

1. From the Review tab, click the Spelling command. 

 
2. The Spelling pane will appear on the right. For each error in your 

presentation, PowerPoint will try to offer one or more suggestions. You 
can select a suggestion and click Change to correct the error. 

https://edu.gcfglobal.org/en/powerpoint2016/checking-spelling-and-grammar/1/
https://edu.gcfglobal.org/en/powerpoint2016/checking-spelling-and-grammar/1/
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3. PowerPoint will move through each error until you have reviewed them 

all. After the last error has been reviewed, a dialog box will appear 
confirming that the spelling check is complete. Click OK. 

 
If no suggestions are given, you can manually type the correct spelling on the slide. 
Ignoring spelling "errors" 
The spell check is not always correct. It may sometimes think a word is spelled 
incorrectly when it's not. This often happens with people's names and proper nouns, 
which may not be in the dictionary. If PowerPoint says something is an error, you can 
choose not to change it using one of three options: 

 Ignore: This will skip the word without changing it. 
 Ignore All: This will skip the word without changing it, and it will also skip 

all other instances of the word in your presentation. 
 Add: This adds the word to the dictionary so it will never come up as an 

error again. Make sure the word is spelled correctly before choosing this 
option. 

 
Automatic spell check 
By default, PowerPoint automatically checks your presentation for spelling errors, so you 
may not even need to run a separate check using the Spelling command. These errors are 
indicated by red wavy lines. 
To use the automatic spell check feature: 

1. Right-click the underlined word. A menu will appear. 
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2. Click the correct spelling from the list of suggestions. 

 
3. The correction will appear in the presentation. 

You can also choose to Ignore an underlined word or Add to Dictionary. 
Modifying proofing options 
PowerPoint allows you to modify the proofing options, giving you more control over how 
it reviews your text. For example, you can customize the automatic spell check to change 
the way PowerPoint marks spelling errors. You can also enable the grammar 
check option to help you find and correct contextual spelling 
errors (like their vs. they're). 
To modify proofing options: 

1. Click the File tab to access Backstage view. 

 
2. Select Options. A dialog box will appear. 

 
3. Select Proofing, then customize the options as needed. When you're 

finished, click OK. 
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Modifying settings in PowerPoint Options—including proofing—will affect any 
presentation you edit in PowerPoint, not just your current presentation. 
5.2 Reviewing Presentations 
Before delivering your presentation, you might ask someone else to review it and give 
you feedback on your slides. You might even work with a collaborator to create a 
presentation together. If you were revising a hard copy, you could add comments in the 
margins or compare your rough and final drafts side by side. You can do these things in 
PowerPoint using the Comments and Compare features. 
Commenting on presentations 
When revising or collaborating on a presentation, you might want to make notes or 
suggestions without actually changing the slide. Leaving a comment allows you to take 
note of something without altering the slide itself. Comments can be added and read by 
the original author or any other reviewers. 
To add a comment: 

1. Select the text or object (or click the area of the slide) where you want 
the comment to appear. 

 
2. Go to the Review tab, then click the New Comment command. 
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3. The Comments pane will appear. In our example, it contains an existing 

comment by another review (Javier), plus a space for your comment. 
4. Type your comment in the box, then press Enter or click anywhere 

outside the box to save the comment. 

 
5. The comment will be represented by a small icon on the slide. 

 
Viewing comments 
You can view or reply to any comment—including other reviewers' comments—by 
returning to the Comments pane. Simply click a comment icon on the slide, or click 
the Show Comments command on the Review tab. 
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To edit a comment: 

1. In the Comments pane, select the comment you want to edit. 

 
2. Type your desired changes, then press Enter or click anywhere outside the 

comment box. Your changes will be applied. 

 
To reply to a comment: 

1. In the Comments pane, click Reply below the comment you want to 
respond to. 
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2. Type your response, then press Enter or click anywhere outside the box. 
Your comment will appear below the original comment, and an 
additional icon will be added to the slide. 

 
Deleting comments 

 To delete a comment, select the comment you want to delete, then go to 
the Review tab and click the Delete command. 

 
 To delete multiple comments, click the drop-down arrow below 

the Delete command. You can delete comments from your current slide 
or from the entire presentation. 

 
5.3 Inspecting and Protecting Presentations 
Before sharing a presentation, you'll want to make sure it doesn't include any 
information you want to keep private. You may also want to discourage others from 
editing your file. Fortunately, PowerPoint includes several tools to help inspect and 
protect your presentation. 

https://edu.gcfglobal.org/en/powerpoint2016/inspecting-and-protecting-presentations/1/
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Document Inspector 
Whenever you create or edit a presentation, certain personal information may be added 
to the file automatically—for example, information about the document's author. You 
can use Document Inspector to remove this type of information before sharing a 
presentation with others. 
Because some changes may be permanent, it's a good idea to use Save As to create a 
backup copy of your presentation before using Document Inspector. 
To use Document Inspector: 

1. Click the File tab to go to Backstage view. 
2. From the Info pane, click Check for Issues, then 

select Inspect Document from the drop-down menu. 

 
3. Document Inspector will appear. Check or uncheck the boxes, depending 

on the content you want to review, then click Inspect. In our example, 
we'll use the default selections. 
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4. The inspection results will show an exclamation mark for any categories 

where it found potentially sensitive data, and it will also have a Remove 
All button for each of these categories. Click Remove All to remove the 
data. 

 
5. When you're done, click Close. 

Protecting your presentation 
By default, anyone with access to your presentation will be able to open, copy, and edit 
its content unless you protect it. There are several ways to protect a presentation, 
depending on your needs. 
To protect your document: 

1. Click the File tab to go to Backstage view. 
2. From the Info pane, click the Protect Presentation command. 
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3. In the drop-down menu, choose the option that best suits your needs. In 
our example, we'll select Mark as Final. Marking your presentation as 
final is a good way to discourage others from editing the file, while the 
other options give you even more control if needed. 

 
4. A dialog box will appear, prompting you to save. Click OK. 

 
5. Another dialog box will appear. Click OK. 

 
6. The presentation will be marked as final. Whenever others open the file, a 

bar will appear at the top to discourage them from editing the document. 
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Marking a presentation as final will not prevent someone from editing it because they 
can just select Edit Anyway. If you want to prevent people from editing it, you can use 
the Restrict Access option instead. 
5.4 Customizing Your Presentation 
5.1 Modifying Themes 
Let's say you really like the style of a theme, but you'd like to experiment with different 
color schemes. That's not a problem: You can mix and match colors, fonts, and effects to 
create a unique look for your presentation. If it still doesn't look exactly right, you can 
customize the theme any way you want. 
To select new theme colors: 
If you don't like the colors of a particular theme, it's easy to apply new theme colors; 
everything else about the theme will remain unchanged. 

1. From the Design tab, click the drop-down arrow in the Variants group and 
select Colors. 

 
2. Select the desired theme colors. 
3. The presentation will update to show the new theme colors. 

https://edu.gcfglobal.org/en/powerpoint2016/modifying-themes/1/
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To customize colors: 
Sometimes you might not like every color included in a set of theme colors. It's easy to 
change some or all of the colors to suit your needs. 

1. From the Design tab, click the drop-down arrow in the Variants group. 
2. Select Colors, then click Customize Colors. 

 
3. A dialog box will appear with the 12 current theme colors. To edit a color, 

click the drop-down arrow and select a different color. You may need to 
click More Colors to find the exact color you want. 
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4. In the Name: field, type the desired name for the theme colors, then 

click Save. 

 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  878 | 1352  

5. The presentation will update to show the new custom theme colors. 
With some presentations, you may not notice a significant difference when changing the 
theme colors. For example, a textured background will not change when theme colors 
are changed. When trying different theme colors, it's best to select a slide that uses 
several colors to see how the new theme colors will affect your presentation. 
To select new theme fonts: 
It's easy to apply a new set of theme fonts without changing a theme's overall look. The 
built-in theme fonts are designed to work well together, which can help to unify your 
presentation. 

1. From the Design tab, click the drop-down arrow in the Variants group and 
select Fonts. 

 
2. Select the desired theme fonts. 

 
3. The presentation will update to show the new theme fonts. 

To customize theme fonts: 
If you have specific fonts in mind for a presentation, it's easy to choose your own theme 
fonts. 

1. From the Design tab, click the drop-down arrow in the Variants group. 
2. Select Fonts, then click Customize Fonts. 
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3. A dialog box will appear with the two current theme fonts. To change the 

fonts, click the drop-down arrows and select the desired fonts. 
4. In the Name: field, type the desired name for the theme fonts, then 

click Save. 

 
5. The presentation will update to show the new custom theme fonts. 

Changing the theme fonts will not necessarily update all text in your presentation. Only 
text using the current theme fonts will update when you change the theme fonts. 

 
To select new theme effects: 
PowerPoint makes it easy to apply new theme effects, which can quickly change the 
appearance of shapes in your presentation. 

1. From the Design tab, click the drop-down arrow in the Variants group and 
select Effects. 

 
2. Select the desired theme effects. 
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3. The presentation will update to show the new theme effects. 

Applying new theme effects will change different shape styles from the Format tab when 
editing a shape or SmartArt graphic. It's important to note that this change will only apply 
to shapes using the Subtle Effect, Moderate Effect, and Intense Effect. 

 
Background styles 
To further customize your slides, you can change the background color by choosing a 
different background style. The available background styles will vary depending on the 
current theme. 
To apply a background style: 
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1. From the Design tab, click the drop-down arrow in the Variants group. 

 
2. Select Background Styles. 

 
3. Select the desired style. The available styles will change depending on the 

current theme colors. 

 
4. The new background will appear in each slide of your presentation. 

If you want even more control over the background, click the Format 
Background command on the Design tab. 

 
Different themes also include different slide layouts and background graphics.  
Saving custom themes 
Once you've found settings you like, you may want to save the theme so you can use it in 
other presentations. If you only want to use the theme in the current presentation, you 
won't need to save it. 
To save a theme: 

1. From the Design tab, click the drop-down arrow in the Themes group. 
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2. Click Save Current Theme. 

 
3. A dialog box will appear. Type a file name, then click Save. 

 
4. When you click the drop-down arrow in the Themes group, you'll see the 

custom theme under Custom. 
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Custom themes have another unique and powerful feature: Any custom theme you save 
in PowerPoint can actually be used in other Microsoft Office applications, such as Word 
and Excel. 
 
 
 
5.2 Slide Master View 
You may have noticed that when you select a different theme in PowerPoint, it 
rearranges the text on your slides and adds shapes to the background. This is because 
each theme has built-in slide layouts and background graphics. You can edit these layouts 
with a feature called Slide Master view. Once you learn how to use Slide Master view, 
you'll be able to customize your entire slide show with just a few clicks. 
What is Slide Master view? 
Slide Master view is a special feature in PowerPoint that allows you to quickly modify the 
slides and slide layouts in your presentation. From there, you can edit the slide master, 
which will affect every slide in the presentation. You can also modify individual slide 
layouts, which will change any slides using those layouts. 
For example, let's say you find a theme you like but you don't like a few of the slide 
layouts. You could use Slide Master view to customize the layouts to look exactly the way 
you want. 

https://edu.gcfglobal.org/en/powerpoint2016/slide-master-view/1/
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In Slide Master view, the Slide Master tab will appear first on the Ribbon, but you'll still 
be able to access commands on different tabs as normal. 

 
Using Slide Master view 
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Whether you're making significant changes to your slides or just a few small tweaks, 
Slide Master view can help you create a consistent, professional presentation without a 
lot of effort. You could use Slide Master view to change just about anything in your 
presentation, but here are some of its most common uses. 

 Modify backgrounds: Slide Master view makes it easy to customize 
the background for all of your slides at the same time. For example, you 
could add a watermark or logo to each slide in your presentation, or you 
could modify the background graphics of an existing PowerPoint theme. 

 Rearrange placeholders: If you find that you often rearrange the 
placeholders on each slide, you can save time by rearranging them in 
Slide Master view instead. When you adjust one of the layouts in Slide 
Master view, all of the slides with that layout will change. 

 Customize text formatting: Instead of changing the text color on each 
slide individually, you could use the Slide Master to change the text color 
on all slides at once. 

 Create unique slide layouts: If you want to create a presentation that 
looks different from regular PowerPoint themes, you could use Slide 
Master view to create your own layouts. Custom layouts can include your 
own background graphics and placeholders. 

Some overall presentation changes—like customizing the theme fonts and theme 
colors—can be made quickly from the Design tab. Review our lesson on Modifying 
Themes to learn more. 
To make changes to all slides: 
If you want to change something on all slides of your presentation, you can edit the Slide 
Master. In our example, we'll add a logo to every slide. If you'd like to work along with 
our example, right-click the image below and save it to your computer. 

 
1. Select the View tab, then click the Slide Master command. 

 
2. The presentation will switch to Slide Master view, and 

the Slide Master tab will be selected on the Ribbon. 
3. In the left navigation pane, scroll up and select the first slide. This is 

the slide master. 

http://www.gcflearnfree.org/powerpoint2016/modifying-themes/1/
http://www.gcflearnfree.org/powerpoint2016/modifying-themes/1/
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4. Make the desired changes to the slide master. In our example, we’ll insert 

a picture of the Mongibello logo. 

 
5. Move, resize, or delete slide objects as needed. In our example, we'll 

resize the logo and move it to the bottom-right corner. 
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6. When you’re finished, click the Close Master View command on the Slide 
Master tab. 

 
7. The change will appear on all slides of the presentation. 

 
When you make a change to the slide master, it's a good idea to review your 
presentation to see how it affects each slide. You may find that some of your slides don't 
look exactly right. On the next page, we'll show you how to fix this by customizing 
individual slide layouts. 
Customizing slide layouts 
You can use Slide Master view to modify any slide layout in your presentation. It's easy 
to make small tweaks like adjusting background graphics and more significant changes 
like rearranging or deleting placeholders. Unlike the slide master, changes to a slide 
layout will only be applied to slides using that layout in your presentation. 
To customize an existing slide layout: 
In our example, our newly added logo is hidden behind the photo in the Picture with 
Caption Layout. We'll customize this layout to make room for the logo. 

1. Navigate to Slide Master view. 
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2. Locate and select the desired layout in the left navigation pane. You can 

hover the mouse over each layout to see which slides are currently using 
that layout in the presentation. 

 
3. In some layouts, the background graphics may be hidden. To show the 

graphics, uncheck the box next to Hide Background Graphics. 

 
4. Add, move, or delete any objects as desired. In our example, we'll delete 

the gray background shape. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  889 | 1352  

 
5. If you want to change the arrangement of the placeholders, you can 

move, resize, or delete any of them. In our example, we'll move our text 
placeholders and the black bar to the right side, and the photo 
placeholder to the left side. 

 
6. When you're finished, click the Close Master View command on the Slide 

Master tab. 

 
7. All slides using the layout will be updated. 
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You can also move placeholders on the slide master, which will move the placeholders 
on multiple slide layouts at the same time. However, some slide layouts may still need to 
be adjusted manually. 
Customizing text formatting 
You can also customize the text formatting from Slide Master view, including 
the font, text size, color, and alignment. For example, if you wanted to change the font 
for every title placeholder in your presentation, you could modify the master title 
style on the slide master. 

 
Each title placeholder is connected to the master title style on the slide master. For 
example, take a look at the slides before changing the title font. 
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Now look at the same slides after changing the title font. 

 
Instead of customizing individual placeholders, you could change the theme fonts for a 
presentation. From the Slide Master tab, click the Fonts command in 
the Background group, then select the desired fonts. 
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Creating new slide layouts 
One of the most powerful features of Slide Master view is the option to create new slide 
layouts. This is an easy way to add interesting and unique slide layouts to an existing 
theme. You could even use this feature to design an entirely new theme, as in the 
example below. 

 
To insert a new slide layout: 

1. Navigate to Slide Master view. From the Slide Master tab, click the Insert 
Layout command. 

 
2. The new slide layout will appear. 
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3. The layout will include title and footer placeholders by default. Click 

the Title and Footers boxes in the Master Layout group to toggle these 
placeholders on and off. 

 
4. You can now add background graphics, shapes, and pictures to the slide 

layout. You can also move, adjust, and delete the existing placeholders. In 
our example, we'll move the title placeholder to the bottom-right corner. 
We've also changed the text alignment to align right instead of align left. 

 
5. To add new placeholders, click the bottom half of 

the Insert Placeholder command, then select the desired placeholder 
type. In this example, we'll use the Picture placeholder. 
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6. Click and drag to draw the placeholder on the slide. 

 
To rename a custom layout: 
When you're done designing your custom layout, you'll want to give it a unique name so 
it will be easy to find. 

1. From Slide Master view, select the desired layout, then click 
the Rename command. 

 
2. A dialog box will appear. Type the desired name, then click Rename. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  895 | 1352  

 
To use a custom layout: 
Once you've created a custom slide layout, it's easy to add a new slide with that layout or 
apply it to an existing slide. 

1. If you're currently in Slide Master view, click the Close Master 
View command on the Slide Master tab. 

2. From the Home tab, you can insert a new slide with the custom layout 
or apply it to an existing slide. In our example, we'll select 
the Layout command and apply the new style to slide 6. 

 
3. The custom slide layout will be applied. 

 
PowerPoint also allows you to add new placeholders to existing slide layouts. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  896 | 1352  

Using custom layouts in other presentations 
When you modify the slide master or slide layouts in Slide Master view, you're actually 
creating a custom version of the current theme. If you want to apply the theme to other 
presentations, you'll need to save it. 
To save a theme: 
From the the Slide Master tab, click the Themes command, then select Save Current 
Theme from the drop-down menu. 

 
If you're not in Slide Master view, you can save the theme from the Design tab. Just click 
the drop-down arrow in the Themes group, then select Save Current Theme. 

 
 
5.3 Hyperlinks 
Whenever you use the Internet, you use hyperlinks to navigate from one webpage to 
another. If you want to include a web address or email address in your PowerPoint 
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presentation, you can choose to format it as a hyperlink so a person can easily click it. It's 
also possible to link to files and other slides within a presentation. 
About hyperlinks 
Hyperlinks have two basic parts: the address of the webpage, email address, or other 
location they are linking to, and the display text (which can also be a picture or a shape). 
For example, the address could be https://www.youtube.com, and YouTube could be 
the display text. In some cases, the display text might be the same as the address. When 
you're creating a hyperlink in PowerPoint, you'll be able to choose both the address and 
the display text or image. 
To insert a hyperlink: 

1. Select the image or text you want to make a hyperlink. 
2. Right-click the selected text or image, then click Hyperlink. Alternatively, 

you can go to the Insert tab and click the Hyperlink command. 

 
3. The Insert Hyperlink dialog box will open. 

 
4. If you selected text, the words will appear in the Text to display field at 

the top. You can change this text if you want. 

https://www.youtube.com/
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5. Type the address you want to link to in the Address field. 
6. Click OK. The text or image you selected will now be a hyperlink to the 

web address. 

 
To insert a hyperlink to an email address: 

1. Right-click the selected text or image, then click Hyperlink. 
2. The Insert Hyperlink dialog box will open. 
3. On the left side of the dialog box, click Email Address. 

 
4. Type the email address you want to connect to in the Email Address box, 

then click OK. 

 
PowerPoint often recognizes email and web addresses as you type and will format them 
as hyperlinks automatically after you press the Enter key or spacebar. 
To open and test a hyperlink: 

1. After you create a hyperlink, you should test it. Right-click the hyperlink, 
then click Open Hyperlink. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  899 | 1352  

 
2. Your web browser should open and then navigate to the linked page. If it 

doesn't work, check the hyperlink address for any misspellings. 
To open a hyperlink while viewing your slide show, click the hyperlink. 

 
To remove a hyperlink: 

1. Right-click the hyperlink. 
2. Click Remove Hyperlink. 

 
More hyperlinks 
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In PowerPoint, you can use hyperlinks to link to resources that are not online. To create a 
quick way to refer to another slide in your presentation, you can create a hyperlink to 
that slide. If you need to access a file stored on your computer, you can create a 
hyperlink to it. Additionally, PowerPoint allows you to format pictures and shapes as 
hyperlinks. 
Using shapes and pictures as hyperlinks 
Sometimes you might want to format objects—including shapes, text boxes, and 
pictures—as hyperlinks. This is especially helpful if you want the object to act like 
a button. To do this, right-click the desired object and select Hyperlink from the menu 
that appears. Click the object during the presentation to open the hyperlink. 

 
 
To insert a hyperlink to another slide: 

1. Right-click the selected text or image, then click Hyperlink. 
2. The Insert Hyperlink dialog box will appear. 
3. On the left side of the dialog box, click Place in this Document. 

 
4. A list of other slides in your presentation will appear. Click the name of 

the slide you want to link to. 
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5. Click OK. The text or image will now be a hyperlink to the slide you 

selected. 

 
Adding a hyperlink to a shape is similar to creating an action button. We'll talk more 
about how to turn a shape into a button in our Action Buttons lesson. 
To insert a hyperlink to another file: 

1. Right-click the selected text or image, then click Hyperlink. The Insert 
Hyperlink dialog box will appear. 

2. On the left side of the dialog box, click Existing File or Webpage. 
3. Click the drop-down arrow to browse for your file. 

 
4. Select the desired file. 

http://www.gcflearnfree.org/powerpoint2016/action-buttons/1/


 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  902 | 1352  

 
5. Click OK. The text or image will now be a hyperlink to the file you 

selected. 

 
If you plan on displaying your presentation on a different computer than you used to 
create it, your hyperlink to another file may not work. Make sure you have a copy of the 
linked file on the computer you are using to present, and always test hyperlinks before 
giving a presentation. 
5.4 Action Buttons 
Another tool you can use to connect to a webpage, file, email address, or slide is called 
an action button. Action buttons are built-in shapes you can add to a presentation and 
set to link to another slide, play a sound, or perform a similar action. When someone 
clicks or hovers over the button, the selected action will occur. Action buttons can do 
many of the same things as hyperlinks. Their easy-to-understand style makes them 
especially useful for self-running presentations at booths and kiosks. 
Inserting action buttons 
You can insert action buttons on one slide at a time, or you can insert an action button 
that will show up on every slide. The second option can be useful if you want every slide 
to link back to a specific slide, like the title page or table of contents. 
To insert an action button on one slide: 

1. Click the Insert tab. 
2. Click the Shapes command in the Illustrations group. A drop-down menu 

will appear with the action buttons located at the very bottom. 
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3. Select the desired action button. 
4. Insert the button onto the slide by clicking the desired location. 

The Action Settings dialog box will appear. 
5. Select the Mouse Click or Mouse Over tab. Selecting the Mouse Click tab 

means the action button will perform its action only when clicked. 
Selecting the Mouse Over tab will make the action button perform its 
action when you move the mouse over it. 

 
6. In the Action on click section, select Hyperlink to:, then click the drop-

down arrow and choose an option from the menu. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  904 | 1352  

 
7. Check the Play Sound box if you want a sound to play when the action 

button is clicked. Select a sound from the drop-down menu, or 
select Other sound to use a sound file on your computer. When you're 
done, click OK. 

 
To insert an action button on all slides: 
If you'd like to add an action button to every slide, you can do this with a feature 
called Slide Master view.  

1. Click the View tab. 
2. In the Master Views group, click the Slide Master command. In the left 

navigation pane, scroll up and select the first slide. 
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3. Go to the Insert tab and select an action button from the bottom of 

the Shapes menu. Click on the slide to add the action button, and choose 
the desired options from the dialog box that appears. 

4. Return to the Slide Master tab and click Close Master View. The new 
action button will now be on every slide. 

 
To edit, move, or delete an action button inserted this way, click the View tab, then Slide 
Master. Click Close Master View after making any desired changes. 
If you notice that an action button isn't appearing on certain slides, you may need to 
uncheck the Hide Background Graphics box. 

 
To test an action button: 
After you create an action button, you should test it. 

1. Click the Slide Show tab. 
2. In the Start Slide Show group, click From Current Slide. 
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3. Click your action button. 
4. After you have tested it, right-click anywhere on the screen and select End 

Show. 

 
5. If your action button did not work as you intended, follow the instructions 

below to edit it. 
To edit an action button: 

1. Select the action button. 
2. Click the Insert tab. 
3. In the Links group, click the Action command. The Actions Settings dialog 

box will appear. 

 
4. Edit the action or hyperlink, then click OK. 
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To change the appearance of an action button: 
1. Select the action button. 
2. Click the Format tab. 

 
3. To change the button style or color, use the tools in the Shape 

Styles group. 

 
4. To change the shape of the action button, click Edit Shape in the Insert 

Shapes group. Select a new shape from the drop-down menu. 
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5.5 Rehearsing and Recording Your Presentation 
Fortunately, PowerPoint offers several tools that can help you rehearse your slide show. 
You can even record a copy with voiceover narration, allowing viewers to watch the 
presentation on their own. 
Rehearsing slide show timings 
Rehearsing timings can be useful if you want to set up a presentation to play at a certain 
speed without having to click through the slides yourself. It also gives you the 
opportunity to practice your talking points. Using this feature, you can save timings for 
each slide and animation. PowerPoint will then play the presentation automatically using 
these timings. 
Rehearsing is often one of the last steps in creating a polished presentation.  
To rehearse timings: 

1. Go to the Slide Show tab, then click the Rehearse Timings command. 

 
2. You'll be taken to a full-screen view of your presentation. Practice 

presenting your slide show. When you're ready to move to the next slide, 
click the Next button on the Recording toolbar in the upper-left corner. 
You also can also use the right arrow key on your keyboard. 

https://edu.gcfglobal.org/en/powerpoint2016/rehearsing-and-recording-your-presentation/1/
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3. When you reach the end of the show, a dialog box will appear with 

the total time of your presentation. If you're satisfied with your timings, 
click Yes. 

 
4. The timings will be saved. The next time you present, PowerPoint will use 

these timings to advance the slides automatically. 
If you need more than one try to get the timings just right, the Recording toolbar can be 
used to take a break or start over on a slide. To pause the timer, click the Pause button. 
No actions taken while the timer is paused will be included in the timings. To re-record 
the timings on the current slide, click the Repeat button. 

 
Recording your slide show 
The Record Slide Show feature is similar to the Rehearse Timings feature, but it's a bit 
more comprehensive. If you have a microphone for your computer, you 
can record voiceover narration for the entire presentation. This is useful if you plan to 
use your slide show as a self-running presentation or video. 
To record a slide show: 

1. From the Slide Show tab, select the Record Slide Show drop-down arrow, 
then choose either Start Recording from Beginning or Start Recording 
from Current Slide. 
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2. A dialog box will appear. Select the desired options, then click Start 
Recording. Remember, you can only record narration if you have 
a microphone attached to your computer. 

 
3. Your presentation will appear in full-screen view. Perform your slide 

show. Make sure to speak clearly into the microphone if you're recording 
narration. 

4. When you're ready to move to the next slide, click the Next button on 
the Recording toolbar or use the right arrow key. 

 
5. When you reach the end of the show, PowerPoint will close the full-screen 

view. 
6. Your slide timings and narration are now part of your presentation. The 

slides with narration will be marked with a speaker icon in the bottom-
right corner. 

 
In recorded slide shows, the mouse pointer isn't visible in the finished product; therefore, 
if you want to point something out, you'll need to use the laser pointer feature. Simply 
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hold Ctrl on your keyboard while you click and hold your mouse. The cursor will appear 

as a small red dot. 
To remove slide timings or narration: 
If you change your mind about including slide timings or narration, you can easily remove 
one or both. You can clear them from the entire presentation or just the current slide. 
To do this, simply go to the Slide Show tab, click the Record Slide Show drop-down 
arrow, hover over Clear, then choose the desired option from the menu. 

 
 
5.6 Sharing Your Presentation Online 
PowerPoint offers several options to enhance or even totally change the way you deliver 
presentations. Instead of presenting your slide show normally, you can choose to present 
it as a video, or you can even present it live online so others can view it remotely. No 
matter how you choose to give your presentation, you can enhance it by customizing 
your slide show to remove or reorder slides. All of these options can help you give a 
polished and professional presentation. 
Exporting a presentation as a video 
The Create a Video feature allows you to save your presentation as a video. This can be 
useful because it lets your viewers watch the presentation whenever they want. To make 
sure your viewers have enough time to view each slide, you might want to rehearse the 
timings or record your slide show before using this feature. 
To create a video: 

https://edu.gcfglobal.org/en/powerpoint2016/sharing-your-presentation-online/1/
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1. Click the File tab to access Backstage view. 
2. Select Export, then click Create a Video. Video export options will appear 

on the right. 

 
3. Click the drop-down arrow next to Presentation Quality to select the size 

and quality of your video. 

 
4. Select the drop-down arrow next to Use Recorded Timings and 

Narrations. Choose Don't Use Recorded Timings and Narrations if you 
don't have or don't want to use recorded timings. You can also 
choose Use Recorded Timings and Narrations if you have already 
recorded timings and narrations and want to use them in your video. 

 
5. Click Create Video. The Save As dialog box will appear. 
6. Select the location where you want to save the presentation, then enter a 

name for the presentation. 
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7. Click Save. As PowerPoint creates your video, a status bar will appear at 

the bottom of the PowerPoint window. When the bar is complete, your 
video is ready to view, send, or upload. 

 
In addition to emailing your video, you can upload your video to free video-sharing 
sites like YouTube. Once your video is uploaded, you can give the link to anyone you 
want to see it. To learn more about using YouTube to share videos online, visit 
our YouTube tutorial. 

http://youtube.com/
http://www.gcflearnfree.org/youtube
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Presenting your slide show online 
Presenting a slide show online is surprisingly easy. All you and your viewers need is an 
Internet connection—they don't even need PowerPoint. Once your viewers are 
connected, you can start the presentation as you normally would. 
Please note that you cannot edit your presentation or mark it with a highlighter or pen 
while you are presenting a slide show online. You also cannot use PowerPoint to speak to 
your audience. Plan to communicate with your viewers through teleconferencing, or pre-
record your narration. 
To present online: 

1. Select the Slide Show tab, then locate the Start Slide Show group. 
2. Click the Present Online command. 
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3. A dialog box will appear. Click Connect. A status message will appear as 
PowerPoint prepares your online presentation. 

 
4. A link will appear. If it's not already selected, select the link. 
5. Click Copy Link to make a copy of the link, which you can paste just about 

anywhere—including Facebook, a blog, or an email. You'll just want to 
make sure each of your viewers receives a copy of the link before you 
begin your presentation. 

 
6. Click Start Presentation. 
7. Present the slide show as you normally would, using the mouse or 

keyboard to advance the slides. 
8. When you are finished, click End Online Presentation. 
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9. A dialog box will appear to confirm that you want to end the presentation. 

Click End Online Presentation. 
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Module 5: Internal office management 

The modern guide to office management 
Office management is a big job and involves a lot of stakeholders. It’s about more than 
handing out office supplies and handling other administrative tasks—it’s actually about 
making sure that your modern office and everyone in it work harmoniously.  
In this guide, we will look at office management, as it is done by modern office managers. 
We will look at the demands of the job of office management, the skills required to 
succeed, how the role is changing, and how you can excel in this area.  
 

What is office management? 

Office management is a job that focuses on improving productivity, efficiency, and working 
conditions within an office. It may involve a wide range of responsibilities, including 
managing a modern workplace, handling office equipment, building a warm office 
environment, managing office budget, welcoming visitors and new employees to the 
workspace, organizing activities in the office and off-site events for office personnel, 
planning and booking travel for staff, managing internal communications, acquiring office 
furniture, and more. 
Office Manager is a specific job title whose work will vary greatly from company to 
company, depending on the industry, the size of the company, and the make-up of other 
departments. Office administration will differ greatly depending on whether you work for 
a large or small business. 
There are a number of alternative titles for the role such as: 

 Workplace Manager 
 Head of Office Operations 
 Facility Manager 
 Administrative Director 

Office manager skills 

Soft skills are vital for a good office manager, above all else. Office managers often serve 
as a go-between for different departments, be it communication between upper 
management and staff, between HR and employees, or between the company and other 
workers in the building, such as custodial staff. Read our article on how to improve your 
office management skills and what tools you should master to further your career. 
This is not to say that technical competencies are unimportant, these can certainly add 
value. Especially as the office manager role continues to change over time, technical 
experience and education, such as a capacity to use software or an understanding of labor 
laws, grow in importance.  
With that said, the main soft skills and duties of an office manager should focus on are: 

 Organizational skills and time management skills, as the quantity and variety of 
demands on the role means that only the best-organized office managers will really 
perform well.  
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 Interpersonal and leadership skills, which will allow them to maintain happy 
employees, make a good first impression with visitors, and diffuse tense 
disagreements between teams. You will also need to work with lots of different 
departments, including administrative staff, secretarial roles, finance teams, 
human resources, and more.  

 Communication skills, so team members have a clear idea of what senior 
management is planning for the future, and what they expect from the staff. This 
will likely require some PowerPoint skills.  

 Negotiation skills, to improve any agreements the company may have with 
outside providers. For example, if you’re changing office buildings, you’ll need to 
have negotiation skills and decision-making abilities to get the best deal for your 
company.  

What are the typical types of office management? 

No matter the industry, there is room for an office manager position in most companies. 
However, the tasks assigned to this employee can vary greatly and may depend on a 
number of factors, not least of all the industry in which the company operates.  
The most common types of office manager are: 

 Corporate office managers 
 Legal office managers 
 Medical and dental office managers 
 Virtual office managers 

Corporate office managers 

In a corporation, office managers’ chief tasks surround improving the performance of the 
departments working within the office. The environment in which employees work 
should be appropriate to the work they are doing, and also to the branding and culture of 
the company itself. 
Within corporate settings, office managers may be involved with the work of other 
departments, such as human resources (HR & staffing), finance, and even marketing. 
For large corporations, it is common for there to be multiple branches spread across the 
country, or even around the world. In this case, at least one office manager is usually 
hired to oversee the tasks at each branch, with each reporting to a more senior office 
manager, generally employed at the head office, who manages the overall operations of 
office management. 
Legal office managers 
Legal offices employ office managers to manage working environments for staff and clients 
of the company. Their responsibilities differ between offices, but the legal office managers 
are often tasked with handling incoming clients and other visitors to the building, dealing 
with administrative assistants, handling staff payroll, and working on projects in tandem 
with the HR team. 
One of the main responsibilities for a legal office manager is the office space itself. As these 
are often where current and prospective clients come to speak with their legal council, the 
working space must give the highest sense of professionalism.  
Working as a legal office manager generally requires an understanding of the law, 
particularly in any field in which the company specializes.  
Medical and dental office managers 
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In the healthcare industry, office managers are often employed in hospitals, doctor’s 
offices, and dentist’s offices. In this case, office managers are generally required to have a 
certain level of relevant industry knowledge. This can include education in healthcare or 
anatomy, lab procedures, and even the law surrounding healthcare. 
An office manager working in healthcare is still put in charge of the working space, with a 
focus on creating an environment that is suitable for patients. Above all, strict cleanliness 
is vital throughout the facility. 
Patients’ comfort and feeling of ease is also important, so waiting rooms and operating 
rooms should have a calming and safe aesthetic, and staff must be encouraged to give a 
similar presence when dealing with patients. 
Additional tasks for office managers in healthcare may include dealing with the 
confidentiality of patients, ensuring proper practices for disposing of medical waste are 
followed, and possibly even supervising medical assistants. 
Virtual office managers 

Many companies don’t have a need for an office manager working full-time at a single 
location. The company may be too small and unable to afford someone for the position, 
or they may only have a few hours of work per week to take care of. It’s also becoming 
more common to run a business with a large portion of employees, or perhaps even the 
entire staff, working remotely. 
For companies like these, the role of a virtual office manager is becoming quickly more 
common and vital to success. It allows important tasks to be properly handled by an 
office manager without forcing the company to change to a more traditional setup.  
The responsibilities of a virtual office manager will depend highly on the company itself – 
what the company needs, how many hours the employee is expected to work per week, 
the company culture, and so on. But, most of the responsibilities of the corporate office 
manager will still apply. 
The biggest difference with a virtual office manager is the lack of physical space to 
manage. It may seem redundant to have an office manager with no office, but this is a 
misconception. 
With a virtual office, the office manager must still juggle most of the tasks of a traditional 
office manager – such as organizing travel, planning offsite company events, helping with 
projects for other teams, implementing videoconferencing tools – but now this requires 
dealing with teams spread across different locations. 
And this may even mean different countries in totally different time zones. It may seem 
counterintuitive, but employing an office manager may be most important when there is 
no physical office at all. 
How is the concept of office management changing? 

Office management has evolved considerably in recent years. These employees have 
transformed from receptionists and secretaries tasked with making photocopies and 
relaying messages, now to more strategic-level roles in the company. 
Many office managers now meet with senior staff regularly as they are charged with 
important decisions such as office location, productivity improvements, and more. 
Modern office management 

Modern office managers are expected to have a more direct impact on the revenue 
generation of the company. They are tasked with planning, executing, and analyzing their 
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own projects just as other departments in the company – all with the aim of bringing real 
value to the company. 
More and more, office managers are becoming involved with the work of other teams – 
such as helping to craft large marketing and branding campaigns, helping to plan 
company-run events, and aiding the HR team with projects aimed at improving employee 
satisfaction and productivity. 
The office manager can typically be tasked with finding and establishing 
suitable employee wellness programs, usually in coordination with HR. 
With this extra responsibility and room for career growth comes higher expectations. A 
successful office manager should have experience and knowledge in the various software 
used by the company. 
Project management skills are a must, as the role becomes more important and self-
starting. It’s important they keep updated with industry knowledge, such as trends, 
regulations, and news. 
An office manager may be asked to wear many different hats. Not only may two 
companies have a very different set of expectations for the position, but the 
responsibilities for an office manager at a company may change significantly from week 
to week. 
If other departments start projects that need help, or if a large company event draws 
near, or if sudden change for the industry takes place, then the office manager may be 
asked to drop their current tasks and help pick up the slack. 
What are the main functions of office management? 

An office manager’s responsibilities within a company will depend on a lot of factors, 
such as the industry, the size, and the culture of the company. So this list will focus on 
the typical responsibilities of a modern office manager in a corporate office. 
The typical fields of office management can be broken down into: 

 The office space 
 Employee management 
 Event planning 
 Employee travel 
 Facility staff 
 Internal communication 
 Safety and security 

The office space  

In a standard office management role, this is often the key responsibility. Striking a 
balance between form and function is important – ensuring a positive atmosphere, while 
being conducive to high performance. 
Example tasks:  

 Ensuring the aesthetics of the office space matches the brand and the people 
working there. 

 Setting the culture, norms, and organization of in-office working. 
 Creating an appropriate working space for employees to improve productivity and 

morale. 
 Replacing broken, used-up, or obsolete equipment. 
 Handling the meeting spaces used by different teams. 
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Employee management 

Often, although not without some controversy, the office manager will be asked to help 
HR with the rest of the staff. And in small, up-and-coming companies, there may be no 
HR team at all, and the entirety of these responsibilities can fall to the office manager. 
In these cases, a general office manager should not be considered, but rather someone 
with extensive knowledge of employment law should be brought in. 
In any case, involving the office manager in HR responsibilities may include softer tasks, 
such as hearing concerns and feedback from staff, as well as tasks related to wages and 
benefits. 
Example tasks:  

 Managing perks and wellbeing programs. 
 Understanding how employees in the office work best, and what their needs and 

wants are. 
 Working with HR on recruitment and hiring. 
 Administering the payment and promotions of existing staff 
 Helping to create external motivation for employees. 

Managing facility staff 

Company employees are often not the only people working within the office space. 
External contractors and employees of the rented building will often be present in the 
office, and their management generally falls within the purview of the office manager. 
Example tasks:  

 Working with people who work in the office space, but who aren’t employees of 
the company, such as maintenance workers, custodial staff, or delivery drivers. 

 Communicating with the landlord or property manager. 
 Establishing relationships with external supplies. 

Event planning 

Managing the events taking place within the office space falls clearly within the domain 
of an office manager. This often also extends to events outside the office, be they team-
building employee events or ones involving clients and prospects. 
Example tasks: 

 Planning and organizing holiday celebrations at the office. 
 Managing off-site trips, like workshops, team-building events, retreat, and so on. 
 Dealing with venues, vendors, booths, and itineraries. 

Employee travel 

Managing the travel of employees is a huge part of modern office management. There 
are a lot of moving parts to consider, and the workload for travel management can be 
immense and very chaotic at times. 
Unforeseen complications with travel can have damaging consequences for a company if 
not handled right, as it may mean missing out on an important industry event, or losing a 
big prospective client. 
Example tasks:  

 Managing a travel budget for employees. 
 Dealing with flights, transport to and from airports, and accommodation. 
 Handling emergencies, such as cancelled or missed flights. 

Internal communication 
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Communication between senior management of a company and the working employees 
is extremely important for the productive work of a company. The management of this is 
often tasked to the office manager. Even if a company has a communications 
department, or communication specialists within the marketing team, the office manager 
may be asked to help with this type of work. 
Example tasks:  

 Communicating the needs and the goals of the company to its employees. 
 Updating employees on company changes, such as branding, hirings, and 

departmental updates. 
 Hearing and taking into consideration the concerns and needs of employees 

Safety and security 

The importance of creating a safe work environment cannot be understated. This means 
the working conditions for employees must be safe, and the company should also be 
secure from potential external threats. 

 Organizing and undertaking drills, e.g. for fires or active shooters 
 Ensuring the building is locked up at night 
 Managing security teams or CCTV 
 Distributing and tracking keys and passes for employees and guests 
 Ensuring access to proper safety gear 
 Approving tools and materials to be used by the right employees 
 (In conjunction with IT) Data security 
 (In conjunction with HR) Dealing with inter-employee harassment, discrimination, 

or threatening behaviour, displays of anger and frustration from staff 
The role of the admin professional continues to evolve, with more demands on the 
position every year. One of the best ways to compare your skills to the market is to look 
at office manager job descriptions, you will see the high expectations many companies 
have. 
Companies can see the direct impact of office managers on their working environment, 
and so the role is not likely to disappear any time soon. For office managers, the role is so 
demanding that it can lead to senior positions in the company from Chief of Staff to even 
Chief Operations Officer. 
12 tips to become a great office manager 
The Office Manager role is changing. There’s no doubt about it. The role was already 
beginning to shift before the outbreak of the coronavirus pandemic. However, upon 
returning to the physical office or virtual office, the role of the office manager is 
evolving.   
Office Managers are no longer there to make sure people wash their dishes after lunch, 
to buy office supplies, or to fix the broken printer. They are now essential for employee 
happiness, safety, retention, and more.  
This article will explore the qualities, skills, and tools that a great office manager needs to 
excel in their role this year and beyond.  
How to become a Great Office Manager  
Often referred to as office administrators, office coordinators, or office operations 
managers, these professionals are often the first point of contact for anyone in or out of 
the company. Their responsibilities vary drastically, from building a great work 
environment to helping onboard a new hire to acting as executive assistants.  
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That’s why an office manager’s workload piles up fast. Along with keeping the office 
space functional and dynamic, they also need to manage staff movements, travel, 
expectations, the list goes on. There’s a mountain of expectation on an office manager’s 
role, and many employees have their different ideas of what an office manager should 
actually do.  
Becoming an office manager is highly rewarding, not only by fulfilling people’s 
expectations of you but exceeding them. You can hold yourself accountable for, and 
become a key contributor to, the success of a business and its employees.  
Setting clear expectations to become a good office manager 

1. Be the most organized person in the company 

Organizational and time management skills are at the top of the list and for a good 
reason. It’s no longer just about creating a new filing system. An office manager needs to 
know everyone’s schedule, as well as their own. The role requires juggling co-workers, 
3rd party suppliers, long-term business plans, as well as day-to-day operations. If 
organizational skills aren’t there, work will pile up fast. 
2. Be a great communicator  

You need strong communication skills to thrive in an office management role. It helps to 
avoid mistakes, resolve conflicts, and give clear directions. An office manager is one of 
the few roles within a company that has communication with absolutely everyone, from 
new employees to the C-level executives. Make sure you’re an excellent communicator, 
and it will make the role a whole lot easier.  
3. Be innovative at problem-solving  

The company knowledge that an office manager accumulates over the years is unrivaled. 
They help a business through its most challenging times, and it all comes down to 
excellent problem-solving qualities. The longer you’re in the position, the more you’ll find 
you are being turned to from all seniority levels for your advice on challenging employee 
situations. 
Problem-solving doesn’t stop there though. An office manager will often be tasked with 
the responsibility to make something happen with little or no budget. The role requires 
you to be innovative with the resources you have and make things happen regardless of 
the problems you may face.  
4. Be empathetic 

Every office manager needs to be able to understand and empathize with all team 
members. As a core part of the team with a good overview of everyone’s working 
situations, an office manager is often the voice for a large majority of employees. You’ll 
need to be able to lead with empathy and charisma to make sure everyone is heard and 
understood.  
An office manager will often find themselves on wellness or positive initiative 
committees. They’ll need to be able to take the reins on empathetic projects, applying a 
business mind with a kind heart, and managing expectations alongside realities.    
Keep learning to become a better office manager  
5. Develop your negotiation skills 

An office management position comes with a certain amount of negotiation involved. 
You’ll be responsible for a budget to keep the day-to-day office ticking over; as well as 
larger budgets for company events, conferences, and more in your daily routine. It’s up 
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to the office manager to make the most of a budget and maximize what the business can 
get for the money it has. 
Negotiation skills will also come in the form of peace-keeping. A diverse business comes 
with diverse personalities and it’s not uncommon for people to clash heads from time-to-
time. These confrontations often fall on human resources and the office manager to 
resolve and find a peaceful solution that fits everyone.  
6. Always work on your business knowledge  

Whether it is budgeting skills, financial planning, recruitment strategies, or management 
theory, these skills will put you in a position to advance quickly. The modern office 
manager can have a lot of contact with senior management, having some financial or 
business know-how in your back pocket will help you get your ideas implemented and 
improve your general efficiency. 
7. A little legal knowledge goes a long way 

Office managers are often responsible for dealing with external suppliers or office 
contracts solely on their own. It’s handy to be able to deal with these contracts with 
some legal knowledge. You’ll be better equipped to understand the small print, when or 
how the contract can end, and how the business can maximize results with its spend.  
8. Understand emotional intelligence  

Having great interpersonal skills is critical in being able to manage and be managed 
within a team. Harnessing it massively helps your people skills and ensures that your 
team or teams have the best chance of success. It also helps to have a positive attitude 
that makes people feel comfortable to speak to you about anything.  
It’s been found that companies that harness emotional intelligence tend to have better 
customer loyalty and higher employee engagement rates, which leads to greater success 
for the business. By embarking on an emotional intelligence course, you’re better 
equipped to connect with employees and harness emotions for greater productivity.  
Tools to master to be a successful office manager  
9. Become an excel wizard 

Office managers are responsible for data entry and storage, administrative and 
managerial support, accounting, budgeting, data analysis, research, reporting, and 
forecasting. The list is extensive and doesn’t end there.  
Excel will become an office manager’s best friend, but you need to be able to use it to its 
fullest potential. There’s no use having a basic knowledge of excel. Learn how to format 
and make the most of the tool and, in turn, make the role (and your workday) easier. 
Being an Excel wizard definitely needs to form part of your skillset.  
10. Learn bookkeeping software  

Office managers often have a budget to look after and can be tasked with supporting 
other departments in looking after their numbers too. The role can also be responsible 
for setting up company-wide processes to ensure departments are keeping track of their 
budgets in a way that is understood by everyone.  
The good news is that there’s plenty of bookkeeping software available. It will be down 
to the office manager to find and onboard the software that’s the best fit for the 
company. 
11. Use project management software 
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The same can be said for project management software. Whether it’s team-building days, 
town halls, new software integrations, there will always be projects to manage in running 
a business. These projects often fall into the hands of the office manager.  
Master project management software that you can introduce with the role. Keep track of 
tasks, people, and ensure that any project assigned is completed as efficiently as 
possible. 
12. Become a travel management guru 

Phoning up a corporate travel agent is now a little old school, and expensive for the 
company. Also, using Skyscanner or Kayak doesn’t give employees the support they need 
in the journey. Train yourself up on travel management software and impress senior 
management with your budget control and time efficiency. Most travel software lets you 
digitize your travel policy to automate your company’s rules around spend and travel. 
How to write an office manager job description 
Office Management roles have changed, they are no longer what they used to be. Today, 
any office manager is expected to be as adaptable and global-minded as some of our 
world’s best businesses.  
When you’re looking for an office manager you need someone that is not only organized 
and has excellent people skills, but someone with great know-how for remote work 
tools, legal knowledge, and has a global business mindset.  
In this short article, we’ll guide you through the essentials you need to involve in your 
office manager job description to attract the talent your business needs.  
Specialized office managers 
Before we dive into office manager job descriptions and responsibilities, we need to 
establish the different kinds of office managers out there. Many businesses can hire a 
regular office manager and will have success. Modern office management roles require a 
degree of specialization, and some companies require office managers to be more 
industry-specific. 
Medical & Dental Office Management  
A healthcare office manager differs slightly. This medical office management position 
comes with the regular responsibilities of leading business operations, overseeing 
operational staff- in this case, receptionists and billing technicians- as well as helping with 
local marketing initiatives. However, healthcare office managers often need to ensure 
the correct coding is used by staff when designating a diagnosis or results.  
There’s no degree or qualification required, although there is a nice-to-have certification 
available: Professional Association of Health Care Office Management (PAHCOM).  
Law Office Management 

Law office managers may perform some of the same responsibilities as legal secretaries, 
paralegals, and legal assistants- depending on their education. As well as the standard 
office management responsibilities, law office managers also help to recruit attorneys, 
maintain the library and office records, and perform legal research.  
There may be some education or and training required, depending on the responsibilities 
the law firm is looking to fill.   

Office manager job description example 
Writing an Office manager intro paragraph 

https://www.healthecareers.com/article/career/medical-office-manager-job-description
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The introduction paragraph to your office manager job description should dive into your 
company mission and vision. You’ll want to find someone as passionate about what your 
business does as you are. 
 If you can, try to go into describing your employee culture, life at the office, and the type 
of qualities you’re looking for in a candidate.  
Office manager job responsibilities & requirements 

 Support/manage company day-to-day operations, systems, and staff 
 Maintain office services by working with internal or external suppliers  
 Payroll support 
 Support staff retention and onboarding 
 Planning & Implementing internal systems and procedures 
 Designing & Implementing office policies  
 Staff reporting and trend watching presentations for leadership 
 Coaching, counseling and disciplining employees where necessary  
 Company event budgeting & management 
 Greeting visitors in-office and over the phone 
 Coordinating all staff travel including, flights, hotels, car rental, insurance, and 

budgets 
 Working with contractors & vendors  
 Support in local marketing initiatives 

Work hours & benefits 

It’s important to manage expectations here while keeping the potential candidate excited 
for the role. Be clear with the office hours the candidate needs to be available. Also, note 
down any travel required.  
Balance this out with your company perks. Do you offer free lunches, gym memberships, 
company retreats, or other wellness programs?  Put all of that information in this 
section.  
Office manager skills & qualifications 

Each company will be looking for its own set of skills and qualifications from an office 
manager, selects those that are specific to your role.  

 Microsoft Office: Excel, Word, Powerpoint, Outlook, Teams, etc   
 Google Suite: Drive, Docs, Gmail, Sheets, Calendar, etc 
 Remote tools: Slack, Zoom, Skype, Google Hangouts, etc  
 Desired Bachelor/High school diploma/GED 
 Language proficiency   

Desirable but not essential skills & qualities  

Again, these will vary depending on your business and the type of candidate you’re 
looking to hire. If your business tone allows it, feel free to be a little playful towards the 
end of this list and show that you’re human.  

 Knowledge of administrator systems, responsibilities & procedures  
 Bookkeeping, travel & project management software knowledge 
 Analytical minded & results-driven 
 Thrives under pressure  
 Extra languages  
 Travel booking experience  
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 Can bake a mean carrot cake 
Other titles for an office manager 

We’ll wrap things up with other names for an office management position. It’s good to 
get these into your job description and encompass them into your recruitment strategy if 
you’re hoping to attract as many great candidates as possible. Not everyone is searching 
for “office manager” jobs.  
Some other titles you can consider are:  

 Workspace manager  
 Employee wellbeing manager 
 Area Manager (Office) 
 HQ Manager  
 Internal Office Manager  
 Workplace manager  
 Administrative director  
 Business Manager 
 Wellbeing manager  
 People and Happiness Manager  
 Operations Manager 

 

 

Employee wellness programs: ideas and implementation 

Employee wellness is now deemed as business-critical if a company wants to attract and 
retain top talent. Employee Wellness programs have the power to reduce company 
healthcare costs by 127%. 
Plus, 80% of employees with robust wellness programs feel more engaged, and 
companies with engaged employees can be up to 21% more profitable. With numbers 
like this, any business owner can’t ignore the emphasis their company needs to put on 
wellness and its importance for employees and business success.  
Employee wellness doesn’t stop there. If you’re hoping to lift global standards around 
mental and physical health, then it needs to start in the workplace. In this article, we’ll 
explore the whats and whys behind employee wellness programs, where wellness 
programs fit in for companies of different sizes and types. We’ll also explore the various 
categories of wellness programs available, and how best to implement them.  
Employee wellness programs are very different for every business, and they often come 
down to your mission, vision, and values. Consider what your company is trying to create. 
How do your employees need to feel to help you get there?  
By reading this article, you’re already one step closer to creating a healthier workplace 
and world for your employees and beyond.  
 
What is an employee wellness program? 

There are five core pillars of wellness. Each of these wellness areas encompasses 
different tactics that can help to lift your company and its workforce. 

1. Physical  
2. Social 
3. Mental  

https://join.travelperk.com/reglp-cn-c035-covid-controller-checklist.html
https://join.travelperk.com/reglp-cn-c035-covid-controller-checklist.html
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4. Financial  
5. Community  

  
In short, an employee wellness program is a regular effort to encourage a healthier 
lifestyle for employees. It is the creation of healthy habits within the workplace that are 
explored through one of the five pillars above. These programs come in many shapes and 
sizes, and we’ll discuss many of them throughout this article.  
Any wellness program needs to be driven by key stakeholders within the business, and 
it’s project management often falls into the hands of someone within HR or Office 
Management positions. However, a successful wellness program is initiated from the top-
down and led by example. Leadership needs to be fully on board with any wellness 
program and should be at the forefront of every wellness initiative.  
Why is employee wellness important? 

A successful wellness program can help businesses across the board. Take a look at some 
statistics for implementing a wellness program within the workplace:  

 Double employee engagement rates  
 Reduce sick days by up to 6 days per year  
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 91% of workers at companies that support wellbeing feel motivated to do their 
best  

 Organizations with higher levels of engagement are 22% more productive 
 For every dollar companies spend on wellness, they can save $2.73 in reduced 

absenteeism (Wellsteps) 
 Create 50% higher revenue per employee  
 Reduce stress and increase positive communication among employees  
 20% of employees would trade a pay rise for better health coverage 

How to select the right employee wellness program 

 
There are many wellness programs out there. It can be overwhelming trying to select a 
program that’s right for your business, and more importantly, your employees. Whether 
you choose one wellness program or decide to invest your time and effort into many, 
what’s important is that you’re proactive in creating a healthier working environment.  
There are a few things you need to consider when selecting the right wellness program.  
A change in culture 

First thing’s first, consider that you’re changing company culture. You’re about to start 
creating a culture of wellbeing. Changes in culture come from changing habits, and we all 
know that habits can be the hardest of things to break.  
When you’re considering implementing a wellness program, really take a moment to 
think about how this will evolve your company culture, and what habits you’ll need to 
break among your workforce along the way. Perhaps it’s better to start with an easier 
habit to break before tackling larger, more inset habits. 
A demand in resources 

Secondly, you need to consider your resources. What do you have available to create a 
culture of wellbeing? Consider the stakeholders you need to be involved. Also, take into 
account whether you have a budget for your department’s efforts or will need to get one 
approved. What goals are you trying to reach, and how will your wellness program help 
you hit them? 
These factors that you need to consider when building out any wellness program often 
comes down to the size or structure of your company.  
With that being said, let’s dive into some employee wellness program ideas for different 
size businesses that fall within the social, financial, and community pillars. We’ll go on to 
explore physical and mental wellness ideas later in this article.  
 
Employee wellness program ideas for small businesses 

If you’re working at a startup or a relatively small business, you have a few advantages. 
Habits are often not hard set, your workforce is agile and adaptable, and people expect 
your culture to be ever-evolving.  
People often know that funding and financial resources are not always on a startup or 
small company’s side. There’s no harm in implementing those wellness programs that are 
low-cost; they can still be high reward. Types of wellness programs you can consider are:  
Social 
Buddy systems, culture onboarding, free staff team building activities, religious rooms, 
and cultural inspired hangouts. 

https://www.wellsteps.com/blog/2020/01/02/workplace-wellness-statistics-wellness-stats/
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Financial  
Company stipends, self-study hours, discounts on courses, financial resources, company 
shares options. 
Community 
A positive initiative committee, positive impact initiatives.  
Employee wellness program ideas for large corporates 

Corporates are often in a better position to be able to source funding for wellness 
programs. However, getting buy-in can be tougher. Depending on the size, and often the 
age of your corporate will determine how easy it is for you to get your initiative pushed 
forward.  
Take into account that you’re creating new work lifestyles that are out to break 
old, comfortable habits. Buy-in from employees themselves may be tricky as well. Types 
of wellness programs for corporates can be:  
Social 
Mentor or buddy programs, cross-department meet & greets, company-wide team-
building events. 
Financial  
Financial wellness enables other aspects of health management. Annual bonuses, 
contributions to savings, pension plans, yearly reviews, money management & financial 
literacy classes, company discounts and perks, student loan support.  
Community  
Company donations in names of best-performing employees, global green initiatives.  
Employee wellness program ideas for remote employees 
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Remote companies need wellness programs too. Being remote is a benefit, sure, but 
there’s more to it. Remote options certainly help to attract talent and send your talent 
casting net global rather than within a certain radius of your office.  
However, remote employees also have more options when they’re selecting a company 
to work for. It means you’ll need to stand out to attract and retain the talent that will 
help your remote business thrive, and this can be done through your wellness initiatives.  

  
Some wellness options for remote companies are:  
Social 
Social wellness is essential for remote employees. 70% of remote workers feel left out of 
the traditional workplace.  
Provide your employees with opportunities to connect, encourage time online that 
doesn’t revolve around work, and give them reasons to come together through a 
wellness initiative. Consider book clubs, offline retreats, online coffee & breakfast breaks. 
Financial  
Tech stipends, free-time or holiday stipends, home-office support, self-education time 
and support. 
Community  
Another big one for remote employees; they tend to be mission-driven and choose their 
employers as much as their employers choose them. Ensure your company has a 
wellness program that enables remote employees to be a part of giving back from afar. 
Pick causes that are global, not location-specific. 
 
Wellness program ideas for employees who travel 

Business travel may seem glamorous to those members of staff new to the task, but it 
can be tiring both physically and mentally for the employees who have to do this 

https://smallbiztrends.com/2020/02/remote-workers-are-lonely.html#:~:text=20%25%20of%20Remote%20Workers%20Struggle%20with%20Loneliness&text=More%20people%20are%20working%20remotely,Report%20by%20Buffer%20and%20AngelList.
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consistently. Travel wellness is becoming essential to many companies’ travel policies. In 
fact, the quality and frequency of business travel directly affect the retention rate of 
employees. Given that many employees who travel are valuable sales or account 
management staff, it is no wonder that many companies have put additional perks and 
wellness programs in place for these staff. 
Bleisure travel 
Bleisure travel, i.e. extending a work trip to include vacation days, so to take advantage 
of the destination. Some companies permit employees to extend their stay and either 
take vacation days or have one day as a free vacation day. Bleisure has become a new 
corporate standard and has shown to keep employees motivated for upcoming trips. 
International Gym memberships 
For traveling employees, fitness can be key to their general wellbeing, made difficult by 
having their routine changed by the demands of travel. Some companies such 
as AndJoy or TrainAway, offer the perfect solution for international travelers. 
Healthy food subsidy 
Another way to encourage employees to eat right when on the road, is to offer extra 
budget for meals in the healthy range. Some employers simply ask the employee to tag 
the meal as a health choice in their expenses in order to receive the extra budget. This 
nudging effect, promotes more healthy meals and less fast food 
Mental health wellness programs for all company types 

Mental health is at the forefront of employer branding today. People need to know 
you’re supporting mental health issues and following through with your word. Ensure 
that your company and its employees are as equipped as they can be to support mental 
health among each other.  
By actively enforcing mental health programs into your workplace, you will be able to:  

 Reduce employee health care costs 
 Reduce sick days  
 Achieve greater employee productivity  
 Reduce disability and compensation costs 
 Improve general morale and employee loyalty  

Some useful resources when considering a mental health wellness program:  
 Workplace Health Assessment with The CDC  
 Final Rule on Employer Wellness Programs and the Genetic Information 

Nondiscrimination Act  
 The Health Insurance Portability and Accountability Act 

A few mental health wellness programs you can consider: 
1. Mental health first aid courses 

This two-day course from MHFA England teaches managers to recognize signs that an 
employee may need mental health support. The course is designed to give your company 
a first-aid style response.  
2. Free counseling services 

The Employee Assistance Professionals Association provides various subscription-based 
services to companies, giving employees access to a wealth of health professionals for 
free.  
3. Wellness action plans 

http://www.andjoy.life/
https://www.trainaway.fit/
https://www.britsafe.org/products/mental-health-first-aid/
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Mind is a UK based charity devoted to providing help and support to anyone experiencing 
mental health problems. They have created:  

 A wellness action plan for line managers 
 A wellness action plan for employees  

 
4. Book clubs 

Book clubs are a great way of supporting the mental wellbeing of your employees. They 
are best coupled with a book or kindle stipend and managed by one person. Consider 
building a book club on slack and hold monthly get-togethers. A book club encourages 
positive communication between employees and builds a sense of comradery.  
5. The act of being grateful  

An easy win but often overlooked. Encourage the act of being grateful among employees. 
Make sure this is part of their daily or weekly culture- to be thankful for another 
employee or external stakeholders. Highlight great work and let leadership sing about 
success that is not only based on numbers but kindness.  
6. Emotional intelligence classes 

  
Emotional intelligence is an incredible tool in the workplace. It will enable managers to 
make the most out of their team by giving them the support and resources they can 
identify are needed. Emotional intelligence dives into the psychology of team-building 
and people management.  
7. Fight Seasonal Affective Disorder  

https://www.mind.org.uk/workplace/mental-health-at-work/taking-care-of-your-staff/employer-resources/wellness-action-plan-download/line-managers-guide-form/
https://www.mind.org.uk/workplace/mental-health-at-work/taking-care-of-yourself/guide-to-waps-employees/employees-guide-form/
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We don’t all need company retreats to be booked in when the weather is getting us 
down. Consider other ways you can help your workforce fight SAD. Introduce therapy 
lamps in offices or find other ways to make sure employees get the daylight they need to 
live a healthier lifestyle. 
8. Screen-free hours 

Going screen-free is unheard of in many workplaces. A screen-free initiative needs to be 
introduced by line-managers and is especially crucial for remote companies. We all need 
offline time. We need time to unwind and to come back to work refreshed.  
Let your team know that it’s okay to turn off notifications and set strict times that they 
are not allowed to touch their laptops; they’ll thank you for it.  
9. Some useful mental health wellness software companies are:  

 Limeade ONE : Limeade ONE brings together employee wellbeing, engagement, 
and inclusion in a mobile-first experience. 

 Virgin Pulse: Virgin Pulse provides culture-first technology solutions designed to 
grow with your business and wellbeing needs. 

 Training Amigo : Training Amigo gives your team the power to easily manage 
engagement, wellbeing, and recognition in one HUB. 

  
Fitness wellness programs for all companies  
ASICS have hit the nail on the head with their slogan sound mind, sound body. One helps 
the other, and one does not come without the other. By introducing a fitness wellness 
program to your business, you’ll ensure healthier and happier employees.  
Some ideas you can consider implementing:  
1. An office sports league 

Find a sport that a few of your employees play – or if they don’t play, it will be interesting 
too. Create a league within that sport with other companies in the area. Create a 
volleyball, football, or even ultimate frisbee league.  
Keep your employees fit, encourage team-building, and provide social networking 
opportunities while you’re at it.  

https://verilux.com/collections/happylight-therapy-lamps-boxes
https://verilux.com/collections/happylight-therapy-lamps-boxes
https://www.limeade.com/en/limeade-one/
https://www.virginpulse.com/en-gb/
https://trainingamigo.com/
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2. On-site sports facilities  

This largely comes down to the budget and resources you have available. On-site sports 
facilities like gyms are a huge wellness benefit. However, if you’re not in a position to 
implement these, consider gym discounts, online meditation or yoga classes, or access to 
other sports facilities near your employee’s homes.  
3. Walks and Talks 

An easy one to implement, no matter what type of company you have. If these are part 
of the company onboarding and training, then your employees will continue to host 
them without further encouragement. Walking meetings are a great initiative to keep 
minds fresh and legs young.  
4. Access to healthy ways of travel 

Try to eradicate driving to work where you can. Consider introducing a wellness benefit 
that includes free or discounted access to other forms of transport like bikes, scooters, 
skates, or even a good pair of walking shoes.  
 
5. Workout time  

Everyone works differently. If you can be flexible towards people’s preferences, then do 
so. No one likes the gym rush at 6 pm, and few of us are actually morning birds, despite 
what we say. Give your employees time to workout in the week. Flexible hours or 
designated gym times are a great way to promote healthy living.  
6. Fitness challenges  

Challenges are an excellent way to combine any fitness wellbeing program with a little 
competition. It takes out the need to continually remind people of your initiative by 
putting people in competition with each other.  
Smart technology, like apple watches that can track steps, is a great place to start. Or, 
consider working towards a greater goal with an app like the couch to 5k app.  
7. Healthy Eating  

Healthy eating is easier said than done, especially if someone doesn’t feel they have the 
time or the knowledge to prepare healthy meals. Consider how your company can 
support this. Can you provide nutritional advice or healthy food workshops? Are you in a 
financial position to provide free, healthy food? What works best for your employees? 
8. Some useful fitness wellness software:  

 Grokker: Grokker empowers your workforce to take control of their wellbeing — 
no matter where they are. 

 Incentfit: Rewards your employees for living well. 
 CoreHealth: Total Well-Being Technology. 
 Pacer for Teams: Your team’s step challenges made simple.  

How to implement an employee wellness program 
Deciding to implement an employee wellness program is one thing, but implementing it 
is something else entirely. Follow these steps to ensure you have the best chance of 
implementing a successful employee wellness initiative.  

1. Perform a company-wide qualitative and quantitative analysis  
2. Set KPIs and goals  
3. Get Key stakeholders on board 
4. Create a wellness committee  

https://apps.apple.com/gb/app/one-you-couch-to-5k/id1082307672
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5. Get a budget 
6. Identify external partners to support your initiatives 
7. Create incentives and rewards for employees 
8. Form a communication plan and onboarding 
9. Evaluate and optimize 

How to measure and analyze an employee wellness program 
There are different ways to measure the success of your wellness program, both 
quantitative and qualitative. It’s something you’ll need to decide on when you’re creating 
KPIs and goals for your initiative.  
An employee feedback survey is a great way to get your ear to the ground and find out 
the effects of your efforts. If you’re using any software, then that software will also come 
with reporting tools you can utilize.  
Going back to the beginning of this article, look at the hard numbers of your business. 
Have you seen a notable increase in productivity or employee engagement? Have your 
health care expenses decreased, job application rates increased, or is the business overall 
more profitable?  
Many factors can come into consideration when you’re summing up these numbers, so 
what’s most important is you track the dates you implement specific actions and 
consider the lead and effect time it will take to show in your figures. Report smartly, 
create actionable insights, and keep your employee wellness programs thriving. 
Summing up 
Employee wellness varies dramatically from company to company. The task of evaluating 
and implementing an employee wellness program is sometimes carried out by office 
management staff, the Human Resources Department, or professional talent recruitment 
teams. Even though the employee wellness still has a wide variety of owners and forms, 
it is still present in almost every business today. Simply put, the few businesses that do 
not consider employee wellness a priority are setting themselves up to be out-recruited 
and eventually out-competed by their competition. 
What does an office assistant do? 
Do you enjoy speaking to a variety of people? Would you like to support a range of teams 
in hitting their goals? Would you like a job where no two days are the same? If the 
answer to these questions is yes, then the role of office assistant could be a great fit. 
According to Indeed, the average salary for an office assistant is $15.42 an hour, which 
equates to approximately $32,000 per annum.  
Depending on the size of the organization, an office assistant role is generally considered 
an entry-level position. However, in larger companies, the job might come with more 
responsibility and an hourly wage of up to $30. Plus, as you gain experience, there may 
be scope to expand your duties and move into an office manager role in some 
organizations.  
But what is an office assistant, and how does their job differ from other positions like 
executive or administrative assistant? Read on for more details on the duties and 
responsibilities of this position, plus the pathways to landing your first job as an office 
assistant!  
What does an office assistant do?  
The primary function of office assistants is to help businesses to keep their workspace 
running smoothly. While an office assistant will provide administrative support such as 
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diary management and coordinating travel schedules, their role differs slightly from that 
of a virtual assistant or executive secretary.  
Their role is predominantly an operational one, supporting the company to provide a 
functioning office setting for their business. It’s safe to say no two days as an office 
assistant will be the same! However, some typical responsibilities can include;  
Typical office assistant duties: 

 Maintaining office supplies and liaising with vendors.  
 Keeping communal spaces in good order throughout the day.  
 Greeting visitors and answering phone calls when needed.  
 Proofreading and distributing materials like agendas and minutes.  
 Note-taking in meetings.  
 Managing any general business email inboxes, ensuring communications reach 

the necessary departments.  
 Assisting with travel arrangements.  
 Scheduling appointments and managing diaries for executives.  
 Coordinating office events when needed.  
 Helping with any bookkeeping, data entry, and general administrative tasks 

required.  
 Assisting new starters with getting settled and with any office equipment issues.  

What skills do you need as an office assistant?  
As we have seen, being an office assistant has a wide range of responsibilities. So what 
competencies and soft skills are needed to be successful in this role? Below you will find 
a rundown of the most important abilities you will need to possess as an office assistant.  
Check out our comprehensive list of qualities to cultivate if you want to be the best office 
assistant.  
To be flexible. 
As an office assistant, your role is relatively flexible and encompasses a variety of 
different duties. A good OA is a team player with a can-do attitude who is willing to take 
on tasks as and when they crop up to help the business run smoothly.  
As an office assistant, there will be few tasks beyond your remit. So if you prefer to have 
a more defined list of responsibilities, this might not be the role for you. Time 
management is another vital skill for office assistants who will need to juggle their varied 
workload to handle issues in real-time while ensuring they still hit their deadlines for 
time-sensitive projects.  
To have excellent communication skills.  
Having solid interpersonal skills in both verbal and written contexts is the key to success 
as an OA. In the office, you are the first face clients or potential hires will encounter. Your 
interactions will set the tone as they check out whether the company is a good fit for 
them. The same applies to any communications over email or telephone.  
As an office assistant, you are the first port of call and impression of the business. Plus, 
using communication skills to develop strong relationships with office equipment 
suppliers can secure your company a better level of service or even a discount or two. 
Employers need to trust that every time you greet a visitor or answer phones, you will 
approach each interaction with the utmost professionalism.  
To be able to work independently. 
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When hiring an office assistant, executives look for someone who doesn’t require lots of 
supervision and is happy to manage their schedule and workload. Office assistants need 
to be proactive, spotting any potential issues and tackling them independently. No boss, 
or fellow employee, is going to appreciate an OA checking in to see if they can order 
more coffee when the office is almost down to its last cup!  
Businesses are searching for a candidate with initiative who is confident about problem-
solving within time and budget constraints. This is perhaps one of the most important 
aspects of being a successful office assistant. Ultimately you are there to remove tasks 
from other team members’ to-do lists, not create more with lots of questions!  
To be detail-oriented. 
As an OA, you will need to have exceptional organizational skills. On top of managing 
your schedule and to-do list, you will also need to possess excellent attention to detail. 
You will be handling a range of documents, from important internal memos to 
correspondences with clients. Having a perfectionist mindset and double-checking your 
work can help avoid embarrassing and potentially costly mistakes.  
To be technologically savvy. 
As well as general word processing and computer skills, you will need to demonstrate 
knowledge of the differing office management software for the various clerical tasks you 
will have to undertake. Technology shifts all the time, and you may find organizations are 
using replacements for many of the programs in the traditional Microsoft Office suite.  
For example, you might find companies prefer to use Canva over Powerpoint or have 
replaced Excel with Google Sheets. While each company might have individual 
preferences, understanding the different programs and platforms OA’s generally use is 
handy.  
What qualifications are needed to be an office assistant? 
The role of office assistant encompasses many responsibilities and requires a range of 
skills. While some office assistants will have a bachelor’s degree, a college education is 
not necessarily a prerequisite. As a minimum, businesses will be looking for applicants to 
have a high school diploma or GED.  
When weighing up candidates for an office assistant position, experience and proven 
administrative skills are more likely to be a determining factor than a formal qualification. 
However, it can be considered a bonus to have a clean driving license depending on the 
company you are applying to.  
How do you secure your first office assistant job?  
If being an office assistant sounds like an appealing next step when starting your job 
search and crafting your cover letter, it’s worth reflecting on your previous employment. 
Has any of your former work experience given you experience that could be relevant to a 
position as an office assistant?  
Maybe you developed customer service skills or have examples of times you had to think 
on your feet from a previous retail role? Perhaps you have developed strong 
organizational skills while volunteering at a local nonprofit? Whatever your background, 
it’s worth mentioning any relevant skills you have acquired to set yourself ahead of other 
applicants.  
Another way to stand out is to obtain some certifications. LinkedIn and specific computer 
software providers offer candidates the opportunity to test their proficiency with 
particular programs such as excel or skills like data entry. If you pass, you can gain 
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certificates that you can add to your application. Plus, investing in short courses like first 
aid training or fire marshaling can help your application shine.  
When looking through any office assistant job description, try to identify a feature of that 
business that draws your interest. Showing you are passionate about the company 
straight off the bat in your cover letter will go a long way to help secure an interview.  
Working as an office assistant can be a gratifying role. You get to support a business and 
its employees in creating a great work environment. You will have the chance to meet 
new people and will have variety in your work. OA’s are respected team members and 
enjoy benefits like healthcare, and there is lots of room for career development.  
After a few years of experience in a smaller organization, you can work your way up to 
roles with increasing responsibility. Plus, depending on the company, if you need to have 
more flexibility for childcare, there might also be an opportunity to scale down from a 
full-time to a part-time position.  
10 tips to be the best office assistant 
Have you already secured your first OA position and want to know the top skills for kick-
starting your professional development? A career in office support has lots of room for 
growth, but you will need to prove your worth within the organization. So what skill set 
do you need to cultivate to be a genuinely stand-out office assistant?  
1. Do your research 
When trying to secure your first entry-level role, you did your research to impress in your 
interview. When climbing the ladder and looking for more senior roles, take note of the 
organizations you feel more drawn to. When eyeing up your dream position, analyze 
what parts of the business’ mission statement you feel most aligned with. Hiring 
managers are looking for their office assistants to be passionate advocates for their 
business. Expressing what attracted you to this office assistant job description concisely 
in your cover letter will help you stand out amongst other applicants. Once they are in 
the role, great OA’s continue to keep abreast of the latest developments within the 
company so they can answer any questions from visiting clients!  
2. Swot up on your software.  
The role of office assistant encompasses a wide range of administrative tasks and a host 
of supporting software to master. While individual organizations might have specific 
programs for you to learn, having a general overview of the types of software you might 
need to use can help you ace any interview. Technology changes and the best 
administrative assistants work hard to stay on top of the latest trends. But when you are 
starting out, begin with tackling the most commonly used tools;  
Word Processing  

 Microsoft Word  
 Google Docs 

Email  
 Outlook  
 Gmail  

Organization  
 Slack 
 Asana  
 Trello  
 Evernote  
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 Google Drive  
 Dropbox  
 Wetransfer  
 Google Sheets 
 Excel  
 Google Forms  
 Google Calendar 
 Calendly  

Bookkeeping  
 Quickbooks 
 Xero  

Communication 
 Zoom 
 Google Meet 
 Microsoft Teams  
 Skype  

Design  
 Photoshop 
 Canva  
 Powerpoint 

3. Hone your communication skills.  
Strong written and verbal communication skills are perhaps the most vital ingredient to 
becoming an accomplished office assistant. Whether you are meeting in person or over 
phone calls, companies trust you to be the first impression their client has of the 
business. They need the peace of mind that their OA will have the interpersonal skills to 
handle every interaction professionally. But office assistants are busy people! You will be 
wearing lots of hats and juggling an extensive to-do list at any given time. To succeed as 
an OA, you need to hone this soft skill so you can get your point across succinctly and 
politely in all contexts.  
4. Let your personality shine.  
Being a friendly face is an essential part of being a successful office assistant. Not only are 
you there to greet visitors and make a great first impression, but you are also there to 
create a supportive office environment for your colleagues. Team members are more 
likely to discuss their issues with an OA who adopts a kind and open approach. Don’t be 
afraid to get to know your fellow employees in the break room. You might be able to nip 
a problem in the bud over a casual coffee! Being an approachable ear for colleagues isn’t 
the only way the relationships you build as an OA can serve the business. Having a 
friendly attitude with suppliers can reap preferential rates or a speedier level of service!  
5. Prove you are an excellent problem-solver. 
If you enjoy a challenge and love having a job where no two days are the same, you are 
likely thriving as an office assistant! Problem-solving skills are key for OA’s who need to 
think on their feet to resolve office management issues without being micromanaged. 
The role of office assistant also requires an element of flexibility. The most successful 
OA’s are team players with a positive attitude who are content taking on new tasks as 
they arise. Terrific office assistants not only handle problems in real-time, they also try to 
negate them wherever possible. Whether it’s keeping coffee supplies well-stocked or 
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flagging potential scheduling issues, employers appreciate an office assistant with a 
proactive approach.  
6. Brush up on organization.  
Exceptional organizational skills are a must for any office assistant. In handling your time 
and responsibilities, you will need to have an organized approach to everything you do. 
As an OA, you are also responsible for the organization of the physical office and other 
team members. You will be an administrative assistant for various departments, and 
each task might require a new process. For example, there might be varying filing 
systems between teams, or certain executives might have different preferences for their 
travel arrangements. The best office assistants can rise to these organizational 
challenges, keep abreast of expectations, and deliver a personalized level of 
administrative support.  
7. Tackle your time management. 
As an office assistant, your workload will be a constant juggle between day-to-day and 
longer time-sensitive tasks. It’s a fine line to walk. If you get too bogged down in a data 
entry project, you could overlook ordering office supplies. Miss the data entry deadline, 
and you anger your boss. Miss out on delivery dates for equipment, and you have to 
handle frustrated colleagues. Developing top time management skills ensures you meet 
deadlines while not neglecting your other ongoing responsibilities. The best office 
assistants learn that saying yes to everyone can do more harm than good. It’s better to 
set realistic deadlines than burn yourself or let people down trying to achieve the 
impossible. Managing expectations with your co-workers is an important skill and a more 
sustainable way to cement yourself as a vital team member.  
8. Pay attention to the details. 
A critical part of having top-notch organizational skills is noticing the details. As an office 
assistant, you will have access to many sensitive aspects of the business. From being the 
first person potential clients meet to writing up minutes from top-level meetings. The 
best office assistants take pride in their work and apply a level of perfectionism to 
everything they do. Even simple steps like proofreading all emails can help avoid any 
issues and hit the right tone with clients and colleagues alike. But not only can great 
attention to detail save the company from costly mistakes, it can also help secure new 
business. Think back to a time when you visited an office. How did it feel when the 
assistant had to ask three times if you took milk in your coffee or, even worse, almost 
instantly forgot who you came to see! Paying attention to these details will help you 
impress your employers and make you stand out as an exceptional OA.  
9. Trust your intuition.  
As an office assistant, you will likely sit outside the typical management silos. You may 
even report directly to a senior executive. When filling an office assistant position, 
employers are looking for a candidate who is confident working independently. 
Executives won’t have time to sign off on every decision, so an OA needs to use their 
initiative to solve as many issues as they can themselves. The role of office assistants also 
comes with significant responsibility. OA’s will often be given a budget for office 
equipment and will need to manage this themselves throughout the year. As we have 
seen, employers want an assistant who takes a proactive approach. If your instinct says 
you need to flag something to management, you need to allow them plenty of time to 
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respond. No boss will be pleased with an OA who is reactive and needs lots of last-
minute support with issues they should have seen coming.  
10. Collect solid references.  
When fulfilling your duties as an admin assistant, you will be privy to sensitive 
information. So when starting your job search for a more senior position, it’s crucial to 
demonstrate that you are a trustworthy employee. Having a couple of solid references 
from your former employers can show you have been a respected team member in other 
organizations. Keeping up good relationships with colleagues past and present is a good 
habit to maintain, as you never know when you might need someone to vouch for your 
previous work experience. You can even start curating references on social media. Ask 
current and past co-workers to give you a recommendation on your LinkedIn profile, but 
be sure to reciprocate the favor! 
8 Must-have office administrator skills 
Office administrators play a key part in holding offices together. On a day-to-day basis, 
they’re the people responsible for supporting team members, helping them to maintain 
high levels of productivity and efficiency. It’s common to see record-keeping, creative 
thinking, and general administrative tasks on a job description, but what else makes a 
stand-out office administrator?  
Office administrators’ skills are incredibly valuable to all team members. So, what does it 
take to be a great office administrator? Here, we go through the mix of skills, qualities, 
and characteristics of an office administrator. 
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8 Must-have skills and qualities of an office administrator 

Depending on the industry, some office administrators will need specialized skills or 
knowledge. However, most office administrators will need several standard skills in order 
to carry the job out well. Below, we go through eight must-have skills you’ll need to be a 
great office administrator.   
1. Strong organizational skills  
Office administrators are nothing if not organized, with impeccable multi-tasking and 
time management skills, too. They’re able to keep up with and adapt quickly to 
competing priorities in fast-paced environments, keeping not only themselves organized, 
but other team members, too.  
They keep records, files, and databases incredibly organized, and are a whizz at 
scheduling appointments, maintaining multiple calendars, writing memos, creating 
templates, and making travel arrangements.  
2. Communication skills  
Both written and verbal communication skills are highly important in any office 
administrator role. They’re often responsible for managing other office administrative 
assistants, and so delegating tasks in a clear and understandable way is paramount to the 
productivity of the office.  
They’re also who people go to when they need something done, ordered, or arranged, 
which means communication is a non-negotiable office administration skill.  
3. Interpersonal skills  
Teamwork is an office administrator’s middle name. Office administrators are able to 
easily interact with a large range of employees across all levels of seniority and within 
many different company departments. They’re also responsible for keeping the office 
manager up-to-speed.  
4. Accounting and bookkeeping skills 
In some cases, office administrators are responsible for accounting and bookkeeping 
tasks. They’re often responsible for collating office receipts and travel expenses, 
preparing and disbursing payments, and compiling statistical or financial reports and 
spreadsheets. It’s also worth noting that many administrative positions require the use of 
accounting and expense software such as Quickbooks.  
5. Experience with technology and software   
Office administrators must be proficient in the use of common computer applications 
and software such as programs within Microsoft Office (Excel, Word, Powerpoint, etc). 
They’re also well-versed in data entry, report compilation, and answering virtual 
correspondence using different software applications.  
6. Problem-solving skills 
Office administrators are the problem-solvers of the office. If the printer breaks, if 
someone’s keycard stops working, or if the heating breaks down, they’re responsible for 
getting these fixed while also maintaining the office as usual. 
They’re also skilled in navigating their superiors’ competing priorities, schedules, and 
projects, and are able to quickly switch gear when something needs to be taken care of 
urgently.  
7. Attention to detail 
Since they’re responsible for multiple moving parts, office administrators have a keen 
eye for the tiniest of details. They know the when, how, why, what, and where of 
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everything office-related, can spot potential mistakes before they happen, and work 
tirelessly to make sure everyone’s needs are accommodated for. 
8. Customer service skills 
Last but not least, office administrators are not just responsible for pleasing the office, 
but for assisting customers and clients, too. Customer service skills are imperative since 
office administrators are often the first point of contact with customers both in-person 
and via phone calls, and may need to deal with customer complaints and refer customers 
to the correct individual or department in a pleasant, efficient manner.  
How to be a great office administrator 

If you already have these office administrator skills under your belt, it’s well worth 
learning some extra skills or honing your existing ones to help you stand out from the 
crowd.  
Here are some tips to help you become the best office administrator possible! 
1. Be proactive with tasks 
Office administrators are responsible for multiple tasks that are often competing against 
one another, too. Although you can’t predict every task that will land at your feet, there 
are often recurring tasks that you can be proactive with, such as ordering office supplies, 
budgeting, and maintaining filing systems.  
For example, if you know your company is going through an extensive hiring period and 
will be expecting several new staff members, you could begin to look into extra office 
equipment, order extra office keycards, or purchase extra software licenses. This level of 
strategic planning will help provide a high level of administrative support for your 
superiors.  
2. Learn more about your company and industry 
As we mentioned, most office administrators have several standard skills and 
characteristics in common. However, to become a more valuable office administrator, 
you could spend time learning more about your company’s wider goals and objectives, its 
growth projections, and engross yourself in what’s happening in your specific sector and 
industry as a whole.  
3. Use tools to automate and streamline tasks  
Office administrators juggle many tasks, many of which are recurring, and could be taken 
care of with office management software. This also frees up your time for more business-
critical priorities. For instance, if managing employee travel expenses for corporate 
accommodation and transport always falls to you, you could consider using a travel 
management platform like TravelPerk that can help you create one simple invoice that 
collects all costs after every trip, eliminating the need to track down invoices from 
multiple employees. 

Top 30 best office management software tools 
Full disclaimer, office managers do a lot of different things. Depending on the product or 
service that your company provides — and how large your company is — all of these 
tools and tasks might not apply to you. The demands on the office management staff are 
extensive, so we’ve done our best to compile a list of the best office management 
software for you. 
Your daily to-dos might include a little client account management, a little travel booking, 
a little bookkeeping, or not. You might serve as a personal assistant to your CEO or you 
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might handle customer concerns. Whether you work for a large or small business, having 
a great management system can make your workday more enjoyable and 
productive.  Disclaimer aside, there are awesome office and project management tools 
that can help nearly every office manager to do their job faster and smoother than 
before. Let’s dive into the best software for office managers! 
Amazing project management softwares for office managers 
Office managers can implement project management software for internal company 
tasks like documentation updates, events planning, and more. 
Asana 
Asana’s many task viewing options (including timelines, boards, and task lists) make this 
tool a fan favorite. For each project, you can choose the organization system that makes 
the most sense. You can assign tasks to different team members, create interactive 
calendars and track your progress in real-time. 
Trello 
Trello can help you streamline collaboration with easy-to-follow workflows and task 
boards. Comment on tasks, upload relevant files and track progress. Not to mention that 
there’s a mobile app available for both iOS and Android! 
TaskWorld 
If your team doesn’t yet have a communication tool like Slack or Flock (or is open to 
switching over), then TaskWorld can be a great way to get communication and 
collaboration all in one place, because this tool offers not only task management and 
project planning, but public and private channels and chats as well. 
Bitrix24 
Bitrix24 is a robust, powerhouse software that combines document management, 
calendar management, event scheduling and customer resource management with 
project management and collaboration. 
The importance of document collaboration 

Gone are the days of having to download a document or sheet from Box and Dropbox, 
change it in Microsoft Office, and reupload it. Asset management still has its place, but 
not for active, living projects. 

https://trello.com/home
https://taskworld.com/product
https://www.bitrix24.com/
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Google Drive 
Where would any of us be without Google Drive? If you haven’t yet switched your team 
over to Google Drive, what are you waiting for? Talk them into taking the plunge. For 
most documentation needs, we suggest you change to this cloud storage system right 
away. 
LibreOffice 
For teams that can’t rely on Google Drive and need a smoother way to collaborate on 

documents that can more reliably be exported as .docx of .xlsx or .pptx, then LibreOffice 

is the perfect cloud collaboration solution. 

Communication tools for modern teams 

Why email when you can chat? 

https://www.google.com/drive/
https://www.libreoffice.org/discover/libreoffice/
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Slack 
King of office chat, Slack is a communication tool that allows you to send direct messages 
to individual colleagues or to converse informally in groups called channels. Channels can 
be organized around teams, projects, topics or all three. 
Fleep 
While most chat and communication tools are built to reduce email and get people 
outside of email, that’s not always helpful. For teams that need to communicate with 
people outside their internal organization (clients for example), then integrating with 
email is a big plus. Fleep lets everyone choose their preference, whether that’s their 
inbox or the Fleep app, and integrates all communications. 
Flock 
In addition to individual and group chat, file sharing, and chat search, Flock also offers to-
do lists, polling, and email list building (for when chatting isn’t the best medium but you 
still want to contact everyone in that channel). Flock is also the cheapest chat solution. 
Video conferencing tools for remote work 

Google Meet 
Previously known as Google Hangouts, this is Google’s solution to enterprise 
conferencing software. It’s offered for free as part of the Google Workspace, or any 
Google user. It’s a great, hassle-free way to meet with colleagues no matter where you 
are. 
Microsoft Teams 
If you’re more into the office suite, Microsoft Teams is a great option for Office 365 
users. It’s completely compatible with all of Microsoft’s other tools like Excel, Word, and 

https://slack.com/
https://fleep.io/
https://flock.com/
https://meet.google.com/
https://www.microsoft.com/en-us/microsoft-teams/group-chat-software
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PowerPoint. Use the free browser version as a guest, or check out their pricing options to 
get the full suite. 

 
Zoom 

Zoom 
The famous Zoom! The popularity and prevalence of this video conferencing tool have 
skyrocketed since remote working became the new normal in 2020. It’s a highly reliable 
tool with some great functionalities that make teamwork and collaboration quick and 
easy. 
Travel & Expense management software 

The travel booking management software category is on the come-up and you’ll be 
happy to be an early adopter. 
TravelPerk 
TravelPerk is built for booking and managing business travel. Aggregating all the flight 
and hotel options you can find on Google and delivering that inventory alongside 
business-critical features like travel policy limits for self-booking and spend reporting, 
TravelPerk is a no brainer. And did we mention the 24/7 trip support? It’s amazing. 
Business travelers will thank you for it. 

https://zoom.us/
https://www.travelperk.com/
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Book every aspect of your business trip within the TravelPerk app 
Expensify 
No one likes writing expense reports. Really no one. Expensify automates the whole 
expense reporting process with receipt scanning and bookkeeping integration and fast 
reimbursements. 
The elements of stellar event planning 

When you’re planning an event, you need all the help you can get. There are tools and 
systems that can make everything so much easier. 
Typeform 
As a survey tool, Typeform can be used for so many different things, including getting 
feedback on a recent event, asking for lunch orders, or discovering what type of furniture 
your team would like to have in the new lounge. But one of the best uses of Typeform is 
event planning. 
Need to discover when team members will be arriving or what their preferred itinerary 
is? Typeform is so helpful for grouping people together and tackling trip booking or other 
event related tasks. 
TravelPerk Group Booking 
Ok, so we know we mentioned TravelPerk but bare with us here. TravelPerk has some 
awesome services built into the platform and overall experience. Group booking is one of 
them. 
 
If you’ve ever organized a retreat or a summit, you know what a headache group events 
are. The TravelPerk specialists will handle group booking for you and make sure all of the 
itineraries and travel data is inside your TravelPerk account so that you as an 
administrator can keep track of everyone and your CFO can see all the spend. 
  

https://use.expensify.com/
https://www.typeform.com/
https://www.travelperk.com/travel-solutions/group-bookings/
https://www.travelperk.com/
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Office management and general organization 

Google Calendar 
Make everyone’s lives easier by implementing the use of Google Calendar across the 
entire team or company. If you have to book group lunches or meetings, it will be so 
much easier to pick a time (with no back and forth) if you can view the shared calendars 
for the relevant parties. 
 
And if anyone on your team in charge of client care or customer support uses scheduling 
tools like Calendly or Acuity Scheduling — tools that integrate with Google Calendar — 
any event you create in their schedule will then be automatically blocked off. Best of all, 
Google Calendar sends event notification and reminders so missed meetings are much 
less common! 
Q 
Q can do a whole lot of things but our personal favorite is powered by a startup called 
Hivy, which Q recently acquired. 
 
Now baked inside the robust Q platform, this smart tool integrates with the Slack bot so 
any employee can ask for more forks or more chamomile tea or more staplers, and 
follow up on that request to make sure that you’ve ordered it. When other team 
members are on the lookout for items in low supply (and they remind you), it’s a blessing 
for a busy office manager. 
OneLogin 
You and your team use so many different tools every day! I mean really, you should be 
using most of the ones on this list. That means so many different login credentials. Say 
goodbye to needing to remember dozens of passwords, and use OneLogin to login to 
every other tool that you use. Not only is this more secure, but it also keeps you more 
productive because you can login once and go about your day. 
Envoy 
For the modern receptionist, Envoy is a must. Here’s what you can do with this platform: 
allow guests to sign in, send notifications to the host, get signatures from visitors on legal 
documents if needed, and quickly print guest badges. And it’s completely optimized for 
touch screen use on tablets. Hooray! 
Amazon Business 
Amazon, why do you have to make life so easy? The retail giant isn’t just for consumers. 
They’ve got fast shipping and easy ordering for businesses too. You can even set up 
approval workflows for ordering supplies, pay in the way that’s convenient for your 
business, and get exclusive savings. 
The best bookkeeping and account management tools 
As an office manager, you may or may not handle bookkeeping, invoicing and the like. If 
you do, you want something that is easy to use and just works. These tools fit the bill 
perfectly. 
QuickBooks 
Enter profits and losses, categorize items, run quarterly reports, and be fully prepared 
come tax season. QuickBooks has been around for a long time as a desktop application, 
and has successfully made the jump to an easy-to-use web app. 
Xero 

https://gsuite.google.com/learning-center/products/calendar/get-started/#!/
https://www.managedbyq.com/
https://www.onelogin.com/
https://envoy.com/
http://www.amazonbusiness.com/
https://quickbooks.intuit.com/
https://www.xero.com/
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Xero is a bookkeeping and accounting platform known for its reliable mobile experience 
and quick and easy reconciliations.The 600+ app integrations make it a fan favorite. 
Wave 
Professional, easy-to-create invoices from a free tool? It doesn’t get better. If your 
company uses a robust suite that includes invoicing, you won’t need this. But if you’re 
using simple finance tools, then this is the perfect add-on for creating quick invoices. 

PandaDoc 
PandaDoc 
If your company does client work, then as an office manager you probably handle the 
contracts and proposals. If you’re handling this manually with Microsoft Word, it’s a real 
pain. Switch over to a smart system like PandaDoc to handle proposals and contracts and 
allow clients to esign on any device. 
FreshBooks 
If your team bills for their hours, then having a time tracker integrated into your invoicing 
system can be a huge time saver for you. FreshBooks allows you to track time, send 
invoices, manage expense reporting, and collect payments. Perfect fit for law firms, 
agencies, IT consulting firms and more. 
Note taking and list making for admin work 

https://www.waveapps.com/
https://www.pandadoc.com/
https://www.freshbooks.com/
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You’re in charge of keeping everything on track, and while there’s no app for giving you 
four extra arms, there are some great apps for managing your to-dos. 

Evernote 
Evernote 
With Evernote, create dynamic notes that include links, checklists, tables, attachments 
and audio recordings. Best of all, these notes are easy to search and can be shared and 
collaborated on with others. 
Wunderlist 
This robust app (available on any device) can help you organize your lists and notes into 
folders, create due dates and push notification reminders, and even help you manage 
your deluge of incoming email by turning emails into tasks. 
Any.do 
In addition to creating to-dos and organizing your daily calendar, you can set up recurring 
tasks, collaborate with your team, get location-based reminders, and more. If making 
phone calls is part of your daily workflow, this is the perfect app for you because it 
integrates with your phone dialpad. 
 

Types of email management tools 

Whether you check email for your CEO or handle customer support issues, you could 
benefit from one or more of these email management tools. 
Help Scout 
Collaborate with other teammates to reply to customer emails by tagging conversations, 
triggering auto-responses, marking a conversation as complete, mentioning other 
colleagues in private comments and more. 
ReplyManager 

https://evernote.com/
https://www.wunderlist.com/
https://www.any.do/assistant
https://www.helpscout.net/help-desk-software/
https://www.replymanager.com/
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Perfect for large ecommerce brands, eBay sellers and Amazon sellers, ReplyManager 
helps you tackle customer support email with centralized, faster replies. 
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FreshDesk 
This affordable is a great tool if you’ve never used a customer support tool before and 
you’re still doing everything in your inbox. It can even help you if you don’t actually 
handle customer support but you get so much incoming email that you need canned 
responses and scenario automation. (We won’t tell). 
Inbox Pause 
As an office manager, responding to dozens of email everyday is part of your job. But if 
you don’t bulk email management then you won’t be able to get anything else done. 
Inbox Pause literally puts your inbox on pause so you can set aside 15 or 30 minutes to 
handle other important tasks. 
Yesware 
While many users rely on Yesware for email tracking, it’s template feature is even more 
useful. If you find yourself having to answer the same question over and over, or send 
the same onboarding email to new clients or customers, then Yesware templates will be 
a life saver. The follow up and reminders features are amazing too. 
SaneBox 
Designed to help you get to Inbox Zero, SaneBox helps your prioritize important emails, 
send distractions to a “SaneLater” folder, customize other folder types, and send emails 
to yourself at a future date. 
 

Office Management: File Management System 

What Does File Management System Mean? 
A file management system is used for file maintenance (or management) operations. It is 
is a type of software that manages data files in a computer system. 
A file management system has limited capabilities and is designed to manage individual 
or group files, such as special office documents and records. It may display report details, 
like owner, creation date, state of completion and similar features useful in an office 
environment. 
A file management system is also known as a file manager. 
A file management system's tracking component is key to the creation and management 
of this system, where documents containing various stages of processing are shared and 
interchanged on an ongoing basis. It consists of a straightforward interface where stored 
files are displayed. It allows the user to browse, move, and sort them according to 
different criteria such as date of last modification, date of creation, file type/format, size, 
etc. 
 
The system may contain features like: 

 Assigning queued document numbers for processing. 

 Owner and process mapping to track various stages of processing. 

 Report generation. 

 Notes. 

 Status. 

 Create, modify, move, copy, delete and other file operations. 

 Add or edit basic metadata. 

https://freshdesk.com/features
http://inboxpause.com/
https://www.yesware.com/
https://www.sanebox.com/
https://www.travelperk.com/demo-request/
https://www.travelperk.com/demo-request/
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In Microsoft Windows operating systems, the default file management system is 
Windows Explorer. On Mac computers, instead, this role is taken belongs to a tool called 
Finder. Although the functionality offered by these file management systems is pretty 
basic, they are usually enough for most users. 
However, some businesses might want more advanced tools that can, for example, 
understand the differences between files of the same format or sort them according to 
their content. 
More advanced file management systems can provide additional functions, such as 
document management software (DMS) which can organize important documents. Files 
are assigned a label or indexed according to their attributes to build a searchable 
database for faster retrieval. 
A file management system should not be confused with a file system, which manages all 
types of data and files in an operating system (OS), or a database management system 
(DBMS), which has relational database capabilities and includes a programming language 
for further data manipulation. 
Why we need file management software and systems? 
A file management system is a cloud-based service that facilitates the storage and 
managing (and sometimes creation) of all your documents and files from a single point of 
contact. 
In other words, it’s a filing system that operates in the cloud where you can store all your 
documents and company files and retrieve them whenever you want from anywhere 
around the world. 
Remote working has brutally exposed the old paper-based document storage models 
that businesses have been using for decades, leaving them in despair. Even when 
working in a physical office, paper documents bring more chaos to the table than calm. 
The chances of error and misplacement along with supplementary costs of storing and 
maintaining file cabinets are a few of the major hurdles businesses tackle every day. 
Besides, they are difficult to locate and access becomes impossible if your peers are 
working remotely. 
The challenges are bigger than you think. Take a look at these stats: 

 A staggering 7.5% of all paper documents get lost. 

 Document challenges account for 21.3% productivity loss. 

 Companies with annual revenues between $500k and $1 million can save as much 
as $40k per year by switching to digital document management. 

 On average, a professional spends 18 minutes searching for a document, which 
adds up to nearly 50% of their total time on the job. 

 Around 20 percent of the business time – the equivalent of one day per working 
week – is wasted by employees searching for information to do their job 
efficiently. 

 File management system plays a significant role in making the management of 
files easier, faster, and more efficient. 

The Many Advantages of a File Management System: 
File management software and systems offer a lot of advantages when compared to 
physical files storage systems, some of which include: 

 Simple storage, surveillance, and retrieval of documents irrespective of location 
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 Superior search abilities mean less time is spent on searching for important files 

 Lowered storage costs associated with physical files. 

 More security and privacy control over sensitive company data 

 Disaster recovery and backups 

 Real-time collaboration and improved teamwork 

 The version history of each document to see when edits were made 

 and much more! 
Seeing that over 77% of business owners want to access files remotely, having a file 
management system in place seems like an obvious decision. 
OFFICE MANAGEMENT: FILES AND RECORDS MANAGEMENT 
1: The objectives / policies for files and records management shall be to: 

 Standardize the filing system among various Government agencies; 

 Improve the documentation and thus facilitate a sound information system for 
efficient management; 

 Ensure proper maintenance, storage and archiving of records; 

 Expedite decision making and correspondence; 

 Strictly maintain office secrecy and prevent the untimely and unwarranted flow of 
information outside the agency; 

 Promote individual and collective responsibility and accountability within the civil 
service; and 

 Economize the government operation 
2: Organizing Files 

Overview and General Principles 

Most department offices already have organized file arrangements or file plans in 
place for hard copy records. This chapter addresses general file organizational 
principles to employ when the need arises to 

 create, revise or overhaul a filing system; 
 develop and apply file management techniques and procedures to electronic 

documents and records; 
 develop or revise a file plan index to files; or 
 establish procedures to review files in all media for storage and disposition. 

The principles apply to files in any medium. 
Organizing for Retrieval 
Organize files for easy and intuitive retrieval of information. Organization is typically 
hierarchical, moving from broad categories through subcategories to specific contents 
such as individual folders or documents. The usual need is to retrieve a specific 
document. In hard copy file systems organization through the folder level is ordinarily 
sufficient. In an electronic file system organization techniques may extend to specific 
criteria to identify individual documents. 
Proper organization enables both efficient retrieval of individual documents and the 
efficient management of the record series to which they belong through the record life 
cycle. 
Basic Arrangements 
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The three basic types of file arrangement are 
 alphabetical - using names, subjects, geographic locations, etc.; 
 numerical – using numbers in various combinations, such as date, control-section 

and job, etc.; and 
 alphanumerical – using a combination of letters and numbers. 
Hierarchical Groupings 
Typical file organization moves from broad groupings of files through progressively 
more specific groupings to particular files or documents. 

 

 
3: File Management on Shared Drives 

File Location 
Use shared drives to maintain electronic files enhances accessibility and security. 
Standard procedures should include guidance to employees on routine transfers of 
electronic files from individual desktops to the shared drive as they are developed in 
the course of business functions. 
While shared drives offer convenience when documents are being developed, the 
FileNet enterprise document management system (EDMS) is the preferred repository 
for the retention of completed documents. Until EDMS is fully implemented across the 
enterprise, however, many offices will continue to maintain electronic records on their 
shared drives. 
This section discusses addresses the following techniques for managing files on the 
share drive: 

 file Naming and Organization 
 date-Based File Organization 
 event-Based File Organization 
 document Naming 
 e-mail Guidelines 

File Naming and Organization 
Electronic file naming should support both retrieval and record life cycle management 
for electronic files that are retained on a shared drive. While document and folder 
names may suggest content, use of dates or numbers in the names can help to 
graphically organize them on the display. 
Date-Based File Organization 

http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/rec_4_1folder.gif
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
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Organize and name date-managed files in the following manner: 

 
Event-Based File Organization 
Employ the same folder structure as the date-based arrangement, above, but create 
separate folders to contain active and completed files, as in the following example: 

 
As the status of records changes from active to completed, move the records from the 
Active minor group to the appropriate folder in the Completed Minor Group. 
Since records are typically managed on a periodic basis, organization of completed 
event-based records by year of completion is ordinarily sufficient to accomplish 
efficient retention and destruction of records. Folder structures can be organized for a 
closer adherence to minimum retention requirements for sensitive records by using 
month folders, or a similar finer level of detail in a date-based minor group. 
Document Naming 
Appropriate document naming is essential to allow accurate identification of content 
for retrieval. In most functions, using a combination of a date and standard title 
suggestive of the document content or function is sufficient. Document naming 
conventions can be established as routine procedures for many documents related to 
operations. Some examples include the following: 
 MM-DD-YY Approval Memo (or E-mail or Letter or Form) (NOTE: It may be helpful 

for retrieval to include the type of document format, such as e-mail or form, for 
correspondence.) 

 MM-DD-YY Status Report (File suffix (.doc, .xls,) will identify type of document) 
 MM-DD-YY (Recipient Name) E-mail 
 MM-DD-YY Form Title-Person Name or other Identifier 
Use of the date allows for an easy sequential organization of documents related to a 
process. Numerical suffixes can identify consecutive content related to a document or 
subject. 
Managers or supervisors can establish naming conventions appropriate to the needs of 
their operations and train employees to use them. 

http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/rec_4_2folder.gif
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/rec_4_3folder.gif
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CAUTION: Excessively long folder or document names may result in file corruption that 
prevents document actions, such as moving or copying document files. 

E-mail Guidelines 
E-mail messages created or received by means of state resources, including employees 
and facilities, are considered state records. Inadequately managed or controlled e-mail 
represents a significant legal vulnerability in most organizations. While users may view 
the medium as a communications utility, much like the telephone, the courts may 
consider e-mail messages as documentary evidence. Responsibility for appropriate 
management of e-mail is shared by managers, supervisors and users. 
Basic Guidelines. Several basic measures can reduce risks related to e-mail, including 
the following: 
 identifying and characterizing e-mail related to routine business functions 
 developing e-mail subject/naming conventions to relate the content to a specific 

record 
 developing e-mail text templates for use in routine business communications 
 establishing and enforcing procedures to save e-mail to the appropriate record 

folder immediately upon completion of the transaction 
 arranging for frequent and regular automatic emptying of mailboxes 
 training employees on e-mail procedures and include appropriate e-mail 

management in performance planning and evaluation 
 copying only those who have a direct stake in the content of the e-mail 
 using links to documents posted to the intranet for broadcast e-mail 

communications 
Record Copy Status. Identify and retain e-mail according to the requirements for the 
record to which its content relates. The following guidelines can help in determining 
the record copy status of e-mail: 
 The person authoring an e-mail in connection with a business function may be 

presumed to have created the original (e-mail) record 
 E-mail that contains a string of dialog, (initial message, response(s), and 

attachments) that represents a completed communication or transaction related to 
a function for which the office or unit is responsible is normally a record. 

Transitory e-mail typically not considered for record copy status includes: 
 e-mail received that does not require a response or further documented action; 
 e-mail transmitting attachments (unless it is important to retain documentation of 

the transmittal itself); 
 informal conversational e-mail that does not include content that turns the message 

into a record. 
Saving to the Shared Drive. Saving e-mail to the appropriate folder on the shared drive 
as a routine procedure related to the maintenance of an electronic file or record 
allows the content to remain accessible if the original account should be discontinued. 
E-mail saved in this manner defaults to a Word document in the form of a memo. The 
essential basic metadata of sender, recipient and date is preserved in this format. 
 
4: File Management in an EDMS 

Active and Passive EDMS Uses 
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Active EDMS use employs the technology to manage documents involved in the 
conduct of business processes. Typical actions involve coordination of revisions or 
document handoffs for reviews or approvals. 
Passive use employs EDMS simply as a repository for retaining documents after their 
active use is completed. Typical actions involve adding the document or a scanned 
image to the library when the hard copy would ordinarily be filed. 
EDMS and SharePoint Services 
Microsoft’s Share Point Services (SPS) is marketed as a document management 
application, and has become popular as a means of sharing documents and conducting 
collaborative processes in the department. As documents are developed locally on 
shared drives, they may be posted to SPS sites for collaborative actions across the 
enterprise. SPS is a more user-friendly tool than FileNet for collaboration and business 
process-related document actions. 
SPS, however, should not be used as a repository for the retention of completed 
documents as official records, as the ease with which SPS sites can be developed and 
accessed by large numbers of users and then removed presents inherent 
vulnerabilities. The Technology Services Division’s procedures governing the use of SPS 
emphasize that “SPS web sites should be focused primarily on defined projects and 
organizational infrastructure support issues.” Accordingly, completed or final 
documents managed through SharePoint should be moved to the FileNet EDMS for 
retention. If necessary, links to documents in the FileNet repository may be 
established in SPS sites. 
Before eliminating SPS sites, SharePoint managers must take care to ensure that 
official records and documents are preserved and retained. Discussion strings may 
contain content necessary to preserve as a record, and steps to index and retain that 
content are also necessary. 
Using Properties to Manage Files in an EDMS 
Library developers coordinate with subject matter experts to develop indexing criteria 
for retrieving and managing the life cycle of documents related to their individual 
business processes. Users are typically unconcerned with document life cycle 
management after they complete their role in the process. 
In an EDMS, properties, or index terms, are assigned to documents when they are 
added to the repository. These properties are fields in a database that is used for 
building searches to retrieve documents. Documents added to the EDMS require 
certain properties that furnish essential data for life cycle management. These 
properties include the following: 
 Record Type — Relates the document to a record series in the TxDOT Records 

Retention Schedule 
 Document Type — Identifies specific document components in a record, some of 

which may require special retention requirements 
 Document Date — Used for date-based purposes/document operations 
 Document Status — Used to track document handling/life cycle status 
 File Code — A numerical identifier used to enable batch document operations 
Optional custom properties are available for document indexing to support retrieval. 
Ordinarily, only a limited number of index terms (or properties) are necessary for the 
majority of retrieval needs for documents related to a business process. It is important 
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to establish a balance between the number of properties used and the real retrieval 
needs related to the document. More properties to keep track of mean greater 
workload in adding and maintaining documents in the repository. 
Optional properties may also be used for active document management. For example, 
the Process Status can track a document’s relationship or use in the management of a 
process. 
EDMS File Management Procedural Overview 
Managers, supervisors, records custodians or coordinators must include EDMS records 
in routine file management procedures. The procedures resemble those for hard copy 
records, but involve more teamwork. The following steps are discussed in the 
remainder of this section: 
 declaring a record to trigger retention 
 changing security to preserve document integrity 
 including records in the EDMS in periodic records management procedures 
 generating a report of destroyed records 
 deleting the records from the library 
Developing queries and scripts that perform global operations on component 
documents of records specific to various department functions involves coordination 
between the OPR and EDMS system administrator. Once developed and stored, 
however, queries, search templates and scripts may be reused—with adjustments to 
certain values—to perform the same operations in the future. 
NOTE: E-mail all queries or scripts that are based on the standard library design 

to EDMS_OPR@txdot.gov to ensure system users have access to these 
resources. 

Declaring a Record 
Declaring a record by an OPR may be event-driven, as in acceptance of a project, or 
date-driven, as in the turn of a fiscal or calendar year. For example, on notification of a 
construction or maintenance project’s completion, the OPR should perform a global 
document status property change to “Final” for all documents sharing the CSJ of the 
completed project. It is generally sufficient to batch records with an “AC” (After 
Completion) retention trigger in date-based groupings. For example, a declaration 
operation may specify all records with a document status of “Final” and document 
date equal to or before a specified trigger date, for example 0901YYYY. 
The nature of the record determines its handling. If an OPR determines that a record 
should be destroyed as soon as it becomes eligible, it may be necessary to perform 
declaration and reporting on a more frequent basis. 
Business process experts may collaborate with system administrators to explore 
developing scripts that would base global document property changes when a 
capstone document, such as a project acceptance letter, for example, is added to the 
library. 
External resources may help this process. For example, the Construction Division 
periodically disseminates an Excel spreadsheet listing completed construction and 
maintenance projects by CSJ and completion dates among other categories. This data 
could be incorporated in scripts that run against the repository and update status 
properties for the affected documents. 
Securing the Record 

mailto:EDMS_OPR@txdot.gov
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Security settings for declared records are imposed to preserve their integrity and limit 
access during their retention, reducing risks of inadvertent changes to, or loss of 
documents. It may be possible to accomplish this at the same time the record is 
declared. 
Optimally, access to a record during retention is restricted to the EDMS system 
administrator. If business processes require retrieval of documents from storage, read-
only access should be limited to specific individuals. To support legal inquiries 
concerning the integrity of records retained in the EDMS, OPRs should maintain a list 
of these persons, the specific record types they are authorized to access, and their 
rights to the documents. 
Including EDMS in Periodic Records Management Procedures 
Most routine procedures used to identify records eligible for destruction are managed 
on a date basis, typically at the turn of the fiscal year. Part of this procedure should 
include performing queries to report records eligible for destruction on the basis of 
their document status and date properties. Responsible persons then review the 
reports and authorize destruction of records or request withholding of destruction for 
specific records or documents. 
In the case of reference files or documents retained indefinitely or “AV” (as long as 
they have administrative value) annual reviews afford owners the opportunity to 
reevaluate the need to retain the document. 
OPRs can define the parameters of the reports. In some cases it may be sufficient to 
simply identify the record type and list specific identifying information, for example, 
denoting purchasing records for a specific fiscal year with a list of PO numbers. 
Other queries may require specifying a listing that includes specific component 
documents. 
Procedures used to report the records should include a global revision of the 
document status property to “Delete” and a review of documents against the EDMS 
file plan to identify any documents to be withheld for state archives review. Owners 
choosing to retain specific documents should revise the document status property to 
“Reference File” and enter an explanation for withholding the document from 
destruction in the “Document Comment” property. 
In cases where certain selected documents are routinely retained for a longer period 
than other documents in the record type, the longer retention value may be 
established in the file plan, which can permit the use of the file code to exclude the 
document from the global document status property change, and report of documents 
eligible for destruction. See the following discussion on the EDMS file plan. 
Reporting Records to be Destroyed 
Once the eligible records have been reviewed and approved for destruction, a report 
should be generated and attached to Form 1420, Records Destruction Log, for 
submission to Records Management. The report can make use of properties in the 
EDMS database and fields in the EDMS file Plan, and should include the record type, 
record date, the retention code (Trigger Date and Years field from the EDMS file plan), 
and a reference to the agency item number on the records retention schedule (also in 
the file plan). 
Deleting the Records 
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On completion of the report of records authorized for destruction, the EDMS system 
administrator may proceed with deletion of the records with the document status 
property “Delete.” 
Using the File Code Property 
When users select a record type and a document type when adding documents to the 
library, the selections associate the document with a file code—a unique numerical 
identifier that relates the document to a retention rule. The Excel EDMS File Plan 
spreadsheet also includes the retention trigger event, the number of years the 
retention is required, archival requirements (if any), and a citation to the TxDOT 
records retention schedule. System administrators can select fields from the file plan 
for developing stored queries or scripts to accomplish operations on documents and 
collections of documents (records) in the library. 
The file plan is posted on the EDMS intranet page and available via links from the ECM 
SharePoint site as well. 
To employ the file plan, replace the “##” in the field(s) with your D/D/O’s functional 
account number (for example, “14” for the Austin district). Agency Item Number 
citations with a functional account number present refer to a division or office OPR for 
documents which may have a different retention requirement. In situations where a 
document exists in both district and division libraries, two separate entries in the file 
plan exist. 
Assigning the functional account number relates the document contents to your 
specific D/D/O when citing the department’s records retention schedule in reports of 
records eligible for destruction or for attaching to Form 1420 upon completion of 
destruction. Multiple RRS Item references relate to records retention requirements for 
specific office operations. Records management can assist in selecting the appropriate 
reference for the particular library application being developed. 
Controlling EDMS Costs 
EDMS employs server-based technology which, in the current environment, represents 
a considerable cost to the department. While conscientious observance of file 
management/records retention and destruction procedures offers the possibility of 
establishing some equilibrium in storage requirements over time, the trend will be 
toward increasing storage needs as reference files of indefinite retention (“archival” 
files) are added. 
Not all documents belong in an EDMS, and careful planning before implementing the 
technology can help to manage costs associated with the system. More detailed 
information on planning for EDMS is available in an EDMS Planning Handbook. 
Alternative approaches toward the management of archival files can reduce costs and 
improve security. Mass storage drives are inexpensive and can be duplicated with 
backups maintained in a separate location. Immediate online access is probably not 
that important for records stored in these devices, and the drives may be accessed 
“nearline”quickly enough for the majority of business processes that may need to call 
upon their contents. 

5: Using a File Plan 
Definition and Content 

http://crossroads/org/gsd/Records%20Management/pdf/EDMSPlanningHandbook.pdf
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All TxDOT office or work units are required to develop and maintain a file plan. 
Records custodians must certify the currency and accuracy of their file plans to 
the DDO Records Administrator, who, in turn must certify the currency and 
accuracy of their organization's file plan to TxDOT Records Management. 
The file plan discussed in this section is distinct from the EDMS file plan. A file 
plan is an index and a location guide to the information in files. It identifies 
record copy files to manage in accordance with the records retention schedule, 
retention requirements, and includes records being retained. 
File plans must be reviewed and revised as necessary to maintain their utility for 
locating files. They can serve as a running inventory of an office’s records. 
The standard department file plan is an Excel spread sheet that includes the 
following file plan information. 

Table 4-1: File Plan Content 

Block Description 

Record Type The record type may be a general description or a specific file name. 

File 
Title/Description 

File titles or descriptions identify major groups, minor groups and individual file folders. Major and minor group titles and descriptions 
may also appear on file guides in file cabinet drawers. Include instructions for standard electronic document/file naming conventions 
as applicable. 

Location 

Files may be located in a variety of places. The file plan should guide users to the right place. For small offices, a general location 
statement may suffice. Larger offices may need to develop a numbering system for file cabinets and drawers or include a map or 
layout of the file cabinets with the file plan. File plans for electronic files may include directory paths and folder names. or by 
Document Class and Record Type properties in the EDMS. 
The following procedure is an easy way to copy and paste files in a shared drive: 
1. Open a blank worksheet in Excel with a wide column A. 
2. Open the shared drive and select List View. 
3. Highlight all folders. 
4. Right click and select Copy as Path. 
5. Paste to the first column and row in the spreadsheet. Note: The folders may not paste in the same order as originally displayed. 

Highlight the column and select Sort A to Z. 
6. Create enough rows in the file plan template to accept the folder list. 
7. Copy and paste the folder list to the file plan. 

File 
Organization 
Description 

Describe how files are organized. The description may include records and date range(s) in retention to be updated during annual 
currency review and certification. 

Status Identify record copy files to help file management procedures related to retention and disposition of records. 

Retention 
Enter retention periods for record copy files. Although information and convenience copies need to be retained only as long as 
needed, some offices include retention periods for them on the file plan if it is important to keep the records for specific periods. 

RSS Item 
For record copy files, the agency item number from the TxDOT records retention schedule is necessary when completing the records 
destruction log after purging files. Having it on the file plan is a convenient reference. 

 
 
 
The following figure illustrates the file plan formats. 

 

http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/
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Coordinating review and acceptance of the plan during its development among 
those who are responsible for and/or use the files helps to ensure filing 
accuracy. The file plan is a dynamic document that should be revised as needed. 
Certification 
The Records Custodian shall certify the accuracy and currency of the file plan 
and forward a copy to the DDO Records Administrator. TxDOT Records 
Management sends an annual reminder to DDO Records Administrators to have 
their respective Records coordinators review and certify the currency and 
accuracy of their file plans. When local review is completed, the Records 
Administrator shall send an email to TxDOT Records Management certifying the 
currency and accuracy of the file plans within their organization. 

http://onlinemanuals.txdot.gov/txdotmanuals/rec/images/rec_4_4_Fileplan.jpg
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Distributing the File Plan 
Keep a copy of the file plan available at a central location for reference by 
employees. Making the plan available in an office’s shared drive or on an 
intranet site is an efficient method of dissemination. In hard-copy files, it may be 
helpful to insert a copy of the file plan at the front of each file drawer. 
NOTE: It can also be helpful to maintain a file of previous file plans to use when 

records need to be retrieved from storage. 
Support for Discovery and Open Records 
DDO records administrators should maintain a file of current and recent file 
plans for their organizations to aid compliance efforts related to legal discovery 
and open records. 

Electronic Records 

Definition of Electronic Record 
An electronic record is any information created, used and retained in a form that only 
a computer can process. Electronic records include email, text messages, disaster 
recovery backup tape, and records that exist on portable media, such as memory 
sticks, BlackBerry devices, or PDAs. Records related to department work that may be 
produced or kept on personal devices away from the office are 
considered state records, and are not the employee's personal property. 
Any state record may be created or stored electronically. Certified output from 
electronically digitized images or other electronic data compilations is accepted as 
original state records by any court or administrative agency of this state unless barred 
by a federal law, regulation, or rule of court. 
The definition of a record can range from a single document to entire files of different 
types of applications and media related to the conduct of official business. In this 
chapter, the term record and file may be used interchangeably to describe official 
records, as distinguished from the use of these terms to describe specific data sets in 
the computing environment. 
 defines electronic records, 
 summarizes requirements for managing electronic records, 
 discusses practical procedures and best practices for managing electronic records 

during the inactive portion of their life cycle, 
 discusses management of email records, 
 discusses records management planning in the development of electronic document 

management systems, and 
 Discusses risk management and electronic records. 
 
Vital Records 

Vital Records 
Vital (essential) records, as defined in the Preservation of Essential Records Act Texas 
Government Code, §441.056, are records that, following a disaster, are necessary for 
the department to 
 resume or continue operations; 
 reaffirm authority and activity, including legal and financial positions; and 
 protect the rights and interests of the department and its customers. 
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Although all state records serve a purpose, only about 5 percent of an agency's records 
are truly vital as defined above. 
The Act requires each state agency to identify vital records, and to be able to rapidly 
reconstruct vital records from backup copies after a disaster. This chapter contains 
information on identifying and protecting vital records. 
Identifying Vital Records 
Vital records are only those records that are essential for TxDOT offices to carry out 
their responsibilities following a disaster. Vital records are identified in the TxDOT 
records retention schedule. 
Vital records may consist of 
 operational records necessary to resume or continue operations; 
 legal records for proof of authority or activity; 
 fiscal/financial records, especially those related to receivables; and/or 
 governmental records necessary to protect the rights and interests of the 

department, its employees and the public. 
Responsibility for Vital Records 
Offices that maintain vital records are responsible for 
 identifying vital records and making sure they are listed as vital on the TxDOT 

Records retention schedule, 
 implementing vital records protection procedures to back up vital records, and 
 advising the TxDOT records management officer on backup records locations, 

contacts and sources for records retrieval and reconstruction. 
Common Vital Records 
Vital records are not necessarily permanent records or records with archival value. 
Vital records may be vital for only a part of their total retention. 
Common vital records include the following: 
 active contracts and agreements, with all amendments and supporting 

documentation 
 financial records 

o accounts receivable (vendors will provide copies of lost or damaged accounts 
payable) 

o loans or money transactions 
o general ledgers 
o records proving payment 

 employee records 
o payroll 
o benefits 

 operations and manufacturing records 
o engineering drawings 
o in-process project records 
o research and development notes, reports, plans, formulae 
o production/design specifications 
o equipment inventory 

 negotiable instruments 
o checks 
o bonds 
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o notes 
 ownership records 

o deeds 
o titles 
o leases 
o patents and trademarks 
o licenses 

 insurance policy information 
If a record you consider vital is not identified as vital on the records retention 
schedule, annotate your file plan or record copy responsibility list to make employees 
aware of the need for special handling for the records. You may also include the 
following: 
 Special instructions. For example, the record may be vital only for a specific period 

of time within a longer retention period. 
 Backup protection. If the backup protection method is dispersal 

through routine distribution, indicate the department offices that are the primary 
and secondary contacts. For districts, this may include both a building within the 
district and an area office or Austin headquarters division which may have a copy as 
part of routine operations. If the record is dispersed through planned distribution, 
indicate the location of the backup copy. Additionally, note any special storage 
equipment used and its specifications. 

 Persons authorized to access the records. If the records are kept in secured storage, 
include information on contact persons for access. 

Disaster Recovery Planning 

General -- Steps in Disaster Recovery Planning 
Disaster recovery planning includes the following steps: 
 disaster prevention measures 
 development of a disaster recovery plan 
 development of disaster recovery and records salvage procedures, as part of 

the plan 
Definitions 
A disaster is generally defined as an event that causes widespread destruction 
and distress. 
When a disaster causes the irreparable loss of information, it may be called 
a catastrophe. This chapter contains information that can help prevent disasters 
and help to keep any that may occur from becoming catastrophes. 

Disaster Prevention 

Recognizing Threats to Records 
Recognizing potential threats to records can help prevent disasters. The four most common 
threats to records include the following: 
 fire 
 water 
 theft and sabotage 
 adverse environmental conditions 

o flood 
o tornado or hurricane 
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o earthquake 
Other threats include the following: 
 civil disaster 
 accidental destruction 
 neglect 
 misplacement 
 deterioration by age 

Methods of Protection 
The table below lists the four most common threats to records and ways to protect records 
from damage. 
Record Threats and Methods of Protection 

Threat Protection 

Fire 

To minimize chances that a fire will start and maximize 
chances for quickly extinguishing any fires that do start: 
 Do not store records near a heater, radiator or other 

heat source. 
 Prohibit smoking in record storage areas. 
 Do not store records with chemicals, cleaning supplies, 

etc. 
 Remove paper clutter from storage areas. 
 Observe approved records retention periods to ensure 

the timely destruction and removal of records,  
 thereby reducing the amount of potential fuel. 
 Make sure electrical wiring is safe. When possible, 

avoid the extended use of lighting or equipment with 
cords around  

 storage areas. After using such appliances, unplug 
them before leaving the area. 

 Comply with all local fire, electrical, plumbing, heating 
and construction codes. 

 Have fire extinguishers available near the records. Have 
them inspected regularly, and train staff to know 
where they are located and how to use them. 

 Clearly mark escape routes and exits. Hold regular fire 
drills to practice emergency procedures. 

 Periodically evaluate fire prevention systems in use, 
such as smoke detectors and/or sprinkler systems. 

 Try to store records against an outside wall. In fires, 
structures tend to collapse toward the center where 
fire burns hottest and longest. 

Water 

Water damage may occur as a result of other forms of 
disaster. Water damage and flooding often occur as a 
result of efforts to put out a fire. Winds and wind-driven 
rain can break windows and damage records. Also, routine 
structural failures such as backed-up drains and sewers, or 
broken pipes, can cause water damage. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  970 | 1352  

To reduce the likelihood of water damage to records, do 
the following: 
 Avoid storing records in basements, under water pipes, 

or directly on the floor. 
 Locate all drains and have them checked regularly. 
 Regularly inspect the sprinkler system, and check the 

general condition of the records storage site for 
susceptibility to flooding. 

 Look for any potential water hazards during routine 
inspections of plumbing. 

 Do not install carpet in storage areas. It retains 
moisture, prevents drainage and, if wet, will create 
humidity and temperature problems. 

 Try to store records in an area without windows. 

Theft and Sabotage 

Security is the key to protecting records from theft and 
sabotage. Consider the following when determining who 
will have access to individual record series: 
 whether the records are classified as open or 

confidential 
 characteristics of the record medium 
 whether the records include vital records 
 physical features of the building where the records are 

used or stored 
Conduct an initial security analysis and periodic evaluations 
of security in records storage areas and active files areas. 
The following basic protective measures will improve 
security: 
 Determine who needs access to specific record series 

and limit the number of employees who handle these 
records. 

 Limit access to record storage areas. 
 Be aware that terminated employees may pose 

security risks. Be sure they turn in all relevant 
identification and keys before leaving. 

 Ensure that all access control systems, intrusion 
detection systems and alarm systems receive regular 
maintenance. 

 Make security checks at closing time to ensure all exits 
and windows are locked, all equipment has been 
turned off or unplugged, all lights and water faucets 
are off, no cigarettes are smoldering in ashtrays and no 
unauthorized persons are in the building. 

 Keep the exterior of the facility well lit at night. 
 Establish procedures to follow in the event of theft or 

vandalism. 
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Environmental Conditions 

The most important factor in protection from 
environmental conditions is avoidance of extremes. Avoid 
storing records in attics, basements or warehouses that are 
not in some way climatically controlled. To help retard 
natural deterioration, provide at least the following: 
 air-conditioning 
 air circulation 
 temperature stabilized within a range of 60-75 degrees 

Fahrenheit 
Most modern paper deteriorates continuously due to high 
levels of paper acidity. Atmospheric pollution intensifies 
this problem. Microforms and magnetic media may 
deteriorate unless there are controls for temperature, 
humidity, pollution and light. Some protective measures in 
addition to the above are to 
 avoid storing records in areas where there is smoke, 

dust or chemical fumes produced by paints or copying 
devices, 

 protect all records from direct sunlight and bright 
lights, 

 keep the storage area free of food, beverages and 
plants to avoid soiling the records or attracting insects 
or rodents. 

 
Developing a Disaster Recovery Plan 
General -- What the Plan Involves 
Districts, divisions, and offices should develop a written disaster recovery plan 
appropriate to their own operations. Even minimal preparation can have a 
significant impact on the success of efforts to recover TxDOT records. 
The following pages contain information to use in developing a disaster recovery 
plan.  
Developing a disaster recovery plan involves 

 stockpiling emergency supplies and arranging services, 
 establishing a disaster recovery team, 
 developing disaster recovery and records salvage procedures, 
 Contingency planning. 

Emergency Supplies and Services 
In an emergency, self-reliance is critical. In any major disaster, TxDOT is likely to 
have to assist with recovery efforts for other agencies and the public while 
managing its own recovery. 
Initial disaster recovery plan development should include: 
 stockpiling emergency supplies, 
 Arranging necessary services to aid in disaster recovery. 
Check supplies and re-confirm service agreements periodically. After a wide-
scale disaster, these resources may not be readily available. Suppliers or service 
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organizations may have their own damages to deal with, or they may be helping 
someone else. 
Disaster Recovery Team 
Department offices should establish in-house disaster recovery teams to resume 
or sustain operations after a disaster, including handling recovery of their 
records. The teams should develop and practice disaster recovery and records 
salvage procedures. Teams may also want to train office employees in disaster 
recovery. 
Each team member should have two copies of the office's disaster recovery plan, 
one at the office and another at home. 
Recovery Team Responsibilities 
Ideally, a disaster recovery team should consist of at least four members, 
including a team leader. Each team member should have an alternate. 
Responsibilities of team members are as follows: 
 Team leader: Acts as point of contact for local emergency service agencies; 

performs overall management of the team's disaster recovery and records 
salvage procedures; coordinates with other offices; authorizes expenditures 
for wages, supplies, transportation and services; and is liaison with TxDOT 
customers and/or the public. 

 Recovery and salvage supervisor: Assembles, trains, and directs work crews 
for recovery and salvage procedures. Controls the flow of work and materials. 

 Coordinator of Enterprise Content and Records Management, (ECRM): 
Assembles supplies and equipment and may arrange such things as food for 
work crews. 

 Record keeper: Inventories damaged records. Assesses damage and salvage 
required. Performs or supervises recovery and salvage procedures. 

Disaster Recovery and Records Salvage Procedures 
Each district, division and office is responsible for developing emergency 
procedures to follow in a disaster and making sure employees are familiar with 
them. 
Include these essential procedures in any disaster recovery plan: 
1. Activate Recovery Team - Once the building has been declared safe to enter, 
the team leader should contact the team and brief them on procedures and 
priorities to be met. The recovery team should then 
 assign specific responsibilities to members; 
 set up a communications center and obtain services, supplies and equipment; 
 make arrangements to take care of physical needs (food, water, hygiene) of 

personnel involved in the recovery. 
2. Establish Security and Safety - For security and safety, restrict access to 
damaged area(s), allowing only essential personnel to enter. This minimizes 
opportunities for further damage to records and injuries to personnel. Use 
security guards, sign-in/out registers, and/or identification badges to restrict 
access. 
Basic safety precautions include the following: 
 Inspect disaster areas for hidden hazards, such as shorted motors or broken 

electrical wires. 
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 Avoid standing water and wet carpets, which make it dangerous to use 
electrical equipment. 

 Install and use temporary wiring properly. 
 Handle fire- or water-damaged files carefully. Wet records are heavy and 

fragile. Use care lifting record boxes or opening file cabinets. 
 Use face masks and protective gloves. Wash or clean clothing as soon as 

possible to reduce health hazards from fungi and bacteria. 
3. Assess Damage - Inspect damaged areas as quickly as possible. Avoid handling 
records, if possible. Take photos to document record damage. Keep the 
following questions in mind: 
 How much damage has occurred? 
 What kind (fire, smoke, soot, clean or dirty water, heat, humidity)? 
 Is it confined to one area or is the entire building damaged? 
 How much of the records holdings are affected? 
 What type(s) of records media have been damaged (paper, microforms, 

photographs, magnetic tapes, diskettes)? 
 Are the damaged records easily replaced? (Are backup copies stored off-site? 

Are the damaged records convenience copies? Can they be replaced with 
copies from other offices?) 

 If the damaged records are irreplaceable, what is their value? (How important 
are these records to the business of TxDOT?) 

 What is the order of priority to recover damaged essential records? 
 Can the in-house recovery team salvage records or is outside help needed? 

NOTE: Take steps to stabilize the environment while assessing the 
damage (see below). 

4. Stabilize Environment - Take steps to stabilize the environment while the 
damage assessment is taking place. Mold can appear on records in 48 hours and 
is encouraged by high humidity and temperatures. Quickly reducing the 
humidity and temperature can reduce the risk of mold and buy time for 
recovery. 
The following procedures will help stabilize the environment: 
 Keep the air constantly circulating. 
 Arrange fans to expel humid air outside. 
 Use dehumidifiers if they are helpful. (Dehumidifiers may help in small, 

enclosed areas. Operating them may raise the temperature, however, and 
they tend to freeze up in colder temperatures.) 

Immediately pump standing water from the area. Use caution -- standing water 
can conceal hazards. Remove wet debris and carpeting. The following 
equipment should be readily accessible: 
 portable generators, in case of power failure 
 shop vacuums capable of handling water (pumps may be needed to remove 

large quantities of standing water) 
 fans to circulate the air 
 thermometers, hygrometers or other tools to measure temperature and 

humidity 
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5. Treat Water-Damaged Records - Water-damaged records are the records 
most likely to be salvaged. See the next table for methods of treating water-
damaged records. 
6. Perform Post-Disaster Assessment - Assessing the disaster recovery plan is 
essential. Share the results with districts, divisions and offices and revise the 
plan if needed. Assess the following: 
 effectiveness of recovery procedures 
 areas for improvement 
 sources and supplies 
 any off-site facilities used 
Salvaging Water-Damaged Records 
The records most likely to be salvaged after a disaster are those that have water 
damage. A number of options are available for treating water-damaged records. 
The steps to follow vary according to the record medium and are described 
below. 
Paper - When paper records are slightly damp, air-drying (natural drying) may 
suffice. If records are soaked, they should be freeze-dried, regardless of 
quantity. 
 Air-drying: To air-dry paper records, hang the paper on lines. You may want to 

interleave pages with special blotter paper as a preliminary step before 
hanging the paper. 

 Rooms used for drying areas should have good air circulation and low 
humidity. Use fans, dehumidifiers and/or air conditioning. Handheld hair 
dryers (set on cool) may be used to speed drying. 

 Freeze-drying: The most effective procedure for stabilizing water-damaged 
records and archival materials is to blast-freeze them to a temperature of -20 
degrees F, and then dry them using a thermal vacuum process. 
Freezing allows time to estimate recovery costs, prepare and coordinate 
subsequent steps in the drying and recovery operation, and clean up the 
disaster site. In addition, freezing stabilizes water-soluble materials (inks, 
dyes, etc.), that may disperse during air drying. 
Thermal vacuum drying causes water to pass from a frozen state to a vapor 
without returning to a liquid form. It reduces stains and removes the odor 
caused by smoke. Determining a source for thermal-vacuum drying services 
should be part of disaster planning. The Blackmon-Mooring Steamatic 
company (in Austin) has special vehicles that can travel to remote sites to 
perform this service. (Many carpet cleaning/water removal services can 
perform the service or suggest vendors who can.) 

Microfilm - In recovering microfilm or microfiche, speed is essential to avoid the 
breakdown of film emulsions and the onset of bacterial growth which destroys 
images. 
Immerse the film in clean, cold, preferably distilled water. Send the film to a 
professional laboratory for cleaning. Generally, film should not be frozen 
because ice crystals may harm it. 
Electronic Media - Off-site storage of backups is the best possible disaster 
recovery strategy for electronic records. If electronic records on portable media 
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are water-damaged, do not use them until they are thoroughly clean and dry 
and their housing or containers have been replaced. This reduces the possibility 
of damage to equipment, especially for disk drives. 
Diskettes require the following steps: 
 To clean and dry, do the following: 

o Drain. 
o Remove from jackets. 
o Rinse in distilled water. 
o Blot with lint-free cloth. 
o Air-dry approximately eight hours. 

 When diskettes are dry, do the following: 
o Insert into a new jacket. 
o Copy information on damaged diskettes onto new diskettes. 
o If information copies correctly, discard damaged diskettes. 
o Clean copy equipment drive heads to prevent permanent damage to the 

heads. 
Magnetic Tape that has become wet has a good chance for recovery through 
these steps: 
 Hand dry all external surfaces with a soft, lint-free cloth. 
 Air-dry the tape using a tape cleaner or winder to run the tape from reel to 

reel. 
 Consult a company that does magnetic tape restoration. 
Compact Disk or other Optical Media require these steps: 
 Clean any dirt or debris from the disk using a disk cleaning solution. 
 Hand dry all external surfaces with a soft, lint-free cloth. 
Contingency Planning 
Contingency planning combines emergency preparation with routine office 
procedures to help the office continue operations with as little interruption as 
possible after a disaster. 
The real disaster is failure to prevent avoidable situations. 
For effective contingency planning, do the following: 
 Keep your office file plan up-to-date. Know which records your office has 

record copy responsibility for, and be ready to carry out disaster recovery and 
salvage procedures for those records. 

 Be aware of alternate locations for records. You may use this information to 
replace records quickly after a disaster. District and division offices that are 
related by function are often alternate locations for the same record, even 
though only one office may be designated as the office of record. Part of a 
disaster preparedness plan could include: 
o notation of alternate locations on the file plan, or 
o securing a copy of any procedures manual or internal office procedural 

material that may include information on alternate locations for records. 
 Keep a current list of contact persons for various types of records. 
 Keep identification and protections for vital records current. Carry out vital 

records protection as described in Chapter 6, "Vital Records" in a disciplined 
manner. 
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 Back up electronic records routinely and frequently. Dispersal of a second 
backup copy at another, off-site location is a good protective measure. 

Inactive Record Storage 

Generally, only active records need to be maintained in office space. A common 
measure for identifying active records is one reference per month per file or file 
drawer. Records kept for a specific period of time during which they are most likely to 
be referenced, (for example, the current fiscal year) may also be considered as active. 
Proper implementation of the TxDOT records retention schedule and use of inactive 
records storage 
 reduces the volume of records and the equipment and space needed to 

accommodate them, 
 increases the filing and retrieval efficiency in the office, 
 minimizes the cost of storing official department records for the required retention 

period, 
 preserves accessibility to records during their required retention periods, and 
 ensures proper coordination and documentation of the destruction of official state 

records. 
Records Eligible for Storage at a Records Center 
Only official record copy records or files of Austin headquarters divisions and offices 
listed on the TxDOT records retention schedule are eligible for storage at a the records 
center. Districts should maintain a similar policy for storing records to conserve 
resources. 
Information or convenience records or files are ineligible for storage, since they can be 
disposed of without formality once their administrative value has been met. 
A record series with a retention code of AV (as long as administratively valuable) is not 
eligible for records center storage unless a specific retention period and destruction 
date is assigned to it. 
For assistance contact TxDOT Records Management by e-mail from the link on 
the records management intranet site or at the phone number on the site. 
Storage Locations 
Eligible records from headquarters divisions or offices are stored at the TxDOT records 
center at 2000-A Centimeter Circle in north Austin. 
Districts may store inactive records locally or at off-site storage facilities. 
Selecting Records for Storage 
Points to consider when evaluating whether to transfer records to storage include: 
 volume of records and required minimum retention period 
 how frequently the records are needed or used 
 the urgency of need when they are required 
 time required for retrieval 
 availability, cost and use of office space and filing equipment vs. the lower cost of 

storage 
 viability of imaging (in Chapter 9, Section 1, Storing, Scanning or Microfilming?) as an 

alternative to hard copy storage. 
Microfilming Records 

Introduction and General Guidelines 

http://onlinemanuals.txdot.gov/txdotmanuals/rec/record_copy_responsibility.htm#i999895
http://crossroads/org/gsd/Records%20Management/retsked.htm
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Sections 441.188 and 441.189 of the Government Code authorize agencies to retain 
records on microfilm or electronically. Document imaging involves the conversion of 
hard copy original documents or records to an alternative medium. Records with 
permanent or long term (more than 20 years) retention periods or archival 
requirements may be retained on microfilm. Offices choosing to microfilm records may 
obtain those services through a purchase of services. This chapter contains guidelines 
for microfilming. See Chapter 5, “Electronic Records,” for information on electronic 
imaging. 
Storing, Scanning or Microfilming? 
The majority of department records require retention for fewer than five years. For all 
but permanent or archival records, storage in the original format is the easiest and 
cheapest way to retain hard copy inactive records until their destruction date. 
Scanning records to an electronic system has replaced microfilming of hard copy files 
that require lengthy retention as a standard department practice. Scanning is most 
efficient when done at the time a record would ordinarily be filed. Batch scanning of 
files for electronic storage is almost as labor-intensive as microfilming. 
The space-saving and distribution advantages of microfilm can be achieved by 
electronic imaging without incurring the limitations of film. Microfilming is labor-
intensive and expensive. Managers should carefully evaluate the actual need to use 
microfilm. Considerations include the manpower to prepare and index the records for 
microfilming, to inspect the microfilm product after filming and the cost, availability 
and maintenance of equipment to store and read or print copies from the microfilm. 
The following table describes the advantages and limitations of microfilm. 

Advantages Limitations 

 Space savings. Microfilm concentrates a large 
volume of information in a small package. 
One 250-foot roll of 16 mm microfilm can 
hold the equivalent of a document storage 
box of records (up to 4,200 8-1/2-by-11-inch 
pages or images). Nine 100-foot rolls can 
store the equivalent of one five-drawer file 
cabinet (25,000 8-1/2-by-11-inch pages or 
images). 

 Low cost distribution. Microfilm is 
inexpensive to duplicate. 

 File integrity. Once filmed, all records in a file 
are together, and individual records cannot 
be physically removed, lost or misfiled. Any 
alterations are apparent. 

 Security. Duplicate security copies can be 
stored in a separate place 

 Archival preservation. Microfilm may be 
used for reference in place of original 
documents and can offer an increased life 
span. 

 Expense. Microfilm is expensive and labor 
intensive to create. 

 Unclear copy. The quality of the original 
record affects the quality of the filmed image. 
Old, faded or damaged documents may not 
reproduce clearly. Colors do not appear, and 
it may be difficult to tell whether a filmed 
record is the original. Official certifications 
and explanatory notes filmed with the 
records on target sheets can address these 
limitations to some extent. 

 Equipment requirements. Microfilm requires 
equipment ranging from simple readers that 
cost as little as $150 to highly advanced 
reader/printers that can cost up to $30,000. 
Continuing availability of equipment and 
service support over time may present 
difficulties in using microfilm for archival 
preservation. 

 Environmental storage 
considerations. Microfilm will deteriorate if it 

http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.441.htm#441.188
http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.441.htm#441189
http://onlinemanuals.txdot.gov/txdotmanuals/rec/electronic_records.htm
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 Convertability. Microfilm images may be 
converted to paper or, with proper 
equipment, digitized. 

is stored in an environment that does not 
have temperature and humidity controls. See 
"Storage Environment" in this chapter. The 
product of deterioration, acetic acid, may 
present a workplace hazard to employees. 

 User resistance. Using microfilm and 
microfilm equipment for any length of time 
can be tedious. 

 
 
Microfilm Formats 
The most commonly used microfilm formats include: 
Roll film: The most economical microform, 16 mm width is typically used for 
documents, and 35 mm widths are used for larger format documents such as drawings 
or maps. Roll film ensures file integrity and is best used for long-term storage of 
inactive records. 
Microfiche: A sheet of 105mm film (usually 4 inches by 6 inches) that can contain at 
least 98 images (depending on the size of the originals), microfiche is best used for 
frequently referenced files. An eye-readable label makes retrieval easier. Because a 
microfiche is a single unit, it provides reasonable file integrity. It is moderately 
expensive to produce, although a microfiche reader is the least expensive type of 
microfilm reader. Microfiche, jackets (transparent cards 4 inches by 6 inches with 
chambers for the insertion of individual frames or strips of microfilm) are typically 
produced and the customer is furnished a microfiche duplicate for active use. 
Microfiche, jackets (transparent cards 4 inches by 6 inches with chambers for the 
insertion of individual frames or strips of microfilm) are typically produced and the 
customer is furnished a microfiche duplicate for active use. 

11: Records Destruction 
Authorization for Destruction 
Texas Government Code §441.187 authorizes TxDOT to dispose of any record listed on 
the approved TxDOT records retention schedule once the required retention period 
has been met. 
NOTE: Records involved in an audit, investigation, litigation or open records request 

cannot be destroyed until conclusion of the action involving those records. 
Advantages of Timely Disposal 
Destroying records as soon as they become eligible after having met their retention 
requirement benefits the department by: 
 reducing exposure to legal discovery and open records demands,. There is no 

requirement to produce records that were destroyed in the normal course of 
business, as long as there was no anticipated or actual legal action in place at the 
time of their destruction that would have required us to withhold them from 
destruction, and 

 reducing the cost of storage (physical space and equipment, virtual space, system 
performance), since the department now pays an external vendor for server storage 
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and network bandwidth services. Benefit will also accrue as enterprise FileNet 
libraries accumulate content over time. 

Records Eligible for Destruction 
Official (record copy) records are eligible for destruction when they have been 
retained for the total retention period in the TxDOT records retention schedule. 
Non-record convenience or information copies and e-mail of a transitory nature may 
be destroyed without formality once their purpose has been served. 
Withholding Records from Destruction 
Records involved in an audit, investigation, litigation or an open records request shall 
not become eligible for destruction until the final conclusion of the action and 
satisfaction of the retention requirements pertaining to records related to the action. 
Take steps to identify and preserve records involved in such actions as soon as you 
become aware of the possibility of the action, and include steps to verify conclusion of 
any actions during review of eligibility for destruction. Coordinate with the Office of 
General Counsel (OGC) to determine the status of any records subject to a litigation 
hold before authorizing their destruction. 
 
List of Best File Management Software and Systems: 

Below is a list of our picks for the best file management software and systems available 
today. 

 Microsoft Sharepoint 
 DocuWare 
 ProofHub 
 Google Drive 
 Alfresco 
 M-Files 
 OnlyOffice 
 LogicalDoc 
 Dokmee 
 Hightail 

#1. Microsoft Sharepoint 

https://www.microsoft.com/en-in/microsoft-365/sharepoint/collaboration
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Next up is Sharepoint, a file management system by Microsoft. SharePoint empowers 
teams to store all company knowledge- documents, files, content, etc and find anything 
they need quickly. SharePoint allows team members to create dynamic team sites for 
projects, departments, as well as division. Inside these sites, employees can share data, 
news, files, and other important resources and collaborate inside and outside the 
organization. 
With a tool like SharePoint, your employees can become more organized, and productive 
by having their files centrally located in team sites. Apart from being an amazing file 
manager, Sharepoint also combines many aspects of a calendar tool, messaging 
tools, project management tools, a company’s intranet, cloud storage service, and even 
a content management system. 
The platform is a part of the Microsoft 365 suite of apps and integrates with MS Office, 
Onedrive, Microsoft Teams, and more to bring all your collaboration in one place. 
Some Key Features of Sharepoint 

 Share files from Teams, Onedrive, and more 
 Mobile apps to access files anywhere, anytime. 
 Annotate, highlight, and comment on files. 

Pricing:  
 Free with limited functionality 
 Paid plans start from $5 per user per month 

#2. DocuWare 

https://blog.bit.ai/best-free-project-management-software/
https://bit.ai/content-management-system
https://start.docuware.com/
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DocuWare says that employees spend 50% of their time searching for documents. If 
that’s the case, we are in big trouble! Don’t worry though, Docurware handles all our 
search worries easily by allowing users to store all documents and files on its cloud-based 
platform. Document management and workflow automation service, Docuware reduces 
time wastage significantly and help employees be more productive. 
Docuware has advanced document indexing and storage abilities, making it easy to get a 
hold of your files, no matter where you are. With over 25 years of experience in the 
industry, Docuware has evolved into a robust file management system and continues to 
provide a great service. 
Along with file management, Docuware automates business processes such as 
onboarding of new employees, invoice processing, or contract management. 
Furthermore, Docuware protects your files from unauthorized access by providing 
regulatory compliance safety features and disaster recovery benefits. 
Some Key Features of Docuware 

 Process planner to plan out business processes 
 Barcode scanning and invoice processing 
 Integration with other cloud applications like Google Drive 

Pricing:  
 Paid plans start from Cloud Base (Includes 4 named client users with 20 GB 

storage), Cloud Professional (Includes 15 named client users with 50 GB storage), 
Cloud Enterprise (Includes 40 named client users with 100 GB storage), Cloud 
Large Enterprise (Includes 100 named client users with 250 GB storage) 

  
#3. ProofHub 

https://www.proofhub.com/features/file-management-software
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When it comes to enhanced team collaboration and simplified project management, 
ProofHub is a cloud-based SaaS tool that needs no introduction. ProofHub offers a wide 
range of advanced features under one virtual roof, including efficient “File Management 
Software”. Project teams also spend a considerable amount of time sorting and 
organizing their digital files and documents, but ProofHub’s File Management system 
simplifies the whole process.  
The software enables project teams to upload, store, and organize all their documents in 
one place. You can easily access your files, share links and collaborate on them with 
widely distributed team members. “File versioning” allows you to store multiple versions 
of the same file, and “Advanced search” makes it easy to locate your documents by using 
relevant keywords and phrases.  
 You can also use ProofHub’s File Management system on your mobile phone.   
Some Key Features of ProofHub’s File Management Software:  

 Online proofing allows you to review, proof, and annotate files with markup tools 
 Attach files and documents to tasks, discussions, chats, and notes 
 Real-time collaboration and feedback sharing on files  

Pricing:  
 ProofHub offers two pricing plans – The Essential plan with all basic features at 

$45/month, billed annually, and the Ultimate Control plan with all basic plus 
premium features is priced at $89/month, billed annually. 

  
#4. Google Drive 

https://www.google.com/drive/
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Need something casual? Check out Google Drive, a file management system by Goole. 
Even though not as powerful or robust as other file management software on this list, it 
still gets the job done and is a great tool for the average user. A free collaboration 
platform by Google, Drive integrates with Google Docs and Google sheets, allowing you 
to store all your documents and files inside Drive with one click. 
Google Drive offers free 15GB of cloud storage to store all your files and you can upgrade 
to a pro version in case you need more. The platform is simple and intuitive to use, 
however it doesn’t really scale when you have a large company. Drive also has 
smartphone apps for both iOS and Android so you can access your files on the go. 
Some Key Features of Google Drive 

 User-friendly, simple design 
 Integrates with Google Docs and Google Sheets 
 Perfect for individual users 

Pricing:  
 Free 15 GB storage 
 Paid plans start from: 100GB for $1.99, 200GB for $2.99, and 2TB for $9.99 per 

month. 
Read more: What is Knowledge Management and Why Your Organization’s Success 
Depends on It? 
  
#5. Alfresco 

https://blog.bit.ai/what-is-knowledge-management/
https://blog.bit.ai/what-is-knowledge-management/
https://www.alfresco.com/
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Next up is Alfresco, an Enterprise Content Management Tool aimed to streamline your 
organization’s knowledge. Alfresco removes content silos by providing users a single 
source of truth for all their data and files. No more searching emails and hard drives for 
content and documents! 
Want to improve your workflow? Alfresco’s document management lets employees find, 
share, and store all important files including legal contracts, marketing assets, customer 
files, and more. With document scanning and capture, get more out of your documents, 
and unlock business intelligence like never before. Alfresco’s AI and machine learning 
capabilities can also extract information from AWS. Alfresco is available on the web, on 
desktop, and via mobile apps. 
Some Key Features of Alfresco 

 Smart folders to find information quickly 
 Built-in workflows to simplify document review and approval process 
 Multiple layers of access permissions for added security 

Pricing:  
 Free trial 
 Paid plans start from Starter (supports 100 users), Business (supports 300 users), 

Enterprise (supports 1000 users)- customized pricing. Contact sales. 
  
 
#6. M-Files 

https://www.m-files.com/en
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An intelligent information management system, M-Files is next up on our list. The 
platform organizes company files based on what the file is about and not where it’s 
stored. By creating a central location for all files, M-files allows users to quickly find the 
file they are looking for, no matter where (desktop, cloud storage services, etc) the file is 
stored. 
Simply tag the file, fill in the metadata, and click save and M-files will easily locate your 
data and would also notify you of any sort of duplication. M-Files is a platform and 
device-independent, meaning that users can choose between on-premises, cloud, or 
hybrid deployment of M-files and simplify their workflow. With enterprise-grade security, 
you would never have to worry about losing your data with M-Files. 
Some Key Features of M-Files 

 Search across devices, services, and locations 
 Cloud-based, on-premise, or hybrid deployment 
 Integrates with Salesforce, Sharepoint, Google Gsuite, and more 

Pricing:  
 Contact sales 

 #7. OnlyOffice 

https://www.onlyoffice.com/
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OnlyOffice wants your entire office files to be deployed on their platform for easy storage 
and retrieval. Employees can upload files, documents, presentations, spreadsheets, and 
other workplace data to Onlyoffice’s web app and manage it online. OnlyOffice was 
awarded as the best document management software of 2018 by PCmag and we aren’t 
complaining! 
Apart from storing your files, OnlyOffice allows users to track changes, collaborate in 
real-time, leave suggestions, and access version history. Supporting all major file formats 
including PDF, DOC, CSV, TXT, and HTML, OnlyOffice makes sure all your files are secured 
on their platform. 
Users can also connect their cloud storage services like Dropbox or Google Drive to bring 
all of their data under one roof. 
Some Key Features Onlyoffice 

 Store and play videos in multi-format 
 Share files as read-only, review, comment, form filling, or full access. 
 Version and revision control system 

Pricing:  
 Free trial 
 Paid plans start from Enterprise Edition Start ($1200/server, lifetime access), 

Enterprise Edition Standard ($2400/server, lifetime access), Enterprise Edition 
Standard+ ($4800/server, lifetime access). 

#8. LogicalDoc 

https://www.logicaldoc.com/
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Looking for an open-source solution to your file management worries? Try LogicalDoc, an 
open-source file management system with the bells and whistles of an enterprise 
document management. LogicalDoc is perfect for those organizations that already have a 
ton of paper documents lying around and what to convert those into digital documents. 
The platform is available for deploying as both a cloud-based web app and as on-premise 
software. 
The tool is really easy to use- simply drag and drop files to your dashboard and create 
your digital file library. With collaboration features in-built, users can create and edit 
documents together and keep a record of version history. The platform also has an 
internal messaging system as well as barcode management capabilities. 
Some Key Features of LogicalDoc 

 Auto-naming and auto-filing of documents 
 Syncs across devices, be it Windows, Mac, iOS, or Android 
 Barcode scanning, bulk upload, auto-import from email, and more 

Pricing:  
 Book demo for pricing quote 

  
#9. Dokmee 

https://www.dokmee.com/
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Next up is Dokmee, another great file management system that wants to help you get rid 
of your paper documents. The platform works by the user uploading their electronic files 
to the Dokmee cloud and let Dokmee do the rest. Users can organize their files in 
separate folders and spaces, making them easy to find and retrieve. With powerful 
production level-imaging and data capture, users can scan and index files onto the 
Dokmee cloud with ease. 
With collaboration features like multi-user access, document audit, restrictions, version 
control, and more, Dokmee ensures teamwork and compliance in the workplace. 
Dokmee’s scanning technology can also extract data from documents like page size, page 
count, and compression type. With enterprise-grade-security data centers and 24×7 
monitoring and power supply, your files are safe with Dokmee. 
Some Key Features of Dokmee 

 Automated data capture and annotations 
 Rules-based document indexing and routing 
 File sharing and collaboration 

Pricing:  
 Free trial 
 Paid plans start from $29/month 

Read more: Best Cloud Document Management Systems in 2022 
  
 
 
 
 
 
 
 
#10. Hightail 

https://blog.bit.ai/best-cloud-document-management-system/
https://www.hightail.com/
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Formerly known as YouSendIt, Hightail is the last tool on our list. A file sharing and 
collaboration platform, Hightail works around “spaces” which are nothing but groups 
where employees can share files with another and collaborate on work. Hightail makes it 
extremely convenient to add files to their platform- whether you prefer to drag and drop 
them to the Hightail dashboard or import them from other services like Dropbox or 
Google Drive. 
Apart from file sharing, Hightail also promotes creative collaboration, and employees can 
annotate content, collect different versions, and chat in real-time to get work done. You 
can also track files sent and received and be on top of your work. With password 
protection and expiration limits, users can share their files in a safe and secure way. 
Some Key Features of Hightail 

 Integrates with Google Drive, Dropbox, and OneDrive 
 Share files without needing a Hightail account 
 Receive email notification once your files are delivered. 

Pricing:  
 Free with limited functionality 
 Paid plans start from Pro ($12/month per user), Teams($24/month per user), 

Business ($36/month per user) 
Conclusion 

These are our top picks for the best of the best file management system on the market 
today. Every business creates and shares a ton of files and documents, making them an 
indispensable part of our workflow. 
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Streamlining this process can do wonders for employee productivity, efficiency, and 
stress management. A file management system helps you do just that and thus, gives you 
an advantage over your competitors. 
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Module 6: Digital Communication (email and others) 

 

Lesson 1: Email Basics 

Introduction 

Do you ever feel like the only person who doesn't use email? You don't have to feel left 
out. If you're just getting started, you'll see that with a little bit of practice, email is easy 
to understand and use. 
 
In this lesson, you will learn what email is, how it compares to traditional mail, and how 
email addresses are written. We'll also discuss various types of email providers and the 
features and tools they include with an email account. 
 

Getting to know email 

Email (electronic mail) is a way to send and receive messages across the Internet. It's 
similar to traditional mail, but it also has some key differences. To get a better idea of 
what email is all about, take a look at the infographic below and consider how you might 
benefit from its use. 
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Email advantages 

 Productivity tools: Email is usually packaged with a calendar, address 
book, instant messaging, and more for convenience and productivity. 

 Access to web services: If you want to sign up for an account like 
Facebook or order products from services like Amazon, you will need an 
email address so you can be safely identified and contacted. 

 Easy mail management: Email service providers have tools that allow you 
to file, label, prioritize, find, group, and filter your emails for easy 
management. You can even easily control spam, or junk email. 

 Privacy: Your email is delivered to your own personal and private account 
with a password required to access and view emails. 

 Communication with multiple people: You can send an email to multiple 
people at once, giving you the option to include as few as or as many 
people as you want in a conversation. 

 Accessible anywhere at any time: You don’t have to be at home to get 
your mail. You can access it from any computer or mobile device that has 
an Internet connection. 

Understanding email addresses 

To receive emails, you will need an email account and an email address. Also, if you want 
to send emails to other people, you will need to obtain their email addresses. It's 
important to learn how to write email addresses correctly because if you do not enter 
them exactly right, your emails will not be delivered or might be delivered to the wrong 
person. 
Email addresses are always written in a standard format that includes a user name, 
the @ (at) symbol, and the email provider's domain. 
The user name is the name you choose to identify yourself. 

 
The email provider is the website that hosts your email account. 

 
Some businesses and organizations use email addresses with their own website domain. 
 

 
About email providers 
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In the past, people usually received an email account from the same companies that 
provided their Internet access. For example, if AOL provided your Internet connection, 
you'd have an AOL email address. While this is still true for some people, today it's 
increasingly common to use a free web-based email service, also known as webmail. 
Anyone can use these services, no matter who provides their Internet access. 
Webmail providers 
Today, the top three webmail providers are Yahoo!, Microsoft's Outlook.com (previously 
Hotmail), and Google's Gmail. These providers are popular because they allow you to 
access your email account from anywhere with an Internet connection. You can also 
access webmail on your mobile device. 

 
Visit the links below to compare the features of the three top webmail providers: 

 Yahoo! Features 
 Outlook.com Features 
 Gmail Features 

Other email providers 
Many people also have an email address hosted by their company, school, or 
organization. These email addresses are usually for professional purposes. For example, 
the people who work for this website have email addresses that end 
with @gcflearnfree.org. If you are part of an organization that hosts your email, they'll 
show you how to access it. 
Many hosted web domains end with a suffix other than .com. Depending on the 
organization, your provider's domain might end with a suffix like .gov (for government 
websites), .edu (for schools), .mil (for military branches), or .org (for nonprofit 
organizations). 
Email applications 
Many companies and organizations use an email application, like Microsoft Outlook, for 
communicating and managing their email. This software can be used with any email 
provider but is most commonly used by organizations that host their own email. 
Email productivity features 
In addition to email access, webmail providers offer various tools and features. These 
features are part of a productivity suite—a set of applications that help you work, 
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communicate, and stay organized. The tools offered will vary by provider, but all major 
webmail services offer the following features: 

 Instant messaging, or chat, which lets you have text-based 
conversations with other users . 

 
 An online address book, where you can store contact information for the 

people you contact frequently 

 
 An online calendar to help organize your schedule and share it with 

others 
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 A public profile that you can use for basic social networking purposes, like 

sharing photos, previous work or school history, and status updates, 
among other things 

 
In addition, each provider offers some unique features. For instance, when you sign up 
for Gmail you gain access to a full range of Google services, including Google 
Drive, Google Docs, and more. Outlook, on the other hand, offers connectivity 
with OneDrive and Microsoft Office Web Apps. You can visit our tutorials on Google 
Drive, Google Docs and OneDrive and Office Online to learn more. 
Lesson 2: Getting started with email 
You should now have a good understanding of what email is all about. Over the next few 
lessons, we will continue to cover essential email basics, etiquette, and safety tips. 
Setting up your own email account 
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If you want to sign up for your own email account, we suggest choosing from one of the 
three major webmail providers. 

 Yahoo! Mail: Click Create Account 
 Outlook.com: Click Sign up 
 Gmail: Click Create an account (review our lesson on Setting Up a Gmail 

Account for help) 
 

Lesson 2: Common Email Features 
Introduction 
No matter which email service you choose, you'll need to learn how to interact with 
an email interface, including the inbox, the Message pane, and the Compose pane. 
Depending on the email provider, the interfaces may look and feel different, but they all 
function in essentially the same way. 
In this lesson, we'll talk about using an email interface to send and receive messages. 
We'll also discuss various terms, actions, and features that are commonly used when 
working with email. 
Understanding the email interface 
Below are some examples of different email interfaces from Gmail. Review the images 
below to become familiar with various email interfaces. 
Keep in mind that these examples will only provide a general overview. You can visit 
our Gmail tutorial to learn how to use an email application in detail. 
Inbox 
The inbox is where you'll view and manage emails you receive. Emails are listed with the 
name of the sender, the subject of the message, and the date received. 

 
Message pane 
When you select an email in the inbox, it will open in the Message pane. From here, you 
can read the message and choose how to respond with a variety of commands. 

http://www.gcflearnfree.org/gmail/


 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  999 | 1352  

 
Compose pane 
You can click the Compose or New button from your inbox to open the Compose pane to 
create your own email message. From here, you'll need to enter the recipient's email 
address and a subject. You'll also have the option to upload files (photos, documents, 
etc.) as attachments and add formatting to the message. 

 
 
A Compose pane will also appear when you select Reply or Forward. The text from the 
original message will be copied into the Compose pane. 
Common email terms and actions 
All email applications use certain terms and commands you will need to understand 
before using email. The examples below use Gmail's Compose pane and Message 
pane to introduce basic email terms, but these will still be applicable for Yahoo! and 
Outlook. 
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Lesson 3: Contacts and Calendars 
Introduction 
In addition to email services, most webmail providers offer an online 
calendar and address book. These features make it easy to stay organized and access 
your important information from anywhere. 
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In this lesson, you'll learn more about the basics of online calendars and contacts 
lists using examples from a few common webmail providers, including Yahoo! and Gmail. 

 
Contacts basics 
Online contacts lists help you organize contact information for your friends, family, and 
coworkers, just like an address book. Once people are added to your contacts list, it's 
easy to access their information anytime and anywhere. 
Review the examples below to become familiar with the basic features and advantages of 
online contacts lists. 
Adding contacts 
It's easy to add people to your contacts list. When you create a new contact, you should 
(at the very least) enter a first and last name, as well as an email address. However, you 
can also enter other information, like a phone number, home address, and more. In 
most email accounts, the name and email of anyone you correspond with will be added 
to your contacts list automatically. 
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Selecting contacts 
Once you've added people to your contacts list, you'll never have to worry about 
remembering an email address. Whenever you create a new email, you can select 
the To or Add Recipients button. 

 
Then choose recipients from your contacts list. The contacts' email addresses will be 
added automatically to the message. You'll even be able to use the same contact 
information for other webmail services, like instant messaging and calendar sharing. 
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Most email services will also autocomplete or suggest an email address when you start 
typing, as long as it's an address that's already been saved in your contacts. 

 
Linking contacts 
If you already have a lot of contacts saved in another web-based service, such as 
Facebook or LinkedIn, it's easy to link them between accounts, which can save you a lot 
of time. For example, you could import your Facebook contacts to your webmail service 
or use your existing contacts list to search for friends on Facebook. 

 
Contact groups 
If you frequently connect with the same group of people, you can create contact 
groups for quick access. This allows you to quickly sort your contacts by type. For 
example, you might use one group to organize your personal contacts and another 
for professional contacts. 
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Calendar basics 
Online calendars make it easy to schedule appointments, organize tasks, and manage 
your time, just like a desk calendar. But unlike a physical calendar, online calendars give 
you the freedom to quickly edit and rearrange your schedule whenever you want. You'll 
even be able to access your calendar on the go and sync it across multiple devices, like 
your mobile phone and personal computer. 
Review the examples below to become familiar with the basic features and advantages of 
online calendars. 
 

 
Creating appointments 
It's easy to schedule, track, and edit upcoming appointments or events. When you create 
a new appointment, you should (at the very least) include a title, start and end time, 
and location, but you can also include other information, such as reminder 
preferences, detailed notes, and more. 
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Switching views 
You can choose a variety of view options for your calendar, including a daily, weekly, 
and monthly summary of your upcoming appointments. 

 
Using multiple calendars 
If you keep a lot of different appointments, you can create multiple calendars to help 
organize your schedules. For example, you might use one calendar to keep track of your 
personal tasks and another to manage your family's schedule. Each calendar is assigned 
its own color, so it's easy to organize lots of different appointments. You can 
even toggle calendars on and off to easily sort your appointments. 
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Sharing calendars 
You can share your calendar with anyone who uses the same webmail provider. Once 
you've shared a calendar, you'll be able to view and even edit a friend's calendar, 
depending on your sharing preferences. 
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Lesson 4: Email Etiquette and Safety 
Introduction 
Like any form of online communication, it's important to practice good etiquette and 
safety when using email. Etiquette is a set of rules and guidelines that people use to 
communicate more effectively. You should also know how to protect yourself from 
certain risks, like malware and phishing. 
In this lesson, we'll discuss writing more effective emails using good email etiquette, both 
for personal use and in the workplace. We'll also talk about different strategies for using 
email safely. 
Tips for email success 
Here are some basic rules you can follow to write better emails, no matter who you're 
emailing. In some cases, it's OK to break these rules. Use these rules as a starting point, 
then tailor each email you send based on the situation. 
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Lesson 4: Email attachment etiquette 
Attachments are an easy way to share files, photos, and more, but many people aren't 
aware of some of the most common attachment mistakes. Be sure to follow these basic 
rules when including attachments in your emails. 
Mention included attachments 
Never attach a file without mentioning it in the body of your email. Something as simple 
as I've attached a few photos to this email will help your recipients know what to 
expect. On the other hand, make sure the attachments you mention are actually 
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included with the message—it's easy to focus on your message and forget to include the 
file itself. We recommend attaching any files before you start writing. 

 
Consider file size and format 
Avoid sending excessively large attachments or uncompressed photos, which can take a 
long time for your recipients to download. You can always ZIP or compress files to make 
them easier to send. Additionally, make sure your attachments don't need to be viewed 
in a specific application—use universal file types like .PDF, .RTF, and .JPG. 

 
Only include related files 
If you need to send a lot of different files to the same person, consider sending the 
attachments through multiple emails. If you include several unrelated files in the same 
email, it can be difficult for your recipients to find the exact file they need. 
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While attachments are still an easy way to share files quickly over email, many people 
have begun using cloud-based storage services like Google Drive and Microsoft 
OneDrive to share large files. Rather than sharing the file itself, you can share a link, 
allowing others to access the file remotely.  
Using email in business 
Whether you're using email at work or applying for a job, the normal rules of email 
etiquette still apply. However, there are a few additional considerations to keep in mind, 
as business emails can affect your professional reputation. 
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Remember, you should never use your work email account for personal communication. 
It's best to get your own personal account from a webmail service like Gmail, Yahoo!, or 
Outlook.com.  
Email safety 
Email is not totally secure, so you should avoid sending sensitive information like credit 
card numbers, passwords, and your Social Security Number. In addition, you may 
receive emails from scammers and cybercriminals. The first step in dealing with email 
safety concerns is understanding them so you know what to look for. 

 
Spam 
Spam is another term for junk email or unwanted email advertisements. It's best 
to ignore or delete these messages. Luckily, most email services offer some protection, 
including spam filtering. 
Phishing 
Certain emails pretend to be from a bank or trusted source in order to steal your 
personal information. It's easy for someone to create an email that looks like it's from a 
specific business. Be especially cautious of any emails requesting an urgent response. 
Attachments 
Some email attachments can contain viruses and other malware. It's generally safest not 
to open any attachment you weren't expecting. If a friend sends you an attachment, you 
may want to ask if he or she meant to send it before downloading. 
Setting up your own email account 
Now that you've finished exploring Email Basics, you may feel ready to set up your own 
email account. You can get a free email account from any major webmail provider, 
including Yahoo!, Outlook.com, and Gmail. 

 
Lesson 5: Extras 
Time-saving email tips 
Many email clients have a variety of helpful features you might not know about. These 
features are pretty easy to use, and they can save you time and help you to better 

https://www.gcflearnfree.org/email101/introduction-to-email/1/
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organize your emails. In this lesson, we'll go over some of these tips and tricks to help 
you optimize your email experience. 
Selecting multiple emails 
Let's say you have a large number of emails you'd like to delete. It would be fairly time 
consuming to go through and individually delete each email. Luckily, most clients have a 
feature that allows you to select multiple emails. These are usually in the form of check 
boxes next to each of your emails. Many clients also have a Select All button, which will 
select every email on the page, as seen below. 

 
Once the emails are selected, you can then perform any action you want, including 
deleting, sorting, and archiving. 
Keyboard shortcuts 
Most email clients have some set of keyboard shortcuts that can help you navigate your 
emails more quickly. An example that's fairly universal is using the arrow keys to scroll 
through email messages instead of having to click specific buttons. Other keyboard 
shortcuts (like replying and deleting) will vary from client to client. Below are a few 
support pages listing shortcuts for some popular clients: 

 Gmail 
 Outlook 
 Yahoo! Mail 

If you use an email service other than those listed above, you should be able to find its 
corresponding keyboard shortcuts via its help page or a quick Internet search. 
Creating groups 
If you find yourself sending emails to the same people on a regular basis, it might be a 
good idea to create a group. Many clients allow you to select various email addresses 
and save them as a single group. This way, you can simply select the group as the 
recipient instead of having to select each individual address. This feature can usually be 
accessed from the Contacts page of your email client. 
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Email filters 
When you're receiving a lot of emails on a daily basis, it can be difficult to keep them 
organized. Luckily, various email clients offer a feature called filters, which basically sort 
your emails into folders as you receive them. 
You can create filters that sort your email by various characteristics, including 
specific senders or recipients, keywords in the subject or body, and attachments. For 
example, let's say you want to make sure emails from Twitter don't get lost among the 
rest of your messages. You could create a filter that sorts every email received from 
Twitter, as shown below. 

 
 
Lesson 6: Email violations can jeopardize your job 
Embarrassing or inappropriate communications sent via company email can damage 
professional credibility, reputations, and careers. Employees who violate their 
companies' email policies can face penalties ranging from disciplinary action to 
termination. 
 
Many employers monitor email, and some employees have even been fired for violating 
their companies' email policies. Violation of company email policy and messages 
containing inappropriate or offensive language are the two most common causes for 
email-related firing. While workers may be disciplined or fired because of inappropriate 
email messages, companies can face the risk of lawsuits. 
 
It's important to find out what your company’s email policies are, and make sure you 
comply. But in general, there are a few guidelines to keep in mind when it comes to 
handling email at work. 
 
Keep it professional 
Never convey anger, use profanity, or make racist or sexist remarks. Remember, 
inappropriate words or images sent via email can come back to haunt you. Don't send or 
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forward emails containing libelous, defamatory, offensive, racist, or obscene remarks—
even if they are meant to be a joke. 
 
Keep in mind that while email is a convenient way of sending information, it's not always 
the best way to communicate. Things like tone, facial expression, and body language can 
completely change the meaning of a word or phrase. But because these things are lost in 
email communication, it's possible for people to interpret messages the wrong way. 
 
Don't discuss confidential information 
Most email is insecure unless it has been encoded or encrypted. Because of this, sending 
an email is like sending a postcard for many eyes to see. Never send confidential 
information to someone through email. 
 
Think before you send 
Don’t treat email casually. Play it safe. In general, don't write anything in email that you 
wouldn't feel comfortable saying in a crowded elevator. Whenever you're writing an 
email, take a moment to think before you send. 
 
Lesson 7: Avoiding Spam and Phishing 
Avoiding spam and phishing 
From email to instant messaging to social media, the Internet is an essential 
communication tool. Unfortunately, it's also popular among scammers and 
cybercriminals. To protect yourself from email scams, malicious software, and identity 
theft, you'll need to understand how to identify and avoid potentially dangerous content 
in your inbox, including spam and phishing attempts. 
Dealing with spam 
If you've ever received unwanted email advertisements, you may already be familiar 
with spam, also known as junk email. Spam messages can clutter your inbox and make it 
more difficult to find the emails you actually want to read. Even worse, spam often 
includes phishing scams and malware, which can pose a serious risk to your computer. 
Fortunately, most email services now include several features to help you protect your 
inbox from spam. 
Spam filters 
Whenever you receive an email, most email providers will check to see if it's a real 
message or spam. Any likely spam messages will be placed in the spam folder so you 
don’t accidentally open them when checking your email. 
Spam-blocking systems aren’t perfect, though, and there may be times when legitimate 
emails end up in your spam folder. We recommend checking your spam folder regularly 
to make sure you aren’t missing any important emails. 
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Many email services also have a feature you can use to mark emails as spam. In Gmail, 
for example, you can select the message and click the Mark as Spam button. This helps 
your email provider filter out these types of messages in the future. 

 
Turning off email images 
Spam messages often contain images that the sender can track. When you open the 
email, the images will load and the spammer will be able to tell if your email works, 
which could result in even more spam. You can avoid this by turning off email images. 
Let's look at how to do this in Gmail, but remember that the process will vary depending 
on your email service. 

1. Click the gear icon, then select Settings from the drop-down menu. 

 
2. Select Ask before displaying external images, then click Save at the 

bottom. 
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3. Whenever you open a message with images, Gmail will prevent them 

from loading by default. 

 
Phishing 
Phishing scams are messages that try to trick you into providing sensitive information. 
These often appear to come from a bank or another trusted source, and they'll usually 
want you to re-enter a password, verify a birth date, or confirm a credit card number. 
Phishing messages may look real enough at first glance, but it’s surprisingly easy for 
scammers to create convincing details.  
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Other common email scams 
Spam and phishing are common problems, but there are many other types of email 
scams you may encounter. Some will promise to give you a lot of money if you advance a 
small amount upfront. Others may pretend to be from people you know in real life, and 
they'll often ask you to send money or download an attached file. 
As with spam and phishing scams, remember to trust your best judgement. You 
should never send someone money just because you've received an email request. You 
should also never download email attachments you weren't expecting because they 
might contain malware that could damage your computer and steal your personal 
information. 
Spam, scams, and phishing schemes will continue to evolve and change. But now that 
you know what to look for—and what to avoid—you can keep your inbox and computer 
that much safer. 
Lesson 8: How Formal Should an Email Be? 
Finding the right tone for an email can be tricky. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1023 | 1352  

 
Sometimes it may feel like an email must be formal in order to be correct. The truth is, a 
formal tone isn’t always automatically better than a casual tone. But how do you know 
which one to use, and when? There are several things you can look for to help you decide 
how formal or casual the tone of your email should be. 
When should an email sound more formal? 

 
Consider the person you're writing to. How do you know this person? What, if any, 
contact have you had in the past? These factors are going to be the best guide in deciding 
the tone of your email. If you’re initiating first contact with someone such as a potential 
employer—or anyone in a position superior to you—generally you want to default to a 
formal tone. 
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Whenever you’re writing to someone you’ve never met in person, the tone of your email 
is especially important. Because this email will be your way of making a first impression, 
you want to make sure it’s a good one. Stick to greetings that use either a full name or a 
title and last name if you have that information. If you don’t have the name of the person 
you’re emailing, using Dear Sir or Madam is fine. 
Using more professional language and avoiding contractions will also give your email a 
more formal tone. For example, instead of I won’t be able to make it, saying Regretfully, 
I will not be able to attend gives your email an overall more professional tone. Also keep 
in mind that avoiding abbreviations and using correct spelling and grammar are just as 
important when it comes to setting the tone of your email. 
In the example below: 
An applicant is emailing a recruiter she's never met. The formal greeting and language 
she uses give her email a more professional tone. 

 
Similarly, you want to make sure you’re closing your email in a way that matches the 
greeting of your email. Ending an email with simply Thanks! may sound friendly, but it 
can come off as too familiar and casual. For more formal emails, your best bet is to close 
with something like Thank you very much or Best regards to maintain a professional 
tone. 
Be sure to provide contact information. 
This is particularly important when initiating contact with someone—especially potential 
employers. You want to make sure they have all the information they need to contact 
you in the future. 

 
However, the rules of formality may not always apply. 
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For instance, if you’re writing a response to an email you have received, make note of the 
tone and language used by the sender. This can help take a lot of the guesswork out of 
deciding the tone of your email. 
If you notice that the tone sounds less than perfectly formal, it’s OK to mirror this in your 
reply. For example, if in the greeting someone uses Hi and your first name, it would be 
acceptable to use the same tone in your response. Look at the other person's use of 
abbreviations, contractions, and general word choice as a guide. In most situations, 
mirroring the tone set is perfectly acceptable for your response. 

 
When is it OK for an email to sound more casual? 

 
Situations in which it is acceptable to send a more casual, friendly email tend to be more 
obvious. For example, if you’re writing to a friend or family member, it is of course 
appropriate to use a casual tone. 
When it comes to people like your colleagues or peers, take two things into consideration 
when deciding on tone: 

1. How long have you known this person? 
2. In what context have you known this person? 
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Generally, the longer you’ve known someone—or if you interact with a person outside of 
work with some frequency—the more acceptable it is to use a casual tone. An email with 
a very casual tone may read more like a text message than a letter, and it could include 
things like abbreviations or emoticons—it all depends on the culture of your workplace. 
Think about the environment you work in, and look for examples set by your peers and 
superiors when deciding whether to use things like these. 
One very important thing to keep in mind: 

 
Professional isn’t always the same as formal. In a work environment, it’s important to 
always remain professional, even when the tone is casual. It’s never a good idea to gossip 
or say anything bad about other people you work with, no matter how well you know the 
colleague or coworker you’re emailing. It’s the sort of thing that could very easily come 
back to haunt you, but fortunately it’s also easy to avoid. 
Lesson 9: All About Online Communication 
Introduction 
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In the past, email was the best way to communicate with people online. But today, there 
are many different ways to talk online, allowing you to do things like: 

 Make phone calls from your computer and even see the person you're 
talking with 

 Share with lots of friends at the same time without sending an email to 
each of them individually 

 Engage with different websites by making comments or posting your own 
content 

Over the next several lessons, we'll take a look at some different methods of online 
communication, including chat, video calling, text messages, and status updates. 
How people communicate online 
When people are not online, they use a variety of communication methods, 
including phone calls, written letters, and face-to-face conversation. We use these 
different methods depending on the situation. Online communication is very similar: 
People may use instant messaging, video chat, or social networking depending on the 
situation. You can choose whichever methods best fit your needs. 
Review the graphic below to get an idea of how a few different people communicate 
online. 
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Staying safe online 
No matter how you communicate online, you'll need to think about privacy and safety. 
Each service that we'll discuss has its own privacy settings. It's helpful to review these 
settings before using any service to avoid revealing your conversations and personal 
information to a broader audience. 
Act as if you were communicating offline: Remember, everything you write online is 
relatively permanent, so even passing comments could have negative consequences for 
you or someone else in the future. 
Lesson 10: Chat and Instant Messaging 
 

 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1029 | 1352  

Chat and instant messaging (IM) are short messages sent and read in real time, allowing 
you to converse more quickly and easily than email. 
Chat and IM are generally used when both (or all) people are online, so your message 
can be read immediately. By comparison, an email message won't be seen until the 
recipient checks his email, meaning that chat and IM are better for quick messages and 
conversations. 
Chat vs. IM 
The terms chat and IM are sometimes used interchangeably. However, they can have 
slightly different meanings: 

 Chat often occurs in a virtual chat room, which can include many different 
people who may or may not know each other. Many chat rooms focus on 
a particular topic or interest. 

 IM usually includes a list of your contacts, called a Buddy List or Friend 
List, which allows you to see who is online. IM is especially suited for one-
on-one communication, but it's possible to send messages to multiple 
people at once. IM is technically a kind of chat, and some IM services use 
the term "chat" instead. 

Pros and cons of instant messaging 
Will chat or IM work for your needs? Review some of the pros and cons to help decide: 
Pros: 

 It's instant; you don't need to wait for the other person to check his email. 
 It's great for quick messages, questions, or notifications. 
 Compared to email, it's easier to carry on a conversation (or even multiple 

conversations). 
 You can stay logged in while doing other things on your computer, which 

makes it easy to multi-task. 
Cons: 

 If someone is not online, you may have to contact him another way. 
 It's not as convenient as email for lengthy or complicated messages. 
 It's not always instantaneous: If your friends are busy or away from the 

computer, it may take a while for them to respond. 
 Since people may type quickly or use abbreviations, messages could be 

difficult to understand. Also, as with email, it's possible to misinterpret 
someone's tone. 
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Lesson 11: Online Phone Calls 
 

 
It's easy to make free or inexpensive phone calls to almost anywhere in the world using 
your computer. You don't even necessarily need a super-fast Internet connection. Many 
IM and chat services include voice chat, which lets you talk to your friends who are 
online. 
Some services go a step further, allowing you to call any phone number and even 
providing you with a phone number for others to call. As these services are often very 
inexpensive, some people use them to replace their traditional, or landline, phone 
service entirely. 
You may have heard the term VoIP (pronounced "voyp"), which stands for Voice over 
Internet Protocol. VoIP can be used to describe any kind of online phone service. 
Hardware and software requirements 
In order to make phone calls from your computer, you'll need 
a microphone and speakers, or better yet, a headset with a microphone. If your 
computer has a built-in microphone and speakers, you may be able to use those instead. 
There are also adapters that will let you connect a regular phone to your computer or 
your router. 
Different services will have their own hardware and software requirements, but most 
computers from the last few years will have more than enough processing power. In 
addition, a broadband Internet connection is recommended but not necessarily 
required. 
Pros and cons of online phone services 
Will an online phone service work for your needs? Review some of the pros and cons to 
help decide: 
Pros: 

 Some services are free or very inexpensive. 
 Unlike chat or email, you can actually talk to someone. 
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 You can use it as a replacement for your landline, or just to save minutes 
on your mobile phone. 

 It's possible to set up a conference call (or group chat) with multiple 
people. 

Cons: 
 Compared to IM or chat, it's more difficult to carry on several 

conversations at once. 
 Unlike a traditional phone, it won't work if the power goes out. 
 Some features, like the ability to call phones, may cost extra. 
 You may need to purchase a microphone, speakers, or headset if you 

don't already own these. 
 On slower Internet connections, it may not work at all or could be 

unreliable. 
 Most online phone services cannot be used to make emergency calls. 

Lesson 12: Video Chat and Group Calls 
 

 
Video chat allows you to see and hear the people you're communicating with in real 
time. Whether you're talking with a family member or collaborating at work, video chat 
can add a personal touch to your conversations. Just like voice chat, it's included in 
many IM and chat services, and it's often free. 
Hardware and software requirements 
Like voice chat, you'll need a microphone and speakers, or a headset that contains both. 
You'll also need a webcam so the other person can see you. Many computers have 
a built-in webcam, usually located just above the screen. There are also inexpensive 
webcams that connect to your computer's USB port, which can be purchased at any store 
that sells computer hardware and electronics. 
Generally, video chat will require a broadband Internet connection. The faster your 
Internet connection, the better the video quality. With slower connections, the video can 
become choppy or may not work at all. 
Group video chat 
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With some services, it's possible to video chat with multiple people. This is often 
called group video chat or video conferencing, while the meeting itself is often called 
a webinar (short for web seminar). It's often used in the workplace, but you can use it 
anytime you want to collaborate with a group. However, you should be aware that some 
services charge extra for this feature, and it may require a faster Internet connection. 
If you're giving a presentation, you can even share your screen with the people you're 
talking to. That means they'll see exactly what you're seeing on the screen, whether it's 
a PowerPoint presentation, a photo, or a spreadsheet. Screen sharing is also useful if 
you're having a problem with your computer, as it can help others see and identify the 
issue. 
Pros: 

 You can see the person you're talking with. 
 Many voice chat services are free and may be included with your IM or 

chat program. 
 It's possible to chat with multiple people at once. 

Cons: 
 You may need to buy a webcam and headset if you don't already own 

them. 
 It may not work with slower Internet connections. 
 Even though you can see the person, it's not the same as talking face to 

face. Due to the camera angle and picture quality, you may find it a 
bit awkward or unflattering. 

 
Lesson 13: Text Messages 
 

 
You've probably heard people talk about text messaging, or texting. Text messages are 
short messages (usually 160 characters or fewer) sent from one mobile phone to 
another. It's similar to instant messaging, except that you won't need to log in—you'll 
just send messages directly from your phone. 
Typically, texting is not free, although your mobile carrier probably offers service 
packages that include a certain number of texts per month (or even unlimited texts). If 
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you don't have a texting plan, you'll generally be charged whenever you send or receive a 
text message. 
Text messaging is also known as SMS, which stands for Short Message Service. 
Why text? 
Many people ask the same question: "Why would I send a text message when I could 
just call the person?" One of the main reasons is that it's faster, at least for short 
messages. It can easily take several minutes to "send" your message with a phone call. 
With a text message, the same message could be sent with a text in just a few seconds. 
There are also times when it's not really possible to call someone, like if you're at 
a meeting, or in class, or any other place where you're not able to talk easily. Texting is 
often the best alternative in these situations. 
Do note that typing on a mobile phone tends to be slower than typing on a computer. To 
speed things up, people often use abbreviations and acronyms. If you're not familiar 
with these abbreviations, it can be difficult to understand some text messages. To see 
some of the most common acronyms, check out the Top 50 Popular Text & Chat 
Acronyms. 
Texting without a mobile phone 
Text messages are designed to be sent from one mobile phone to another. However, 
there are some websites, such as textem.net, which allow you to send a text message 
from a computer to a mobile phone. 
This can be especially helpful if you don't use texting on your phone but need to contact 
someone who does. 
Pros and cons of text messaging 
Will text messages work for your needs? Review some of the pros and cons to help 
decide: 
Pros: 

 Texts can be sent and received with almost any mobile phone—not just 
smartphones. 

 They are great for quick messages, especially if you are away from a 
computer. 

 People you text will see your message either immediately or the next 
time they look at their phones. 

 It's possible to send text messages from a computer to a mobile phone. 
Cons: 

 Text messages generally cost money, unless they are included in your 
mobile phone plan. Also, recipients may also be charged when they read 
the message. 

 The 160-character limit makes text messages unsuitable for longer 
messages. 

 Unless your mobile phone has a full keyboard, it may take a long time to 
type your message. 

Lesson 14: Direct Messages 

http://www.netlingo.com/top50/popular-text-terms.php
http://www.netlingo.com/top50/popular-text-terms.php
http://www.textem.net/
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Many websites allow you to send direct messages: private messages sent from one 
person to another. In many ways, direct messaging is very similar to email, but with a 
few important distinctions: 

 It has fewer features than email. 
 It's only used to communicate with other people who use the same 

website. 
 You don't get your own email address, which means that you can't really 

use direct messages as a replacement for email. 
When are direct messages used? 
Direct messages are often used when email is not an option. For example, eBay sellers 
may keep their email address private, but you can always contact them through eBay's 
direct message feature. Direct messages allow both parties to communicate without 
sharing their email addresses. For convenience, you can usually have direct messages 
forwarded to your email address. 
There are two main types of websites where you might use direct messages: 

 Online stores: If you have a question about an item, you might send 
the seller a direct message. This is especially common on websites like 
eBay and Etsy where items are sold by regular people, not retailers. 

 Social networking sites: Websites like Twitter, Facebook, and LinkedIn let 
you send direct messages to other users. This allows you to send a private 
message without posting it to a public profile. 

Pros and cons of direct messaging 
Will direct messages work for your needs? Review some of the pros and cons to help 
decide: 
Pros: 

 Your contact info stays private. Neither person has to reveal an email 
address. 

 You can send private messages that are visible only to the recipient. 
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 It gives you an alternate way to contact friends if you lose their email 
addresses. 

 It's included with sites you may already use, such as eBay, Facebook, and 
Twitter. 

Cons: 
 Like email, it may take a long time for the other person to see your 

message. 
 It can't really be used as a replacement for email, and its usage is more 

limited. 
 
Lesson 15: Social Posts, Status Updates, and Tweets 
Imagine you're at a party. You might be talking to one person, or a small group of people, 
but other people can join the conversation. This is basically how social networking sites 
work. Conversations are more open and public, which can provide a richer social 
experience than other forms of online communication. 
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Communicating in a social network 
Once you've joined a social network, you can start posting your thoughts, questions, 
pictures, links, videos, or anything else you'd like to share. These are called social posts 
because they are visible to other people, unlike direct messages or email. Posts will 
appear on your activity feed, which is visible to your friends on the site. 
Social posts are known by many different names, but they are most commonly 
called status updates. You can use status updates to let your friends know what you're 
doing or to say what's on your mind. Some social networking sites have unique names 
for their social posts. For example, on Twitter a post is called a tweet, while a post 
on Pinterest is known as a pin. 
Pros and cons of social networking 

 
Pros: 

 You can communicate with a lot of people at the same time. 
 It's easy to post your thoughts, pictures, links, and more. 
 It provides a richer social experience than email or instant messaging. 
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 You can stay in touch with people who live far away or who you don't see 
often. 

Cons: 
 If you have friends who use a different social networking site (or don't 

use any at all), they won't see your social posts. 
 You can accidentally post sensitive information that will be seen by many 

different people. 
 Things that you post may be permanent, so you have to be careful not to 

post things that could harm your reputation in the future. 
 Some sites have complex privacy options, which may be a bit confusing to 

set. 
Lesson 16: Blogging 

 
Have you ever wanted to create your own magazine or newsletter? Would you like to 
promote your home-based business or build your personal brand? Have you always 
wanted to create your own website, but didn't know how? Today it's possible to do these 
things by creating a blog (short for weblog). Best of all, it's free and relatively easy. 
Many blogs focus on a particular topic or interest, like music, cooking, technology, 
or parenting. Others are less structured and cover a variety of topics. It's easy to find a 
professional design for your blog, even if you don't know much about building a 
webpage. 
Different types of blogs 
You don't necessarily have to be a writer to create a blog. Some blogs focus on a 
particular type of media, such as video or photos, instead of having full-fledged articles. 
Others have shorter posts, which won't require as much writing and which may be less 
time consuming. Below are some common types of blogs: 

 Video blog: Also known as a vlog, this is a type of blog composed mainly 
of videos. Many YouTube channels are classified as video blogs. 

 Photoblog: This is a blog that is mostly photos, with or without 
descriptions. 
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 Microblog: A microblog consists of very short posts. Status updates are a 
form of microblogging. Twitter and Tumblr are two of the most popular 
microblogging services. 

 
Blogging privacy 
It's important to remember that blogging is a public form of online communication. 
Generally, anyone in the world can view your posts and your profile. This means you 
should be extra careful not to post sensitive information. Additionally, posting things 
that reflect negatively on you (such as derogatory or offensive content) could seriously 
affect your personal and professional reputation. 
Pros and cons of blogging 
Pros: 

 It gives you an opportunity to write about things that matter to you. 
 Your blog can be read by people all over the world. 
 A blog is much easier to set up than a regular website. 
 You can choose a design and layout that you like. 

Cons: 
 It can be time consuming, especially if you post frequently. 
 You'll need to avoid posting sensitive information because it can be 

viewed by anyone. 
 Writing derogatory or offensive content could harm your reputation.  

Lesson 17: 5 free instant messenger services 
If you're looking for a way to keep in touch, we've collected five instant messenger 
services that allow you to chat with friends online: 
Google Hangouts: Once you've downloaded Google Hangouts, you can chat from your 
computer's desktop, make video calls, and participate in group chats with other Google 
Hangouts and Gmail users. 
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Facebook Messenger: If you already have a Facebook account, this can be a convenient 
option. All of your Facebook friends will be easy to find through Messenger, so you won't 
have to spend time adding people to your list of contacts. 
Skype: Although Skype is probably best known for offering voice and video calling, it also 
has instant messaging features. One advantage of Skype is its language-translation 
feature: It can translate instant messages, voice calls, and video calls automatically. 
Pidgin: Pidgin is a basic instant messaging service for Windows that allows you to chat 
with users of other instant messaging services like Google Talk, ICQ, and many more. 
Adium: Similar to Pidgin, Adium is a basic instant messaging service that allows you to 
chat with users of other instant messaging services like Google Talk and ICQ. The service, 
designed for macOS users, also lets you combine contacts if a contact has more than one 
instant messaging name. 
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Module 7: Data Security 

Introduced to Data Security: 
Data Security is the means of ensuring that data is kept safe from corruption and that 
access to it is suitably controlled. Data Security helps to ensure privacy. It also helps to 
protect personal data. 
Data security is the process of maintaining the confidentiality, integrity, and availability of 
an organization’s data in a manner consistent with the organization’s risk strategy. 
Before an incident happens, companies must have a security architecture and response 
plan in place. Once an incident occurs, they must be able to detect the event and 
respond accordingly. After the incident, the company must be able to recover effectively 
and efficiently. 

What You Should Know about Data Security: 
Data security is not just about protecting company and customer data from threats. Your 
network is made up of multiple layers that have unique attack surfaces. Compromise at 
one layer can propagate through the operating system and applications. To help protect 
data, reduce risk, and assure compliance standards, your security and integrity 
capabilities should be rooted in hardware. 
 
Meeting industry standards for healthcare, finance, government, and retail can help you 
stay in compliance when handling sensitive customer data. 

 
While compliance is important, best practices recommend putting additional protections 
in place—from the hardware and firmware up through the operating system and 
applications and to the cloud. 
 
The most commonly used security technologies include data encryption in transit and at 
rest, authentication and authorization, hardware-based security (or physical-based 
security), and data backup. 

What are the Main Elements of Data Security? 
The core elements of data security are confidentiality, integrity, and availability. Also 
known as the CIA triad, this is a security model and guide for organizations to keep their 
sensitive data protected from unauthorized access and data exfiltration. 

 Confidentiality ensures that data is accessed only by authorized individuals; 

 Integrity ensures that information is reliable as well as accurate; and 

 Availability ensures that data is both available and accessible to satisfy business 
needs. 

What are Data Security Considerations? 
There are a few data security considerations you should have on your radar: 

 Where is your sensitive data located? You won’t know how to protect your data 
if you don’t know where your sensitive data is stored. 

https://www.varonis.com/products/data-classification-engine/?hsLang=en
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 Who has access to your data? When users have unchecked access or 
infrequent permission reviews, it leaves organizations at risk of data abuse, theft 
or misuse. Knowing who has access to your company’s data at all times is one of 
the most vital data security considerations to have. 

 Have you implemented continuous monitoring and real-time alerting on your 
data? Continuous monitoring and real-time alerting are important not just to 
meet compliance regulations, but can detect unusual file activity, suspicious 
accounts, and computer behavior before it’s too late. 

What are Data Security Technologies? 
The following are data security technologies used to prevent breaches, reduce risk and 
sustain protections. 
Data Auditing 

The question isn’t if a security breach occurs, but when a security breach will occur. 
When forensics gets involved in investigating the root cause of a breach, having a data 
auditing solution in place to capture and report on access control changes to data, who 
had access to sensitive data, when it was accessed, file path, etc. are vital to the 
investigation process. 
Alternatively, with proper data auditing solutions, IT administrators can gain the visibility 
necessary to prevent unauthorized changes and potential breaches. 
Data Real-Time Alerts 

Typically it takes companies several months (or 206 days) to discover a breach. 
Companies often find out about breaches through their customers or third parties 
instead of their own IT departments. 
By monitoring data activity and suspicious behavior in real-time, you can discover more 
quickly security breaches that lead to accidental destruction, loss, alteration, 
unauthorized disclosure of, or access to personal data. 
Data Risk Assessment 

Data risk assessments help companies identify their most overexposed sensitive data and 
offer reliable and repeatable steps to prioritize and fix serious security risks. The process 
starts with identifying sensitive data accessed via global groups, stale data, and/or 
inconsistent permissions. Risk assessments summarize important findings, expose data 
vulnerabilities, provide a detailed explanation of each vulnerability, and include 
prioritized remediation recommendations. 
Data Minimization 

The last decade of IT management has seen a shift in the perception of data. Previously, 
having more data was almost always better than less. You could never be sure ahead of 
time what you might want to do with it. 
Today, data is a liability. The threat of a reputation-destroying data breach, loss in the 
millions or stiff regulatory fines all reinforce the thought that collecting anything beyond 
the minimum amount of sensitive data is extremely dangerous. 
To that end: follow data minimization best practices and review all data collection needs 
and procedures from a business standpoint. 
Purge Stale Data 

Data that is not on your network is data that can’t be compromised. Put in systems that 
can track file access and automatically archive unused files. In the modern age of yearly 

https://www.varonis.com/guides/how-to/perform-entitlement-reviews/?hsLang=en
https://www.varonis.com/blog/real-time-alerting-and-monitoring-with-varonis-datalert/?hsLang=en
https://www.varonis.com/products/datadvantage/?hsLang=en
https://www.varonis.com/products/datadvantage/?hsLang=en
https://www.itgovernanceusa.com/blog/how-long-does-it-take-to-detect-a-cyber-attack
https://www.varonis.com/products/datalert/?hsLang=en
https://info.varonis.com/risk-assessment?hsLang=en
https://www.varonis.com/blog/privacy-design-cheat-sheet/?hsLang=en
https://www.varonis.com/guides/how-to/discover-stale-data/?hsLang=en
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acquisitions, reorganizations and “synergistic relocations,” it’s quite likely that networks 
of any significant size have multiple forgotten servers that are kept around for no good 
reason. 

How Do You Ensure Data Security? 
While data security isn’t a panacea, you can take several steps to ensure data security. 
Here are a few that we recommend. 
Quarantine Sensitive Files 

A rookie data management error is placing a sensitive file on a share open to the entire 
company. Quickly get control of your data with data security software that continually 
classifies sensitive data and moves data to a secure location. 
Track User Behavior against Data Groups 

The general term plaguing rights management within an organization is 
“overpermissioning’. That temporary project or rights granted on the network rapidly 
becomes a convoluted web of interdependencies that result in users collectively having 
access to far more data on the network than they need for their role. Limit a user’s 
damage with data security software that profiles user behavior and automatically puts in 
place permissions to match that behavior. 

Respect Data Privacy 
Data Privacy is a distinct aspect of cybersecurity dealing with the rights of individuals and 
the proper handling of data under your control. 

Data Security Regulations 
Regulations such as HIPAA (healthcare), SOX (public companies) and GDPR (anyone who 
knows that the EU exists) are best considered from a data security perspective. From a 
data security perspective, regulations such as HIPAA, SOX, and GDPR require that 
organizations: 

 Track what kinds of sensitive data they possess 
 Be able to produce that data on demand 
 Prove to auditors that they are taking appropriate steps to safeguard the data 

These regulations are all in different domains but require a strong data security mindset. 
Let’s take a closer look to see how data security applies under these compliance 
requirements: 
Health Insurance Portability and Accountability Act (HIPAA) 

The Health Insurance Portability and Accountability Act was legislation passed to regulate 
health insurance. Section 1173d—calls for the Department of Health and Human Services 
“to adopt security standards that take into account the technical capabilities of record 
systems used to maintain health information, the costs of security measures, and the 
value of audit trails in computerized record system.” 
From a data security point of view, here are a few areas you can focus on to meet HIPAA 
compliance: 

 Continually Monitor File and Perimeter Activity – Continually monitor activity 
and access to sensitive data – not only to achieve HIPAA compliance, but as a 
general best practice. 

 Access Control – Re-compute and revoke permissions to file share data by 
automatically permissioning access to individuals who only have a need-to-know 
business right. 

https://www.varonis.com/blog/data-classification/?hsLang=en
https://www.varonis.com/products/data-transport-engine/?hsLang=en
https://www.varonis.com/blog/the-difference-between-uba-and-ueba/?hsLang=en
https://www.varonis.com/blog/data-privacy/?hsLang=en
https://www.varonis.com/blog/hipaa-compliance/?hsLang=en
https://www.medscape.org/viewarticle/821650_2
https://www.varonis.com/solutions/data-protection/?hsLang=en
https://www.varonis.com/products/edge/?hsLang=en
https://www.varonis.com/products/dataprivilege/?hsLang=en
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 Maintain a Written Record – Ensure you keep detailed activity records for all user 
objects including administrators within active directory and all data objects within 
file systems. Generate changes automatically and send to relevant parties who 
need to receive the reports. 

Sarbanes-Oxley (SOX) 

The Sarbanes-Oxley Act of 2002, commonly called “SOX” or “Sarbox,” is a United States 
federal law requiring publicly traded companies to submit an annual assessment of the 
effectiveness of their internal financial auditing controls. 
From a data security point of view, here are your focus points to meet SOX compliance: 

 Auditing and Continuous Monitoring – SOX’s Section 404 is the starting point for 
connecting auditing controls with data protection: it asks public companies to 
include in their annual reports an assessment of their internal controls for reliable 
financial reporting, and an auditor’s attestation. 

 Access Control –Controlling access, especially administrative access, to critical 
computer systems is one of the most vital aspects of SOX compliance. You’ll need 
to know which administrators changed security settings and access permissions to 
file servers and their contents. The same level of detail is prudent for users of 
data, displaying access history and any changes made to access controls of files 
and folders. 

 Reporting – To provide evidence of compliance, you’ll need 
detailed reports including: 

o data use, and every user’s every file-touch 
o user activity on sensitive data 
o changes including permissions changes which affect the access privileges 

to a given file or folder 
o revoked permissions for data sets, including the names of users 

General Data Protection Regulation (GDPR) 

The EU’s General Data Protection Regulation covers the protection of EU citizen personal 
data, such as social security numbers, date of birth, emails, IP addresses, phone numbers, 
and account numbers. From a data security point of view, here’s what you should focus 
on to meet GDPR compliance: 

 Data Classification – Know where sensitive personal data is stored. It’s critical to 
both protecting the data and also fulfilling requests to correct and erase personal 
data, a requirement known as the right to be forgotten. 

 Continuous Monitoring –The breach notification requirement enlists data 
controllers to report the discovery of a breach within 72 hours. You’ll need to spot 
unusual access patterns against files containing personal data. Expect hefty fines 
if you fail to do so. 

 Metadata – With the GDPR requirement to set a limit on data retention, you’ll 
need to know the purpose of your data collection. Personal data residing on 
company systems should be regularly reviewed to see whether it needs to be 
archived and moved to cheaper storage or saved for the future. 

 Data Governance – Organizations need a plan for data governance. With data 
security by design as the law, organizations need to understand who is accessing 

https://www.varonis.com/securing-active-directory/?hsLang=en
https://info.varonis.com/varonis-and-sox-compliance?hsLang=en
https://www.varonis.com/products/datadvantage/?hsLang=en
https://www.varonis.com/products/dataprivilege/?hsLang=en
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personal data in the corporate file system, who should be authorized to access it 
and limit file permission based on employees’ actual roles and business need. 

 

How Varonis Helps with Data Security 

For companies that have a hold on data and have security obligations due to GDPR or 
other regulatory requirements, understanding our mission at Varonis will help you 
manage and meet data protection and privacy regulations requirements. 
The mission at Varonis is simple: your data is our primary focus, and our data security 
platform protects your file and email systems from cyberattacks and insider threats. 
We’re fighting a different battle – so your data is protected first. Not last. 
We continuously collect and analyze activity on your enterprise data, both on-premises 
and in the cloud. We then leverage five metadata streams to ensure that your 
organization’s data has confidentiality, integrity, and availability: 

 Users and Groups – Varonis collects user and group information and maps their 
relationships for a complete picture of user account organization. 

 Permissions – We add the file system structure and permissions from the 
platforms that we monitor, and combine everything into a single framework for 
analysis, automation, and access visualization. 

 Access Activity – Varonis continually audits all access activity, and records & 
analyzes every touch by every user. Varonis automatically identifies 
administrators, service accounts and executives and creates a baseline of all 
activity. Now you can detect suspicious behavior: whether it’s an insider accessing 
sensitive content, an administrator abusing their privileges, or ransomware like 
CryptoLocker. 

 Perimeter Telemetry – Varonis Edge analyzes data from perimeter devices such 
as VPN, proxy servers, and DNS – and combines this information with data access 
activity to detect and stop malware apt intrusions and data exfiltration. 

 Content Classification – Varonis scans for sensitive and critical data, and can 
absorb classification from other tools like DLP or e-Discovery. Now we know 
where sensitive data lives and where it’s overexposed. 

These five metadata streams are critical to achieving data security nirvana. When you 
combine them, you can get reports on sensitive data open to global group access, stale 
data, data ownership, permissions changes and more. Then, prioritize your custom 
reports and act to remediate your risk. Meanwhile, you’ll know that your data is 
continuously monitored and that you’ll receive real-time alerts when suspicious behavior 
is taking place. 

Information Security: 
Information Security is not only about securing information from unauthorized access. 
Information Security is basically the practice of preventing unauthorized access, use, 
disclosure, disruption, modification, inspection, recording or destruction of information. 
Information can be physical or electronic one. Information can be anything like your 
details or we can say your profile on social media, your data in mobile phone, your 
biometrics etc. Thus Information Security spans so many research areas like 
Cryptography, Mobile Computing, Cyber Forensics, Online Social Media etc. 

https://www.varonis.com/products/data-security-platform/?hsLang=en
https://www.varonis.com/products/data-security-platform/?hsLang=en
https://www.varonis.com/data-stores/active-directory/?hsLang=en
https://www.varonis.com/products/datalert/?hsLang=en
https://www.varonis.com/products/datadvantage/?hsLang=en
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https://www.varonis.com/products/data-classification-engine/?hsLang=en
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Information Security programs are build around 3 objectives, commonly known as CIA – 
Confidentiality, Integrity, and Availability.  
 Confidentiality – means information is not disclosed to unauthorized individuals, entities 
and process. For example if we say I have a password for my Gmail account but someone 
saw while I was doing a login into Gmail account. In that case my password has been 
compromised and Confidentiality has been breached. 
Integrity – means maintaining accuracy and completeness of data. This means data 
cannot be edited in an unauthorized way. For example if an employee leaves an 
organisation then in that case data for that employee in all departments like accounts, 
should be updated to reflect status to JOB LEFT so that data is complete and accurate 
and in addition to this only authorized person should be allowed to edit employee data. 
Availability – means information must be available when needed. For example if one 
needs to access information of a particular employee to check whether employee has 
outstanded the number of leaves, in that case it requires collaboration from different 
organizational teams like network operations, development operations, incident 
response and policy/change management.  
Denial of service attack is one of the factor that can hamper the availability of 
information. 
Apart from this there is one more principle that governs information security programs. 
This is Non repudiation.  
  
 
Non repudiation – means one party cannot deny receiving a message or a transaction 
nor can the other party deny sending a message or a transaction. For example in 
cryptography it is sufficient to show that message matches the digital signature signed 
with sender’s private key and that sender could have a sent a message and nobody else 
could have altered it in transit. Data Integrity and Authenticity are pre-requisites for Non 
repudiation.  
Authenticity – means verifying that users are who they say they are and that each input 
arriving at destination is from a trusted source.This principle if followed guarantees the 
valid and genuine message received from a trusted source through a valid transmission. 
For example if take above example sender sends the message along with digital signature 
which was generated using the hash value of message and private key. Now at the 
receiver side this digital signature is decrypted using the public key generating a hash 
value and message is again hashed to generate the hash value. If the 2 value matches 
then it is known as valid transmission with the authentic or we say genuine message 
received at the recipient side 
Accountability – means that it should be possible to trace actions of an entity uniquely to 
that entity. For example as we discussed in Integrity section Not every employee should 
be allowed to do changes in other employees data. For this there is a separate 
department in an organization that is responsible for making such changes and when 
they receive request for a change then that letter must be signed by higher authority for 
example Director of college and person that is allotted that change will be able to do 
change after verifying his bio metrics, thus timestamp with the user(doing changes) 
details get recorded. Thus we can say if a change goes like this then it will be possible to 
trace the actions uniquely to an entity. 
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At the core of Information Security is Information Assurance, which means the act of 
maintaining CIA of information, ensuring that information is not compromised in any way 
when critical issues arise. These issues are not limited to natural disasters, 
computer/server malfunctions etc.  
 
Thus, the field of information security has grown and evolved significantly in recent 
years. It offers many areas for specialization, including securing networks and allied 
infrastructure, securing applications and databases, security testing, information systems 
auditing, business continuity planning etc. 

Difference between Cyber Security and Information Security 
 
The terms Cyber Security and Information Security are often used interchangeably. As 
they both are responsible for security and protecting the computer system from threats 
and information breaches and often Cybersecurity and information security are so closely 
linked that they may seem synonymous and unfortunately, they are used synonymously. 
If we talk about data security it’s all about securing the data from malicious user and 
threats.  
Now another question is that what is the difference between Data and Information? So 
one important point is that “not every data can be an information” data can be informed 
if it is interpreted in a context and given meaning. for example “100798” is data and if we 
know that it’s the date of birth of a person then it is information because it has some 
meaning. 
 
 
 
so information means data which has some meaning. 

CYBER SECURITY INFORMATION SECURITY 

It is the practice of protecting the 
data from outside the resource on 
the internet. 

It is all about protecting information from 
unauthorized user, access and data 
modification or removal in order to provide 
confidentiality, integrity, and availability. 

It is about the ability to protect the 
use of cyberspace from cyber attacks. 

It deals with protection of data from any 
form of threat. 

Cybersecurity to protect anything in 
the cyber realm. 

Information security is for information 
irrespective of the realm. 

Cybersecurity deals with danger 
against cyberspace. 

Information security deals with the 
protection of data from any form of threat. 
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CYBER SECURITY INFORMATION SECURITY 

Cybersecurity strikes against Cyber 
crimes, cyber frauds and law 
enforcement. 

Information security strives against 
unauthorised access, disclosure 
modification and disruption. 

On the other hand cyber security 
professionals with cyber security 
deals with advanced persistent 
threat. 

Information security professionals is the 
foundation of data security and security 
professionals associated with it prioritize 
resources first before dealing with threats. 

It deals with threats that may or may 
not exist in the cyber realm such as a 
protecting your social media account, 
personal information, etc. 

It deals with information Assets and 
integrity confidentiality and availability. 

 
Diagram are given below to represent the difference between Information 
Security and Cybersecurity. 
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In above diagram ICT refers for Information and communications technology (ICT) which 
is an extensional term for information technology (IT) that define the role of unified 
communications and the integration of telecommunications (basically digital 
communication security). 
 
Need of Information Security 
Information system means to consider available countermeasures or controls stimulated 
through uncovered vulnerabilities and identify an area where more work is needed. The 
purpose of data security management is to make sure business continuity and scale back 
business injury by preventing and minimizing the impact of security incidents. The basic 
principle of Information Security is:  

 Confidentially 

 Authentication 

 Non-Repudiation 

 Integrity 

The need for Information security:   
 
Protecting the functionality of the organization:  
The decision maker in organizations must set policy and operates their organization in 
compliance with the complex, shifting legislation, efficient and capable applications. 
Enabling the safe operation of applications:  
The organization is under immense pressure to acquire and operates integrated, efficient 
and capable applications. The modern organization needs to create an environment that 
safeguards application using the organizations IT systems, particularly those application 
that serves as important elements of the infrastructure of the organization.  
Protecting the data that the organization collect and use:  
Data in the organization can be in two forms are either in rest or in motion, the motion of 
data signifies that data is currently used or processed by the system. The values of the 
data motivated the attackers to seal or corrupts the data. This is essential for the 
integrity and the values of the organization’s data. Information security ensures the 
protection of both data in motion as well as data in rest.  
Safeguarding technology assets in organizations:  
The organization must add intrastate services based on the size and scope of the 
organization. Organizational growth could lead to the need for public key infrastructure, 
PKI an integrated system of the software, encryption methodologies. The information 
security mechanism used by large organizations is complex in comparison to a small 
organization. The small organization generally prefers symmetric key encryption of data. 

Basic principles of Information Security 
What are the 3 Principles of Information Security? 
The basic tenets of information security are confidentiality, integrity and availability. 
Every element of the information security program must be designed to implement one 
or more of these principles. Together they are called the CIA Triad. 
Confidentiality 
Confidentiality measures are designed to prevent unauthorized disclosure of information. 
The purpose of the confidentiality principle is to keep personal information private and 
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to ensure that it is visible and accessible only to those individuals who own it or need it 
to perform their organizational functions. 
Integrity 
Consistency includes protection against unauthorized changes (additions, deletions, 
alterations, etc.) to data. The principle of integrity ensures that data is accurate and 
reliable and is not modified incorrectly, whether accidentally or maliciously. 
Availability 
Availability is the protection of a system’s ability to make software systems and data fully 
available when a user needs it (or at a specified time). The purpose of availability is to 
make the technology infrastructure, the applications and the data available when they 
are needed for an organizational process or for an organization’s customers. 

 
Threats to Information Security 
Information Security threats can be many like Software attacks, theft of intellectual 
property, identity theft, theft of equipment or information, sabotage, and information 
extortion.  
Threat can be anything that can take advantage of a vulnerability to breach security and 
negatively alter, erase, harm object or objects of interest.  
 
Software attacks means attack by Viruses, Worms, Trojan Horses etc. Many users believe 
that malware, virus, worms, bots are all same things. But they are not same, only 
similarity is that they all are malicious software that behaves differently.  
 
Security Misconfiguration 
Modern organizations use a huge number of technological platforms and tools, in 
particular web applications, databases, and Software as a Service (SaaS) applications, or 
Infrastructure as a Service (IaaS) from providers like Amazon Web Services. 
 
Enterprise grade platforms and cloud services have security features, but these must be 
configured by the organization. Security misconfiguration due to negligence or human 

https://www.imperva.com/learn/availability/high-availability/
https://www.imperva.com/learn/availability/high-availability/
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error can result in a security breach. Another problem is “configuration drift”, where 
correct security configuration can quickly become out of date and make a system 
vulnerable, unbeknownst to IT or security staff. 
 
Organizations can mitigate security misconfiguration using technological platforms that 
continuously monitor systems, identify configuration gaps, and alert or even automatically 
remediate configuration issues that make systems vulnerable. 
Unsecure or Poorly Secured Systems 
The speed and technological development often leads to compromises in security 
measures. In other cases, systems are developed without security in mind, and remain in 
operation at an organization as legacy systems. Organizations must identify these poorly 
secured systems, and mitigate the threat by securing or patching them, decommissioning 
them, or isolating them. 
 
Malware is a combination of 2 terms- Malicious and Software. So Malware basically 
means malicious software that can be an intrusive program code or anything that is 
designed to perform malicious operations on system. Malware can be divided in 2 
categories:  
  
1. Infection Methods 
2. Malware Actions 
 
Malware on the basis of Infection Method are following:  
  
1. Virus – They have the ability to replicate themselves by hooking them to the program 

on the host computer like songs, videos etc and then they travel all over the Internet. 
The Creeper Virus was first detected on ARPANET. Examples include File Virus, Macro 
Virus, Boot Sector Virus, Stealth Virus etc. 

2. Worms – Worms are also self-replicating in nature but they don’t hook themselves to 
the program on host computer. Biggest difference between virus and worms is that 
worms are network-aware. They can easily travel from one computer to another if 
network is available and on the target machine they will not do much harm, they will, 
for example, consume hard disk space thus slowing down the computer. 

3. Trojan – The Concept of Trojan is completely different from the viruses and worms. 
The name Trojan is derived from the ‘Trojan Horse’ tale in Greek mythology, which 
explains how the Greeks were able to enter the fortified city of Troy by hiding their 
soldiers in a big wooden horse given to the Trojans as a gift. The Trojans were very 
fond of horses and trusted the gift blindly. In the night, the soldiers emerged and 
attacked the city from the inside.  
Their purpose is to conceal themselves inside the software that seem legitimate and 
when that software is executed they will do their task of either stealing information 
or any other purpose for which they are designed.  
They often provide backdoor gateway for malicious programs or malevolent users to 
enter your system and steal your valuable data without your knowledge and 
permission. Examples include FTP Trojans, Proxy Trojans, Remote Access Trojans etc.  
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4. Bots –: can be seen as advanced form of worms. They are automated processes that 
are designed to interact over the internet without the need for human interaction. 
They can be good or bad. Malicious bot can infect one host and after infecting will 
create connection to the central server which will provide commands to all infected 
hosts attached to that network called Botnet. 

Malware on the basis of Actions:  
  
1. Adware – Adware is not exactly malicious but they do breach privacy of the users. 

They display ads on a computer’s desktop or inside individual programs. They come 
attached with free-to-use software, thus main source of revenue for such developers. 
They monitor your interests and display relevant ads. An attacker can embed 
malicious code inside the software and adware can monitor your system activities 
and can even compromise your machine. 

2. Spyware – It is a program or we can say software that monitors your activities on 
computer and reveal collected information to an interested party. Spyware are 
generally dropped by Trojans, viruses or worms. Once dropped they install 
themselves and sits silently to avoid detection.  
One of the most common example of spyware is KEYLOGGER. The basic job of 
keylogger is to record user keystrokes with timestamp. Thus capturing interesting 
information like username, passwords, credit card details etc. 

3. Ransomware – It is type of malware that will either encrypt your files or will lock your 
computer making it inaccessible either partially or wholly. Then a screen will be 
displayed asking for money i.e. ransom in exchange. 

4. Scareware – It masquerades as a tool to help fix your system but when the software 
is executed it will infect your system or completely destroy it. The software will 
display a message to frighten you and force to take some action like pay them to fix 
your system. 

5. Rootkits – are designed to gain root access or we can say administrative privileges in 
the user system. Once gained the root access, the exploiter can do anything from 
stealing private files to private data. 

6. Zombies – They work similar to Spyware. Infection mechanism is same but they don’t 
spy and steal information rather they wait for the command from hackers. 

 Theft of intellectual property means violation of intellectual property rights like 
copyrights, patents etc. 

 Identity theft means to act someone else to obtain person’s personal information or 
to access vital information they have like accessing the computer or social media 
account of a person by login into the account by using their login credentials. 

 Theft of equipment and information is increasing these days due to the mobile 
nature of devices and increasing information capacity. 

 Sabotage means destroying company’s website to cause loss of confidence on part of 
its customer. 

 Information extortion means theft of company’s property or information to receive 
payment in exchange. For example ransomware may lock victims file making them 
inaccessible thus forcing victim to make payment in exchange. Only after payment 
victim’s files will be unlocked. 
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These are the old generation attacks that continue these days also with advancement 
every year. Apart from these there are many other threats. Below is the brief description 
of these new generation threats.  
  
 Technology with weak security – With the advancement in technology, with every 

passing day a new gadget is being released in the market. But very few are fully 
secured and follows Information Security principles. Since the market is very 
competitive Security factor is compromised to make device more up to date. This 
leads to theft of data/ information from the devices 

 Social media attacks – In this cyber criminals identify and infect a cluster of websites 
that persons of a particular organization visit, to steal information. 

 Mobile Malware –There is a saying when there is a connectivity to Internet there will 
be danger to Security. Same goes for Mobile phones where gaming applications are 
designed to lure customer to download the game and unintentionally they will install 
malware or virus on the device. 

 Outdated Security Software – With new threats emerging everyday, updation in 
security software is a prerequisite to have a fully secured environment. 

 Corporate data on personal devices – These days every organization follows a rule 
BYOD. BYOD means Bring your own device like Laptops, Tablets to the workplace. 
Clearly BYOD pose a serious threat to security of data but due to productivity issues 
organizations are arguing to adopt this. 

 Social Engineering – is the art of manipulating people so that they give up their 
confidential information like bank account details, password etc. These criminals can 
trick you into giving your private and confidential information or they will gain your 
trust to get access to your computer to install a malicious software- that will give 
them control of your computer. For example email or message from your friend, that 
was probably not sent by your friend. Criminal can access your friends device and 
then by accessing the contact list, he can send infected email and message to all 
contacts. Since the message/ email is from a known person recipient will definitely 
check the link or attachment in the message, thus unintentionally infecting the 
computer. 

 

Active and Passive attacks in Information Security 
Active attacks: An Active attack attempts to alter system resources or affect their 
operations. Active attacks involve some modification of the data stream or the creation of 
false statements. Types of active attacks are as follows:  

 Masquerade 
 Modification of messages 
 Repudiation 
 Replay 
 Denial of Service 

Masquerade –  
A masquerade attack takes place when one entity pretends to be a different entity. A 
Masquerade attack involves one of the other forms of active attacks.  If an authorization 
procedure isn’t always absolutely protected, it is able to grow to be extraordinarily liable 
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to a masquerade assault. Masquerade assaults may be performed using the stolen 
passwords and logins, with the aid of using finding gaps in programs, or with the aid of 
using locating a manner across the authentication process. 
  

 
Masquerade Attack 

Modification of messages – 
It means that some portion of a message is altered or that message is delayed or reordered 
to produce an unauthorized effect. Modification is an attack on the integrity of the original 
data. It basically means that unauthorized parties not only gain access to data but also 
spoof the data by triggering denial-of-service attacks, such as altering transmitted data 
packets or flooding the network with fake data. Manufacturing is an attack on 
authentication. For example, a message meaning “Allow JOHN to read confidential file X” 
is modified as “Allow Smith to read confidential file X”.  
  



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1056 | 1352  

 
Modification of messages 

Repudiation –  
This attack occurs when the network is not completely secured or the login control has 
been tampered with. With this attack, the author’s information can be changed by actions 
of a malicious user in order to save false data in log files, up to the general manipulation 
of data on behalf of others,  similar to the spoofing of e-mail messages.   
Replay –  
It involves the passive capture of a message and its subsequent transmission to produce 
an authorized effect. In this attack, the basic aim of the attacker is to save a copy of the 
data originally present on that particular network and later on use this data for personal 
uses. Once the data is corrupted or leaked it is insecure and unsafe for the users. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1057 | 1352  

 
Replay 

Denial of Service –  
It prevents the normal use of communication facilities. This attack may have a specific 
target. For example, an entity may suppress all messages directed to a particular 
destination. Another form of service denial is the disruption of an entire network either by 
disabling the network or by overloading it with messages so as to degrade performance.  
  

 
Denial of Service 
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Passive attacks: A Passive attack attempts to learn or make use of information from the 
system but does not affect system resources. Passive Attacks are in the nature of 
eavesdropping on or monitoring transmission. The goal of the opponent is to obtain 
information that is being transmitted. Types of Passive attacks are as follows:  
 The release of message content 
 Traffic analysis 
The release of message content –  
Telephonic conversation, an electronic mail message, or a transferred file may contain 
sensitive or confidential information. We would like to prevent an opponent from learning 
the contents of these transmissions.  
  

 
Passive attack 

Traffic analysis –  
Suppose that we had a way of masking (encryption) information, so that the attacker even 
if captured the message could not extract any information from the message.  
The opponent could determine the location and identity of communicating host and could 
observe the frequency and length of messages being exchanged. This information might 
be useful in guessing the nature of the communication that was taking place.  
The most useful protection against traffic analysis is encryption of SIP traffic. To do this, an 
attacker would have to access the SIP proxy (or its call log) to determine who made the 
call. 
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Traffic analysis 

At a glance 

Active Attacks Passive Attacks 

Modify messages, 
communications or data 

Do not make any change to 
data or systems 

Poses a threat to the 
availability and integrity of 
sensitive data 

Poses a threat to the 
confidentiality of sensitive 
data. 

May result in damage to 
organizational systems. 

Does not directly cause 
damage to organizational 
systems. 
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Victims typically know 
about the attack 

Victims typically do not know 
about the attack. 

Main security focus is on 
detection and mitigation. 

Main security focus is on 
prevention. 

 
Information Security and Data Protection Laws 
Information security is in constant interaction with the laws and regulations of the places 
where an organization does business. Data protection regulations around the world focus 
on enhancing the privacy of personal data, and place restrictions on the way 
organizations can collect, store, and make use of customer data. 
Data privacy focuses on personally identifiable information (PII), and is primarily 
concerned with how the data is stored and used. PII includes any data that can be linked 
directly to the user, such as name, ID number, date of birth, physical address, or phone 
number. It may also include artifacts like social media posts, profile pictures and IP 
addresses. 
Data Protection Laws in the European Union (EU): the GDPR 
The most known privacy law in the EU is the General Data Protection Regulation (GDPR). 
This regulation covers the collection, use, storage, security and transmission of data 
related to EU residents. 
The GDPR applies to any organization doing business with EU citizens, regardless of 
whether the company itself is based inside or outside the European Union. Violation of 
the guidelines may result in fines of up to 4% of global sales or 20 million Euro. 
The main goals of the GDPR are: 

 Setting the privacy of personal data as a basic human right 
 Implementing privacy criteria requirements 
 Standardization of how privacy rules are applied 

GDPR includes protection of the following data types: 
 Personal information such as name, ID number, date of birth, or address 
 Web data such as IP address, cookies, location, etc. 
 Health information including diagnosis and prognosis 
 Biometric data including voice data, DNA, and fingerprints 
 Private communications 
 Photos and videos 
 Cultural, social or economic data 

Data Protection Laws in the USA 
Despite the introduction of some regulations, there are currently no federal laws 
governing data privacy in general in the United States. However, some regulations 
protect certain types or use of data. These include: 

 Federal Trade Commission Act—prohibits organizations from deceiving consumers with 
regard to privacy policies, failure to adequately protect customer privacy, and misleading 
advertising. 

https://www.imperva.com/learn/data-security/personally-identifiable-information-pii/
https://www.imperva.com/learn/data-security/gdpr/
https://www.imperva.com/learn/data-security/data-privacy/
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 Children’s Online Privacy Protection Act—regulates the collection of data related to 
minors. 

 Health Insurance Portability and Accounting Act (HIPAA)—regulates the storage, privacy 
and use of health information. 

 Gramm Leach Bliley Act (GLBA)—regulates personal information collected and stored by 
financial institutions and banks. 

 Fair Credit Reporting Act—regulates the collection, use, and accessibility of credit 
records and information. 
Additionally, the Federal Trade Commission (FTC) is responsible for protecting users from 
fraudulent or unfair transactions such as data security and privacy. The FTC can enact 
regulations, enforce laws, punish violations, and investigate organizational fraud or 
suspected violations. 
In addition to federal guidelines, 25 US states have enacted various laws to regulate data. 
The most famous example is the California Consumer Privacy Act (CCPA). The law went 
into effect in January 2020 and provides protection to California residents, including the 
right to access private information, request deletion of private information, and opt out 
of data collection or resale. 
There also other regional regulations such as: 
 Australian Prudential Regulatory Authority (APRA) CPS 234 
 Canada Personal Information Protection and Electronic Documents Act (PIPEDA) 
 Singapore Personal Data Protection Act (PDPA) 

 

Data Security Solutions 
Micro Focus drives leadership in data security solutions with over 80 patents and 51 
years of expertise. With advanced data encryption, tokenization, and key management to 
protect data across applications, transactions, storage, and big data platforms, big data 
solutions, Micro Focus simplifies the protection of sensitive data in even the most 
complex use cases. 
Data Discovery and Classification 
Modern IT environments store data on servers, endpoints, and cloud systems. Visibility 
over data flows is an important first step in understanding what data is at risk of being 
stolen or misused. To properly protect your data, you need to know the type of data, 
where it is, and what it is used for. Data discovery and classification tools can help. 
 
Data detection is the basis for knowing what data you have. Data classification allows you 
to create scalable security solutions, by identifying which data is sensitive and needs to 
be secured. Data detection and classification solutions enable tagging files on endpoints, 
file servers, and cloud storage systems, letting you visualize data across the enterprise, to 
apply the appropriate security policies. 
 
Data Masking 
Data masking lets you create a synthetic version of your organizational data, which you 
can use for software testing, training, and other purposes that don’t require the real 
data. The goal is to protect data while providing a functional alternative when needed. 
 

https://www.imperva.com/learn/data-security/hipaa-privacy-rule/
https://www.imperva.com/learn/data-security/cps-234/
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Data masking retains the data type, but changes the values. Data can be modified in a 
number of ways, including encryption, character shuffling, and character or word 
substitution. Whichever method you choose, you must change the values in a way that 
cannot be reverse-engineered. 

 
Identity Access Management 
Identity and Access Management (IAM) is a business process, strategy, and technical 
framework that enables organizations to manage digital identities. IAM solutions allow IT 
administrators to control user access to sensitive information within an organization. 
 
Systems used for IAM include single sign-on systems, two-factor authentication, multi-
factor authentication, and privileged access management. These technologies enable the 
organization to securely store identity and profile data, and support governance, 
ensuring that the appropriate access policies are applied to each part of the 
infrastructure. 
Cloud data security – Protection platform that allows you to move to the cloud securely 
while protecting data in cloud applications. 
Data encryption – Data-centric and tokenization security solutions that protect data 
across enterprise, cloud, mobile and big data environments. 
Encryption is viewed as one of the most reliable ways to keep your data confidential at 
rest, in transit, or when processing real-time analytics. Data encryption uses algorithms 
to encode data into an unreadable format that needs an authorized key for decryption. 
But cryptographic processing can be vulnerable to side channel attacks and can affect 
performance. 
The latest technologies can speed up encryption and boost security without affecting 
performance. 
Hardware-Based Security- Hardware security that guards financial data and meets 
industry security and compliance requirements. 
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As hackers have become more sophisticated, they’ve made their way down the stack, 
increasing attacks at the hardware level. That’s why you need to protect your data at 
every layer of the IT infrastructure—not just the software. Intel’s hardware-enabled 
security capabilities include protections built right into the silicon, creating Trusted 
Infrastructure, which helps secure hardware, firmware, operating system, applications, 
networks, and the cloud. 
Key management -- Solution that protects data and enables industry regulation 
compliance. 
Enterprise Data Protection – Solution that provides an end-to-end data-centric approach 
to enterprise data protection. 

 
Payments Security – Solution provides complete point-to-point encryption and 
tokenization for retail payment transactions, enabling PCI scope reduction. 
Big Data, Hadoop and IofT data protection – Solution that protects sensitive data in the 
Data Lake – including Hadoop, Teradata, Micro Focus Vertica, and other Big Data 
platforms. 
Mobile App Security - Protecting sensitive data in native mobile apps while safeguarding 
the data end-to-end. 
Web Browser Security - Protects sensitive data captured at the browser, from the point 
the customer enters cardholder or personal data, and keeps it protected through the 
ecosystem to the trusted host destination. 
eMail Security – Solution that provides end-to-end encryption for email and mobile 
messaging, keeping Personally Identifiable Information and Personal Health Information 
secure and private. 
Data Loss Prevention (DLP) 
To prevent data loss, organizations can use a number of safeguards, including backing up 
data to another location. Physical redundancy can help protect data from natural 
disasters, outages, or attacks on local servers. Redundancy can be performed within a 
local data center, or by replicating data to a remote site or cloud environment. 
 
Beyond basic measures like backup, DLP software solutions can help protect 
organizational data. DLP software automatically analyzes content to identify sensitive 
data, enabling central control and enforcement of data protection policies, and alerting 
in real-time when it detects anomalous use of sensitive data, for example, large 
quantities of data copied outside the corporate network. 
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Governance, Risk, and Compliance (GRC) 
GRC is a methodology that can help improve data security and compliance: 
Governance creates controls and policies enforced throughout an organization to ensure 
compliance and data protection. 
Risk involves assessing potential cybersecurity threats and ensuring the organization is 
prepared for them. 
Compliance ensures organizational practices are in line with regulatory and industry 
standards when processing, accessing, and using data. 
Password Hygiene 
One of the simplest best practices for data security is ensuring users have unique, strong 
passwords. Without central management and enforcement, many users will use easily 
guessable passwords or use the same password for many different services. Password 
spraying and other brute force attacks can easily compromise accounts with weak 
passwords. 
 
A simple measure is enforcing longer passwords and asking users to change passwords 
frequently. However, these measures are not enough, and organizations should consider 
multi-factor authentication (MFA) solutions that require users to identify themselves 
with a token or device they own, or via biometric means. 
 
Another complementary solution is an enterprise password manager that stores 
employee passwords in encrypted form, reducing the burden of remembering passwords 
for multiple corporate systems, and making it easier to use stronger passwords. 
However, the password manager itself becomes a security vulnerability for the 
organization. 
 
Authentication and Authorization 
To help keep unauthorized users from accessing sensitive data, you’ll need to have the 
right user authentication methods in place. But strong passwords aren’t enough. The 
most-secure methods use hardware security features such as biometrics, built-in two-
factor authentication, and secure enclave technology built into the processor itself. 
Organizations must put in place strong authentication methods, such as OAuth for web-
based systems. It is highly recommended to enforce multi-factor authentication when 
any user, whether internal or external, requests sensitive or personal data. 
In addition, organizations must have a clear authorization framework in place, which 
ensures that each user has exactly the access rights they need to perform a function or 
consume a service, and no more. Periodic reviews and automated tools should be used 
to clean up permissions and remove authorization for users who no longer need them. 
 
Data Security Audits 
The organization should perform security audits at least every few months. This identifies 
gaps and vulnerabilities across the organizations’ security posture. It is a good idea to 
perform the audit via a third-party expert, for example in a penetration testing model. 
However, it is also possible to perform a security audit in house. Most importantly, when 
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the audit exposes security issues, the organization must devote time and resources to 
address and remediate them. 
 
Anti-Malware, Antivirus, and Endpoint Protection 
Malware is the most common vector of modern cyberattacks, so organizations must 
ensure that endpoints like employee workstations, mobile devices, servers, and cloud 
systems, have appropriate protection. The basic measure is antivirus software, but this is 
no longer enough to address new threats like file-less attacks and unknown zero-day 
malware. 
 
Endpoint protection platforms (EPP) take a more comprehensive approach to endpoint 
security. They combine antivirus with a machine-learning-based analysis of anomalous 
behavior on the device, which can help detect unknown attacks. Most platforms also 
provide endpoint detection and response (EDR) capabilities, which help security teams 
identify breaches on endpoints as they happen, investigate them, and respond by locking 
down and reimaging affected endpoints. 
Data Backup 
Data backup solutions can help you restore your company and customer data in the 
event of a storage failure, breach, or disaster. By creating an exact copy of your data and 
storing it in a secure location that can be accessed by authorized administrators, you can 
minimize the risk of a primary data failure. However, for better data integrity and 
security, you’ll need protections for that backup, both while that data is being sent to its 
backup location as well as when it’s stored to assist in spotting anomalies or threats 
early. A documented data backup policy can help you comply with various security 
regulations as well as establish a consistent, reliable data recovery process. 
Different ways of backing up data and information: 
There are plenty of options available for people looking to backup up their data, all with 
their own pros and cons. In this article we have listed some of your options, but 
remember: it’s best to have more than one backup to be safe. This is particularly true in 
the case of ransomware. For example, if you back up your computer to an external hard 
drive, but leave that drive connected when you are not doing backup, some ransomware 
will try to encrypt those backup filed as well: always disconnect backup drives when the 
backup has finished. 
1. USB stick 
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Small, cheap and convenient, USB sticks are everywhere, and their portability means that 
they’re easy to store safely, but also pretty easy to lose. There are questions about the 
number of read/write cycles they can take, so should be considered alongside other 
backup methods. 
Pros: 

 Extremely portable 

 Very cheap 

 Can easily transfer data to other sources 
Cons: 

 Portability means they’re small and easy to lose 

 Questions over read/write cycle longevity 
2. External hard drive 
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External hard drives are just what they sound like – hard drives that live outside your 
computer, meaning they can be plugged in to other sources. If using them for backup, it’s 
best not to use them as an ‘extra every day hard drive’. 
Pros: 

 Relatively cheap 

 Plenty of storage space for larger files 
Cons: 

 Potentially open to problems which lost files in the first place (a power surge or 
malware) 

3. Time Machine 
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For the Mac users out there, Time Machine is an option that backs up to external hard 
drives automatically. Apple sells  its own brand of dedicated wireless Time Capsules, but 
you can use any hard disk for it. Using this method, you’ll automatically keep backups 
hourly for the last 24 hours, daily for the last month and then weekly backups until the 
machine is full. 
Pros: 

 Automated, meaning you shouldn’t forget to stay up to date 

 Frequency of backups means you should never be too out of date 

 Backs up whole drive, not just the key files 
Cons: 

 Dedicated wireless machine is expensive 

 Mac only 
4. Network Attached Storage 
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Businesses tend to backup their files to network attached storage, but with more and 
more homes having multiple computers, the idea has a certain appeal, especially for 
those looking to save files from more than one source. With prices coming down, a 
dedicated wireless storage solution is a convenient option which requires less thought. 
Pros: 

 Automatic backups mean you don’t risk forgetting 

 Wireless solutions also work with phones and tablets 
Cons: 

 Can be expensive 

 Can be awkward to set up and maintain 
5. Cloud Storage 
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While network attached storage is essentially your own Cloud Server, there are plenty of 
third party cloud storage options around: free, paid, or free with paid extras. iCloud, 
Dropbox, Google Drive and OneDrive are big names, but others are available. 
Pros: 

 Can be done automatically 

 A certain amount of space is usually free 

 Device agnostic 
Cons: 

 Requires an internet connection to work 

 You can’t account for their security breaches 

 Companies aren’t obliged to keep these services around forever 
6. Printing 
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At a first glance, this might sound a facetious inclusion. But while considerably less 
technically advanced, printing offers you a hard copy of your most important documents 
that will survive power outages, and are easy to store and access even if your computer 
is out of action for a few days. Of course it’s hard to keep documents up to date this way, 
and it won’t work for video or audio files, but for that novel you’d be devastated to lose, 
it’s certainly worth considering. 
Pros: 

 A backup that won’t be affected by hardware outages or tech headaches 

 Impossible for hackers to access 
Cons: 

 Impossible for certain file types 

 Awkward to manage 

 Less practical for longer documents 

 Not great for the environment 
However you choose to backup your data (and it’s smart to consider using more than one 
solution, at least for your life-or-death files), make sure that you do it. Often people don’t 
think about what were to happen if their valuable files were to be lost, until it’s too late. 
Don’t make that mistake, and use World Backup Day to make sure your files are all safe 
and accounted for. 

Modern Best Data Security technologies: 
1. Data classification 
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Classification is the foundation of data security. It helps in prioritizing the assets the 
company needs to protect. Many tools support both user-driven and automated 
classification capabilities. A well-planned data classification system makes essential data 
easy to find. This can be essential for risk management, and compliance. 
 
2. Data access policies 
Providing the right amount of data access to individual users is crucial for data 
protection. Authorising only key members of the teams to handle secure data makes sure 
that the possible data breaches are remaining at a very low state. The tools are helping in 
sensitive data discovery and cleaning up data access permissions to enforce least 
privilege. 
 
3. Cloud data protection 
Encrypting sensitive data and storing it in the cloud makes system backups safer as well, 
and also it makes accessing data much easier for involved parties. Online document 
management systems come in handy for every company, as they make accessing files 
easy, safe and available for all the involved parties. Always use trustworthy cloud-based 
document management system, make sure the server parks are located inside the EU 
where strict data policy regulations apply, also, read their contract to see if they have 
backdoor channels for your files. 
 
4. Two-factor authentication 
Two-factor authentications are very useful for preventing attackers from getting access 
to one’s account. Even if your password was guessed correctly by hackers, the 2nd step 
will stop them from entering the account. With the use of a 2nd factor it is guaranteed 
that even if the password is stolen, attackers cannot get into the account. 
 
5. Tokenization 
Substituting a randomly generated value, or a token, for sensitive data like credit card 
numbers, bank account numbers, and social security numbers makes it safer to store 
sensitive information. Unlike encryption, there is no mathematical relationship between 
the token and its original data; to reverse the tokenization, a hacker must have access to 
the mapping database, and this makes it much more difficult to read the data. 
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Popular Data Security Software Categories 
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Module 8: Email Merge 

 

Introductions: 
Mail Merge is a handy feature that  incorporates data from both Microsoft  Word and 
Microsoft  Excel and allows you to create multiple documents at  once, such as  letters,  
saving you the  time and effort  of  retyping the same letter over and over.  Here is an 
example of  how to  use it  to  create  a letter  thanking people who donated to  a 
particular fund. 

EMAIL MERGE IN OUTLOOK  
Mail Merge from Outlook 

Starting a Mail Merge from within Outlook is the easiest method if all the 
people who you want to include are already in a Contacts folder in Outlook. 
In this mail merge example we will send a select amount of contacts an email and ask 
them whether their contact information is correct. 
As the whole process involves quite a few clicks, we’re going to break it down in 4 easy to 
follow steps. 
Important! 
Before continuing, please verify with your ISP or mail admin first if there are any 
restrictions in how many emails you may send within an hour or in total on a day. Some 
have put a restriction on that but as long as you stay under a 100 it’s very likely you won’t 
run into any issues and there is probably no need to contact your ISP. 
If there is a limit set, then you can use a Mail Merge tool with scheduling functionality to 
work around these limits and send out the mail merge is smaller batches. 
Step 1: Select or filter your contacts 
We start the Mail Merge process by specifying which of our contacts we want to send an 
email to. 

1. Select the Contacts folder containing the contacts that you want to send an email to 
(press CTRL+3 to quickly switch to your Contacts folders). 

2. Select the contacts that you want to email to or apply a filter to your view so that 
only the contacts that you want to address are visible. Quick methods to apply a 
filter are; 
 Perform a search. 

For instance, based on the Company or a Category (provided that you have 
assigned the same category to similar contacts). You can do some 
quite advanced Search queries as well. 

 Sort or group your Contacts folder by Category or another field in 2 easy steps. 
a. Set your View to the “List” or “Phone” view. 

View-> Change View 

https://www.howto-outlook.com/howto/mailmerge.htm#mail_merge_with_3rd_party_tools
https://www.howto-outlook.com/howto/searchcommands.htm
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b. Change your Arrangement. 
 Simplified Ribbon (Microsoft 365) 

View-> Arrange By-> Categories 
 Classic Ribbon 

View-> option group: Arrangement-> Categories 
Step 2: Start the Mail Merge 
Now that we’ve selected the contacts, it is time to start the Mail Merge. 

1. Open the Mail Merge dialog in Outlook: 
 Simplified Ribbon (Microsoft 365) 

Home-> press the ellipsis (…) button on the right-> button Mail Merge… 
 Classic Ribbon 

Home-> option group: Actions-> button Mail Merge 
2. Verify if the correct options are set for contacts; 

 “All contacts in current view” if you filtered your view so that only the contacts 
that you want to address are visible. 

 “Only selected contacts” if you manually selected the contacts from the 
Contacts folder that you want to address. 

3. At the bottom of the dialog set the “Merge options” to; 
 Document Type: Form Letters 
 Merge to: E-mail 
 Message subject line: <whatever you want as a subject for your message> (you 

can modify this later too) 

 
Your screen should now look something like this. 

4. Press OK and wait for Word to start. 
5. A new document will open. Select the Mailings tab on the Ribbon. 
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The Mail Merge tab in the Ribbon of Word as part of a Microsoft 365 subscription. 

Step 3: Create the message with Contact fields 
Now it is time to start writing your message with variables. This sounds more difficult 
than it is. 

1. Insert a greeting line by pressing the “Greeting Line” button 
2. Select the greeting line that you want and which greeting line to use when no 

proper information is found from the contact information. 
 Note that you can type freely in the format fields. So instead of selecting “Dear 

” you can also type “Hello “. 
 Please be aware that you need to type a space at the end of the word in order 

not to have it “stick” to the name of the addressee. 
3. Press OK to close the dialog and then press ENTER to start a new line in the 

document. 
4. Here type the following; 

“Please verify your contact details that we have on file and either confirm it to us or 
provide us updated information.” 

5. Press ENTER again to start a new line and insert the address by pressing the 
“Address Block” button. 

6. As we’ve already addressed the person, we remove their name from the address 
block by disabling the option “Insert recipient’s name in this format:” 
As we only address individuals in our example we also disable the option “Insert 
company name”. 

7. Press OK to close the dialog and press ENTER to start a new line. 
8. Now we’re going to include the home telephone number by pressing the “Insert 

Merge Field” button. 
9. From the dialog that pops up select Home_Phone and then press Insert. 
10. Press Close to close the dialog and press ENTER to start another new line. 
11. Now type the following; 

“Thanks in advance and best regards, <your name here>“ 

https://www.howto-outlook.com/pictures/mail-merge-word-ribbon-mailings-tab.png
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Your document should now look something like this. 

Step 4: Send out the personalized mass mailing 
Only a few more clicks and checks, and and the messages will be on their way. 

1. Before sending, it is best to preview your results first by pressing the “Preview 
Results” button. 

2. You can use the arrow buttons in the toolbar to browse through all the personalized 
emails. 

3. Now it is time to send the messages; Press the Finish & Merge button and select 
“Send E-mail Messages…”. 

4. A new dialog will now pop-up. As we had already set the subject and selected all the 
correct contacts we don’t need to change anything in this dialog. Click OK to 
complete the merge. 

 
Pressing OK will directly start sending the emails. 

Tool Tip! 
If you need to send along an attachment with your mail merge or also want to address 
people via the CC or BCC address line, then you can use the Mail Merge Toolkit add-in 
from MAPILab. 
If you decide to order use 4PM76A8 to get a discount. 
Mail Merge from Word with Outlook as source 

https://addins.howto-outlook.com/mapilab_mailmerge
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Starting your mail merge from Word is also possible. The end-result is the 
same as starting it in Outlook. The main difference is the dialog box that you use to select 
the correct contacts but more about that later. 
Document types 
Word provides tools for incorporating your data into the following kinds of documents.  
 

 Letters that include a personalized greeting. Each letter prints on a separate sheet of 
paper. 

 Email where each recipient's address is the only address on the To line. You'll be sending 
the email directly from Word. 

 Envelopes or Labels where names and addresses come from your data source. 
 Directory that lists a batch of information for each item in your data source. Use it to 

print out your contact list, or to list groups of information, like all of the students in each 
class. This type of document is also called a catalog merge. 
In this example we again send a selected amount of contacts an email but we’ll skip the 
letter writing as it is similar to the example above section. 

1. Start the Mail Merge Wizard; 
Select the tab Mailings-> click the Start Mail Merge button-> Step by Step Mail 
Merge Wizard… 

2. The Task Pane panel will open on the right side of the document to choose the 
document type. 
Here select “E-mail messages”. 
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Using the Mail Merge Wizard in Word to create a mail merge. 

3. Pressing Next will brings us to step 2 where you can choose the document to start 
from. As we will be typing our own contents we just click Next. 

4. In this example we will be using Outlook as the source again so click “Select from 
Outlook contacts”. 

5. As you can have multiple Contacts folders in Outlook we need to select the actual 
folder which we will be using by pressing “Choose Contacts Folder”. 

 
Bringing up this dialog could take a while and could also cause a mail profile prompt 
from Outlook. 

6. After selecting the Contact folder of your choice you could be presented with the 
“Choose Profile” dialog from Outlook. If you don’t know this dialog, there is 
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probably one selection in the drop down list anyway or set to the correct default so 
simply press OK. 

7. Word now opens the “Mail Merge Recipients” dialog where you can specify which 
contacts to send to. 
This dialog offers various selecting and filtering options. This dialog can be a bit slow 
when you have a lot of contacts as it refreshes the screen after pretty much every 
action. However, the “Find duplicates…” feature is quite handy especially, when you 
want to use the entire Contacts folder for your mail merge. 

 
The Mail Merge Recipients allows you to refine your selection of Contacts. 

8. After selecting the recipients, the next step is to write your message. The Mail 
Merge Wizard already shows you some variables you can use. Writing of the 
message can be done in the same way as in the example indicated above. 

9. The next step allows you to preview all the emails you’ll eventually be sending. 
10. In Step 6 you can press “Electronic Mail…” to set the final options before mailing 

your message 
 Note that it is the same dialog as we had in our previous example but now you 

still need to fill in some details; 
 To: Email_Address 
 Subject line: Your personal information 

11. After setting the options, pressing OK will direct start sending the emails. 
  



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1081 | 1352  

Mail Merge from Word with another source 

When you want to send out personal emails via Outlook but the information 
itself isn’t in Outlook, but for instance in Excel, Access, a SQL query, a csv-file, etc., then 
you can start your mail merge from within Word as well. 
The process is similar as doing a mail merge from within Word with Outlook as the 
source, with an additional step to match the merge fields. 

1. Start the mail merge from Word again as indicated above until you reach the screen 
with Step 3 in the Mail Merge Wizard. 

2. In Step 3 select “Use an existing list”. 
3. Click the Browse… button. 
4. Select the location of the document containing the information. This can be Excel 

sheets, Access Databases, Database Queries, Text Documents and many other 
sources as long as it is in a structured format Word can work with. 
 Depending on the file type you selected you might need to put in the 

delimiters; the characters that are used to separate the columns and rules. 
5. After you have selected the file and optionally filtered your contacts to address, 

continue to Step 4. 
6. When you reach Step 4, it is a good time to match the fields from your source to 

Mail Merge fields to be able to use the predefined blocks such as “Greeting Line”. 
For instance, when you have an Excel sheet that contains the columns Name, Email 
Address, Usernames and Passwords, you’d want to match the Name field to the 
“Last Name” merge field. 

1. Press the Match Fields button. 
2. You’ll now get a dialog with standard Merge Fields in Word which can be used 

in standardized templates. 
3. Expand the drop down list next to “Last Name” and set it to the column in 

your source document (in our case an Excel sheet) containing that information 
(in our case the column “Name”). 

4. Match up other fields if you need and press OK to close the dialog. 
7. You can now continue with the mail merge as indicated in the process above. 
8. When you get to the dialog to send the messages, you must set the “To:” field to 

the column that contains the list of email addresses to send to. 
Mail Merge with 3rd party tools 

Below is a list of 3rd party mail merge tools which you can use in addition to 
the Word Mail Merge or as a replacement of it. I won’t discuss their start to finish 
processes but will highlight their unique features. 
Mail Merge Toolkit by MAPILab 
 Fully integrates with the Mail Merge Wizard providing you with more sending 

options. 

https://addins.howto-outlook.com/mapilab_mailmerge
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 Mail merge with attachments or even a different attachment for each recipient. 
 Optionally set CC and BCC recipients. 
 Allows customization of the Subject too. 
 Discount code: 4PM76A8 

Send Individually by Sperry Software 
 Easy to use. 
 Automatically creates individual emails from addresses you have put in the To field. 
 Has its own merge fields already mapped to contact details which can be used in a 

message. 
 Supports a simple txt-file as the source for the mail merge with an email address on 

each individual line. 
 Discount code: BH93RF24 

Send Personally by MAPILab 
 Easy to use. 
 Automatically creates individual emails from addresses you have put in the To field. 
 Has its own merge fields already mapped to contact details which can be used in a 

message. 
 Allows for an exclusion list. 
 Discount code: 4PM76A8 

Merge Tools by Doug Robbins (Word MVP) 
 Installation via a Word Startup template (dotm-file). 
 Merge to e-mail messages either with or without attachments, with the documents 

created by the merge being sent as either Word or PDF attachments or as the body 
of the e-mail message. 

 Many to One type merges, which can be used for creating documents such as 
invoices where there are multiple records in the data source that have common 
data in one of the fields. 

 Merging to a document that will include a chart that is unique to each record in the 
data source. 

 Video tutorial by Kevin Stratvert (ex-Microsoft employee). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

https://addins.howto-outlook.com/sperry_sendindividually
https://addins.howto-outlook.com/mapilab_sendpersonally
http://bit.ly/1hduSCB
https://youtu.be/yj_s3cdfVDY
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Module 9: Digital Marketing and Social Media 
management 

 

Lesson 1: Digital Marketing 

1.1 What is Digital Marketing? 

Digital marketing is the practice of promoting products or services with the help of digital 
devices and technology. 
In simple words, digital marketing is any form of marketing that occurs online with the 
help of mobile, laptop, internet, etc. In addition to digital signage and technology that 
may not be connected to the internet. It can range from anything as complex as 
automated email marketing initiatives all the way down to the content choices on your 
website’s blog. 
Now, you know what digital marketing is, so let's proceed and know the types of digital 
marketing. 

1.2 Types of Digital Marketing 

If you have a computer or a smartphone, as many of us do, you’ve experienced digital 
marketing. It could be an email in your inbox, a search result when using Google, an ad 
on Facebook, a text message sent to your phone, or a post by an influencer on Instagram. 
As you can see, internet marketing is an expansive field with many areas of 
specialization. The core forms of digital marketing, however, are: 

a. Search Engine Optimization (SEO) 
Put, SEO consists of carefully structuring and optimizing your website’s pages to achieve 
the best position possible on search engine result pages (SERPs) when internet users 
perform a search on an engine like Google that’s related to your business. 

b. Paid Social and Paid Search Advertising 
Ads that appear on social media are paid social ads, and all that seems on SERPs when 
you enter a query are paid search ads. Advertisers create these paid ads and compete 
with others for positions on their chosen social platform or the SERP for their selected 
search engine. 

c.  Email Marketing 
Any marketing that occurs through email is known as email marketing, and it’s not just 
for newsletters and coupons. All marketing-related interaction over email fits into this 
category. 

d.  Content Marketing 
Every effort to market through online content is considered content marketing (and 
often employs SEO, paid search, and paid social advertising). For example, all these 
content types (and more) are grouped under the content marketing category: 

 Blog posts 

 Infographics 

 Videos 

 eBooks 

 White papers  
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Other types of digital marketing include marketing automation, design, apps, mobile 
marketing and SMS, web analytics, and growth hacking. 

1.3 Benefits of Digital Marketing 

Digital marketing has become hugely popular in such a short period, and for a good 
reason. Today’s customers and clients spend an increasing amount of time online, and 
they expect their favorite companies to be online, too. 
The internet landscape might seem intimidating, but effective digital marketing can be an 
enormous boon for business. With careful strategy and implementation, the benefits of 
digital marketing on business include the expansion of the audience, meeting target 
customers where they’re spending their time, and achieving this for a far more 
affordable price than traditional marketing methods allow. 
For these reasons and more, more than 60 percent of marketers have moved their focus 
from traditional to digital marketing. 

1.4 How Digital Marketing Works? 

While the benefits of digital marketing are plentiful, understand that each form of 
internet marketing functions in its way. Companies would be wise to assess the bigger 
picture before determining which forms of digital marketing in which to invest and which 
platforms to use. It’s generally recommended to crawl before you walk–start small with 
your online marketing strategy and grow as the company becomes accustomed to 
different areas.  
 
Digital marketing is hugely helpful to firms in that it allows them to grow their audience 
as far as their budget allows. On the other side of the coin, internet marketing offers 
companies the chance to focus clearly on marketing to the right audience. In other 
words, a firm may reach the perfect target clientele on a local, national, or international 
stage, all while staying on budget. 

1.5 How does Digital Marketing work? 

There are two ways in which Digital Marketing is implemented by brands and businesses: 

 B2C (Business to Customer) 

 B2B (Business to Business) 
B2C (Business to Customer) 
As the name suggests, this sort of Digital Marketing is conducted when a brand or a 
company has to sell a product or service to individual customers. Infact, 95 percent of the 
time, the ads and marketing that you see online are examples of B2C campaigns, e.g., an 
ad for a candy bar, a promotional video for a safety razor, or a movie trailer. All of these 
marketing efforts are targeting individual consumers and not organizations. Since most 
traditional means of B2C marketing are far too redundant in the digital era, Digital 
Marketing is easily the best way to go about in this area. 
Let’s get into the B2C Digital Marketing: 

 Analyze and profile your customers 

 Create activities for attracting customers and engage with them. Games and contests 
are generally a great idea to promote your brand. By giving the customers something 
of value or challenge and via the means of entertaining them, you are ensuring to 
stand out from the usual direct marketing crowd, which people are annoyed by.  
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 Use Search Engine Optimization or SEO to optimize your content on which you are 
basing your marketing. 

 Time-limited offers like discount codes or free store credit can help boost your sales. 
By providing discounts to an Internet user, you may be swaying them from where 
they usually would have bought that product and turning them into your own 
customer. 

 After segmenting the crowd and singling out your target audience, tailor your 
marketing campaign completely around their needs and desires through emails, 
videos, and social media posts. 

 Once you have narrowed down your customer segment, try to find out which social 
media influencers or the category of influencers they tend to follow. Then, you can 
contact that influencer and offer them a sum of money, a free sample, or your 
product, or some other forms of incentives, to promote your product. Keep in mind 
that this sort of marketing is on the expensive side, and you really need to be wise 
about your budget and target case to hire influencers. 

B2B (Business to Business) 
B2B is conducted for very specific products. You wouldn’t generally see B2B products 
being advertised on platforms with traffic from the everyday crowd. These marketing 
campaigns are low profile, professional, and in most cases, marketed directly (or pitched) 
to the client. This client can be a small business or a corporate giant. We can take heavy-
duty cooking machinery used in big fast-food restaurants as an example. What would be 
the point of running a TV ad for an industry-level chimney? None. This sort of marketing 
is done through B2B-specialized salesmen who use custom-made marketing material, 
PowerPoint presentations, and word of mouth to pitch their product.  
B2B campaigns are highly custom-made and catered to a very small group of people and 
their needs. A lot of times, an entire marketing campaign and presentation will be 
created for a single client organization. Let’s look at the process: 

 Study the marketspace and analyze your competitors’ offerings, price points, and 
marketing material 

 Identify and study the businesses that you are going to target. For example, imagine 
your analysis finds out that the biggest complaint about industrial chimneys is 
blockage. Then, you need to advertise your product in a way that offers a solution to 
that particular problem or conveys how your product deals with that particular issue 
better than your competitors 

 Have a professional-looking website or landing page 

 Perform SEO 

 Whenever you successfully transact with a business, make it a point to request them 
to refer other potential clients to your organization.  

 Use paid Ads 

 Make and use custom-made video ads (pitches) 

 Share your professional brand identity through social media 

1.6 Digital Marketing Roles and Responsibilities 

Job responsibilities for digital marketers will vary depending on experience and 
specialization.  
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For example, an SEO specialist will understand all aspects of SEO, including the know-
how to drive organic traffic, identify and evaluate high-quality content, and make 
competitor analyses.  
On the other hand, a social media manager will devise a social media strategy in line with 
the identity of the brand, define a communication style and a content strategy, create 
and adapt the content for each social media network, and stay up-to-date on the latest 
digital marketing trends. 
 
Now, as you are well versed with the understanding of what is digital marketing, its type, 
benefits, roles, and responsibilities let's have a look at the difference between inbound 
marketing and digital marketing. 
 

1.7 What’s the Difference between Inbound Marketing and Digital Marketing? 
Inbound Marketing 
Inbound marketing is a form of marketing that can apply to digital or traditional 
marketing. Inbound functions like a magnet. The marketer provides content that is 
attractive to the intended audience, and the audience finds it of their own accord. In 
other words, it’s a form of marketing that isn’t forced upon its target.  
Digital Marketing 
Digital marketing can be inbound or not. If you create incredible content on your website 
that draws in readers and turns them into customers, you’re using an inbound marketing 
strategy. If, however, you run ads on social media or search engines, you’re forcing your 
marketing onto the viewer, which is not an inbound method. 
 

1.8 Email Marketing: A Complete Step-by-Step Guide to Start On 

1.8.1 What is Email Marketing? 

It is a way of delivering effective messages to convert leads into sales by sending 
personalized emails to targeted customers. It also helps us to educate our target 
customers on the value of our product.  

1.8.2 Importance of Email Marketing 

 Costs lesser as compared to other marketing channels 
 Shows a higher ROI (return on investment) 
 Helps in attracting new customers  
 Easier Integration with other communication channels 
 Assists in creating targeted and personalized messages 
 Helps higher-intent client to engage with your business 
 Helps reaching larger audiences and even smaller targeted lists 

1.8.3 How to Practice Email Marketing? 

Define Your Audience 

Identify the target audience and create segments based on their geography, 
demographics, firmographics, past purchases, email engagement, etc. 

Choose Suitable Email Marketing Platform 

Next, choose a suitable email marketing service for your company. Then create 
campaigns and set an appropriate call to action. 
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Test Your Emails before Sending 

A/B test you emails with the following steps: 
 Optimize Basic Elements of Email 

 
Emails elements - Email marketing 

 Attract the audience with a compelling subject line 
 Ensure to choose the preview text wisely 
 Offer relevant content to your audience 
 Place CTA in a visible place for your visitors 
 Add relevant images and ensure of creating visually appealing emails 
 Design mobile-friendly emails 

Gain Your Audience’s Trust  

 
Audience 

 Build and segment an email list based on user behavior 
 Send campaigns immediately or schedule a time 
 Ensure to follow a consistent schedule to build trust with your audience 

Measure the Results 

 
Measure Results 

 Optimize your subject lines, preheader text, email content, CTA, and landing pages 
through A/B tests 

 Measure performance (open rate, CTR rate, response, and rate) 
 A soft bounce means the email has reached the recipient's mail server but is 

bounced back undelivered 
 A hard bounce email occurs when the email has been permanently rejected 
 Open Rate: It is the percentage of the total number of recipients who opened an 

email campaign 
 Click-through Rate: It is the percentage of recipients that have clicked the CTA in 

your email message 
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 Response Rate: It is the percentage of the number of people who completed the 
survey of your email by selecting the link of your email campaign and completed an 
action 

 Forward Rate: The forward rate refers to the rate at which your subscribers share 
your email campaigns with others 

 Bounce Rate - There are two types of bounces -- hard and soft.  
 

Below is an example of an optimized email that can help you bring a high open rate: 

 
Optimized email 

Types of Email Campaigns 

There are a variety of email campaigns that can be used to interact with your target 
audience. And here’s how you can optimize each type of email campaign: 

 Welcome emails 
 Newsletter 
 Promotional emails 
 Abandonment cart emails 
 Re-engagement campaign 
 Sponsorship Emails  

1. Welcome Emails 

 According to Campaign Monitor, a lot of recent studies have shown that welcome 
emails have an average read rate of 34% 

 Welcome mails encourage new subscribers to engage with your products and 
services 

How to Optimize? 

 Send your welcome email immediately after the sign-up process of the user 
 It should be informative, clear and actionable 
 Optimize subject lines and email content 
 Keep messages short and clear 

https://www.campaignmonitor.com/blog/email-marketing/2019/02/10-essential-elements-of-an-effective-welcome-email/
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 Use relevant CTA 
 

An example of an optimized welcome email is shown below: 

 
Welcome email - Email Marketing 

2. Newsletters 

 With email newsletters, the audience are connected and informed about the 
product updates 

 This is a very significant way of educating your audience and prospects about your 
business 

How to Optimize? 

 Try to reduce text and provide visually interesting campaigns  
 Stack your email content and optimize CTA 
 Create an interesting header 
 Share a variety of content (like videos, articles, eBooks, podcasts, webinars) with 

your readers 
 Follow a consistent schedule for sending emails 

 
Below is an example of a newsletter: 
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Newsletter - email marketing 

3. Promotional Emails  

According to convince and convert, 68% of Millennials have confirmed that Promotional 
Emails have influenced their purchase decisions. 

 These emails drive revenue by sending special offers  
 Its objective is to make a conversion 

How to Optimize? 

 Ensure to personalize your campaigns 
 Engage your customers by including limited time offers 
 Send offer emails on holidays for high engagement rate 

 
Below is an example of a promotional email: 

https://www.convinceandconvert.com/digital-marketing/email-marketing-statistics/
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Promotional email 

4. Abandonment Cart Emails 

 Abandonment emails are shared with clients who have kept products on their cart 
but did not complete the checkout process 

 It is an effective way to improve sales 

How to Optimize? 

 Use a simple abandoned cart email template 
 Personalize your abandoned-cart recovery emails 
 Adding a product image in your email remainder can result in high click-through 

rate 
 Send a series of email reminders to your clients. 

Below is an example of abandonment cart email: 

https://www.google.com/search?q=willington+reality+email+marketing+example&rlz=1C1CHBF_enIN832IN832&source=lnms&tbm=isch&sa=X&ved=2ahUKEwiX2tu5s8LqAhUbyzgGHf5WBUMQ_AUoAXoECA0QAw&biw=1396&bih=665#imgrc=o26WtQ1AmpijAM
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abandonment cart email - email marketing 

5. Re-Engagement Campaign 

 It is a practice of sending series of emails to inactive email subscribers 
 It leads to high user engagement rate and maintains a high IPR (Inbox Placement 

Ratio) 

How to Optimize? 

 Opt for gamification to win back inactive subscribers 
 Prefer subject lines like "We have been waiting for your response" or "We have got 

a special offer for you." 
 Conduct a poll or quiz to re-engage with your subscribers 

Below is an example of a re-engagement campaign: 
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Re-engagement campaign  

6. Sponsorship Emails 

 These emails let you advertise your copy in another vendor's newsletter 
 In simple terms, it is a way to reach a different audience and gain new leads 

through display ads via emails 

How to Optimize? 

 Choose the right promotional partner 
 Use only one primary CTA whereas offering multiple deals to the audience can be 

confusing 
 Always clearly define your objectives 
 Leverage social media platforms in order to maximize the reach of your campaign 

https://www.google.com/search?q=starbucks+re+engagement+platform&rlz=1C1CHBF_enIN832IN832&source=lnms&tbm=isch&sa=X&ved=2ahUKEwi4vYrUs8LqAhVMyzgGHZGTC2oQ_AUoA3oECA0QBQ&biw=1396&bih=665#imgrc=uiRe2wHv-RsdCM
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Sponsorship email 

What is A/B testing? 

A/B testing or split testing is a way to analyze which of the two email campaign strategies 
can result in high open rates and click rates. 

1. Subject Line 

 It is the message that the recipient sees when the emails reach his/her inbox  
 An interesting subject line can convince a reader to open your email and read 

further 

How to Optimize? 

 Your chosen subject line should be relevant to your audience 
 Include a number in your subject line 
 Make sure the subject line isn’t too lengthy (17-24 characters) 
 Prefer using actionable language, like "Final Hour," "download," "get your free," 

etc. 
 Opt for title case in subject lines 

 
Below is an example of an optimized subject line: 

https://www.google.com/search?q=sponsorship+email+maarketing+examples&tbm=isch&ved=2ahUKEwi91oj5s8LqAhWE2nMBHTQaAMMQ2-cCegQIABAA&oq=sponsorship+email+maarketing+examples&gs_lcp=CgNpbWcQAzoECAAQQzoGCAAQBRAeUIg9WOZUYOtWaABwAHgAgAGYAYgBpwqSAQQwLjExmAEAoAEBqgELZ3dzLXdpei1pbWc&sclient=img&ei=ezkIX_2sNIS1z7sPtLSAmAw&bih=665&biw=1396&rlz=1C1CHBF_enIN832IN832#imgrc=xpFIgnULRce_3M
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subject line 

Based on research, Convince and Convert have confirmed that 82% of marketers opt for 
subject lines shorter than 60 characters. 

 
Source: Convinceandconvert 

2. Sender Name 

 It is a key element of your email message displayed in your recipient's' inboxes 
 An optimized sender name will boost your open rates and build trust with your 

target audience 

How to Optimize? 

 Always have a clear sender name as it results in a high open-rate 
 It's always better to use an organization or brand name over an individual person's 

name 
 Consistency and familiarity of your sender name helps in building trust with your 

audience 
 Avoid no-reply address and always prefer using a valid email address 
 Below is an example of a Gmail account full of emails, where the first column 

contains the sender name, or "from" name 
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3. Personalization 

It is a strategy of creating more engagement by targeting an email campaign to a specific 
audience 

How to Optimize? 

 Address the email to the person's first name 
 Leverage the demographic and behavioral data you have about your readers  
 Set up automated behavioral trigger emails for converting your readers to 

subscribers 
Based on research, the campaign monitor says, studies show that personalized emails 
have 2.5 times higher click-through rates, and are six times more likely to drive a 
conversion. 

4. CTA 

It is an action incorporated in emails to encourage the audience for engagement 

How to Optimize? 

 Keep your CTAs not more than three words (such as, "sign up now" or "Download 
now" 

 Personalize Your CTAs  
 Always use responsive designs  
 Opt for button format, as its more clickable 

According to Crazy Egg, CTA with button designs have high converting rate: 

 
Below are the top five A/B testing tools that can help in optimizing your email for high 
open rate: 

 HubSpot’s A/B testing kit 
 Crazy egg 
 Omniconvert 
 Optimizely 

http://insight.venturebeat.com/email-personalization-practitioner-guide
https://www.crazyegg.com/blog/high-converting-cta-buttons/
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 VWO 

How to Grow an Email Subscriber List? 

If you're noticing an increase in unsubscribes or if you want to grow your subscriber 
number, opt for the following techniques: 

 Create remarkable email content for high engagement 
 Encourage your subscribers to forward the email as it can be a great way to find a 

target audience 
 Do not opt for longer-form content as it results in low conversion rate 
 Send content that meets your customer expectation 
 Prefer using bullet points to make the content readable and follow a logical 

structure in your email 
 Use compelling images for high open rates 
 Prefer to draft emails with responsive designs  
 Quick Response code is an easier way to encourage readers to sign up for an email 

list even when they're offline 
 Reach out to the audience through the social network to increase your email sign 

up list at a quicker pace 
 Use recipient names and personalize emails for your readers 
 Add a clear CTA at the end 
 Test your subject lines, preheader, CTA, and email content 
 Segment your emails and provide an option for social sharing 

How To Segment Email List For High Open and Click-Through-Rate? 

Email list segmentation can be a very simple process if done in the right way. In case 
you're willing to put some effort, here's what you need to know: 

 Geographic segmentation - With this segmentation, you can target your audience 
based on geographical areas, such as by city, state, country, or continent 

 Demographic - Segment your audience by age, education, income, gender, 
occupation, nationality, and more 

 Behavioral segmentation - It segments target audience by their behaviors and 
decision-making patterns such as purchase, online activity, search history, and 
more 

How To Automate Email Marketing With An Auto Responder? 

There are basically two types of emails you can send to your readers: 
 Broadcasts 
 Autoresponders 

Broadcast emails are one-time email campaigns which are delivered to a group of 
audience in your contact list and Auto Responder is a programming script where emails 
are sent at frequent intervals based on the behavior of subscribers. 
A suitable example of Auto Responder is below: 
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AutoResponder 

To create an AutoResponder: 
1. In the mail section, go to Menu>> AutoResponders 
2. Click Create AutoResponder and write a message in the internal name. 
3. Choose the list linked to the autoresponder 
4. Assign the AutoResponder to a particular day 
5. Select delay time, days of the week, you'd like for the message to go out on 
6. Choose the from and reply-to addresses. 
7. Write a compelling subject line 
8. Choose Google Analytics as the source before sending the email 
9. Finally, save and publish if you want the message to go live right away 

Email Marketing Tools 

Selecting the right tool for your email campaign is essential, as it will help grow your 
businesses. With the tool, it's easier to identify the right templates for your emails. 
Selecting the right tool can help to share engaging emails such as welcoming a new 
subscriber, notifying clients of a sale, etc. These are some of the most widely used tools to 
ensure you hit the mark every time: 

 Mailchimp 
 Marketo 
 ConvertKit 
 Sendinblue 

Mailchimp 

 It is a reliable and feature-packed tool that helps grow businesses 
 Offers basic analytics that are helpful for inbound campaigns 
 It helps in boosting lead tracking and conversions 
 It is a cost-efficient tool for businesses having less than 2,000 subscribers 
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Marketo 

 It has various pricing options that can fit into different companies' budgets 
 It is suitable for medium-sized organizations and provides services which can be 

focused on lead management, email marketing, and mobile marketing 
 It's easy to learn and set up. And you pay only for the options that you use 

Convertkit 

 Easy understanding of autoresponder sequence and enables us to create segments 
of the target audience 

 Helps to grow businesses through attractive forms, dynamic emails, trackable data, 
and simple automation feature 

 New features are regularly updated for better usage  
SendinBlue 

 Automation workflow speeds ups the task and enhances the user experience 
 Optimizes open and click-through rates by scheduling time and date for delivering 

emails  
 Easy to create a professional newsletter with its advanced features 

 
YouTube Keyword Research: All You Need to Know About It 

 
 
JumpShot confirms that after Google, YouTube is the most popular search engine. If you 
have a YouTube channel and are seeking to get more views for it, your main target is to 
focus on the keywords with search demand. This YouTube keyword research technique 
helped Ahref grow their YouTube channel from 10,000 to over 200,000 monthly views in 
a year. 

https://www.simplilearn.com/tutorials/seo-tutorial/how-to-do-keyword-research
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Source: Ahref 

Note: Ahref also earned approximately 50,000 new subscribers in that same period. 
Let us discuss a few simple YouTube keyword research techniques that will help us find 
relevant and high search volume keywords. 
YouTube Auto Suggest 

 YouTube has a feature called autocomplete. 
 This feature suggests only popular keywords. 
 With the suggestion, when you type a keyword relevant to your niche, you will 

receive a list of suggestions related to the term. 
For example, if you type "digital marketing," then you get suggestions like "digital 
marketing," and "digital marketing for beginners." 

 
Note: According to WordStream, YouTube autocomplete is useful to find long-tail 
keywords 
Use Keyword Tool.io 
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Instead of manually if you want to search keywords with the help of a tool, we suggest 
you check out KeywordTool.io. 

 
This tool helps marketers identify hundreds of autocomplete suggestions for YouTube, 
Google, and other search engines. 
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Keep a Track of Your Competitors 

 Study your competitors' campaigns by finding new profitable keywords. 
 Search for phrases or keywords that are used by your competitors in their video 

title and description. 
Here comes the important question: How to spy on the keyword? 

 Go to your competitor's channel and click on the videos tab, then sort by the 
"most popular" option. This way, you will find a list of top videos. 

 Now, choose a video and take a look at the keywords used in the title and 
description of the video. 

  
 As a result, you have a list of keywords that you can optimize your videos around. 

 
 Now, let us have a look at video tags. Video tags of YouTube can be viewed on the 

HTML page. 
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 To check video tags, right-click on the web page and select view page source. 

  
 Search for "keywords" (using CTRL+F shortcut). The terms that appear next to the 

"keywords" are the video tags used by your competitor. 

 
 Also, there is another way to find your competitor's video tags. 
 Install Chrome Plugins–Using this, an individual can see video tags on the web page 

itself. 

  
 For example, VidIQ and TubeBuddy's extension give you the exact tags that your 

competitors use for their videos. 
According to an industry study, using keywords in video tags helps you to rank well on 
YouTube. 

https://vidiq.com/
https://www.tubebuddy.com/
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Important Factors of YouTube Keyword Research 

 Well-chosen keywords (primary and secondary) help your video to rank well on 

YouTube. 

 We should do keyword research based on: 

 Search volume - Choose keywords with high search volume as they drive more 

traffic to your video. 

 Competition–Keywords with low difficulty rank well on YouTube. 

 Relevancy–Always prefer keywords that are relevant to your content. 

 Primary keyword–Choose a keyword that defines the nature of your business. 

 Secondary keyword - Prefer keywords that are highly relevant to your primary 

keyword. 

For example, if you have a machine learning video, you can choose your primary keyword 
as and secondary keyword as the following: 
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Check Out Google Search Results 

 When doing YouTube keyword research, opt for keywords that Google shows on 
the video results page (as they have high search volume), which means your video 
can get more views if you rank on Google as well. 

 According to Backlinko, Google ranks videos with keywords like, "how-to" and 
"Tutorials". 

 For example, On Google, when you search for a machine learning tutorial or how 
to become a machine learning engineer, you get results for the following. 

  

Ahref Site Explorer Using Scraper Extension 

 Identify high traffic YouTube videos using Ahref site explorer. 
 Identify your competitor channel on YouTube and select the "Videos" tab to check 

their uploads.  
 Now, Copy and paste the video URLs into Ahrefs Site Explorer. 

 
Source: Ahref 

 If you want the process to be done quickly, we suggest you use the Scraper 
extension. Right-click anywhere on the page and hit "Scrape similar," then add this 
code in the "Selector" field: 

//h3/a 

 Now, under the columns section -> XPath name, type: 

concat ('https://www.youtube.com', @href) 

 On the right-hand side, you will get a list of videos that have high traffic. So, select 
"Scrape" and "Copy to clipboard." 

 Now, paste the results into the Ahrefs Batch Analysis tool, select the URL mode -> 
run the search -> sort by the "Traffic" column from high to low. 

https://ahrefs.com/batch-analysis
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 To see the keywords for the list of videos, select the down arrow (from target 
domain), and hit "Organic keywords." 

  
Source: Ahref 

What is Affiliate Marketing and How to Start it? 

Affiliate Marketing is a term that's synonymous with giving individuals a secure method 
to earn money online. And although its 'ease' is debatable, they're not half-wrong. Once 
appropriately understood, affiliate marketing can be easy. We've all heard about how it's 
useful for individuals, but did you know that it can be helpful for organizations as well?  

Affiliate Marketing Stats in 2020 

Affiliate marketing is a domain within marketing that's seen significant growth in the last 
few years. And if you're on the fence about getting into it, here are a few stats that are 
sure to push you over to its side:  

 
 The annual affiliate marketing spend is estimated to be 12 billion US dollars 

(SoftwareFindr) 
 It accounts for 15 percent of the entire digital marketing revenue (SoftwareFindr) 
 More than 80 percent of advertisers and 84 percent of publishers capitalize on an 

affiliate marketing program (Rakuten Marketing) 
 It is possible to make over $1000 in a single sale. Some affiliate programs even offer 

their affiliates with more than 8000 dollars per conversion. 

https://www.softwarefindr.com/affiliate-marketing-statistics/
https://rakutenadvertising.com/media-and-press/independent-survey-commissioned-by-rakuten-affiliate-network-reveals-affiliate-mxarketing-industry-to-grow-to-6-8-billion-over-next-five-years/
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Quite powerful numbers! Next: let’s get a deeper understanding of what exactly affiliate 
marketing is.  

What is Affiliate Marketing?  

Affiliate Marketing is a form of digital marketing in which merchants pay commissions to 
a particular website or other third parties to advertise their products. These are 
advertised in the form of referrals. There are four major components involved in affiliate 
marketing. These are the same, regardless of whether you look at it from the affiliate or 
merchant's perspective.  
Merchant 

The merchant refers to the component of affiliate marketing that creates the product. It's 
the merchant's product that the affiliates need to advertise. The term 'merchant' can 
refer to anyone, from startups to large multinational corporations. They can also be 
referred to as the brand, the seller, the creator, etc. 
Affiliate 

The affiliate is the third party website or entity, which advertises the merchant's 
products. The affiliate's objective is to show his audience the value of the product or 
service the merchant is offering, and then convince them to buy it. Some of the ways that 
affiliates are incentivized are based on: 

 Registrations 
 Email sign-ups 
 Sales and 
 Subscriptions 

There are various components that make the relationship between an affiliate and the 
merchant possible: the affiliate network.  
The Affiliate Network 

The affiliate network acts as the middle-man between the merchants and the affiliates. It 
allows merchants to find an affiliate they want to collaborate with (who are in-sync with 
the merchant's brand values) and, likewise, enables affiliates to find merchants they 
want to work with.  
The affiliate network provides merchants with tools to track and process payments for 
affiliates. 
Consumer 

Consumer: the most crucial component of affiliate marketing. The merchant would not 
get any revenue without customers to buy these products, and the affiliates wouldn't get 
any commission either.  

What is the Process of Affiliate Marketing? 

Step 1 

Use a tool or platform to look up affiliates who might be interested in advertising your 
products or services. Initially, it might be difficult to decide which affiliate network to 
choose from. Here are some tips to help you with that. 

 Targeting the Right Affiliates 
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You need to understand what kinds of affiliates you want to advertise your brand. If 
your brand belongs to a particular niche, it's highly likely that an affiliate network 
that caters to your specific needs already exists. You just need to find it. 

 Competitive Analysis 

Find out which affiliate networks your competitors are using. Analyze out how 
successful these networks are for them, and how large their affiliate programs 
are.  

 Tracking Solutions 

You need to determine what kind of tracking solutions you require. Although most 
merchants are okay with basic tracking abilities, some others may require 
advanced tracking, which could be a deciding factor. 

 Affordability 

Some networks might require a monthly membership, and some others take a cut 
from your profits. 

Some of the most popular affiliate networks in the market right now are:  

 
Fig: Popular Affiliate Networks - Affiliate Marketing 

Step 2 

Set up rules, guidelines, image specifications, commission values, etc. that need to be 
adhered to by the affiliates. Some of the specifications can be:  

 The types of creatives (images) that can be used 
 The kind of text that's present in the advertisement 
 Image specifications 
 Referral links 
 Commission percentage, and so on 

The commissions that the affiliate is entitled to be mentioned. Let's look at an example of 
when an affiliate gets a 15% commission for each time the referral code is used.  
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Fig: An Affiliate's Commission  
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Step 3 

The affiliates apply to advertise on behalf of your brand/ organization. Affiliates can get 
in touch with you through the affiliate network, or through a link on your website, set up 
for this specific purpose.  
Did you know that Amazon gives you the option to become their affiliate?  

 
Fig: Amazon's Affiliate Program 

Step 4 

You need to select an affiliate that's best suited for your brand. This can be done by 
choosing applicants for your affiliate program (on your website or the affiliate network). 
Affiliates can be selected based on:  

 The amount of traffic the affiliate's website receives 
 The success of their previous affiliate campaigns 
 Their acceptance of the commission that you are offering 

Step 5 

The affiliate advertises the merchant's product in his blog, website, YouTube channel, 
etc. Most of these have a referral link or an advertisement incorporated into them. The 
customer clicks on this and is transferred to the merchant's website.  
Now, let's take a look at some of the marketing channels used by affiliates.  

 Influencers: This is an individual with a sizable audience in social media. With social 
media posts, blogs, and other forms of interaction, the influencer can guide his/ 
her audience to the merchant's website.  

 Bloggers: Most bloggers can rank in search engine queries organically. Taking 
advantage of this, bloggers sample your products/ services and then review them 
comprehensively, which compels the audience to go to the merchant's website.  

 Paid Search Focused Micro-sites: These are sites that are websites, different from 
the merchant's main site that focuses on content tailored to a particular type of 
audience. They are usually successful thanks to their straightforward and simple 
call-to-action.  

 Email Lists: Some affiliates still use email marketing with the help of email lists 
they have built over a while. Others also take advantage of email newsletters that 
hyperlink to the merchant's product 

 Large Media Websites 

 These are websites that advertise to millions of people. With this comes great 
exposure and similarly huge conversion rates, providing sizable revenues to the 
merchant and the affiliate.  

https://affiliate-program.amazon.com/
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Step 6 

The customer purchases on the merchant's website, and the affiliate network takes note 
of the transaction details. 
Step 7 

The validity of the transaction is verified, and the amount is credited to the affiliate. 
Step 8 

The affiliate network may take a cut of the profit, and then pay the affiliate his/ her 
commission, and the process repeats itself.  

How to Succeed in Affiliate Marketing (Merchant)? 

 Attract successful and profitable affiliates by offering competitive rates. 
 Gamify your compensations into different tiers. Rewards are given to the affiliates 

that are performing well. 
 Ensure you communicate regularly, and a good relationship is maintained with 

your affiliates. 
 Set up strong guidelines and focus on the liberties that can be taken by the 

affiliates.  
 Be flexible with your budget, as long it is bringing in profits. 
 Nurture new affiliates by providing them with appropriate talking points and 

promotional ideas. 
 Create a buzz around your product by having affiliates promote your products 

along with additional details about them. 
Below listed are some of the benefits a merchant has in affiliate marketing.  

Benefits of Affiliate Marketing for a Merchant 

 You get to choose an affiliate that represents your brand and products the best 
 You're only paying the affiliates their commission if conversions take place 
 The affiliate's audience would be highly likely to be interested in your product 
 The process works in a semi-automatic fashion 

How to Become an Affiliate Marketer? 

1. Choose a Niche 

The first thing you need to figure out is the niche you want to cater to. To decide on a 
particular niche, you need to ask yourself questions like:  

 What are some topics I'm passionate about? 
 Are people interested in my niche? 
 Will there be constant demand?  
 What's the competition like? 
 What are the other affiliate programs that work within my niche? 

Tools like Google Trends, Ubersuggest, and Clickbank would determine how successful 
your chosen niche is.  
2. Research Programs 

The next step is to find an affiliate marketing program that's suitable for you. You can 
make an informed decision by keeping in mind the following questions: 

 Which merchants are working with the program of your choice? 
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 How much commission will you make? 
 Are you ready to commit to the program and the brands that work with it? 
 What support does the program provide you? 

3. Build Your Platform 

Next, you need to build a platform that can make your content work. You have two 
options to choose from:  

 Make a website (a blog or a marketplace) 
 Run paid ads 

 It's on these platforms that you can present your content for the audience to see. 
4. Create and Publish Quality Content 

One of the most important steps here is to create content that helps you stand out as a 
valuable, bankable, and trustworthy affiliate marketer. Some types of content you can 
start with are:  

 Product Reviews: You can write reviews of products and services within your 
niche.  

 Blog Posts: With a consistent post schedule, and by posting unique, high-quality 
content relating to your niche, you will be able to establish yourself as a leader in 
that niche. Your audience will significantly value your recommendations, and by 
extension, help you in your efforts. 

 Guides: You can create informational content that can get people interested in 
what you have to say. In time, you can develop your audience's interest in the 
product you're trying to sell. 

5. Create an Ad Account 

Although creating a website is a great option to become an affiliate marketer, advertising 
is also a great way to perform affiliate marketing. With the latter method, you don't even 
need a website! Some of the most popular advertising platforms on the internet are: 

 Google Ads 
 Facebook Ads 
 Bing Ads 

You can choose an appropriate platform depending on your requirements.  
Next up, let's have a look at how affiliates can make money off affiliate programs.  
How is an Affiliate Marketer Paid? 

There are three different methods based on which an affiliate can be paid. Let's have a 
look at each of them: 

 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1114 | 1352  

1. Pay Per Sale 

In this program, the affiliate is paid a percentage of the sale by the merchant, after the 
purchase of the product by a customer.  
2. Pay Per Lead 

In this case, the affiliate is provided compensation based on the number of leads that 
have been converted. The affiliate's objective is to drive his/ her audience to the 
merchant's website and have them perform a particular action like - sign up for a trial, 
subscribing to a newsletter, etc. 
3. Pay Per Click 

In this case, the affiliate needs to redirect customers to the merchant's website. The 
affiliate is paid depending on the increase in web traffic that they bring to the site.  
Now, let's take a look at the benefits of becoming an affiliate marketer.  

Benefits of Becoming an Affiliate Marketer 

 A Constant Flow of Income 

Once you've invested time and resources into your campaign, you can relax as your 
audience purchases your products in the following days. This flow of income could likely 
continue for a long time. And even if you're not in front of your computer, the pay 
remains continuous. 

 No Customer Support 

Once your customers have bought your product, you won't have to worry about 
customer support or satisfaction. Those become issues that the merchant needs to 
handle.  

 Work from Home 

You'll be able to receive revenue for campaigns created by the merchants from 
the comfort of your home. You could do this work in your pajamas. 

 Cost-effective 

You can get started quickly and with ease and low cost. You don't have to worry about 
any affiliate program fees, and neither do you need to create a product. 

 Convenient and Flexible 

You have the freedom to set your own goals, determine your hours, not get bogged 
down by restriction or regulations. 

 Performance-Based Rewards  

Affiliate marketing is entirely based on your performance. The more effort you put into 
it, the better outcome you get.  
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What is Google Data Studio and How to Create Report on It? 

What is Google Data Studio? 
Google Data Studio is a web-based data visualization tool that helps users build 
customized dashboards and easy-to-understand reports. It helps in tracking key KPI's for 
customers, visualizing trends, and comparing performances over time. 
 
What Are the Benefits of Using Google Data Studio? 

 Easier set up with simple reporting. 
 Creates customized and engaging reports. 
 Pulls multiple data sources into a single report. 
 Makes sharing and collaboration simple. 
 Creates up to five customized reports that are free of cost. 
 Helps the user connect to 150+ data sources. 
 Monitors campaigns effectively. 
 Reduces turnaround time on reporting. 

How Do I Use Google Data Studio? 

1. Log In 

Go to Data Studio by visiting https://www.google.com/analytics/data-studio, and log in 
using your Google Analytics, Google Ads, or Search Console login information.  
Now, you'll be taken to the Google Data Studio overview page. To view the dashboard, 
click the "Home" tab. 
2. Explore the Data Studio Dashboard  

The image below gives you an idea of how sample reports look, and the type of 
information you can fetch from your custom reports. 

 
Data studio dashboard 

The following image of "Welcome to Data Studio!" provides an interactive tutorial that 
will help you understand how to get started with Data Studio. Be sure not to miss out on 
this. 
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Welcome Page 

3. Reports and Data Sources 

 
Reports and data sources - Data Studio 

As shown in the above image, reports, and data sources are displayed on the dashboard 
of Data Studio. Reports let you create data visualizations. Data sources are the instance 
of a connector, which links your report to your external data, such as Google Analytics, 
Google AdWords, etc. 
4. Connect Your First Source  
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Connect Source - Data Studio 
 Data sources act as a link to connect a Data Studio report to a collection of 

underlying data.  
 Each data source has unique features and pre-built connectors that help users 

access and connect efficiently with the Data Studio. 
 Data Studio supports 500+ data sources; some of the most popular sources are: 

o Google Analytics 
o Google Ads 
o Google Search Console 
o BigQuery 
o YouTube Analytics 
o PostgreSQL 
o Search Ads 360 

How to Create a Report on Google Data Studio? 

To create a new report, click on the blue plus (+) button at the bottom right-hand corner 
of the screen. 
The two basic parts of any data report are: 

 Data sources  
 Widgets  

Now, let’s set up a data source first and then build a widget. 

Step 1: Add a Data Source 

Data sources can be added using a data connector. Create a new blank report and add a 
data source (for example, Google Analytics) in the panel.  
In this example, we will add a Google Analytics data source. 

 First, add a ‘New Data Source’ button in the panel and select Google Analytics. 
 Then, create a ‘New Report’ in the panel.  
 Now, select a Connector for creating a new data source, and create a ‘New Data 

Source’ in the panel and add that to your report. 
 Now, click the ‘Authorize’ option to authorize the connection between Data 

Studio and Google Analytics 
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Authorization To Connect - Data Studio 

Once it's authorized, go to the “Google Analytics Account” -> “Property” -> (the view you 
want to get data from) -> “Connect” (on the right corner of the page). 

 As a result, the data source is now connected to your Google Studio. Now, a full 
list of metrics and dimensions are displayed in the new data source. If you want to 
add these metrics and dimensions to your report, click the ‘Add to Report’ button 
on the page. 

 
Add Dimensions and Metrics 

Step 2: Add a Widget 

Now, let's focus on creating visualizations that can be added to your report. Some of the 
visualization include: 

 Pie Charts 
 Bar Charts 
 Time Series Graphs 
 Tables 
 Maps 
 Scorecards 

Additionally, you can also include design elements like text boxes that will make you 
understand your reports in an easier manner. 
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Some of the other important controller elements in the widgets are Date Selector 
(changes the date range of the data), Filter Controller (allows to modify the entire data in 
the report), and Data Control (an easier way to share reports with peers who are willing 
to use that report with their data). 
Consider this example where you will create a simple time-series graph that shows the 
number of sessions that Google Analytics recorded. 

 In the toolbar, select the “Insert” -> “Time Series” option. 
 With the cursor, draw a graph on the report. 
 As a result, the graph will be added to your report. 

  
Time Series 

By default, the graph will have ‘Session’ as the metric, and ‘Date’ as the dimension. 
Step 3: Customize the Widget 

The metric and dimension can be modified the way you want. 
For example, you can add a comparison period, which allows you to compare your 
present data to the previous one. In the Date Range section, select ‘Auto’ and click on the 
dropdown menu below it and choose the ‘Start Date’ and ‘End Date’. 

 
Dates 

Step 4. Create Your Report Theme 
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Whether your report is for clients, teams, or managers, it'll be effective only if presented 
in the right way. To create your report style and formatting, click the  ‘Theme and layout’ 
option in the toolbar. 

 
Theme and layout 

Any changes made here will reflect upon your report. 
This tool has many in-built themes such as simple, simple dark, constellation, groovy, etc. 
But, here it's simpler to design your style. 
Some of the brightly colored themes available are displayed below:  
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Current Theme 

In the toolbar, go to “Theme and layout” -> “Theme” -> “Customize” 
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Edit Theme 

Here, you can choose primary and secondary colors (from the color palette), fonts, and 
the text of your choice. This tab also lets you create a custom chart palette with more 
options for background settings. 
Step 5: Embed External Content in Reports 

With this feature, you can embed external files like Google Docs, Google Sheets, and 
even online videos to create the best experience for your clients.  

 To add content, click “Insert” -> “URL embed” 
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URL embed 

 Now, a  transparent frame appears on the screen. Resize and place the frame as 
required. 

 On the properties panel, go to the ‘Data’ tab, enter the desired URL in the 
external content URL field. 

 Now, configure the chosen content's frame border properties in the ‘Style’ tab.  
Step 6: Share the Report 

Here, you can share or invite others to view or access reports and data sources. Also, by 
turning on link sharing, anyone in your organization can view your Data Studio assets, 
despite not having a Google account. So, you just have to select the ‘Share’ button to let 
your customers or peers view or edit the reports. 
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Digital Marketing Skills to Master in 2022 

Digital marketing is a lucrative and cost-effective form of marketing. Thanks to a majority 
of the world’s audience having access to the internet, digital marketing enables marketers 
to engage with their target audiences. It helps users with personalized experiences to 
target them based on their preferences and build awareness and reputation of the brand.  

Mobile Marketing 

 
First off, let’s have a look at some statistics.  
“Mobile is responsible for an average of more than 40% of revenue in leading B2B 
organizations” - BCG 
“Marketers and advertisers put 51% of their budget into mobile ads” - Impact BNG 
“Mobile devices are used for over 40% of online transactions” - Think With Google 
Now that we know how important it is to focus on mobile marketing, let’s take a look at 
exactly what it is.  
Mobile marketing is a form of digital marketing that involves advertising 
products/services through channels like smartphones, tablets, and other mobile devices 
via websites, SMS, social media, in-app notifications, etc.  
Some of the critical areas to be focused on for successful mobile marketing are:  
1. Focus on the Customer and Personalized Marketing 
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You need to give users a personalized experience and personalized ads based on their 
location and purchase history. With this, the users feel like they’re directly interacting 
with the brand; and hence their loyalty to the brand also dramatically increases.  
2. Identifying Trends With Data 

With the help of data, different trends can be easily identified. With this, customer 
profiles can be created, along with predictive and behavioral analysis that can help with 
understanding users, and how to grab their attention better.  
3. Testing 

Testing helps you understand what works and what doesn’t in your campaigns. It gives 
you insights and learnings that you can use to ensure the success of future marketing 
campaigns. 
4. Mobile Analytics 

By focusing on metrics like engagement ratio, cost per install, average revenue per user, 
and so on, you get a clear understanding of what’s going well and what isn’t. It helps 
provide insights that would drive future campaigns and experiments.  
Now, moving on to our next top digital marketing skill - Customer Relationship 
Management. 
5. Customer Relationship Management 
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“Businesses that leverage CRM software, see sales increase by 29%, sales productivity 
increase by 34%, and sales forecast accuracy increase by 42%” - Salesforce 
“CRM marketing will be worth $73 billion in 2020” - Impact BND 
“Towards the end of 2019, 86% of customers are willing to pay 25% more for better 
customer experience” - Small Biz Genius 
Now, let’s have a detailed look at CRM.  
CRM (Customer Relationship Management) refers to a collection of strategies, tools, and 
technologies through which your relationship and interaction with potential or existing 
customers can be managed. It also enables you to develop new customer relationships or 
retain them. It also helps with sales, marketing, and service management. It may also 
store data like purchase history, personal information, and so on.  
Some of the key areas to be focused on customer relationship management are:  
1. Data Analytics 

Thanks to data analyzed from different metrics, you can perform optimizations that can 
be incorporated into upcoming campaigns. Although your requirements may vary, some 
of the most popular metrics you can focus on are customer churn, NPS(Net Promoter 
Score), customer retention rate, customer churn, first contact resolution rate, etc.  
2. To Understand How Different Tools Work 
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When it comes to CRMs, there’s a huge number of options available. From Salesforce, 
Hubspot CRM, Zoho CRM to Microsoft Dynamics, there is plenty of choices. It’s essential 
to be experienced in at least some popular CRMs considering how each of them has its 
nuances, advantages, and disadvantages. 
6. Designing 

 
Now, let’s have a look at some stats related to designing.  
“70% of companies invest in content marketing, which could include visual marketing 
strategies” - HubSpot 
“32% of marketers say visual images are the most important form of content for their 
business, with blogging in second (27%)” - Social Media Examiner 
Now that we know how vital designing is, let’s have a look at what exactly designing is.  
Designing involves the process of advertising products and services in a visually appealing 
manner. Designing consists of a combination of high-quality creative and copy. A basic 
understanding of designing concepts can be greatly helpful in scenarios where you can 
provide insights for the kinds of creatives you can create for an advertisement.  
Some of the key areas to be focused on for proper designing are:  
1. Having a Basic Understanding of Design Philosophies 
You need to have a basic understanding of adding attention-grabbing and relevant images, 
and other design philosophies to create high-quality designs.  
2. Knowing How to Work With Tools Like Adobe Photoshop and AfterEffects 
You need to understand the working of tools like Adobe Photoshop and AfterEffects to 
churn out good quality creatives. Having even a basic understanding of this software would 
be greatly useful in the long run.  
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7. Social Listening 

 
Let’s have a look at what exactly social listening is.  
Social listening refers to how a brand can learn about what customers are saying about 
them and the industry on the internet, by monitoring digital channels. With this, you can 
track, analyze, and respond to conversations and feedback on the brand’s social media 
channels. This can improve your relationship with your users, increase their brand 
loyalty, and convert them into potential customers.  
Some of the critical areas for social listening are:  
1. Understanding Different Social Media Platforms 
You need to understand how different social media platforms work, how each of these 
platforms is different from each other, what type of content works best for a particular 
platform, and so on.  
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2. You Need Experience With Popular Tools  
Experience with tools like HubSpot and HootSuite will help you handle issues like PR 
crises, customer complaints, user-generated content, competitive intelligence, 
suggestions from users, and much more. Next, at number 8, we have copywriting.  
 
8. Copywriting 

 
Let’s have a look at some stats related to copywriting.  
“A compelling copy draws 7.8 times more site traffic and produces brand recall which 
brings higher engagement rates” – CMI 
 
“64% of B2B marketers outsource their demanding copy needs” – CMI 
 
Now, let’s have a look at what exactly copywriting is.  
 
Copywriting involves creating promotional texts that can be used in brochures, 
notifications, billboards, emails, and so on. High quality written content can increase 
brand awareness and encourage users to perform a particular action like signing up to a 
website, buying a specific product, and so on.   
Some of the critical areas of copywriting are:  
1. Understanding Customers and Competition 
Customers can give you vital information that can help you understand your competition. 
You’ll understand what content your audience enjoys the most, what they dislike, what 
content gets maximum engagement, and so on. For this, having grammatical skills and 
excellent writing skills that can be hugely beneficial for you.  
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Email Marketing 

 
Let’s have a look at some stats related to email marketing.  
“49% of consumers would like to receive promotional emails from their favorite brands” - 
Statista 
“81% SMBs rely on email as their primary customer acquisition channel, and 80% for 
retention” - Impact BND 
“In 2019, global email users amounted to 3.9 million. By 2023, this is set to grow to 4.3 
billion” - Statista 
Now, let’s have a look at what exactly email marketing is.  
Email marketing is a method that uses emails to promote products and services to a 
highly targeted audience. It can be used to improve brand relationships or ultimately 
drive them away.  
Customers can directly interact with personalized emails. This helps them stay updated 
with new products and services.  
Next, let’s have a look at the key concepts of email marketing.  
1. Focusing on Personalization and Automation 
Email marketing can be used to keep in touch with your users, to inform them about the 
latest products/services, and to perform other forms of engagement.  
2. Complying With Data Privacy Rules 
Privacy rules like GDPR specify a large number of restrictions that need to be followed. If 
these rules aren’t followed, your brand could face huge fines. 
3. Experimenting With Different Kinds of Content 
Your emails can have images, gifs, or videos attached to them. Each of these can impact 
your customers  
4. Understanding Popular Tools and Metrics  
Having an understanding of popular tools like Mailchimp and Hootsuite can help you 
become successful at email marketing. These platforms also come with several features 
like contact segmenting, autoresponders, service and app integration, A/B testing, and 
much more. 
Now,  Social Media Marketing.  
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Social Media Marketing 

 
 Let’s have a look at some statistics related to social media marketing.  
“90.4% of Millennials, 77.5% of Generation X, and 48.2% of Baby Boomers are active 
social media users” - E-marketer 
“73% of marketers believe social media marketing has been “somewhat effective” or 
“very effective” for their business” - Buffer 
“Nearly 50% of the world’s population uses social media” - Statista 
Now, let’s have a look at what exactly social media marketing is.  
Social media marketing enables marketers to drive traffic to their website, build their 
brand, increase sales, and achieve their marketing goals by creating and sharing content 
through social media platforms like text, images, videos, and other forms of content that 
can drive engagement. You can also perform paid advertising on these platforms.  
Next, let’s have a look at some key concepts of social media marketing.  
1. Understanding Different Social Media Platforms 
Each of these social media platforms has its nuances, audiences, advantages, and 
disadvantages. An understanding of these platforms can help you choose a platform based 
on your requirements.  
2. Monetization 
Social media platforms like YouTube enable you to monetize your videos. Events, affiliate 
marketing, and influencer marketing are some other options that can be used.   
3. Analytics 
Experience with marketing tools like Buffer and Buzz sumo can help you track and analyze 
competitors’ content to determine what works best.   
You need to know your user base, understand what content they enjoy, and then optimize 
it.  
Now, let’s have a look at number 3, PPC.  
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PPC (Pay-Per-Click) 

 
Let’s have a look at some stats related to PPC. ‘ 
“Businesses make an average of 2 dollars in income for every 1 dollar they spend in 
Google Ads” - Google 
“Paid ads have an 11.38% CTR on Google” - Sparktoro 
“33% of people click on a paid search ad because it directly answers their search query” - 
Clutch.co 
Let’s have a look at what exactly PPC is.  
Pay-per-click lets marketers advertise their content by spending a certain amount of 
content each time their ads are clicked. One of the most successful types of PPC is search 
engine marketing.  
Let’s have a look at the key concepts of PPC. 
1. Google Ads 

One of the most popular platforms in the market, Google ads, enables marketers to 
advertise to a broad audience. You need to understand how the platform works, its 
different features and functionalities to be used more efficiently.   
2. Analytics 

Metrics like cost-per-click, clickthrough rates, quality scores, etc. need to be understood 
to make optimal and well-informed decisions.   
Having skills with copywriting and visual design can be hugely beneficial to the marketer 
and the organization. 
Now, for number 2 on our list - SEO.  

Must-Have Digital Marketing Tools in 2020 

Digital Marketing Tools You Should Consider. 

 

https://www.simplilearn.com/exploring-ppc-search-ads-and-display-ads-article
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Email Marketing 
1. MailChimp: is a web-based email marketing service. In addition to sending marketing 

emails like newsletters, you can create targeted campaigns and automated messages. It 

offers templates that can be customized as well as a number of options for sending 

emails. 

Features 

 Customizable forms and templates 
 A/B testing 
 Social media plug-ins 
 Automation workflows 
 Multiple campaigns 
 Real-time reports 
 Tutorials 

Pricing 

The basic plan is free and includes up to 2,000 subscribers and up to 12,000 emails per 
month. Other plans are available for $10 to $199 per month. 
2. HubSpot Sales 

Focused on the sales process as a whole, HubSpot Sales allows you to create and share 
email templates. Every lead’s contact info, email leads, and clicks get logged 
automatically. 
Features 

 Automated emails, including follow-up emails 
 Works with Gmail, G Suite, and Outlook or Office 365 for Windows 
 Email tracking, including open, click and reply data 
 Customizable templates 

Pricing 

Subscriptions are $200 to $2,400 month, billed annually. 
 
Social Media Management 

3. Buffer 

Buffer makes managing your social media easy. Nicknames like “The Siri of Social 
Media” and “Social Media Assistant” have been applied to Buffer. It allows you to 
optimize your posts on Facebook, LinkedIn, App.net, and Twitter, by scheduling them in 
advance; Buffer posts them at the best time based on time zone. 
Features 

 The free trial period for paid plans 
 Detailed analytics 
 Multiple social networks 
 High security with two-step login 
 Posts the same message to all platforms or customizes for each 
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Pricing 

Two plans are available for individuals: Individual, which is free, and Awesome, which is 
$10 per month. Three plans are available for teams and agencies: Small, which is $99 per 
month; Medium, $199 per month; and Large, $399 per month. 
4. Sprout Social 

Sprout Social provides solutions for social media management, marketing, analytics and 
customer service. It’s integrated with Facebook, LinkedIn, Twitter, Google+ and more. 
You’ll get excellent statistics across all of your interlinked social networking sites. Sprout 
Social has become an incredible force in the social media world in a short time. 

 
  

http://sproutsocial.com/
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Search Engine Optimization 

 
First, let’s have a look at some statistics.  

 “57% of B2B marketers stated that SEO generates more leads than any other 
marketing initiative” - HubSpot 

 “Where to buy” + “near me” mobile queries have grown by over 200% in the past 
two years” – Google. 

 “On the first page alone, the first five organic results account for 67.60% of all the 
clicks” - Zero Limits Web 

 Let’s have a look at what exactly the search engine organization is. 

 SEO enables marketers to improve the quality and quantity of the traffic coming 
to your website by making it more visible to users who have searched for a 
particular keyword. SEO improves unpaid results and doesn’t count as traffic 
obtained from paid ads.  

1. Technical SEO 

Understanding the technical concepts of SEO like sitemaps, server-side settings, rewrites, 
etc. enables marketers to perform server level and page level optimizations.  
This ensures users find the website’s content and help generate traffic and improve 
conversions.  
2. Content Marketing 

With content marketing, marketers can create high-quality content; SEO can provide 
appropriate keywords that enable the material to be identified by search engines.  
3. Link Building 

https://www.simplilearn.com/tutorials/seo-tutorial/what-is-seo
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SEO involves a combination of external and internal link building. One builds links with 
credible websites, and the other optimizes links within the website and social media 
platforms. 
4. Site Usability 

Placing objects and information appropriately on the website will make it easy to use and 
navigate.  
5. Google Analytics & Webmaster 

Google Analytics will help with tracking and reporting website traffic. Google Webmaster 
will help track your website’s search performance with the help of the google search 
console and additional resources.  
 
Next, number 1 on our list is Data Analytics.  
1. Data Analytics 

 
Data analytics involves the combination of collecting and organizing data, to draw 
conclusions that can be incorporated into upcoming campaigns.  
Here are some key concepts of Data analytics.  
1. Google Analytics 

Google Analytics is a popular tool that enables marketers to analyze their website. It 
records information like the number of visitors coming to the site, the demographics of 
the visiting audience, their interests, etc. This information can be used to drive future 
marketing campaigns.  
2. Data Visualization 
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Data visualization enables data to be translated into a chart, graph, or other visual 
components.  
Understanding data visualization would help with understanding data quickly and 
cleanly.  
It enables brands to identify upcoming trends and to respond to them quickly. The brand’s 
story can also be shared with others, thanks to being able to create a narrative with 
graphics and diagrams. And finally, a clear understanding of data structures fundamentals 
and basic statistics can significantly ease the process of data analysis.  
 
Features 

 Social media dashboard 
 Link performance analysis 
 Can view Twitter follower demographics and contact details 
 Discover customers by interest or by location 
 Monitor competitor activity 
 Customer relationship management tools 
 Integrated analytics 
 Free trial 

Pricing 

Offers three plans: Premium, $99 per month; Corporate, $149 per month, and Enterprise, 
$249 per month. 
5. Wyng (formerly Offerpop) 

Wyng lets you configure and personalize digital, mobile, and social campaigns. It also lets 
you view and manage user-generated content and much more. 
Features 

 Integrate with other enterprise platforms, such as Experian and Sprout Social 
 Build custom configurations using open-source technology 
 Auto-response in real-time 
 Customizable templates 
 Preview rendering for mobile, tablet and desktop devices 
 Real-time reports 

Pricing 

Contact Wyng to get a breakdown of plans and prices. 
6. Nanigans 

Nanigans offers “profit-driven advertising automation” designed for in-house advertisers. 
Founded in 2010, the company helps marketers achieve social and mobile performance 
marketing goals using workflow automation, predictive optimization, and more. 
Features 

 Official partner of Facebook, Instagram, and Twitter 
 Industry-leading advertising automation software 
 100-plus reporting attributes 
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 Cross-channel ROI (return on investment) automation 
Pricing 

Nanigans is one of the most expensive advertising tools on the market, but it’s also one 
of the best. Contact the company for a demo and pricing. 
 
 
7. Facebook’s Power Editor 

A powerful tool designed for bigger Facebook advertisers, Power Editor lets you create, 
edit and publish multiple ads at once. Facebook’s Ad Manager is for beginners; Power 
Editor is a more advanced and effective way of managing ads. 

 
Features 

 Manage many ads simultaneously 
 Import ads using Excel 
 Find what you want quickly using search filters 
 Works with Chrome, Firefox, Internet Explorer, and Edge 

Pricing 

Varies based on the campaign. 

Analytics 
8. Google Analytics 

Google Analytics is a comprehensive freemium web analytics service available to anyone 

with a Google account. It helps you understand your site users and figure out which 

digital campaigns are working and which aren’t. 

Features 

http://www.nanigans.com/
https://www.facebook.com/business/help/165119026899353
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 Custom reports 
 Cross-device data 
 Segmentation for analysis of subsets 
 Built to work with Google’s other media and publisher products 

 
Pricing 

The standard version of Google Analytics is free. The premium version is $150,000 per 
year. 
9. Kissmetrics 

A web-based solution, Kissmetrics helps in analyzing, recognizing, understanding, and 
enhancing the metrics that drive online business. The biggest difference between it and 
Google Analytics is that user behavior is more accessible on a multisession basis. 
Features 

 Real-time tracking 
 A/B testing 
 Funnel and cohort reports 
 Design editor 
 Behavior campaigns and behavioral comparisons 
 Software integration 
 Revenue reports 

Pricing 

Subscription plans start at $500 per month. You can request a demo. 
Task and File Management 
10. Trello 

All marketers can benefit from Trello, which is a software developed for managing 
projects. It has cards that are like sticky notes that you can arrange on aboard. An 
individual card has deadlines, checklists, images, colored labels, attachments, and notes 

https://neilpatel.com/
https://trello.com/
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from any others sharing the board with you. There is no limit to the number of boards 
you can have. 

 
Features 

 Collaborate with others in real-time 
 For companies of all sizes 
 Integrate apps into the workflow 
 Offers email notifications and an activity log 
 Attach photos and drawings 

Pricing 

In addition to a free basic version, there’s a Business Class option for $9.99 per month 
when paid annually, and an Enterprise option for $20.83 or less. 
11. Dropbox 

Dropbox is a tool for sharing, saving, and syncing files. Files saved on Dropbox can be 
accessed from anywhere around the world, including on mobile devices, and can be 
shared with people who don’t have a Dropbox account. 
Most e-mail services limit the size of attachments, meaning large files generally can’t be 
sent over e-mail. Photos, videos, Word documents, presentations, and spreadsheets can 
all be backed up and shared using Dropbox. 
Features 

 File storage and sharing 
 Accessible from any device 
 Preview ability 
 Automatic updates 
 Simple link sharing via email, chat or text message 
 Online backup and file recovery 
 Offline access 

Pricing 

The basic version is free; the upgraded option costs $9.99 per month when billed 
monthly or $99 billed annually. 
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12. Evernote 

Evernote didn’t take long to carve out a niche for itself in the world of digital marketing. 
The application is designed for note-taking and archiving. You can also put together web 
articles and save images, and share everything with your team. The app is available on a 
range of devices. Once you make a note, you can access it from anywhere. 

Features 

 Web clipping support 
 Edit rich text and sketches 
 For mobile and desktop devices 
 Store notes, web clips, files, and images 
 Record audio 
 Share notes and collaborate on files 

Pricing 

The basic plan with up to 60 MB of new uploads per month is free. The Plus plan, with 1 
GB of uploads per month, is $34.99 per year; the Premium plan gets you 10 GB and costs 
$69.99 per year. 
SEO 
13. Raven 

Reports are what tell you if a campaign is working and if targets are being met —report 
generation and presentation take up a considerable amount of a marketer’s 
time. Raven is an SEO toolkit that makes creating marketing reports easier. It also helps 
you research, monitor, and manage your social media, content, pay-per-click (PPC), and 
search engine optimization (SEO) campaigns. 

 

Features 

 Automated marketing reports 
 More than 20 data connectors, including Google Analytics and Facebook Ads 
 Site auditor tool automatically crawls sites to gather data 
 Create unlimited campaigns 

https://raventools.com/
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 Very user-friendly 
 Free trial 

14. Visual Website Optimizer 

Visual Website Optimizer lets you create various versions of your website and landing 
pages to see which would generate maximum sales. You can request a demo. 

 

Features 

 A/B testing 
 Split URL and usability testing 
 Behavioral and geographical targeting 
 Revenue tracking 
 Plug-ins and integration 
 Real-time reports 

Pricing 

Three plans: Startup, $49 per month billed annually (or $59 per month billed monthly); 
Business, $129 per month billed annually (or $155 per month billed monthly); and 
Enterprise, $999 per month billed annually. 
15. Moz 

Moz began as an SEO consulting company in 2004. It offers Moz Pro and Moz Local to 
help you improve search rankings to get more views and customers. Moz Pro is “the SEO 
toolset that’s got it all: keyword research, link building, site audits, and page 
optimization,” according to the website, while Moz Local helps with SEO-integrated 
business listings. 

Moz Pro Features 

 Industry-leading SEO metrics 
 Many ranking tools 
 Site audit tool identifies errors 

https://vwo.com/
https://moz.com/
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 User-friendly analytics 
 Free trial 

 

Pricing 

Four plans, from $79 to $479 per month, both paid annually. 
16. SEMrush 

SEMrush helps you maximize your efforts in the areas of SEO, PPC, social media, content, 
and public relations. It offers info on things like best-performing posts, performance 
versus the competition, and strategy analysis, and trending topics. 

 

Features 

 Analytics cover organic, advertising and keyword research and more 
 Data visualizations for fast competitive analysis 
 Site audit 
 Brand monitoring 
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 Position tracking 

Pricing 

Three monthly plans (lower prices for annual billing): Pro, $99.95 per month; Guru, 
$199.95 per month; and Business, $399.95 per month. 
Content Marketing 
17. BuzzSumo 

When you’re creating your marketing strategy, you’ll need to look for what is trending on 
sites and what is clicking with your audience. BuzzSumo is a tool that ranks content 
shared on social media sites based on the number of hits it gets. You can easily find who 
the most influential content curators or aggregators are within any niche. 
 
BuzzSumo also gathers statistics on the industry’s influencers along with their associated 
websites. When used wisely and paired with some of the other tools on this list, the 
possibilities are endless. 

http://buzzsumo.com/
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Features 

 Content insights, alerts, curation, discovery, and analysis 
 Influencer amplification available 
 Competitor analysis and comparisons 
 Social backlinks and advertising filters 
 Open API 

Pricing 

Three plans (prices are for monthly billing): Pro, $79 per month; Agency, $239 per month; 
and Enterprise, $559 per month. 
18. Kapost 

Content marketing is big. And Kapost is a tool that combines world-class software and 
expert service to help you deliver content that gets results. It’s designed to help you 

https://uplandsoftware.com/kapost/
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manage the whole content marketing process, from planning to ideation to production 
and finally to distribution and analytics. 

Features 

 More than 60 out-of-the-box integrations 
 Open API 
 Plenty of support through consulting services and more 
 Customizable content dashboard and workflow 
 Cross-channel content performance metrics 
 Automated email notifications 
 Can manage videos, blog posts, e-books, white papers, presentations, emails, 

landing pages, and webinars 

Pricing 

A subscription starts at $3,500 per month. 
Visual Marketing (Images and Videos) 
19. Piktochart 

Piktochart helps you create professional-looking infographics even if you have no design 
experience. The tool provides over 100 templates that you can customize or just fill out. 

 

Features 

 More than 600 professionally designed templates 
 Very user-friendly interface 
 Library of more than 4,000 images to use 
 Import data from Excel or Google spreadsheet or Survey Monkey 

Pricing 

https://piktochart.com/
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The basic plan is free. There are two upgraded versions: Lite, $15 per month; and Pro, 
$29 per month. 
20. Vimeo 

The highly popular Vimeo site is a platform that lets you view, upload, and share videos. 
It has mostly original content instead of TV shows and movies. 

Features 

 Can embed your own logo into the video (Pro version) 
 No ads before the video, unlike YouTube 
 Supportive community 
 Fewer videos than YouTube, so less competition for viewers 

 

Pricing 

The basic plan is free; upgraded plans range from $5 to $50 per month. 
21. Unbounce 

Unbounce helps you build, publish, and test landing pages. The site provides an easy-to-
use editor to create high-conversion landing pages. 

Features 

 Landing page and overlay templates 
 Real-time stats 
 A/B testing 
 Lead generation tools 
 Multiuser and client management 
 Integrations 
 Text replacement automatically changes selected keywords to match those used in 

search queries 

https://vimeo.com/
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 Free trial 

Pricing 

Three plans (based on annual billing): Essential, $79 per month; Premium, $159 per 
month; and Enterprise, $399-plus per month. 
22. GoToMeeting 

Meetings and calls with clients are a given, but you don’t have to be there in person. 
Video-conferencing software GoToMeeting lets you have meetings online, making it easy 
and cost-effective to collaborate with colleagues and interact with customers. 
Features 

 Access to instant meetings with a single click 
 One-time scheduled and recurring meetings 
 Seamless audio 
 Recording option 
 Integrated scheduling with Microsoft Outlook 
 Use on Mac, PC, iPad, iPhone or Android 
 Free trial 

Pricing 

Three plans (based on annual billing): Starter, $19 per month; Pro, $29 per month; and 
Plus, $49 per month. 

 
Automation Software 

23. Pardot 

Pardot is a web-based marketing software that helps you streamline lead management 

and create and track online campaigns. It offers modules for building and managing 

elements like forms and landing pages. 

Features 

http://www.pardot.com/
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 Customizable templates 
 Email testing with automated CAN-SPAM compliance 
 Lead scoring, grading, and management 
 Tracking and analytics 
 Top-notch customer support 
 Real-time sales alerts 

Pricing 

Three plans: Standard, $1,000 per month; Pro, $2,000 per month; and Ultimate, $3,000 
per month. 

24. Marketo 

Marketo bills itself as a “world leader in marketing automation for companies of any 
size.” It’s a pioneer in innovation and offers a range of products; it also lets you tap into 
the insight of expert marketers through its Marketing Nation. 

Features 

 Easily build and scale automated marketing campaigns 
 Explains search marketing, landing pages, web personalization, more 
 Integrations 
 Analytics 
 A/B testing 
 Ad targeting and mobile engagement 

Pricing 

Varies based on the bundle chosen. 

  

https://www.marketo.com/
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What is Social Media Marketing? 
Social media marketing is the practice of using various social media channels to connect 
with customers and lead them to your product or service, a compelling option in the 
marketing toolkit. But don't feel bad if you don't fully understand the concept as the 
term often gets thrown around without a whole lot of thought about a clear definition.  
Social media marketing is simple on the surface, but it includes multiple layers that 
impact the best practices for different types of organizations. While social media 
marketing may seem easy, jumping in without a solid understanding will hurt your 
chances of getting the right results. 
Social media management is the process of creating, publishing, and analyzing content 
you post on social media platforms like Facebook, Instagram, and Twitter, as well as 
engaging with users on those platforms. You can streamline social media management 
with free and paid tools, as well as professional social media management services. 
A Quick History of Social Media 
Social media began in 1997 with a website called Six Degrees, growing to around 1 
million members who could create profiles and connect with one another by "friending." 
Then, in the next couple of years, with the rollout of a site called LiveJournal, blogging 
took off to keep friends updated with each other’s personal lives.  
The first decade of the 2000s saw expansive social media growth with the addition of 
Friendster, LinkedIn, Facebook, YouTube, MySpace, and Twitter. Not all of them survived 
as we all know, but they changed the internet landscape and marketing forever. 
What is a social media manager? 
A social media manager, whether working as a consultant, in-house employee, or team 
member at a social media agency, is a skilled professional at social media marketing, 
advertising, and management. They help achieve your goals for social media, like growing 
your following or social media revenue. 
Social Media Marketing Defined 
Before building a social media marketing plan, you need to start with the fundamentals; 
a definition of the concept will provide a foundation on which to develop your 
understanding. At the simplest level, social media marketing involves the use of various 
social media channels to connect with more customers and lead them to your product or 
service. That is an excellent place to start, but it doesn't tell the whole story.  
Neil Patel, one of the most successful entrepreneurs in the social media realm, defines 
social media marketing as the process of "creating content that you have tailored to the 
context of each social media platform to drive user engagement and sharing." This 
definition expands our view to see the need to understand the differences between the 
various platforms and to be clear about our goals. 
The Benefits of Social Media Marketing 
Many organizations jump into social media marketing or develop a social media 
marketing plan without thinking much about the outcomes. It doesn't make sense to 
invest time, energy, or money in social media without understanding the benefits.  
A clear view of potential outcomes can help you evaluate the cost-benefit and fine-tune 
your strategy for the best results. Here are just some of the possible benefits: 

 Better awareness of your business and brand 
 High website traffic 

https://www.simplilearn.com/tutorials/social-media-marketing-tutorial/how-to-do-social-media-marketing
https://www.simplilearn.com/essentials-of-social-media-marketing-article
https://www.simplilearn.com/essentials-of-social-media-marketing-article
https://neilpatel.com/
https://blog.hootsuite.com/social-media-for-business/
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 More sales leads 
 Increased sales 
 Good customer engagement 
 The chance to better understand customers 

Lesson 2: Why is social media management important? 
Social media management offers several benefits, including: 

Cost: No matter your marketing budget, social media is a cost-effective initiative. It’s free 

to join social media networks, post content, respond to user comments, and more. Even 

social media advertising offers a profitable channel for reaching your audience and 

building an online following. 

Reach: Social media networks, from Facebook to LinkedIn, can connect you with users 

across the world. You can also use social media platforms, like Pinterest, to reach niche 

audiences. Traditional marketing and advertising can’t match the reach — or price — or 

social. That’s why social media management is a must for businesses. 

Users: Incorporating social media into your marketing strategy allows you to align your 

marketing initiatives with user behavior. For example, 74% of people now use social media 

when making purchase decisions. Not to mention, 80% of people get advice about 

purchases through social media. 

Performance: Marketers and business owners alike agree on the performance of social 

media marketing and advertising. Via social, companies can build their brand and even 

generate leads and sales. Almost 45% of business-to-business (B2B) marketers, for 

instance, have earned a client through Facebook. 

With social media’s multiple advantages, it’s worth considering for your marketing 

strategy. 

Lesson 3: How Does Social Media Marketing Work? 

A well-developed social media marketing plan includes several steps, all of which are 
required to get the most bang for your buck.  
It starts with an effective strategy. Determine your business goals and choose a path to 
achieve them. Then come planning and publishing. At some point, you need to jump in 
and start sharing content on the platforms with which you’ve chosen to engage. But, 
unlike other marketing methods, the next steps are just as important—listening and 
engaging.  
The benefits of social media become apparent when people begin to comment, tag, 
share, and message you (or your business). It’s important not just to watch and listen, 
but also to respond and continue the conversation.  
Finally, part of a great social media marketing plan is reviewing analytics. You can track 
views, likes, shares, comments, and other aspects of engagement to see what parts of 
your plan have the most impact. 
Here are some of the most common platforms for social media management: 
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Lesson 4: Social Platforms 
1. Facebook 
2. Twitter 
3. Instagram 
4. LinkedIn 
5. YouTube 
6. Pinterest 

Facebook 
With nearly two billion daily users, Facebook is a massive social media network. That’s 
why agencies that offer social media management services will not only specialize in 
Facebook but also recommend it due to its audience variety. 
Learn more about Facebook for social media marketing: 
 Demographics: Facebook offers access to several different demographics, from 

seniors and youth to men and women. Plus, more than 50% of adults in the U.S. use 
Facebook multiple times a day, which lets you connect with varying segments of your 
target audience. 

 Uses: From a social media management perspective, Facebook is useful for building 
relationships with existing and future customers. It can also help build brand loyalty, 
which can encourage future purchases. 

 Perks: A massive perk about Facebook is that it features a wide variety of ads and 
content formats, from photos to videos to text. Even better, for more than 40% of 
business-to-business (B2B) marketers, it’s led to new clients. 

No matter your industry or goals, expect to use Facebook in your social media strategy. 
Twitter 
With 330 million monthly users, Twitter doesn’t offer the same reach as Facebook. It 
does, however, provide your business access to a group of users that engage with brands 
daily. Depending on your target audience, that’s an advantage. 
Learn more about Twitter for social media marketing: 
 Demographics: Less than 25% of U.S. adults use Twitter, but the social media platform 

provides competitive access to users between the ages of 18 to 29 — more than 40% 
of Twitter users are from this age group. They’re also more likely to be active on the 
platform multiple times a day. 

 Uses: Unlike Facebook, Twitter focuses more on news. It also emphasizes two-way 
conversations between users, whether they’re a brand or consumer. If you’re looking 
to engage with your target audience, Twitter is a good option. 

 Perks: One advantage of Twitter is its users — they’re active and happy to engage 
with other users. Twitter also features a specific audience, which is helpful if people 
between the ages of 18 to 29 are in your target market. 

Twitter isn’t for every company, but it does offer value to those in certain sectors. 
Instagram 
With around one billion monthly users, Instagram is becoming a new standard for social 
media management services. Its focus on images, as well as videos, encourages 
companies to come up with creative ways to capture and engage their audiences. 
Learn more about Instagram for social media marketing: 

https://www.webfx.com/social-media/glossary/what-is-social-media-management/#facebook
https://www.webfx.com/social-media/glossary/what-is-social-media-management/#twitter
https://www.webfx.com/social-media/glossary/what-is-social-media-management/#instagram
https://www.webfx.com/social-media/glossary/what-is-social-media-management/#linkedin
https://www.webfx.com/social-media/glossary/what-is-social-media-management/#youtube
https://www.webfx.com/social-media/glossary/what-is-social-media-management/#pinterest
http://www.pewinternet.org/2018/03/01/social-media-use-in-2018/
https://blog.hootsuite.com/twitter-statistics/
http://www.pewinternet.org/fact-sheet/social-media/
http://www.pewinternet.org/fact-sheet/social-media/
http://www.pewinternet.org/fact-sheet/social-media/
https://www.emarketer.com/content/global-instagram-users-2020/
https://www.webfx.com/blog/social-media/why-instagram-matters-to-marketing-infographic/
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 Demographics: Instagram is a prime platform for connecting with users between the 
ages of 18 to 29, as well as 30 to 49. Over 70% of Americans between 18 to 29 use 
Instagram — for users between 30 to 49, the number is nearly 50%. 

 Uses: Like Facebook, Instagram is useful for establishing a relationship with 
consumers, as well as engaging them. Depending on your industry, you can also use 
Instagram to generate new leads. That’s why retail, entertainment, and beauty 
businesses often use the platform. 

 Perks: A benefit of Instagram is that users love to use the platform. That’s why nearly 
60% check in multiple times a day, which increases the chances that users will not only 
see your posts but also interact with them. 

For certain markets, Instagram is a must-have platform in your social media strategy. 
LinkedIn 
As the biggest professional social network in the world, LinkedIn offers access to more 
than 774 million users. That’s why it’s an ideal platform for businesses looking to recruit 
candidates, as well as establish themselves as an industry leader. 
Learn more about LinkedIn for social media marketing: 
 Demographics: LinkedIn is a popular platform among college graduates — more than 

half use the network. Even better, 90% of LinkedIn users are also on Facebook, which 
is helpful if your strategy focuses on both platforms. 

 Uses: Like Twitter, LinkedIn is useful for sharing news-related materials, such as 
company announcements or industry-specific news. It can also assist in developing 
relationships with other companies, plus building your reputation via content 
marketing. 

 Perks: LinkedIn offers a few benefits for businesses, especially B2B operations. For 
B2B leads from social media, 80% come from LinkedIn. That’s why more than 60% of 
marketers find it’s the most effective platform for their business. 

Depending on your goals, market, and operations, LinkedIn could offer several 
advantages. 
YouTube 
With more than two billion users, YouTube offers access to more than 80% of adults in the 
U.S. In response, businesses are doing more with their YouTube accounts, from creating 
how-to videos to showcasing behind-the-scenes material. 
Learn more about YouTube for social media marketing: 
 Demographics: Like Facebook, YouTube features a wide range of users, from 18 to 65 

and older. Even 49% of people 65 and older watch YouTube, while almost 83% of 50-
to-64-year-olds visit the platform. 

 Uses: With YouTube, your company can provide users with informational content. A 
few examples include how-to videos on your products, as well as explainer videos 
related to your industry or services. These can increase user brand awareness, as well 
as lead to conversions. 

 Perks: A notable benefit of YouTube is that it converts more than any other social 
media platform — even Facebook. That can lead to big gains for your company, 
especially if you’re offering a high-priced product. 

While more time-intensive than other social media outlets, YouTube is worth the 
investment. 
Pinterest 

https://www.pewresearch.org/internet/fact-sheet/social-media/
https://www.pewresearch.org/internet/fact-sheet/social-media/
https://www.pewresearch.org/internet/fact-sheet/social-media/
https://about.linkedin.com/
https://about.linkedin.com/
https://www.webfx.com/blog/social-media/why-linkedin-matters-to-marketing-infographic/
https://www.pewresearch.org/internet/fact-sheet/social-media/
https://www.pewresearch.org/internet/fact-sheet/social-media/
http://www.pewinternet.org/2018/03/01/social-media-use-in-2018/
https://www.webfx.com/content-marketing/learn/content-marketing-strategy/
https://www.webfx.com/content-marketing/learn/content-marketing-strategy/
https://www.webfx.com/blog/social-media/8-surprising-social-media-facts/
https://www.webfx.com/lead-generation/b2b/
https://www.webfx.com/lead-generation/b2b/
https://www.statista.com/forecasts/1144088/youtube-users-in-the-world
https://www.pewresearch.org/internet/fact-sheet/social-media/
https://www.webfx.com/blog/social-media/why-youtube-matters-to-marketing-infographic/
https://www.pewresearch.org/internet/fact-sheet/social-media/
https://www.webfx.com/blog/social-media/why-youtube-matters-to-marketing-infographic/
https://www.webfx.com/blog/social-media/why-youtube-matters-to-marketing-infographic/
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Pinterest has more than 450 million monthly active users, providing companies with a 
strong visual focus, such as cabinet manufacturers, clothing stores, and flower shops, the 
chance to connect with people in their target audience. 
Learn more about Pinterest for social media marketing: 
 Demographics: This social media platform features a strong female audience, 

with more than 40% of women — and only 16% of men — using Pinterest. For the age 
groups from 18 to 64, between thirty and 40% of U.S. adults use the platform, while 
usage for those 65 and older is 18%. 

 Uses: Pinterest is excellent for showcasing your product in a non-promotional way. 
For example, you can highlight the uses and features of your goods. You can even 
connect with influencers to promote your products further. 

 Perks: One perk of Pinterest is that users rely on it to plan for future purchases, with 
one study discovering that more than 85% of millennials use it for that purpose. As a 
result, you’re connecting with consumers already planning to buy. 

Depending on your audience, Pinterest is an asset to your social media management 
services. 
While agencies will vary in the platforms they specialize in, WebFX focuses on several 
social media platforms. Our social media management services are available for Facebook, 
Twitter, Instagram, LinkedIn, and Pinterest. 
Best social media management tools 
If you’re excited about getting started with social media, you can make the experience 
(and your productivity) even better with social media management tools. These paid and 
unpaid tools can help you schedule content, respond to comments, and more. 
A few of the best social media management tools include: 
 Buffer: A paid tool, Buffer can help you manage social accounts, establish a posting 

schedule, schedule social media posts, and more. Plus, it’s available as a mobile app to 
make social media management hassle-free. 

 Hootsuite: Another paid social media management tool, Hootsuite helps you manage 
all your social media platforms, reply to user questions and comments across 
channels, and monitor your social media strategy’s performance via analytics. 

 CoSchedule: A paid tool, CoSchedule focuses on more than managing your social 
media. Schedule your social media posts, as well as build content calendars, publish 
blog posts, and more. 

For more help finding the perfect toolkit, check out: 
 6 Best Social Media Tools for Scheduling 
 4 Best Social Media Tools for Management 
 7 Best Social Media Tools for Monitoring 
 4 Best Social Media Tools for Automation 
 
 
Is a Career in Social Media Marketing for You? 
As an increasing number of businesses discover the benefits of social media marketing, 
there’s a corresponding need for social media experts. Fortunately, for those who are 
interested in this field, the necessary skills are easily attainable as it just takes a 
willingness to learn and succeed.  

https://www.statista.com/statistics/463353/pinterest-global-mau/
https://www.webfx.com/blog/social-media/why-your-marketing-team-needs-to-use-pinterest-infographic/
https://www.pewresearch.org/internet/fact-sheet/social-media/
https://blog.hootsuite.com/pinterest-statistics-for-business/
https://www.webfx.com/social-media/services/
https://www.webfx.com/blog/general/4-social-management-tools-to-increase-productivity/
https://buffer.com/
https://www.hootsuite.com/
https://coschedule.com/
https://www.webfx.com/blog/social-media/social-media-scheduling-tools/
https://www.webfx.com/blog/general/4-social-management-tools-to-increase-productivity/
https://www.webfx.com/blog/general/the-only-7-social-media-monitoring-tools-youll-ever-need/
https://www.webfx.com/blog/social-media/social-media-automation/
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Social media marketing as a career field was virtually unheard of a decade ago. Now, 
however, it’s an established, growing field with a positive outlook for the foreseeable 
future. 
But don't feel like you need to be an expert to start your career in social media 
marketing. If you know how to communicate, tell compelling stories, and enjoy analyzing 
trends, you might be a perfect fit as a professional in this industry. What’s more, it helps 
if you have the drive to continue learning as social media is evolving and needs 
professionals who can keep up. 

Lesson 5: How to Get Started in Social Media Marketing? 
Social media is undoubtedly an exciting and ever-changing industry. Psychology is as 
much a part of the job as creativity and data—it utilizes both the right and left sides of 
the brain, and each day brings about new challenges. There are a couple of things you 
can do right away to prepare yourself for a career in social media marketing, helping 
transform you into an industry-ready marketer. 
Play in the Sandbox 
The first thing to do when considering a career in social media marketing is to get your 
feet wet in the social media world. Start building your presence on major platforms like 
Facebook, Twitter, YouTube, and Instagram. Also, follow other thought leaders in the 
industry. See what type of plans they’re working on and get a better understanding of 
the benefits of social media marketing from their standpoint. 
 

Digital Marketing - Social Media 
Social media today is essentially word-of-mouth marketing. Getting people to connect 
with you online in the social arena helps spread the word about what your company is 
and what are your products and services. 

Lesson 6: SEO and Social Media 
For many teams, there are different sets of people who work on SEO and social media 
separately; however, this scenario is changing lately. 

 The two may still officially belong to separate teams, but social media marketers 
will need to be more informed on the SEO strategist’s agenda, so that the SEO 
strategy can go hand-in-hand with content promotion. 

 SEO strategists too need to know how to work with social media marketers in order 
to receive the social signals it needs to make sure their company ranks high in 
search. 
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There are two functions of social media for business − 

 Are you participating in the conversation and sharing? 
 Are you listening and monitoring what is being said about you? 

Start Social Media Marketing 
If you’re starting from scratch with your social media strategy, here are the basic steps to 
get you started − 

 Step 1 − Choose your social networks 
 Step 2 − Fill your profiles completely, remembering to load in your keywords 
 Step 3 − Find your voice and tone 
 Step 4 − Pick your posting strategy - how often, when, and what type of content 
 Step 5 − Analyze and test 
 Step 6 − Automate and engage 

Although we’ll be getting into the specifics in the latter half of the tutorial, here are a few 
things to consider in your general social media strategy. 
Facebook tops the list of social media strategy 
For many, social media starts with Facebook. Just having a page, however, does not 
suffice. Sophisticated content marketing is now the way to foster engagement on 
Facebook. If your business doesn’t have a content marketing strategy or a blog, but wants 
to maintain a strong Facebook presence, it may be time to create a content marketing 
strategy for Facebook. We’ll get to know more on this in a subsequent chapter. 
Optimize for mobile 
All social media efforts need to be optimized for mobile. You’ve probably heard, but 
everyone needs to make sure their websites are optimized for mobile. Social media 
managers need to be aware of this to ensure that the format of any promotions they do 
(especially those that include driving people to their company websites) are optimized for 
mobile. Any images used on social media should also be viewable on mobile for optimized 
user experience. 

Lesson 7: Emphasize on human experience 

It may be digital, but you need to consider the “human experience.” Google and Facebook 
have made changes to their platforms to push businesses to focus more on the “human 
experience.” For social media marketers, your social media posts need to be more 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1157 | 1352  

relevant, provide more value to your audience, and the engagement needs to be more 
“human.” 
What does social media management include? 
Generally, social media management focuses on the following: 

 Auditing your existing social media strategy 
 Researching your target audience 
 Choosing your social media platforms 
 Creating your social media strategy 
 Designing your social media profiles 
 Developing your social media ads 
 Building your social media content calendar 
 Creating platform-specific social media content 
 Responding to your social media followers 
 Growing your social reach 
 Monitoring your social media performance 
 Keep reading to learn more about these social media management practices for 

businesses! 
 
How to get started with social media management for businesses 
You know the definition of social media management and what social media 
management for businesses typically focuses on — now, learn how to bring those 
practices to life in your social media campaigns with this breakdown of the 11 most 
critical processes: 
 
1. Auditing your existing social media strategy 
Are you already marketing and advertising your business on social media? Then, you’ll 
want to set aside some time to audit your existing strategy. With a social media audit, you 
look at what’s working and what isn’t within your social media campaigns. 
Typical steps within a social media audit include: 

 Reviewing your social media goals 
 Ensuring your branding across social media networks matches 
 Compiling your social media metrics, like followers, engagement rate, and more 
 Analyzing your social media metrics to find trends, like content preferences 
 Reviewing your competitor’s social media presence 
 And more 

Your audit will provide immediate insight into your social media strategy. Plus, it’ll offer a 
foundation for improving your campaigns so you can achieve the results your business 
wants to see from social media, from more followers to better client satisfaction. 
If you partner with a social media manager, they’ll take care of this step for you. 
2. Researching your target audience 
Investigating your audience is a core part of social media management. If your agency — 
or your company — doesn’t know who your audience is, it makes developing a social 
media strategy challenging. 
Know who your audience is, and you’ll know where to find them online. 

https://www.webfx.com/blog/social-media/how-to-perform-a-social-media-audit/
https://www.webfx.com/blog/social-media/social-media-metrics/
https://www.webfx.com/blog/marketing/rethinking-demographics/
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That’s critical, as you want to maximize your investment in social media management. By 
targeting your audience on their preferred platform, you can earn a bigger return on 
investment (ROI). 

 
As an example, imagine social media marketing for dentists. While one dentist provides 
pediatric care, another offers implant services. They each operate in the health and 
medical sector, but they have completely different audiences. 
When their social media management services include audience research, these practices 
ensure they invest their marketing budget and ad spend creating content and 
advertisements that target the right users, versus anyone that needs dental care. 
Invest in social media management services, and you can expect your account manager to 
ask about your target audience at the start. In some cases, an agency may take the 
initiative to ask about your target audience when you call to discuss their services. 
3. Choosing your social media platforms 
Next, you’ll decide which social media platforms to use. Time is one of the most valuable 
resources when it comes to social media management for businesses, so it’s essential to 
focus your efforts on the networks that matter most to your audience. 
While you should have a profile on the top social media networks, like Facebook, Twitter, 
and LinkedIn, you shouldn’t divide your time between them evenly. Instead, prioritize 
social media platforms by how much your audience uses them. 
You can find which networks matter most to your target market by reviewing 
demographic data. If you conducted a social media audit, you could also reference your 
engagement rates to see which networks performed best. Check competitor activity, too. 
If you use social media management services, don’t worry. Your account manager will 
provide platform recommendations based on their research of your industry, audience, 
and goals. 
4. Creating your social media strategy 
Before your account manager (or your internal team) can launch your social media 
campaign, they need to develop your strategy. In most cases, they’ll focus on building a 
strategy for each platform due to the different roles and uses of Twitter, LinkedIn, 
Facebook, and other social media platforms. 
In addition to considering your audience, they’ll also look at the following factors: 

https://www.webfx.com/social-media/learn/social-media-roi/
https://www.webfx.com/social-media/learn/social-media-roi/
https://www.webfx.com/industries/health/dentist/social-media/
https://www.webfx.com/social-media/glossary/what-is-social-media-management/#social-media-management-networks
https://www.webfx.com/social-media/glossary/what-is-social-media-management/#social-media-management-networks
https://www.webfx.com/blog/social-media/how-to-create-a-social-media-marketing-plan/
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 Your goals: What does your business want to accomplish with social media? Do you 
want to build more brand awareness among consumers or establish brand loyalty 
among existing clients? Or, is there another goal you want to accomplish? 

 Your industry: What do audiences in your industry want to know? Are there content 
gaps that your company can fill, such as with blog posts or guides that you can then 
share on social media? Or, are there industry leaders you can connect with on 
different platforms? 

 Your brand: What is your brand voice? Do you have a set of standards or processes 
when engaging with clients in a public forum? Or, how does your branding influence 
the colors and media that you use? 

Some of these questions, such as your branding standards and goals, will require your 
direct input. At WebFX, we’re always curious to learn about your company — it’s that 
curiosity that lets us create powerful and personalized social media strategies. 
5. Designing your social media profiles 
When you create or update your social media profiles, making sure they fit with your 
brand is essential. 

 
That’s why social media management services can also include social media design. This 
service focuses on creating professional images that capture your brand and make a great 
first impression on users. 
In most cases, social media design will focus on your account’s static images, such as the 
following: 
 Your Twitter header and background 
 Your Facebook header, icon, and profile picture 
 Your Instagram profile picture 

Once they’ve designed your social media accounts — and you’ve approved of the designs 
— your social media specialist can start working towards your marketing goals, such 
as increasing post engagement or driving conversions. 
6. Developing your social media ads 
Depending on your business’ goals and service plan, your social media manager may 
develop an advertising strategy for your company. If you want to earn more genuine 
followers, as well as encourage user engagement, social media ads are essential. 
Platforms, from Snapchat to Facebook, vary in their approach to ads. They feature 
different ad types, as well as different goals. Facebook, for example, offers the option to 

https://www.webfx.com/blog/seo/components-of-high-quality-blog-posts/
https://www.webfx.com/social-media/services/design/
https://www.webfx.com/blog/social-media/how-to-engage-users-on-social-media/
https://www.webfx.com/blog/social-media/driving-sales-with-social-media-how-to-use-social-media-to-transform-fans-into-dollars/
https://www.webfx.com/blog/social-media/snapchat-for-businesses/
https://www.webfx.com/social-media/learn/facebook-ad-specifications/
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create ads for increasing brand awareness, generating leads, earning store visits, and 
more. 
Some other ad features that your social media manager will look at include: 

 Audience 
 Media 
 Content 
 Calls-to-action (CTA) 
 Cost-per-click (CPC) 
 And more 

These are all critical factors that influence the success of your advertisements. You may 
create an ad with a compelling CTA, but if you target it to the wrong audience, you won’t 
see the results you expected. 
Before launching an ad campaign, you should have the chance to review and sign off on 
your ads. 
7. Building your social media content calendar 
Another deliverable included in most social media management services is a content 
calendar for each of your social media accounts. This calendar serves as a reference point 
for you and your professional social media management team. 
In your content calendar, which will include the current month, you can view scheduled 
posts for your social media accounts. These posts may include company announcements 
and holiday tidings, as well as shared content, such as a blog post from your website or an 
image from a client. 
Before publishing these posts, your social media manager will likely request that you 
review and approve all the content. While this requires some effort on your part, it 
guarantees that the only content that goes live is the content you want. 
8. Creating platform-specific content 
A social media specialist does more than build a content calendar for your company — 
they also create the content in it. In some cases, they may oversee every aspect of 
content creation, from developing the topic to writing the copy to selecting the media. 

 
To create the best possible content, however, many social media specialists will work with 
graphic designers and copywriters. The result is a piece of content that resonates with 
users and accomplishes your company’s goals. 

https://www.webfx.com/blog/marketing/5-ways-create-best-possible-calls-action/
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If your calendar includes content from a third party — maybe you’re sharing an 
influencer’s blog post that mentions your product — your social media manager will 
ensure they have the appropriate link and caption to share on your social media accounts. 
9. Responding to your social media followers 
A day-to-day responsibility included with many social media management services is 
interacting with your followers and commenters. For many businesses, this service is 
invaluable as it has a direct impact on brand awareness and brand loyalty. 

 
As a part of this service, your social media manager will adhere to your brand and 
company standards when engaging with your followers. They’ll also respond to users that 
leave negative comments, such as about a bad experience. 
For social media users, your company’s interaction with them demonstrates that you care. 
In many industries, that will set your business apart from your competitors. It can even 
become a selling point for consumers, especially since more than 65% of people use social 
media for customer service. 
10. Growing your social reach 
Ads are not the only way that your social media specialist will increase your followers and 
social media presence. As a part of your social media management services, your provider 
may reach out to influencers and trusted organizations in your industry. 
That can lead to coverage of your company by those individuals, which can connect you 
with their followers. The result is more exposure for your brand, as well as the chance to 
earn more followers and clients. 
 

https://www.webfx.com/industries/industrial/manufacturing/social-media/
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If you sell kitchen cabinets, for example, an influencer could highlight your product as a 
purchase for their renovated kitchen. They’ll create a post highlighting the experience on 
their social media account, which you can then share to yours. 
It’s a chance for you, as well as another organization, to gain coverage. 
11. Monitoring your social media performance 
A critical part of social media management is monitoring the performance of your efforts. 
That’s why your team of social media specialists will track the performance of your ads, as 
well as creative content, and share those results with you. 
With MarketingCloudFX from WebFX, we make sure you can see the performance, as well 
as the returns of your investment. This proprietary application, which IBM’s artificial 
intelligence software powers, also offers numerous other useful tools for your digital 
marketing efforts outside of social media. 
When you invest in social media management services — or any digital marketing service 
— it’s essential that you partner with an agency that not only monitors the performance 
of your social media accounts but also reacts when that performance drops. 
You want a partner that develops an action plan for improving low performance too — 
not someone that excuses it. Adopt this mindset, and you’ll find the best agency for your 
business. That kind of partnership leads to better results and a better ROI. 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.webfx.com/marketingcloudfx/
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Module 10: Online Research and Market 
Research 

 

What is market research? 
Market research is the process of gathering information about your business's buyers 
personas, target audience, and customers to determine how viable and successful your 
product or service would be, and/or is, among these people. 

What is Online Market Research? 
Online Market Research is a research method in which the data collection process is 
carried out over the Internet. 
Online Market Research can be either Qualitative or Quantitative.  Qualitative Online Tools 
include Video Ethnography and Market Research Online Communities (MROCs).  
Quantitative Online Methods include mobile and app surveys. 
This research can evaluate the performance of a product or service and may allow 
companies to glean insight into consumer purchasing behavior. With the rising use of the 
Internet, online research has become a popular tool among market research firms. 
Online research can provide additional information about a buyer, such as her prior 
purchasing history. Online research projects can be carried out by a company itself or by a 
hired research firm. 
 

Why do market research? What is the Purpose of Online Market Research? 
Market research allows you to meet your buyer where they are. As our world (both digital 
and analog) becomes louder and demands more and more of our attention, this proves 
invaluable. By understanding your buyer's problems, pain points, and desired solutions, 
you can aptly craft your product or service to naturally appeal to them. 
Market research also provides insight into a wide variety of things that impact your bottom 
line including: 

 Where your target audience and current customers conduct their product or service 
research 

 Which of your competitors your target audience looks to for information, options, or 
purchases 

 What's trending in your industry and in the eyes of your buyer 
 Who makes up your market and what their challenges are 
 What influences purchases and conversions among your target audience  

 
Conducting proper online market research requires time and money. But investing those 
resources into ecommerce research makes sense for the following reasons:  
 
1. Get a deeper understanding of your target audience. 
Knowing your target audience is critical for coming up with new product ideas, 
developing a winning marketing strategy and creating copy that converts. 
Ecommerce personas also help ensure that you are speaking directly to the customer’s 
needs and satisfy all of their expectations.  
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Keep in mind that while knowing the demographics of your target market is important, 
it’s not enough in and of itself.  
In addition to knowing who your target customers are, you should also understand what 
they think, feel and value. 
Online market research, especially qualitative research, can help you delve into the 
internal motivators that prompt a purchase.  
2. Learn customer behaviors.  
Understanding how your target customers shop online can help you improve the usability 
of your website and provide a better customer experience. Every point of friction in the 
buyer’s journey reduces customer satisfaction and increases the likelihood of cart 
abandonment, lost up-sale or missed retention opportunity.  
 
Online market research can help you identify those points of friction and common deal-
breakers. Then, use this know-how to simplify navigation, facilitate product discovery 
and improve conversion rates.  
3. Find new business opportunities.  
Lots of ecommerce business opportunities are out there that can make your company 
more successful: 

 New product development  

 Cross-border sales 

 Subscription offerings 

 Or new business models  
Doing online business research and looking at the market data can help you uncover 
those opportunities that lie hidden in plain sight. 
As you begin honing in on your market research, you'll likely hear about primary and 
secondary market research. The easiest way to think about primary and secondary 
research is to envision to umbrellas sitting beneath market research: one for primary 
market research and one for secondary market research. 
Beneath these two umbrellas sits a number of different types of market research, which 
we'll highlight below. Defining which of the two umbrellas your market research fits 
beneath isn't necessarily crucial, although some marketers prefer to make the 
distinction. 
So, in case you encounter a marketer who wants to define your types of market research 
as primary or secondary — or if you're one of them — let's cover the definitions of the 
two categories next.  

2 Types of Market Research 
Primary vs. Secondary Research 
There are two main types of market research that your business can conduct to collect 
actionable information on your products including primary research and secondary 
research. 
Primary Research 
Primary research is the pursuit of first-hand information about your market and the 
customers within your market. It's useful when segmenting your market and establishing 
your buyer personas. 
Primary research is data collection, done by you, using your internal resources. 
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Here are a few examples: 

 Online surveys and questionnaires. 

 In-person, in-depth interviews. 

 Online focus groups.  
In other words, with primary research, you are the one doing the data collection, then 
analyzing that data to extract actionable business insights. 
Primary market research tends to fall into one of two buckets: exploratory and specific 
research. 
Exploratory Primary Research 
This kind of primary market research is less concerned with measurable customer trends 
and more about potential problems that would be worth tackling as a team. It normally 
takes place as a first step — before any specific research has been performed — and may 
involve open-ended interviews or surveys with small numbers of people. 
Specific Primary Research 
Specific primary market research often follows exploratory research and is used to dive 
into issues or opportunities the business has already identified as important. In specific 
research, the business can take a smaller or more precise segment of their audience and 
ask questions aimed at solving a suspected problem. 
Secondary Research 
Secondary research is all the data and public records you have at your disposal to draw 
conclusions from(e.g. trend reports, market statistics, industry content, and sales data 
you already have on your business). Secondary research is particularly useful for 
analyzing your competitors.  
Secondary research is using data and insights, produced by someone else. 
Here are a few examples: 

 Government statistics: For example, if you are in the healthcare industry, then 
the National Center for Health Statistics can be a valuable source of data. 

 Industry statistics: Statista is a great website for learning more about a particular 
market. The Big-4 accounting firms also conduct a ton of original industry 
research.  

 Industry reports: For example, HubSpot publishes an annual “State of Marketing 
Report” in which they share their online marketing research and provide an 
overview of the latest industry trends. 

The main buckets your secondary market research will fall into include: 
Public Sources 
These sources are your first and most-accessible layer of material when conducting 
secondary market research. They're often free to find and review — lots of bang for your 
buck here. 
Government statistics are one of the most common types of public sources according to 
Entrepreneur. Two U.S. examples of public market data are the U.S. Census Bureau and 
the Bureau of Labor & Statistics, both of which offer helpful information on the state of 
various industries nationwide. 
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Commercial Sources 
These sources often come in the form of market reports, consisting of industry insight 
compiled by a research agency like Pew, Gartner, or Forrester. Because this info is so 
portable and distributable, it typically costs money to download and obtain. 
Internal Sources 
Internal sources deserve more credit for supporting market research than they generally 
get. Why? This is the market data your organization already has! 
Average revenue per sale, customer retention rates, and other historical data on the 
health of old and new accounts can all help you draw conclusions on what your buyers 
might want right now. 
Now that we've covered these overarching market research categories, let's get more 
specific and look at the various types of market research you might choose to conduct. 

Types of Market Research 
1. Interviews 
2. Focus Groups 
3. Product/ Service Use Research 
4. Qualitative research 
5. Quantitative research 
6. Observation-Based Research 
7. Buyer Persona Research 
8. Market Segmentation Research 
9. Pricing Research 
10. Competitive Analysis Research 
11. Customer Satisfaction and Loyalty Research 
12. Brand Awareness Research 
13. Campaign Research 

1. Interviews 
Interviews allow for face-to-face discussions (in-person and virtual) so you can allow for a 
natural flow or conversation and watch your interviewee's body language while doing so.  
2. Focus Groups 
Focus groups provide you with a handful of carefully-selected people that you can have 
test out your product, watch a demo, provide feedback, and/or answer specific 
questions. 
How It Works 
A focus group usually consists of 5-12 individuals who all possess certain characteristics 
pertaining to the topic of the group. A moderator or interviewer facilitates the discussion 
and creates an environment that promotes the communication of different perceptions 
and points of view. They usually last for about one to two hours, during which group 
members are usually asked five or six questions. 
 
The discussion is then carefully analyzed to provide insights as to how a product, service, 
or opportunity might be perceived by the group. The qualitative data is used to develop 
products, services, or opportunities that will meet customer requirementsDemand 
CurveThe demand curve is a line graph utilized in economics, that shows how many units 
of a good or service will be purchased at various prices. 
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 Types of Focus Groups 
 1. Two-Way 
One group watches another group answer the questions posed by the moderator. By 
listening to what the other group thinks and says, the group that listens is able to 
facilitate more discussion and potentially draw different conclusions. 
2. Dual-Moderator 
Two moderators are present – one which ensures the group session progresses smoothly 
and one that makes sure that the topics in question are all covered. Dual-moderator 
focus groups typically result in a more productive session. 
3. Dueling-Moderator 
There are two moderators who play devil’s advocate. The purpose of the dueling-
moderator focus group is to facilitate new ideas by introducing new ways of thinking and 
varying viewpoints. 
4. Respondent-Moderator 
One or more of the participants in the group takes the lead as moderator. This is done to 
change the dynamics of the group and generate more varied responses. 
5. Mini Focus Group 
A focus group that consists of fewer participants – usually four or five – which creates a 
more intimate group. 
6. Online Focus Group 
Participants respond and share information through online means. Online focus groups 
are created to reach a broader range of participants. 
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Advantages of a Focus Group 

 Focus groups are a cheaper means of obtaining information, as compared to 
individual interviews. 

 Participants are able to listen to the responses of other participants and “feed off 
each other.” 

 The groups generally result in more data being gathered, as participants are given 
the opportunity to rebut each other. 

 Compared to a quantitative survey, these groups are able to gather more 
information about perceptions, attitudes, and experiences. 

 Disadvantages of a Focus Group 

 Group dynamics, such as group is a term developed by social psychologist Irving 
Janis in 1972 to describe faulty decisions made by a group due to group pressures. 
Groupthink is a phenomenon in which the ways of approaching problems or 
matters are dealt by the consensus of a group rather than by individuals acting 
independently. may inhibit discussion. 

 The group may be difficult to manage and control, due to the number of 
participants. 

 Shy participants or introverts may feel overpowered and intimidated by assertive 
participants. This can introduce bias and affect the end result. 

 Analysis of data may be time-consuming and challenging. 

 The group culture may intimidate or fail to energize participants, resulting in 
weaker data collection. 

3. Product/Service Use Research 
Product or service use research offers insight into how and why your audience uses your 
product or service, and specific features of that item. This type of market research also 
gives you an idea of the product or service's usability for your target audience.  
This research will help you answer several questions: 

 What do customers need? 
 Which customer needs aren’t currently being met? 
 How do we improve the existing product or introduce a new product? 
 What type of customer will be interested in a new or modified product? 
 Are people aware of the products currently available in the market? 
 Are people satisfied with existing products? 

 
Qualitative research 
Qualitative market research is the collection of primary or secondary data that is non-
numerical in nature, and therefore hard to measure. 
Qualitative research collects and analyzes unstructured data through techniques which 
include observations, interviews, and focus groups. Qualitative research enables 
researchers to develop research hypotheses and uncover context-rich insights for a wide 
variety of different concepts. 
Research methods that would gather qualitative data include: 

 Interviews (face to face / telephone) 

 Focus groups 

 Open-ended survey questions 
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Strengths and Weaknesses of Qualitative Research 
Qualitative methodologies have certain strengths and weaknesses that researchers 
should consider when designing their market research strategy. The strengths of 
qualitative research include: 
Nuance: Qualitative techniques enable researchers to understand complex ideas and 
concepts in great detail and offer a window into the decision making process of research 
participants. 
Cost Effectiveness: Researchers typically conduct qualitative research with a small 
number of participants, meaning that many types of qualitative research can be relatively 
affordable to conduct. 
Flexibility: Techniques are flexible and, when new concepts or ideas emerge, it’s 
straightforward for researchers to adapt their approach and explore new topics without 
redesigning the whole market research process.  
There are also some limitations to qualitative research, which is why it’s important that 
qualitative techniques are not the only ones used in the research process. These include: 
 
Labor Intensive: Designing and administering qualitative research can be time-
consuming. Researchers need to find appropriate participants, design the research 
agenda, and determine the best way to interpret responses. 
Difficult to Analyze Data: Qualitative research does not produce numerical results, 
meaning that analysis of the results can be subjective. Sometimes, market researchers 
may come away with entirely different conclusions from the same focus group or set of 
interviews. 
Challenging to Control for Variables: Because research is conducted with few 
participants, it can be difficult to control for variables and ensure that the sample is 
representative. One example: focus groups can easily be derailed by a particularly 
vociferous participant. 
Researchers collect this market research type because it can add more depth to the data. 
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This kind of market research is used to summarise and infer, rather than pin-points an 
exact truth held by a target market. For example, qualitative market research can be 
done to find out a new target market’s reaction to a new product to translate the 
reaction into a clear explanation for the company. 
 
 
 

Quantitative research 
Quantitative Market Research is a technique to ask questions to the target audience in an 
organized manner using surveys, polls or questionnaires. Received responses can be 
analyzed to make well-thought decisions for improving products and services, that will in 
turn help increase respondent satisfaction levels. Well-founded results can be achieved 
in case a large sample size that represents a population is surveyed. 
The age of Information has transformed both selling as well as purchasing habits and 
norms. “Information” or “data” is now more valuable than gold. Companies rise and fall 
on the basis of how well they are able to collect and analyze data and make informed 
decisions based on the gathered insights. 
 
Any evolved customer who makes a purchase online can tell how quickly businesses have 
become “customer-centric”. And the first step towards becoming a customer-centric 
business is through customer feedback and research. 
Quantitative research methods include: 

 Polls 

 Questionnaires 

 Surveys 
 

 
 
Reasons to conduct Quantitative Market Research 
Research is the first step for a successful marketing campaign, be it a new product 
launch, sales pitch positioning or conducting a data-oriented statistical analysis. 
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By conducting an online quantitative market research, insights about marketing activities 
like updating the website, social media page management or newsletters can also be 
received. 
By implementing Quantitative Market Research, questions like “Who are currently buying 
my products/services?”, “Why are the others not buying my product?”, “How to reach 
out to my potential clientele?” are answered. 
Quantitative research starts with survey creation, designing, and distribution. After the 
survey is sent out to the right people, data collection and analysis has to be done to get 
desired insights.   
Steps of quantitative market research 
Significance of Quantitative Market Research 
As the name implies, Quantitative market research focuses on the quantity and 
structured collection of data. It began with face-to-face techniques and now has evolved 
into online surveys like those provided by QuestionPro. It is often used to capture data 
like customer behavior, size of the market, identifying reasons for product repurchase. 
This type of market research is usually based on a large number of samples. 
 
Characteristics of Quantitative Market Research 
The basic characteristics of quantitative market research are: 

 The premise that quantitative market research operates on is to confirm the 
hypothesis of the phenomena of how many. 

 The data collected is solely in the form of numbers and statistical formula can be 
applied to this data to come up quantified actionable insights. 

 Data collected and the mode of collection is very structured. It is a mix of 
questionnaires, surveys etc. 

 The research study is designed in a way that the questions are structured and the 
possible responses to these questions are also structured. This is laid out well in 
advance before the study. 

 Since the questions are not open ended, they point towards certain answers so 
the scope for uncertainty is limited. 

What is the methodology for creating a successful quantitative market research survey? 
Quantitative market research is a highly scientific method of market research. It uses 
deductive reasoning to come to a conclusion and create actionable insights from the data 
collected. This research method works on the principle of developing a hypothesis, 
collecting data and then analyzing that data to further prove or disprove the hypothesis. 
The milestone based procedure of the quantitative design is: 
Make an observation of something that is unknown to you. Investigate the theory that is 
related to your issue or the field that requires validation. 
Create an in-depth hypothesis to validate your research and findings and end objective. 
Plan for how to prove or disprove this hypothesis and create a structure to achieve this 
objective. 
Collect and analyze your data. If your data validates your hypothesis, prepare for final 
validations and to present findings. If the data disproves your hypothesis, you can either 
start afresh with a new hypothesis or drop your current research. 
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The milestones mentioned above fall under 5 quantitative design types namely; survey 
research, descriptive research, correlational research, causal-comparative/quasi-
experimental research and experimental research. 
 
What are the common techniques to conduct a quantitative market research? 
Quantitative market research can be conducted by primary and secondary research 
types. Some of the Some of the most common ways to conduct a quantitative market 
research are: 
Primary quantitative market research techniques 
Primary techniques are the most common forms of conducting quantitative market 
research. Some of the most common and widely used forms are: 
 
Surveys: Traditionally, surveys were conducted using paper-based methods and have 
gradually evolved into online mediums. Closed-ended questions form a major part of 
these surveys as they are more effective in collecting quantitative data. The survey 
makes include answer options which they think are the most appropriate for a particular 
question. Surveys are integral in collecting feedback from an audience which is larger 
than the conventional size. A critical factor about surveys is that the responses collected 
should be such that they can be generalized to the entire population without significant 
discrepancies. Quantitative market research is conducted under two broad buckets of 
the frequency they are administered at: 
Cross-sectional research survey: Cross-sectional market research is a quantitative market 
research method that analyzes data of variables collected at one given point of time 
across a sample population. population or a pre-defined subset. This research method 
has people who are similar in all demographics but the one that is under research. 
Longitudinal research survey: Longitudinal market research is a quantitative market 
research method where research is conducted over years or decades on a target 
demographic markets or certain individuals to collect statistical data.  
 One-on-one Interviews: This quantitative data collection method was also traditionally 
conducted face-to-face but has shifted to telephonic and online platforms. Interviews 
offer a marketer the opportunity to gather extensive data from the participants. 
Quantitative interviews are immensely structured and play a key role in collecting 
information. There are two major sections of these online interviews: 
Face-to-Face Interviews: An interviewer can prepare a list of important questions in 
addition to the already asked survey questions. This way, interviewees provide 
exhaustive details about the topic under discussion. An interviewer can manage to bond 
with the interviewee on a personal level which will help him/her to collect more details 
about the topic due to which the responses also improve. Interviewers can also ask for an 
explanation from the interviewees about unclear answers. 
Online/Telephonic Interviews: Telephone-based interviews are no more a novelty but 
these quantitative interviews have also moved to online mediums such as Skype or 
Zoom. Irrespective of the distance between the interviewer and the interviewee and 
their corresponding time zones, communication becomes one-click away with online 
interviews. In case of telephone interviews, the interview is merely a phone call away. 
Computer Assisted Personal Interview: This is a one-on-one interview technique where 
the interviewer enters all the collected data directly into a laptop or any other similar 
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device. The processing time is reduced and also the interviewers don’t have to carry 
physical questionnaires and merely enter the answers in the laptop. 
Secondary quantitative market research techniques 
Secondary techniques to conduct quantitative market research are a means to validating 
a hypothesis or drawing conclusions from empirical data and primary data. This research 
method is a form of observational market research where historical data helps validate 
the statistical observations of the primary data. For example: mapping the purchase of 
snowblowers to the months where sales spike with historical data of inclement weather 
helps manage supply and demand as well as trained personnel during those months. 

 
5 steps needed for creating a successful quantitative market research survey: 

a. Specify the Goal: Why do you want to conduct this market research? There should 
be a clear answer to this question so that the steps that follow are smoothly 
executed. 

b. Have a Plan Sketched Out: Every step that needs to be achieved has to be put to 
paper like the tools that are required to carry out the research, survey templates, 
the target audience etc. This may vary from project to project. 

c. Collect Data: This is the most crucial step in this market research. Data is collected 
through 3 main mediums: online surveys, telephone interviews or email surveys. 

d. Analysis of Collected Data: Once the data is gathered, it needs to be analyzed. 
Various methods of analysis like SWOT Analysis, Conjoint Analysis, TURF Analysis 
can be carried out to get best results.Quantitative Market Research Analysis 

e. Compile Reports: A report consisting of graphs, charts, and tables should be 
created so that the person in-charge of the report can incorporate the observed 
changes.   
 

Observation-Based Research 
Observation-based research allows you to sit back and watch the ways in which your 
target audience members go about using your product or service, what works well in 
terms of UX, what roadblocks they hit, and which aspects of it could be easier for them to 
use and apply.  
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Depending on the type of observation research and the goal of the study, the market 
researcher will have varying levels of participation in the study. Sometimes the 
researcher will insert themselves into the environment, and other times, the researcher 
will not intervene in the setting and observe from a distance or in a laboratory setting. 
 
The purpose of this type of research is to gather more reliable insights. In other words, 
researchers can capture data on what participants do as opposed to what they say they 
do. 
When should a market researcher use observational research? 
As a market researcher, you have several different research methodologies at your 
disposal, including surveys, interviews, observations, etc. 
Using observational data is best when one of the following situations apply: 

 You need to gather sensitive information, and you don’t trust your participants 
will be honest with their self-reporting. 

 You need to understand the how or what of a research question. 
 The topic is new, and you need robust data to explain consumer behavior. 
 When behavior in a natural setting is vital to your research question. 
 When behavior in a controlled setting is critical to your research question. 
 If you are concerned that self-reported data about behaviors will differ from 

actual actions, even if it’s unintentional. 
 When you need more information about a specific research question to formulate 

a more complete and accurate survey. 
If any of these situations describe you or your current research state, then an 
observational study may be just what you need. 
What are the three types of observational research? 
When it comes to observational research, you have three different types of 
methodologies: controlled observations, naturalistic observations, and participant 
observations. 
Let’s quickly look at what each type of observation includes, how they differ, and the 
strengths and weaknesses of each type of observation. 
1. Controlled observation 

Controlled observations are typically a structured observation that takes place in a psych 
lab. The researcher has a question in mind and controls many of the variables, including 
participants, observation location, time of the study, circumstances surrounding the 
research, and more. 
During this type of study, the researcher will often create codes that represent different 
types of behaviors. That way, instead of writing a detailed report, they can classify 
behavior into different categories and analyze the data with more ease. 
Advantages and limitations of controlled observation 

The advantages of controlled observation include: 
 You can make an observation schedule for your sampling, and have other market 

researchers use the same codes if they replicate the study. This helps test for 
reliability. 

 The coded data is easy to analyze and quantify. 
 Controlled studies aren’t as time-consuming. 

Limitations of a controlled observation include: 
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 It may be challenging to determine the validity of the study if participants know 
they are being watched. 

2. Naturalistic observation 

Naturalistic observation is another type of observation research method used by market 
researchers. This type of observation is when market researchers study the behaviors of 
participants in a natural surrounding. There are typically no predetermined behavioral 
codes. Instead, the researcher will take rigorous notes and code the data later. 
Advantages and limitations of naturalistic observation 

Some advantages of naturalistic observation include: 
 The study ensures validity when participants are in their natural setting. 
 This type of study can generate new ideas and research questions. 
 It opens researchers’ minds to possibilities they might not have considered 

before. 
 Researchers can collect authentic data and avoid any potential problems with 

self-reported data. 
Some limitations include: 

 You can’t control different variables, making it difficult to replicate the study and 
test for reliability. 

 It may be challenging to conduct this type of study on a wide scale. 
 You have to use skilled researchers, so you don’t risk missing critical behavioral 

data. 
 You aren’t able to manipulate any variables. 

3. Participant observation 

The last type of observation method is participant observation. This is a type of 
naturalistic observation in the fact that market researchers will observe participants in 
their natural habitat. The difference is market researchers will insert themselves into the 
environment. 
Advantages and limitations of participant observation 

Some advantages of this type of observation include: 
 You can control some of the variables by being part of the natural environment. 
 You can still observe participants in their natural habitat, even if they know you 

are part of the study. 
 You can avoid incorrect self-reported data through this method of observation as 

well. 
Here are some limitations to this type of study to consider: 

 It can be challenging to take notes openly without blowing your cover as the 
market researcher. 

 If you can’t take notes openly, you’ll have to rely on memory for note-taking, and 
memory can be faulty. 

 If a researcher becomes too involved in the study, they could become less 
objective. This could threaten the validity of the study. 

Each type of study will help you gather insight into how customers and participants 
behave, but they also come with their own set of limitations. 
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 Buyer Persona Research 
Buyer persona research gives you a realistic look at who makes up your target audience, 
what their challenges are, why they want your product or service, what they need from 
your business and brand, and more.  
 Market Segmentation Research 
Market segmentation research allows you to categorize your target audience into 
different groups (or segments) based on specific and defining characteristics — this way, 
you can determine effective ways to meet their needs, understand their pain points and 
expectations, learn about their goals, and more.  
It provides valuable data on customer demographics, needs, values, attitudes, and 
behaviors. As you better define target groups, you’re able to further develop your 
marketing strategy. “You can then tailor your message and positioning for the different 
segments you’ve identified.” 
Pricing Research 
Pricing research gives you an idea of what similar products or services in your market sell 
for, what your target audience expects to pay — and is willing to pay — for whatever it is 
you sell, and what's a fair price for you to list your product or service at. All of this 
information will help you define your pricing strategy.  
 
Whether you’re deciding on a price for a new product or optimizing the price for an 
existing product, pricing research helps determine the price elasticity of a product based 
on a given customer segment and set of features. 
You can get to know which features and capabilities a customer is willing to pay a 
premium for and which types of customers are more price sensitive. “You can then 
create different pricing plans based on who a customer is (e.g., student or professional), 
and what features you’re including (e.g., unlimited use vs limited use).” 
 
 Competitive Analysis 
Competitive analyses are valuable because they give you a deep understanding of the 
competition in your market and industry. You can learn about what's doing well in your 
industry, what your target audience is already going for in terms of products like yours, 
which of your competitors should you work to keep up with and surpass, and how you 
can clearly separate yourself from the competition.  

1.  Customer Satisfaction and Loyalty Research 
Customer satisfaction and loyalty research give you a look into how you can get current 
customers to return for more business and what will motivate them to do so (e.g. loyalty 
programs, rewards, remarkable customer service). This research will help you discover 
the most-effective ways to promote delight among your customers. 

2.  Brand Awareness Research 
Brand awareness research tells you about what your target audience knows about and 
recognizes from your brand. It tells you about the associations your audience members 
make when they think about your business and what they believe you're all about.   
 Campaign Research 
Campaign research entails looking into your past campaigns and analyzing their success 
among your target audience and current customers. It requires experimentation and 
then a deep dive into what reached and resonated with your audience so you can keep 
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those elements in mind for your future campaigns and hone in on the aspects of what 
you do that matters most to those people.  
Now that you know about the categories and types of market research, let's review how 
you can conduct your market research. 
Here's how to do market research step-by-step. 

How to Do Market Research 
1. Conduct keyword research. 
2. Define your buyer persona. 
3. Identify a persona group to engage. 
4. Prepare research questions for your market research participants. 
5. List your primary competitors. 
6. Summarize your findings. 

 
Conduct keyword research. 

Keyword research can help you figure out whether there’s a demand for the product that 
you want to sell online. 
Even though high search volumes don’t mean the product’s idea is profitable, they do 
indicate genuine interest among consumers.  
Moreover, keyword research is also useful when you are working on your inbound 
marketing strategy since it allows you to pinpoint opportunities for generating organic 
traffic with search engine optimization (SEO). 
Some of the popular free keyword research tools are: 

 Google Keyword Planner. 
 Keyword Tool.  
 Ubersuggest. 

However, a premium tool such as Ahrefs or SEMRush provides business owners with 
deeper level insights.  
While Ahrefs is a sophisticated tool that might take time to master, you can learn how to 
do basic keyword research with it in just 10 minutes. 
Simply watch the “Keyword Research Tutorial: From Start to Finish” video in which Sam 
Oh explains everything you need to know to get started.  
This tutorial is particularly helpful for ecommerce entrepreneurs because Sam uses a new 
ecommerce store that sells computers, computer parts, computer accessories and 
software to show the ropes of research.  
Here’s a quick summary: 

 Generate keyword ideas. Start by typing in a few broad keywords related to your 
business (e.g., “computer”), then go to “Having same terms” report to expand 
your list of ideas. Then filter those keyword ideas down, group them by search 
intent (informational, navigational, commercial, transactional) and evaluate their 
business potential.  

 Analyze Google’s top ten search results. See which websites already rank for the 
target keyword. Pay attention to the content format. Consider using a similar type 
of content, but look for opportunities to improve upon the published posts.  

 Assess how hard it will be to rank on Google for that keyword. Take a look at the 
number of referring domains and the domain ratings for the top ten search 

https://www.bigcommerce.com/blog/ecommerce-seo/
https://ads.google.com/intl/US/home/tools/keyword-planner/
https://keywordtool.io/
https://neilpatel.com/ubersuggest/
https://ahrefs.com/
https://www.semrush.com/
https://www.youtube.com/watch?v=OMJQPqG2Uas
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results. Competing with websites that have a similar domain rating (DR) to yours 
is the best strategy.  

 Analyze topical relevance. See how your website compares to those in the top ten 
search results. Are you in the same industry? Is it a commercial domain? Is it a 
niche publisher, covering the topic exclusively? Doing so will give you more 
insights into the difficulty of ranking for that particular keyword.  

 Reverse-engineer the topics that are driving traffic to your competitors’ 
websites. Go to Ahrefs Site Explorer, enter a competitor’s domain name and go to 
the top pages report. Then look at the traffic, the top keywords and the referring 
domains.  

Sam Oh also emphasizes that keyword research isn’t about search volume alone. Your 
goal is to find topics that potential customers are searching for, create educational 
content around them and soft-pitch your offers. 
 
At the end of the day, traffic quality beats traffic quantity. When you are considering a 
particular keyword, ask yourself whether ranking for it will lead to more sales, not just 
extra traffic. 
 
 
Research current trends.  

When you are doing product research for ecommerce, you should always look into the 
latest consumer trends. Use Google Trends to uncover those. 
Here are the two questions that can help with online product research: 

 Is the interest in this product declining, stable or growing? 

 Is the interest in this product seasonal or does it remain the same all year? 
Simply type in a relevant keyword and pick a time period. 
For example, if you type in “artificial plants” and pick “Past 5 Years” as your timeframe, 
you will see that the interest in this keyword has been stable, with a noticeable increase 
in the last year. 
A moderate but stable level of interest like that may indicate an opportunity for building 
a sustainable, long-lasting business.  
Check your assumption with a quick google search for such businesses. And yes, we have 
Autograph Foliages — a company that has been selling artificial plants for over 40 years!  
Also, when you see an upcoming trend, analyze it from different angles. For example, 
CBD is a promising new market with a diverse range of business opportunities. So rather 
than doing CBD-everything, consider niching down.  
Lab to Beauty, for instance, saw great success with selling CBD-infused beauty products.  
Also, be wary when a trend has a crazy upward trajectory at the moment. Because a real-
time spike in interest might turn out to be a short-lived fad.  
While it’s okay to capitalize on hot trends, you shouldn’t build your entire business 
around them. Make sure that your foundation is stable. 
Define your buyer persona. 

Before you dive into how customers in your industry make buying decisions, you must 
first understand who they are. 
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This is where your buyer personas come in handy. Buyer personas — sometimes referred 
to as marketing personas — are fictional, generalized representations of your ideal 
customers. 
Use a free tool to create a buyer persona that your entire company can use to market, 
sell, and serve better. 
 
They help you visualize your audience, streamline your communications, and inform your 
strategy. Some key characteristics you should be keen on including in your buyer persona 
are: 

 Age 
 Gender 
 Location 
 Job title(s) 
 Job titles 
 Family size 
 Income 
 Major challenges 

The idea is to use your persona as a guideline for  how to effectively reach and learn 
about the real audience members in your industry. Also, you may find that your business 
lends itself to more than one persona — that's fine! You just need to be  thoughtful 
about each specific persona when you're optimizing and planning your content and 
campaigns. 
 Identify a persona group to engage. 

Now that you know who your buyer personas are, use that information to help you 
identify a group to engage to conduct your market research with — this should be a 
representative sample of your target customers so you can better understand their 
actual characteristics, challenges, and buying habits. 
The group you identify to engage should also be made of people who recently made a 
purchase or purposefully decided not to make one. Here are some more guidelines and 
tips to help you get the right participants for your research.  
How to Identify the Right People to Engage for Market Research 
When choosing who to engage for your market research, start by focusing on people who 
have the characteristics that apply to your buyer persona. You should also: 
Aim for 10 participants per buyer persona. 
We recommend focusing on one persona, but if you feel it's necessary to research 
multiple personas, be sure to recruit a separate sample group for each one. 
Select people who have recently interacted with you. 

You may want to focus on people that have completed an evaluation within the past six 
months — or up to a year if you have a longer sales cycle or niche market. You'll be 
asking very detailed questions so it's important that their experience is fresh. 
Gather a mix of participants. 

You want to recruit people who have purchased your product, purchased a competitor's 
product, and decided not to purchase anything at all. While your customers will be the 
easiest to find and recruit, sourcing information from those who aren't customers (yet!) 
will help you develop a balanced view of your market.  
Here are some more details on how to select this mix of participants: 
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 Pull a list of customers who made a recent purchase. As we mentioned before, 
this is usually the easiest set of buyers to recruit. If you're using a CRM system, 
you can run a report of deals that closed within the past six months and filter it 
for the characteristics you're looking for. Otherwise, you can work with your sales 
team to get a list of appropriate accounts from them. 

 Pull a list of customers who were in an active evaluation, but didn't make a 
purchase. You should get a mix of buyers who either purchased from a 
competitor or decided not to make a purchase. Again, you can get this list from 
your CRM or from whatever system your Sales team uses to track deals. 

 Call for participants on social media. Try reaching out to the folks that follow you 
on social media, but decided not to buy from you. There's a chance that some of 
them will be willing to talk to you and tell you why they ultimately decided not to 
buy your product. 

 Leverage your own network. Get the word out to your coworkers, former 
colleagues, and LinkedIn connections that you're conducting a study. Even if your 
direct connections don't qualify, some of them will likely have a coworker, friend, 
or family member who does. 

 Choose an incentive. Time is precious, so you'll need to think about how you will 
motivate someone to spend 30-45 minutes on you and your study. On a tight 
budget? You can reward participants for free by giving them exclusive access to 
content. Another option? Send a simple handwritten 'thank you' note once the 
study is complete.  

 Prepare research questions for your market research participants. 
The best way to make sure you get the most out of your conversations is to be prepared. 
You should always create a discussion guide — whether it's for a focus group, online 
survey, or a phone interview — to make sure you cover all of the top-of-mind questions 
and use your time wisely. 
(Note: This is not intended to be a script. The discussions should be natural and 
conversational, so we encourage you to go out of order or probe into certain areas as 
you see fit.) 
Your discussion guide should be in an outline format, with a time allotment and open-
ended questions for each section. 
Wait, all open-ended questions? 
Yes — this is a golden rule of market research. You never want to "lead the witness" by 
asking yes and no questions, as that puts you at risk of unintentionally swaying their 
thoughts by leading with your own hypothesis. Asking open-ended questions also helps 
you avoid one-word answers (which aren't very helpful for you). 
Example Outline of a 30-Minute Survey  
Here's a general outline for a 30-minute survey for one B2B buyer. You can use these as 
talking points for an in-person interview, or as questions posed on a digital form to 
administer as a survey to your target customers. 
Background Information (5 Minutes) 
Ask the buyer to give you a little background information (their title, how long they've 
been with the company, and so on). Then, ask a fun/easy question to warm things up 
(first concert attended, favorite restaurant in town, last vacation, etc.). 
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Remember, you want to get to know your buyers in pretty specific ways. You might be 
able to capture basic information such as age, location, and job title from your contact 
list, there are some personal and professional challenges you can really only learn by 
asking. 
Here are some other key background questions to ask your target audience: 

 Describe how your team is structured. 
 Tell me about your personal job responsibilities. 
 What are the team's goals and how do you measure them? 
 What has been your biggest challenge in the past year? 

Now, make a transition to acknowledge the specific purchase or interaction they made 
that led to you including them in the study. The next three stages of the buyer's 
journey will focus specifically on that purchase. 
Awareness (5 Minutes) 
Here, you want to understand how they first realized they had a problem that needed to 
be solved without getting into whether or not they knew about your brand yet. 

 Think back to when you first realized you needed a [name the product/service 
category, but not yours specifically]. What challenges were you facing at the 
time? 

 How did you know that something in this category could help you? 
 How familiar were you with different options on the market? 

Consideration (10 Minutes) 
Now you want to get very specific about how and where the buyer researched potential 
solutions. Plan to interject to ask for more details. 

 What was the first thing you did to research potential solutions? How helpful was 
this source? 

 Where did you go to find more information? 
If they don't come up organically, ask about search engines, websites visited, people 
consulted, and so on. Probe, as appropriate, with some of the following questions: 

 How did you find that source? 
 How did you use vendor websites? 
 What words specifically did you search on Google? 
 How helpful was it? How could it be better? 
 Who provided the most (and least) helpful information? What did that look like? 
 Tell me about your experiences with the sales people from each vendor. 

Decision (10 Minutes) 
 Which of the sources you described above was the most influential in driving your 

decision? 
 What, if any, criteria did you establish to compare the alternatives? 
 What vendors made it to the short list and what were the pros/cons of each? 
 Who else was involved in the final decision? What role did each of these people 

play? 
 What factors ultimately influenced your final purchasing decision? 

Closing 
Here, you want to wrap up and understand what could have been better for the buyer. 

 Ask them what their ideal buying process would look like. How would it differ 
from what they experienced? 
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 Allow time for further questions on their end. 
 Don't forget to thank them for their time and confirm their address to send a 

thank-you note or incentive. 
 List your primary competitors. 
List your primary competitors — keep in mind listing the competition isn't always as 
simple as Company X versus Company Y. 
Sometimes, a division of a company might compete with your main product or service, 
even though that company's brand might put more effort in another area. 
For example. Apple is known for its laptops and mobile devices but Apple Music 
competes with Spotify over its music streaming service. 
From a content standpoint, you might compete with a blog, YouTube channel, or similar 
publication for inbound website visitors — even though their products don't overlap with 
yours at all. 
And a toothpaste company might compete with magazines like Health.com or Prevention 
on certain blog topics related to health and hygiene even though the magazines don't 
actually sell oral care products. 
Identifying Industry Competitors 
To identify competitors whose products or services overlap with yours, determine which 
industry or industries you're pursuing. Start high-level, using terms like education, 
construction, media & entertainment, food service, healthcare, retail, financial services, 
telecommunications, and agriculture. 
The list goes on, but find an industry term that you identify with, and use it to create a 
list of companies that also belong to this industry. You can build your list the following 
ways: 

 Review your industry quadrant on G2 Crowd: In certain industries, this is your 
best first step in secondary market research. G2 Crowd aggregates user ratings 
and social data to create "quadrants," where you can see companies plotted as 
contenders, leaders, niche, and high performers in their respective industries. G2 
Crowd specializes in digital content, IT services, HR, ecommerce, and related 
business services. 

 Download a market report: Companies like Forrester and Gartner offer both free 
and gated market forecasts every year on the vendors who are leading their 
industry. On Forrester's website, for example, you can select "Latest Research" 
from the navigation bar and browse Forrester's latest material using a variety of 
criteria to narrow your search. These reports are good assets to save on your 
computer. 

 Search using social media: Believe it or not, social networks make great company 
directories if you use the search bar correctly. On LinkedIn, for example, select 
the search bar and enter the name of the industry you're pursuing. Then, under 
"More," select "Companies" to narrow your results to just the businesses that 
include this or a similar industry term on their LinkedIn profile. 

Identifying Content Competitors 
Search engines are your best friends in this area of secondary market research. To find 
the online publications with which you compete, take the overarching industry term you 
identified in the section above, and come up with a handful of more specific industry 
terms your company identifies with. 
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A catering business, for example, might generally be a "food service" company, but also 
consider itself a vendor in "event catering," "cake catering," "baked goods," and more. 
Once you have this list, do the following: 

 Google it: Don't underestimate the value in seeing which websites come up when 
you run a search on Google for the industry terms that describe your company. 
You might find a mix of product developers, blogs, magazines, and more. 

 Compare your search results against your buyer persona: Remember the buyer 
persona you created during the primary research stage, earlier in this article? Use 
it to examine how likely a publication you found through Google could steal 
website traffic from you. If the content the website publishes seems like the stuff 
your buyer persona would want to see, it's a potential competitor, and should be 
added to your list of competitors. 

After a series of similar Google searches for the industry terms you identify with, look for 
repetition in the website domains that have come up. 
Examine the first two or three results pages for each search you conducted. These 
websites are clearly respected for the content they create in your industry, and should be 
watched carefully as you build your own library of videos, reports, web pages, and blog 
posts. 

1.  Summarize your findings. 
Feeling overwhelmed by the notes you took? We suggest looking for common themes 
that will help you tell a story and create a list of action items. 
To make the process easier, try using your favorite presentation software to make a 
report, as it will make it easy to add in quotes, diagrams, or call clips. 
Feel free to add your own flair, but the following outline should help you craft a clear 
summary: 

 Background: Your goals and why you conducted this study. 
 Participants: Who you talked to. A table works well so you can break groups 

down by persona and customer/prospect. 
 Executive Summary: What were the most interesting things you learned? What 

do you plan to do about it? 
 Awareness: Describe the common triggers that lead someone to enter into an 

evaluation. (Quotes can be very powerful.) 
 Consideration: Provide the main themes you uncovered, as well as the detailed 

sources buyers use when conducting their evaluation. 
 Decision: Paint the picture of how a decision is really made by including the 

people at the center of influence and any product features or information that 
can make or break a deal. 

 Action Plan: Your analysis probably uncovered a few campaigns you can run to 
get your brand in front of buyers earlier and/or more effectively. Provide your list 
of priorities, a timeline, and the impact it will have on your business. 

 Less is more – Preface your report with executive summaries that highlight your 
key discoveries and their implications 

 Work with experts – Make sure you’ve access to a dedicated team of experts 
ready to help you design and launch successful projects 

Lastly, let's review a resource that can help you compile everything we just discussed in a 
simple yet effective way (plus, it's free!). 
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Utilize social media.  
Social media is a treasure trove of consumer insights. It’s the place where people 
broadcast their complaints, wishes, preferences and aspirations. But to find those golden 
nuggets of wisdom, you need to go on a deep dive.  
To avoid getting too deep down the internet rabbit hole, keep your online business 
research focused on:  
Following influencers in your industry. Analyze their opinions, conversations and past 
partnerships with brands. 
Monitor relevant hashtags. Identify the most relevant hashtags for your products and 
then make it a habit to monitor them regularly. 
Analyze competitor sentiment. Keep an ear on what people are saying about your 
competitors. This is a great way to figure out what their strengths and weaknesses are. 
Note that the most valuable information often lies in posts that mention a competing 
company or their products but don’t tag them.  
Text analysis can come in handy here. This machine learning technique helps analyze 
massive quantities of textual data and extract relevant information from it.  
For example, text analytics software could analyze all tweets with a specific hashtag. 
Then let you know whether the overall sentiment was positive or negative, which words 
appeared most frequently, etc. Investing in text analytics software would give you a 
much more accurate picture of the market and analyze a wider range of ideas shared 
online.  
Picking out the language your customers use — words, slang, metaphors — to express 
their preferences is a short-cut to writing better copy. By infusing the voice of customer 
data into your messaging, you make your pitches feel more personal and relevant. 
Market Research Report Template 
Within a market research kit, there are a number of critical pieces of information for your 
business's success. Let's take a look at what those different kit elements are next.  
1. Five Forces Analysis Template 
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Use Porter's Five Forces Model to understand an industry by analyzing five different 
criteria and how high the power, threat, or rivalry in each area is — here are the five 
criteria:  

 Competitive rivalry 
 Threat of new entrants 
 Threat of substitution 
 Buyer power 
 Supplier power 

 
SWOT Analysis Template 

https://offers.hubspot.com/market-research-kit?hubs_post-cta=image&hubs_post=blog.hubspot.com/marketing/market-research-buyers-journey-guide
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 A SWOT (Strengths, Weaknesses, Opportunities, Threats) analysis looks at your internal 
strengths and weaknesses, and your external opportunities and threats within the 
market. 
A SWOT analysis highlights direct areas of opportunity your company can continue, build, 
focus on, and work to overcome. 
  
Market Survey Template 
Both market surveys and focus groups help you uncover important information about 
your buyer personas, target audience, current customers, market, competition, and 
more (e.g. demand for your product or service, potential pricing, impressions of your 
branding, etc.). 
Surveys should contain a variety of question types, like multiple choice, rankings, and 
open-ended responses. Ask quantitative and short-answer questions to save you time 
and to more easily draw conclusions. (Save longer questions that will warrant more 
detailed responses for your focus groups.) 
Here are some categories of questions you should ask via survey:  

 Demographic questions 
 Business questions 
 Competitor questions 

https://offers.hubspot.com/market-research-kit?hubs_post-cta=image&hubs_post=blog.hubspot.com/marketing/market-research-buyers-journey-guide
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 Industry questions 
 Brand questions 
 Product questions 

Focus Group Template 
Focus groups are an opportunity to collect in-depth, qualitative data from your real 
customers or members of your target audience. You should ask your focus group 
participants open-ended questions. While doing so, keep these tips top of mind: 

 Set a limit for the number of questions you're asking (after all, they're open-
ended).  

 Provide participants with a prototype or demonstration. 
 Ask participants how they feel about your price. 
 Ask participants about your competition. 
 Offer participants time at the end of the session for final comments, questions, or 

concerns. 
Conduct Market Research to Grow Better 
Conducting market research can be a very eye-opening experience. Even if you think you 
know your buyers pretty well, completing the study will likely uncover new channels and 
messaging tips to help improve your interactions. 
What's a Competitive Analysis & How Do You Conduct One? 
What is a competitive market analysis? 
A competitive analysis is a strategy that involves researching major competitors to gain 
insight into their products, sales, and marketing tactics. Implementing stronger business 
strategies, warding off competitors, and capturing market share are just a few benefits of 
conducting a competitive market analysis. 
A competitive analysis can help you learn the ins and outs of how your competition 
works, and identify potential opportunities where you can out-perform them. 
It also enables you to stay atop of industry trends and ensure your product is consistently 
meeting — and exceeding — industry standards. 
Let's dive into a few more benefits of conducting competitive analyses: 
 

 Helps you identify your product's unique value proposition and what makes your 
product different from the competitors', which can inform future marketing 
efforts. 

 Enables you to identify what your competitor is doing right. This information is 
critical for staying relevant and ensuring both your product and your marketing 
campaigns are outperforming industry standards. 

 Tells you where your competitors are falling short — which helps you identify 
areas of opportunities in the marketplace, and test out new, unique marketing 
strategies they haven't taken advantage of. 

 Learn through customer reviews what's missing in a competitor's product, and 
consider how you might add features to your own product to meet those needs. 

 Provides you with a benchmark against which you can measure your growth. 
What is competitive market research? 
Competitive market research focuses on finding and comparing key market metrics that 
help identify differences between your products and services and those of your 
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competitors. Comprehensive market research helps establish the foundation for an 
effective sales and marketing strategy that helps your company stand out from the 
crowd. 
Next, let's dive into how you can conduct a competitive analysis for your own company. 
 

3 Types of Competitors to Watch (+ How to Find Them) 
1. Direct competitors. 
A direct competitor probably comes to mind when you think of your competition. These 
are businesses offering similar (or identical) products or services in the same market. 
They also vye for the same customer base. 
Some famous examples of direct competitors include Apple versus Android, Pepsi versus 
Coca-Cola, and Netflix versus Hulu. But direct competition isn't exclusive to well-known 
national or international brands. Two shoe stores in a rural town are direct competitors. 
So are a handful of realtors servicing one area. 
Digital companies also see direct competition. For example, after the success of Twitter’s 
Periscope app, Facebook pivoted its focus to live video to keep up. 
Since direct competitors sell similar products in a similar manner, this type of 
competition is often a zero-sum game — meaning, a customer that buys a competitor's 
product won't buy yours. For example, if you buy a hamburger at McDonald's, it's not 
likely you'll swing by Burger King to buy another one. 
2. Indirect competitors. 
Indirect competitors are businesses in the same category that sell different products or 
services to solve the same problem. 
For example, Taco Bell and Subway fall under the same category — fast-food — but they 
offer entirely different menu options. While they both seek to solve the same problem 
(feed hungry people), they provide different products to solve it. 
Here's another example — residential painters experience indirect competition with 
home improvement chains like Home Depot or Lowes. Again, the category is the same 
but the product offerings differ. 
Indirect competition isn't necessarily a zero-sum game. Consider someone buying 
supplies from Lowe's to re-paint their home —only to do a sloppy job. They may call a 
local painter to fix the mistakes. 
3. Replacement competitors. 
A replacement competitor offers an alternative to the product or service that you offer. 
You both seek to solve the same pain points, but the means are different. 
For example, a restaurant and coffee shop in the same neighborhood could be 
replacement competitors. Walking down the street, some customers may choose to grab 
a to-go lunch from the coffee shop, while others prefer the restaurant. 
The idea here is that customers are using the same resources to purchase the 
replacement that they could've used to buy your offerings. 
These competitors are potentially dangerous if there's more than one way to solve the 
same problem you seek to resolve. Additionally, these are the most challenging 
competitors to identify. After all, we can't read people's minds and understand all the 
choices that led them to us. 
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But we can find other ways to uncover this information — such as requesting feedback 
from customers or keeping an eye on their social media mentions. With this insight, you 
can better understand your audience and identify your replacement competitors. 
As you work to identify your competitors, you may discover more than you anticipated. 
Don't get overwhelmed. Remember that not all competitors are built the same — some 
are less of a threat than others. 
Now let's discuss ways to identify the players above, below, and next to you. 

5 Ways to Identify the Competition 
1. Check the first page of Google. 
An easy starting point is doing a quick Google search. Think of a few keywords someone 
might search to find you, such as [service or product] + [location]. For example, general 
contractor Sacramento. 
Then, note the top companies on the first page of your search results. You may notice 
your keywords return thousands of results, but you shouldn't stress. The most relevant 
section is the first page and the competition directly above and below you on it. Those 
tend to be your direct competitors. 
2. Research targeted keywords. 
Check the keywords you are currently targeting to identify other businesses targeting the 
same ones. 
This is a solid strategy for finding your indirect competition since they likely target the 
same keywords. For example, the keyword "fast-food" may reveal Subway and Taco Bell 
— both indirect competitors —as the top two results. 
3. Monitor social media conversations. 
Opinions are aplenty on social media — so it's relatively easy to find what your 
customers are saying. To find relevant conversations, enter your businesses' name in the 
search bar and check the results. 
For instance, someone may post a question to Twitter asking what hair salon they should 
visit in your city. A follower may respond with the name of your business, along with a 
handful of others. 
You can expand your search beyond social media to include community forums, such as 
Reddit or Quora — along with review sites like Yelp. Both of these resources can reveal 
helpful insight into your customers and why they chose your business over the 
competition. 
4. Perform market research. 
Check the market for your product or service and note any companies with a competing 
offer. Market research can be done a number of ways — whether that be with a Google 
search, by browsing through trade journals, or by talking with your sales team to see 
what other companies are commonly brought up by customers (to name a few). 
5. Ask your customers. 
Customers are crucial to identifying your competition — after all, they likely sifted 
through most of them before landing on you. There are many ways to solicit feedback 
from customers — both online and in-person. That could mean striking up conversations 
while cashing them out or sending an email survey after each sale. One way or another, 
try to find the best approach and regularly check the feedback for any trends. 

https://blog.hubspot.com/website/10-best-online-tools-spying-competitors-traffic?_ga=2.208256658.1451543749.1639523540-171391690.1639523540
https://blog.hubspot.com/service/social-listening?_ga=2.213106324.1451543749.1639523540-171391690.1639523540
https://blog.hubspot.com/service/social-listening?_ga=2.213106324.1451543749.1639523540-171391690.1639523540
https://blog.hubspot.com/marketing/market-research-buyers-journey-guide?_ga=2.213106324.1451543749.1639523540-171391690.1639523540
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Every business has competition, and it pays to know the top players. But remember, as 
your business grows and evolves, so too will the competition. A direct competitor may go 
out of business, or an indirect competitor may become a direct one. All this to say, make 
a habit of routinely checking those above, below, and next to you. 

How to Conduct a Market Opportunity Analysis 
 
What is market opportunity analysis? 
Market opportunity analysis is the process of researching where and how you can reach 
more potential clients or grow your revenue share. It involves identifying competitions, 
understanding your audience, and uncovering potential risks. By doing a market 
opportunity analysis, you’ll be able to prioritize new business ideas based on how 
potentially profitable and risky they are. 
Who should conduct a market opportunity analysis? 
That answer is, "everyone." All sizes of organizations will benefit from better 
understanding the industry in which they’re operating or approaching. Whether you 
work in B2B, B2C, government, or non-profit organizations, defining and analyzing the 
market will help you make better decisions. 
This kind of analysis can help you grow your existing business, pivot into new markets 
and opportunities, or expand into the periphery of your current market. 

5 Benefits of a Market Opportunity Analysis 
1. Make better long-term strategic decisions. 
2. Evaluate product or service demand. 
3. Identify potential marketing strategies. 
4. Uncover areas for further research. 
5. Identify and navigate potential roadblocks. 

There are many reasons to take the time and examine the full range of options before 
forging ahead. Here are five important benefits you’ll get from market analysis. 
1. Make better long-term strategic decisions. 
Your business is impacted by many external factors. Without taking the time to examine 
the current market trends, you’ll be flying blind. 
A market opportunity analysis can provide the insight you need to see into the future. 
What will the market look like in a year? Five years? 10 years? What forces are acting on 
the market today? How is the demographic of your target audience shifting? 
2. Evaluate product or service demand. 
You may have invented the next Google Glass: a great product with tough, niche 
demand. A market assessment will show the potential for selling your product or service. 
This analysis will help you evaluate if expanding into a potential new market is 
worthwhile for your company. 
You may find that there is no existing market for your idea, leading to a “Blue Ocean 
Strategy.” “Blue oceans,” explain authors W. Chan Kim and Renee Mauborgne, “denote 
all the industries not in existence today — the unknown market space, untainted by 
competition. In blue oceans, demand is created rather than fought over. There is ample 
opportunity for growth that is both profitable and rapid.” 
While that might be the case, you might also fail to create the market, or need to spend 
time and energy educating customers on the value of your new idea. 

https://www.google.com/glass/start/
https://www.blueoceanstrategy.com/what-is-blue-ocean-strategy/
https://www.blueoceanstrategy.com/what-is-blue-ocean-strategy/
http://www.insead.edu/alumni/newsletter/February2005/Interview.pdf
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3. Identify potential marketing strategies. 
The four P’s of your marketing mix are price, place, product, and promotion. Through the 
process of a market opportunity analysis, organizations can gain a deeper understanding 
of who their target customers are, what they want, and how they make their decisions. 
After assessing the current market, you’ll be able to price your product effectively and 
know which promotion strategies will work best. Are there partnerships you should 
pursue? Will direct sales or inbound marketing work best? 
4. Uncover areas for further research. 
When you start to better understand the market, you may identify even more new 
opportunities to explore. As the saying goes, “You don’t know what you don’t know.” You 
may discover a new government initiative that encourages sustainable businesses. 
A customer research project may identify a new pain point that you didn’t realize existed. 
The benefit of knowing your marketplace really deeply is that you’ll be ready to leverage 
any new opportunities that pop up. 
5. Identify and navigate potential roadblocks. 
A SWOT analysis looks at the strengths, weaknesses, opportunities, and threats of a 
potential strategy. Identifying the weaknesses and the threats to your market 
opportunity is key to your success. No business idea is perfect. But knowing where you 
might run into trouble before you even begin can help you plan ahead and mitigate those 
risks. 
Examples of Market Opportunity Analysis 
Before we get into the step-by-step instructions of how to do your own analysis, let’s 
look at the results of two very different case studies. The purpose of both of these 
research projects was to identify new opportunities, however, they were done in two 
different industries: elderly care options and the automotive industry. 
1. Say Yeah! ElderCare Case Study 
Consulting agency Say Yeah! conducted a market opportunity analysis for a company 
looking to expand its business model into the elderly care industry. They started by 
mapping the customer journey for an adult child caring for their elderly parent, along 
with all the decision points they encounter. 
By examining market forces — such as government subsidies, the changing 
demographics, and all the options older adults have — Say Yeah! was able to uncover 
several different options by which ElderCare could increase their profits. 
Notably, they recommended ElderCare expand its referral business to include retirement 
homes, in-home care, and other social services. 
“Their initial business premise is validated: by shifting the industry to a subscription-
based model, led by an online marketplace, this business could carve out a significant 
piece of profit in the elder care industry by providing far more value to retirement homes 
at less cost.” 

https://www.hubspot.com/inbound-marketing?_ga=2.59502381.1005086283.1619121444-1574829959.1619121444&hubs_post=blog.hubspot.com/marketing/market-opportunity-analysis&hubs_post-cta=inbound%20marketing%20work%20best
https://blog.hubspot.com/marketing/swot-analysis?_ga=2.59502381.1005086283.1619121444-1574829959.1619121444
https://sayyeah.com/case-study/elder-care/
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2. Ipsos Business Consulting Automotive Case Study 
A global automotive conglomerate was interested in the growing electronic vehicle (EV) 
market, specifically three-wheelers in India. Ipsos conducted a study of the EV 
market through customer interviews, business model analysis, and government research. 
At the end of the study, they provided recommendations around charging station 
locations, leasing vs purchasing options, and other infrastructure requirements. 

https://www.ipsos.com/en-hk/case-study-market-opportunity-assessment-auto
https://www.ipsos.com/en-hk/case-study-market-opportunity-assessment-auto
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How to Conduct a Market Opportunity Assessment 
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1. Identify potential opportunities. 
Your first step is to lay out the potential opportunities you want to investigate. What 
segment are you hoping to expand into? What type of customer are you hoping to 
attract? Are you looking to acquire or partner with another business? Have current 
events created a potential opportunity? 
Knowing whether you want to expand, pivot, invest, create, or reposition your offerings 
will inform the next steps of your market research. 
Once you’ve identified market opportunities, you’re ready to start researching their 
potential. 
2. Understand the customer. 
In every opportunity, the customer will inform your success. Does this product meet their 
needs? Do they have the purchasing power to make this idea profitable? How do they 
make their purchasing decisions? The second step in the analysis is to really, deeply 
understand your potential customers and their needs. This research may include any of 
the following tools: 

 Customer interviews 
 Customer journey map 
 Surveys 
 Demographic data 

3. Research competitors. 
Next, you’ll want to understand who all the players in the existing market 
are. Competitor research can help you understand how big the market share is, how 
existing products are positioned in the market, and how crowded the market is. Here are 
some questions you might want to ask: 

 What is their value proposition? 
 How is their product offering different from ours? 
 Who are their partners? 
 What do their reviews say about their product or service? 
 Are there any gaps we could fill? 
 How likely are new competitors? 

4. Consider external factors. 
External factors are always shaping and changing the marketplace. The acronym “STEEP” 
can help us dive into the five main forces we need to be aware of. 
Social 
How is culture changing the market? For example, more employees working from home 
during the pandemic has opened up an entire sector of the market that didn’t exist 
before. Jumping on trends can be a lucrative strategy unless the trends disappear too 
quickly. 
Technical 
What new innovations have influenced the market? Can you apply this technology in 
other ways or in new industries? 
Economic 
What is the current economic climate like? Will you be able to get a loan if needed? Do 
your customers have disposable income? How does the market forecast look for the next 
year? Five years? 
Ecological 

https://blog.hubspot.com/service/customer-journey-map?_ga=2.66266030.1005086283.1619121444-1574829959.1619121444
https://blog.hubspot.com/marketing/competitive-analysis-kit?_ga=2.66266030.1005086283.1619121444-1574829959.1619121444
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What impact does this idea have on the environment? Can you improve the sustainability 
of the product or service? 
Political 
You may be pleasantly surprised to learn that your local government is offering grants, 
tax breaks, or other incentives for businesses in your industry. Alternatively, you may find 
that there are regulatory roadblocks in your way that you’ll need to account for in your 
analysis. 

 
5. Be aware of internal forces. 
Finally, dive into your own business’ capabilities. Do you have the skills, workforce, 
technology, and financial resources to invest in a new product? If you’re launching a very 
innovative product, are you going to be able to hire people with the necessary skills? 
What new departments or teams will you need to create to manage this new 
opportunity? 
Make better decisions with market opportunity analysis. 
Not every idea is worth pursuing — but many are. With market opportunity analysis, 
you’ll learn which business strategies will help you grow, along with their potential risks. 
Don’t launch your next product or service without doing your homework. 

How to Run a Focus Group for Your Business 
How to Run a Focus Group 

1. Choose your topic of discussion 
2. Choose your questions or discussion prompts 
3. Prepare your focus group questionnaire 
4. Appoint a notetaker 
5. Recruit and schedule participants 
6. Get consent and start the discussion 
7. Have everyone introduce themselves 
8. Ask your questions 
9. Seek equal representation from the group 
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10. End the meeting in a reasonable amount of time 
11. Analyze and incorporate feedback 

Follow Along With a Free Focus Group Questionnaire Template 

 
How to Run a Focus Group 
1. Choose your topic of discussion. 
Going into a focus group, your discussion should be narrowed down to one or a few 
topics. Keep in mind that you won't be able to thoroughly address every area you want to 
discuss in one short focus group session. 
Because of this, it's not uncommon for companies to run multiple rounds of focus groups 
around different topics. For example, if you're launching a new product, you could center 
one focus group around the product's marketing and brand positioning, and another one 
around the usability and functionality of the product itself. 
2. Choose your questions or discussion prompts. 
Once you determine the topic of discussion for your focus group, create a list of 
questions and discussion prompts that will help you gather the data you need. 
Let's return to the product launch example from above. If you're running the product 
marketing focus groups, you could ask questions like: 

 What do you think of the packaging design? 
 How much money would you spend on a product like this? 
 What other companies do you think of when you see a product like this? 

Meanwhile, for a focus group about the product itself, you’ll want to ask about the 
product's functionality, ease of use, and perceived favorability. 
Also, remember to ask open-ended questions — "Do you like the product?" and "What 
do you think of the product?" may seem similar in nature, but the latter will produce 
more detailed results. 
3. Prepare your focus group questionnaire. 
After you've chosen your questions and discussion prompts, organize them on a focus 
group questionnaire. Be sure to leave enough space on the questionnaire for overall 

https://offers.hubspot.com/market-research-kit?hubs_post-cta=image&_ga=2.132002186.409423879.1616568612-1008608015.1616568612&hubs_post=blog.hubspot.com/marketing/how-to-run-a-focus-group
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notes, a list of common responses, and one or two noteworthy responses that really 
stood out. 

 
4. Appoint a notetaker. 
Your focus group discussion should be facilitated by at least one person, while another 
person on your team should be a designated notetaker. 
Why? The facilitator's job is to facilitate — to guide the discussion and foster new ideas 
from participants. This task can get easily derailed if the facilitator also needs to pause 
the discussion to write down big, bold ideas and reactions from participants. 
To avoid this possibility of disruption, appoint a notetaker before going into the focus 
group who can focus solely on jotting down the general consensus from the group, 
unique and noteworthy individual responses, and the key takeaways for the business. 
5. Recruit and schedule participants. 
One of the most challenging parts of running a focus group is getting people to actually 
show up. After you select a time and a place, you'll want to start spreading the word to 
participants. 
Here are a few ways to find them: 
Reach out to existing customers. 
If you're doing market research for an existing company, reach out to your customers 
through account managers or an email database. Since current customers will likely be 
the first to use what you're launching, this will be the perfect opportunity to gauge early 
reactions for the official launch. 
For incentives, you could offer free or discounted services or reward them on a customer 
advocacy program like Influitive. 
Advertise on social media. 

https://offers.hubspot.com/market-research-kit?hubs_post-cta=image&_ga=2.132002186.409423879.1616568612-1008608015.1616568612&hubs_post=blog.hubspot.com/marketing/how-to-run-a-focus-group
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Looking for middle-aged males or senior citizens in the greater Ann Arbor area? No 
problem! Social media advertising offers advanced targeting options for you to reach 
your target market. 
You should also think about which sites are most used by the people you want in your 
focus group. If you're interested in surveying middle-aged working professionals, you'll 
probably have better luck on LinkedIn than you would on TikTok. 
Try location-based promotion. 
If you're hyper-targeting a location, supplement your recruiting efforts with 
advertisements that will only be seen by those in your area. A few examples include: 

 Billboard Ads 
 Public Transit-Based Ads (Trains, Busses, Taxis, etc.) 
 Ads in Local Publications and Newspapers 

Be prepared to offer incentives. 
People rarely do anything for free. In your advertisements and promotional assets, 
highlight the incentive you're prepared to offer — which could be cash, a gift card, or a 
discount on whatever you're selling. 
If you're strapped for cash, consider hosting a raffle or giveaway for participants. That 
way, if you host a focus group of eight people, you could offer a chance at a $100 gift 
card (rather than a guaranteed $25 per participant) to save you $100. 
6. Get consent and start the discussion. 
Before you start your focus group discussion, remind participants of the purpose of the 
group and hand out a consent form. The consent form should reiterate the purpose of 
the event, outline the participants' rights, identify the compensation, list the facilitators' 
contact information, and prompt participants to sign. 
After everyone signs off, it's time to run the focus group. 
7. Have everyone introduce themselves. 
To break the ice and get people talking, start the discussion off by introducing yourself 
and inviting the participants to do the same. 
This is another chance for you to learn more about your target market. In addition to 
having participants say their names, consider asking them to share their industry or 
interests to get a more personal understanding of how your product, service, or business 
could play a role in their everyday lives. 
8. Ask your questions. 
Remember, this is not an interview! Before the focus group begins, you should prepare 
a list of five to 10 questions. 
That being said, it can be easy to tie yourself to your list of questions or discussion points, 
but sticking too closely to this can hamper natural and effective conversations. If the 
group takes a slightly different turn than you were expecting, don't be afraid to allow the 
conversation to veer off-course if it seems productive. 
running a focus group to solicit multiple ideas, so only hearing from one or two people 
defeats the purpose of the exercise. Be ready to jump in when someone has been quiet 
for too long and say something along the lines of "Isabella, what's your input here?" or 
"Raheem, what do you think about what Isabella said?" 
The point of a focus group is not just to confirm information you think is true, but also to 
uncover what you don't know. 
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So long as it's not too far off-topic, allow the conversation to happen naturally and use an 
agenda as a guide rather than a point-by-point checklist of topics to cover. 
Additionally, you may not ask every question on your list, depending on the direction of 
the conversation. Make sure you ask the most important questions first, and follow-up 
on certain discussion points to keep things flowing rather than hosting a pure question-
and-answer forum. 
9. Seek equal representation from the group. 
Remember, this is not an interview! You're running a focus group to solicit multiple ideas, 
so only hearing from one or two people defeats the purpose of the exercise. Be ready to 
jump in when someone has been quiet for too long and say something along the lines of 
"Isabella, what's your input here?" or "Raheem, what do you think about what Isabella 
said?" 
10. End the meeting in a reasonable amount of time. 
Exhaustion and the law of diminishing returns are real, so keep them in mind when 
planning the time frame for your focus group. 
At the start of the session, in your advertisements, and/or on your consent form, you 
should specify how long the focus group will last. It's your responsibility to moderate the 
discussion in a way that ensures the time frame is not exceeded. 
Now, if the exercise lasts for an hour and five minutes and you promised an hour focus 
group, that's totally acceptable. However, if you promised a 45-minute session and it 
goes well over an hour, your attendees could be resentful and less likely to offer valuable 
feedback. 
When the discussion is over, thank your attendees for their time and deliver the 
promised incentive, if applicable. Additionally, remind them of your contact information 
if they decide they have more feedback or comments they'd like to provide. 
11. Analyze and incorporate feedback. 
Ideally, your focus group has provided you with plenty of responses, unique angles, and 
actionable ideas to help your business thrive. After all of your focus groups have taken 
place, have your team compile and analyze the commonalities of the ideas presented 
and what changes, if any, are applicable to the product, service, or business in question. 
Focus Group Agenda 
To get started with your focus group, you’ll need an agenda to stay on task during the 
meeting. First, you’ll want to welcome the participants in the focus group and introduce 
yourself and other researchers who may be present. This step is important as it 
establishes rapport with the group and builds trust. 
Next, ask participants to introduce themselves. This does a few things: it continues 
building rapport among the group members and it confirms the pronunciation of 
everyone’s names — you don’t want to spend the next hour or more together saying 
everyone’s names incorrectly! 
Before asking questions, establish some ground rules for the group. If a topic could 
become controversial, let that be known and set boundaries for how far a discussion can 
go. If you’ll be asking for information that isn’t normally shared in a group setting, assure 
the cohort that the findings won’t have names or identifying data attached to the 
responses. Finally, if your company is reimbursing expenses or providing payment to the 
focus group participants, let them know how and when they’ll receive their 
disbursements. 
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Now, here’s the fun part. Although you may have one broad topic to discuss during the 
focus group, it’s very likely that you’ll have several subtopics that need to be addressed 
separately. Structure your questions in such a way that the flow of the conversation 
makes sense. This could be by theme, chronological order, or the current-future state of 
your business. 
Once you’ve reached a stopping point during the conversation, wrap up any lingering 
questions and ideas within the group. Finally, thank everyone for their time and end the 
session. 
If you need those steps organized in a handy agenda, we’ve got you covered. Download 
the PDF below and save it for your next focus group. 
Focus Group Example 
Now that you have a step-by-step guide for conducting a focus group, it’s time to see one 
in action. Using the steps above, I’ve identified a recent focus group example that follows 
most of the guidelines we’ve recommended. 
Georgetown University Institute of Politics and Public Service conducted a focus group 
with first-time voters after the 2020 election. It could have been very easy for this focus 
group to get off track and into political affiliations; However, you’ll notice in this example 
that the researcher had a topic in mind — the first-time-voter experience — and didn’t 
deviate from that topic. She asked probing questions and sought out a variety of 
perspectives from the group. 
Watch this focus group to get a better understanding of how to start these conversations 
and keep them going to get the insights you need. 
Running a Better Focus Group 
Taking this methodical approach to running a focus group can produce better and more 
insightful feedback from your participants. To keep your questions, thoughts, and 
responses organized, we developed a focus group template, which you can use to run a 
better focus group.  
18 Tools & Resources for Conducting Market Research 
Market Research Tools 

1. Think With Google Research Tools 
2. Census Bureau 
3. Make My Persona 
4. Tableau 
5. Statista 
6. Claritas MyBestSegment 
7. SurveyMonkey 
8. Typeform 
9. Upwave Instant Insights 
10. Loop11 
11. Userlytics 
12. Temper 
13. NielsenIQ 
14. Ubersuggest 
15. Pew Research Center 
16. BrandMentions 
17. Qualtrics Market Research Panels 
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18. Qualaroo 
We are creatures of habit, especially when it comes to buying behavior. We know the 
location of our favorite products in the store, and we trust that they'll work year after 
year. According to McKinsey, nearly 3 out of 4 Americans stick with the same brand — 
and 8 out of 10 stay with the same retailer. 
People don't like change. It's a battle to get someone to switch to an unknown brand, 
especially during times of crisis. 
When a client wants to launch a new product, get into a different market, or open a new 
store location, the odds are stacked against them. It’s commonly known that most 
product launches are destined to fail — and that’s because they do. 
In part, we can blame lack of research for why there are so many unsuccessful product 
launches and ill-conceived new feature additions. Founders and brand managers "know" 
it will be successful — they run on their instincts, not the facts. (It was this instinct that 
led Clairol to release Touch of Yogurt Shampoo, which some people thought was a 
breakfast food option.) 
Finding out if a product will be successful beyond the initial curiosity is just good 
business. With market research, you determine whether the opportunity exists, how to 
position the product or service, or what consumers' opinions are after the launch. 
If you're sensitive to the high costs of failure and need to gather facts and opinions to 
predict whether your new product, feature, or location will be successful, start by 
investing in market research using these tools and resources. 
 

Helpful Market Research Tools & Resources 
1. Think with Google Research Tools 

 
Wish you had information on your product’s likelihood of success? Think With Google's 
marketing research tools offer interesting insights on whether anyone is looking for your 

https://www.thinkwithgoogle.com/tools/
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product (Google Trends), which markets to launch to (Market Finder), and what retail 
categories rise as the months and seasons pass (Rising Retail Categories). 
If you’d like to market your product through YouTube, the Find My Audience tool allows 
you to investigate what your potential viewers are interested in and what you should 
discuss in your brand’s YouTube channel. 
Pricing: Free 
 
 
 
 
 
 
 
 
 
 
 
 
2. Census Bureau 

 
The Census Bureau offers a free resource for searching U.S. census data. You can filter by 
age, income, year, and location. You can also use some of its shortcuts to access 
visualizations of the data, allowing you to see potential target markets across the 
country. 
One of the best ways to use this tool is by finding the NAICS code for your business, then 
accessing the Tables tool, then clicking Filter on the sidebar and searching for your 
industry. Easily find out where your target industry is most popular — or where the 
market has been oversaturated. Another helpful tool is the Census Bureau Business and 
Economy data, where you can also target premade tables depending on your industry. 
Pricing: Free 

https://data.census.gov/cedsci/
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3. Make My Persona 

 
Make My Persona is a proprietary tool that allows you to create a buyer persona for your 
potential new product. Defining who might benefit from your product is key to marketing 
it in an effective way. In this tool, you pick a name for the persona, choose their age, 
identify their career characteristics, and identify their challenges, allowing you to 
pinpoint both demographic and psychographic information. 
This tool is most suited for B2B product launches, because you’ll be prompted to 
document your buyer persona’s career objectives and role-specific challenges. As such, 
your product would ideally solve a problem for them in the workplace or help their 
company achieve revenue goals. 
Pricing: Free 
4. Tableau 

https://www.hubspot.com/make-my-persona?hubs_post=blog.hubspot.com/marketing/market-research-tools-resources&hubs_post-cta=Make%20My%20Persona
https://www.tableau.com/
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Tableau is a business intelligence suite of products that allows you to “connect to 
virtually any data source.” But the data isn’t presented in unreadable tables. Rather, 
Tableau helps you visualize this data in a way that helps you glean insights, appeal to 
external stakeholders, and communicate the feasibility of your product to potential 
investors. 
You can visualize data on anything from corn production in tropical climate zones to 
office product sales in North America. With Tableau’s tools, you can take as granular or 
as general a look you’d like into potential marketplaces and supplier regions. 
Pricing: $12/user/month (Tableau Viewer); $35/user/month (Tableau Explorer); 
$70/user/month (Tableau Creator) 
5. Statista 

https://www.statista.com/
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Statista is a data visualization website that takes data from reputable reports across the 
web and makes them easy and digestible for researchers, marketers, and product 
creators just like you. 
It helps you find even the most specific data relating to your industry. Are you planning 
on launching a new video game and want to know how many hours people spend playing 
video games? There’s a chart for that. 
One neat aspect of using Statista is that the same chart is updated as the years pass. Say 
that you want to allude to the value of the beauty market in your proposal. If your 
investor accesses that same graph a year from now, it will reflect updated numbers, as 
Statista always finds the most recent research to update their visualizations. (Note that 
Statista doesn’t carry out original research.) 
Pricing: Free; $39/month (billed yearly); $1,950 (one-time 30-day access) 
6. Claritas MyBestSegment 

https://www.statista.com/statistics/550657/beauty-market-value-growth-worldwide-by-country/
https://claritas360.claritas.com/mybestsegments/
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Claritas MyBestSegment provides product researchers with tools to understand an area's 
demographic information and the area’s inhabitants’ lifestyle habits. By finding out what 
a segment of the population does — without having to go out and survey them — you 
can find out which areas would be most receptive to a campaign or launch, which 
competitors are located nearby, and which lifestyle trends have shifted or are on the rise. 
A snapshot of an audience segment gives you basic information on their household 
income, lifestyle traits, employment levels, and education levels. If you want more 
specific data relating to these topics, you’ll have to contact Claritas’ sales team to 
become a customer. 
Pricing: Free; Pricing available on request 
7. SurveyMonkey 

https://www.surveymonkey.com/
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SurveyMonkey is a powerful tool for creating in-depth market research surveys that will 
help you understand your market and consumer preferences. 
With this tool, you can create targeted, uber-specific surveys that help you collect 
answers that pertain specifically to your product. While using a data source can give you 
a general overview of your target audience and market, SurveyMonkey can help you get 
more granular insights from real consumers. 
SurveyMonkey offers dedicated market research solutions and services, including a 
global survey panel, a survey translation service for international research, and a 
reporting dashboard option that allows you to easily parse through the results. 
Pricing: Free, $32/month (Advantage Annual), $99/month (Premier Annual), $99/month 
(Standard Monthly); $25/user/month (Team Advantage, minimum 3 users), 
$75/user/month (Team Premier, minimum 3 users), Enterprise (Contact for pricing) 
 
 
 
 
 
 
 
8. Typeform 

https://www.typeform.com/
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Like SurveyMonkey, Typeform allows you to run research surveys to get direct answers 
from your target consumers. It’s an easy-to-use, mobile-optimized form-builder that's 
great for market research. 
Typeform’s distinguishing factor is that it shows viewers one form field at a time. In its 
templates, it encourages a more conversational, casual approach (like in its market 
research survey template). This makes it a better fit for product launches that target a 
younger demographic. If you’re targeting C-suite executives at established firms, consider 
a more formal option such as SurveyMonkey or keeping your tone more formal in your 
questions. 
You can create a wide range of question types, including multiple choice questions, short-
form questions, and rating scale questions. Other features include the ability to recall 
answers from previous questions and create logic jumps. 
In a survey, you’d want to collect both demographic and psychographic information on 
your customer, seeking to understand their purchasing behaviors and the problems they 
encounter. The goal is to find out if your product is the solution to one of those problems 
— and whether, before launching, you should add more features or rethink your product 
positioning strategy. 
Pricing: Free; $35/month (Essentials); $50/month (Professional); $70/month (Premium) 
9. Upwave Instant Insights 

https://www.typeform.com/pricing/
https://www.upwave.com/instant-insights/
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Upwave Instant Insights is a consumer research tool that’s part of the Upwave brand 
marketing platform. While it isn’t advertised as a survey creation tool, it allows you to 
launch market research surveys specifically to get consumer insights. 
Instant Insights allows you to target audiences on Upwave’s partner ecosystem and 
visualize the data for easy scanning by key stakeholders and investors. One pro of using 
this platform is that Upwave distributes your survey to real people — not just people 
taking surveys for the money, which could skew the results. 
To create a survey, you sign up on the Upwave platform, click your name in the upper 
right-hand corner, and click “My Surveys,” where you can create as many surveys as you 
want. For the Basic option, you have a 6-question limit, while the Advanced option allows 
you to include unlimited questions. 
Pricing: $2/study participant (Basic); $3/study participant (Extended); $4/study 
participant (Advanced) 
 
 
 
 
 
 
10. Loop11 

http://www.loop11.com/
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Loop11 is a user experience testing platform that allows you to test the usability of your 
website, study user intent, test the information architecture of your site, and examine 
how the user experience changes based on the device they’re using. 
This tool is useful for market research because you can find out whether your target 
consumers find your site easy to navigate. You can also identify snags that prevent 
conversions. 
Loop11 tests your site by making users perform tasks. They then complete a short 
question about how easy or difficult the task was to complete. Your product may be 
phenomenal, but unless consumers can buy it through your site, you won’t launch it 
successfully. 
You can use Loop11’s participants or bring in your own. 
Pricing: $63/month (Rapid Insights), $239/month (Pro), $399/month (Enterprise) 
 
 
 
 
 
 
11. Userlytics 

https://www.loop11.com/pricing/
http://www.userlytics.com/sitepublic/
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Like Loop11, Userlytics allows you to test the usability of your website, mobile app, and 
site prototype. You can target different devices, define a buyer persona, and disqualify 
participants based on screening questions. 
Testing is based on tasks that your test-takers carry out. They then answer a simple 
question about the difficulty of the task. You can structure the question in various ways; 
you can leave it open-ended, provide multiple choices, or ask for a rating. Other formats 
you can use include System Usability Scale (SUS) questions, Net Promoter Score (NPS) 
questions, and Single Ease Questions (SEQ). 
Userlytics performs both a webcam and a screen recording. You can compare the user’s 
answers with their reactions on video to understand how they feel when they’re 
interacting with your assets. 
Pricing: $49/participant (Quick & Easy); $69/participant (Annual Enterprise); Custom 
pricing available on request 
 
 
 
 
 
12. Temper 

https://www.userlytics.com/prices-plans
https://www.userlytics.com/prices-plans
https://www.temper.io/
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Sometimes you need a no-frills test to take the pulse of consumers. Temper allows you to 
create a question, grab a snippet of code, and pop it onto your website. The smiley face, 
"meh" face, and frown face make it easy for viewers to make a snap judgment. 
One great way to use this tool is by adding the widget on a blog post announcing the 
launch of your new product. That way, you can find out general sentiment on the 
product before launching it. You can also add it to a product page, an email, or a landing 
page. 
When you include the widget, you can change the question to something that’s tailored 
to your offerings. 
Pricing: $12/month (Hobby), $49/month (Pro), $89/month (Business), $199/month 
(White Label) 
 
 
 
 
 
 
 
13. NielsenIQ 

https://nielseniq.com/global/en/
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NielsenIQ is a retail and consumer intelligence consultant that works with you to collect 
consumer insights, identify the best distribution channels for your product, and create a 
range of products that addresses the needs of your target buyers. 
This service helps you look at your product launch from all angles and delivers forecasting 
data that predicts how your sales will perform upon launch. NielsenIQ can also 
run consumer insights surveys on their list of panelists and partners. 
Because it operates like a consultant and not as a self-service software, NielsenIQ is a 
better option for established firms with a bigger product launch budget. 
14. Ubersuggest 

 
Ubersuggest is a simple tool for doing keyword and content research. You can input a 
phrase, and it'll create a list of keyword suggestions. You can also see top performing 

https://app.neilpatel.com/en/ubersuggest/overview
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articles and pages so that you get an initial understanding of the type of content that 
ranks for the keywords. 
This tool is useful for market research because you can see who your top competitors 
are, how often your product is searched for, and whether there’s enough space in the 
market for the type of product you’re launching. You can also find out the questions your 
target audience asks in relation to the product. Each of these questions can be turned 
into a blog post that can inform your audience, increasing your brand authority and 
driving conversions. 
Alternatives to Ubersuggest include Moz, Ahrefs, and SEMRush. 
Pricing: Free; $29/month (Individual); $49/month (Business); $99/month (Enterprise / 
Agency) 
 
 
 
 
 
 
 
 
15. Pew Research Center 

 
From economic conditions, to political attitudes, to social media usage, the Pew Research 
Center website has a ton of free research that you can use to better understand your 
target market. Best of all, the site has interactive articles that allow you to filter and sift 
through the data for more granular, targeted insights. 
Topics include U.S. politics, digital media, social trends, religion, science, and technology. 
Pricing: Free 

https://moz.com/explorer
https://ahrefs.com/keywords-explorer
https://www.semrush.com/analytics/keywordoverview/
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16. BrandMentions 

 
BrandMentions is a social media monitoring platform that can help you understand what 
your prospective customers are buzzing about online. Search for a keyword, and 
BrandMentions will show you recent social posts that contain that keyword, along with 
the context of its usage. After subscribing to the platform, you can also get sentiment 
analysis on the keyword. 
You’ll also get other metrics such as Reach (how many people view the keyword per day), 
Performance (how many people engage with the keyword per day), and Mentions by 
Weekday (when people are mentioning the keyword). 
You can use this tool for market research by finding out when people are looking for your 
product on social media sites. When you start announcing the new product, you can use 
insights from this tool to post about the launch at exactly the right time. It also allows 
you to find out how people are generally feeling about the type of product you’re 
launching. That way, you can better refine the tone of your campaigns. 
Pricing: $99/month (Growing Business); $ 299/month (Company); $ 499/month 
(Enterprise/Agency) 
 
 
 
 
17. Qualtrics Market Research Panels 

https://brandmentions.com/socialmention/
https://www.qualtrics.com/uk/research-services/online-sample/
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Qualtrics takes the pain of finding respondents for your market research surveys through 
an online sample service. After identifying your target audience, you can go to Qualtrics 
for access to a representative sample. You can either use your chosen survey software or 
use Qualtrics’ built-in platform for insights and feedback. 
Pricing: Pricing available on request 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
18. Qualaroo 

https://qualaroo.com/
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Qualaroo is an advanced user and market research tool that helps you understand your 
target market with targeted surveys. You can run surveys on over six channels at once 
(such as website, app, product, social media, and mail,) to get a 360-degree view of your 
existing and potential customers. 
It comes packed with features like question branching, 12+ answer types, automatic 
survey language translation, in-depth audience targeting, pre-built survey templates, and 
an extensive repository of professionally designed questions. 
You can create various market research surveys in minutes to collect data on the 
demographic, psychographic, and behavioral traits of your target audience. It can help 
you map customers' expectations and preferences, create customer personas, and 
perform audience segmentation. 
Qualaroo also promotes quick feedback analysis. Its in-built AI-based sentiment analysis 
and text analytics engine automatically categorizes the responses based on user moods. 
It also highlights the key phrases and words in real-time, saving hours of manual work. 
Pricing: $80/month billed annually (Essentials); $160/month billed annually (Premium) 
 
Conducting market research is essential to successfully launch a product to market. 
 
In order to become an online market research PRO, need to understand: 
 

 What are the different types of market research, and how is quant online 
research different 

 How to unpack your research objective 

 Questionnaire design 

 Survey programming 

 Conducting fieldwork 

 Data cleaning and processing 

 Data analysis and interpretation 
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Module 11: E-commerce 

What is E-Commerce? 
E-Commerce or Electronics Commerce is a methodology of modern business, which 
addresses the requirements of business organizations. It can be broadly defined as the 
process of buying or selling of goods or services using an electronic medium such as the 
Internet.  
E-Commerce or Electronics Commerce is a methodology of modern business, which 
addresses the need of business organizations, vendors and customers to reduce cost and 
improve the quality of goods and services while increasing the speed of delivery. 
Ecommerce refers to the paperless exchange of business information using the following 
ways − 

 Electronic Data Interchange (EDI) 
 Electronic Mail (e-mail) 
 Electronic Bulletin Boards 
 Electronic Fund Transfer (EFT) 
 Other Network-based technologies 

 
Features 
E-Commerce provides the following features − 
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 Non-Cash Payment − E-Commerce enables the use of credit cards, debit cards, 
smart cards, electronic fund transfer via bank's website, and other modes of 
electronics payment. 

 24x7 Service availability − E-commerce automates the business of enterprises and 
the way they provide services to their customers. It is available anytime, 
anywhere. 

 Advertising / Marketing − E-commerce increases the reach of advertising of 
products and services of businesses. It helps in better marketing management of 
products/services. 

 Improved Sales − Using e-commerce, orders for the products can be generated 
anytime, anywhere without any human intervention. It gives a big boost to 
existing sales volumes. 

 Support − E-commerce provides various ways to provide pre-sales and post-sales 
assistance to provide better services to customers. 

 Inventory Management − E-commerce automates inventory management. 
Reports get generated instantly when required. Product inventory management 
becomes very efficient and easy to maintain. 

 Communication improvement − E-commerce provides ways for faster, efficient, 
reliable communication with customers and partners. 

 
Traditional Commerce v/s E-Commerce 

Sr. 
No. 

Traditional Commerce E-Commerce 

1 Heavy dependency on information 
exchange from person to person. 

Information sharing is made easy via electronic 
communication channels making little 
dependency on person to person information 
exchange. 

2 Communication/ transaction are done 
in synchronous way. Manual 

Communication or transaction can be done in 
asynchronous way. Electronics system 
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intervention is required for each 
communication or transaction. 

automatically handles when to pass 
communication to required person or do the 
transactions. 

3 It is difficult to establish and maintain 
standard practices in traditional 
commerce. 

A uniform strategy can be easily established and 
maintain in e-commerce. 

4 Communications of business depends 
upon individual skills. 

In e-Commerce or Electronic Market, there is no 
human intervention. 

5 Unavailability of a uniform platform as 
traditional commerce depends heavily 
on personal communication. 

E-Commerce website provides user a platform 
where al l information is available at one place. 

6 No uniform platform for information 
sharing as it depends heavily on 
personal communication. 

E-Commerce provides a universal platform to 
support commercial / business activities across 
the globe. 

 

E-Commerce advantages can be broadly classified in three major categories − 
 

 Advantages to Organizations 
 Advantages to Consumers 
 Advantages to Society 
 e-commerce advantages 

Advantages to Organizations 

 Using e-commerce, organizations can expand their market to national and 
international markets with minimum capital investment. An organization can 
easily locate more customers, best suppliers, and suitable business partners 
across the globe. 

 E-commerce helps organizations to reduce the cost to create process, distribute, 
retrieve and manage the paper based information by digitizing the information. 

 E-commerce improves the brand image of the company. 

 E-commerce helps organization to provide better customer services. 

 E-commerce helps to simplify the business processes and makes them faster and 
efficient. 

 E-commerce reduces the paper work. 

 E-commerce increases the productivity of organizations. It supports "pull" type 
supply management. In "pull" type supply management, a business process starts 
when a request comes from a customer and it uses just-in-time manufacturing 
way. 

 

Advantages to Customers 
 It provides 24x7 support. Customers can enquire about a product or service and 

place orders anytime, anywhere from any location. 
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 E-commerce application provides users with more options and quicker delivery of 
products. 

 E-commerce application provides users with more options to compare and select 
the cheaper and better options. 

 A customer can put review comments about a product and can see what others 
are buying, or see the review comments of other customers before making a final 
purchase. 

 E-commerce provides options of virtual auctions. 

 It provides readily available information. A customer can see the relevant detailed 
information within seconds, rather than waiting for days or weeks. 

 E-Commerce increases the competition among organizations and as a result, 
organizations provides substantial discounts to customers. 

 

Advantages to Society 
 Customers need not travel to shop a product, thus less traffic on road and low air 

pollution. 

 E-commerce helps in reducing the cost of products, so less affluent people can 
also afford the products. 

 E-commerce has enabled rural areas to access services and products, which are 
otherwise not available to them. 

 E-commerce helps the government to deliver public services such as healthcare, 
education, social services at a reduced cost and in an improved manner. 

 

E-commerce disadvantages 
The disadvantages of e-commerce can be broadly classified into two major categories − 

 Technical disadvantages 

 Non-Technical disadvantages 
Technical Disadvantages 

 There can be lack of system security, reliability or standards owing to poor 
implementation of e-commerce. 

 The software development industry is still evolving and keeps changing rapidly. 
 In many countries, network bandwidth might cause an issue. 
 Special types of web servers or other software might be required by the vendor, 

setting the e-commerce environment apart from network servers. 
 Sometimes, it becomes difficult to integrate an e-commerce software or website 

with existing applications or databases. 
 There could be software/hardware compatibility issues, as some e-commerce 

software may be incompatible with some operating system or any other 
component. 

 
Non-Technical Disadvantages 

 Initial cost − The cost of creating/building an e-commerce application in-house 
may be very high. There could be delays in launching an e-Commerce application 
due to mistakes, and lack of experience. 
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 User resistance − Users may not trust the site being an unknown faceless seller. 
Such mistrust makes it difficult to convince traditional users to switch from 
physical stores to online/virtual stores. 

 Security/ Privacy − It is difficult to ensure the security or privacy on online 
transactions. 

 Lack of touch or feel of products during online shopping is a drawback. 
 E-commerce applications are still evolving and changing rapidly. 
 Internet access is still not cheaper and is inconvenient to use for many potential 

customers, for example, those living in remote villages. 

E-Commerce - Business Models 
E-commerce business models can generally be categorized into the following categories. 

1. Business - to - Business (B2B) 
2. Business - to - Consumer (B2C) 
3. Consumer - to - Consumer (C2C) 
4. Consumer - to - Business (C2B) 
5. Business - to - Government (B2G) 
6. Government - to - Business (G2B) 
7. Government - to - Citizen (G2C) 

Business - to - Business 
A website following the B2B business model sells its products to an intermediate buyer 
who then sells the product to the final customer. As an example, a wholesaler places an 
order from a company's website and after receiving the consignment, sells the 
endproduct to the final customer who comes to buy the product at one of its retail 
outlets. 
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Business - to - Consumer 
A website following the B2C business model sells its products directly to a customer. A 
customer can view the products shown on the website. The customer can choose a 
product and order the same. The website will then send a notification to the business 
organization via email and the organization will dispatch the product/goods to the 
customer. 

 
Consumer - to - Consumer 
A website following the C2C business model helps consumers to sell their assets like 
residential property, cars, motorcycles, etc., or rent a room by publishing their 
information on the website. Website may or may not charge the consumer for its services. 
Another consumer may opt to buy the product of the first customer by viewing the 
post/advertisement on the website. 

 
Consumer - to - Business 
In this model, a consumer approaches a website showing multiple business organizations 
for a particular service. The consumer places an estimate of amount he/she wants to 
spend for a particular service. For example, the comparison of interest rates of personal 
loan/car loan provided by various banks via websites. A business organization who fulfills 
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the consumer's requirement within the specified budget, approaches the customer and 
provides its services. 

 
Business - to - Government 
B2G model is a variant of B2B model. Such websites are used by governments to trade 
and exchange information with various business organizations. Such websites are 
accredited by the government and provide a medium to businesses to submit application 
forms to the government. 

 
Government - to - Business 
Governments use B2G model websites to approach business organizations. Such websites 
support auctions, tenders, and application submission functionalities. 

 
Government - to - Citizen 
Governments use G2C model websites to approach citizen in general. Such websites 
support auctions of vehicles, machinery, or any other material. Such website also provides 
services like registration for birth, marriage or death certificates. The main objective of 
G2C websites is to reduce the average time for fulfilling citizen’s requests for various 
government services. 
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E-Commerce - Payment Systems 
E-commerce sites use electronic payment, where electronic payment refers to paperless 
monetary transactions. Electronic payment has revolutionized the business processing by 
reducing the paperwork, transaction costs, and labor cost. Being user friendly and less 
time-consuming than manual processing, it helps business organization to expand its 
market reach/expansion. Listed below are some of the modes of electronic payments − 
1. Credit Card 
2. Debit Card 
3. Smart Card 
4. E-Money 
5. Electronic Fund Transfer (EFT) 

 

1. Credit Card 
Payment using credit card is one of most common mode of electronic payment. Credit 
card is small plastic card with a unique number attached with an account. It has also a 
magnetic strip embedded in it which is used to read credit card via card readers. When a 
customer purchases a product via credit card, credit card issuer bank pays on behalf of 
the customer and customer has a certain time period after which he/she can pay the 
credit card bill. It is usually credit card monthly payment cycle. Following are the actors in 
the credit card system. 

 The card holder − Customer 

 The merchant − seller of product who can accept credit card payments. 

 The card issuer bank − card holder's bank 

 The acquirer bank − the merchant's bank 

 The card brand − for example , visa or Mastercard. 
Credit Card Payment Process 

Step Description 

Step 1 Bank issues and activates a credit card to the customer on his/her request. 

Step 2 The customer presents the credit card information to the merchant site or 
to the merchant from whom he/she wants to purchase a product/service. 

Step 3 Merchant validates the customer's identity by asking for approval from the 
card brand company. 

Step 4 Card brand company authenticates the credit card and pays the 
transaction by credit. Merchant keeps the sales slip. 

Step 5 Merchant submits the sales slip to acquirer banks and gets the service 
charges paid to him/her. 

Step 6 Acquirer bank requests the card brand company to clear the credit amount 
and gets the payment. 
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Step 6 Now the card brand company asks to clear the amount from the issuer 
bank and the amount gets transferred to the card brand company. 

 

2.Debit Card 
Debit card, like credit card, is a small plastic card with a unique number mapped with the 
bank account number. It is required to have a bank account before getting a debit card 
from the bank. The major difference between a debit card and a credit card is that in 
case of payment through debit card, the amount gets deducted from the card's bank 
account immediately and there should be sufficient balance in the bank account for the 
transaction to get completed; whereas in case of a credit card transaction, there is no 
such compulsion. 
 
Debit cards free the customer to carry cash and cheques. Even merchants accept a debit 
card readily. Having a restriction on the amount that can be withdrawn in a day using a 
debit card helps the customer to keep a check on his/her spending. 
 

3.Smart Card 
Smart card is again similar to a credit card or a debit card in appearance, but it has a 
small microprocessor chip embedded in it. It has the capacity to store a customer’s work-
related and/or personal information. Smart cards are also used to store money and the 
amount gets deducted after every transaction. 
 
Smart cards can only be accessed using a PIN that every customer is assigned with. Smart 
cards are secure, as they store information in encrypted format and are less 
expensive/provides faster processing. Mondex and Visa Cash cards are examples of smart 
cards. 
 

E-Money 
E-Money transactions refer to situation where payment is done over the network and the 
amount gets transferred from one financial body to another financial body without any 
involvement of a middleman. E-money transactions are faster, convenient, and saves a 
lot of time. 
 
Online payments done via credit cards, debit cards, or smart cards are examples of 
emoney transactions. Another popular example is e-cash. In case of e-cash, both 
customer and merchant have to sign up with the bank or company issuing e-cash. 
 

Electronic Fund Transfer 
It is a very popular electronic payment method to transfer money from one bank account 
to another bank account. Accounts can be in the same bank or different banks. Fund 
transfer can be done using ATM (Automated Teller Machine) or using a computer. 
 
Nowadays, internet-based EFT is getting popular. In this case, a customer uses the 
website provided by the bank, logs in to the bank's website and registers another bank 
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account. He/she then places a request to transfer certain amount to that account. 
Customer's bank transfers the amount to other account if it is in the same bank, 
otherwise the transfer request is forwarded to an ACH (Automated Clearing House) to 
transfer the amount to other account and the amount is deducted from the customer's 
account. Once the amount is transferred to other account, the customer is notified of the 
fund transfer by the bank. 

E-Commerce - Security Systems 
Security is an essential part of any transaction that takes place over the internet. 
Customers will lose his/her faith in e-business if its security is compromised. Following 
are the essential requirements for safe e-payments/transactions − 

 Confidentiality − Information should not be accessible to an unauthorized person. 
It should not be intercepted during the transmission. 

 Integrity − Information should not be altered during its transmission over the 
network. 

 Availability − Information should be available wherever and whenever required 
within a time limit specified. 

 Authenticity − There should be a mechanism to authenticate a user before giving 
him/her an access to the required information. 

 Non-Repudiability − It is the protection against the denial of order or denial of 
payment. Once a sender sends a message, the sender should not be able to deny 
sending the message. Similarly, the recipient of message should not be able to 
deny the receipt. 

 Encryption − Information should be encrypted and decrypted only by an 
authorized user. 

 Auditability − Data should be recorded in such a way that it can be audited for 
integrity requirements. 

Measures to ensure Security 
Major security measures are following − 

 Encryption − It is a very effective and practical way to safeguard the data being 
transmitted over the network. Sender of the information encrypts the data using 
a secret code and only the specified receiver can decrypt the data using the same 
or a different secret code. 

 Digital Signature − Digital signature ensures the authenticity of the information. A 
digital signature is an e-signature authenticated through encryption and 
password. 

 Security Certificates − Security certificate is a unique digital id used to verify the 
identity of an individual website or user. 

Security Protocols in Internet 
We will discuss here some of the popular protocols used over the internet to ensure 
secured online transactions. 

Secure Socket Layer (SSL) 
It is the most commonly used protocol and is widely used across the industry. It meets 
following security requirements − 

 Authentication 
 Encryption 
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 Integrity 
 Non-reputability 

"https://" is to be used for HTTP urls with SSL, where as "http:/" is to be used for HTTP 
urls without SSL. 

Secure Hypertext Transfer Protocol (SHTTP) 
SHTTP extends the HTTP internet protocol with public key encryption, authentication, 
and digital signature over the internet. Secure HTTP supports multiple security 
mechanism, providing security to the end-users. SHTTP works by negotiating encryption 
scheme types used between the client and the server. 

Secure Electronic Transaction 
It is a secure protocol developed by MasterCard and Visa in collaboration. Theoretically, 
it is the best security protocol. It has the following components − 

 Card Holder's Digital Wallet Software − Digital Wallet allows the card holder to 
make secure purchases online via point and click interface. 

 Merchant Software − This software helps merchants to communicate with 
potential customers and financial institutions in a secure manner. 

 Payment Gateway Server Software − Payment gateway provides automatic and 
standard payment process. It supports the process for merchant's certificate 
request. 

 Certificate Authority Software − This software is used by financial institutions to 
issue digital certificates to card holders and merchants, and to enable them to 
register their account agreements for secure electronic commerce. 

 
 

E-Commerce - B2B Model 
A website following the B2B business model sells its products to an intermediate buyer 
who then sells the products to the final customer. As an example, a wholesaler places an 
order from a company's website and after receiving the consignment, it sells the 
endproduct to the final customer who comes to buy the product at the wholesaler's retail 
outlet. 
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B2B identifies both the seller as well as the buyer as business entities. B2B covers a large 
number of applications, which enables business to form relationships with their 
distributors, re-sellers, suppliers, etc. Following are the leading items in B2B eCommerce. 

 Electronics 
 Shipping and Warehousing 
 Motor Vehicles 
 Petrochemicals 
 Paper 
 Office products 
 Food 
 Agriculture 

Key Technologies 
Following are the key technologies used in B2B e-commerce − 

 Electronic Data Interchange (EDI) − EDI is an inter-organizational exchange of 
business documents in a structured and machine processable format. 

 Internet − Internet represents the World Wide Web or the network of networks 
connecting computers across the world. 

 Intranet − Intranet represents a dedicated network of computers within a single 
organization. 

 Extranet − Extranet represents a network where the outside business partners, 
suppliers, or customers can have a limited access to a portion of enterprise 
intranet/network. 

 Back-End Information System Integration − Back-end information systems are 
database management systems used to manage the business data. 

Architectural Models 
Following are the architectural models in B2B e-commerce − 
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 Supplier Oriented marketplace − In this type of model, a common marketplace 
provided by supplier is used by both individual customers as well as business 
users. A supplier offers an e-stores for sales promotion. 

 Buyer Oriented marketplace − In this type of model, buyer has his/her own market 
place or e-market. He invites suppliers to bid on product's catalog. A Buyer 
company opens a bidding site. 

 Intermediary Oriented marketplace − In this type of model, an intermediary 
company runs a market place where business buyers and sellers can transact with 
each other. 

E-Commerce - B2C Model 
In B2C model, a business website is a place where all the transactions take place directly 
between a business organization and a consumer. 

 
In the B2C model, a consumer goes to the website, selects a catalog, orders the catalog, 
and an email is sent to the business organization. After receiving the order, goods are 
dispatched to the customer. Following are the key features of the B2C model − 

 Heavy advertising required to attract customers. 
 High investments in terms of hardware/software. 
 Support or good customer care service. 

Consumer Shopping Procedure 
Following are the steps used in B2C e-commerce − 
A consumer − 

 determines the requirement. 
 searches available items on the website meeting the requirment. 
 compares similar items for price, delivery date or any other terms. 
 places the order. 
 pays the bill. 
 receives the delivered item and review/inspect them. 
 consults the vendor to get after service support or returns the product if not 

satisfied with the delivered product. 
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Disintermediation and Re-intermediation 
In traditional commerce, there are intermediating agents like wholesalers, distributors, 
and retailers between the manufacturer and the consumer. In B2C websites, a 
manufacturer can sell its products directly to potential consumers. This process of 
removal of business layers responsible for intermediary functions is 
called disintermediation. 

 
Nowadays, new electronic intermediary breeds such as e-mall and product selection 
agents are emerging. This process of shifting of business layers responsible for 
intermediary functions from traditional to electronic mediums is called re-
intermediation. 
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Module 12: Graphics Design 

Lesson 1: Intro to Graphic Design 
1.1 Typography 
Typography is everywhere we look. It's in the books we read, on the websites we visit, 
even in everyday life—on street signs, bumper stickers, and product packaging. 

 
But what exactly is typography? Simply put, typography is the style or appearance of 
text. It can also refer to the art of working with text—something you probably do all the 
time if you create documents or other projects for work, school, or yourself. 
Common types of fonts 
Typography can be an intimidating subject, but it doesn't have to be. You only need to 
know a little to make a big difference in the stuff you do every day. So let's get started. 
First, some common types of fonts and what you need to know about them. 
Serif fonts 
Serif fonts have little strokes called serifs attached to the main part of the letter. 
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Because of their classic look, they're a good choice for more traditional projects. They're 
also common in print publications, like magazines and newspapers. 

 
Sans serif fonts 
Sans serif fonts don't have that extra stroke—hence the name, which is French 
for without serif. 
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This style is considered more clean and modern than serif fonts. Also, it tends to be 
easier to read on computer screens, including smartphones and tablets. 

 
Display fonts 
Display fonts come in many different styles, like script, blackletter, all caps, and just plain 
fancy. 

 
Because of their decorative nature, display fonts are best for small amounts of text, like 
titles and headers and more graphic-heavy designs. 
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Choosing a font 
In a way, fonts have their own language. They all have something to say beyond the 
words on the page. They can come across as casual or neutral, exotic or graphic. That's 
why it's important to think about your message, then choose a font that fits. 

 
Fonts to avoid 
Some fonts come with extra baggage, including Comic Sans, Curlz, and Papyrus. There's 
nothing particularly wrong with these fonts—they just have a certain reputation for 
being outdated and overused. 
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If you find yourself tempted by them, think twice and consider using something else. 
There are many fonts with a similar look and feel that are less likely to detract from your 
message. 
Combining fonts 
When deciding which fonts to use, less is more. It's best to limit yourself to one or two 
per project. If you need more contrast, try repeating one of your fonts in a different size, 
weight, or style. This trick is practically foolproof for creating interesting combinations 
that work. 

 
You've probably heard that opposites attract. The same is true for fonts. Don't be afraid 
to combine font styles that are different but complementary, like sans serif with serif, 
short with tall, or decorative with simple. This can be challenging at first, but don't 
despair. Look to other designs for inspiration, and soon you'll get the hang of it. 
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Other important terms 
Maybe you've heard terms like kerning, leading, tracking, and hierarchy. For those with 
more experience, these concepts are essential for creating professional-looking designs. 
As a beginner, you don't need to know everything about these terms—just enough to 
inform your work and help you talk about design with more confidence. 

 
Hierarchy 
Hierarchy is used to guide the reader's eye to whatever is most important. In other 
words, it shows them where to begin and where to go next using different levels of 
emphasis. 
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Establishing hierarchy is simple: Just decide which elements you want the reader to 
notice first, then make them stand out. High-level items are usually larger, bolder, or 
different in some way. Remember to keep it simple and stick to just a few 
complementary styles. 

 
Leading 
Leading (rhymes with wedding) is the space between lines of text, also known as line 
spacing. 
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If you're not sure how much line spacing to use, don't fret—the default is usually fine. 
The goal is to make your text as comfortable to read as possible. Too much or too little 
spacing, as in the example below, can make things unpleasant for the reader. 

 
Tracking 
Tracking is the overall space between characters, sometimes called character spacing. 
Most programs let you condense or expand this depending on your needs. 
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In some designs, you might adjust your tracking to create a certain artistic effect. It can 
also help you fix fonts that are poorly spaced to begin with. 

 
Kerning 
Kerning is the space between specific characters. Unlike tracking, it varies over the 
course of the word because each letter fits together differently. 

 
Some fonts have what we call bad kerning, making certain letters look improperly 
spaced. If a font you're using has bad kerning, it's best to cut your losses and choose 
something else. 

 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1241 | 1352  

Putting it all together 
Well-crafted text can mean the difference between something ordinary and something 
extraordinary—even if you're just getting started with design. All it takes is an interest in 
typography and you'll start to notice more, see more, and be able to do more in your 
own work. 

 
 

Lesson 2: Color 
The power of color 
Color plays a vital role in design and everyday life. It can draw your eye to an image. 
Sometimes it can trigger an emotional response. It can even communicate something 
important without using words at all. 

 
So how do we know which colors look good together and which ones don't? The answer 
is simple: Color theory. 
Artists and designers have followed color theory for centuries, but anyone can learn 
more about it. It can help you feel confident in many different situations, whether 
it's choosing colors for a design or putting together the perfect outfit. With a little 
insight, you'll be looking at color in a whole new way. 
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Color basics 
Let's start at the beginning with a refresher on the basics. Remember learning 
about primary and secondary colors in school? Then you already have some knowledge 
of color theory. 

 
Secondary colors are created by combining two primary colors. Red and yellow make 
orange; yellow and blue make green; and blue and red make purple. 

 
If we mix these colors together, we get even more in-between shades, like red-orange 
and yellow-green. All together, they form what's called a color wheel. (You can probably 
see where it gets its name.) 
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A closer look 
Now that you know about the color wheel, let's take it one step further 
with hue, saturation, and value. These are terms you might not encounter in daily life, 
but they're the key to understanding more nuanced colors—like all those little paint 
chips at the home improvement store. 

 
Hue 
Hue is the easiest one; it's basically just another word for color. In the example below, 
you might describe the hue as coral pink or light red, depending on your interpretation. 

 
Saturation 
Saturation refers to intensity—in other words, whether the color appears more subtle or 
more vibrant. Highly saturated colors are brighter or richer. Desaturated colors have less 
pigment and therefore less oomph. 
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Value 
Value has to do with how dark or light the color is, ranging from black to white. As you 
can see below, this gives us many different shades, from a deep reddish brown to a light 
pastel pink. 

 
Creating color schemes 
So how do we put this all together to create professional-looking color schemes? There 
are actually tried-and-true formulas based on something called color harmony that can 
help. 
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Color harmony uses the color wheel to illustrate time-tested color combinations. We'll 
explore some of the most common types of harmony below. 
Monochromatic 
The easiest formula for harmony is monochromatic because it only uses one 
color or hue. To create a monochromatic color scheme, pick a spot on the color wheel, 
then use your knowledge of saturation and value to create variations. 

 
The best thing about monochromatic color schemes is that they're guaranteed to match. 
The colors suit each other perfectly because they're all from the same family. 
Analogous 
An analogous color scheme uses colors that are next to each other on the wheel, like 
reds and oranges or blues and greens. 
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Don't be afraid to play with the palette and create your own unique interpretation. 
That's what color harmony is all about; the formulas are merely starting points to help 
guide and inspire you. 

 
 
Complementary 
Complementary colors are opposite each other on the wheel; for instance, blue and 
orange or the classic red and green. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1247 | 1352  

 
To avoid complementary color schemes that are too simplistic, add some variety by 
introducing lighter, darker, or desaturated tones. 

 
Split-complementary 
A split-complementary color scheme uses the colors on either side of the complement. 

 
This gives you the same level of contrast as a complementary color scheme but more 
colors to work with (and potentially more interesting results). 
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Triadic 
A triadic color scheme uses three colors that are evenly spaced, forming a 
perfect triangle on the wheel. 

 
These combinations tend to be pretty striking—especially when they 
include primary or secondary colors—so be mindful when using them in your work. 
Tetradic 
Tetradic color schemes form a rectangle on the wheel, using not one but two 
complementary color pairs. This formula works best if you let one color dominate while 
the others serve as an accent. 

 
Avoiding common mistakes 
There are a few classic dos and don'ts when it comes to color. For instance, have you 
ever seen colors that seem to vibrate when they're placed next to each other? 
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The solution is to tone it down—literally—and there's a simple way do it. Start with one 
color, and try adjusting its lightness, darkness, or saturation. Sometimes a little contrast 
is all your color palette needs. 

 
Readability is an important factor in any design. Your colors should be legible and easy 
on the eyes, especially when working with text. 
Sometimes that means NOT using color—at least not in every little detail. 

 
Neutral colors like black, white, and gray can help you balance your design, so when 
you do use color, it really stands out. 
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Choosing the right colors 
Every color sends a message. It's important to consider the tone of your project, and 
choose a color palette that fits. 
For example, bright colors tend to have a fun or modern vibe. 

 
Desaturated colors often appear more serious or businesslike. 

 
Sometimes it just depends on the context. With practice and creativity, there's no limit 
to what you can do. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1251 | 1352  

 
Finding inspiration 
You can find ideas for color schemes in all kinds of interesting places, from advertising 
and branding to famous works of art. 

 
You can even use a web resource to browse color palettes or generate your own. 
Experienced designers often take inspiration from the world around them. There's 
nothing wrong with finding something you like and making it your own. 
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Putting it all together 
Everywhere you look, there's color, color, and more color. It can be intimidating to use it 
in your work, but it doesn't have to be. Just keep experimenting, and remember what 
you've learned about color theory. Soon, choosing great-looking colors will feel like 
second nature. 

 
 

Lesson 3: Layout and Composition 
What is composition? 
In many ways, layout and composition are the building blocks of design. They give your 
work structure and make it easier to navigate, from the margins on the sides to the 
content in between. 

 
Why is composition so important? In short, it's the way your content is arranged. It 
doesn't matter if you're working with text, images, or elements in a graphic; without a 
thoughtful, well-composed layout, your work would basically fall apart. 
Watch the video below to learn more about layout and composition. 
Five basic principles 
The key to mastering layout and composition is to think like a designer. Luckily, it's easier 
than it sounds. There are five basic principles that can help you transform your work and 
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sharpen your eye for design. Keep them in mind during your next project, and look for 
ways to apply them. 

 
Proximity 
Proximity is all about using visual space to show relationships in your content. In 
practice, it's pretty simple—all you have to do is make sure related items are grouped 
together (for instance, blocks of text or elements in a graphic, as in the example below). 

 
Groups that are NOT related to each other should be separated to visually emphasize 
their lack of a relationship. All in all, this makes your work easier to understand at a 
glance, whether it's purely text or something more visual. 
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White space 
White space is an important part of every composition. Now, this doesn't mean 
literal white space; it just means negative space, like the spaces between your content, 
between lines, and even the outer margins. 

 
There's no one way to use white space correctly, but it's good to understand its purpose. 
White space helps you define and separate different sections; it gives your content room 
to breathe. If your work ever starts to feel cluttered or uncomfortable, a little white 
space might be just what the doctor ordered. 
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Alignment 
Alignment is something you deal with all the time, even if you don't realize it. Whenever 
you type an email or create a document, the text is aligned automatically. 

 
When aligning objects by yourself (for instance, images or separate text boxes), getting it 
right can be tricky. The most important thing is to be consistent. 
It might help to imagine your content arranged inside of a grid, just like the example 
below. Notice how there's an invisible line centering each image to the text? Each 
grouping is also evenly spaced and aligned, with equal-sized margins. 
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It's this attention to detail that makes the composition easier to navigate. Without 
consistent alignment, your work could start to feel disorganized. 
Contrast 
Contrast simply means that one item is different from another. In layout and 
composition, contrast can help you do many things, like catch the reader's eye, create 
emphasis, or call attention to something important. 
To create contrast in the example below, we've used color, more than one style of text, 
and objects of differing sizes. This makes the design more dynamic and, therefore, more 
effective at communicating its message. 
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Hierarchy 
Contrast is also closely tied to hierarchy, which is a visual technique that can help the 
viewer navigate your work. In other words, it shows them where to begin and where to 
go next using different levels of emphasis. 

 
Establishing hierarchy is simple: Just decide which elements you want the reader to 
notice first, then make them stand out. High-level or important items are usually larger, 
bolder, or more eye-catching in some way. 

 
Repetition 
Repetition is a reminder that every project should have a consistent look and feel. This 
means finding ways to reinforce your design by repeating or echoing certain elements. 
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For instance, if you have a specific color palette, look for ways to carry it through. If 
you've chosen a special header style, use it every time. 

 
It's not just for aesthetic reasons—being consistent can also make your work easier to 
read. When viewers know what to expect, they can relax and focus on the content. 
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Putting it all together 
You might say layout and composition are the unsung heroes of design. It's easy to 
overlook their role, but they're part of everything you do. 

 
The principles you just learned can help you elevate any project. All it takes is a 
little attention to detail and you can create beautiful, professional-looking compositions. 
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Lesson 4: Images 
The power of images 
Images can be a powerful force in design. No matter what the subject, we're naturally 
drawn to them. From beautiful, high-definition photos to carefully crafted graphics, 
they're usually the first thing we see. 

 
However, images aren't just for decoration. In design, they're the hook that draws the 
viewer in. Compelling visuals can help you connect with the audience—and make a 
strong impression—before they've even read a single word. 
Finding images 
You don't have to be an artist to use images in your work. All it takes is a little creativity 
and a willingness to think outside the box. With the right resources, you can learn to set 
your designs apart. First: finding high-quality images for almost any type of project. 
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Using stock 
Maybe you're handy with a camera or have some graphic design experience—that's 
great! If not, don't panic. There are countless online sources that offer images for exactly 
this purpose. 

 
The truth is, most people (including professionals) rely on free or low-cost images 
called stock. Stock is perfect when you need something specific—for example, a photo of 
a tiny dog in a teacup—and you don't have the time or resources to create it yourself. 
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Choosing effective stock 
Most stock image sites let you browse or search their offerings. Look for results that 
are relevant to your project, but also unique in some way. 

 
In this example, we've searched for the word travel. The image below would be a fine 
choice because it subtly illustrates the concept but has a personal feel. 
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As viewers, we're are naturally drawn to images that feel authentic, like distinct but 
believable photos and graphics that tell a story. The best images are somewhat open 
ended. They set the tone for your project but leave room for interpretation. 

 

 
Some stock images are just too generic to be effective. For instance, how many times 
have you seen a business presentation with something like the graphic below? 
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For a more modern, professional design, avoid images that lack context or are too literal 
in meaning. Instead, look for imagery that's connected to your work, but in a 
more subtle, relatable way. 

 
Image usage rights 
Almost every stock image has a license that states how it can be used. Some are very 
generous and ask for little or nothing in return. Others are more restrictive and can have 
serious legal ramifications if disobeyed. 
Before you use a stock image, make sure you understand the license associated with it 
(you might need to do some research if it isn't clearly explained).  
The importance of quality 
Of course, it's not just about content. There's also a technical side to images, which can 
have a big impact on your design. It doesn't matter if the photo you've chosen is 
absolutely perfect in every other way. If it's blurry or pixelated, it could give the wrong 
impression. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1265 | 1352  

 
Look for high-quality images that are sharp, clear, and free of distortion. In 
general, bigger is better, because it gives you more to work with. A large, high-resolution 
image can always be cropped or sized down, depending on the needs of the project. 

 
Unfortunately, it doesn't work the other way around. If you enlarge a small image—in 
other words, make it bigger than its original size—there will be a noticeable loss in 
quality. The image will become blurry and/or distorted, as in the example below. 

 
Raster vs. vector 
There's a reason small images lose quality when you enlarge them. It's because they're 
made up of thousands—sometimes even millions—of tiny little pixels. The word for this 
type of image is raster. 
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When you view a raster image at its original size or smaller, the pixels are invisible—
they're just too small to see. They only become apparent when you zoom in or make the 
image larger. 

 
Vector graphics are quite different from raster. You can make them any size, big or small, 
without losing quality. In the example below, the image has been enlarged, but there's 
no pixelation—not even a little bit. 
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That's because vectors are made of something more complex than pixels. They're 
rendered using a special form of geometry. You're not likely to find vector graphics 
outside of professional design settings, but it's good to know what they are. 

 
Editing images 
Few stock images are perfect as is, even if they're technically high-quality ones. Maybe 
the image is the wrong size or the colors could use some work. Fortunately, even basic 
programs let you make simple adjustments. Look for these options the next time you 
need to fix or enhance an image. 

 
For a closer look at image editing, read our Image Editing 101 tutorial. 

http://www.gcflearnfree.org/imageediting101/
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Cropping 
Cropping can be used to change the size, shape, or focus of an image, making it useful in 
many different situations. 

 
Try this feature if your graphic is the wrong dimensions, or if it includes something you'd 
rather cut out. 

 
Resizing 
Resizing an image will ensure it's the perfect fit for your project. Just remember that you 
can't make an image bigger than its original size without affecting its quality. 
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If the image you're working with simply isn't big enough, it's best to choose something 
else. You can also find a creative way to work with the image size you have. In the 
example below, we've added a background image instead of enlarging the portrait. 

 
Other adjustments 
Cosmetic adjustments let you enhance certain image qualities, including brightness, 
contrast, saturation, and color. 
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If your favorite program offers filters or presets, you can change your image dramatically 
with very little time and effort. 

 
Putting it all together 
Adding photos, graphics, and other visuals to your work is a great way to make it more 
engaging. Even a simple background image can transform your design into something 
special. 
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Just remember what you've learned about image quality—both technical and 
conceptual—and your work is sure to stand out for the right reasons. 

 
 

Lesson 5: Fundamentals of Design 
The basis of art, design, and more 
The fundamentals of design are the foundation of every visual medium, from fine art to 
modern web design. They're even present in seemingly unimportant details, like the 
fonts that make up most compositions. 
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What do these examples have in common? Some very basic elements, 
including line, shape, form, texture, and balance. They might not seem like much on 
their own, but together, they're part of almost everything we see and create. 

 
The fundamentals can be intimidating at first, especially if you don't consider yourself an 
artist. But keep an open mind—there's a lot they can teach you about working with 
different assets and creating simple visuals from scratch. 
Line 
A line is a shape that connects two or more points. It can be fat, thin, wavy, or jagged—
the list goes on. Every possibility gives the line a slightly different feel. 
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Lines appear frequently in design; for example, in drawings and illustrations. They're also 
common in graphic elements, like textures, patterns, and backgrounds. 

 
Lines can be used in more humble compositions, too—for organization, emphasis, or just 
decoration. In the example below, lines have been used to create a flow chart that guides 
the reader's eye from one element to the next. 
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When working with lines, pay attention to things like weight, color, texture, and style. 
These subtle qualities can have a big impact on the way your design is perceived. 

 
Look for places where lines are hiding in plain sight; for example, in text. Even here, 
experimenting with different line qualities can give you very different results. 
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Shape 
A shape is any two-dimensional area with a recognizable boundary. This includes circles, 
squares, triangles, and so on. 

 
Shapes fall into two distinct categories: geometric (or regular) and organic (where the 
shapes are more free form). 
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Shapes are a vital part of communicating ideas visually. They give images heft and make 
them recognizable. We understand street signs, symbols, and even abstract art largely 
because of shapes. 

 
Shapes have a surprising number of uses in everyday design. They can help you organize 
or separate content, create simple illustrations, or just add interest to your work. See if 
you can spot the many examples in the image below. 
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Shapes are important because they're the foundation of so many things. Learn to look 
for them in other designs, and soon you'll start seeing them everywhere. 

 
Form 
When a shape becomes 3D, we call it a form. Forms make up a variety of things in the 
real world, including sculptures, architecture, and other three-dimensional objects. 
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However, forms don't have to be three-dimensional shapes. They can also be implied 
through illustration, using techniques like light, shadow, and perspective to create the 
illusion of depth. 

 
In two-dimensional design, form makes realism possible. Without it, renderings like the 
image below—a ball with highlights and shading—simply wouldn't be the same. 
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Even images that are less realistic use similar techniques to create dimension. Below, the 
lighting and shading are stylized, but still hint at form and depth. 

 
In everyday composition, the purpose of form is the same, but on a smaller scale. For 
example, a simple shadow can create the illusion of layers or give an object a sense of 
place. 
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Basic forms can bring a touch of realism to your work, which is a powerful tool when 
used in moderation. 
Texture 
Texture is the physical quality of a surface. Like form, it can be part of a three-
dimensional object, as in the example below (a small prickly cactus in a shiny ceramic 
pot). 

 
Or it can be implied through illustration, suggesting that it would have texture if it existed 
in real life. 
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In design, texture adds depth and tactility to otherwise flat images. Objects can appear 
smooth, rough, hard, or soft, depending on the elements at play. 

 
For beginners, textures make great background images and can add a lot of interest to 
your work. Look closely, and you may find texture in unexpected places, like distressed 
fonts and smooth, glossy icons. 
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Just be careful not to go overboard—too much texture in a single design can quickly 
become overwhelming. 

 
Balance 
Balance is the equal distribution of visual weight (more specifically, how much any one 
element attracts the viewer's eye). Balance can be affected by many things, 
including color, size, number, and negative space. 
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Mastering balance can be tricky for beginners because it does take some intuition. 
Luckily, the design world is full of examples that can help you understand its different 
iterations. 

 
Symmetrical designs are the same or similar on both sides of an axis. They feel balanced 
because each side is effectively the same (if not identical). 
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Asymmetrical designs are different, but the weight is still evenly distributed. The 
composition is balanced because it calls attention to the right things (in this example, the 
person's name and company logo). 

 
The rule of thirds 
Many people, including designers and photographers, use a strategy called the rule of 
thirds. This imagines your work area divided into a 3x3 grid. The focal point of the image 
is placed on or near one of the grid lines, creating visual balance with the rest of the 
space. 
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We find this type of composition appealing because, according to studies, the human 
eye naturally follows this path when scanning a design. 

 
Putting it all together 
The fundamentals of design are all about the bigger picture—in other words, learning to 
appreciate the many small details that make up every composition. 
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This insight can be applied to almost any type of project, whether you're creating your 
own graphics or just looking for simple ways to enhance your work. 

 
 

Lesson 6: Branding and Identity 
Influencing through design 
Branding and visual identity are all around us. Look closely, and you'll find them on 
websites, product packaging, and different types of advertising. Even personal items, like 
documents and business cards, bear some form of identity. 
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Simply put, branding is what other people think—about you, your company, your 
product, or your service. Visual identity is what that brand looks like, from your logo to 
your color choices and so much more. 

 
Strong visuals can be very persuasive. Think of your own experiences as a consumer. 
Have you ever chosen a product simply because you liked the way it looked? 
Understanding visual identity can help you make more thoughtful design decisions, 
regardless of your role, medium, or skill level. 
A closer look at visual identity 
Visual identity is kind of like a preview of your brand. Each part of your design is a clue 
that tells the viewer what they can expect. Your aesthetic can be traditional, modern, or 
a little more out there—every brand is different. No matter what, all of your design 
elements work together to show exactly what your brand is about. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1288 | 1352  

 
Of course, it's not all business. You can apply the concept of identity to almost any type 
of project, including personal designs. Whether you're updating your resume or looking 
for ways to enhance your blog, there are many benefits to having a consistent visual 
style. 

 
Some companies use an actual style guide to keep their brand looking consistent. If 
you're just getting started with design, it's OK to take a more casual approach. 
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The main components of visual identity are logo, color, typography, and images. Read on 
to learn more. 
Logo 
A logo is what identifies your brand using a particular mark, type design, or both. The 
most effective logos tend to be fairly simple—something viewers will recognize and 
remember. 

 
Every element of your logo contributes to your brand identity, including your font 
choice, colors, and other imagery. Change even one of these elements, and it can have a 
big impact on the way your brand is perceived. 
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In practice, logos are everywhere. You'll find them in corporate settings, as well as out 
and about, representing small businesses, freelancers, and other entrepreneurs. A logo is 
a lot like a literal brand—it's how people come to recognize you and identify your 
product or service. 

 
That's why it's important to use it wisely. A logo that's pixelated, distorted, or too small 
to read could give viewers the wrong impression. Below, you'll find several examples of 
low-quality files. 
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To combat this, keep a master digital copy that's sharp, high in quality, and large enough 
for any project. This way, you're prepared for anything that might come along, whether 
it's a small print job or something much, much bigger. 

 
Color 
Color helps define your brand in a very powerful way. Not only does it make a strong 
impression on the viewer, but it also creates a sense of unity when used across multiple 
projects or platforms. 
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Most brands derive their main colors directly from the company logo. Additional colors 
can help you expand the main palette and further define your brand's personality and 
style. 

 
There are lots of ways to use brand colors. Just be careful not to go overboard or ignore 
widely accepted design standards. Good color use is all about moderation. 
Avoid common pitfalls, like colors that vibrate or distract viewers from your work. For 
instance, in the image below, the text clashes with the background, making it difficult to 
read. 
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Make sure to include neutrals in your color palette, like black, gray, white, or off-white. 
This way, when you do use your brand's colors, they really stand out. 

 
Typography 
Text is one of the simpler aspects of identity, but it can be surprisingly expressive. All it 
takes is a different font, and you can subtly (or not so subtly) change the entire feel of 
your brand. 
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Most brands choose two to three fonts—often inspired by the logo—for basic, everyday 
use. Creative fonts should also be chosen with care and should be a reflection of your 
unique visual identity. 

 
There are certain fonts that professionals know to avoid—fonts that were once popular 
but that are now considered outdated and overused. The fonts below are notorious 
examples. 
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When in doubt, a more timeless, understated font is less likely to detract from your 
message. Your font choice should complement your brand, but still be current and 
professional. 

 
Images 
Images are a huge part of building a unique identity. Every photo, graphic, icon, and 
button is a chance to showcase your brand and shape the way it's perceived. 
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In professional settings, images are usually created specifically for the brand; for 
instance, pictures in a catalog or graphics in an app. If you don't have the luxury of this, 
you can get similar results by choosing images with a subtle through line; for example, a 
signature color or similar style. 

 
Most importantly, avoid images that feel generic or obviously staged. This is difficult if 
you're relying on third-party stock, but there are ways to set your brand apart. 
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Avoid images that lack context or appear frequently in other brands' designs. Take the 
photo below. Some viewers might find it off-putting due to the forced pose and artificial 
background. 

 
Instead, choose images that seem genuine and that feature authentic people, places, and 
things. The best images are the embodiment of your unique point of view. They 
represent how you want to be seen when people think about your brand. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1298 | 1352  

 
Putting it all together 
Visual identity isn't just a marketing tool. It's a way of looking at design that removes a 
lot of the guesswork. With a clear vision of your brand, you know exactly what colors, 
fonts, and images to use. You can create consistent works that viewers will remember. 
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Module 13: ICT Legal Environment Awareness in 
Bangladesh (Short) 
 

OVERVIEW: 
The development of information and communications technologies (ICTs) enables 
businesses and individuals to communicate and transact with other parties electronically, 
instantaneously and internationally.  This  gives rise to  a  variety  of legal  and  regulatory  
issues for policymakers, from  the validity  of  electronic  methods of  contracting  and the 
security  risks inherent  in them,  to concerns over cybercrime  and the  ability  to protect  
intellectual  property rights online.  This guide examines distinguishes ICT legal issues into 
five distinct areas:  
•  Legal infrastructure, which  considers some  of  the key  legal  and  regulatory  facilitators 
for electronic  commerce, from  adherence  to  law  reform  principles such  as ‘technology 
neutrality’, to regulatory  structures and  market  liberalization.  
•  Legal  certainty, which  examines  the  legal status of electronic communications  and 
forms  of  contracting,  specifically  the  need  to  explicitly  recognize  the validity, 
enforceability  and admissibility  of electronic  means  of executing  legal  acts.  
•  Legal  security, which examines  the  security  risks inherent  in  an electronic  
environment and considers  the  methods used to  overcome  these, in  particular  the  use 
of  digital signatures  and certification services.  
•  Legal  protection, which reviews  intellectual  property  rights and  how  such  intangible 
property  is protected  in  an online  environment, as  well  as  the consumer protection 
issues  which  the Internet  raises.   
•  Legal  deterrence, which examines the  development of cybercrime and  the regulatory 
approaches to  criminalizing such  harmful  conduct and  ensuring that  law enforcement 
are  able  to investigate  and  prosecute offenders.   
Information Technologies have generated profound changes in human society.  These are 
quite different from social transformations caused by earlier scientific advances. The  
invention  of the  telegraph  in  the  early 19th  century  started the modern  Information 
&  Communication Technology  (ICT).  By  the  21st  Century  we  witness a  dramatic  new 
wave  of ICT,  leading  to massive  socio-economic  changes.  
 
Bangladesh has placed poverty alleviation on the top of its development agenda. It is here 
that ICT has a critical role to play.  It is for developing countries and especially the least  
developed among  them  to  seize  the  opportunity  and adopt  ICT  as a priority  tool  to  
fight  hunger, malnutrition, illiteracy, discrimination  against  women, children,  aged  and  
disabled.  The need to invest in ICT infrastructure and especially ICT human resources is 
paramount.  
 
The  ICT  sector  of  Bangladesh is  one  of  the  fastest  growing  sectors of  its  economy.  
ICT has been declared as the thrust sector by the Government.  A comprehensive  ICT  
Policy  has  been formulated and a  National  ICT  Task  Force, headed  by  the  Honorable  
Prime  Minister,  has been  formed. The Government  organization entrusted  for the 
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development  and  promotion  of the ICT  sector  is  the Ministry  of  Science  and  
Information  &  Communication  Technology.   Bangladesh  Computer  Council  (BCC),  the 
apex  body  for  promotion of  all  kinds  of  ICT activities  in  the  country,  works  under  
the  Ministry  of  Science  and  Information  & Communication  Technology. 
A Brief History of Security Awareness 
It comes as no surprise that the history of cybersecurity can be traced back to the 
appearance of the internet. Ever since the worldwide web began to percolate into 
mainstream society, cybercriminals have been coming up with innovative ways to take 
advantage of this. 
 
One of the first incidents of hacking took place in the early 1980s when a group of 
computer hackers known as the 414s (named after their Milwaukee area code) were 
arrested for breaking into more than 60 computer networks. These include the Memorial 
Sloan-Kettering Cancer Center and the Los Alamos National Laboratory. 
 
As hacking became increasingly challenging during this period, the Computer Fraud and 
Abuse Act was created to punish those who were caught victimizing computer systems. By 
the late 1980s, a unit called the Computer Emergency Response Team (CERT) was formed 
under the Computer Emergency Response Team (CERT) to investigate the growing volume 
of hacking on computer networks. 
 
Towards the end of the 1980s, Robert Morris released the historic Internet worm, which 
caused 10% of the internet to shut down (at the time). It was also possibly the first denial-
of-service (DoS) attack ever to appear on the internet. 
 
Though hacking from the 1980s was, for the most part, carried out by amateurs and 
hacking students, cybercrime took a more serious turn as the 1990s rolled by. By this time, 
cybercrime had not only increased in sophistication but notoriety. Hackers started to 
target government agencies and substantial corporate databases, such as Yahoo!, eBay, 
and Amazon. 
 
From the late 1990s to the beginning of the millennium, viruses, such as Melissa and 
ILOVEYOU, started making headlines for infecting more than 10 million personal 
computers and causing the failure of email systems around the world. These threats 
inevitably led to the development of antivirus technology and the growing importance of 
security awareness for computer users. 
ICT Policy of Bangladesh 
For  the  development  of  ICT  sector  within  the  framework  of  overall  national 
development,  the Government  has approved  the National  ICT  Policy  in  October  2002.   
The Vision of  this Policy  aims  at  building  an ICT-driven  nation comprising  of  knowledge-
based  society  by  the year  2006. In  view of  this, a  country-wide  ICT-infrastructure will  
be  developed  to  ensure access to  information  by  every  citizen  to  facilitate  
empowerment  of  people  and  enhance democratic  values and norms  for  sustainable 
economic  development  by  using  the infrastructure  for  human resources development,  
governance,  e-commerce,  banking,  public utility services  and  all sorts  of  on-line  ICT-
enabled  services.  A  comprehensive Action  Plan "Roadmap  for  ICT  Development"  and 
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Poverty  Reduction Strategic  Paper  (PRSP)  based on the ICT  Policy, 2002, Kualalampur  
and  Hyderabad  declaration  and  the Millennium Development Goals  is  under  
preparation. 
Intellectual Property Rights (Copyright) Law 
To  help  the ICT  sector  flourish in  the  country,  there is  a  need for  an  effective  legal 
framework. Timely and suitable legal reforms can create an ICT-friendly legal 
environment. Such an environment will help this sector grow by attracting investment.  
In  order  to  create such  a  legal  environment,  the  amendment  of  the  Copyright Act 
2000  incorporating  issues related to ICT is  in  the process of  finalization.  Bangladesh  is  
presently  signatory  to  two important  international  copyright  agreement/convention  
and is  presently  working  for upgrading  the  Intellectual  Property  Rights  (IPR)  Law in  
light  of  the  changing  needs.   
Law  on  Information  Technology  
To  create  a smooth  environment  for  e-Commerce and  to  safeguard the dealings  over 
the net and  to  check  the threat  to  computer  communication, the government  has 
drafted  the  ICT  law and  is  in  the  process of  enactment  by  the Parliament.  The  
Information Technology  (Electronic Transaction)  Act  will  provide  a  legal  framework  
that recognizes digital  signatures and other  electronic  documents  and  have  enough 
provisions  to check  cybercrimes,  which are not  covered by  any  existing  law of  the  
land.    The  draft  has been made  based  on  the  Model  Law on E-commerce  framed  in  
1996  by  the  United  Nations Commission on International  Trade  Law   (UNICITRAL).      
Challenges and Prospects of e-Governance     
The government  is  considering  aggressively  to  move into  e-governance  for  providing  
all needed  information  to  citizens  and  for  efficient  and  transparent services  and  to  
create  an information environment  and  enhance the efficiency, effectiveness, 
dynamism  in  public agencies  and  to  ensure  their  accountability.  Transformation  to  
e-Government  is  only  possible with  the  right governance  structure,  together  with  
the  political  will  to  drive  change  across  the whole  of  government  services  
encompassing  such  vital  sectors  as  Human  Services,  Justice & Public  Safety,  
Revenue,  Defense,  Education,  Transport  &  Motor Vehicles,  Regulation  & Democracy,  
Procurement  and Postal. 
ICT ACT 2006  
In order to facilitate e-commerce and promote the growth of information technology, 
the Information and Communication Technology Act (ICT) of 2006 of Bangladesh 
established provisions with a maximum penalty of up to 10 years imprisonment or a fine 
of up to 10 million taka or both. The ICT Act, 2006 as amended in 2013 is obviously quite 
a brilliant feat in the cyber law field of Bangladeh. 
 
In Bangladesh, the ICT Act, 2006 was enacted to prevent cybercrimes and regulates e-
commerce. Before this Act was enacted, the law applicable to cyber offences was the 
Penal Code, which was enacted long ago in 1860 when nobody even thought of 
computer technology or cyber crime. With the entry into force of the ICT Act, 2006, in 
order to meet the new requirements of cyber space crimes as well as c-commerce 
disputes, it becomes necessary to introduce certain consequential changes in certain 
provisions of the Penal Code, 1860 as well as in the Evidence Act, 1872. 
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What are the main offences in Bangladesh in regards to the Information Technology Law, 
Internet and ICT Act? 
 Some of the main offences are pointed out below that may arise out of Online Law / 
Internet Law in Bangladesh ICT Rules, Regulations and Rights in Bangladesh (not in any 
specific order.) 
 
Fake Electronic Publication 
 If any person intentionally publishes or transmits or causes to be published or 
transmitted on the website or in an electrical form any material which is false or obscene 
or which has the effect of tending to debase and corrupt persons, who are likely, having 
regard to all relevant circumstances, to read, see or hear the matter contained or 
embodied in it, or causes to deteriorate or creates possibility to deteriorate law and 
order, prejudice the image of the State or person or causes to hurt or may hurt religious 
belief or instigate against any person or organization, then this activity will be regarded 
as an offence. 

 Punishment for Fake Electronic Publication 
 Anyone who commits the offense of electrically publishing false, obscene or defaming 
information shall be punished with imprisonment for a term of at least 7 years and a 
maximum of 14 years, and with a fine of up to 10 Taka lakes or both. 
Hacking an electronic device ( Hacking a Computer/Phone/Info): 
 If any person with the intent to cause or knowing that he is likely to cause wrongful loss 
or damage to the public or any person, does any act and thereby destroys, deletes or 
alters any information residing in a computer resource or diminishes its value or utility or 
affects it injuriously by any means or damages through illegal access to any such 
computer, computer network or any other electronic system which do not belong to him, 
then such activity shall be treated as hacking offence. 

 Punishment of Hacking an electronic device ( Hacking a Computer/Phone/Info): 
Anyone who commits the offense of electrically publishing false, obscene or defaming 
information shall be punished with imprisonment for a term of at least 7 years and a 
maximum of 14 years, and with a fine of up to 10 Taka lakes or both. 
3. Unauthorized access to protected systems in Bangladesh 
Any person who secures access to or attempts to secure access to a protected system 
will be treated as an offence. 

 Punishment for Unauthorized Access to Protected Systems 
Anyone who commits an offense of unauthorized access to protected systems shall be 
punished with imprisonment for a term which may extend to a minimum of 7 years and a 
maximum of 14 years or a fine which may extend to or with 10 lakes of Taka. 
4. Disclosure of confidentiality and privacy in Bangladesh: 
No person having secured access to any electronic record, book, register, 
correspondence, information, document or other material shall disclose such electronic 
record book, register, correspondence, information, document or other material to any 
other person without the consent of the person concerned as an offence. 

 Punishment for disclosure of confidentiality and Privacy 
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Any person committing disclosure of confidentiality and privacy shall be punished with 
imprisonment for a term of up to two years or with a fine of up to two Taka lakes or 
both. 
Using a computer to help commit an offence in Bangladesh 
Whoever knowingly assists in committing crimes under the ICT Act, using any computer, 
email or computer network, resource or system shall be considered an offense. 

 Punishment for using a computer to help commit an offence 
Any person who assists in committing an offense as set out above shall be punished with 
the penalty for the core offence. 
 

 
What is the purpose of the ICT Act 2006 in Bangladesh (Online Law / Internet Law in 
Bangladesh | ICT)? 
The purpose of this Act is to guarantee the legal security of documentary 
communications between persons, partnerships and the State, irrespective of the 
medium used; the consistency of legal rules and their application to documentary 
communications using information technology-based media, whether electronic, 
magnetic, optical, wireless or otherwise, or based on technology combinations. 
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The ICT Act promotes the Public Key Technology Trust Chain. The law allows digital 
certificate infrastructure to be developed and managed by the Controller of Certifying 
Authorities (CCA), including audits to be carried out. 
 
The ICT law was formulated to promote the development of Bangladesh’s information 
and communication technologies. The aim is to facilitate the use of information and 
communication technologies to build the information society. 
 
Where the information contained in a document is considered confidential by statute, 
confidentiality must be covered by appropriate means, including on a communication 
network. 
Some Cyber Crimes which are to be dealt through this act are follows: 

 Hacking or unauthorised entry into information systems 

 Introduction of viruses 

 Publishing or distributing obscene content in electronic form 

 Tampering with electronic documents required by law 

 Fraud using electronic documents 

 Violation of privacy rights such as STALKING 

 Violation of copyright, trademark or trademark rights 
Advantages to be fruitful from the Act: 
This Act has provided us with few advantages such as the conduct of important security 
issues under the ICT Act, 2006, which are so critical to the success of electronic 
transactions. The Act has given the concept of secure digital signatures a legal definition 
that would have to be passed through a system of a security procedure, as stipulated by 
the government at a later date. On the other hand, businesses can now conduct 
electronic commerce using the legislative framework established by the Act. This Act also 
provided other facilities for the operation of cyber business or information and 
technology sector. 
 
The purpose of this Act is to guarantee the legal security of documentary 
communications between persons, partnerships and the State, irrespective of the 
medium used; the consistency of legal rules and their application to documentary 
communications using information technology-based media, whether electronic, 
magnetic, optical, wireless or otherwise, or based on technology combinations. -Online 
Law / Internet Law in Bangladesh|ICT Rules, Regulations and Rights in Bangladesh 
 

Criticism of the ICT Act 2006 
Although Critics ocassionally point out that certain specific limitations of the Act still 
remain. (Online Law / Internet Law in Bangladesh | ICT) 
A. Practical Difficulty of Application 
The legislation was originally intended to apply to crimes committed both in Bangladesh 
and worldwide but barely people practically take actions to execute their rights under 
the act. 
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B. Difficulties with Electronic Transaction 
 ‘The enactment has an important effect on Bangladesh’s e-commerce and m-commerce. 
But as for the electronic payment of any transaction it keeps itself almost impractical. 
C. Intellectual property Security 
 The Act is not vocal on the various intellectual property rights, such as copyright, 
trademark and e-information and data patent rights. 
D. Not Addressing Mobile crime and contradicting Email Evidence 
One of the staggering part of the act is that no crime committed via mobile phones is 
addressed in the Act. Also, this law admitted to convey emails as evidence, contrary to 
the Evidence Act of the country, which does not recognize emails as evidence. 

The Digital Security Act 
 
The Digital Security Act was enacted to ensure national data security and develop laws 
regarding data crime identification, prevention, suppression, trial, and other related 
matters. Below are the relevant provisions laid out in the Digital Security Act- 
Under the Digital Security Act, if any data or information published or propagated in 
digital media regarding a subject that comes under the purview of the Director General 
which threatens data security, then the Director General can request the relevant 
regulatory authority to remove or block said data or information as appropriate. 
DATA PROTECTION AUTHORITY -REGULATORY AUTHORITY 
Main regulator for data protection 
Under the Digital Security Act, the NDSC has been entrusted with the authority to 
formulate and issue data protection guidance as and when required. However, for 
executive matters such as blocking content or decrypting a data source, the Digital 
Security Agency ('DSA') has the executive power. 
Main powers, duties and responsibilities 
The powers, duties, and responsibilities of the NDSC include: 

 if digital security is under threat, providing necessary directions on how to remedy 
the situation; 

 advising on how to improve the digital security infrastructure, how to increase in 
its manpower, and how to increase in its quality; 

 enacting inter-institutional policies with the aim of ensuring digital security; and 
 taking necessary steps to ensure the implementation of the Digital Security Act and 

of the Rules enacted under the Digital Security Act. 
The powers, duties, and responsibilities of the DSA include: 

 taking necessary actions to ensure digital security of critical infrastructure; 
 formulating a strategy for risk management; 
 developing standards of digital security and standard operating procedure; 
 establishing, operating, and controlling the Digital Forensic Laboratory; 
 fixing the standards and value of hardware, software, and human skill used for 

digital protection; 
 taking measures against crimes involving digital devices and cybercrime; 
 establishing digital security service systems and operating, protecting, inspecting, 

controlling, and managing the interoperability among different institutions; 
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 facilitating research on digital security and collaboration among different 
universities and research institutions; 

 inspecting if digital security service is being rightly implemented; 
 monitoring internal and international risk and conduct awareness; 
 actively participating in remedying any breach of digital security issues related to 

national security, public health, public discipline, and essential services; 
 nurturing and facilitating digital security related industries; 
 following and collating digital security related information from different countries 

and analysing their impact in the local context; and 
 investigating any weakness of digital security, as well as breaches and harmful 

activities. 
KEY DEFINITIONS 
Personal data: 
 Personal data is not expressly defined. However, the Digital Security Act expressly 
defines 'identity information' as any information which is biological or physical or any 
other information which uniquely or jointly with other information can identify a person 
(which includes body corporates) or system, whose name, photograph, address, date of 
birth, mother's name, father's name, signature, national identification card, birth and 
death registration number, finger print, passport number, bank account number, driving 
licence, E-TIN number (i.e. electronic tax identification number), electronic or digital 
signature, user name, credit or debit card number, voice print, retina image, iris image, 
DNA profile, security related personal data, or any other identification which, due to the 
facilitation of technology, is easily available. 
Sensitive data:  

Has not been expressly defined. 
Data controller|data processor:  

The concepts of data controller, joint controller, and data processor are not defined in 
Bangladesh law. Additionally, there is no distinction between the concepts of data 
controller and data processor. Whoever deals with such data is considered as the 'data 
user', which refers to the person who collects, sells, takes possession, supplies, or uses 
such data. 
Data subject:  

Data subject has not been expressly defined. In local context it refers to whoever owns 
such data or to whomever the personal information is tagged to and is considered the 
data owner. 
Biometric data:  

Biometric Data has not been expressly defined. However, certain biometric data has 
been covered under the definition of 'identity information' as discussed above. 
Health data: 

 Health Data has not been expressly defined in the Digital Security Act. 
Pseudonymisation:  

Pseudonymisation has not been expressly defined in the Digital Security Act. 
LEGAL BASES 
As per Digital Security Act, if any person without any legal authority collects, sells, takes 
possession, supplies, or uses any person's identity information, then that activity will be 
an offence under the Act. The concept of 'legal authority' is similar to the concept of 
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'legal basis' in the General Data Protection Regulation (Regulation (EU) 
2016/679) ('GDPR') and can be granted in form of the below: 
Consent 
The data subject may give his/her prior specific informative consent for processing or 
relevant purpose irrespective of any consideration. In addition to prior specific 
informative consent, consent may also be granted on terms inserted in the related 
contract for the subject matter. The person may supply data on their own with some pre-
determined usage granted. 
Contract with the data subject 
In order the to get the consent from the data subject, as stated above, the data 
controller can either grant prior specific informative consent or such consent may also be 
granted on terms inserted in the related contract for the subject matter. 
Legal obligations 
In addition to consent, the data controller can also process data to which they are 
contractually or statutorily authorised to process without any additional consent. 
Interests of the data subject 
Such interest has not been expressly granted under the Digital Security Act. As such, as 
long as the data controller acts as per the terms of the contractual terms on consent. 
Public interest 
Access and use of data belonging to a data user on the grounds of public interest is only 
allowed by law enforcement agencies per the Digital Security Agency. 
 Legitimate interests of the data controller 
Not applicable. 
Legal bases in other instances 
Not applicable. 

CONTROLLER AND PROCESSOR OBLIGATIONS 
Data processing notification 
The data protection laws of Bangladesh do not expressly impose any obligation over the 
controller and processor except for those agreed in the relevant contract of data usage 
(such as prior specific informative consent), except that the data user needs to ensure 
protection and confidentiality of such data and may be held accountable for any breach. 
Unless there is a specific term agreed in such contract, the data user is not obliged to any 
of the below obligations such as data processing notification.  
Data transfers 
The data protection laws of Bangladesh do not expressly impose any obligations on data 
transfers or any localisation requirements, except as otherwise agreed between the data 
user and data subject. However, for certain industries such as banking and 
telecommunications there is a restriction on the transfer of certain data beyond the 
jurisdictional limit of the country. 
Data processing records 
The data protection laws of Bangladesh do not expressly impose any obligation on data 
processing records, except as otherwise agreed between the data user and data subject. 

https://www.dataguidance.com/comparisons/general-data-protection-regulation
https://www.dataguidance.com/comparisons/general-data-protection-regulation
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Data protection impact assessment 
The data protection laws of Bangladesh do not expressly impose any obligation to 
conduct a Data Protection Impact Assessment ('DPIA'), except as otherwise agreed 
between the data user and data subject. 
Data protection officer appointment 
The data protection laws of Bangladesh do not expressly impose any obligation on data 
protection officer appointment. 
Data breach notification 
The data protection laws of Bangladesh do not expressly impose any obligation on data 
breach notification. 
Data retention 
The data protection laws of Bangladesh do not expressly impose any obligation on data 
retention. 
Children's data 
The data protection laws of Bangladesh do not expressly address regulating the 
processing of children's data. 
Special categories of personal data 
No such requirements have been imposed by Bangladesh data protection laws. 
Controller and processor contracts 
No such requirements have been imposed by Bangladesh data protection laws. 

 
PENALTIES 
As per the Digital Security Act, if any person without any legal authority collects, sells, 
takes possession, supplies, or uses any person's identity information, then such person 
will be penalized with imprisonment for a term not exceeding five years or a fine not 
exceeding BDT 500,000 (approx. €4,970) or with both. If any person commits the offence 
for the second time or recurrently commits it then they will be penalized with 
imprisonment for a not exceeding seven years or with a fine not exceeding BDT 1 million 
(approx. €9,950) or with both. 
Offences under the Digital Security Act 
Unauthorized access in critical information infrastructure ('CII'): 

 If any person intentionally or knowingly illegally accesses, or by means of such 
unauthorized access, harms, or destroys or renders inactive a CII or attempts to do 
so, then such offence may be punished with imprisonment for a term not 
exceeding seven years, and/or with a fine not exceeding BDT 2.5 million (approx. 
€24,860). If such offence is committed with the intention to commit any crime, 
then such person may be punished with imprisonment for a term not exceeding 14 
years and/or with a fine not exceeding BDT 10 million (approx. €99,450). 

Illegal entrance to a computer, digital device, or computer system: 

 Such offence is punishable with imprisonment for a term not exceeding six months 
and/or by a fine not exceeding BDT 300,000 (approx. €2,980). If such offence is 
committed with the intention to commit any crime, then the offence will be 
penalized with imprisonment for a term not exceeding three years and/or with a 
fine not exceeding BDT 1 million (approx. €9,950). If an offence is committed in the 
case of a secured computer or computer system or computer network, then the 
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punishment is imprisonment for a term not exceeding three years and/or by a fine 
not exceeding BDT 1 million (approx. €9,950). 

Damage to a computer or computer system: 

 Such offence is punishable with imprisonment for a term not exceeding seven 
years and/or a fine not exceeding BDT 1 million (approx. €9,950). 

Offences relating to a computer source code change: 

 Such offence is punishable with imprisonment for a term not exceeding three years 
and/or a fine not exceeding BDT 300,000 (approx. €2,980). 

Digital or electronic forgery: 

 Such offence is punishable with imprisonment for a term not exceeding five years 
and/or with a fine not exceeding BDT 500,000 (approx. €4,970). 

Digital or electronic fraud: 

 Such offence is punishable with imprisonment for a term not exceeding five years 
and/or with a fine not exceeding BDT 500,000 (approx. €4,970). 

Identity fraud: 

 It shall be considered an offence if any person intentionally or knowingly uses any 
computer, computer program, computer system, computer network, digital device, 
digital system, or digital network: 

o with the intention of deceiving or cheating, carries the identity of another 
person or shows any person's identity as his own; or 

o assuming, by forgery, the identity of an alive or dead person as one's own in 
order: 

 to achieve some advantages for oneself or for any other person; 
 to acquire any property or interest in any property; or 
 to harm a person by using another person's identity in disguise. 

 Such offence is punishable with imprisonment for a term not exceeding five years 
and/or by a fine not exceeding BDT 500,000 (approx. €4,970). 

Punishment for collecting or using identity information without permission: 
 If any person without any legal authority collects, sells, takes possession, supplies 

or uses any person's identity information, then this activity will be an offence 
under the Act. If any person commits any such offence, the person may be 
punished with imprisonment for a term not exceeding five years and/or a fine not 
exceeding BDT 500,000 (approx. €4,970). 

Cybercrime: 
 It is considered an offence if any person: 

o with the intention to breach national security or to endanger the sovereignty 
of the nation and to instil terror within the public or a part of them, creates 
an obstruction in the authorised access to any computer, computer network 
or internet network, or illegally accesses the said computer, computer 
network or internet network, or causes the act of obstruction of access or 
illegal entry through another person; 

o creates such virus within any digital device or inserts malware which results 
in the death of a person or results in serious injury to a person or raises a 
possibility of it; 

o damages or destroys the supply of daily necessities of the public or adversely 
affects any CII; or 
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o intentionally or knowingly enters or penetrates any computer, computer 
network, internet network, any secured data information or computer 
database or such secured data information or computer database which can 
be used to damage friendly relations with another foreign country, or can be 
used for acts against public order, or which can be used for the benefit of 
any foreign country or any foreign person or any group. 

Such offences are punishable with imprisonment for a term not exceeding 14 years 
and/or with a fine not exceeding BDT 10 million (approx. €9,950). 
Regarding e-transactions without legal authority: 

 It shall be considered an offence if any person: 
o performs an e-transaction through an electronic or digital medium of any 

bank, insurance, or any other financial institution or any mobile money 
service providing organisation without legal authority; or 

o performs an e-transaction that has been declared illegal by the Government 
or the Bangladesh Bank ('the Central Bank'). 

 Such offence is punishable with either a maximum of five years of imprisonment 
and/or a fine of BDT 500,000 (approx. €4,970). 

Illegal transferring, saving, etc. of data or information: 
 if any person enters any computer or digital system illegally and does any addition 

or subtraction, transfer or act with the aim to transfer, save, or aid in saving any 
data or information belonging to a government, semi-government, autonomous or 
statutory organisation or any financial or commercial organisation, then the 
activity of that person will be considered an offence. If any person commits such an 
offence, then they may be sentenced to a term of imprisonment not exceeding five 
years and/or with a fine not exceeding BDT 1 million (approx. €9,950). 

Hacking-related offences: 
 If a person commits hacking, then it will be considered an offence and for this, they 

may be sentenced to a term of imprisonment not exceeding 14 years and/or with 
fine not exceeding BDT 10 million (approx. €99,450) or with both. 

Offences under the Technology Act 
Damage to a computer or computer system: 

 A person may be punishable with imprisonment for a term which may extend to 14 
years (minimum seven years), and/or with a fine which may extend to BDT 1 
million (approx. €9,950), if he/she, without permission of the owner or any person 
who is in charge of a computer, computer system, or computer network: 

o accesses or secures access to such computer, computer system, or computer 
networks for the purpose of destroying information or retrieving or 
collecting information or assists others to do so; 

o downloads, copies, or extracts any data, computer database or information 
from such computer, computer system or computer network including 
information or data held or stored in any removable storage medium; 

o introduces or causes to be introduced any computer contaminant or 
computer virus into any computer, computer system or computer network; 

o damages or causes damage to occur willingly in any computer, computer 
system or computer network, data, computer database or any other 

https://www.bb.org.bd/
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programs residing in such computer, computer system, or computer 
network; 

o disrupts or causes disruption of any computer, computer system, or 
computer network; 

o denies or causes the denial of access to any person authorised to access any 
computer, computer system, or computer network by any means; 

o provides any assistance to any person to facilitate access to a computer, 
computer system, or computer network, in contravention of the provisions 
of the Technology Act, rules or regulations made thereunder; 

o for the purpose of advertisement of goods and services, generates or causes 
the generation of spam or sends unwanted electronic mail without any 
permission of the originator or subscriber; or 

o charges the services availed of by a person to the account of another person 
by tampering with or manipulating any computer, computer system or 
computer network. 

Tampering with a computer source code: 

 Under Section 55 of the Technology Act the activity of, intentionally or knowingly 
concealing, destroying, or altering, or causing another person to conceal, destroy, 
or alter, any computer source code used for a computer, computer program, 
computer system, or computer network, when the computer source code is 
required to be kept or maintained by any law, is regarded as an offence. Whoever 
commits such an offence shall be punishable with imprisonment for a term which 
may extend to three years, and/or with a fine which may extend to BDT 1 million 
(approx. €9,950). 

Hacking a computer system: 

 Under Section 56 of the Technology Act, activities considered a hacking offence 
include: 

o if any person with the intent to cause or knowing that he/she is likely to 
cause wrongful loss or damage to the public or any person, does any act and 
thereby destroys, deletes, or alters any information residing in a computer 
resource or diminishes its value or utility or affects it injuriously by any 
means; or 

o if any person damages through illegal access to any such computer, 
computer network or any other electronic system which does not belong to 
him/her. 

 Whoever commits hacking offences shall be punishable with imprisonment for a 
term which may extend to 14 years (minimum seven years), and/or with a fine 
which may extend to BDT 10 million (approx. €99,450). 

Disclosure of confidentiality and privacy: 

 As per Section 73 of the Technology Act, no person who, in pursuance of any of the 
powers conferred under this Act, or rules and regulations made thereunder, has 
secured access to any of the following, shall, without the consent of the person 
concerned, disclose: 

o electronic records; 
o books; 
o registers; 
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o correspondence; 
o information; 
o documents; or 
o other material. 

 Whoever commits the offence of disclosing confidential and private information 
shall be punishable with imprisonment for a term that may extend to two years, 
and/or with a fine which may extend to BDT 200,000 (approx. €1,990). 

 
Understanding Threats and preventions 
Hackers and Predators 
People, not computers, create computer security threats and malware. Hackers and 
predators are programmers who victimize others for their own gain by breaking into 
computer systems to steal, change, or destroy information as a form of cyber-terrorism. 
These online predators can compromise credit card information, lock you out of your 
data, and steal your identity. As you may have guessed, online security tools with identity 
theft protection are one of the most effective ways to protect yourself from this brand of 
cybercriminal. 
Social Engineering 
Social engineering is the term used for a broad range of malicious activities accomplished 
through human interactions. It uses psychological manipulation to trick users into making 
security mistakes or giving away sensitive information. 
Social engineering attacks happen in one or more steps. A perpetrator first investigates 
the intended victim to gather necessary background information, such as potential points 
of entry and weak security protocols, needed to proceed with the attack. Then, 
the attacker moves to gain the victim’s trust and provide stimuli for subsequent actions 
that break security practices, such as revealing sensitive information or granting access to 
critical resources. 
Social engineering prevention 
Social engineers manipulate human feelings, such as curiosity or fear, to carry out 
schemes and draw victims into their traps. Therefore, be wary whenever you feel 
alarmed by an email, attracted to an offer displayed on a website, or when you come 
across stray digital media lying about. Being alert can help you protect yourself against 
most social engineering attacks taking place in the digital realm. 
Moreover, the following tips can help improve your vigilance in relation to social 
engineering hacks. 
 

o Don’t open emails and attachments from suspicious sources – If you don’t know 
the sender in question, you don’t need to answer an email. Even if you do know 
them and are suspicious about their message, cross-check and confirm the news 
from other sources, such as via telephone or directly from a service provider’s 
site. Remember that email addresses are spoofed all of the time; even an email 
purportedly coming from a trusted source may have actually been initiated by an 
attacker. 

o Use multifactor authentication – One of the most valuable pieces of information 
attackers seek are user credentials. Using multifactor authentication helps ensure 

https://www.imperva.com/learn/application-security/malware-detection-and-removal/
https://www.imperva.com/learn/application-security/malware-detection-and-removal/
https://www.imperva.com/learn/application-security/ethical-hacking/
https://www.imperva.com/learn/data-security/sensitive-data/
https://www.imperva.com/learn/data-security/sensitive-data/
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your account’s protection in the event of system compromise. Imperva Login 
Protect is an easy-to-deploy 2FA solution that can increase account security for 
your applications. 

o Be wary of tempting offers – If an offer sounds too enticing, think twice before 
accepting it as fact. Googling the topic can help you quickly determine whether 
you’re dealing with a legitimate offer or a trap. 

o Keep your antivirus/antimalware software updated – Make sure automatic 
updates are engaged, or make it a habit to download the latest signatures first 
thing each day. Periodically check to make sure that the updates have been 
applied, and scan your system for possible infections. 

 
Spyware, and Malware 
Spyware Threats 
A serious computer security threat, spyware is any program that monitors your online 
activities or installs programs without your consent for profit or to capture personal 
information. We’ve amassed a wealth of knowledge that will help you combat spyware 
threats and stay safe online. 
While many users won't want to hear it, reading terms and conditions is a good way to 
build an understanding of how your activity is tracked online. And of course, if a company 
you don't recognize is advertising for a deal that seems too good to be true, be sure you 
have an internet security solution 
Malware is malicious software such as spyware, ransomware, viruses and worms. 
Malware is activated when a user clicks on a malicious link or attachment, which leads to 
installing dangerous software. Cisco reports that malware, once activated, can: 

 Block access to key network components (ransomware) 
 Install additional harmful software 
 Covertly obtain information by transmitting data from the hard drive (spyware) 
 Disrupt individual parts, making the system inoperable 

 
Social Media 
As the number of users accessing social platforms is increasing day by day, so are the 
risks. As social media has grown by leaps and bounds, it has brought various benefits 
simultaneously, and it has posed serious social media cyber security concerns. 
Identity Theft: As millions share their personal information for getting registered in one 
or more social media platforms, these data becomes vulnerable as hackers and identity 
thieves use this information’s to reset passwords, apply for loans, or other malicious 
objectives. 
Romance Scams: A romance scam is a fraudulent scheme in which a swindler pretends 
romantic interest in a target, establishes a relationship, and then attempts to get money 
or sensitive information from the target under pretenses. 
Whistle-blower: People are often impulsive on social media; they show their vexation 
with their colleagues or bosses without thinking. They may deliberately reveal sensitive 
data in their posts, which can cause significant damage to the reputation of the 
organization. 
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Cyber Stalking: It refers to harassment over the internet. Cyber stalkers harass victims on 
social media by sending unpleasant and lewd messages. They morph photos of victims 
and circulate them on social media, alleging rumors making the victim’s life unbearable. 
Cyber Bullying: It refers to bullying through the digital medium. It can take place on 
social media, gaming platforms, messaging platforms, etc. It is aimed at scaring, shaming, 
or annoying the targeted victim. 
Cyber Terrorism: Nowadays, social media is also used to facilitate terrorism-related 
activities. It can support, promote, engage, and spread terrorism propaganda like 
incitement to terrorism, recruitment, radicalizing training, and planning of terrorist 
attacks. 
Solutions on social media threats 

i. Creating strong passwords is the primary option to ensure the privacy of your 
information.  

ii. Ensure passwords are complex, including upper & lower case, numbers, and 
special characters. It should be memorized and never be written on paper. 

iii. We need to be sensitive in what we upload/share in our social networking 
accounts and avoid sharing personal information like date of birth, social security 
details, phone numbers, names, and pictures of family members. 

iv. Use security and privacy options provided by social media platforms viz: 2-factor 
authentication system, access control. 

v. Connect our devices only to authorized wifi access, use privacy options provided 
by various mobile operating systems, use auto-lock features, and download apps 
only from authorized app stores. 

vi. Keep the operating system updated with the latest patches, turn-on the firewall, 
and avoid installing cracked software. 

vii. Ensure our antivirus is updated and scans are performed frequently. 
viii. We need to be smart using the internet and avoid visiting untrusted websites; 

referral links to visit websites are never to be clicked; instead, type in the 
browser’s URL address. 

ix. Care needs to be taken to accept friend requests only from people we know and 
block those who post upsetting content or comments. 

 
Secure Passwords 
With the right password, a cyber-attacker has access to a wealth of information. Social 
engineering is a type of password attack that Data Insider defines as “a strategy cyber 
attacker’s use that relies heavily on human interaction and often involves tricking people 
into breaking standard security practices.” Other types of password attacks include 
accessing a password database or outright guessing. 
Two-Factor Authentication 
Two factor authentication is all about ensuring that the person standing at the door is 
who they claim to be. It’s designed to guard against unauthorized users from picking up a 
lost or stolen card or using another users PIN to unlawfully gain access.  
How it works 
Two factor authentication is often a combination of what you have (physical or mobile 
credential), what you know (PIN), or who you are (biometric data).  
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I. What you have: This is likely to be either a physical credential such as a card or 
tag or a mobile credential that is linked to your smart phone.  

II. What you know: This is often a password or PIN that is unique to the user.  
III. Who you are: Two Factor Authentication is not limited to Card and PIN. Biometric 

data is something that is inherent to each user and can include their fingerprint, 
face structure, or their retina pattern.  

Each of these authentication methods have varing levels of security on their own, but 
when combined, they can offer a high level of security that is often required for data 
centers, medical facilities and financial institutions. 
 
Securing Mobile Devices 
Encryption 

Encryption attempts to make information unreadable by anyone who is not explicitly 
authorized to view that data. People or devices can be authorized to access encrypted 
data in many ways, but typically this access is granted via passwords or decryption keys. 
There are various strengths and methods of encryption and as technology evolves, older 
methods of encryption are no longer considered secure. Sensitive information should be 
encrypted using the best method available whenever possible. 
Data can be encrypted in several ways: 

 Encrypted Communication 

 Virtual Private Network (VPN) 

 Destroying Sensitive Data 
There are many important uses of encryption 

Most of us encounter encryption every day. Popular uses include: 
I. Every time you use an ATM or buy something online with a smartphone, 

encryption is used to protect the information being relayed. 
II. Securing devices, such as encryption for laptops. 

III. Most legitimate websites use "secure sockets layer” (SSL), which is a form of 
encrypting data when it is being sent to and from a website. This keeps attackers 
from accessing that data while it is in transit. Look for the padlock icon in the URL 
bar and the "s" in the "https://" to ensure you are conducting secure, encrypted 
transactions online. 

IV. Your WhatsApp messages are also encrypted, and you may also have an 
encrypted folder on your phone. 

V. Your email can also be encrypted with protocols such as Open PGP. 
VI. VPNs – Virtual Private Networks – use encryption, and everything you store in the 

cloud should be encrypted. You can encrypt your whole hard drive and even make 
encrypted voice calls. 

VII. Encryption is used to prove the integrity and authenticity of information using 
what are known as digital signatures. Encryption is an integral part of digital-rights 
management and copy protection. 

Encryption in cyber security is a way of protecting private information from being stolen 
or compromised. Another important aspect of online safety is using a high-quality 
antivirus solution, such as Kaspersky Total Security, which blocks common and complex 
threats like viruses, malware, ransomware, spy apps, and the latest hacker tricks. 
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CLEAN TRACES OF YOUR WORK OFF YOUR DEVICE 

Set a regular schedule to wipe your device's unused memory securely, to continue to 
ensure sensitive files do not remain on your devices, hard drives, USB memory sticks, 
removable memory cards (SD cards) from cameras, mobile phones or portable music 
players, and any other device that saves sensitive information. 
TO FULLY WIPE A DEVICE 

All devices 
 Close down all unnecessary apps. 
 Disconnect from the Internet, turning off wifi or unplugging the internet cable 

as needed. 
 Create an encrypted backup of your important files, as discussed in our guide 

How to recover from information loss. 
 You may want to start by clearing your browser's temporary files. 

 WHEN YOU SELL, GIVE AWAY, OR DISPOSE OF AN OLD COMPUTER OR PHONE 
 Fully wipe the device using the instructions above. 
 Remove USB drives, CDs, DVDs, SD cards, SIM cards, dongles, or other small 

devices that may be inserted or plugged into your device. 
 If possible, when you are selling or giving away an old computer, do not give the 

new owner the hard drive; but if you must, be sure you have followed 
instructions on how to erase it first. 

 If you are disposing of an old hard drive, consider destroying it physically as well 
as wiping it. You can do this by hitting it hard a few times with a hammer, 
hammering nails through the drive, or with a drill. Do not burn or pour acid on a 
drive, and do not put it in the microwave. 

 You can also keep a wiped drive that is in good condition to re-use yourself, in a 
new device or as an external hard drive. 

 

Physical Security Measures 
#1: Lock up the server room 
Even before you lock down the servers, in fact, before you even turn them on for the first 
time, you should ensure that there are good locks on the server room door. Of course, 
the best lock in the world does no good if it isn't used, so you also need policies requiring 
that those doors be locked any time the room is unoccupied, and the policies should set 
out who has the key or keycode to get in. 
More work is being completed via mobile device. Are your employees using their devices 
safely? If not, there may be consequences. 
The server room is the heart of your physical network, and someone with physical access 
to the servers, switches, routers, cables and other devices in that room can do enormous 
damage. 
 
#2: Set up surveillance 
Locking the door to the server room is a good first step, but someone could break in, or 
someone who has authorized access could misuse that authority. You need a way to 
know who goes in and out and when. A log book for signing in and out is the most 
elemental way to accomplish this, but it has a lot of drawbacks. A person with malicious 
intent is likely to just bypass it. 
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A better solution than the log book is an authentication system incorporated into the 
locking devices, so that a smart card, token, or biometric scan is required to unlock the 
doors, and a record is made of the identity of each person who enters. 
 
A video surveillance camera, placed in a location that makes it difficult to tamper with or 
disable (or even to find) but gives a good view of persons entering and leaving should 
supplement the log book or electronic access system. Surveillance cams can monitor 
continuously, or they can use motion detection technology to record only when someone 
is moving about. They can even be set up to send e-mail or cell phone notification if 
motion is detected when it shouldn't be (such as after hours). 
 
#3: Make sure the most vulnerable devices are in that locked room 
Remember, it's not just the servers you have to worry about. A hacker can plug a laptop 
into a hub and use sniffer software to capture data traveling across the network. Make 
sure that as many of your network devices as possible are in that locked room, or if they 
need to be in a different area, in a locked closet elsewhere in the building. 
 
#4: Use rack mount servers 
Rack mount servers not only take up less server room real estate; they are also easier to 
secure. Although smaller and arguably lighter than (some) tower systems, they can easily 
be locked into closed racks that, once loaded with several servers, can then be bolted to 
the floor, making the entire package almost impossible to move, much less to steal. 
 
#5: Don't forget the workstations 
Hackers can use any unsecured computer that's connected to the network to access or 
delete information that's important to your business. Workstations at unoccupied desks 
or in empty offices (such as those used by employees who are on vacation or have left 
the company and not yet been replaced) or at locations easily accessible to outsiders, 
such as the front receptionist's desk, are particularly vulnerable. 
 
Disconnect and/or remove computers that aren't being used and/or lock the doors of 
empty offices, including those that are temporarily empty while an employee is at lunch 
or out sick. Equip computers that must remain in open areas, sometimes out of view of 
employees, with smart card or biometric readers so that it's more difficult for 
unauthorized persons to log on. 
 
#6: Keep intruders from opening the case 
Both servers and workstations should be protected from thieves who can open the case 
and grab the hard drive. It's much easier to make off with a hard disk in your pocket than 
to carry a full tower off the premises. Many computers come with case locks to prevent 
opening the case without a key. 
 
You can get locking kits from a variety of sources for very low cost, such as the one at 
Innovative Security Products. 
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#7: Protect the portables 
Laptops and handheld computers pose special physical security risks. A thief can easily 
steal the entire computer, including any data stored on its disk as well as network logon 
passwords that may be saved. If employees use laptops at their desks, they should take 
them with them when they leave or secure them to a permanent fixture with a cable 
lock, such as the one at PC Guardian. 
 
Handhelds can be locked in a drawer or safe or just slipped into a pocket and carried on 
your person when you leave the area. Motion sensing alarms such as the one at 
SecurityKit.com are also available to alert you if your portable is moved. 
 
For portables that contain sensitive information, full disk encryption, biometric readers, 
and software that "phones home" if the stolen laptop connects to the Internet can 
supplement physical precautions. 
 
#8: Pack up the backups 
Backing up important data is an essential element in disaster recovery, but don't forget 
that the information on those backup tapes, disks, or discs can be stolen and used by 
someone outside the company. Many IT administrators keep the backups next to the 
server in the server room. They should be locked in a drawer or safe at the very least. 
Ideally, a set of backups should be kept off site, and you must take care to ensure that 
they are secured in that offsite location. 
 
Don't overlook the fact that some workers may back up their work on floppy disks, USB 
keys, or external hard disks. If this practice is allowed or encouraged, be sure to have 
policies requiring that the backups be locked up at all times. 
 
#9: Disable the drives 
If you don't want employees copying company information to removable media, you can 
disable or remove floppy drives, USB ports, and other means of connecting external 
drives. Simply disconnecting the cables may not deter technically savvy workers. Some 
organizations go so far as to fill ports with glue or other substances to permanently 
prevent their use, although there are software mechanisms that disallow it. Disk locks, 
such as the one at SecurityKit.com, can be inserted into floppy drives on those computers 
that still have them to lock out other diskettes. 
 
#10: Protect your printers 
You might not think about printers posing a security risk, but many of today's printers 
store document contents in their own on-board memories. If a hacker steals the printer 
and accesses that memory, he or she may be able to make copies of recently printed 
documents. Printers, like servers and workstations that store important information, 
should be located in secure locations and bolted down so nobody can walk off with them. 
 
Also think about the physical security of documents that workers print out, especially 
extra copies or copies that don't print perfectly and may be just abandoned at the printer 
or thrown intact into the trash can where they can be retrieved. It's best to implement a 
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policy of immediately shredding any unwanted printed documents, even those that don't 
contain confidential information. This establishes a habit and frees the end user of the 
responsibility for determining whether a document should be shredded. 

Insider threats 
An insider threat occurs when individuals close to an organization who have authorized 
access to its network intentionally or unintentionally misuse that access to negatively 
affect the organization's critical data or systems. 
Careless employees who don't comply with their organizations' business rules and 
policies cause insider threats. For example, they may inadvertently email customer data 
to external parties, click on phishing links in emails or share their login information with 
others. Contractors, business partners and third-party vendors are the source of other 
insider threats. 
Some insiders intentionally bypass security measures out of convenience or ill-considered 
attempts to become more productive. Malicious insiders intentionally elude 
cybersecurity protocols to delete data, steal data to sell or exploit later, disrupt 
operations or otherwise harm the business. 

Preventing insider threats 
The list of things organizations can do to minimize the risks associated with insider 
threats include the following: 

 limit employees' access to only the specific resources they need to do their jobs; 

 Train new employees and contractors on security awareness before allowing 
them to access the network. Incorporate information about unintentional and 
malicious insider threat awareness into regular security training; 

 set up contractors and other freelancers with temporary accounts that expire on 
specific dates, such as the dates their contracts end; 

 implement two-factor authentication, which requires each user to provide a 
second piece of identifying information in addition to a password; and 

 Install employee monitoring software to help reduce the risk of data breaches and 
the theft of intellectual property by identifying careless, disgruntled or malicious 
insiders. 

Viruses and worms 
Viruses and worms are malicious software programs (malware) aimed at destroying an 
organization's systems, data and network. A computer virus is a malicious code that 
replicates by copying itself to another program, system or host file. It remains dormant 
until someone knowingly or inadvertently activates it, spreading the infection without 
the knowledge or permission of a user or system administration. 
 
A computer worm is a self-replicating program that doesn't have to copy itself to a host 
program or require human interaction to spread. Its main function is to infect other 
computers while remaining active on the infected system. Worms often spread using 
parts of an operating system that are automatic and invisible to the user. Once a worm 
enters a system, it immediately starts replicating itself, infecting computers and networks 
that aren't adequately protected. 
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Preventing viruses and worms 
To reduce the risk of these types of information security threats caused by viruses or 
worms, companies should install antivirus and antimalware software on all their systems 
and networked devices and keep that software up to date. In addition, organizations 
must train users not to download attachments or click on links in emails from unknown 
senders and to avoid downloading free software from untrusted websites. Users should 
also be very cautious when they use P2P file sharing services and they shouldn't click on 
ads, particularly ads from unfamiliar brands and websites. 
Carefully evaluating free software, downloads from peer-to-peer file sharing sites, and 
emails from unknown senders are crucial to avoiding viruses. Most web browsers today 
have security settings which can be ramped up for optimum defense against online 
threats. But, as we'll say again and again in this post, the single most-effective way of 
fending off viruses is up-to-date antivirus software from a reputable provider. 
Botnets 
A botnet is a collection of Internet-connected devices, including PCs, mobile devices, 
servers and IoT devices that are infected and remotely controlled by a common type of 
malware. Typically, the botnet malware searches for vulnerable devices across the 
internet. The goal of the threat actor creating a botnet is to infect as many connected 
devices as possible, using the computing power and resources of those devices for 
automated tasks that generally remain hidden to the users of the devices. The threat 
actors -- often cybercriminals -- that control these botnets use them to send email spam, 
engage in click fraud campaigns and generate malicious traffic for distributed denial-of-
service attacks. 
Preventing botnets 
Organizations have several ways to prevent botnet infections: 

o monitor network performance and activity to detect any irregular network 
behavior; 

o keep the operating system up to date; 
o keep all software up-to-date and install any necessary security patches; 
o educate users not to engage in any activity that puts them at risk of bot infections 

or other malware, including opening emails or messages, downloading 
attachments or clicking links from unfamiliar sources; and 

o Implement anti botnet tools that find and block bot viruses. In addition, most 
firewalls and antivirus software include basic tools to detect, prevent and remove 
botnets. 

 Drive-by download attacks 
In a drive-by download attack, malicious code is downloaded from a website via a 
browser, application or integrated operating system without a user's permission or 
knowledge. A user doesn't have to click on anything to activate the download. Just 
accessing or browsing a website can start a download. Cybercriminals can use drive-by 
downloads to inject banking Trojans, steal and collect personal information as well as 
introduce exploit kits or other malware to endpoints. 
 
Preventing drive-by download attacks 
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One of the best ways a company can prevent drive-by download attacks is to regularly 
update and patch systems with the latest versions of software, applications, browsers, 
and operating systems. Users should also be warned to stay away from insecure 
websites. Installing security software that actively scans websites can help protect 
endpoints from drive-by downloads. 
 
Phishing attacks 
Phishing attacks are a type of information security threat that employs social engineering 
to trick users into breaking normal security practices and giving up confidential 
information, including names, addresses, login credentials, Social Security numbers, 
credit card information and other financial information. In most cases, hackers send out 
fake emails that look as if they're coming from legitimate sources, such as financial 
institutions, eBay, PayPal -- and even friends and colleagues. 
 
In phishing attacks, hackers attempt to get users to take some recommended action, 
such as clicking on links in emails that take them to fraudulent websites that ask for 
personal information or install malware on their devices. Opening attachments in emails 
can also install malware on users' devices that are designed to harvest sensitive 
information, send out emails to their contacts or provide remote access to their devices. 
Preventing phishing attacks 
Enterprises should train users not to download attachments or click on links in emails 
from unknown senders and avoid downloading free software from untrusted websites. 
 
Distributed denial-of-service (DDoS) attacks 
In a distributed denial-of-service (DDoS) attack, multiple compromised machines attack a 
target, such as a server, website or other network resource, making the target totally 
inoperable. The flood of connection requests, incoming messages or malformed packets 
forces the target system to slow down or to crash and shut down, denying service to 
legitimate users or systems. 
Preventing DDoS attacks 
To help prevent DDoS attacks, companies should take these steps: 

o Implement technology to monitor networks visually and know how much 
bandwidth a site uses on average. DDoS attacks offer visual clues so 
administrators who understand the normal behaviors of their networks will be 
better able to catch these attacks. 

o Ensure servers have the capacity to handle heavy traffic spikes and the necessary 
mitigation tools necessary to address security problems. 

o Update and patch firewalls and network security programs. 
o Set up protocols outlining the steps to take in the event of a DDoS attack 

occurring. 
 
Ransomware 
In a ransomware attack, the victim's computer is locked, typically by encryption, which 
keeps the victim from using the device or data that's stored on it. To regain access to the 
device or data, the victim has to pay the hacker a ransom, typically in a virtual currency 
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such as Bitcoin. Ransomware can be spread via malicious email attachments, infected 
software apps, infected external storage devices and compromised websites. 
Preventing ransomware 
To protect against ransomware attacks, users should regularly back up their computing 
devices and update all software, including antivirus software. Users should avoid clicking 
on links in emails or opening email attachments from unknown sources. Victims should 
do everything possible to avoid paying ransom. Organizations should also couple a 
traditional firewall that blocks unauthorized access to computers or networks with a 
program that filters web content and focuses on sites that may introduce malware. In 
addition, limit the data a cybercriminal can access by segregating the network into 
distinct zones, each of which requires different credentials. 
 
Exploit kits 
An exploit kit is a programming tool that enables a person without any experience writing 
software code to create, customize and distribute malware. Exploit kits are known by a 
variety of names, including infection kit, crimeware kit, DIY attack kit and malware 
toolkit. Cybercriminals use these toolkits to attack system vulnerabilities to distribute 
malware or engage in other malicious activities, such as stealing corporate data, 
launching denial of service attacks or building botnets. 
Preventing exploit kits 
To guard against exploit kits, an organization should deploy antimalware software as well 
as a security program that continually evaluates if its security controls are effective and 
provide protection against attacks. Enterprises should also install antiphishing tools 
because many exploit kits use phishing or compromised websites to penetrate the 
network. 
Advanced persistent threat attacks 
An advanced persistent threat (APT) is a targeted cyberattack in which an unauthorized 
intruder penetrates a network and remains undetected for an extended period of time. 
Rather than causing damage to a system or network, the goal of an APT attack is to 
monitor network activity and steal information to gain access, including exploit kits and 
malware. Cybercriminals typically use APT attacks to target high-value targets, such as 
large enterprises and nation-states, stealing data over a long period. 
Preventing APT attacks 
Detecting anomalies in outbound data may be the best way for system administrators to 
determine if their networks have been targeted. 
Indicators of APTs include the following: 

 unusual activity on user accounts; 

 extensive use of backdoor Trojan horse malware, a method that enables APTs to 
maintain access; 

 odd database activity, such as a sudden increase in database operations involving 
massive amounts of data; and 

 the presence of unusual data files, possibly indicating that data that has been 
bundled into files to assist in the exfiltration process. 

To combat this type of information security threat, an organization should also deploy a 
software, hardware or cloud firewall to guard against APT attacks. Organizations can also 
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use a web application firewall to detect and prevent attacks coming from web 
applications by inspecting HTTP traffic. 
 
Malvertising 
Malvertising is a technique cybercriminals use to inject malicious code into legitimate 
online advertising networks and web pages. This code typically redirects users to 
malicious websites or installs malware on their computers or mobile devices. Users' 
machines may get infected even if they don't click on anything to start the download. 
Cybercriminals may use malvertising to deploy a variety of moneymaking malware, 
including cryptomining scripts, ransomware and banking Trojans. 
 
Some of the websites of well-known companies, including Spotify, The New York Times 
and the London Stock Exchange, have inadvertently displayed malicious ads, putting 
users at risk. 
 
Preventing malvertising 
To prevent malvertising, ad networks should add validation; this reduces the chances a 
user could be compromised. Validation could include: Vetting prospective customers by 
requiring legal business paperwork; two-factor authentication; scanning potential ads for 
malicious content before publishing an ad; or possibly converting Flash ads to animated 
gifs or other types of content. 
To mitigate malvertising attacks, web hosts should periodically check their websites from 
an unpatched system and monitor that system to detect any malicious activity. The web 
hosts should disable any malicious ads. 
To reduce the risk of malvertising attacks, enterprise security teams should be sure to 
keep software and patches up to date as well as install network antimalware tools. 
Spot the differences between a real email and a scam email! 
While phishing and spam emails can often look the same and use similar language, the 
biggest differences are in what the sender seeks. Spam is flooding the Internet with the 
same message sent to millions. The majority of spam is commercial advertising for 
products that might seem rather suspicious. They want you to buy their dubious wares, 
access their dubious sites, or just forward their message to others. 
 
Phishing emails want your information — your usernames, passwords, credit card details 
and more. Phishing emails are also usually more personalized and may seem to have 
some relevance. It might be from a credit card you recently opened or an organization 
you’ve donated to before. 
 
It’s important to remember that phishing emails can have many different goals. A 
phishing email could be an attempt to hack a network or infect it with malware. Phishing 
emails, especially spear phishing, are attempting to acquire sensitive information: spam 
emails do not. That is the major difference between the two. 
 
Phishing emails are also targeted to a person. The email likely has a salutation with the 
person’s name. Spam isn’t this personal; it’s broader. In fact, you may find that your 
email address is only in the BCC field. This is, of course, a sure sign that it’s spam. 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1324 | 1352  

 
A sense of urgency is one tell-tale sign of phishing. Language like “only the first 50 
respondents” or “offer ends tomorrow” will be found in the message. Spam doesn’t 
typically have a timetable. 
Hoax Emails 
These type of fake email is disguised as communications from a trusted source, such as a 
bank or known affiliate like Booking.com. It may contain their branding or even replicate 
their common email format. 
Email Hoax Definition 
According to Technopedia an email hoax is: “a scam that is distributed in email form. It is 
designed to deceive and defraud email recipients, often for monetary gain.” 
 
The objective: 
To convince the recipient that the email is from a trusted source, in order to obtain 
payment details or confidential information. 
 
How to tell if an email is a hoax: 
The “from” name may state that the email was delivered from the trusted source, but 
the email address will be slightly different. If it’s not from an email using their official 
website domain you should be on high alert. An example of this would be an email 
coming from invoice@booking-ltd.com instead of invoice@booking.com. 
Incorrect logos or slightly different design. 
Generic salutation such as “Dear Sir or Madam”, or use of the business name instead of 
addressing you personally. Banks and genuine affiliates will know your name. 
If the reason for the email is a surprise, such as an overdue payment reminder when your 
account is up-to-date. 
How to protect yourself from hoax emails: 
When logging into a trusted website, always look for “https” at the beginning of the URL. 
The “s” stands for secure. 
Check for the padlock symbol in your browser’s address bar. This also means the website 
is secure. 
Make sure the URL is genuine. Hoax emails often link to a hoax website with URLs similar 
to the real one, but different. 
Enter website URLs straight into your address bar. Don’t reply on links within emails as 
they could be fake. 
Phishing Emails 
The people behind phishing emails are experts in manipulation. They will use urgency to 
convince you to open a deceptive link or attachment before you have time to consider 
the consequences. An example of this would be an email with the subject line “FINAL 
NOTICE – IMMEDIATE PAYMENT REQUIRED” containing minimal description and 
referring to an invoice attached. Without hesitation many will open the attachment to 
see which payment is overdue, but instead it allows software to be installed on your 
computer. This type of fake email may also include a link to a malicious website with the 
same outcome. 
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Phishing Email Definition: 
According to the Australian Cyber Security Centre, phishing is: “a way that cybercriminals 
steal confidential information, such as online banking logins, credit card details, business 
login credentials or passwords/passphrases, by sending fraudulent messages (sometimes 
called ‘lures’). 
 
The objective: 
To use pressure and quick emotional responses to trick the recipient into making a 
payment, visiting a malicious website, or to open an attachment containing a virus or 
spyware. 
 
How to identify a phishing email: 

 Urgent or upsetting statements demanding your immediate reaction. 

 Requests for payment or your financial/personal information. 

 They often use a generic greeting in their emails, such as “Dear user”. 

 Wrong or out-of-date logos or design 

 How to protect yourself from phishing emails: 

 Always check the “from” name and email address. Never open attachments or 
click links from senders you do not know and trust. 

 
 
Beware of false links. Just because the text says “www.google.com” does not mean that 
it will direct you to Google. For example, here I have created a link with text 
facebook.com which instead goes to Twitter when clicked. Always hover your mouse 
over links to see the true destination before clicking. If the address looks suspicious in 
any way, do not click! 
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Scam Emails 
Scam emails often include “too good to be true” offers, such as lottery wins, surprise 
inheritance and unsolicited job offers. People and businesses may also receive a fake 
email requesting payment for products or services they did not purchase. You’ve likely 
never heard from the sender before, but the email will try to imply a connection. 
The objective: 
To use a false affiliation or unbelievable offer to trick you into giving them money. Often 
will try to encourage you to reply to the email. 
How to tell if an email is a scam: 
You do not know the sender (even if their email suggests they know you, you can’t recall 
the affiliation). 

o The email presents an unrealistic promise or offer. 
o The email requests payment for a purchase you did not make. 
o How to protect yourself from scam emails: 
o If the sender, product or service doesn’t seem familiar, ignore or delete the email. 

Do not reply. 
o If you have received an email requesting to renew a product or service, always 

make sure that it is for a service you genuinely signed up for. 
o If it sounds too good to be true, it probably is! 

 

Methods to browsing the web safe! 
Keep your browser and any plugins updated 
Web browsers are often your first point of contact with the internet no matter what 
device you are using. Developers release frequent updates to ensure you can experience 
the latest the web has to offer – more than ever websites are taking advantage of all the 
new features enabled by HTML5 video and audio, advanced styling and improved speeds. 
Many sites have stopped supporting older versions browsers, due to compatibility and 
security concerns. 
Hackers often target vulnerabilities in web browsers which is why the companies that 
make them release regular updates to patch any vulnerabilities. Installing the latest 
versions helps keep your device secure – fortunately, most common browsers include 
options to automatically update either in the browser themselves or as part of the 
operating system update tools. 
Use a browser that allows you to take your bookmarks with you between devices 
Most modern browsers allow you to create an account so that you can reduce your 
reliance on search engines and synchronize your bookmarks between your laptop, tablet, 
and smartphone. Many even enable you to see the pages you have open in other devices 
and open them in the device you are using at the time. 
 
Block Pop-ups 
While desktop pop-ups from your operating system are unavoidable, pop-ups in your 
web browser can often be switched off. Browser pop-ups typically open new browser 
windows to push adverts, and while most are just annoying, some can contain malicious 
links or inappropriate content. Most browsers come with filters that automatically block 
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pop-ups and enable you to allow them for those trusted sites where they may be 
advantageous. 
 
Use an ad blocker 
Pop-up ads and the feeling of ads following you around the internet have led to the rise 
in popularity of the adblocker. Ad blockers stop webpages showing you ads, which 
sounds great until you realize how controversial this subject is and the profound impact it 
could have on the websites you visit. 
Most websites are paid for by ads on a pay per impression basis – so if you have an ad 
blocker running, you deny the publisher the revenues that are paying to keep the site 
going. 
By all means, protect yourself using an ad blocker, but do consider whitelisting your 
favorite sites as the ad revenue is what keeps them in business! 
Enable “do not track” in your browser 
Many browsers include the ability to send a “do not track” request to websites which 
asks them not to collect or track your browsing data. However, what happens depends 
on how the sites respond to the request – but most websites and web servers don’t 
change their behavior and would appear to ignore the request. Still, making it clear you 
don’t wish to be tracked is a good start. 
Clear your web browser cache and cookies 
Even if websites do decide to track your browsing data, you can limit the impact by 
regularly clearing your browser cache and deleting unwanted cookies. This prevents ads 
from following you around the web and can also ensure you have the latest version of a 
web page downloaded. 
All major browsers allow you to do this manually, and you can easily clear all your data, 
but there are also software options that automate the process to make your life easier. 
Whichever route you choose to go it may be worth considering whitelisting those sites 
that you regularly log in to avoid having to re-enter login details constantly. 
Turn on private browsing 
Private browsing protects your private information and blocks some websites from 
tracking your search and browsing data. It won’t hide your activity from your internet 
service provider, but it does reduce the accumulation of cookies and can be helpful if you 
are buying presents online for a significant other. 
Use a VPN 
Virtual proxy networks or VPNs help you maintain your privacy by encrypting your data 
and internet requests before they ever hit the internet. The technology works the same 
no matter how you have connected to the internet – the encrypted data is sent to the 
VPN server which decrypts the requests before sending them on to the online 
destination. The information is then sent back through the same process meaning that 
sites, advertisers and internet service providers can’t track what you are doing. 
VPNs such as the one included in Panda Dome uses the most secure encryption protocols 
on the market to ensure the only person that can see your data is you. 
Use a password manager 
The number of password leaks that occur when websites are hacked makes it very 
dangerous to reuse the same password for a range of different sites. To prevent 
password leaks from being too damaging, you need to use unique passwords on every 
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website. These should also be strong passwords – long, unpredictable passwords that 
contain numbers and symbols. 
However, remembering strong passwords for all those different passwords is almost 
impossible – that’s where a password manager comes in. They encrypt and securely store 
your login information for all the websites you used and help you log in automatically – 
leaving you to remember just the one master password. 
Ensure you have up-to-date antivirus and firewall protection 
You need antivirus and firewall protection software on your computer no matter how 
carefully you browse the web or how smart you think you are about the links you click 
and the files you open. 
Threats can be hidden in even in the most reputable websites or files from the most 
trusted of sources and ensuring you are protected with a smart antivirus platform is well 
worth a small investment in time to ensure you are protected. The most reputable 
antivirus software solutions currently available, use big data and AI to monitor every 
running application and detect attacks before they happen. 
Digital Signatures 
A digital signature is a type of electronic signature that uses a specific technical 
implementation. Digital signature providers follow the PKI (Public Key Infrastructure) 
protocol. 
Digital signatures use a standard, accepted format, called Public Key Infrastructure (PKI), 
to provide the highest levels of security and universal acceptance. They are a specific 
signature technology implementation of electronic signature (eSignature). 

 

 
The use of electronic signatures is gaining momentum in Bangladesh, but the laws 
dealing with them are still being expanded. Electronic signatures are recognized under 
the country’s Information and Communication Technology Act 2006 (ICT Act), meaning 
they can be used to sign any documents that require a signature, subject to certain 
exceptions. 
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While the ICT Act is the primary legislation dealing with electronic signatures in 
Bangladesh, also relevant are the Information Technology (Certifying Authority) Rules 
2010 (CA Rules); National Information and Communication Technology Policy 2018; and 
the Certification Practice Statement published by the Office of the Controller of Certifying 
Authorities (CCA). At this time there is no case law that deals with electronic or 
certificate-based digital signatures. 
The ICT Act uses the terms electronic signature and digital signature interchangeably. In 
fact, the Bengali version of the ICT Act refers to “electronic signature” whereas the 
English version uses “digital signature”. According to the Act, electronic signatures (or 
digital signatures, in the English version) must be able to: 

 identify the signatory; 

 affix with the signatory uniquely; 

 be created in a safe manner or using means under the sole control of the 
signatory; and 

 be related with the attached data in such a manner that is capable of identifying 
any alteration made in the data thereafter. 

Any type of electronic signature will be treated as ineffective if the electronic record 
related to it is tampered with or amended. 
Special considerations 

 
In Bangladesh, several use cases require a traditional signature. In others, such as dealing 
with public sector entities, the requirements will vary from case to case. 
Transacting with public sector entities 

 
Bangladesh has no fixed requirements or restrictions for using digital or electronic 
signatures when dealing with Government entities. However, restrictions may apply 
depending on the particular department’s terms of engagement. Also, under the ICT Act, 
the Government and its agencies have no obligation to accept documents in an electronic 
form. 
Use cases that generally require a traditional signature 

There are certain types of documents or agreements that cannot by law be signed or 
executed electronically in Bangladesh. Such documents generally require the person 
executing them to be physically present before the Government office in question, or to 
provide a thumb impression along with a “wet signature”. Examples of these documents 
may include: 

 Will; 

 Power of Attorney; 

 Deed of Sale in relation to immovable property; 

 Agreements where stamp duty is payable; 

 Documents which need to be signed before the notary public and/or witnessed. 
Documents relating to legal proceedings which need to be sworn before an affidavit 
commissioner. 
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How Can Security Awareness Be Improved? 
An effective cybersecurity awareness information plan must be fun and not stringent, 
and it must be backed up by the executive and management board. It must be targeted 
at improving user behavior and be interactive in a way that necessitates feedback from 
all users. It should also be diverse in such a way that it penetrates the totality of the 
corporation with security awareness training materials, including email tips, posters, 
newsletters, and other regularly distributed communication materials. 
Other ways to improve your security awareness training include: 

 Being flexible with your corporate culture. 

 Avoid punishing mistakes for clicks on phishing and spear phishing attempts. 

 Preparing phishing simulations at random intervals. 

 Frequently training staff and constantly reviewing training materials. 

 Ensuring that your security awareness training includes everything that is relevant 
to the security of your organization. 

 Customizing trainings to the right people and at the right time. 

 Look at security awareness training from the standpoint of behavioral change 
instead of theoretical pursuits and compliance requirements. 
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Module 14: Mobile Technology 

Mobile Technology: 
 An overview 
Mobile technology is technology where the user uses mobile phone to do the operations 
related to communication system, for example to establish communication with friends, 
relatives and others. It uses to transmit the data from one system to others.  Mobile 
Technology consists of portable two-way communications systems, computing devices, 
and the related networking equipment. 
 
Mobile technology is a technology which is used primarily in cellular communication 
system and other related aspects. It uses a network type in which several transmitters are 
able to send data on a single channel at the same time. This model is known as Code-
Divisions Multiple Accesses (CDMA). This platform allows many users to use single 
frequencies, as it limits the possibility of frequency interference from two or more sources. 
Over the years, the channel has grown. Mobile technology is evolving rapidly; its 
applications are becoming increasingly diverse over the years and are gradually replacing 
some similar sources on the market that are also used for communication, e.g. post office 
and land lines. Mobile technology has improved from a basic phone call and texting device 
into a multi-tasking system used for GPS navigation, internet browsing, gaming, instant 
messaging, etc. With the rise, professionals argue that computer technology's future 
depends on wireless networking and mobile computing. Mobile technology is becoming 
more and more popular through tablets and portable computers. 
 
Nowadays this smartphone system has been upgraded to a very large multitasking 
computer that is used for GPS navigation, gaming, and internet browsing and instant 
messaging. Mobile technology has gained growing popularity through tablets and portable 
computers. 
Wireless systems are loosely called the networking networks linking these devices. They 
allow mobile devices to share speech, data, and (mobile) applications. 
obile technology is popular and on the rise. The number of smartphone users has gone up 
over 3 billion1 and by 2022 the global mobile workforce is projected to hit 1.87 billion. 
 
Mobile Technology is characterized as any device with internet capabilities that can be 
accessed from wherever the user is. Current devices in this class contain devices like 
smartphones, tablets, some iPods and laptops, although this list will certainly increase in 
the coming years. 

Mobile Device Examples 
Mobile devices are everywhere and they're not just limited to the phones in our pockets. 
Whether it's distributing a stronger WiFi signal or enabling a user to access phone calls 
from their wrist, mobile devices come in all shapes, sizes, and functionalities. Some of the 
most popular forms of mobile technology include:  
Smartphones – most people have access to a smartphone today but any cell phone can be 
considered mobile technology. 
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Laptops – An evolution from the notebook computers of the past, modern laptops come 
in a variety of sizes but nearly all contain two-way network connectivity capabilities and 
can be used in a variety of environments. 
Tablets – Often operating on the same systems as smartphones but with more powerful 
components, tablets offer even more portability than laptops with much of the same 
functionality. 
Smartwatches – These devices are designed to sync with other devices, like smartphones 
or laptops, and utilize cloud capabilities to display notifications and applications on a 
smaller, wearable screen. 
Hotspots – Devices require an internet connection of some kind to access the internet and 
hotspots provide a solution when a connection would be otherwise unattainable. Often 
running via cellular networks, hotspots host private WiFi networks that users can connect 
to in unorthodox environments. 
Mobile gaming consoles – Gaming consoles have long existed in portable forms but recent 
generations possess the power to rival home consoles and feature two-way connectivity 
for accessing downloadable content, playing games with others over a network, and 
sending messages. 
IoT Devices – Many, but not all, IoT devices can be considered mobile technology, such as 
sensors and smartwatches. These devices represent a broad category and react to their 
environment to communicate specific signals when an event is triggered. 

Types of Mobile Technologies 
Followings are the key mobile technologies, 

1. SMS 
2. MMS 
3. 4G 
4. 3G 
5. GSM 
6. CDMA 
7. Wi-Fi 

1) SMS 
"SMS" means Fast Messaging Service. It is nowadays the oldest and most commonly used 
text messaging service. It includes MMS (Multimedia Messaging Service) that allows SMS 
users to send multimedia content, such as images, audio, and visual files. Both SMS and 
MMS are sent using cellular networks, so a wireless plan and a wireless carrier is needed. 
 
If you give your phone a typical "email" message it is called an SMS. You just sent an MMS 
while you are sending the gif. 
As a low cost messaging tool SMS is rapidly gaining popularity in the US. The SMS is 
described as text messages sent to mobile phones, up to 160 characters in length. SMS has 
been synonymous with every text message sent to a cellular phone in recent months. 
SMS is used for sending text messages to cell phones. Usually the messages can be up to 
160 characters in length, although some services use 5-bit mode that supports 224 
characters. SMS was initially designed for phones using GSM (Global System for Mobile 
Communications) communication, but it is now supported by all major cellular phone 
systems. 
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Although SMS is most widely used between friends or co-workers for text messaging, it 
also has many other applications. SMS subscription services, for example, can transmit 
weather, news, sports updates, and stock quotes to phones of users. SMS may also notify 
employees of sales requests, service stops and other business-relevant information. 
Doctors are able to accept SMS messages about emergencies in patients. 
Fortunately, text messages sent via SMS do not require the receiver's telephone to be on 
for efficient transmission of the message. The SMS service will keep the message until the 
recipient turns on his or her phone and the message is sent to the recipient 's phone at 
which point. Most cell phone companies allow you to send a certain number of text 
messages at no charge per month. Although figuring out what that number is will be a 
good idea before you go nuts with the text message. 
How does SMS Works? 
When you send a text message, it goes first over a network called the control channel to a 
nearby cellular tower and then into an SMSC hub. The SMSC resends the message to the 
recipient's nearest tower, and then it goes to their cell. SMS also sends message related 
data including message length, size, time stamp and destination. 
Of the 109 text messages I sent yesterday, 15 were, for example, SMS messages sent to 
people who have phones on other networks, 70 were sent via iMessage, and the rest were 
sent via OTT apps. 
2) MMS 
MMS messaging known as Multimedia Messaging Service is a standard way to deliver 
multimedia content-including messages. In comparison to SMS, MMS can offer a variety 
of media including up to 40 seconds of video, one picture, a multi-image slideshow, or 
audio. Most of the modern devices will support texting with MMS. MMS support is usually 
built into the text message interface and automatically turns on when required. For 
example, a text-only message will be sent via SMS if you type in. The multimedia portion 
will be transmitted through MMS, if you add a graphic or video. Likewise, if anyone sends 
you a multimedia message, your phone will receive the file automatically using MMS. If 
your phone does not support MMS messages, you will most likely receive a text message 
which includes a URL from a web browser where you can access the file from. 
An MMS message can send rich media content any time, anywhere, directly to mobile 
devices. It is a powerful and effective tool which helps businesses and businesses to 
reinforce and deepen customer loyalty by keeping them updated about their products and 
services with vital information. MMS texts are an important marketing communication tool 
since the text is packed with photos and videos. And other audios. MMS is really a modern 
way to connect with people over mobile devices. Text messages are more successful as 
they provide the receiver with valuable information and services. The more a company 
approaches its clients, the more likely a long-lasting brand partnership would be built up. 
How Does MMS Work? 
In a standard phone-to-phone MMS transaction, the method of sending and receiving an 
MMS message works like this: 

 The sending phone triggers a data link, usually via GPRS ( General Packet Radio 
Service), which provides TCP / IP connectivity. 

 The sending phone encodes the MMS message HTTP POST to the Multimedia 
Messaging Service Center (MMSC) in the MMS Encapsulation Protocol, as specified 
by the Open Mobile Alliance; The encoded MMS message contains all of the MMS 
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message text, along with header information that includes a list of intended 
message recipients. (In most cases, the HTTP POST will be routed via a proxy server. 
Some devices will use WP-HTTP (Wireless Profiled HTTP) and TCP via a WAP 2.0 
proxy server while other devices will use the Wireless Session Protocol via a 
traditional Wireless Application Protocol [WAP] proxy server / gateway.) 

 The MMSC receives the MMS message sent, and validates the message sender. 
 The MMSC stores MMS message content, making it accessible as a dynamically 

generated URL connection. 
 The MMSC generates an MMS message, which is sent to the recipient(s) of the 

message via WAP Push over SMS. This MMS notification message contains a URL 
pointer for the content of the dynamically generated MMS. 

 The receiver receives an MMS notification message and then initiates a data link 
providing access to the TCP / IP network (usually via GPRS). 

 The receiver phone executes a GET HTTP (Hyper Text Transfer Protocol) to retrieve 
the MMS message link URL from the MMSC. 

3) 3G 
Number three in 3 G's name means third generation access technology which allows 
mobile phones to be connected to the internet. 
Every new technology has new frequency bands and higher rates of data transmission. 
The 1980s saw the first generation emerging. Know mobile phones? First-generation 
networking was used on those voluminous phones that were typically mounted in cars 
because they were too heavy to hold comfortably. Sometimes that large briefcase a bureau 
worker was carrying around wasn't full of important papers, but he was lugging around a 
massive "mobile" phone instead! 
The second generation network, which became available in the '90s, allowed text 
messaging to be used. This significant and groundbreaking improvement also offered a 
more secure network and paved the way for the ever-present 3 G and 4 G technologies. 
In 2001, 3 G connection-based networks were launched, marking the beginning of 
widespread Internet use on mobile phones. Smartphones were introduced soon after, 
offering all the possibilities of a device in the palm of your hand. 
How 3 G technologies work? 
3 G data technology uses a network of telephone towers to transmit the signals, ensuring 
a stable and relatively fast long distance link. The tower closest to the mobile phone of the 
user is transferring data into it. Although it may not sound complex, at the time it was 
launched 3 G technology was groundbreaking. 
Today we enjoy more mature 4 G technology which will soon be replaced by powerful 5 G 
networks themselves. Many people will use 3 G when 4 G is unavailable, but even after 
almost two decades of use the system will holds up. You might have noticed the 
connectivity on your own mobile phone moving from 4 G to 3 G depending on which 
service is more readily accessible at a given venue. 
3 G networks can upload speeds up to 3 Mbps (about 15 seconds for uploading a 3-minute 
MP3 song). By contrast, up to 144Kbps (about 8 minutes to download a 3-minute song) 
can be achieved with the fastest 2 G phones. 
With your new 3 G enabled phones you may be shocked to visit some countries and it 
refuses to pick up the network until you choose the 2 G search mode! 3 G systems are 
designed for digital mobile phones with a full display screen and improved connectivity. 
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Requirements for 3 G Use 
Unlike Wi-Fi, which you can use in hotspots for free, you need to pay to a service provider 
to get 3 G access to the network. This sort of service is sometimes referred to as a data 
plan or a network plan. 
Your computer is connected to the 3 G network through its SIM card (in the case of a 
mobile phone) or 3 G data card (which may be of various forms, such as USB, PCMCIA, 
etc.), all of which are typically supplied or sold by the service provider. 
These cards are how the system connects to the Internet when it's within a 3 G network's 
range. The technology is also backward compatible with older technologies, which is why 
a 3 G compliant phone will get 2 G service when there is no 3 G service available. 
4) 4G 
4 G is the fourth generation of mobile networking technology. It carries on from mobile 
technology of 3 G and 2G. 
2 G technology introduced in the 1990's allowed digital telephone calls to be made and 
texts sent. Then 3 G arrived in 2003, allowing you to search web sites, make phone calls, 
and stream music and video on the move. 
4 G technology builds on what 3 G does but does it all at a much quicker pace. 
Naturally, there is now also 5 G, which follows the same trend. It's the fifth generation and 
still is quicker. 
To put it simply, 4 G is described as the fourth generation of mobile technology which 
follows the preceding 2 G and 3 G networks. It is often referred to as 4 G LTE, but this is 
not technically correct because LTE is just a single 4 G type. Currently it is the most mature 
technology embraced by most mobile network service providers. 
However, as you might have read, 5 G is growing alongside current 3 G and 4 G mobile 
networks and is beginning to operate. 
When it first came out 4 G changed the way we use mobile internet easily. Although 3 G 
networks were reasonably small, 4 G network connectivity allowed users to access the web 
and display HD videos on mobile devices that effectively turned smartphones into modern-
day computers. 
Today, on handheld devices such as smartphones or tablets, you can perform most of the 
tasks that you do on a laptop or desktop computer. 4 G networks mean you can maintain 
reliable speeds virtually anywhere, no matter how much data you need. 
4 G released in UK in 2012. Right now, its forerunner 3 G is dwarfing the number of mobile 
users who use 4G. Nevertheless, expect that to change in years to come as 4 G contracts 
decline in price and 4 G network coverage expands further across the UK. 
How fast is 4G? 
Compared with 3 G, the 4 G networks are very good. 
Premium 4 G provides download speeds of about 14 Mbps, which is almost five times 
faster than that provided by its predecessor, the 3 G network. Currently, 4 G networks can 
reach speeds as high as 150 Mbps, enabling users to download gigabytes of data in minutes 
or even seconds, rather than hours like with 3 G networks. 
Uploading data is also much quicker – typical 4 G upload speeds are around 8 Mbps, with 
potential rates reaching as high as 50 Mbps, while 3 G caps off at approximately 0.5 Mbps. 
It is a substantial difference, no matter how you look at it. 
Today, with data plans being more accessible, the use of mobile and local WiFi networks 
has been mixed by many users, as both have similar speeds. Some companies also sell 
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home-based 4 G networks for people who want a mobile hotspot that they can take 
wherever they go with them. 
5. Global System for Mobile technology:  
The  (GSM) is an acronym for Global System for Mobile Communication. GSM is a cellular 
technology that is open and digital and is used for mobile communication. It operates on 
the 850 MHz, 900 MHz, 1800 MHz, and 1900 MHz frequency ranges. It employs a hybrid 
of FDMA and TDMA.  
 
Code Division Multiple Access:  
(CDMA) is an acronym for code division multiple access. It is a channel access mechanism 
that also serves as an example of multiple access. Multiple access simply means that data 
from multiple transmitters can be delivered onto a single communication channel at the 
same time. 
Wi-Fi (Wireless Fidelity):  
Wi-Fi is a wireless networking technology that allows us to connect to a network or to 
other computers or mobile devices across a wireless channel. Data is delivered in a circular 
region over radio frequencies in Wi-Fi. Wi-Fi (Wireless Fidelity) is a generic acronym for a 
communication standard for a wireless network that functions as a Local Area Network 
without the use of cables or other types of cabling. 
Use of Mobile technology 
The incorporation of mobile technology into business has aided tele collaboration. Now, 
people could connect from anywhere using mobile technology, and access the papers and 
documents they need to complete collaborative work. 
Work is being redefined by mobile technologies. Employees are no longer confined to their 
desks; they can work from anywhere in the world. 
Mobile technology can help your company save time and money. Employees who work 
from home save thousands on a regular basis. Mobile phones eliminate the need for costly 
technology like landline carrier services. Cloud-based services are less expensive than 
traditional systems. Technology can also help your company become more flexible and 
productive. 
Mobile technology has the potential to boost productivity significantly. Mobile application 
integration saves an average of 7.5 hours per week per employee. Workers can also 
become more productive with the use of smartphones and mobile gadgets. 
The popularity of cloud-based services has skyrocketed in recent years. Cloud-based 
mobile technology applications have been seen to be more useful than any smartphone, 
particularly in terms of available storage space. 
Advantages of Mobile technology 
 Through a variety of applications, we can now stay in touch with our friends and family 

members anytime we choose. We may now communicate or video visit with anybody 
we want by just using our cell phone or cell phone. Aside from that, the portable keeps 
us informed about the rest of the globe. 

 Today’s mobile phones have made our day-to-day activities much more natural. Today, 
one may check the current traffic situation on their phone and make appropriate 
decisions to arrive on time. The weather is also a factor. 

 With the advancement of mobile technology, the entire gaming world is now under 
one roof. When we are tired of monotonous work or during breaks, we can listen to 
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music, view movies, watch our favorite shows, or simply watch a video of our favorite 
song. 

 Mobile phones are being used for a variety of legitimate tasks, including meeting 
schedules, sending and receiving documents, providing introductions, warnings, and 
job applications, among others. Cell phones have become an indispensable tool for all 
working people. 

 These days, mobile phones are also used as a wallet to make payments. Utilities might 
be used to send money to friends, relatives, and others right now. 

Disadvantages of Mobile technology 
 The modern family has become reliant on mobile phones. In any case, when we don’t 

have to travel, we surf the internet, play around, and create a genuine junkie. 
 Because of the widespread use of mobile technology, people nowadays don’t meet in 

person but rather tweet or comment on social media sites. 
 Because of the widespread use of mobile devices, there is a major risk of losing one’s 

protection. By efficiently reading through your web-based social networking account, 
anyone may now easily obtain data such as where you reside, your loved ones, what 
you do for a living, where you live, and so on. 

 Mobile phone prices have risen in tandem with their worth. People nowadays spend a 
significant amount of money on cell phones, which could be better spent on more useful 
things like education or other beneficial items throughout our lives. 

Mobile Technology & Reach 
Mobile technology has grown leaps and bounds over the last few decades. The journey 
from the clunky wireless phone to sleek smartphone has been peppered by a number of 
amazing innovations and discoveries. 
With the 3G mobiles available today, users can do a lot more with their smartphones than 
just sending a voicemail or SMS. They can browse the web, check the weather, read a 
book, prepare a to-do-list, carry their favorite music around, find their way around a new 
city with GPRS, and do much more. 
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Mobile Marketing Technology & Reach 
In such a scenario, every business person willing to practice the mobile marketing 
technique has to be aware about the following top 5 ways in which mobile technologies 
have changed the way users interact with mobile devices − 
Anywhere anytime access 
Unlike laptops and desktops, tablet and mobile devices are easy to carry around. Users 
can access the internet in their mobile devices at anytime and anywhere and it has 
decreased use of the laptops. 
Mobile Apps are easier than websites 
Companies that have an online customer base for instance e-commerce portals have 
noticed that the sales and subscriptions they get from their apps are higher in comparison 
to that of their websites. This means, online purchasing from the mobile phones are 
easier. 
Advertisements should be personalized 
Most of the users feel that the mobile are more personal device than say a laptop or a 
desktop. Therefore, they expect that the content they receive on their mobile phones 
must be personalized as well. 
Social media is a prime channel 
Whether your customers are business professionals, students, home-makers, teenagers 
etc., commonly, they spend more than 3 hours a week on social media channels, such as 
Twitter, Facebook etc. Surprisingly, most of these customers access these channels on 
their smartphones. 
Mobiles are turning into mini-computers 
Slowly but surely technicians and developers are packing the mobile phones with 
computer-like features. With bigger screens, faster performance, optimum storage 
capacity, longer battery life, and a ton of productivity booster applications. The evolution 
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of phones from a simple calling device to multi-tasking-pocket-size computers has 
revolutionized the world. 
Key capabilities of effective mobile technology 
Scalability: Creating point solutions that don’t scale across an enterprise can be costly in 
terms of development, management and maintenance. Apps need to be conceived 
holistically with consideration for lines of business, processes and technical 
environments. 
 
Integration: IDC has pointed out (PDF, 611KB) that “…applications offered on mobile 
phones and tablets have a separation between the mobile app and back-end business 
logic and data services.” Being able to connect logic and data services to the app is 
critical, whether the logic and data are on premises, on the cloud or in hybrid 
configurations. 
 
Reuse: Over 105 billion mobile apps were downloaded in 2018.⁶ Many are, or can be 
modified or combined, for business applications. Using existing apps accelerates time-to-
value and improves cost efficiency by taking advantage of domain and industry expertise 
built into the app. 
 
Cloud-based development: The cloud offers an efficient platform to develop, test and 
manage applications. Developers can use application programming interfaces (API) to 
connect apps to back-end data and focus on front-end functions. They can add 
authentication to bolster security, and access artificial intelligence (AI) and cognitive 
services. 
 
Mobility management: As mobile technology is deployed, organizations look to 
enterprise mobility management (EMM) solutions to configure devices and apps; track 
device usage and inventories; control and protect data; and support and troubleshoot 
issues. 
 
BYOD: Bring your own device (BYOD) is an IT policy that allows employees to use 
personal devices to access data and systems. Effectively adopted, BYOD can improve 
productivity, increase employee satisfaction and save money. At the same time, it 
presents security and device management questions that need to be addressed. 
 
Security: The mobile security battle is daunting in terms of volume and complexity. 
Artificial Intelligence (AI) is emerging as a key weapon to discern security anomalies in 
vast amounts of data. It can help surface and remediate malware incidents or 
recommend actions to meet regulatory requirements from a central dashboard. 
 
Edge computing: One of the key advantages of 5G is that it can bring applications closer 
to their data sources or edge servers. Proximity to data at its source can deliver network 
benefits such as improved response times and better bandwidth availability. From a 
business perspective, edge computing offers the opportunity to perform more 
comprehensive data analysis and gain deeper insights faster. 
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Mobile Technology Applications 

 Business (point-of-sale transactions [seller, buyer], Internet purchases, online 
banking) 

 Communication (voice, text, social media, email, Internet access, travel 
directions) 

 Computing 
 Entertainment (gaming, music, streaming video, ebooks) 
 IoT 
 Mobile apps 
 Remote sensing 
 Travel directions (GPS, cellular-based) 
 Wearables 

Mobile Technology Components 
 

 Hardware (communication subsystem [Wide Area Network components, Local 
Area Network components, Personal Area Network components, antennas, Near 
Field Communication], processor, memory, sensors) 

 Security (hardware and software) 
 Software/firmware (mobile apps, software/firmware, mobile operating systems) 
 User interfaces (hardware [displays, wearable components], software/firmware) 

Mobile Technology Collateral Components 
 Centralized storage 
 Infrastructure 
 Sensors/transducers 

Our attorneys practicing in these fields have experience in the mobile technology 
industry and understand the constantly changing complexity of these inventions. They 
have experience in mobile-related technologies such as social networks and associated 



 

Designing and Implementing Training Program for Increasing 
Women`s Participation in the ICT Sector in Bangladesh, Contract 
Package No: BRCP1/MOC/SD-20. 

 

Prepared by: IBCS-PRIMAX Software (BD) Ltd.    P a g e  1341 | 1352  

operations, software, wireless communications, speech recognition, GPS systems, video 
applications, and image processing.  Our educational and work backgrounds enable us to 
effectively communicate with our clients to understand their goals, so that we can obtain 
effective long-term global protection for them. 

23 Mobile Technology Waves for 2022 
1. Android Instant Apps are on the rise 
Android app developers or people who have an app available on the Google Play Store 
have probably heard of Android Instant Apps. 
These are native apps that don’t require installation and run instantly, hence the name. 

 
This technology is now available to all developers. So whether you’re an existing Android 
developer or a new one, anyone has access to this type of development. 
Android Instant apps are revolutionary for both developers and users. Now a user can 
run an app and test it out without needing to download it first. 
This works on the newest Android devices. It’s supported by devices from Android 5.0 to 
Android 8.0, or API level 21 to API level 26. 
Having a smooth Instant App will be necessary to get users to download your app. If they 
don’t have a good experience when they’re trying it out, they probably won’t install it. 
This new technology also poses some new questions. Will Apple follow this trend and 
create a similar feature for there app store? 
As of now, this feature is strictly for Android devices. But I’ll be interested to see how this 
plays out over the next year. You should keep an eye on this as well. 
2. Mobile artificial intelligence 
In 2022, we are one step closer to robots taking over the world. I’m kidding, of course. 
While we’re not quite there yet, we are seeing more and more advances in artificial 
intelligence, especially in the mobile industry. 
Some AI software that you might be familiar with include: 

 Siri 
 Cortana 
 Alexa 

https://developer.android.com/topic/instant-apps/index.html
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 Google Assistant 
But now regular mobile apps are using voice recognition software and AI to enhance the 
user experience. Voice recognition also improves hands-free use. Some mobile app 
accessibility is also linked to AI. 
Artificial intelligence is used to bridge translation gaps with voice recognition. 
Understanding the user’s voice will help developers and marketers learn more about 
these people. 
As a result, you’ll be able to target users better and generate more revenue with relevant 
advertisements. 
3. Mobile security 
Businesses need to start prioritizing mobile security to protect user information and 
make sure that all transactions are safe. 
That’s because some users are hesitant to use payment apps for reasons related 
to security and distrust. 

 
Businesses who rely on mobile payments need to put these concerns to rest in the 
coming year. 
56% of consumers in the United States believe that mobile payments increase their 
chances of falling victim to theft and fraud. 
Only 5% of these consumers believe that mobile payments reduce theft and fraud 
chances. An additional 13% of US consumers don’t think it makes a difference. 
With so many companies going mobile and relying on mobile payments to turn a profit, I 
expect mobile security to be a top priority for these businesses. 
Companies will come up with ways to ease the minds of their consumers. As a result, I’m 
expecting there to be a shift in the perception of mobile payments in the coming year. 
Consumers will feel safer about making these transactions. 

https://buildfire.com/app-accessibility-mobile-development/
https://buildfire.com/app-accessibility-mobile-development/
https://bankinnovation.net/2017/06/security-and-lack-of-trust-stall-mobile-payment-adoption/
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If you’re one of the companies that offers a mobile payment option, you need to address 
these security concerns ASAP. 
4. Geofencing and location-based services 
It’s no secret that mobile apps are tracking the location of their users. In fact, users are 
giving them permission to do so. 
Whenever you download and use a new app, you’ll get a notification that requests 
permission to access your location. Here’s an example of what this notification looks like 
on iOS devices. 

 
You can’t even use some apps unless you share your location with them. For example, if 
you’re using a rideshare app like Uber or Lyft, you won’t be able to get connected with a 
driver unless the app knows exactly where you are. 
But now location-based services are trending in a new direction. Companies that don’t 
need your location are still requesting it. 
They are using it to improve their marketing efforts. In fact, 70% of apps share user data 
with third-party services. 
It’s easier to target users from a marketing perspective if you know their location. For 
example, businesses are using geofencing to make more money. 
If someone with an app downloaded to their device walks into a certain geofenced area, 
they’ll get a push notification from the app with some kind of promotion based on that 
location. 
We’re going to see an increase in this type of marketing strategy in 2022. 

https://support.apple.com/en-gb/HT203033
https://buildfire.com/what-is-geofencing/
https://theconversation.com/7-in-10-smartphone-apps-share-your-data-with-third-party-services-72404
https://buildfire.com/make-money-with-geofencing/
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5. Mobile applications for small businesses 
Mobile applications are no longer just for the giant companies anymore. Any business in 
any industry needs to have a mobile app. It doesn’t matter how big or small your 
company is. 
Small business owners are recognizing this trend and starting to develop. In fact, 
roughly 50% of small business owners plan to develop a mobile app. 
55% of small businesses say that they’re developing an app to increase sales. While other 
businesses site an improvement in the customer experience and staying competitive in a 
specific market as the reasons for development. 
Regardless of the reason, small business apps are still on the rise. 
6. Augmented reality will be incorporated into more apps 
More mobile apps will adapt to augmented reality in 2022. 
These types of apps incorporate the real world with the app. Pokemon Go is a perfect 
example of an augmented reality app. Here’s an example of the game. 

 
The sidewalk, grass, benches, trees, sky, people, and power lines all exist in reality for the 
image above. If you were to take out your camera, you’d see all of this on the screen. 
But this type of mobile tech adds elements to your device that aren’t actually there, like 
the fictional Pokemon character above. 
Pokemon Go was downloaded 752 million times and generated more than $1.2 billion in 
revenue. There are more than 5 million daily active users playing this game across the 
globe. 

https://buildfire.com/marketing-strategies-for-small-businesses/
https://smallbiztrends.com/2016/04/small-businesses-will-have-a-mobile-app-by-2017.html
https://www.pokemongo.com/
https://expandedramblings.com/index.php/pokemon-go-statistics/
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It’s safe to say that this was a huge success. Because of this, more companies are going to 
try and use augmented reality apps to drive downloads, engagement, and revenue for 
their business. 
7. Apps built for transportation are evolving 
Transportation apps are changing. 
We’re already familiar with mobile tech like Uber and Lyft. People even use car sharing 
apps like Turo or Zipcar to get around. 
There are apps for train schedules, buses, and planes. Everything that I’ve just mentioned 
is something that we have grown accustomed to in the past several years. 
But now we’re seeing even more companies starting to appear with a mobile application 
for unique modes of transportation. I’m referring to apps like Limebike and Bird. 

 
With Bird, users who download the app can locate electric scooters in their area. The 
scooter is unlocked and started by using the app. 
Then a user can go for a ride and leave it anywhere when they’re finished by locking it 
through the app and completing the ride. Once the ride is completed, another user has 
the option to use that same scooter and pick it up exactly where it was left. 
People don’t need to bring the scooters to a specific location or charging station, which 
makes it really appealing to the users. 
Bird raised more than $15 million to start their business. With so much money being 
invested into this new technology, I anticipate this company to expand and for other 
businesses to replicate their business model in the coming year. 
8. Mobile app revenue is on the rise 
The Google Play Store and the Apple App Store both saw a major increase in app revenue 
last year. What caused this? 

https://www.limebike.com/
https://www.bird.co/
https://www.forbes.com/sites/alanohnsman/2018/02/13/scooter-service-bird-raises-15-million-amid-legal-spat-with-santa-monica/#10d4f7ec22e5
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For starters, there was a 13.5% increase in global app downloads. There was a 6.7% 
increase and 16.7% increase from the Apple App Store and Google Play Store, 
respectively. 
There is no sign of this trend slowing down in 2022. In fact, experts predict that markets 
like India and Brazil alone will see a 30% to 50% increase in total hours spent using a 
mobile application. 
According to Statista, the global app revenue is expected to reach $935 billion by 2023. 
That’s roughly 2.5x the figures from 2018. 
How can your company get a piece of that massive share? 
9. Wearable technology being paired with mobile apps 
In 2022 we’ll see an increase of wearable mobile tech. I’m talking about things like: 

 smart watches 
 fitness bracelets 
 glasses 
 healthcare monitors 

All of these devices, and more, will be paired and used with mobile apps. For example, 
look at a company like Fitbit. 
Their wearable mobile tech can be monitored and accessed through their app. Users can 
see things like how many steps they took in a day, their heart rate, and other trackable 
information. 
The idea behind this concept is for the consumer to track and monitor their fitness and 
health journey. With the app, it’s easy to compare data and how you’re improving over 
the course of a day, week, month, or even year. 
125 million units of wearable technology to be shipped this year. The lion’s share of these 
devices will be used in conjunction with mobile apps. 
10. People will control their homes with a mobile app 
More consumers are going to use mobile tech to improve their experience in their 
homes. 
For example, Honeywell has a wide range of products in this space. 

https://www.mobileappdaily.com/2017/12/8/app-annie--smartphone-users-will-spend-110bn-on-mobile-apps-in-2018
https://www.statista.com/statistics/269025/worldwide-mobile-app-revenue-forecast/
https://www.fitbit.com/home
https://yourhome.honeywell.com/lyric
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Here’s one of their thermostats that connects to the Wifi network in a home. Users can 
control the temperature and adjust the thermostat from their devices, even if they aren’t 
home. 
Honeywell, along with other companies, also has products for home security and home 
appliances. They all operate a similar way and can be controlled from mobile devices. 
More companies and more consumers will adapt to this trend in the coming year. 
This is a space where machine learning will also come into play in the near future. 
11. Cross platform mobile development 
Mobile app developers who want to launch their app for Android and iOS devices will 
start to take advantage of cross platform mobile application development tools. 
It’s no longer a viable business model for an app to only be available on one platform and 
not the other. In the past, businesses were hesitant to launch on both platforms 
simultaneously because of the high costs. 
They would need to build two completely separate apps. But now, with cross platform 
mobile development trending upward, it’s easier and more realistic for companies to do 
so. 
That’s why we’ll also see an increase in the number of total apps available for download 
across both stores. This number is directly related to the total global app revenue, which 
we’ve previously discussed. 
12. Mobile payments are on the rise 
With an increase in global app revenue as well as a more positive outlook on mobile 
security, mobile payments will be on the rise in 2022. 
I’m talking about mobile tech payment methods like: 

 Apple Pay 
 Venmo 
 Google Pay 
 Paypal 

https://buildfire.com/best-mobile-cross-platform-development-tools/
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Even bank apps and mobile apps that allow users to pay for products or services directly 
within the app. 
Take a look at how these alternative payment options have been trending up in recent 
years, and I don’t expect to see this trend slowing down anytime soon. 
2022 should be another huge year for mobile payments. 
13. Virtual reality apps 
Earlier we discussed augmented reality apps. But virtual reality will continue to grow in 
2022 as well. 
These are apps that require more than just a smartphone or tablet to operate. 
Users will also wear some form of goggles or helmet. They may even have separate 
controllers or joysticks paired with mobile tech as well. 
According to Zion Market Research, the global virtual reality market valuation will be 
worth more than $26 billion in 2022. 
14. Biometrics 
Biometrics are officially part of the mobile application world. 
Mobile devices and apps are using this mobile tech as a security measure for their users. 
I’m referring to things like: 

 fingerprints 
 voice recognition 
 signature recognition 
 facial recognition 

The newest iPhone model uses facial recognition software to unlock the device. 
Other apps are enabling fingerprints and other biometrics in conjunction with two-factor 
authentication to improve security. 
You can expect to see more devices and more mobile apps using biometrics technology 
in 2022. 
15. Cloud-based technology 
Based on research and expert predictions, the cloud market is growing at a rate of 22% 
CAGR. 
76% of all revenue from cloud platforms are controlled by Google, Microsoft Azure, and 
Amazon Web Services. 
Cloud-based technology is also penetrating the world of mobile apps. 
Although it may seem marginal, cloud-based mobile tech is still on the rise and will 
continue to be prominently used in apps and mobile devices throughout 2022. 
16. Personalization is still king 
One thing that won’t change in 2022 is personalization. 

o Mobile users still want a personalized experience, regardless of what they’re 
doing. 

o New apps and new technology will help focus on the user’s personal experience. 
Refer back to some of the trends that we previously discussed. 

o Geofencing will focus on personalization based on a user’s location. 
o In order to pay for things with a mobile device, users will have their personal 

information stored in their profiles. They may even use biometrics to access 
these. 

https://www.zionmarketresearch.com/news/virtual-reality-market
https://buildfire.com/2fa-security/
https://buildfire.com/2fa-security/
https://insanelab.com/blog/mobile-development/mobile-app-development-trends-2018/
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o Apps are starting to use machine learning to learn more about users. Machine 
learning technology makes it much easier to automatically personalize in-app 
content. 

o With so many trends to keep up with in the coming year, just make sure that your 
company doesn’t lose focus when it comes to optimizing the user experience. 

o You’ve still got to make your mobile app as unique as possible for each user. 
17. BYOD 
In the past, businesses didn’t want employees to use their own computers, laptops, 
phones, tablets, and other mobile devices for work. Here’s why businesses were hesitant 
in the past to adapt to the bring your own device concept. 

 
But today with new mobile tech and security, more and more companies are considering 
BYOD to be safe. 
That’s why 87% of businesses today rely on employees using their personal devices to 
access work-related material. 
59% of companies allow their staff to use personal devices directly for work. An 
additional 13% plan to allow this within the next year. 
As you can see from the data, although companies in the past have had security concerns 
about BYOD, its presence in the workplace is still trending upward. I expect that trend to 
continue in 2022. 
Allowing BYOD saves businesses money and also boosts productivity. Studies show that 
employees who use personal devices for work have a 34% increase in productivity. 
18. In-App Gestures 
Touch has now become a norm in the mobile app space. 
Therefore, gestures like taps, double taps, swipes and scrolls have taken over. Actions 
like sharing or deleting a particular in app activity or content is now commonly being 
done with the help of a swipe. Gestures can vary from industry to industry and new and 
innovative gestures are becoming a prominent part of any mobile application customer 
experience. 

https://www.celltrust.com/personas-enable-employers-and-employees-to-remain-in-control-with-byod/
https://www.insight.com/en_US/learn/content/2017/01182017-byod-statistics-provide-snapshot-of-future.html
https://insights.samsung.com/2016/08/03/employees-say-smartphones-boost-productivity-by-34-percent-frost-sullivan-research/
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Reasons Why Gestures are Preferred Over Buttons 

 Gestures make the user-experience very lively and real. They ensure that the app 
interface remains clean and pleasing. The user finds no obstructions while taking 
an action. 

 What you can experience now is that you just need to swipe to delete an 
unwanted email in your inbox. Gestures bring in useful shortcuts in each and 
everything we are doing in the app, hastening and simplifying the process. 

More Importance To Visual Cues In Gestures 
Many a times it has been observed that gestures are inconsistent across apps and 
devices. The situation can at times, become slightly confusing for the user. A user may 
get used to a certain gesture which may not perform the same way in another app or 
device. 
Visual cues about gestures are helpful in making it easier for the user. Progressive 
gestures are thus an upcoming trend in this space. 
19. Minimalistic Interface 
A faster, easy to load app must be easy on the users’ eyes as well. 
Too many design elements in any app makes a user get confused. A minimal UI design 
ensures that the users can understand and use the application with ease. 
With shorter attention span of users and the need for a speedy app, a minimal UI is 
surely the way forward. 
20. User On-boarding 
The impression that the app users get, the first time they use an app, decides its fate with 
that user. An out-of-the box on-boarding experience is crucial for the success of the app. 
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When the user comes on-board, it is their first tryst with the app and if you can sell the 
application at this time, the task is done. 
A progressive on-boarding works well to get the user to become comfortable with the 
application while understanding it better. 

 
Improving the Initial Experience 
As soon as the visitor opens your app for the first time, you need to communicate about 
some of the unique features of the application. 
An introductory video can be quite effective in building a relationship with the users 
while telling them what’s in store for them. 
Provide them with a walk through of the app and some basic tips on using its core 
features. 
Helping the users to personalize the app experience by adding their preferences is quite 
common as well. 
Make The Users Feel Positive 
App gamification is a trend that’s fast catching up. Once the user knows how to use the 
app, you need to make sure that the interaction is consistent. Praise them on having 
completed a step or thank them at completion of a particular activity like a sign up. You 
can add these simple messages to keep them motivated and interested at each step. 
21. User Off-boarding 
Every story has an ending that should be equally inviting. Provide your users with a happy 
passage while exiting the app. For example, if it’s a gaming application, you can tell them 
about the points they have accumulated in the completed session. You can congratulate 
them and motivate them to come back again for more action. A pleasant off-boarding 
experience will surely get the user to talk about the app and get you word-of-mouth 
publicity. 
User off-boarding is fast catching up as a trend and more and more apps and UX 
professionals are joining in the bandwagon. This is one of the key trends to watch out for 
in the coming year. 
22. Internet of Things 
The Internet of Things technology has been around for a while and has added 
tremendous value to businesses globally. 
With sensor technology becoming cheaper, IoT will continue to grow in the coming 
times. The UX of an IoT app plays a very important role in its success. The key challenge 
the UX designers of IoT apps face is to provide the precise information to the user so they 
do not get confused and overwhelmed with extra stuff. 
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In an IoT app the information flows between service providers, apps, things and people 
and one has to ensure that this information is clear, concise and engaging for the user. 
One of the key concerns of the UX professionals and business owners is the security of 
this information. Another important aspect of an app UX built for IoT is the level of 
customization that can be done for different groups of users. Personal users of an IoT app 
require a different experience from that of the business users. One has to clearly 
understand app functionality in each of the cases while doing the app UX. 
23. Animated and Motion Based Design 
Motion based design adds to the delight of the users. Animations are used to 
communicate the story behind each feature and functionality. 

Relevance of Animation 
Animation works when relevant. You need to understand your audience to create stories 
that connect with your audience. Talk to your prospective users and understand their 
expectations of the app. The next step is to understand the user journey and the context 
in which the user action will be taken. 
There are situations in the app’s user journey where the user is looking for answers to 
stuff like: 

 What’s happening next? 
 Have I completed this action? 
 What does this mean? 

These are opportunities to add animation and ensure it helps the users to complete the 
action and move to the next one. 

 
Conclusion 
No matter what type of business you’re in, you’ve got to stay updated on the newest 
technology trends. 
 
More specifically, you need to know what’s happening in the mobile world because that’s 
where your current and prospective customers are living. 
Understanding the latest mobile technology trends of the coming year will help your 
company prepare and make any adjustments to stay up to date. Whether its machine 
learning, VR, or AR, you may want to consider applying some of these trends to your own 
app. 
 
 
 


